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About this Guide

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This section explains the objectives, intended audience, and organization of this publication and 
describes the conventions that convey instructions and other information.

Revision History

This section provides the following information:

• Document Objectives

• Audience

• Document Organization

• Related Documentation

• Document Conventions

• Where to Find Safety and Warning Information

• Obtaining Documentation

• Documentation Feedback

• Obtaining Technical Assistance

• Obtaining Additional Publications and Information

Date Notes

03/28/2007 Revision History Table added for the first time

08/27/2007 Updated About this Guide chapter
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About this Guide
Document Objectives
Document Objectives
This document explains installation, turn up, provisioning, and maintenance for Cisco ONS 15454 dense 
wavelength division (DWDM) systems. Use this document in conjunction with the appropriate 
publications listed in the Related Documentation section.

Audience
To use this publication, you should be familiar with Cisco or equivalent optical transmission hardware 
and cabling, telecommunications hardware and cabling, electronic circuitry and wiring practices, and 
preferably have experience as a telecommunications technician.

Document Organization
The Cisco ONS 15454 DWDM Installation and Operations Guide, Release 4.7 is organized into the 
following chapters:

• Chapter 1, “Install the Shelf and Common Control Cards” provides procedures for installing Cisco 
ONS 15454 ANSI and ETSI shelves and common control cards including the TCC2 and AIC/AIC-I.

• Chapter 2, “Connect the PC and Log into the GUI” includes procedures to install the Cisco 
Transport Controller (CTC), set up a computer for different connection types, and log into the 
Cisco ONS 15454.

• Chapter 3, “Turn Up a Node”provides procedures for node turn up and DWDM card installation.

• Chapter 4, “Perform Node Acceptance Tests” provides acceptance tests for each DWDM node type.

• Chapter 5, “Turn Up Network” explains how to turn up and test a DWDM network.

• Chapter 6, “Create Channels and Circuits” explains how to create DWDM optical channel network 
connections (OCHNCs) and overhead circuits.

• Chapter 7, “Manage Alarms”explains how to document existing node data, view and delete alarms, 
view alarm-affected circuits and LCD alarm counts, manage alarm profiles, filter alarms, suppress 
alarms, and provision external alarms.

• Chapter 8, “Monitor Performance” provides procedures to change the performance monitoring (PM) 
display, monitor performance, and manage remote monitoring (RMON) thresholds.

• Chapter 9, “Manage the Node” explains how to modify node provisioning for the Cisco ONS 15454 
and perform common management tasks such as monitoring the DWDM automatic power control 
and span loss values.

• Chapter 10, “Change Card Settings” explains how to change line, performance monitoring (PM), 
and threshold settings on Cisco ONS 15454 cards.

• Chapter 11, “Maintain the Node” provides hardware and software maintenance procedures for the 
Cisco ONS 15454.

• Chapter 12, “Power Down the Node” explains how to shut down an ONS 15454.

• Chapter 13, “Shelf Hardware Reference” includes descriptions of the rack, backplane, FMECs, 
ferrites, power and ground, fan-tray assembly, air filter, card slots, cables, cable connectors, and 
cable routing.
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Related Documentation
• Chapter 14, “Card Reference” provides descriptions of the common control, 
transponder/muxponder, and DWDM cards as well as small-form factor pluggables (SFPs).

• Chapter 15, “DWDM Node Reference” explains the ONS 15454DWDM node types that are 
available for the ONS 15454. The chapter also explains the DWDM automatic power control, 
ROADM power equalization, span loss verification, and automatic node setup functions. 

• Chapter 16, “DWDM Network Reference” explains the ONS 15454 DWDM network applications 
and topologies.

• Chapter 17, “Cisco Transport Controller Operation” includes information about CTC installation, 
the CTC window, computer requirements, software versions, and database reset and revert.

• Chapter 18, “Security and Timing” describes user security and node/network timing.

• Chapter 19, “CTC Connectivity Reference” includes IP addressing scenarios and information about 
provisionable patchcords, open GNE, and external firewalls.

• Chapter 20, “Alarm Monitoring and Management” describes Cisco Transport Controller (CTC) 
alarm management.

• Appendix A, “CTC Information and Shortcuts” describes the CTC views, menus options, tool 
options, shortcuts, table display options, and shelf inventory data.

• Appendix B, “Hardware Specifications” contains hardware and software specifications for the ONS 
15454 ANSI and ETSI shelf assemblies and cards.

• Appendix C, “DWDM Enhanced State Model” describes the state model for Cisco ONS 15454 
DWDM cards, optical payload ports, out-of-band optical supervision channel (OSC) ports, optical 
channel network connections (OCHNC), and transponder/muxponder cards and ports.

Related Documentation
Use this Cisco ONS 15454 DWDM Installation and Operations Guide, Release 4.7 in conjunction with 
the following referenced publications:

• Cisco ONS 15454 SONET and DWDM Troubleshooting Guide, Release 4.7

• Cisco ONS 15454 SONET and SDH TL1 Quick Reference Guide, Release 4.7

• Cisco ONS 15454 Release 4.7 Network Element Defaults

• Cisco ONS 15454 SDH Release 4.7 Network Element Defaults

• Release Notes for Cisco ONS 15454 Release 4.7

• Release Notes for Cisco ONS 15454 SDH Release 4.7

Document Conventions
This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.
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Where to Find Safety and Warning Information
Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, the user might do something that could result in equipment 
damage or loss of data.

Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and 
Compliance Information document that accompanied the product. This publication describes the 
international agency compliance and safety information for the Cisco ONS 15xxx systems. It also 
includes translations of the safety warnings that appear in the ONS 15xxx system documentation.

[ ] Keywords or arguments that appear within square brackets are optional.

{ x | x | x } A choice of keywords (represented by x) appears in braces separated by 
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the 
Control key while pressing the D key.

screen font Examples of information displayed on the screen.

boldface screen font Examples of information that the user must enter.

< > Command parameters that must be replaced by module-specific codes.

Warning IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. Use the statement number provided at the end of 
each warning to locate its translation in the translated safety warnings that accompanied this 
device. Statement 1071

SAVE THESE INSTRUCTIONS

Convention Application
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About this Guide
Obtaining Documentation
Obtaining Documentation
Cisco documentation and additional literature are available on Cisco.com. Cisco also provides several 
ways to obtain technical assistance and other technical resources. These sections explain how to obtain 
technical information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation at this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

You can access international Cisco websites at this URL:

http://www.cisco.com/public/countries_languages.shtml

Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product documentation from 
the Ordering tool:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local account representative by 
calling Cisco Systems Corporate Headquarters (California, USA) at 408 526-7208 or, elsewhere in 
North America, by calling 800 553-NETS (6387).

Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is 
available in a CD-ROM package that ships with your product. The Optical Networking Product 
Documentation CD-ROM is updated periodically and may be more current than printed documentation. 

Documentation Feedback
You can send comments about technical documentation to bug-doc@cisco.com.
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About this Guide
Obtaining Technical Assistance
You can submit comments by using the response card (if present) behind the front cover of your 
document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance
For all customers, partners, resellers, and distributors who hold valid Cisco service contracts, Cisco 
Technical Support provides 24-hour-a-day, award-winning technical assistance. The Cisco Technical 
Support Website on Cisco.com features extensive online support resources. In addition, Cisco Technical 
Assistance Center (TAC) engineers provide telephone support. If you do not hold a valid Cisco service 
contract, contact your reseller.

Cisco Technical Support Website
The Cisco Technical Support Website provides online documents and tools for troubleshooting and 
resolving technical issues with Cisco products and technologies. The website is available 24 hours a day, 
365 days a year at this URL:

http://www.cisco.com/techsupport

Access to all tools on the Cisco Technical Support Website requires a Cisco.com user ID and password. 
If you have a valid service contract but do not have a user ID or password, you can register at this URL:

http://tools.cisco.com/RPF/register/register.do

Submitting a Service Request
Using the online TAC Service Request Tool is the fastest way to open S3 and S4 service requests. (S3 
and S4 service requests are those in which your network is minimally impaired or for which you require 
product information.) After you describe your situation, the TAC Service Request Tool automatically 
provides recommended solutions. If your issue is not resolved using the recommended resources, your 
service request will be assigned to a Cisco TAC engineer. The TAC Service Request Tool is located at 
this URL:

http://www.cisco.com/techsupport/servicerequest

For S1 or S2 service requests or if you do not have Internet access, contact the Cisco TAC by telephone. 
(S1 or S2 service requests are those in which your production network is down or severely degraded.) 
Cisco TAC engineers are assigned immediately to S1 and S2 service requests to help keep your business 
operations running smoothly.

To open a service request by telephone, use one of the following numbers:

Asia-Pacific: +61 2 8446 7411 (Australia: 1 800 805 227)
EMEA: +32 2 704 55 55
USA: 1 800 553 2447
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Obtaining Additional Publications and Information
For a complete list of Cisco TAC contacts, go to this URL:

http://www.cisco.com/techsupport/contacts

Definitions of Service Request Severity
To ensure that all service requests are reported in a standard format, Cisco has established severity 
definitions.

Severity 1 (S1)—Your network is “down,” or there is a critical impact to your business operations. You 
and Cisco will commit all necessary resources around the clock to resolve the situation. 

Severity 2 (S2)—Operation of an existing network is severely degraded, or significant aspects of your 
business operation are negatively affected by inadequate performance of Cisco products. You and Cisco 
will commit full-time resources during normal business hours to resolve the situation.

Severity 3 (S3)—Operational performance of your network is impaired, but most business operations 
remain functional. You and Cisco will commit resources during normal business hours to restore service 
to satisfactory levels.

Severity 4 (S4)—You require information or assistance with Cisco product capabilities, installation, or 
configuration. There is little or no effect on your business operations.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is available from various online 
and printed sources.

• Cisco Marketplace provides a variety of Cisco books, reference guides, and logo merchandise. Visit 
Cisco Marketplace, the company store, at this URL:

http://www.cisco.com/go/marketplace/

• The Cisco Product Catalog describes the networking products offered by Cisco Systems, as well as 
ordering and customer support services. Access the Cisco Product Catalog at this URL:

http://cisco.com/univercd/cc/td/doc/pcat/

• Cisco Press publishes a wide range of general networking, training and certification titles. Both new 
and experienced users will benefit from these publications. For current Cisco Press titles and other 
information, go to Cisco Press at this URL:

http://www.ciscopress.com

• Packet magazine is the Cisco Systems technical user magazine for maximizing Internet and 
networking investments. Each quarter, Packet delivers coverage of the latest industry trends, 
technology breakthroughs, and Cisco products and solutions, as well as network deployment and 
troubleshooting tips, configuration examples, customer case studies, certification and training 
information, and links to scores of in-depth online resources. You can access Packet magazine at this 
URL:

http://www.cisco.com/packet
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About this Guide
Obtaining Additional Publications and Information
• iQ Magazine is the quarterly publication from Cisco Systems designed to help growing companies 
learn how they can use technology to increase revenue, streamline their business, and expand 
services. The publication identifies the challenges facing these companies and the technologies to 
help solve them, using real-world case studies and business strategies to help readers make sound 
technology investment decisions. You can access iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems for engineering 
professionals involved in designing, developing, and operating public and private internets and 
intranets. You can access the Internet Protocol Journal at this URL:

http://www.cisco.com/ipj

• World-class networking training is available from Cisco. You can view current offerings at 
this URL:

http://www.cisco.com/en/US/learning/index.html
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Cisco ONS 15454 DWDM
September 2004
C H A P T E R 1

Install the Shelf and Common Control Cards

This chapter explains how to install the Cisco ONS 15454 ETSI and Cisco ONS 15454 ANSI shelf 
assemblies. Where procedures differ for the two shelf types, the procedure will indicate “ANSI only” or 
“ETSI only.” For a summary of the tools and equipment required for installation, see the “Required Tools 
and Equipment (ETSI)” section on page 1-4 or the “Required Tools and Equipment (ANSI)” section on 
page 1-2.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). Read 
the installation procedures and precautions before you install the ONS 15454 ANSI or ONS 15454 ETSI 
and connect the power source. 

1. NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6—Complete this procedure before 
continuing with the “NTP-G2 Install the Shelf Assembly” procedure on page 1-8.

2. NTP-G2 Install the Shelf Assembly, page 1-8—Complete this procedure to install the shelf 
assembly in a rack.

3. NTP-G3 Open and Remove the Front Door, page 1-20—Complete this procedure to access the 
equipment before continuing with other procedures in this chapter.

4. NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23—Complete this procedure to 
access the electrical facility connection assembly (EFCA) for the front mount electrical connections 
(FMECs) before continuing with other procedures in this chapter.

5. NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26— Complete this procedure to 
access the backplane before continuing with other procedures.

6. NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-27—Complete this 
procedure to install the MIC-A/P and MIC-T/C/P FMECs, which are required for power supply as 
well as alarm, timing, and LAN connections. 

7. NTP-G7 Install the Power and Ground, page 1-30—Complete this procedure before continuing with 
the “NTP-G8 Install the Fan-Tray Assembly” procedure on page 1-40.

8. NTP-G8 Install the Fan-Tray Assembly, page 1-40—Complete this procedure to install the fan-tray 
assembly in the shelf.
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  Required Tools and Equipment (ANSI)
9. NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-44—Complete this procedure if 
you are planning to install the Alarm Interface Controller–International (AIC-I) card and want to 
increase the number of alarm contacts provided by the AIC-I card. 

10. NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 1-47—Complete 
as needed to set up wire-wrap pin connections.

11. NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only), page 1-59 —Complete this 
procedure to connect an external wire-wrap panel to the alarm expansion panel (AEP).

12. NTP-G12 Install and Close the FMEC Cover (ETSI Only), page 1-63—Complete this procedure to 
install the FMEC cover.

13. NTP-G13 Install the Rear Cover (ANSI Only), page 1-65—Complete this procedure as needed to 
install the rear cover after you have finished servicing the backplane. 

14. NTP-G14 Install DWDM Equipment, page 1-66—Complete this procedure as needed to install 
equipment needed for DWDM networks.

15. NTP-G15 Install the Common Control Cards, page 1-72—Complete this procedure to install the 
TCC2 card and the Alarm Interface Controller (AIC) or AIC-I card. 

16. NTP-G16 Perform the Shelf Installation Acceptance Test, page 1-77—Complete this procedure to 
determine if you have correctly completed all other procedures in the chapter.

Warning This equipment must be installed and maintained by service personnel as defined by AS/NZS 3260. 
Incorrectly connecting this equipment to a general-purpose outlet could be hazardous. The 
telecommunications lines must be disconnected 1) before unplugging the main power connector or 
2) while the housing is open, or both.

Warning This unit is intended for installation in restricted access areas. A restricted access area can be 
accessed only through the use of a special tool, lock and key, or other means of security.

Warning Ultimate disposal of this product should be handled according to all national laws and regulations.

Warning A readily accessible two-poled disconnect device must be incorporated in the fixed wiring.

Note The ONS 15454 is suitable for mounting on concrete or other noncombustible surfaces only. 

Note In this chapter, “shelf assembly” refers to the steel enclosure that holds cards and connects power, and 
“node” refers to the entire hardware and software system.

Required Tools and Equipment (ANSI)
You need the following tools and equipment to install and test the ONS 15454 ANSI shelf assembly.
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Chapter 1      Install the Shelf and Common Control Cards
  Required Tools and Equipment (ANSI)
Cisco-Supplied Materials (ANSI)
The following materials are required and are shipped with the ONS 15454 ANSI shelf (wrapped in 
plastic). The number in parentheses gives the quantity of the item included in the package.

• #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 48-1007-XX) (8)

• #12 -24 x 3/4 socket set screws (48-1003-XX) (2)

• T-handle #12-24 hex tool for set screws (1)

• ESD wrist strap with 1.8 m (6 ft) coil cable (1)

• Tie wraps (10)

• Pinned hex (Allen) key for front door (1)

• Spacers (50-1193-XX) (4)

• Spacer mounting brackets (2)

• Clear plastic rear cover (1)

• External (bottom) brackets for the fan-tray air filter

• Standoff kit (53-0795-XX):

– Plastic fiber management guides (2)

– Fan filter bracket screws (53-48-0003) (6)

User-Supplied Materials (ANSI)
The following materials and tools are required but are not supplied with the ONS 15454 ANSI:

• One or more of the following equipment racks: 

– 19-inch ANSI Standard (Telcordia GR-63-CORE) (482.6 mm) rack; total width 22 inches 
(558.8 mm)

– 23-inch ANSI Standard (Telcordia GR-63-CORE) (584.2 mm) rack; total width 26 inches 
(660.4 mm)

• Fuse panel

• Power cable (from fuse and alarm panel to assembly), #10AWG, copper conductors, 
194 degrees Fahrenheit (90 degrees Celsius)

Note If you are installing power on a 15454-SA-NEBS3E, 15454-SA-NEBS3, or 15454-SA-R1 
shelf assembly, a #10 to #12 AWG power cable is required.

• Ground cable #6AWG stranded

Note If you are installing power on a 15454-SA-NEBS3E, 15454-SA-NEBS3 or 15454-SA-R1 
shelf assembly, the #10 AWG ground cable is required.

• Alarm cable pairs for all alarm connections, #22 or #24 AWG (0.51 mm² or 0.64 mm²), solid tinned

• 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair 
T1-type
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• Single-mode SC fiber jumpers with UPC polish (55 dB or better) for optical (OC-N) cards

• Shielded coaxial cable terminated with SMB or BNC connectors for DS-3 cards

• Shielded ABAM cable terminated with AMP Champ connectors or unterminated for DS1N-14 cards 
with #22 or #24 AWG (0.51 mm² or 0.64 mm²) ground wire (typically about two ft [61 cm] in length)

• 6-pair #29 AWG double-shielded cable

• Tie wraps and/or lacing cord 

• Labels

• Listed pressure terminal connectors such as ring and fork types; connectors must be suitable for 
#10 AWG copper conductors

Tools Needed (ANSI)

The following tools are needed to install an ONS 15454 ANSI:

• #2 Phillips screwdriver

• Medium slot-head screwdriver 

• Small slot-head screwdriver 

• Wire wrapper

• Wire cutters

• Wire strippers

• Crimp tool

• BNC insertion tool

Test Equipment (ANSI)

The following test equipment is needed to install an ONS 15454:

• Voltmeter

• Optical power meter (for use with fiber optics only)

• BER tester, DS-1 and DS-3

Required Tools and Equipment (ETSI)
You need the following tools and equipment to install and test the ONS 15454 ETSI shelf assembly.

Cisco-Supplied Equipment (ETSI)
These materials are required for installation and are supplied with the ONS 15454 ETSI. The shipped 
quantity of each item is in parentheses.

• Double-hole grounding lug for ground connection with a wire receptacle to accommodate the 
recommended 13.3 mm² (#6 AWG) multi-strand copper wire (1)

• M4 x 8 mm pan-head Phillips screws (2)

• M6 x 20 mm socket set screws (2)
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  Required Tools and Equipment (ETSI)
• M6 x 20 mm pan-head Phillips screws (8)

• Tie wraps 0.125-inch (3.2 mm) W x 6.0-inch (152 mm) L (24)

• ESD wrist strap (disposable) (1)

• Pinned Allen key for front door (1)

• Hex key 3-mm long arm (1)

• Bottom brackets for the fan-tray air filter

• Cable assembly, Ethernet, RJ-45 (1)

• Power cable (from fuse and alarm panel to MIC-A/P and MIC-C/T/P) (2)

Caution Only use the power cables that are designed to be used with ONS 15454 ETSI. They are sold separately.

User-Supplied Equipment (ETSI)
The following materials and tools are required for installation but are not supplied with the 
ONS 15454 ETSI:

• Equipment rack (ETSI rack, 2200 mm [86.6 inch] H x 600 mm [23.6 inch] W 
x 300 mm [11.8 inch] D)

• Fuse and alarm panel

• Copper ground cable 13.3-mm² (#6 AWG) stranded, specified for up to 90 degrees Celsius 
(194 degrees Fahrenheit)

• Alarm cable pairs for all alarm connections, 0.51 mm² or 0.64 mm² (#22 or #24 AWG), solid-tinned

• Single-mode SC fiber jumpers with UPC polish (55 dB or better) for optical cards

• Coaxial cable terminated with 1.0/2.3 miniature coax connectors for FMEC cards

• DB-37 cable

• Shielded building integrated timing supply (BITS) clock coaxial cable terminated with 
1.0/2.3 miniature coax connectors

• Labels

Note Ring runs are not provided by Cisco and can hinder side-by-side shelf installation where space is limited. 

Tools Needed (ETSI)

To install the ONS 15454 ETSI, you need the following tools. 

• #2 Phillips screwdriver

• Medium slot-head screwdriver

• Small slot-head screwdriver

• Video fiber connector inspection instrument

• CLETOP cleaning cassette
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DLP-  G1 Unpack and Verify the Shelf Assembly
• Crimping tool—This tool must be large enough to accommodate the girth of the grounding lug when 
you crimp the grounding cable into the lug.

• Wire stripping tool

Test Equipment (ETSI)

To install the ONS 15454 ETSI, you need the following test equipment. 

• Voltmeter

• Power meter (only for use with fiber optics)

• Bit error rate (BER) tester for E1-N-14, E1-42, E3-12, DS3i-N-12, STM1E-12, and FMEC cards

NTP-G1 Unpack and Inspect the Shelf Assembly 

Step 1 Complete the “DLP-G1 Unpack and Verify the Shelf Assembly” task on page 1-6.

Step 2 Complete the “DLP-G2 Inspect the Shelf Assembly” task on page 1-7.

Step 3 Continue with the “NTP-G1 Unpack and Inspect the Shelf Assembly” procedure on page 1-6.

Stop. You have completed this procedure.

DLP-G1 Unpack and Verify the Shelf Assembly 

Step 1 When you receive the ONS 15454 system equipment at the installation site, open the top of the box. The 
Cisco Systems logo designates the top of the box.

Step 2 Remove the foam inserts from the box. The box contains the ONS 15454  shelf (wrapped in plastic) and 
a smaller box of items needed for installation.

Purpose This procedure explains how to unpack the ONS 15454 shelf assemblies 
and verify their contents.

Tools/Equipment Pinned hex (Allen) key for front door

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task removes the shelf assembly from the package.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-  G2 Inspect the Shelf Assembly
Step 3 To remove the shelf, grasp both rings of the shelf removal strap and slowly lift the shelf out of the box. 

Step 4 Open the smaller box of installation materials, and verify that you have all items listed in the “Required 
Tools and Equipment (ETSI)” section on page 1-4 or the “Required Tools and Equipment (ANSI)” 
section on page 1-2. 

Note The fan-tray assembly is shipped separately.

Step 5 Return to your originating procedure (NTP).

DLP-G2 Inspect the Shelf Assembly 

Step 1 Open the shelf using the pinned hex key. For more information, see the “DLP-G9 Open the Front Cabinet 
Compartment (Door)” task on page 1-20.

Step 2 Verify the following:

• The pins are not bent or broken.

• The frame is not bent.

Step 3 If the pins are bent or broken, or the frame is bent, call your Cisco sales engineer for a replacement.

Step 4 Close the front door before installing.

Step 5 Return to your originating procedure (NTP).

Purpose This task verifies that all parts of the shelf assembly are in good condition.

Tools/Equipment Pinned hex (Allen) key for front door

Prerequisite Procedures DLP-G1 Unpack and Verify the Shelf Assembly, page 1-6

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-  G2 Inspect the Shelf Assembly
NTP-G2 Install the Shelf Assembly 
 

Warning Stability hazard. The rack stabilizing mechanism must be in place, or the rack must be bolted to the 
floor before you slide the unit out for servicing. Failure to stabilize the rack can cause the rack to tip 
over.

Warning This product requires short-circuit (overcurrent) protection, to be provided as part of the building 
installation. Install only in accordance with national and local wiring regulations.

Warning To prevent the system from overheating, do not operate it in an area that exceeds the maximum 
recommended ambient temperature of: 45°C (113°F).

Warning Take care when connecting units to the supply circuit so that wiring is not overloaded.

Purpose This procedure reverses the mounting bracket and mounts shelf assemblies 
in a rack.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Pinned hex tool

ETSI only:

Two M6 x 20 socket set screws

Eight M6 x 20 pan-head Phillips mounting screws

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-  G2 Inspect the Shelf Assembly
Warning To prevent the equipment from overheating, do not operate it in an area that exceeds the maximum 
recommended ambient temperature of 131°F (55°C). To prevent airflow restriction, allow at least 
1 inch (25.4 mm) of clearance around the ventilation openings.

Warning The ONS 15454 should be installed in the lower rack position or mounted above another ONS 15454 
shelf assembly.

Warning The ONS 15454 must have 1 inch (25.4 mm) of airspace below the installed shelf assembly to allow air 
flow to the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf assembly) 
provides this spacing and should not be modified in any way. 

Note The 10-Gbps-compatible shelf assembly (15454-SA-10G) and fan-tray assembly (15454-FTA3) are 
required with the ONS 15454 XC10G, OC-192, and OC-48 any slot (AS) cards. 

Note The shelf, the air ramp, and the E1-75/120 conversion panel ship with the ETSI mounting brackets 
installed as needed for installation in an ETSI rack. If you want to install the node in a 19-inch 
(482.6-mm) rack, the ETSI mounting brackets of the shelf and the air ramp need to be replaced with the 
19-inch (482.6-mm) mounting brackets that shipped in the ship kit. 

Step 1 (ANSI shelves only.) Complete the “DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) 
Rack (ANSI Only)” task on page 1-10 if you need to convert from a 23-inch (584.2 mm) to a 19-inch 
(482.6 mm) rack.

Step 2 (ANSI shelves only.) To install the air filter on the bottom of the shelf rather than below the fan-tray 
assembly, complete the “DLP-G4 Install the External Brackets and Air Filter (ANSI Only)” task on 
page 1-11.

Step 3 Complete the necessary rack mount task as applicable:

• DLP-G5 Mount the Shelf Assembly in a Rack (One Person), page 1-13

Warning To prevent bodily injury when mounting or servicing this unit in a rack, you must take special 
precautions to ensure that the system remains stable. The following guidelines are provided to 
ensure your safety:

• This unit should be mounted at the bottom of the rack if it is the only unit in the rack.

• When mounting this unit in a partially filled rack, load the rack from the bottom to the top with the heaviest 
component at the bottom of the rack.

• If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in 
the rack.
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• DLP-G6 Mount the Shelf Assembly in a Rack (Two People), page 1-15

• DLP-G7 Mount Multiple Shelf Assemblies in a Rack, page 1-16

• DLP-G8 Install the Air Ramp, page 1-19

Step 4 Continue with the “NTP-G3 Open and Remove the Front Door” procedure on page 1-20.

Stop. You have completed this procedure.

DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack 
(ANSI Only)

Caution Use only the fastening hardware provided with the ONS 15454 ANSI to prevent loosening, deterioration, 
and electromechanical corrosion of the hardware and joined material.

Caution When mounting the ONS 15454 in a frame with a nonconductive coating (such as paint, lacquer, or 
enamel) either use the thread-forming screws provided with the ONS 15454 ANSI ship kit, or remove 
the coating from the threads to ensure electrical continuity.

Step 1 Remove the screws that attach the mounting bracket to the side of the shelf assembly.

Step 2 Flip the detached mounting bracket upside down. 

Text imprinted on the mounting bracket will now also be upside down.

Step 3 Place the widest side of the mounting bracket flush against the shelf assembly (see Figure 1-1).

The narrow side of the mounting bracket should be towards the front of the shelf assembly. Text 
imprinted on the mounting bracket should be visible and upside down.

Step 4 Align the mounting bracket screw holes against the shelf assembly screw holes.

Step 5 Insert the screws that were removed in Step 1 and tighten them.

Step 6 Repeat the task for the mounting bracket on the opposite side.

Purpose This task installs the mounting bracket to convert a 23-inch (584.2 mm) 
rack to a 19-inch (482.6-mm) rack. This task applies to ONS 15454 ANSI 
shelves only. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 1-1 Reversing the Mounting Brackets (23-inch [584.2-mm] Position to 19-inch [482.6-mm] Position)

Step 7 Return to your originating procedure (NTP).

DLP-G4 Install the External Brackets and Air Filter (ANSI Only)

Note If you choose not to install the brackets, install the air filter by sliding it into the compartment at the 
bottom of the shelf assembly. Each time you remove and reinstall the air filter in the future, you must 
first remove the fan-tray assembly. Do not install an air filter in both filter locations on any shelf 
assembly.

Purpose This task installs the external brackets and air filter on the bottom of the 
shelf rather than below the fan-tray assembly. Installing the external 
brackets and air filter on the bottom of the shelf enables access to the air 
filter without removing the fan-tray assembly. This task applies to the 
ONS 15454 ANSI shelf only. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures DLP-G3 Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack 
(ANSI Only), page 1-10, if applicable

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Top of unit Side of unit

Top of unit

19 in. (482.6 mm) position 23 in. (584.2 mm)
mounting holes

23 in. (584.2 mm) position

47
86

9

Mounting
L brackets

Front

Mounting
L brackets

Rear

Front

Rear

Rear Front

19 in. (482.6 mm)
mounting holes
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Step 1 With the fan-tray assembly removed, place the ONS 15454 facedown on a flat surface. 

Note Although the filter will work if it is installed with either side facing up, Cisco recommends that 
you install it with the metal bracing facing up to preserve the surface of the filter. 

Step 2 Locate the three screw holes that run along the left and right sides of the bottom of the shelf assembly. 

Step 3 Secure each bracket to the bottom of the shelf assembly using the screws (48-0003) provided in the 
backplane standoff kit (53-0795-XX).

Each bracket has a filter stopper and a flange on one end. Make sure to attach the brackets with the 
stoppers and flanges facing the rear of the shelf assembly (the top, if the ONS 15454 is facedown during 
installation). 

Figure 1-2 illustrates bottom bracket installation. If you do not use the brackets, in the future you must 
remove the fan-tray assembly before removing the air filter. The brackets enable you to clean and replace 
the air filter without removing the fan-tray assembly. 

Figure 1-2 Installing the External Brackets

Step 4 Slide the air filter into the shelf assembly.

Step 5 Return to your originating procedure (NTP).
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G5 Mount the Shelf Assembly in a Rack (One Person)
DLP-G5 Mount the Shelf Assembly in a Rack (One Person) 

Note The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. To ensure that the mounting is secure, use two to four M6 mounting screws for each side of 
the shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in 
the rack.

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer’s instructions:

• (ETSI only) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.

• (ANSI only) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A 
fuse panel (30-A fuse per shelf minimum) is required. 

• (ANSI only) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel 
(20-A fuse per shelf minimum) is required.

Step 2 Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches 
[482.6 mm]). 

Figure 1-3 shows the rack-mounting position for the ONS 15454 ETSI.

Purpose This task allows one person to mount the shelf assembly in a rack.

Tools/Equipment Pinned hex tool 

# 2 Phillips screwdriver

ETSI only:

Two M6 x 20 socket set screws

Eight M6 x 20 pan-head Phillips mounting screws

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
1-13
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Chapter 1      Install the Shelf and Common Control Cards
DLP-  G5 Mount the Shelf Assembly in a Rack (One Person)
Figure 1-3 Mounting an ONS 15454 ETSI in a Rack

Step 3 Using the hex tool that shipped with the assembly, install the two temporary set screws into the holes 
that will not be used to mount the shelf. Let the set screws protrude sufficiently to hold the mounting 
brackets.

Step 4 Lift the shelf assembly to the desired position in the rack and set it on the screws.

Step 5 Align the screw holes on the mounting brackets with the mounting holes in the rack.

Step 6 Using the Phillips screwdriver, install one mounting screw in each side of the assembly.

Step 7 When the shelf assembly is secured to the rack, install the remaining mounting screws.

Note Use at least one set of the horizontal screw slots on the shelf assembly to prevent slippage.

Step 8 Using the hex tool, remove the temporary set screws.

Step 9 Return to your originating procedure (NTP).
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G6 Mount the Shelf Assembly in a Rack (Two People)
DLP-G6 Mount the Shelf Assembly in a Rack (Two People) 

Note The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. To ensure that the mounting is secure, use two to four M6 mounting screws for each side of 
the shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in 
the rack.

Note The ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to 
allow air flow to the fan intake. If a second ONS 15454 is installed underneath a shelf assembly, the air 
ramp on top of the bottom shelf assembly provides the desired space. However, if the ONS 15454 is 
installed above third-party equipment, you must provide a minimum spacing of one inch (25.4 mm) 
between the third-party shelf assembly and the bottom of the ONS 15454. The third-party equipment 
must not vent heat upward into the ONS 15454.

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer’s instructions:

• (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.

• (ANSI only.) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A 
fuse panel (30-A fuse per shelf minimum) is required. 

• (ANSI only.) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel 
(20-A fuse per shelf minimum) is required.

Step 2 Ensure that the shelf assembly is set for the desired rack size (either 23 inches [584.2 mm] or 19 inches 
[482.6 mm]).

Step 3 Using the hex tool that shipped with the assembly, install the two set screws into the holes that will not 
be used to mount the shelf. Let the set screws protrude sufficiently to hold the mounting brackets. 

Purpose This task allows two people to mount the shelf assembly in a rack.

Tools/Equipment Pinned hex tool

# 2 Phillips screwdriver

ETSI only:

Two M6 x 20 socket set screws

Eight M6 x 20 pan-head Phillips mounting screws

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G7 Mount Multiple Shelf Assemblies in a Rack
Step 4 Lift the shelf assembly to the desired position in the rack.

Step 5 Align the screw holes on the mounting brackets with the mounting holes in the rack.

Step 6 Have one person hold the shelf assembly in place while the other person uses the Phillips screwdriver to 
install one mounting screw in each side of the assembly.

Step 7 When the shelf assembly is secured to the rack, install the remaining mounting screws. 

Note Use at least one set of the horizontal screw slots on the shelf assembly to prevent slippage.

Step 8 Use the hex tool to remove the temporary set screws.

Step 9 Return to your originating procedure (NTP).

DLP-G7 Mount Multiple Shelf Assemblies in a Rack 

Note A standard ETSI rack can hold three ONS 15454 ETSI shelf assemblies and two air ramps. When 
mounting a shelf assembly in a partially filled rack, load the rack from the bottom to the top with the 
heaviest component at the bottom of the rack. If the rack is provided with stabilizing devices, install the 
stabilizers before mounting or servicing the unit in the rack.

Note The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. When using third-party equipment above the ONS 15454 ETSI, provide a minimum of 
25 mm (1 inch) between the third-party unit and the bottom of the ONS 15454 ETSI. The third-party 
equipment must not vent heat upward into the ONS 15454 ETSI. 

Purpose This task installs multiple shelves in a rack.

Tools/Equipment Pinned hex tool

#2 Phillips screwdriver

ETSI only:

Two M6 x 20 socket set screws (per shelf)

Eight M6 x 20 pan-head Phillips mounting screws (per shelf)

ANSI only:

Two #12-24 x 3/4 set screws (48-1003-XX) (per shelf)

Eight #12-24 x 3/4 pan-head Phillips mounting screws (48-1004-XX, 
48-1007-XX) (per shelf)

Prerequisite Procedures NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G7 Mount Multiple Shelf Assemblies in a Rack
Note The ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly to 
allow air flow to the fan intake. If a second ONS 15454 is installed underneath a shelf assembly, the air 
ramp on top of the bottom shelf assembly provides the desired space. However, if the ONS 15454 is 
installed above third-party equipment, you must provide a minimum spacing of one inch (25.4 mm) 
between the third-party shelf assembly and the bottom of the ONS 15454. The third-party equipment 
must not vent heat upward into the ONS 15454.

Step 1 Verify that the proper fuse and alarm panel has been installed in the top mounting space. If a fuse and 
alarm panel is not present, you must install one according to manufacturer’s instructions:

• (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed.

• (ANSI only.) If you are installing the 15454-SA-ANSI or 15454-SA-HD shelf assembly, a 100-A 
fuse panel (30-A fuse per shelf minimum) is required. 

• (ANSI only.) If you are installing the 15454-SA-NEBS3 shelf assembly, a standard 80-A fuse panel 
(20-A fuse per shelf minimum) is required.

Step 2 Mount the first shelf assembly in the bottom of the rack using the “DLP-G5 Mount the Shelf Assembly 
in a Rack (One Person)” task on page 1-13 or the “DLP-G6 Mount the Shelf Assembly in a Rack (Two 
People)” task on page 1-15.

Figure 1-4 shows a three-shelf ONS 15454 ETSI bay assembly.
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G7 Mount Multiple Shelf Assemblies in a Rack
Figure 1-4 Three-Shelf ONS 15454 ETSI (15454 SDH) Bay Assembly

Step 3 (ETSI only.) Mount the air ramp above the ONS 15454 ETSI. 

The air ramp is needed if you install more than one ONS 15454 ETSI shelf in a rack. To ensure that the 
air ramp is secure, use one or two M6 mounting screws for each side of the shelf assembly. Figure 1-5 
shows how to mount an air ramp in the rack. 
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G8 Install the Air Ramp
Figure 1-5 Mounting the Air Ramp in a Rack

Step 4 Repeat this task for every shelf assembly you need to install.

Step 5 Return to your originating procedure (NTP).

DLP-G8 Install the Air Ramp

Step 1 The air ramp requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. Locate the 
RMU space specified in your site plan.See the “13.5 Typical DWDM Rack Layouts” section on 
page 13-16 for more information about air ramp placement.

Step 2 Verify that the mounting brackets attached to the unit are correct for your rack size. Complete “DLP-G3 
Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as 
required.

Step 3 Align the chassis with the rack mounting screw holes; insert and tighten the four screws.

Purpose Use this task to install the air ramp.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G9 Open the Front Cabinet Compartment (Door)
Step 4 Return to your originating procedure (NTP).

NTP-G3 Open and Remove the Front Door 

Step 1 Complete the “DLP-G9 Open the Front Cabinet Compartment (Door)” task on page 1-20.

Step 2 Complete the “DLP-G10 Remove the Front Door” task on page 1-21.

Step 3 If you are using an ETSI shelf, continue with the “NTP-G4 Open and Remove the FMEC Cover (ETSI 
Only)” procedure on page 1-23. If you are using an ANSI shelf, continue with the “NTP-G5 Remove the 
Backplane Covers (ANSI Only)” procedure on page 1-26.

Stop. You have completed this procedure. 

DLP-G9 Open the Front Cabinet Compartment (Door) 

Note The ONS 15454 shelf assembly has an ESD plug input and is shipped with an ESD wrist strap. The ESD 
plug input is located on the outside of the shelf assembly on the right side. It is labeled “ESD” on the 
top and bottom. Always wear an ESD wrist strap and connect the strap to the ESD plug when working 
on the ONS 15454.

Step 1 Open the front door lock. 

The ONS 15454 shelf assembly comes with a pinned hex key for locking and unlocking the front door. 
Turn the key counterclockwise to unlock the door and clockwise to lock it. Figure 1-6 illustrates the front 
door of the ANSI shelf. 

Purpose This procedure opens and removes the front door to access the equipment.

Tools/Equipment Open-end wrench

Pinned hex (Allen) key 

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task opens the front door.

Tools/Equipment Pinned hex (Allen) key 

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G10 Remove the Front Door
Figure 1-6 Cisco ONS 15454 ANSI Front Door

Step 2 Press the door button to release the latch. A button on the right side of the shelf assembly releases the 
door.

Step 3 Swing the door open.

Step 4 Return to your originating procedure (NTP).

DLP-G10 Remove the Front Door 

Step 1 For ONS 15454 ETSI shelves:

a. Unscrew the nut holding the ground wire to the shelf. Remove the nut and washer. 

Purpose This task removes the front cabinet compartment door.

Tools/Equipment Open-end wrench

Prerequisite Procedures DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Door lock Door button

Viewholes for Critical, Major and Minor alarm LEDs
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G10 Remove the Front Door
b. Remove the ground wire from the shelf. 

c. Hold the door at the top left corner and remove the door from its hinges (Figure 1-7).

Figure 1-7 Removing the ONS 15454 ETSI Front Door

Step 2 For ONS 15454 ANSI shelves: 

a. To remove the door ground strap (available in Release 3.3 and later), perform the following:

• To detach the ground strap from the front door, loosen the #6 Kepnut (49-0600-01) using the 
open-end wrench. Detach the end of the ground strap terminal lug (72-3622-01) from the male 
stud on the inside of the door. 

• To detach the other end of the ground strap from the longer screw on the fiber guide, loosen the 
#4 Kepnut (49-0337-01) on the terminal lug using the open-end wrench. Remove the terminal 
lug and lock washer. 

b. Lift the door from its hinges at the top left corner of the door (Figure 1-8).
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G10 Remove the Front Door
Figure 1-8 Removing the ONS 15454 ANSI Front Door

Step 3 Return to your originating procedure (NTP).

NTP-G4 Open and Remove the FMEC Cover (ETSI Only)

Step 1 Complete the “DLP-G11 Open the FMEC Cover” task on page 1-24.

Step 2 Complete the “DLP-G12 Remove the FMEC Cover” task on page 1-25.

Step 3 Continue with the “NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only)” procedure on 
page 1-27. 

Purpose This procedure opens and removes the FMEC cover on the ONS 
15454 ETSI. The ONS 15454 ETSI has a screw-in panel over the EFCA. 
The FMEC cover protects the FMEC cards. 

Tools/Equipment Medium slot-head screwdriver

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G11 Open the FMEC Cover
Stop. You have completed this procedure. 

DLP-G11 Open the FMEC Cover 

Step 1 Unscrew the screws on the FMEC cover (Figure 1-9).

Figure 1-9 Unscrewing the FMEC Cover 

Step 2 Use the handles to pull the cover forward.

Step 3 Return to your originating procedure (NTP).

Purpose This task opens the FMEC cover. The FMEC cover must be opened to 
install the MIC-A/P and the MIC-C/T/P. 

Tools/Equipment Medium slot-head screwdriver 

Prerequisite Procedures DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G12 Remove the FMEC Cover
DLP-G12 Remove the FMEC Cover 

Step 1 Unscrew the nut holding the ground wire to the shelf. Remove the nut and washer. 

Step 2 Remove the ground wire from the left side of the shelf. 

Step 3 Pull the right side of the hinge-locking spring (Figure 1-10).

Figure 1-10 Removing the ONS 15454 FMEC Cover 

Step 4 Detach the cover from the pin of the hinge.

Step 5 Remove the cover carefully from the left pin of the hinge.

Step 6 Return to your originating procedure (NTP).

Purpose This task removes the FMEC cover in order to install the MIC-A/P and the 
MIC-C/T/P.

Tools/Equipment Medium slot-head screwdriver 

Prerequisite Procedures DLP-G11 Open the FMEC Cover, page 1-24 

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G13 Remove the Lower Backplane Cover
NTP-G5 Remove the Backplane Covers (ANSI Only)

Step 1 Complete the “DLP-G13 Remove the Lower Backplane Cover” task on page 1-26.

Step 2 Complete the “DLP-G14 Remove the Backplane Sheet Metal Cover” task on page 1-27.

Step 3 Continue with the “NTP-G7 Install the Power and Ground” procedure on page 1-30.

Stop. You have completed this procedure. 

DLP-G13 Remove the Lower Backplane Cover 

Step 1 Unscrew the five retaining screws that hold the cover in place.

Step 2 Grasp the cover on each side.

Step 3 Gently pull the cover away from the backplane.

Step 4 Return to your originating procedure (NTP).

Purpose This procedure describes how to access the ONS 15454 ANSI backplane 
by removing the covers. The backplane has two sheet metal covers (one 
on either side) and a lower backplane cover at the bottom. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G3 Open and Remove the Front Door, page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task removes the lower backplane cover of the ONS 15454 ANSI shelf 
assembly.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G14 Remove the Backplane Sheet Metal Cover
DLP-G14 Remove the Backplane Sheet Metal Cover 

Step 1 To remove the lower clear plastic backplane cover, loosen the five screws that secure it to the ONS 15454 
and pull it away from the shelf assembly.

Step 2 Loosen the nine perimeter screws that hold the backplane sheet metal cover(s) in place.

Step 3 Lift the panel by the bottom to remove it from the shelf assembly.

Step 4 Store the panel for later use. Attach the backplane cover(s) whenever electrical interface assemblies 
(EIA[s]) are not installed.

Step 5 Return to your originating procedure (NTP).

NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only)

Caution Always use the supplied ESD wristband when working with a powered ONS 15454 ETSI. Plug the 
wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Purpose This task removes the backplane sheet metal cover that is installed on the 
backplane.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This procedure installs the MIC-A/P and the MIC-T/C/P, which are a type 
of FMEC installed in the EFCA. The EFCA is located at the top of the 
ONS 15454 ETSI shelf. It provides connection for installing power, 
external alarms, timing input and output, and craft interface terminals.This 
procedure applies to the ETSI shelf only. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

FMEC cards (the MIC-A/P and MIC-T/C/P)

Prerequisite Procedures NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G14 Remove the Backplane Sheet Metal Cover
Warning Voltage is present on the backplane when the system is operating. To reduce risk of an electric shock, 
keep hands and fingers out of the power supply bays and backplane areas.

Note The ONS 15454 ETSI EFCA has 12 FMEC slots numbered sequentially from left to right beginning with 
Slot 18. Slots 18 to 22 and 25 to 29 provide electrical connections for the corresponding slots, so they 
are unnecessary in dense wave division multiplexing (DWDM) applications. 

Step 1 Ensure you are installing the FMECs in the correct slot:

• FMEC Slot 23 supports the MIC-A/P.

The MIC-A/P card provides connection for the BATTERY B input, one of the two possible 
redundant power supply inputs. It also provides connection for eight alarm outputs (coming from 
the TCC2 card), sixteen alarm inputs, and four configurable alarm inputs/outputs.

• FMEC Slot 24 supports the MIC-C/T/P.

The MIC-C/T/P card provides connection for the BATTERY A input, one of the two possible 
redundant power supply inputs. It also provides connection for system management serial port, 
system management LAN port, and system timing inputs and outputs.

Step 2 Hold the FMEC by the faceplate.

Step 3 Slide the FMEC along the guide rails into the desired FMEC slot or slots.

Step 4 Push the FMEC gently into the connector. The ONS 15454 ETSI FMECs plug into electrical connectors 
on the back panel of the shelf assembly when the screws are tightened. Figure 1-11 shows FMEC 
installation. 
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G14 Remove the Backplane Sheet Metal Cover
Figure 1-11 Installing FMECs on the ONS 15454 ETSI

Step 5 Tighten the screws.

Step 6 Continue with the “NTP-G7 Install the Power and Ground” procedure on page 1-30.

Stop. You have completed this procedure. 
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Chapter 1      Install the Shelf and Common Control Cards
DLP-  G14 Remove the Backplane Sheet Metal Cover
NTP-G7 Install the Power and Ground 

Warning Shut off the power from the power source or turn off the breakers before beginning work.

Warning This equipment is intended to be grounded. Ensure that the host is connected to earth ground during 
normal use.

Warning Do not mix conductors of dissimilar metals in a terminal or splicing connector where physical contact 
occurs (such as copper and aluminum, or copper and copper-clad aluminum), unless the device is 
suited for the purpose and conditions of use. 

Purpose This procedure installs power feeds and grounds the ONS 15454.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Screws

(ETSI only.) Power cable (from fuse panel to MIC-A/P and to MIC-C/T/P), 
shipped with the ONS 15454 ETSI

(ANSI only.) Power cable (from fuse and alarm panel to assembly), #10 
AWG, copper conductors, 194 degrees F [90 degrees C])

Ground cable 13.3-mm² (#6 AWG) stranded

(ETSI only.) Two-hole grounding lug, shipped with the ONS 15454 ETSI

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for 5.26-mm² (#10 AWG) copper conductors

(ANSI only.) Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Prerequisite Procedures (ETSI) NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 
1-23

(ETSI) NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), 
page 1-27 

(ANSI) NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Warning Connect the ONS 15454 only to a DC power source that complies with the safety extra-low voltage 
(SELV) requirements in IEC 60950-based safety standards.

Warning The ONS 15454 relies on the protective devices in the building installation to protect against short 
circuit, overcurrent, and grounding faults. Ensure that the protective devices are properly rated to 
protect the system, and that they comply with national and local codes. 

Warning A readily accessible two-poled disconnect device must be incorporated in the fixed wiring.

Warning When installing redundant power feeds, do not use aluminum conductors.

Warning If you use redundant power leads to power the ONS 15454, disconnecting one lead will not remove 
power from the node.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Step 1 Verify that the correct fuse and alarm panel is installed in the top mounting space:

• (ETSI only.) Verify that a 100-A fuse panel (30-A fuse per shelf minimum) is installed. If not, install 
one according to manufacturer’s instructions.

• (ANSI only.) If you have the 15454-SA-ANSI or 15454-SA-HD shelf, a 100-A fuse panel (30-A fuse 
per shelf minimum) should be installed. If not, install one according to manufacturer’s instructions.

• (ANSI only.) If you have the 15454-SA-NEBS3 shelf, a standard 80-A fuse panel (20-A fuse per 
shelf minimum) should be installed. If not, install one according to manufacturer’s instructions.

Step 2 Depending on your type of shelf, complete the “DLP-G15 Connect the Office Ground to the 
ONS 15454 ETSI” task on page 1-32 or the “DLP-G16 Connect the Office Ground to the 
ONS 15454 ANSI” task on page 1-33.

Step 3 Depending on your shelf, complete the “DLP-G17 Connect Office Power to the ONS 15454 ETSI” task 
on page 1-35 or the “DLP-G18 Connect Office Power to the ONS 15454 ANSI” task on page 1-37.

Step 4 Complete the “DLP-G19 Turn On and Verify Office Power” task on page 1-39.

Step 5 Continue with the “NTP-G8 Install the Fan-Tray Assembly” procedure on page 1-40.

Stop. You have completed this procedure. 
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DLP-G15 Connect the Office Ground to the ONS 15454 ETSI

Warning This equipment must be grounded. Never defeat the ground conductor or operate the equipment in the 
absence of a suitably installed ground conductor. Contact the appropriate electrical inspection 
authority or an electrician if you are uncertain that suitable grounding is available.

Step 1 Use a wire-stripping tool to remove approximately 0.75 inch (19 mm) of the covering from the end of 
the grounding wire. 

Step 2 Insert the stripped end of the grounding wire into the open-end of the grounding lug. 

Step 3 Use the crimping tool to secure the grounding wire in two different places in the grounding lug.

Step 4 Locate the grounding receptacle on the side panel of the shelf (Figure 1-12).

Step 5 Place the grounding lug against the grounding receptacle on the side panel of the shelf.

Step 6 Insert one of the screws through the locking washer and through the hole in the grounding lug. Insert the 
screw into the threaded holes on the right side of the shelf. Ensure that the grounding lug does not 
interfere with other system hardware or rack equipment.

Step 7 Repeat Step 6 with the second screw. 

Step 8 Prepare the other end of the grounding wire and connect it to an appropriate grounding point in your site 
to ensure adequate earth ground for the shelf.

Purpose This task connects ground to the ONS 15454 ETSI shelf.

Tools/Equipment  2-hole grounding lug, included in the installation kit

2 Phillips head, M6 (metric) machine screws with locking washers, 
included in the installation kit

Grounding wire—Use 13.3-mm² (#6 AWG) copper wire.

#2 Phillips screwdriver

Crimping tool—This tool must be large enough to accommodate the girth 
of the grounding lug when you crimp the grounding cable into the lug.

Wire stripping tool

Prerequisite Procedures DLP-G9 Open the Front Cabinet Compartment (Door), page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Figure 1-12 Grounding the ONS 15454 ETSI

Step 9 Return to your originating procedure (NTP).

DLP-G16 Connect the Office Ground to the ONS 15454 ANSI

Purpose This task connects ground to the ONS 15454 ANSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Screws

Power cable (from fuse and alarm panel to assembly), #10 AWG, copper 
conductors, 194 degrees F [90 degrees C])

Ground cable #6 AWG stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for #10 AWG copper conductors

Prerequisite Procedures DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-  G16 Connect the Office Ground to the ONS 15454 ANSI
Step 1 Verify that the office ground cable (#6 AWG stranded) is connected to the top of the bay according to 
local site practice.

Step 2 Attach one end of the shelf ground cable (#10 AWG) to the right side of the backplane ground nut. See 
Figure 1-13 for the location of the ground on the backplane.

Note When terminating a frame ground, use the kep nut provided with the ONS 15454 and tighten it 
to a torque specification of 31 in-lb. The Kepnut provides a frame ground connection that 
minimizes the possibility of loosening caused by rotation during installation and maintenance 
activity. The type of prevention the kep nut provides for the frame ground connection is 
inherently provided by the terminal block for battery and battery return connections.

Figure 1-13 Ground Location on the Backplane

Step 3 Attach the other end of the shelf ground cable to the bay. 

Step 4 Return to your originating procedure (NTP).

FRAME GROUND 61
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DLP-G17 Connect Office Power to the ONS 15454 ETSI 

Warning When installing or replacing the unit, the ground connection must always be made first and 
disconnected last.

Caution Do not apply power to the ONS 15454 ETSI until you complete all installation steps and check the 
continuity of the –48 VDC battery and battery return. 

Note No more than 2 m (7 ft) of the power supply cable should be exposed between the equipment and the 
cable-management tray. 

Note Only use listed compression-type connectors when terminating the battery, battery return, and ground 
conductors. Connectors must be suitable for copper conductors.

Caution When terminating power, return, and frame ground, do not use soldering lug connectors, screwless 
(push-in) connectors, quick-connect connectors, or other friction-fit connectors.

Purpose This task connects power to the ONS 15454 ETSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Power cable (from fuse and alarm panel to assembly), 5.26-mm² 
(#10 AWG), copper conductors, 194°F [90°C])

Ground cable 13.3-mm² (#6 AWG) stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for 5.26-mm² (#10 AWG) copper conductors

Prerequisite Procedures DLP-G15 Connect the Office Ground to the ONS 15454 ETSI, page 1-32

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Note If the system loses power or if both TCC2 cards are reset, you must reset the ONS 15454 ETSI clock. 
After powering down, the date defaults to January 1, 1970, 00:04:15. To reset the clock, see the 
“NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-6. 

Step 1 Verify that the MIC-A/P FMEC card is installed in Slot 23 and the MIC-C/T/P FMEC card is installed in 
Slot 24 of the EFCA.

Step 2 Attach the connector on the end of the power cable to the power FMEC.

Step 3 Tighten the screws of the connector on the power cable.

Step 4 Connect the power cable to the fuse panel or power source. Use the pin connections in Table 1-1. The 
conductor (green with yellow stripes) is used for secondary grounding such as grounding to the rack.

Step 5 Return to your originating procedure (NTP).

Table 1-1 Pin Connection of the Power FMECs

Pin Function Cable Color

A1 Battery return Black

A2 –48 V battery Red

A3 Ground Green with yellow stripes
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DLP-G18 Connect Office Power to the ONS 15454 ANSI 

Warning Do not apply power to the ONS 15454 until you complete all installation steps and check the continuity 
of the –48 VDC and return. 

Note The battery return connection is treated as DC-I, as defined in Telcordia GR-1089-CORE Issue 3.

Note If the system loses power or both TCC2 cards are reset and the system is not provisioned to get the time 
from a Network Time Protocol/Simple Network Time Protocol (NTP/SNTP) server, you must reset the 
ONS 15454 clock. After powering down, the date defaults to January 1, 1970, 00:04:15. To reset the 
clock, see the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-6.
If you are using the TCC2 cards, the system clock will run for up to three hours. In this case, no action 
would be required. 

Step 1 Connect the office power according to the fuse panel engineering specifications.

Step 2 Measure and cut the cables as needed to reach the ONS 15454 from the fuse panel. Figure 1-14 shows 
the ONS 15454 power terminals.

Step 3 Dress the power according to local site practice. 

Warning When installing the ONS 15454, the ground connection must always be made first and disconnected 
last.

Purpose This task connects power to the ONS 15454 ANSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

Wire cutters

Wire strippers

Crimp tool

Fuse panel

Power cable (from fuse and alarm panel to assembly), #10 AWG, copper 
conductors, 194 degrees F [90 degrees C])

Ground cable #6 AWG stranded

Listed pressure terminal connectors such as ring and fork types; connectors 
must be suitable for #10 AWG copper conductors

Prerequisite Procedures DLP-G16 Connect the Office Ground to the ONS 15454 ANSI, page 1-33

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Figure 1-14 Cisco ONS 15454 Power Terminals

Step 4 Remove or loosen the #8 power terminal screws on the ONS 15454. To avoid confusion, label the cables 
connected to the BAT1/RET1 (A) power terminals as 1, and the cables connected to the BAT2/RET2 (B) 
power terminals as 2. 

Note Use only pressure terminal connectors, such as ring and fork types, when terminating the battery, 
battery return, and frame ground conductors.

Caution Before you make any crimp connections, coat all bare conductors (battery, battery return, and frame 
ground) with an appropriate antioxidant compound. Bring all unplated connectors, braided strap, and bus 
bars to a bright finish, then coat with an antioxidant before you connect them. You do not need to prepare 
tinned, solder-plated, or silver-plated connectors and other plated connection surfaces, but always keep 
them clean and free of contaminants.

Caution When terminating power, return, and frame ground, do not use soldering lug, screwless (push-in) 
connectors, quick-connect, or other friction-fit connectors.

Step 5 Strip 1/2 inch (12.7 mm) of insulation from all power cables that you will use.

Step 6 Crimp the lugs onto the ends of all power leads. 

Note When terminating battery and battery return connections as shown in Figure 1-14, follow a 
torque specification of 10 in-lb. 

33
92

1

RET  1

CAUTION: Remove power from both
the BAT1 and terminal blocks
prior to servicing

SUITABLE FOR MOUNTING ON
A NON-COMBUSTIBLE SURFACE.
PLEASE REFER TO INSTALLATION
INSTRUCTIONS.

-42 V      24 A

BAT  1 RET  2 BAT  2

Battery leads (red)
Return leads (black)
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Step 7 Terminate the return 1 lead to the RET1 backplane terminal. Use oxidation-prevention grease to keep the 
connections noncorrosive.

Warning Do not secure multiple connectors with the same bolt assembly.

Step 8 Terminate the negative 1 lead to the negative BAT1 backplane power terminal. Use oxidation prevention 
grease to keep connections noncorrosive.

Step 9 If you use redundant power leads, terminate the return 2 lead to the positive RET2 terminal on the 
ONS 15454. Terminate the negative 2 lead to the negative BAT2 terminal on the ONS 15454. Use 
oxidation-preventative grease to keep connections noncorrosive.

Step 10 Route the cables out below the power terminals using the plastic cable clamp, as shown in Figure 1-14 
on page 1-38.

Step 11 Return to your originating procedure (NTP).

DLP-G19 Turn On and Verify Office Power 

Caution Do not apply power to the shelf assembly until you complete all installation steps. 

Step 1 Using a voltmeter, verify the office battery and ground at the following points on the fuse and alarm 
panel:

a. To verify the power, place the black test lead of the voltmeter to the frame ground. Place the red test 
lead on the A-side connection and verify that it is between –40.5 VDC and –57 VDC. Place the red 
test lead on the B-side connection and verify that it is between –40.5 VDC and –57 VDC. 

Note The voltages –40.5 VDC and –57 VDC are, respectively, the minimum and maximum 
voltages required to power the chassis. 

b. To verify the ground, place the black test lead of the voltmeter to the frame ground. Place the red 
test lead on the A-side return ground and verify that no voltage is present. Place the red test lead on 
the B-side return ground and verify that no voltage is present. 

Purpose This task measures the power to verify correct power and returns for the 
ONS 15454 shelf.

Tools/Equipment Voltmeter

Prerequisite Procedures DLP-G15 Connect the Office Ground to the ONS 15454 ETSI, page 1-32

DLP-G17 Connect Office Power to the ONS 15454 ETSI, page 1-35

DLP-G16 Connect the Office Ground to the ONS 15454 ANSI, page 1-33

DLP-G18 Connect Office Power to the ONS 15454 ANSI, page 1-37

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-  G19 Turn On and Verify Office Power
Step 2 Complete one of the following to power up the node:

• If you are using a 80-A fuse panel, insert a 20-A fuse into the fuse position according to site practice.

• If you are using a 100-A fuse panel, insert a 30-A fuse into the fuse position according to site 
practice.

Step 3 Using a voltmeter, verify the shelf for –48 VDC battery and ground:

a. To verify the A-side of the shelf, place the black lead of the voltmeter to the frame ground. Place the 
red test lead to the BAT1 (A-side battery connection) red cable. Verify that it reads between 
–40.5 VDC and –57 VDC. Then place the red test lead of the voltmeter to the RET1 (A-side return 
ground) black cable and verify that no voltage is present.

Note The voltages –40.5 VDC and –57 VDC are, respectively, the minimum and maximum 
voltages required to power the chassis. 

b. To verify the B-side of the shelf, place the black test lead of the voltmeter to the frame ground. Place 
the red test lead to the BAT2 (B-side battery connection) red cable. Verify that it reads between 
–40.5 VDC and –57 VDC. Then place the red test lead of the voltmeter to the RET2 (B-side return 
ground) black cable and verify that no voltage is present.

Step 4 Return to your originating procedure (NTP).

NTP-G8 Install the Fan-Tray Assembly 

Caution Do not operate an ONS 15454 without a fan-tray air filter. A fan-tray air filter is mandatory, except for 
ONS 15454 ANSI applications in an outside plant cabinet.

Note Error messages appear on the TCC2 card, the fan-tray LED, and in Cisco Transport Controller (CTC) 
when the fan-tray assembly is removed from the shelf or when one fan is not working.

Note If you are installing the ONS 15454 in an outside plant cabinet, remove the air filter to provide maximum 
cooling capabilities and to comply with Telcordia GR-487-CORE.

Purpose This procedure installs the fan-tray assembly.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G3 Open and Remove the Front Door, page 1-20

NTP-G7 Install the Power and Ground, page 1-30

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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Caution The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 ANSI Release 3.1 or later shelf 
assemblies (15454-SA-ANSI, 800-19857; 15454-SA-HD, 800-24848). It includes a pin that does not 
allow it to be installed in ONS 15454 shelf assemblies released earlier than ONS 15454 Release 3.1 
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1). Installing the 15454-FTA3 in a 
noncompliant shelf assembly might result in failure of the alarm interface panel (AIP), which in turn, 
will result in power loss to the fan-tray assembly. 

Caution You must place the edge of the air filter flush against the front of the fan-tray assembly compartment 
when installing the fan tray on top of the filter. Failure to do so could result in damage to the filter, the 
fan tray, or both.

Caution Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or 
the connectors on the back panel of the shelf assembly. 

Note To install the fan-tray assembly, it is not necessary to move any of the cable-management facilities. 

Step 1 Install the air filter. The air filter can be installed internally between the fan tray and shelf assembly, or 
externally by mounting the air filter bracket on the bottom of the shelf assembly. Slide the air filter into 
the bracket.

Step 2 Install the fan-tray assembly. 

• For the ONS 15454 ETSI shelf, press and hold the locks on the outer edges as you slide the fan-tray 
assembly into the shelf assembly. 

• For the ONS 15454 ANSI shelf, slide the fan-tray assembly into the shelf. 

The electrical plug at the rear of the tray should plug into the corresponding receptacle on the assembly.

Caution Do not force a fan-tray assembly into place. This can damage the connectors on the fan-tray assembly 
and/or the connectors on the back panel of the shelf assembly. 

Step 3 To verify that the tray has plugged into the assembly, look at the fan tray and listen to determine that the 
fans are running. Figure 1-15 shows the fan-tray assembly location on the ONS 15454 ETSI. Figure 1-16 
shows the fan-tray assembly location on the ONS 15454 ANSI.
1-41
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Chapter 1      Install the Shelf and Common Control Cards
DLP-  G19 Turn On and Verify Office Power
Figure 1-15 Installing the Fan-Tray Assembly on the ONS 15454 ETSI
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Figure 1-16 Installing the Fan-Tray Assembly on the ONS 15454 ANSI

Step 4 If you want to install an alarm expansion panel on the ONS 15454 ANSI shelf, continue with the 
“NTP-G9 Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-44. Otherwise, continue 
with the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on 
page 1-47.

Stop. You have completed this procedure. 
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NTP-G9 Install the Alarm Expansion Panel (ANSI Only)

Note The AIC-I card provides direct alarm contacts (external alarm inputs and external control outputs). In 
the ANSI shelf, these AIC-I alarm contacts are routed through the backplane to wire-wrap pins 
accessible from the back of the shelf. When you install an AEP, the direct AIC-I alarm contacts cannot 
be used. Only the AEP alarm contacts can be used. 

Step 1 Remove the two backplane screws. Replace the two screws with standoffs. Insert the longer standoff on 
the left, and the shorter standoff on the right (Figure 1-17). 

Purpose This procedure installs an AEP onto the 15454-SA-ANSI or 15454-SA-HD 
shelf backplane. The AEP provides alarm contacts (32 inputs, 16 outputs) 
in addition to the 16 provided by the AIC-I card. Typically, the AEP is 
preinstalled when ordered with the ONS 15454; however, the AEP can be 
ordered separately. The AIC-I card must be installed before you can 
provision the alarm contacts enabled by the AEP. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Wire wrapper

6-pair #29 AWG double-shielded cable

Standoffs (4)

Prerequisite Procedures DLP-G13 Remove the Lower Backplane Cover, page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 1-17 Replace Backplane Screws with Standoffs

Step 2 Attach the remaining two standoffs on either side of the backplane (Figure 1-18). 

Step 3 Position the AEP board over the standoffs.
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Figure 1-18 Installing Standoffs and the AEP

Step 4 Insert and tighten three screws to secure the AEP to the backplane.

Step 5 Connect the AEP cable to the backplane and AEP:

a. Connect the 10 colored wires to the wire-wrap pins on the backplane. Figure 1-19 shows where the 
cable wires are connected. Table 1-2 shows AEP and AIC-I signals that each wire carries

b. Plug the other end of the AEP cable into AEP connector port. The brown pin is on the top.

Figure 1-19 AEP Wire-Wrap Connections to Backplane Pins
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Step 6 Continue with the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” 
procedure on page 1-47.

Stop. You have completed this procedure. 

NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin 
Connections 

Caution Always use the supplied ESD wristband when working with a powered ONS 15454 ETSI. Plug the 
wristband cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Table 1-2 Pin Assignments for the AEP

AEP Cable Wire Backplane Pin AIC-I Signal AEP Signal

Black A1 GND AEP_GND

White A2 AE_+5 AEP_+5

Slate A3 VBAT– VBAT–

Violet A4 VB+ VB+

Blue A5 AE_CLK_P AE_CLK_P

Green A6 AE_CLK_N AE_CLK_N

Yellow A7 AE_DIN_P AE_DOUT_P

Orange A8 AE_DIN_N AE_DOUT_N

Red A9 AE_DOUT_P AE_DIN_P

Brown A10 AE_DOUT_N AE_DIN_N

Purpose This procedure installs alarm, timing, LAN, and craft wires on the 
ONS 15454 shelf. These wires are attached to the MIC FMECs on the ETSI 
shelf and attached to the backplane on the ANSI shelf.

Tools/Equipment Connectors according to function

Twisted 0.51 mm² or 0.64 mm² (#22 or #24 AWG) shielded wires for LAN 
or craft

75-ohm coaxial cable with 1.0/2.3 miniature coax connector

0.51 mm² or 0.64 mm² (#22 or #24 AWG) alarm wires

Prerequisite Procedures (ETSI only.) NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI 
Only), page 1-27

(ANSI only.) NTP-G5 Remove the Backplane Covers (ANSI Only), page 
1-26

Required/As Needed As needed 

Onsite/Remote Onsite

Security Level None
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Step 1 For an ONS 15454 ETSI shelf, complete the following tasks as necessary:

• Complete the “DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-48 if 
you want to provision external alarms and/or controls with the AIC-I card.

• Complete the “DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only)” task on page 1-51 if 
you are provisioning external timing.

• Complete the DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only), page 1-52 to create an 
external LAN connection. LAN wires or the LAN port on the TCC2 card are necessary to create an 
external LAN connection.

Step 2 For an ONS 15445 ANSI shelf, complete the following tasks as necessary:

• Complete the “DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-53 if 
you are using an AIC or AIC-I card and are not using an AEP.

• Complete the DLP-G24 Install Timing Wires on the Backplane (ANSI Only), page 1-56 if you are 
provisioning external timing.

• Complete the “DLP-G25 Install LAN Wires on the Backplane (ANSI Only)” task on page 1-57 to 
create an external LAN connection. LAN wires or the LAN port on the TCC2 card are necessary to 
create an external LAN connection.

• Complete the “DLP-G26 Install the TL1 Craft Interface (ANSI Only)” task on page 1-58 to access 
TL1 using the craft interface. Craft wires or the EIA/TIA-232 port on the TCC2 card are required to 
access TL1.

Stop. You have completed this procedure. 

DLP-G20 Install Alarm Wires on the MIC-A/P (ETSI Only)

Step 1 Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wires, connect the alarm and control wires on the 
appropriate pins of the DB-62 connector. The pin connectors, signal names, and functions are listed in 
Table 1-3. 

Purpose This task installs alarm cables on the MIC-A/P on the ONS 15454 ETSI so 
that you can provision external (environmental) alarms and controls with 
the AIC-I card.

Tools/Equipment DB-62 connector

0.51 mm² or 0.64 mm² (#22 or #24 AWG) wires

Prerequisite Procedures NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 
1-27

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Table 1-3 Alarm Pin Assignments

DB-62 Pin Connector Signal Name Function

1 ALMCUTOFF– Alarm cutoff

2 ALMCUTOFF+ Alarm cutoff

3 ALMINP0– Alarm input pair number 1

4 ALMINP0+ Alarm input pair number 1

5 ALMINP1– Alarm input pair number 2

6 ALMINP1+ Alarm input pair number 2

7 ALMINP2– Alarm input pair number 3

8 ALMINP2+ Alarm input pair number 3

9 ALMINP3– Alarm input pair number 4

10 ALMINP3+ Alarm input pair number 4

11 EXALM0– Extra alarm 0

12 EXALM0+ Extra alarm 0

13 FGND Ground

14 EXALM1– Extra alarm 1

15 EXALM1+ Extra alarm 1

16 EXALM2– Extra alarm 2

17 EXALM2+ Extra alarm 2

18 EXALM3– Extra alarm 3

19 EXALM3+ Extra alarm 3

20 EXALM4– Extra alarm 4

21 EXALM4+ Extra alarm 4

22 EXALM5– Extra alarm 5

23 EXALM5+ Extra alarm 5

24 EXALM6– Extra alarm 6

25 EXALM6+ Extra alarm 6

26 FGND Ground

27 EXALM7– Extra alarm 7

28 EXALM7+ Extra alarm 7

29 EXALM8– Extra alarm 8

30 EXALM8+ Extra alarm 8

31 EXALM9– Extra alarm 9

32 EXALM9+ Extra alarm 9

33 EXALM10– Extra alarm 10

34 EXALM10+ Extra alarm 10

35 EXALM11– Extra alarm 11

36 EXALM11+ Extra alarm 11
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Step 2 Connect the other end of the alarm and control wires according to local site practice. 

Step 3 Connect the DB-62 connector to the ALARM IN/OUT connector on the MIC-A/P faceplate.

Step 4 Tighten the screws of the connector on the alarm cable.

Step 5 Return to your originating procedure (NTP).

37 ALMOUP0– Normally open output pair number 1

38 ALMOUP0+ Normally open output pair number 1

39 FGND Ground

40 ALMOUP1– Normally open output pair number 2

41 ALMOUP1+ Normally open output pair number 2

42 ALMOUP2– Normally open output pair number 3

43 ALMOUP2+ Normally open output pair number 3

44 ALMOUP3– Normally open output pair number 4

45 ALMOUP3+ Normally open output pair number 4

46 AUDALM0– Normally open minor audible alarm

47 AUDALM0+ Normally open minor audible alarm

48 AUDALM1– Normally open major audible alarm

49 AUDALM1+ Normally open major audible alarm

50 AUDALM2– Normally open critical audible alarm

51 AUDALM2+ Normally open critical audible alarm

52 FGND Ground

53 AUDALM3– Normally open remote audible alarm

54 AUDALM3+ Normally open remote audible alarm

55 VISALM0– Normally open minor visible alarm

56 VISALM0+ Normally open minor visible alarm

57 VISALM1– Normally open major visible alarm

58 VISALM1+ Normally open major visible alarm

59 VISALM2– Normally open minor visible alarm

50 VISALM2+ Normally open minor visible alarm

61 VISALM3– Normally open minor visible alarm

62 VISALM3+ Normally open minor visible alarm

Table 1-3 Alarm Pin Assignments (continued)

DB-62 Pin Connector Signal Name Function
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DLP-G21 Install Timing Wires on the MIC-C/T/P (ETSI Only)

Step 1 Using coaxial cable with 1.0/2.3 miniature coax connectors, connect the clock cable to the appropriate 
connector on the faceplate of the MIC-C/T/P.

Step 2 Gently push the cable with the 1.0/2.3 miniature coax connector down until the cable connector slides 
into the 1.0/2.3 miniature coax connector on the faceplate with a click.

The MIC-C/T/P provides 1.0/2.3 miniature coax connectors that are used for timing input and output. 
The top connectors are for “A” (BITS-1) timing, and the bottom connectors are for “B” (BITS-2) timing. 
In each case, the left connector is the input and the right connector is the output. The input connectors 
for timing provide a 75-ohm termination. System cables are available that can convert timing clocks 
from 75 ohms to 100/120 ohms. Table 1-4 shows MIC-C/T/P pin assignments. 

A high-impedance option (> 3 kilo-ohms or greater) is possible through a jumper on the MIC-C/T/P 
FMEC. You can change the top timing input to high impedance by removing the jumper on P3 of the 
MIC-C/T/P FMEC. You can change the bottom timing input to high impedance by removing the jumper 
on P2 on the MIC-C/T/P FMEC. 

Note Refer to ITU-T G.813 for rules about provisioning timing references.

Step 3 Connect the other end of the cable to the external source of the timing signal according to Table 1-4.

Step 4 Repeat Step 3 for each cable that is required.

Step 5 Return to your originating procedure (NTP).

Purpose This task installs the timing cables on the ONS 15454 ETSI MIC-C/T/P.

Tools/Equipment 75-ohm coaxial cable with a 1.0/2.3 miniature coax connector on the 
MIC-C/T/P side

Prerequisite Procedures NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 
1-27

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-4 MIC-C/T/P Clock Connector Pin Assignment

Pin Function

IN 1 Input from external device

OUT 1 Output to external device

IN 2 Input from external device

OUT 2 Output to external device
1-51
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Chapter 1      Install the Shelf and Common Control Cards
DLP-  G22 Install LAN Wires on the MIC-C/T/P (ETSI Only)
DLP-G22 Install LAN Wires on the MIC-C/T/P (ETSI Only)

Note Rather than using the LAN connection port on the MIC-C/T/P, you can use the LAN connection port on 
the TCC2 card if preferred. Use either the MIC-C/T/P connection or the TCC2 card connection. You 
cannot use the LAN connection port on the MIC-C/T/P and the LAN connection port on the TCC2 card 
simultaneously; however, it is possible for you to make a direct connection from a computer to the LAN 
connection port on the TCC2 card while the LAN connection port on the MIC-C/T/P is in use as long as 
the computer connected directly to the TCC2 card is not connected to a LAN.

Step 1 Using 0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire or CAT-5 UTP Ethernet cable, connect the wires 
to the RJ-45 connector according to Table 1-5. 

Purpose This task installs the LAN wires on the ONS 15454 ETSI MIC-C/T/P.

Tools/Equipment Standard CAT-5 UTP Ethernet cable (straight-through for data terminating 
equipment [DTE] or cross-over for data circuit-terminating equipment 
[DCE])

or

RJ-45 connector

Crimping tool for RJ-45 connector

0.51 mm² or 0.64 mm² (#22 or #24 AWG) wire, preferably CAT-5 UTP

Prerequisite Procedures NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 
1-27

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-5 LAN Pin Assignments

LAN RJ-45 Pin RJ-45 Pin Function

LAN 1 
Connecting to DCE1

(a hub or switch)

Cross-over Ethernet cable

1 3 PNMSRX+
white/green

2 6 PNMSRX–
green

3 1 PNMSTX
white/orange

4 4 —

5 5 —

6 2 PNMSTX–
orange

7 7 —

8 8 —
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Step 2 Return to your originating procedure (NTP).

DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)

Step 1 Using 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 0.64 mm²) twisted-pair 
T1-type wires, wrap the alarm wires on the appropriate wire-wrap pins according to local site practice. 
Ground the shield of the BITS Input cable at the BITS end. For BITS Output, wrap the ground shield of 
the BITS cable to the frame ground pin (FG1) located below the column of BITS pins.

Figure 1-20 shows alarm pin assignments for the AIC-I in the Release 3.4 or higher ONS 15454 
backplane and Figure 1-21 calls out the external alarm pins on that backplane.

LAN 1
Connecting to DTE
(a PC/workstation or 
router)

Straight-through Ethernet 
cable

1 1 PNMSRX+
white/green

2 2 PNMSRX–
green

3 3 PNMSTX+
white/orange

4 4 —

5 5 —

6 6 PNMSTX–
orange

7 7 —

8 8 —

1. The Cisco ONS 15454 ETSI is DCE.

Purpose This task installs alarm wires on the backplane so that you can provision 
external (environmental) alarms and controls with the AIC or AIC-I card. 
If you are using the AEP, do not perform this task.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) wires

100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 
0.64 mm²), twisted-pair T1-type

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-5 LAN Pin Assignments (continued)

LAN RJ-45 Pin RJ-45 Pin Function
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Note The AIC-I requires a shelf assembly running Software Release 3.4.0 or later. The backplane of 
the ANSI shelf contains a wire-wrap field with pin assignment according to the layout in 
Figure 1-20. 
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Figure 1-20 Cisco ONS 15454 Backplane Pinouts (Release 3.4 or Later)
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Field Pin Function Field Pin Function

BITS A1 BITS Output 2 negative (–)   ENVIR
 ALARMS 
IN/OUT

N/O

A1/A13 Normally open output pair number 1

B1 BITS Output 2 positive (+) B1/B13

A2 BITS Input 2 negative (–) A2/A14 Normally open output pair number 2

B2 BITS Input 2 positive (+) B2/B14

A3 BITS Output 1 negative (–) A3/A15 Normally open output pair number 3

B3 BITS Output 1 positive (+) B3/B15

A4 BITS Input 1 negative (–) A4/A16 Normally open output pair number 4

B4 BITS Input 1 positive (+) B4/B16

LAN Connecting to a hub, or switch  ACO A1 Normally open ACO pair

A1 B1

B1 CRAFT A1 Receive (PC pin #2)

A2 A2  Transmit (PC pin #3)

B2 A3 Ground (PC pin #5)

A4 DTR (PC pin #4)

  LOCAL
ALARMS 

AUD
(Audible)

N/O

N/O

A1 Alarm output pair number 1: Remote 
audible alarm.B1 B1

 ENVIR
ALARMS 

IN

A2 Alarm output pair number 2: Critical 
audible alarm.B2

A3 Alarm output pair number 3: Major 
audible alarm.

A1

B3B1

A4 Alarm output pair number 4: Minor 
audible alarm.

A2

B4B2

 LOCAL
ALARMS 

VIS
(Visual)

A1 Alarm output pair number 1: Remote
visual alarm.

A3

B1

A2 Alarm output pair number 2:  Critical
visual alarm.B2

A3  Alarm output pair number 3: Major
visual alarm.B3

A4  Alarm output pair number 4: Minor 
visual alarm.B4

A1

A2

B3

A4

B4

RJ-45 pin 2 TX–

RJ-45 pin 1 TX+

RJ-45 pin 2 RX–

RJ-45 pin 1 RX+

RJ-45 pin 6 TX–

Alarm input pair number 1: Reports 
closure on connected wires.

Alarm input pair number 2: Reports 
closure on connected wires.

Alarm input pair number 3: Reports 
closure on connected wires.

Alarm input pair number 4: Reports
closure on connected wires.

A5

B5

Alarm input pair number 5: Reports
closure on connected wires.

A6

B6

Alarm input pair number 6: Reports
closure on connected wires.

A7

B7

Alarm input pair number 7: Reports
closure on connected wires.

A8

B8

Alarm input pair number 8: Reports
closure on connected wires.

A9

B9

Alarm input pair number 9: Reports
closure on connected wires.

A10

B10

Alarm input pair number 10: Reports
closure on connected wires.

A11

B11

Alarm input pair number 11: Reports
closure on connected wires.

A12

B12

Alarm input pair number 12: Reports
closure on connected wires.

Connecting to a PC/Workstation or router

RJ-45 pin 3 TX+B2

RJ-45 pin 3 RX+

RJ-45 pin 6 RX–

If you are using an 
AIC-I card, contacts 
provisioned as OUT 
are 1-4. Contacts 
provisioned as IN 
are 13-16.
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Figure 1-21 Highlighted Environmental Alarms

Note The X.25, Modem, and TBOS pin fields are not active on either pin field.

Step 2 Return to your originating procedure (NTP).

DLP-G24 Install Timing Wires on the Backplane (ANSI Only)

Step 1 Using 100-ohm shielded BITS clock cable #22 or #24 AWG (0.51 mm² or 0.64 mm²), twisted-pair 
T1-type, wrap the clock wires on the appropriate wire-wrap pins according to local site practice.

Ground the shield of the BITS input cable at the BITS end. For BITS output, wrap the ground shield of 
the BITS cable to the frame ground pin (FG1) located beneath the column of BITS pins. Table 1-6 lists 
the pin assignments for the BITS timing pin fields.
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Purpose This task installs the BITS timing wires on the ONS 15454 ANSI 
backplane.

Tools/Equipment Wire wrapper

100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² or 
0.64 mm²), twisted-pair T1-type

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 1-6 External Timing Pin Assignments for BITS

BITS Pin Tip/Ring CTC/TL1 Name Function

A4 ring BITS-1 Input from BITS device 1

B4 tip BITS-1 Input from BITS device 1

A3 ring BITS-1 Output to external device 1

B3 tip BITS-1 Output to external device 1

A2 ring BITS-2 Input from BITS device 2

B2 tip BITS-2 Input from BITS device 2
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Note For more detailed information about timing, see Chapter 18, “Security and Timing.” To set up 
system timing, see the “NTP-G53 Set Up Timing” procedure on page 5-4.

Step 2 Return to your originating procedure (NTP).

DLP-G25 Install LAN Wires on the Backplane (ANSI Only)

Note Rather than using the LAN wires, you can use the LAN connection port on the TCC2 if preferred. Use 
either the backplane connection or the TCC2 front connection. You cannot use the LAN backplane pins 
and the LAN connection port on the TCC2 simultaneously; however, it is possible for you to make a 
direct connection from a computer to the LAN connection port on the TCC2 while the LAN backplane 
pins are in use as long as the computer that is connected directly to the TCC2 is not connected to a LAN.

Step 1 Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire or CAT-5 UTP Ethernet cable, wrap the wires on 
the appropriate wire-wrap pins according to local site practice. 

Caution Cross talk might result if both receive (Rx) and transmit (Tx) pins connect on the same twisted pair of 
wires from the CAT-5 cable. The two Tx pins need to be on one twisted pair, and the two Rx pins need 
to be on another twisted pair.

A frame ground pin is located beneath each pin field (FG2 for the LAN pin field). Wrap the ground shield 
of the LAN interface cable to the frame ground pin. Table 1-7 shows the LAN pin assignments.

A1 ring BITS-2 Output to external device 2

B1 tip BITS-2 Output to external device 2

Table 1-6 External Timing Pin Assignments for BITS (continued)

BITS Pin Tip/Ring CTC/TL1 Name Function

Purpose This task installs the LAN wires on the ONS 15454 ANSI backplane.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, preferably CAT-5 UTP

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note The TCC2 does not support Ethernet polarity detection. If your Ethernet connection has 
incorrect polarity (this can only occur with cables that have the receive wire pairs flipped), a 
“Lan Connection Polarity Reversed” condition is raised. This condition usually occurs during an 
upgrade or initial node deployment. To correct the situation, ensure that your Ethernet cable has 
the correct mapping of the wire-wrap pins. 

Step 2 Return to your originating procedure (NTP).

DLP-G26 Install the TL1 Craft Interface (ANSI Only)

Note Rather than using the craft pins, you can use a LAN cable connected to the TCC2 EIA/TIA-232 port to 
access a TL1 craft interface. 

Step 1 Using #22 or #24 AWG (0.51 mm² or 0.64 mm²) wire, wrap the craft interface wires on the appropriate 
wire-wrap pins according to local site practice. 

Step 2 Wrap the ground shield of the craft interface cable to the frame-ground pin. 

Table 1-7 LAN Pin Assignments for the ONS 15454 ANSI Shelf

Pin Field Backplane Pins RJ-45 Pins Function/Color

LAN 1 
Connecting to data 
circuit-terminating 
equipment (DCE) (a hub or 
switch); the ONS 15454 is a 
DCE

B2 1 TX+ white/green

A2 2 TX– green

B1 3 RX+ white/orange

A1 6 RX– orange

LAN 1
Connecting to data terminal 
equipment (DTE) (a 
PC/workstation or router)

B1 1 RX+ white/green

A1 2 RX– green

B2 3 TX+ white/orange

A2 6 TX– orange

Purpose This task installs the TL1 craft interface on the ONS 15454 ANSI shelf 
using the craft backplane pins. You can also use a LAN cable connected to 
the TCC2 EIA/TIA-232 port to access a TL1 craft interface.

Tools/Equipment Wire wrapper

#22 or #24 AWG (0.51 mm² or 0.64 mm²) alarm wires

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Wrap the ground wire of your computer cable to pin A3 on the craft pin field. Table 1-8 shows the pin 
assignments for the CRAFT pin field.

Note You cannot use the craft backplane pins and the EIA/TIA-232 port on the TCC2 card 
simultaneously. Using a combination prevents access to the node or causes a loss in connectivity.

Step 3 Return to your originating procedure (NTP).

NTP-G11 Install an External Wire-Wrap Panel on the AEP 
(ANSI Only)

Step 1 Position the lower cover over the AEP. Make sure that the AEP AMP Champ connectors protrude 
through the cutouts in the lower cover (Figure 1-22). 

Table 1-8 Craft Interface Pin Assignments

Pin Field Contact Function

Craft A1 Receive

A2 Transmit

A3 Ground

A4 DTR

Purpose This procedure connects an external wire-wrap panel to the ONS 15454 
ANSI AEP to provide the physical alarm contacts for the AEP. 

Tools/Equipment External wire-wrap panel

Prerequisite Procedures NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-44

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 1-22 Installing the AEP Cover

Step 2 Insert and tighten the eight screws to secure the AEP cover to the AEP. 

Step 3 Connect the cables from the external wire-wrap panel to the AMP Champ connectors on the AEP. 
Table 1-9 lists the alarm input pin assignments. 

Table 1-9 Alarm Input Pin Assignments

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

1 ALARM_IN_1– 27 GND

2 GND 28 ALARM_IN_2–

3 ALARM_IN_3– 29 ALARM_IN_4–

4 ALARM_IN_5– 30 GND

5 GND 31 ALARM_IN_6–

6 ALARM_IN_7– 32 ALARM_IN_8–

7 ALARM_IN_9– 33 GND

8 GND 34 ALARM_IN_10–

9 ALARM_IN_11– 35 ALARM_IN_12–

10 ALARM_IN_13– 36 GND

11 GND 37 ALARM_IN_14–

12 ALARM_IN_15– 38 ALARM_IN_16–

7
8
4
0
4
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Table 1-10 lists the alarm output (external control) pin assignments. 

13 ALARM_IN_17– 39 GND

14 GND 40 ALARM_IN_18–

15 ALARM_IN_19– 41 ALARM_IN_20–

16 ALARM_IN_21– 42 GND

17 GND 43 ALARM_IN_22–

18 ALARM_IN_23– 44 ALARM_IN_24–

19 ALARM_IN_25– 45 GND

20 GND 46 ALARM_IN_26–

21 ALARM_IN_27– 47 ALARM_IN_28–

22 ALARM_IN_29– 48 GND

23 GND 49 ALARM_IN_30–

24 ALARM_IN_31– 50 —

25 ALARM_IN_+ 51 GND1

26 ALARM_IN_0- 52 GND2

Table 1-9 Alarm Input Pin Assignments (continued)

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

Table 1-10 Alarm Output Pin Assignments

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

1 — 27 COM_0

2 COM_1 28 —

3 NO_1 29 NO_2

4 — 30 COM_2

5 COM_3 31 —

6 NO_3 32 NO_4

7 — 33 COM_4

8 COM_5 34 —

9 NO_5 35 NO_6

10 — 36 COM_6

11 COM_7 37 —

12 NO_7 38 NO_8

13 — 39 COM_8

14 COM_9 40 —

15 NO_9 41 NO_10

16 — 42 COM_10

17 COM_11 43 —
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Figure 1-23 illustrates the alarm input connectors. 

Figure 1-23 Alarm Input Connector

Figure 1-24 illustrates the alarm output connectors. 

18 NO_11 44 NO_12

19 — 45 COM_12

20 COM_13 46 —

21 NO_13 47 NO_14

22 — 48 COM_14

23 COM_15 49 —

24 NO_15 50 —

25 — 51 GND1

26 NO_0 52 GND2

Table 1-10 Alarm Output Pin Assignments (continued)

AMP Champ Pin Signal Name AMP Champ Pin Signal Name

ALARM_IN_8-
XREF=5

Connector
Alarm Input

GND

ALARM_IN_0-XREF=5

XREF=5 ALARM_IN_2-XREF=5ALARM_IN_3-
XREF=5 ALARM_IN_4-XREF=5

ALARM_IN_5-

ALARM_IN_6-
XREF=5

ALARM_IN_7-
XREF=5
XREF=5ALARM_IN_9-

XREF=5
ALARM_IN_10-

XREF=5ALARM_IN_11-
XREF=5

ALARM_IN_12-
XREF=5ALARM_IN_13-

XREF=5
ALARM_IN_14-

XREF=5ALARM_IN_15-
XREF=6

ALARM_IN_16-
XREF=6

ALARM_IN_17-

XREF=6
ALARM_IN_18-

XREF=6
ALARM_IN_19- XREF=6 ALARM_IN_20-ALARM_IN_21- XREF=6

XREF=6 ALARM_IN_22-
XREF=6

ALARM_IN_24-
XREF=6

ALARM_IN_25-

XREF=6
ALARM_IN_26-

XREF=6
ALARM_IN_27- XREF=6 ALARM_IN_28-XREF=6
ALARM_IN_29-

XREF=6
ALARM_IN_30-

XREF=6ALARM_IN_31-
XREF=5ALARM_IN_+

GND

GND1

GND252

51

9
8
7
6

50

5

49
48
47
46
45
44
43
42
41
40

4

39
38
37
36
35
34
33
32
31
30

3
29
28
27
26

25
24
23
22
21
20

2

19
18
17
16
15
14
13
12
11
10

1

P3

XREF=6ALARM_IN_23-

ALARM_IN_1- XREF=5

79
87

5
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Figure 1-24 Alarm Output Connector

Step 4 Continue with the “NTP-G12 Install and Close the FMEC Cover (ETSI Only)” procedure on page 1-63 
as needed.

Stop. You have completed this procedure. 

NTP-G12 Install and Close the FMEC Cover (ETSI Only)

Step 1 Insert the cover carefully onto the left pin of the hinge (Figure 1-25).

Step 2 Move the cover to the right side towards the right pin of the hinge.

NO_5 XREF=7
COM_5 XREF=7

NO_3 XREF=7
COM_3 XREF=7

COM_14XREF=7
NO_14XREF=7

XREF=7 COM_12
NO_12XREF=7

COM_10XREF=7
NO_10XREF=7

COM_8XREF=7
NO_8XREF=7

COM_6XREF=7
NO_6XREF=7

COM_4XREF=7
NO_4XREF=7

COM_2XREF=7

NO_1 XREF=7

NO_2XREF=7

COM_0XREF=7
NO_0XREF=7

NO_15 XREF=7
COM_15

XREF=7

NO_13 XREF=7
COM_13 XREF=7

COM_1 XREF=7

NO_11 XREF=7
COM_11

XREF=7

NO_9 XREF=7
COM_9 XREF=7

NO_7 XREF=7
COM_7 XREF=7

Connector
Alarm Output

GND1

GND2

1

10
11
12
13
14
15
16
17
18
19

2

20
21
22
23
24
25

26
27
28
29

3

30
31
32
33
34
35
36
37
38
39

4

40
41
42
43
44
45
46
47
48
49

5

50

6
7
8
9

51

52

P4

79
87

6

Purpose This procedure installs and closes the ONS 15454 ETSI FMEC cover.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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Step 3 Pull the right side of the hinge-locking spring (Figure 1-25). Push the cover onto the right pin until the 
spring snaps into place. 

Figure 1-25 ONS 15454 ETSI FMEC Cover 

Step 4 Attach the ground wire to the shelf. 

Step 5 Attach the washer and nut.

Step 6 Attach the cover to the shelf using the screws on the top of the cover. 

Step 7 Continue with the “NTP-G14 Install DWDM Equipment” procedure on page 1-66.

Stop. You have completed this procedure. 

71
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FAN FAIL
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FMEC cover

Hinge-locking
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1-64
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Chapter 1      Install the Shelf and Common Control Cards
DLP-  G26 Install the TL1 Craft Interface (ANSI Only)
NTP-G13 Install the Rear Cover (ANSI Only)

Step 1 Locate the three screws that run vertically along on each side of the backplane (Figure 1-26). 

Figure 1-26 Backplane Attachment for the Rear Cover

Tip Only six screws (three on each side) line up with the screw slots on the mounting brackets, 
making the screws easy to locate.

Step 2 Loosen the top and bottom screws on one edge of the backplane to provide room to slide the mounting 
brackets into place using the U-shaped screw slots on each end.

Step 3 Slide one of the mounting brackets into place and tighten the screws. 

Step 4 Repeat Steps 2 and 3 for the second mounting bracket.

Step 5 Attach the cover by hanging it from the mounting screws on the back of the mounting brackets and 
pulling it down until it fits snugly into place.

Purpose The following procedure explains how to install the rear cover on an 
ONS 15454 ANSI shelf.

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None

32
07

3

Screw locations
for attaching the

rear cover
1-65
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Chapter 1      Install the Shelf and Common Control Cards
DLP-  G26 Install the TL1 Craft Interface (ANSI Only)
Figure 1-27 shows rear cover installation using spacers.

Figure 1-27 Installing the Rear Cover with Spacers

Step 6 Continue with the “NTP-G14 Install DWDM Equipment” procedure on page 1-66.

Stop. You have completed this procedure. 

NTP-G14 Install DWDM Equipment

Step 1 Complete the “DLP-G27 Install the DCU Shelf Assembly” task on page 1-67 as needed. 

Step 2 Complete the “DLP-G28 Install the Fiber Patch Panel Shelf” task on page 1-68 as needed.

Step 3 Complete the “DLP-G29 Install the Fiber Storage Shelf” task on page 1-68 as needed.

Step 4 Complete the “DLP-G8 Install the Air Ramp” task on page 1-19 as needed.
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Purpose This procedure installs the optional DWDM assemblies. 

Tools/Equipment #2 Phillips screwdriver

Crimping tool (large enough for #10 to #14 AWG)

#14 AWG wire

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 5 Complete the “DLP-G30 Install the FlexLayer Shelf” task on page 1-69 as needed. 

Note Procedures for installing FlexLayer hardware in this chapter require that you have a network 
plan calculated for your DWDM network with Cisco MetroPlanner, Release 2.5. MetroPlanner 
is a DWDM planning tool that is available your Cisco account representative. MetroPlanner 
prepares a shelf plan for each network node and calculates the power and attenuation levels for 
the DWDM cards installed in the node. For information about Cisco MetroPlanner, refer to the 
Cisco MetroPlanner DWDM Operations Guide, Release 2.5.

Step 6 Complete the “DLP-G31 Install the FlexLayer Modules” task on page 1-69 as needed.

Step 7 Complete the “DLP-G32 Install the Y-Cable Protection Modules” task on page 1-71 as needed.

Stop. You have completed this procedure.

DLP-G27 Install the DCU Shelf Assembly

Step 1 The DCU chassis requires 1 rack unit (RU) in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) 
rack. Locate the RMU space specified in your site plan. See the “13.5 Typical DWDM Rack Layouts” 
section on page 13-16 for common site layout plans.

Step 2 Two sets of mounting brackets are included with the DCU mounting kit, one set each for 19-inch 
(482.6-mm) or 23-inch (584.2-mm) racks. Verify that your chassis is equipped with the correct set of 
brackets for your rack. Change the brackets as required.

Step 3 Align the chassis with the rack mounting screw holes; one at a time, insert and tighten the four screws.

Warning This equipment must be properly grounded per local standards and in compliance with Network 
Equipment Building Standard (NEBS) requirements. If not properly grounded, personal injury or 
equipment failure could occur.

Step 4 Connect a frame ground to the ground terminal provided on either side of the chassis. Use minimum 
#14 AWG wire.

Step 5 Return to your originating procedure (NTP).

Purpose If you are installing dispersion compensation modules, use this task to 
install the Dispersion Compensation Unit (DCU) chassis.

Tools/Equipment #2 Phillips screwdriver

Crimping tool

#14 AWG wire and lug

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-G28 Install the Fiber Patch Panel Shelf

Step 1 The fiber patch panel shelf requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. 
Locate the RMU space specified in your site plan. See the “13.5 Typical DWDM Rack Layouts” section 
on page 13-16 for common site configurations.

Step 2 Verify that the mounting brackets attached to the unit are correct for your rack size. Complete “DLP-G3 
Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as 
required.

Step 3 Align the chassis with the rack mounting screw holes, then insert and tighten the four screws.

Step 4 Return to your originating procedure (NTP).

DLP-G29 Install the Fiber Storage Shelf 

Step 1 The fiber storage shelf requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. 
Locate the RMU space specified in your site plan. See the “13.5 Typical DWDM Rack Layouts” section 
on page 13-16 for common site configurations. 

Step 2 Verify that the mounting brackets attached to the unit are correct for your rack size. Complete “DLP-G3 
Reverse the Mounting Bracket to Fit a 19-inch (482.6-mm) Rack (ANSI Only)” task on page 1-10 as 
required.

Step 3 Align the chassis with the rack mounting screw holes, insert the screws (4) and tighten.

Step 4 Return to your originating procedure (NTP).

Purpose This task installs the fiber patch panel shelf.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task installs the fiber storage shelf.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-G30 Install the FlexLayer Shelf

Step 1 The FlexLayer shelf requires 1 RU in a standard 19-inch (482.6-mm) or 23-inch (584.2-mm) rack. 
Locate the RMU space specified in your site plan. Refer to Chapter 13, “Shelf Hardware Reference” for 
typical DWDM site layout plans.

Step 2 A set of mounting brackets are included with the FlexLayer mounting kit, one set each for 19-inch 
(482.6-mm) or 23-inch (584.2-mm) racks. Verify that your chassis is equipped with the correct set of 
brackets for your rack. Change the brackets as required.

Step 3 Align the chassis with the rack mounting screw holes; one at a time, insert and tighten the three screws.

Step 4 Repeat this task as necessary for each FlexLayer shelf assembly you want to install.

Step 5 Return to your originating procedure (NTP).

DLP-G31 Install the FlexLayer Modules

Step 1 Determine the FlexLayer modules that you want to install in the FlexLayer shelf. The FlexLayer shelf 
can house up to four Add/Drop FlexLayer modules. Table 1-11 lists the two-channel FlexLayer modules 
and part numbers. Refer to Chapter 13, “Shelf Hardware Reference” for more information about 
FlexLayer modules.

Purpose This task installs the FlexLayer shelf. Perform this task if you are 
installing any FlexLayer modules or are protecting more than two channels 
with Y-cable protection modules.

Tools/Equipment #2 Phillips screwdriver

FlexLayer shelf assembly (15216-FL-SA)

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Purpose This task installs the FlexLayer modules in the FlexLayer shelf assembly. 
You can only install two-channel FlexLayer modules.

Tools/Equipment #2 Phillips screwdriver

FlexLayer modules

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 2 Insert the appropriate module into the FlexLayer shelf assembly. 

Note FlexLayer modules are not listed in generated Cisco MetroPlanner 2.5 site plans.

Step 3 Use a Phillips screwdriver to install the two accompanying screws.

Figure 1-28 shows the FlexLayer shelf assembly and how the FlexLayer modules can be installed. 

Table 1-11 ONS 15xxx FlexLayer Hardware Part Numbers

Part Number Description

2 Channel Add/Drop FlexLayer Modules

15216-FLB-2-31.1= ITU-100 GHz 2 Ch, FlexMod - 1530.33 and 1531.12

15216-FLB-2-32.6= ITU-100 GHz 2 Ch, FlexMod - 1531.90 and 1532.68

15216-FLB-2-35.0= ITU-100 GHz 2 Ch, FlexMod - 1534.25 and 1535.04

15216-FLB-2-36.6= ITU-100 GHz 2 Ch, FlexMod - 1535.82 and 1536.61

15216-FLB-2-38.9= ITU-100 GHz 2 Ch, FlexMod - 1538.19 and 1538.98

15216-FLB-2-40.5= ITU-100 GHz 2 Ch, FlexMod - 1539.77 and 1540.56

15216-FLB-2-42.9= ITU-100 GHz 2 Ch, FlexMod - 1542.14 and 1542.94

15216-FLB-2-44.5= ITU-100 GHz 2 Ch, FlexMod - 1543.73 and 1544.53

15216-FLB-2-46.9= ITU-100 GHz 2 Ch, FlexMod - 1546.12 and 1546.92

15216-FLB-2-48.5= ITU-100 GHz 2 Ch, FlexMod - 1547.72 and 1548.51

15216-FLB-2-50.9= ITU-100 GHz 2 Ch, FlexMod - 1550.12 and 1550.92

15216-FLB-2-52.5= ITU-100 GHz 2 Ch, FlexMod - 1551.72 and 1552.52

15216-FLB-2-54.9= ITU-100 GHz 2 Ch, FlexMod - 1554.13 and 1554.94

15216-FLB-2-56.5= ITU-100 GHz 2 Ch, FlexMod - 1555.75 and 1556.55

15216-FLB-2-58.9= ITU-100 GHz 2 Ch, FlexMod - 1558.17 and 1558.98

15216-FLB-2-60.6= ITU-100 GHz 2 Ch, FlexMod - 1559.79 and 1560.61
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Figure 1-28 ONS 15xxx FlexLayer Shelf Assembly

Step 4 Repeat this task as necessary for each FlexLayer module you want to install.

Step 5 Return to your originating procedure (NTP).

DLP-G32 Install the Y-Cable Protection Modules

Step 1 Determine the Y-cable modules that you want to install in the FlexLayer shelf. 

Step 2 Insert the appropriate Y-cable module into the FlexLayer shelf assembly. Use a Phillips screwdriver to 
install the two accompanying screws.

Step 3 Repeat this task as necessary for each Y-cable module you want to install.

Step 4 Return to your originating procedure (NTP).

Purpose This task installs the Y-Cable Protection modules in the FlexLayer shelf 
assembly. 

Tools/Equipment #2 Phillips screwdriver

Y-Cable modules:

• Multi-Mode Y Cable Protection FlexMod: 15216-CS-MM-Y=

• Single-Mode Y Cable Protection FlexMod: 15216-CS-SM-Y=

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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NTP-G15 Install the Common Control Cards

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool due to electrical hazard.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside to edge of the shelf assembly.

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Complete the “DLP-G33 Install the TCC2 Card” task on page 1-73.

Figure 1-29 shows card installation in an ONS 15454 ETSI shelf. 

Purpose This procedure describes how to install the common control cards. 

Tools/Equipment Redundant TCC2 cards

AIC card (optional, ANSI only)

AIC-I card (optional)

Prerequisite Procedures NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G14 Install DWDM Equipment, page 1-66

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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Figure 1-29 Installing Cards in the ONS 15454 ETSI

Note If you install the wrong card in a slot, see the “NTP-G107 Remove and Replace DWDM Cards” 
procedure on page 11-12.

Step 2 Complete the DLP-G34 Install the AIC or AIC-I Card, page 1-76, if necessary.

Step 3 Continue with the “NTP-G16 Perform the Shelf Installation Acceptance Test” procedure on page 1-77.

DLP-G33 Install the TCC2 Card 

61
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Purpose This task installs redundant TCC2 cards. The first card you install in the 
ONS 15454  must be a TCC2 card, and it must initialize before you install 
any cross-connect or traffic cards. 

Tools/Equipment Two TCC2 cards

Prerequisite Procedures None

Required/As Needed Required 

Onsite/Remote Onsite

Security Level None
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Note When installing cards, allow each card to boot completely before installing the next card.

Step 1 Open the latches/ejectors of the first TCC2 card that you will install. 

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 7 or 11). 

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the back 
panel of the shelf assembly. Ensure that you cannot insert the card any further. 

If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Step 4 Verify the LED activity of the TCC2 card:

• All LEDs turn on briefly. 

• The red FAIL LED, the yellow ACT/STBY LED, the red REM LED, the green SYNC LED, and the 
green ACO LED turn on for about 10 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds. 

• The red FAIL LED blinks for about 10 seconds.

• The red FAIL LED turns on for about 5 seconds.

• Both green PWR LEDs turn on for 5 seconds. The PWR LEDs then turn red for 2 to 3 minutes before 
going to steady green.

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off 
for about 10 seconds.

• The ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to turn on while 
the DCC processor boots.)

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into the Cisco Transport 
Controller (CTC) and can view the Alarms tab.

Note If the FAIL LED is on continuously, see the tip on page 75 about the TCC2 card automatic 
upload.

Step 5 Verify that the ACT/STBY LED is green for active. The IP address for the node, the temperature of the 
ONS 15454, and the time of day should appear on the LCD. The default time and date is 12:00 AM, 
January 1, 1970. 

Step 6 Verify that the correct software version appears on the LCD. (The LCD cycles through the IP address, 
node name, and software version.)

Step 7 If the LCD shows the correct software version, continue with Step 8. If the LCD does not show the 
correct software version, upgrade the software or remove the TCC2 card and install a replacement card. 

To replace the software, refer to the specific software upgrade document for your release. 

Step 8 Open the latches/ejectors of the redundant TCC2 card. 
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Step 9 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 7 or 11). 

Step 10 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the back 
panel of the shelf assembly. Ensure that you cannot insert the card any further. 

Step 11 Verify the LED activity of the redundant TCC2 card:

• All LEDs turn on for a short moment. 

• The red FAIL LED, the yellow ACT/STBY LED, the red REM LED, the green SYNC LED, and the 
green ACO LED turn on for about 10 seconds. 

• The red FAIL LED and the green ACT/STBY LED turn on for about 40 seconds. 

• The red FAIL LED blinks for about 10 seconds.

• The red FAIL LED turns on for about 5 seconds.

• All LEDs (including the CRIT, MAJ, MIN, REM, SYNC, and ACO LEDs) blink once and turn off 
for about 10 seconds.

• The ACT/STBY LED turns on. (The ACT/STBY LED might take several minutes to turn on while 
the DCC processor boots.) 

Tip If you install a standby TCC2 card that has a different software version than the active TCC card, 
the newly installed standby TCC2 card automatically copies the software version from the active 
TCC2 card. You do not need to do anything in this situation. However, the loading TCC2 card 
does not boot up in the normal manner. When the standby card is first inserted, the LEDs follow 
most of the sequence listed in Step 11. After the red FAIL LED turns on for about 5 seconds, the 
FAIL LED and the ACT/STBY LED begin to flash alternately for up to 30 minutes while the 
new software loads onto the active TCC2 card. After loading the new software, the upgraded 
TCC2 card’s LEDs repeat the sequence from Step 11, and the amber ACT/STBY LED turns on.

Note If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

Note Alarm LEDs might be on; disregard alarm LEDs until you are logged into CTC and can view 
the Alarms tab.

Step 12 Verify that the ACT/STBY LED is amber for standby. 

Step 13 Return to your originating procedure (NTP).
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DLP-G34 Install the AIC or AIC-I Card

Note When installing cards, allow each card to boot completely before installing the next card.

Note The AIC card is not compatible with the ONS 15454 ETSI. The ONS 15454 ETSI supports the AIC-I 
card.

Step 1 Open the latches/ejectors on the card.

Step 2 Use the latches/ejectors to firmly slide the card along the guide rails until the card plugs into the 
receptacle at the back of the slot (Slot 9). 

Step 3 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 4 If you have installed the AIC card, verify the following:

• The red FAIL LED turns on for 1 second, then blinks for 1 to 5 seconds.

• After 1 to 5 seconds, all LEDs blink once and turn off.

• The ACT LED turns on. 

Step 5 If you have installed the AIC-I card, verify the following:

• The red FAIL LED turns on for 1 second, then blinks for 1 to 5 seconds.

• The PWR A and PWR B LEDs become red and the two INPUT/OUTPUT LEDs become green for 
approximately 3 seconds.

• The PWR A LED turns green, the INPUT/OUTPUT LEDs turn off, and the ACT LED turns on.

Note It might take up to 3 minutes for the PWR A and PWR B LEDs to update.

Note If the red FAIL LED does not turn on, check the power. 

Note If you insert a card into a slot provisioned for a different card, no LEDs turn on. 

Purpose This task installs the AIC or AIC-I card. The AIC or AIC-I card provides 
connections for external alarms and controls (environmental alarms). 

Tools/Equipment AIC or AIC-I card

Prerequisite Procedures DLP-G33 Install the TCC2 Card, page 1-73

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note If the red FAIL LED is on continuously or the LEDs act erratically, the card is not installed 
properly. Remove the card and repeat Steps 1 to 5. 

Step 6 Return to your originating procedure (NTP).

NTP-G16 Perform the Shelf Installation Acceptance Test 

Step 1 If you installed an ONS 15454 ETSI shelf, complete Table 1-12 by verifying that each applicable 
procedure was completed. 

Step 2 If you installed an ONS 15454 ANSI shelf, complete Table 1-13 by verifying that each applicable 
procedure was completed. 

Purpose Use this procedure to perform a shelf installation acceptance test for the 
ONS 15454 ETSI and ONS 15454 ANSI.

Tools/Equipment Voltmeter

Oval and/or block ferrites

Prerequisite Procedures Applicable procedures in Chapter 1, “Install the Shelf and Common 
Control Cards”

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Table 1-12 ONS 15454 ETSI Shelf Installation Task Summary

Description Completed

NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G3 Open and Remove the Front Door, page 1-20

NTP-G4 Open and Remove the FMEC Cover (ETSI Only), page 1-23

NTP-G6 Install the MIC-A/P and MIC-T/C/P FMECs (ETSI Only), page 1-27

NTP-G7 Install the Power and Ground, page 1-30

NTP-G8 Install the Fan-Tray Assembly, page 1-40

NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 
1-47

NTP-G12 Install and Close the FMEC Cover (ETSI Only), page 1-63

NTP-G14 Install DWDM Equipment, page 1-66

NTP-G15 Install the Common Control Cards, page 1-72
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Step 3 Complete the “DLP-G35 Inspect the Shelf Installation and Connections” task on page 1-78.

Step 4 Complete the “DLP-G36 Measure Voltage” task on page 1-79.

Step 5 Continue with Chapter 2, “Connect the PC and Log into the GUI.”

Stop. You have completed this procedure. 

DLP-G35 Inspect the Shelf Installation and Connections 

Step 1 Check each wire and cable connection to make sure all cables are locked securely. If a wire or cable is 
loose, return to the appropriate procedure in this chapter to correct it.

Step 2 To check that the front door is seated correctly, verify that it can be easily closed without disturbing fiber 
or Ethernet patch cords.

Step 3 To check that the FMEC cover is seated correctly, verify that it can be easily closed without disturbing 
cables.

Table 1-13 ONS 15454 ANSI Shelf Installation Task Summary

Description Completed

NTP-G1 Unpack and Inspect the Shelf Assembly, page 1-6

NTP-G2 Install the Shelf Assembly, page 1-8

NTP-G3 Open and Remove the Front Door, page 1-20

NTP-G5 Remove the Backplane Covers (ANSI Only), page 1-26

NTP-G7 Install the Power and Ground, page 1-30

NTP-G8 Install the Fan-Tray Assembly, page 1-40

NTP-G9 Install the Alarm Expansion Panel (ANSI Only), page 1-44

NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections, page 
1-47

NTP-G11 Install an External Wire-Wrap Panel on the AEP (ANSI Only), page 1-59

NTP-G13 Install the Rear Cover (ANSI Only), page 1-65

NTP-G14 Install DWDM Equipment, page 1-66

NTP-G15 Install the Common Control Cards, page 1-72

Purpose Use this task to inspect the shelf installation and connections and verify that 
everything is installed and connected properly.

Tools/Equipment None

Prerequisite Procedures Complete Table 1-12 on page 1-77 (ETSI) or Table 1-13 on page 1-78 
(ANSI).

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-  G36 Measure Voltage
Step 4 Return to your originating procedure (NTP).

DLP-G36 Measure Voltage 

Step 1 Using a voltmeter, verify the office ground and power:

a. Place the black lead (positive) on the frame ground on the bay. Hold it there while completing Step b.

b. Place the red lead (negative) on the fuse power points on the third-party power distribution panel to 
verify that they read between –40.5 VDC and –57 VDC (power) and 0 (return ground).

Step 2 Using a voltmeter, verify the shelf ground and power wiring:

a. Place the black lead (positive) on the RET1 and the red lead on the BAT1 point. Verify a reading 
between –40.5 VDC and –57 VDC. If there is no voltage, check the following and correct if 
necessary:

• Battery and ground are reversed to the shelf.

• Battery is open or missing.

• Return is open or missing.

Step 3 Repeat Step 1 and Step 2 for the RET2 and BAT2 of the redundant power supply input.

Step 4 Return to your originating procedure (NTP).

Purpose Use this task to measure the power to verify correct power and returns.

Tools/Equipment Voltmeter

Prerequisite Procedures Complete Table 1-12 on page 1-77 (ESTSI) or Table 1-13 on page 1-78 
(ANSI).

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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September 2004
C H A P T E R 2

Connect the PC and Log into the GUI

This chapter explains how to connect PCs and workstations to the Cisco ONS 15454 and how to log into 
Cisco Transport Controller (CTC) software, which is the ONS 15454 Operation, Administration, 
Maintenance and Provisioning (OAM&P) user interface. Procedures for connecting to the ONS 15454 
ANSI using TL1 are provided in the Cisco ONS 15454 and Cisco ONS 15327 TL1 Command Guide, 
Release 4.6.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G17 Set Up Computer for CTC, page 2-2—Complete this procedure if your PC or workstation 
has never been connected to an ONS 15454.

2. NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 
2-9—Complete this procedure to set up your computer for an onsite craft connection to the 
ONS 15454.

3. NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 
2-20—Complete this procedure to set up your computer to connect to the ONS 15454 using a 
corporate LAN.

4. NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-22—Complete this 
procedure to set up your computer for remote modem access to the ONS 15454.

5. NTP-G21 Log into the ONS 15454 GUI, page 2-23—Complete this procedure to log into CTC.
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NTP-G17 Set Up Computer for CTC
NTP-G17 Set Up Computer for CTC

Note JRE 1.4.2 is required to log into nodes running Release 4.7. To log into nodes running Release 4.5 or 
earlier, you must uninstall JRE 1.4.1 and install JRE 1.3.1_2. 

Step 1 If your computer does not have an appropriate browser installed, complete the following:

• To install Netscape 7.x, download the browser at the following site: 
http://channels.netscape.com/ns/browsers/default.jsp

• To install Internet Explorer 6.x on a PC, download the browser at the following site: 
http://www.microsoft.com

Step 2 If your computer is a Windows PC, complete the “DLP-G37 Run the CTC Installation Wizard for 
Windows” task on page 2-3, then go to Step 4.

Step 3 If your computer is a UNIX workstation, complete the “DLP-G38 Run the CTC Installation Wizard for 
UNIX” task on page 2-6.

Step 4 When your PC or workstation is set up, continue with the setup procedure appropriate to your network: 

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the ONS 15454, page 2-9

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection to the ONS 15454, page 2-20

• NTP-G20 Set Up a Remote Access Connection to the ONS 15454, page 2-22

Note Cisco recommends that you configure your browser to disable the caching of user IDs/passwords on 
computers used to access Cisco optical equipment. 

In Internet Explorer, choose Tools > Internet Options > Content. Click Auto Complete and uncheck 
the User names and passwords on forms option. 

In Netscape 7.0, choose Edit > Preferences > Privacy & Security > Forms and uncheck the option to 
save form data. For passwords, choose Edit > Preferences > Privacy & Security > Passwords and 
uncheck the option to remember passwords. Note that passwords can be stored in an encrypted format. 
Netscape versions earlier than 6.0 do not cache user IDs and passwords.

Stop. You have completed this procedure.

Purpose This procedure configures your PC or UNIX workstation to run CTC. 

Tools/Equipment Cisco ONS 15454 Release 4.7 software or documentation CD

Prerequisite Procedures DLP-G33 Install the TCC2 Card, page 1-73

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level None
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DLP-G37 Run the CTC Installation Wizard for Windows

Note If you will log into nodes running CTC software earlier than Release 4.6, uninstall JRE 1.4.2 and 
reinstall JRE 1.3.1_2. To run R4.7, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

Note JRE 1.4.2 requires Netscape 7.x or Internet Explorer 6.x

Step 1 Verify that your computer has the following:

• Processor—Pentium III, 700 Mhz or faster

• RAM—384 MB recommended, 512 MB optimum

• Hard drive—20 GB hard drive recommended with at least 50 MB of space available

• Operating system—Windows 98 (1st and 2nd editions), Windows NT 4.0 (with Service Pack 6a), 
Windows 2000 (with Service Pack 3), or Windows XP Home

If your operating system is Windows NT 4.0, verify that Service Pack 6a or later is installed. From 
the Start menu, choose Programs > Administrative Tools > Windows NT Diagnostics and check 
the service pack on the Version tab of the Windows NT Diagnostics dialog box. If Service Pack 6a 
or later is not installed, do not continue. Install Service Pack 6a following the computer upgrade 
procedures for your site.

Note Processor and RAM requirements are guidelines. CTC performance is faster if your 
computer has a faster processor and more RAM. 

Step 2 Insert the Cisco ONS 15454 Release 4.7 software or documentation CD into your computer CD drive. 
The installation program begins running automatically. If it does not start, navigate to the CD directory 
and double-click setup.exe.

The Cisco Transport Controller Installation Wizard displays the components that will be installed on 
your computer:

• Java Runtime Environment 1.4.2

• Acrobat Reader 6.0.1

• Online User Manuals

Purpose This task installs the CTC online user manuals, Acrobat Reader 6.0.1, and 
JRE 1.4.2 on a Windows computer, as necessary. JRE 1.4.2 is required to 
run Release 4.7.

Tools/Equipment Cisco ONS 15454 Release 4.7 software or documentation CD

Prerequisite Procedures None

Required/As Needed This task is required if you will use a Windows computer to run CTC and 
if any one of the following is true: 

• JRE 1.4.2 is not installed.

• CTC online user manuals are not installed and are needed.

Onsite/Remote Onsite or remote

Security Level None
2-3
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 2      Connect the PC and Log into the GUI
DLP-G37 Run the CTC Installation Wizard for Windows
Step 3 Click Next.

Step 4 Complete one of the following:

• Click Typical to install both the Java Runtime Environment and online user manuals. If you already 
have JRE 1.4.2 installed on your computer, choose Custom.

• Click Custom if you want to install either the JRE or the online user manuals. By default, Acrobat 
Reader and the online user manuals are selected.

Step 5 Click Next. 

Step 6 Complete the following, as applicable:

• If you selected Typical in Step 4, skip this step and continue with Step 7.

• If you selected Custom in Step 4, check the CTC component that you want to install and click Next. 

– If you selected Online User Manuals, continue with Step 7. 

– If you did not select Online User Manuals, continue with Step 9.

Step 7 The directory where the installation wizard will install the CTC online user manuals appears. The default 
is C:\Program Files\Cisco\CTC\Documentation. 

• If you want to change the CTC online user manuals directory, type the new directory path in the 
Directory Name field, or click Browse to navigate to the directory. 

• If you do not want to change the directory, skip this step.

Step 8 Click Next.

Step 9 Review the components that will be installed. If you want to change the components, complete one of 
the following:

• If you selected Typical in Step 4, click Back twice to return to the installation setup type panel. 
Choose Custom and repeat Steps 5 through 8. 

• If you selected Custom in Step 4, click Back once or twice (depending on the components selected) 
until the component selection panel appears. Repeat Steps 6 through 8.

Step 10 Click Next. It might take a few minutes for the JRE installation wizard to appear. If you selected Custom 
in Step 4 and did not check Java Runtime Environment 1.4.2, continue with Step 12.

Step 11 To install the JRE, complete the following:

a. In the Java 2 Runtime Environment License Agreement dialog box, view the license agreement and 
choose one of the following:

• I accept the terms of the license agreement—Accepts the license agreement. Continue with 
Step b.

• I do not accept the terms of the license agreement—Disables the Next button on the Java 2 
Runtime Environment License Agreement dialog box. Click Cancel to return to the CTC 
installation wizard. CTC will not install the JRE. Continue with Step 12.

Note If JRE 1.4.2 is already installed on your computer, the License Agreement panel does 
not appear. You must click Next and then choose Modify to change the JRE installation 
or Remove to uninstall the JRE. If you choose Modify and click Next, continue with 
Step e. If you choose Remove and click Next, continue with Step i.

b. Click Next.

c. Choose one of the following:
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DLP-G37 Run the CTC Installation Wizard for Windows
• Click Typical to install all JRE features. If you select Typical, the JRE version installed will 
automatically become the default JRE version for your browsers.

• Click Custom if you want to select the components to install and select the browsers that will 
use the JRE version.

d. Click Next.

e. If you selected Typical, continue with Step i. If you selected Custom, click the drop-down list for 
each program feature that you want to install and choose the desired setting. The program features 
include:

• Java 2 Runtime Environment—(Default) Installs JRE 1.4.2 with support for European 
languages. 

• Support for Additional Languages—Adds support for non-European languages.

• Additional Font and Media Support—Adds Lucida fonts, Java Sound, and color management 
capabilities.

The drop-down list options for each program feature include:

• This feature will be installed on the local hard drive—Installs the selected feature.

• This feature and all subfeatures will be installed on the local hard drive—Installs the selected 
feature and all subfeatures.

• Don’t install this feature now—Does not install the feature (not an option for Java 2 Runtime 
Environment).

To modify the directory where the JRE version is installed, click Change, navigate to the desired 
directory, and click OK.

f. Click Next.

g. In the Browser Registration dialog box, check the browsers that you want to register with the Java 
Plug-In. The JRE version will be the default for the selected browsers. It is acceptable to leave both 
browser check boxes unchecked.

Note Setting the JRE as the default for these browsers might cause problems with these browsers.

h. Click Next. 

i. Click Finish.

Note If you are uninstalling the JRE, click Remove.

Step 12 In the Cisco Transport Controller Installation Wizard, click Next. The online user manuals are installed.

Step 13 Click Finish.

Step 14 Return to your originating procedure (NTP).
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DLP-G38 Run the CTC Installation Wizard for UNIX

Note If you will log into nodes running CTC software earlier than Release 4.6, uninstall JRE 1.4.2 and 
reinstall JRE 1.3.1_2. To run R4.7, uninstall JRE 1.3.1_2 and reinstall JRE 1.4.2.

Note JRE 1.4.2 requires Netscape 7.x or Internet Explorer 6.x.

Step 1 Verify that your computer has the following:

• RAM—384 MB recommended, 512 MB optimum

• Hard drive—20 GB hard drive recommended with at least 50 MB of space available

• Operating system—Solaris 8 or 9

Note These requirements are guidelines. CTC performance is faster if your computer has a faster 
processor and more RAM. 

Step 2 Change the directory; type:

cd /cdrom/cdrom0/

Step 3 From the techdoc454 CD directory, type:

./setup.bat

The Cisco Transport Controller Installation Wizard displays the components that will be installed on 
your computer:

• Java Runtime Environment 1.4.2 

• Acrobat Reader 6.0.1

• Online User Manuals

Step 4 Click Next.

Step 5 Complete one of the following:

• Click Typical to install both the Java Runtime Environment and online user manuals. If you already 
have JRE 1.4.2 installed on your computer, choose Custom.

Purpose This task installs the CTC online user manuals, Acrobat 6.0.1, and 
JRE 1.4.2 on UNIX workstations, as necessary. JRE 1.4.2 is required to run 
Release 4.7.

Tools/Equipment Cisco ONS 15454 Release 4.7 software or documentation CD

Prerequisite Procedures None

Required/As Needed This task is required if you will use a UNIX workstation to run CTC and 
any of the following are true: 

• JRE 1.4.2 is not installed.

• CTC online user manuals are not installed and are needed.

Onsite/Remote Onsite or remote

Security Level None
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DLP-G38 Run the CTC Installation Wizard for UNIX
• Click Custom if you want to install either the JRE or the online user manuals. 

Step 6 Click Next. 

Step 7 Complete the following, as applicable:

• If you selected Typical in Step 5, continue with Step 8.

• If you selected Custom in Step 5, check the CTC component that you want to install and click Next. 

– If you selected Online User Manuals, continue with Step 8. 

– If you did not select Online User Manuals, continue with Step 10. 

Step 8 The directory where the installation wizard will install the CTC online user manuals appears. The default 
is /usr/doc/ctc. 

• If you want to change the CTC online user manuals directory, type the new directory path in the 
Directory Name field, or click Browse to navigate to the directory.

• If you do not want to change the CTC online user manuals directory, skip this step.

Step 9 Click Next.

Step 10 Review the components that will be installed.

• If you selected Typical in Step 5, click Back twice to return to the installation setup type panel. 
Choose Custom and repeat Steps 6 through 9.

• If you selected Custom in Step 5, click Back once or twice (depending on the components selected) 
you reach the component selection panel and check the desired components. Repeat Steps 7 
through 9.

Step 11 Click Next. It might take a few minutes for the JRE installation wizard to appear. If you selected Custom 
in Step 4 and did not check Java Runtime Environment 1.4.2, continue with Step 13.

Step 12 To install the JRE, complete the following:

a. In the Java 2 Runtime Environment License Agreement dialog box, view the license agreement and 
choose one of the following:

• I accept the terms of the license agreement—Accepts the license agreement. Continue with 
Step b.

• I do not accept the terms of the license agreement—Disables the Next button on the Java 2 
Runtime Environment License Agreement dialog box. Click Cancel to return to the CTC 
installation wizard. CTC will not install the JRE. Continue with Step 13.

Note If JRE 1.4.2 is already installed on your computer, the License Agreement panel does 
not appear. You must click Next and then choose Modify to change the JRE installation 
or Remove to uninstall the JRE. If you choose Modify and click Next, continue with 
Step e. If you choose Remove and click Next, continue with Step i.

b. Click Next.

c. Choose one of the following:

• Click Typical to install all JRE features. If you select Typical, the JRE version installed will 
automatically become the default JRE version for your browsers. 

• Click Custom if you want to select the components to install and select the browsers that will 
use the JRE version.

d. Click Next.
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e. If you selected Typical, continue with Step i. If you selected Custom, click the drop-down list for 
each program feature that you want to install and choose the desired setting. The program features 
include:

• Java 2 Runtime Environment—(Default) Installs JRE 1.4.2 with support for European 
languages. 

• Support for Additional Languages—Adds support for non-European languages.

• Additional Font and Media Support—Adds Lucida fonts, Java Sound, and color management 
capabilities.

The drop-down list options for each program feature include:

• This feature will be installed on the local hard drive—Installs the selected feature.

• This feature and all subfeatures will be installed on the local hard drive—Installs the selected 
feature and all subfeatures.

• Don’t install this feature now—Does not install the feature (not an option for Java 2 Runtime 
Environment).

To modify the directory where the JRE version is installed, click Change, navigate to the desired 
directory, and click OK.

f. Click Next.

g. In the Browser Registration dialog box, check the browsers that you want to register with the Java 
Plug-In. The JRE version will be the default for the selected browsers. It is acceptable to leave both 
browser check boxes unchecked.

Note Setting the JRE version as the default for these browsers might cause problems with these 
browsers. 

h. Click Next. 

i. Click Finish.

Note If you are uninstalling the JRE, click Remove.

Step 13 In the Cisco Transport Controller Installation Wizard, click Next. The online user manuals are installed.

Step 14 Click Finish.

Note Be sure to record the names of the directories you choose for JRE and the online user manuals.

Step 15 Return to your originating procedure (NTP).
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NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454

Step 1 Complete one of the CTC computer setup tasks shown in Table 2-1 based your CTC connection 
environment.

Purpose This procedure explains how to set up a PC running Windows or a Solaris 
workstation for an onsite local craft connection to the ONS 15454. 

Tools/Equipment Depends on connection type

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None

Table 2-1 CTC Computer Setup for Local Craft Connections to the ONS 15454

CTC Connection Environment CTC Computer Setup Task

• You are connecting from a Windows PC.

• All nodes that you will access run software earlier 
than Release 3.3.

• You will connect to one ONS 15454. 

• You need to access non-ONS 15454 applications 
such as ping and tracert (trace route).

DLP-G39 Set Up a Windows PC for Craft 
Connection to an ONS 15454 on the Same 
Subnet Using Static IP Addresses, page 2-11

• You are connecting from a Windows PC.

• The CTC computer is provisioned for Dynamic 
Host Configuration Protocol (DHCP).

• The ONS 15454 has DHCP forwarding enabled.

• The ONS 15454 is connected to a DHCP server.

Note The ONS 15454 does not provide IP addresses. 
If DHCP is enabled, it passes DCHP requests to 
an external DHCP server.

DLP-G40 Set Up a Windows PC for Craft 
Connection to an ONS 15454 Using Dynamic 
Host Configuration Protocol, page 2-13

Note Do not use this task for initial node 
turn-up. Use the task only if DHCP 
forwarding is enabled on the 
ONS 15454. By default, DHCP is not 
enabled. To enable it, see the 
“NTP-G26 Set Up CTC Network 
Access” procedure on page 3-8.
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Step 2 After setting up your CTC computer, continue with the “NTP-G21 Log into the ONS 15454 GUI” 
procedure on page 2-23 as needed.

Stop. You have completed this procedure.

• You are connecting from a Windows PC.

• All nodes that you will access run software 
Release 3.3 or later.

• You will connect to ONS 15454s at different 
locations and times and do not wish to reconfigure 
your PC’s IP settings each time.

• You will not access or use non-ONS 15454 
applications such as ping and tracert (trace route).

• If you are using an ANSI shelf, you will connect to 
the TCC2 Ethernet port or backplane LAN pins 
either directly or through a hub.

• If you are using an ETSI shelf, you will connect to 
the ONS 15454 Ethernet port or the RJ-45 jack on 
the MIC-C/T/P FMEC either directly or through a 
hub.

DLP-G41 Set Up a Windows PC for Craft 
Connection to an ONS 15454 Using 
Automatic Host Detection, page 2-15

• You are connecting from a Solaris workstation.

• You will connect to one ONS 15454.

• You need to access non-ONS 15454 applications 
such as ping and tracert (trace route).

DLP-G42 Set Up a Solaris Workstation for a 
Craft Connection to an ONS 15454, page 
2-18

Table 2-1 CTC Computer Setup for Local Craft Connections to the ONS 15454

CTC Connection Environment CTC Computer Setup Task (continued)
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DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the 
Same Subnet Using Static IP Addresses

Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 According to the Windows operating system installed on your computer, perform one of the following 
steps:

• For Windows 98, complete Step 3.

• For Windows NT 4.0, complete Step 4.

• For Windows 2000, complete Step 5.

• For Windows XP, complete Step 6.

Step 3 If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, choose TCP/IP for your NIC card, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Specify an IP address. 

h. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address except for 
the last octet. The last octet must be 1 or 3 through 254. This IP address appears on the LCD unless 
its display is suppressed during node provisioning. 

Purpose This task sets up your computer for a local craft connection to the 
ONS 15454 when: 

• You will access nodes running software releases earlier than Software 
Release 3.3.

• You will connect to one ONS 15454; if you will connect to multiple 
ONS 15454s, you might need to reconfigure your computer’s IP 
settings each time you connect to an ONS 15454.

• You need to use non-ONS 15454 applications such as ping and tracert 
(trace route).

Tools/Equipment Network interface card (NIC), also referred to as an Ethernet card

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-G39 Set Up a Windows PC for Craft Connection to an ONS 15454 on the Same Subnet Using Static IP Addresses
i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

j. Click OK.

k. In the TCP/IP dialog box, click the Gateway tab.

l. In the New Gateway field, type the ONS 15454 IP address. Click Add.

m. Verify that the IP address appears in the Installed Gateways field, then click OK.

n. When the prompt to restart your PC appears, click Yes.

Step 4 If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Specify an IP address. 

f. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

g. In the Subnet Mask field, type 255.255.255.0.

h. Click Advanced.

i. In the Gateways List, click Add. The TCP/IP Gateway Address dialog box appears.

j. Type the ONS 15454 IP address in the Gateway Address field.

k. Click Add.

l. Click OK.

m. Click Apply.

n. In some cases, Windows NT 4.0 prompts you to reboot your PC. If you receive this prompt, click 
Yes.

Step 5 If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > 
Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Use the following IP address.

e. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

f. In the Subnet Mask field, type 255.255.255.0.

g. In the Default Gateway field, type the ONS 15454 IP address. 

h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.

j. In the Local Area Connection Status dialog box, click Close.
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DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol
Step 6 If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. From the Network Connections dialog box, click the Local Area Connection icon.

c. From the Local Area Connection Properties dialog box, choose Internet Protocol (TCP/IP), then 
click Properties.

d. In the IP Address field, enter an IP address that is identical to the ONS 15454 IP address shown on 
the ONS 15454 LCD except for the last octet. The last octet must be 1 or 3 through 254.

e. In the Subnet Mask field, type 255.255.255.0.

f. In the Default Gateway field, type the ONS 15454 IP address. 

g. Click OK.

h. In the Local Area Connection Properties dialog box, click OK.

i. In the Local Area Connection Status dialog box, click Close.

Step 7 Return to your originating procedure (NTP).

DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using 
Dynamic Host Configuration Protocol

Note Do not use this task for initial node turn-up. Use the task only if DHCP forwarding is enabled on the 
ONS 15454. By default, DHCP is not enabled. To enable it, see the “NTP-G26 Set Up CTC Network 
Access” procedure on page 3-8.

Note The ONS 15454 does not provide the IP addresses. If DHCP forwarding is enabled, it passes DCHP 
requests to an external DHCP server.

Purpose This task sets up your computer for craft connection to the ONS 15454 
using DHCP. 

Tools/Equipment Straight-through (CAT-5) LAN cable

NIC

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

NTP-G26 Set Up CTC Network Access, page 3-8

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-G40 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Dynamic Host Configuration Protocol
Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 According to the Windows operating system installed on your computer, perform one of the following 
steps:

• For Windows 98, complete Step 3.

• For Windows NT 4.0, complete Step 4.

• For Windows 2000, complete Step 5.

• For Windows XP, complete Step 6.

Step 3 If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, select TCP/IP for your NIC, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Obtain an IP address automatically. 

h. Click OK.

i. When the prompt to restart your PC appears, click Yes.

Step 4 If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Obtain an IP address from a DHCP server.

f. Click OK.

g. Click Apply.

h. If Windows prompts you to restart your PC, click Yes.

Step 5 If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > 
Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Obtain an IP address from a DHCP server.
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DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection
e. Click OK.

f. In the Local Area Connection Properties dialog box, click OK.

g. In the Local Area Connection Status dialog box, click Close.

Step 6 If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.

Note If the Network Connections menu is not available, click Switch to Classic View.

b. In the Network Connections dialog box, click Local Area Connection.

c. In the Local Area Connection Status dialog box, click Properties.

d. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

e. Click Obtain an IP address from a DHCP server.

f. Click OK.

g. In the Local Area Connection Properties dialog box, click OK.

h. In the Local Area Connection Status dialog box, click Close.

Step 7 Return to your originating procedure (NTP).

DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using 
Automatic Host Detection 

Purpose This task sets up your computer for local craft connection to the 
ONS 15454 when:

• If you are using an ANSI shelf, you will connect to the ONS 15454 
Ethernet port or backplane LAN pins either directly or through a hub.

• If you are using an ETSI shelf, you will connect to the ONS 15454 
Ethernet port or the RJ-45 jack on the MIC-C/T/P FMEC either 
directly or through a hub.

• All nodes that you will access are running Software Release 3.3 or 
later.

• You will connect to multiple ONS 15454s and do not want to 
reconfigure your IP address each time.

• You do not need to access non-ONS 15454 applications such as ping 
and tracert (trace route).

Tools/Equipment NIC

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection
Step 1 Verify the operating system that is installed on your computer: 

a. From the Windows Start menu, choose Settings > Control Panel. 

Note In Windows XP, you can select Control Panel directly from the Start menu. Make sure you 
are in Classic View before continuing with this procedure.

b. In the Control Panel window, double-click the System icon.

c. On the General tab of the System Settings window, verify that the Windows operating system is one 
of the following: Windows 98, Windows NT 4.0, Windows 2000, or Windows XP.

Step 2 According to the Windows operating system installed on your computer, perform one of the following 
steps:

• For Windows 98, complete Step 3.

• For Windows NT 4.0, complete Step 4.

• For Windows 2000, complete Step 5.

• For Windows XP, complete Step 6.

Step 3 If you have Windows 98 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.

b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, select TCP/IP for your NIC, then click Properties.

d. In the TCP/IP Properties dialog box, click the DNS Configuration tab and choose Disable DNS.

e. Click the WINS Configuration tab and choose Disable WINS Resolution.

f. Click the IP Address tab.

g. In the IP Address window, click Specify an IP address. 

h. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 9-11.

i. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

j. Click OK.

k. In the TCP/IP dialog box, click the Gateway tab.

l. In the New Gateway field, type the address entered in Step h. Click Add.

m. Verify that the IP address appears in the Installed Gateways field, then click OK.

n. When the prompt to restart your PC appears, click Yes.

Step 4 If you have Windows NT 4.0 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Control Panel.
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DLP-G41 Set Up a Windows PC for Craft Connection to an ONS 15454 Using Automatic Host Detection
b. In the Control Panel dialog box, click the Network icon.

c. In the Network dialog box, click the Protocols tab, choose TCP/IP Protocol, then click Properties.

d. Click the IP Address tab.

e. In the IP Address window, click Specify an IP address. 

f. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 9-11.

g. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

h. Click Advanced.

i. In the Gateways List, click Add. The TCP/IP Gateway Address dialog box appears.

j. Type the IP address entered in Step f in the Gateway Address field.

k. Click Add.

l. Click OK.

m. Click Apply.

n. Reboot your PC. 

Step 5 If you have Windows 2000 installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Settings > Network and Dial-up Connections > 
Local Area Connection.

b. In the Local Area Connection Status dialog box, click Properties.

c. On the General tab, choose Internet Protocol (TCP/IP), then click Properties.

d. Click Use the following IP address.

e. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 9-11.

f. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

g. Type the IP address entered in Step e in the Gateway Address field.

h. Click OK.

i. In the Local Area Connection Properties dialog box, click OK.

j. In the Local Area Connection Status dialog box, click Close.

Step 6 If you have Windows XP installed on your PC, complete the following steps to change its TCP/IP 
configuration:

a. From the Windows Start menu, choose Control Panel > Network Connections.
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DLP-G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454
Note If the Network Connections menu is not available, click Switch to Classic View.

b. From the Network Connections dialog box, click the Local Area Connection icon.

c. From the Local Area Connection Properties dialog box, choose Internet Protocol (TCP/IP), then 
click Properties.

d. In the IP Address field, enter any legitimate IP address other than the node IP address as indicated 
on the LCD of the ONS 15454. The default IP address is 192.1.0.2. 

Note You can suppress the LCD IP address display using CTC. For more information, see the 
“DLP-G162 Change IP Settings” task on page 9-11.

e. In the Subnet Mask field, type the same subnet mask as the ONS 15454. The default is 
255.255.255.0 (24 bit).

f. Type the IP address entered in Step d in the Gateway Address field.

g. Click OK.

h. In the Local Area Connection Properties dialog box, click OK.

i. In the Local Area Connection Status dialog box, click Close.

Step 7 Return to your originating procedure (NTP).

DLP-G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454

Step 1 Log into the workstation as the root user.

Step 2 Check to see if the interface is plumbed by typing:

# ifconfig device 

For example:

# ifconfig hme1

If the interface is plumbed, a message similar to the following appears:

hme1:flags=1000842<BROADCAST,RUNNING,MULTICAST,IPv4>mtu 1500 index 2 inet 0.0.0.0 
netmask 0

If a message similar to this one appears, go to Step 4.

Purpose This task sets up a Solaris workstation for a craft connection to the 
ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-G42 Set Up a Solaris Workstation for a Craft Connection to an ONS 15454
If the interface is not plumbed, a message similar to the following appears: 

ifconfig: status: SIOCGLIFFLAGS: hme1: no such interface. 

If a message similar to this one appears, go to Step 3.

Step 3 Plumb the interface by typing:

# ifconfig device plumb 

For example: 

# ifconfig hme1 plumb

Step 4 Configure the IP address on the interface by typing:

# ifconfig interface ip-address netmask netmask up

For example: 

# ifconfig hme0 192.1.0.3 netmask 255.255.255.0 up

Note Enter an IP address that is identical to the ONS 15454 IP address except for the last octet. The 
last octet must be 1 or 3 through 254. 

Step 5 In the Subnet Mask field, type 255.255.255.0. Skip this step if you checked Craft Access Only on the 
Provisioning > Network > General > Gateway Settings tab.

Step 6 Test the connection:

a. Start Netscape Navigator.

b. Enter the ONS 15454 IP address in the web address (URL) field. If the connection is established, a 
Java Console window, CTC caching messages, and the Cisco Transport Controller Login dialog box 
appear. If this occurs, go to Step 2 of the “DLP-G46 Log into CTC” task on page 2-25 to complete 
the login. If the Login dialog box does not appear, complete Steps c and d.

c. At the prompt, type: 

ping ONS-15454-IP-address

For example, to connect to an ONS 15454 with a default IP address of 192.1.0.2, type:

ping 192.1.0.2

If your workstation is connected to the ONS 15454, the following message appears:

IP-address is alive

Note Skip this step if you checked the Craft Access Only check box at Provisioning > Network > 
General > Gateway Settings. 

d. If CTC is not responding, a “no answer from x.x.x.x” message appears. Verify the IP and subnet 
mask information. Check that the cables connecting the workstation to the ONS 15454 are securely 
attached. Check the link status by typing:

# ndd -set /dev/device instance 0

# ndd -get /dev/device link_status

For example:

# ndd -set /dev/hme instance 0

# ndd -get /dev/hme link_status
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A result of “1” means the link is up. A result of “0” means the link is down.

Note Check the man page for ndd. For example, type: # man ndd.

Step 7 Return to your originating procedure (NTP).

NTP-G19 Set Up a CTC Computer for a Corporate LAN 
Connection to the ONS 15454

Step 1 If your computer is already connected to the corporate LAN, go to Step 2. If you changed your 
computer’s network settings for craft access to the ONS 15454, change the settings back to the corporate 
LAN access settings. This generally means:

• Set the IP Address on the TCP/IP dialog box back to Obtain an IP address automatically 
(Windows 98) or Obtain an IP address from a DHCP server (Windows NT 4.0, 2000, or XP). 

• If your LAN requires that Domain Name System (DNS) or Windows Internet Naming Service 
(WINS) be enabled, change the setting on the DNS Configuration or WINS Configuration tab of the 
TCP/IP dialog box. 

Step 2 If your computer is connected to a proxy server, disable proxy service or add the ONS 15454 nodes as 
exceptions. To disable proxy service, complete one of the following tasks, depending on the web browser 
that you use:

• DLP-G43 Disable Proxy Service Using Internet Explorer (Windows), page 2-21

• DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX), page 2-21

Step 3 Continue with the “NTP-G21 Log into the ONS 15454 GUI” procedure on page 2-23.

Stop. You have completed this procedure.

Purpose This procedure sets up your computer to access the ONS 15454 through a 
corporate LAN. 

Tools/Equipment None

Prerequisite Procedures • NTP-G17 Set Up Computer for CTC, page 2-2

• The ONS 15454 must be provisioned for LAN connectivity, including 
IP address, subnet mask, default gateway.

• The ONS 15454 must be physically connected to the corporate LAN.

• The CTC computer must be connected to the corporate LAN that has 
connectivity to the ONS 15454.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level None
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DLP-G43 Disable Proxy Service Using Internet Explorer (Windows) 

Step 1 From the Start menu, select Settings > Control Panel.

Note If your computer is running Windows XP, you can select Control Panel directly from the Start 
menu. Make sure that you are in Classic View before continuing with this procedure.

Step 2 In the Control Panel window, choose Internet Options.

Step 3 In the Internet Properties dialog box, click Connections > LAN Settings.

Step 4 In the LAN Settings dialog box, complete one of the following tasks:

• Uncheck Use a proxy server to disable the service.

• Leave Use a proxy server selected and click Advanced. In the Proxy Setting dialog box under 
Exceptions, enter the IP addresses of ONS 15454 nodes that you will access. Separate each address 
with a semicolon. You can insert an asterisk (*) for the host number to include all the ONS 15454s 
on your network. Click OK to close each open dialog box.

Step 5 Return to your originating procedure (NTP).

DLP-G44 Disable Proxy Service Using Netscape (Windows and UNIX) 

Step 1 Open Netscape.

Step 2 From the Edit menu, choose Preferences.

Step 3 In the Preferences dialog box under Category, choose Advanced > Proxies.

Purpose This task disables proxy service for PCs running Internet Explorer. 

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed Required if your computer is connected to a network computer proxy 
server and your browser is Internet Explorer. 

Onsite/Remote Onsite or remote

Security Level None

Purpose This task disables proxy service for PCs and UNIX workstations running 
Netscape. 

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed Required if your computer is connected to a network computer proxy server 
and your browser is Netscape.

Onsite/Remote Onsite or remote

Security Level None
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Step 4 On the right side of the Preferences dialog box under Proxies, perform one of the following options:

• Choose Direct connection to the Internet to bypass the proxy server.

• Choose Manual proxy configuration to add exceptions to the proxy server, then click View. In the 
Manual Proxy Configuration dialog box under Exceptions, enter the IP addresses of the ONS 15454 
nodes that you will access. Separate each address with a comma. Click OK to close each open dialog 
box.

Step 5 Return to your originating procedure (NTP).

NTP-G20 Set Up a Remote Access Connection to the ONS 15454

Step 1 Connect the modem to the RJ-45 (LAN) port on the TCC2 card or to the LAN pins on the ONS 15454 
backplane (ANSI only) or the RJ-45 jack on the MIC-C/T/P FMEC (ETSI only).

Step 2 While referring to the modem documentation, complete the following tasks to provision the modem for 
the ONS 15454: 

• For CTC access, set the modem for Ethernet access.

• Assign an IP address to the modem that is on the same subnet as the ONS 15454.

• The IP address the modem assigns to the CTC computer must be on the same subnet as the modem 
and the ONS 15454.

Note For assistance on provisioning specific modems, contact the Cisco Technical Assistance Center 
(Cisco TAC).

Step 3 Continue with the “NTP-G21 Log into the ONS 15454 GUI” procedure on page 2-23.

Stop. You have completed this procedure.

Purpose This procedure connects the CTC computer to an ONS 15454 using a LAN 
modem. To complete this procedure:

• A modem must be connected to the ONS 15454.

• The modem must be provisioned for ONS 15454. To run CTC, the 
modem must be provisioned for Ethernet access.

Tools/Equipment Modem and modem documentation

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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NTP-G21 Log into the ONS 15454 GUI

Step 1 If the computer does not have a physical connection to the ONS 15454 or corporate LAN, complete the 
“DLP-G45 Connect Computer to the ONS 15454” task on page 2-24 or the “NTP-G19 Set Up a CTC 
Computer for a Corporate LAN Connection to the ONS 15454” procedure on page 2-20. 

Step 2 Complete the “DLP-G46 Log into CTC” task on page 2-25. 

Note For information about navigating in CTC, see Appendix A, “CTC Information and Shortcuts.”

Step 3 As needed, complete the “DLP-G48 Create Login Node Groups” task on page 2-29. Login node groups 
allow you to manage nodes that are not connected to the login node through a data communications 
channel (DCC).

Step 4 As needed, complete the “DLP-G49 Add a Node to the Current Session or Login Group” task on 
page 2-30.

Step 5 As needed, complete the “DLP-G50 Delete a Node from the Current Session or Login Group” task on 
page 2-31.

Step 6 As needed, complete the “DLP-G51 Delete a Node from a Specified Login Node Group” task on 
page 2-31.

Step 7 As needed, complete the “DLP-G52 Change the JRE Version” task on page 2-32.

Step 8 As needed, complete the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task 
on page 2-33.

Stop. You have completed this procedure.

Purpose This procedure logs into CTC, the graphical user interface software used to 
manage the ONS 15454. This procedure includes optional node login tasks.

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

One of the following procedures:

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection 
to the ONS 15454, page 2-20

• NTP-G20 Set Up a Remote Access Connection to the ONS 15454, 
page 2-22

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G45 Connect Computer to the ONS 15454

Step 1 If your computer is set up for a local craft connection, connect a straight-through CAT-5 LAN cable from 
the PC or Solaris workstation NIC to one of the following:

• RJ-45 (LAN) port on the active or standby TCC2 card

• RJ-45 (LAN) port on a hub or switch to which the ONS 15454 is physically connected

Note For instructions on crimping your own straight-through (CAT-5) LAN cables, refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Note For initial shelf turn-up, you should connect your PC directly to the LAN port on the TCC2 
card of the ONS 15454. 

Step 2 If your computer is set up for a corporate LAN connection, connect a straight-through (CAT-5) LAN 
cable from the PC or Solaris workstation NIC card to a corporate LAN port.

Step 3 Return to your originating procedure (NTP).

Purpose This task physically connects a CTC computer to the ONS 15454.

Tools/Equipment Straight-through (CAT-5) LAN cable

NIC

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2 and one of the following 
procedures:

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9, or

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection 
to the ONS 15454, page 2-20

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level None
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DLP-G46 Log into CTC

Note For information about CTC views and navigation, see Appendix A, “CTC Information and Shortcuts.”

Step 1 From the computer connected to the ONS 15454, start Netscape (PC or UNIX) or Internet Explorer (PC 
only):

• If you are using a PC, launch Netscape or Internet Explorer from the Windows Start menu or a 
shortcut icon.

• If you are using UNIX, launch Netscape from the command line by typing one of the following:

– To install Netscape colors for Netscape use, type:

# netscape -install

– To limit Netscape to 32 colors so that if the requested color is not available, Netscape chooses 
the closest color option, type:

netscape -ncols 32

Note CTC requires a full 24-color palette to run properly. When using color-intensive applications 
such as Netscape in UNIX, it is possible that UNIX might run out of colors to use for CTC. 
The -install and -ncols 32 command line options limit the number of colors that Netscape 
uses. 

Step 2 In the Netscape or Internet Explorer web address (URL) field, enter the ONS 15454 IP address. For 
initial setup, this is the default IP address, 192.1.0.2. (This IP address appears on the LCD. You can 
suppress the LCD IP address display using CTC after you log in. For more information, see the 
“DLP-G162 Change IP Settings” task on page 9-11.) 

Step 3 Press Enter.

Purpose This task logs into CTC. 

Tools/Equipment None

Prerequisite Procedures NTP-G17 Set Up Computer for CTC, page 2-2

One of the following procedures:

• NTP-G18 Set Up CTC Computer for Local Craft Connection to the 
ONS 15454, page 2-9

• NTP-G19 Set Up a CTC Computer for a Corporate LAN Connection 
to the ONS 15454, page 2-20

• NTP-G20 Set Up a Remote Access Connection to the ONS 15454, 
page 2-22

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note If you are logging into ONS 15454 nodes running different releases of CTC software, log into 
the node running the most recent release. If you log into a node running an older release, you 
will receive an INCOMPATIBLE-SW alarm for each node in the network running a new release, 
and CTC will not be able to manage these nodes. To check the software version of a node, select 
About CTC from the CTC Help menu. This will display the ONS 15454 software version for 
each node visible on the network view. If the node is not visible, the software version can be read 
from the LCD display. To resolve an alarm, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Step 4 If a Java Plug-in Security Warning dialog box appears, complete the “DLP-G47 Install Public-Key 
Security Certificate” task on page 2-28 to install the public-key security certificate required by Software 
Release 4.1 and later.

After you complete the security certificate dialog box (or if the certificate is already installed), a Java 
Console window displays the CTC file download status. The web browser displays information about 
your Java and system environments. If this is the first login, CTC caching messages appear while CTC 
files are downloaded to your computer. The first time you connect to an ONS 15454, this process can 
take several minutes. After the download, the CTC Login dialog box appears (Figure 2-1).

Figure 2-1 Logging into CTC

Step 5 In the Login dialog box, type a user name and password (both are case sensitive). For initial setup, type 
the user name CISCO15 and the password otbu+1.
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Note The CISCO15 user is provided with every ONS 15454. CISCO15 has superuser privileges, so 
you can create other users. You must create another superuser before you can delete the 
CISCO15 user. CISCO15 is delivered with the otbu+1 password. To change the password for 
CISCO15, click the Provisioning > Security tabs after you log in and change the password. To 
set up ONS 15454 users and assign security, go to the “NTP-G23 Create Users and Assign 
Security” procedure on page 3-3. Additional information about security is provided in the 
“18.1 Users and Security” section on page 18-1.

Step 6 Each time you log into an ONS 15454, you can make selections on the following login options:

• Node Name—Displays the IP address entered in the web browser and a drop-down list of previously 
entered ONS 15454 IP addresses. You can select any ONS 15454 on the list for the login, or you can 
enter the IP address (or node name) of any new node where you want to log in.

• Additional Nodes—Displays a list of current login node groups. To create a login node group or add 
additional groups, see the “DLP-G48 Create Login Node Groups” task on page 2-29.

• Disable Network Discovery—Check this box to view only the ONS 15454 (and login node group 
members, if any) entered in the Node Name field. Nodes linked to this node through DCCs are not 
discovered and will not appear in CTC network view. Using this option can decrease the CTC startup 
time in networks with many DCC-connected nodes, and can reduce memory consumption. 

• Disable Circuit Management—Check this box to disable discovery of existing circuits. Using this 
option can decrease the CTC initialization time in networks with many existing circuits and reduce 
memory consumption. This option does not prevent the creation and management of new circuits.

Step 7 Click Login.

If the login is successful, the CTC window appears. From here, you can navigate to other CTC views to 
provision and manage the ONS 15454. If you need to turn up the shelf for the first time, see Chapter 3, 
“Turn Up a Node.” If login problems occur, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Step 8 Return to your originating procedure (NTP).
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DLP-G47 Install Public-Key Security Certificate

Step 1 If the Java Plug-in Security Warning dialog box appears, choose one of the following options:

Note The Java Plug-in Security Warning dialog box options that appear depend on the JRE version 
you are using. If you installed JRE 1.4.2, you will see the following options: Yes, No, Always, 
and More Details. If you are using JRE 1.3.1_02, you will see the following options (noted below 
in parentheses): Grant This Session, Deny, Grant Always, and View Certificate.

• Yes (Grant This Session)—Installs the public-key certificate to your PC only for the current session. 
After the session is ended, the certificate is deleted. This dialog box will appear the next time you 
log into the ONS 15454.

• No (Deny)—Denies permission to install the certificate. If you choose this option, you cannot log 
into the ONS 15454. 

• Always (Grant Always)—Installs the public-key certificate and does not delete it after the session 
is over. Cisco recommends this option.

• More Details (View Certificate)—Allows you to view the public-key security certificate.

Step 2 If the Login dialog box appears, continue with Step 3. If the Change Java Policy File dialog box appears, 
complete this step. The Change Java Policy File dialog box appears if CTC finds a modified Java policy 
file (.java.policy) on your PC. In Software Release 4.0 and earlier, the Java policy file was modified to 
allow CTC software files to be downloaded to your PC. The modified Java policy file is not needed in 
Software Release 4.1 and later, so you can remove it unless you will log into ONS 15454s running 
software earlier than Release 4.1. Choose one of the following options: 

• Yes—Removes the modified Java policy file from your PC. Choose this option only if you will log 
into ONS 15454s running Software Release 4.1 software or later.

• No—Does not remove the modified Java policy file from your PC. Choose this option if you will 
log into ONS 15454s running Software Release 4.0 or earlier. If you choose No, this dialog box will 
appear every time you log into the ONS 15454. If you do not want it to appear, check the Do not 
show the message again check box.

Caution If you delete the Java policy file, you cannot log into nodes running Software Release 4.0 and earlier. If 
you delete the file and want to log into an ONS 15454 running an earlier release, insert the software CD 
for the release into your PC CD-ROM and run the CTC setup wizard to reinstall the Java policy file.

Purpose This task installs the ITU Recommendation X.509 public-key security 
certificate. The public-key certificate is required to run Software 
Release 4.1 or later.

Tools/Equipment None

Prerequisite Procedures This task is performed during the “DLP-G46 Log into CTC” task on 
page 2-25. You cannot perform it outside of this task.

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Return to your originating procedure (NTP).

DLP-G48 Create Login Node Groups

Step 1 From the Edit menu in node view, choose Preferences.

Step 2 Click Login Node Group and Create Group.

Step 3 Enter a name for the group in the Create Login Group Name dialog box. Click OK.

Step 4 In the Members area, type the IP address (or node name) of a node you want to add to the group. Click 
Add. Repeat this step for each node that you want to add to the group.

Step 5 Click OK. 

The next time you log into an ONS 15454, the login node group will be available in the Additional Nodes 
list of the Login dialog box. For example, in Figure 2-2, a login node group is created that contains the 
IP addresses for Nodes 1, 4, and 5. During login, if you choose this group from the Additional Nodes 
list and Disable Network Discovery is not selected, all nodes in the figure appear. If the login group and 
Disable Network Discovery are both selected, only Nodes 1, 4, and 5 appear. You can create as many 
login groups as you need. The groups are stored in the CTC preferences file and are not visible to other 
users.

Purpose This task creates a login node group to display ONS 15454s that have an IP 
connection but not a DCC connection to the login node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 2-2 Login Node Group 

Step 6 Return to your originating procedure (NTP).

DLP-G49 Add a Node to the Current Session or Login Group

Step 1 From the CTC File menu, click Add Node.

Step 2 In the Add Node dialog box, enter the node name (or IP address).

Step 3 If you want to add the node to the current login group, check Add to current login node group. 
Otherwise, leave it unchecked.

Note This check box is active only if you selected a login group when you logged into CTC. 

Step 4 Click OK. 

Purpose This task adds a node to the current CTC session or login node group.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

LAN/WAN (Ethernet)

Three node ring Single

Laptop PC

Node 1
IP Address

192.168.106.143

Node 4
IP Address

192.168.105.119

Node 5
IP Address

192.168.104.109

Node 6
IP Address

192.168.103.199

Node 3Node 2

IP Address
192.168.106.100

55
02

9

Two node ring
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After a few seconds, the new node appears on the network view map.

Step 5 Return to your originating procedure (NTP).

DLP-G50 Delete a Node from the Current Session or Login Group

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the node that you want to delete. 

Step 3 From the CTC File menu, click Delete Selected Node.

After a few seconds, the node disappears from the network view map.

Step 4 Return to your originating procedure (NTP).

DLP-G51 Delete a Node from a Specified Login Node Group

Step 1 From the CTC Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the Login Node Groups tab.

Step 3 Click the login node group tab containing the node you want to remove. 

Step 4 Click the node you want to remove, then click Remove.

Step 5 Click OK.

Purpose This task removes a node from the current CTC session or login node 
group. To remove a node from a login node group that is not the current 
one, see “DLP-G51 Delete a Node from a Specified Login Node Group” 
task on page 2-31.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task removes a node from a specified login node group. To remove a 
node from the current login node group, see “DLP-G50 Delete a Node from 
the Current Session or Login Group” task on page 2-31.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 Return to your originating procedure (NTP).

DLP-G52 Change the JRE Version

Note This task is not used in Release 4.7 because only one JRE version is supported. This task is used in CTC 
releases that support multiple JRE versions.

Step 1 From the Edit menu, choose Preferences.

Step 2 Click the JRE tab. The JRE tab shows the current JRE version and the recommended version.

Step 3 Click the Browse button and navigate to the JRE directory on your computer.

Step 4 Choose the JRE version.

Step 5 Click OK. 

Step 6 From the File menu, choose Exit. 

Step 7 In the confirmation dialog box, click Yes.

Step 8 Return to your originating procedure (NTP).

Purpose This task changes the JRE version, which is useful if you would like to 
upgrade to a later JRE version from earlier one without using the software 
or documentation CD. This does not affect the browser default version. 
After selecting the desired JRE version, you must exit CTC. The next time 
you log into a node, the new JRE version will be used.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup

Step 1 Click the CTC Alerts toolbar icon. 

Step 2 In the CTC Alerts dialog box, choose one of the following:

• All alerts—Sets the CTC Alerts dialog box to open automatically for all notifications.

• Error alerts only—Sets the CTC Alerts dialog box to open automatically for circuit deletion errors 
only.

• Never—Sets the CTC Alerts dialog box to never open automatically.

Step 3 Click Close.

Step 4 Return to your originating procedure (NTP).

Purpose This task sets up the CTC Alerts dialog box to open for all alerts, for circuit 
deletion errors only, or never. The CTC Alerts dialog box displays network 
disconnection, Send-PDIP inconsistency, circuit deletion status, condition 
retrieval errors, and software download failure.

Tools None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Cisco ONS 15454 DWDM
September 2004
C H A P T E R 3

Turn Up a Node

This chapter explains how to provision a single Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) node and turn it up for service, including node name, date and time, timing 
references, network attributes such as IP address and default router, users and user security, card 
installation, and DWDM connections.

Note Procedures in this chapter require that you have a network plan calculated for your DWDM network with 
Cisco MetroPlanner, Release 2.5. Cisco MetroPlanner is a DWDM planning tool that is available from 
your Cisco account representative. Cisco MetroPlanner prepares a shelf plan for each network node and 
calculates the power and attenuation levels for the DWDM cards installed in the node. For information 
about Cisco MetroPlanner, contact your Cisco account representative. For more information about 
MetroPlanner, refer to the Cisco MetroPlanner DWDM Installation and Operations Guide, Release 2.5.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the procedures (NTPs) that you need to complete to turn up a DWDM node. Turn to a 
procedure for applicable tasks (DLPs).

Complete the procedures applicable to your site plan from the following chapters:

• Chapter 1, “Install the Shelf and Common Control Cards”

• Chapter 2, “Connect the PC and Log into the GUI”

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G22 Verify Common Card Installation, page 3-2—Complete this procedure first.

2. NTP-G23 Create Users and Assign Security, page 3-3—Complete this procedure to create Cisco 
Transport Controller (CTC) users and assign their security levels.

3. NTP-G24 Set Up Name, Date, Time, and Contact Information, page 3-6—Continue with this 
procedure to set the node name, date, time, location, and contact information.

4. NTP-G25 Set Power Monitor Thresholds, page 3-8—Continue with this procedure to set the node 
battery power thresholds.
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5. NTP-G26 Set Up CTC Network Access, page 3-8—Continue with this procedure to provision the 
IP address, default router, subnet mask, and network configuration settings.

6. NTP-G27 Set Up the ONS 15454 for Firewall Access, page 3-19—Continue with this procedure if 
the ONS 15454 will be accessed behind firewalls.

7. NTP-G28 Set Up SNMP, page 3-22—Complete this procedure if simple network management 
protocol (SNMP) will be used for network monitoring.

8. NTP-G29 Preprovision a Slot, page 3-24—Complete this procedure to preprovision the ONS 15454 
slots. 

9. NTP-G30 Install the DWDM Cards, page 3-26—Complete this procedure to install the DWDM 
cards, including optical units, muxponders, and transponders.

10. NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-28—Complete this procedure 
next.

11. NTP-G32 Install the Transponder and Muxponder Cards, page 3-30—Complete this procedure next.

12. NTP-G33 Create a Y-Cable Protection Group, page 3-33—Complete this procedure, as needed, for 
TXP and MXP cards that will be protected with Y-cable protection.

13. NTP-G34 Install Fiber-Optic Cables on DWDM Cards, page 3-35—Complete this procedure, as 
needed, to install the fiber-optic cables on the DWDM cards.

14. NTP-G35 Route Fiber-Optic Cables, page 3-55—Complete this procedure, as needed, to route the 
fiber-optic cable.

15. NTP-G36 Calculate Cable Connections, page 3-56—Complete this procedure next.

16. NTP-G37 Run Automatic Node Setup, page 3-58—Complete this procedure next.

17. NTP-G38 Provision Terminations and Ring ID, page 3-60—Complete this procedure next.

18. NTP-G39 Verify OSCM and OSC-CSM Transmit Power, page 3-63—Complete this procedure next.

19. NTP-G40 Replace the Front Door, page 3-64—Complete this procedure, as needed, to replace the 
ONS 15454 front door.

NTP-G22 Verify Common Card Installation

Step 1 Verify that two TCC2 cards are installed in Slots 7 and 11.

Step 2 Verify that the green ACT (active) LED is illuminated on one TCC2 and the amber STBY (standby) LED 
is illuminated on the second TCC2. 

Purpose This procedure verifies that the ONS 15454 node has two TCC2 cards 
installed and is ready for turn up.

Tools/Equipment An engineering work order, site plan, or other document specifying the 
ONS 15454 card installation.

Prerequisite Procedures Chapter 1, “Install the Shelf and Common Control Cards”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Retrieve or higher
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Note If the TCC2 cards are not installed, or if their LEDs are not operating as described, do not 
continue. Repeat the “DLP-G33 Install the TCC2 Card” task on page 1-73 or refer to the Cisco 
ONS 15454 SONET and DWDM Troubleshooting Guide to resolve installation problems before 
proceeding to Step 3.

Step 3 If your site plan requires an AIC or AIC-I card, verify that the AIC/AIC-I card is installed in Slot 9 and 
its ACT (active) LED displays a solid green light.

Step 4 Verify that the software release shown on the LCD matches the software release indicated in your site 
plan. If the release does not match, perform one of the following procedures:

• Perform a software upgrade using a Cisco ONS 15454 software CD. Refer to the release-specific 
software upgrade document.

• Replace the TCC2 cards with cards containing the correct release.

Stop. You have completed this procedure.

NTP-G23 Create Users and Assign Security

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you need to create users. 
If you are already logged in, continue with Step 2.

Note You must log in as a Superuser to create additional users. The CISCO15 user provided with each 
ONS 15454 can be used to set up other ONS 15454 users. You can add up to 500 users to one 
ONS 15454.

Step 2 Complete the “DLP-G54 Create a New User—Single Node” task on page 3-4 or the “DLP-G55 Create 
a New User—Multiple Nodes” task on page 3-4 as needed.

Note You must add the same user name and password to each node a user will access.

Step 3 If you want to modify the security policy settings, including password aging and idle user timeout 
policies, complete the “NTP-G88 Modify Users and Change Security” procedure on page 9-34.

Stop. You have completed this procedure.

Purpose This procedure creates ONS 15454 users and assigns their security levels.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G54 Create a New User—Single Node

Step 1 In node view, click the Provisioning > Security > Users tabs.

Step 2 In the Users window, click Create.

Step 3 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must be 6 to 10 
characters.

• Password—Type the user password. The password must be a minimum of six and a maximum of 20 
alphanumeric (a-z, A-Z, 0-9) and special (+, #,%) characters, where at least two characters are non 
alphabetic and at least one character is a special character. For TL1 compatibility, the password must 
be 6 to 10 characters. The password must not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. See the “18.1 Users and Security” section on page 18-1for 
information about the capabilities provided with each level.

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before the password must be reentered. The defaults are: Retrieve user = unlimited, 
Maintenance user = 60 minutes, Provisioning user = 30 minutes, and Superuser = 15 minutes. 
To change the idle times, refer to the “NTP-G88 Modify Users and Change Security” procedure 
on page 9-34.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

DLP-G55 Create a New User—Multiple Nodes

Purpose This task creates a new user for one ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task adds a new user to multiple ONS 15454s.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Note All nodes where you want to add users must be accessible in network view.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Security > Users tabs.

Step 3 In the Users window, click Create.

Step 4 In the Create User dialog box, enter the following:

• Name—Type the user name. The name must be a minimum of six and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) characters. For TL1 compatibility, the user name must 
6 to 10 characters.

• Password—Type the user password. The password must be a minimum of six and a maximum of 
20 alphanumeric (a-z, A-Z, 0-9) and special (+, #, %) characters, where at least two characters are 
non alphabetic and at least one character is a special character. For TL1 compatibility, the password 
must be 6 to 10 characters. The password must not contain the user name.

• Confirm Password—Type the password again to confirm it.

• Security Level—Choose a security level for the user: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. Refer to the “18.1 Users and Security” section on page 18-1 
for information about the capabilities provided with each level.

Note Each security level has a different idle time. The idle time is the length of time that CTC can 
remain idle before it locks up and the password must be reentered. The defaults are: Retrieve 
user = unlimited, Maintenance user = 60 minutes, Provisioning user = 30 minutes, and 
Superuser = 15 minutes. To change the idle times, refer to the “NTP-G88 Modify Users and 
Change Security” procedure on page 9-34.

Step 5 Under “Select applicable nodes,” deselect any nodes where you do not want to add the user (all network 
nodes are selected by default).

Step 6 Click OK.

Step 7 In the User Creation Results dialog box, verify that the user was added to all the nodes chosen in Step 5. 
If not, click OK and repeat Steps 2 through 6. If the user was added to all nodes, click OK and continue 
with the next step.

Step 8 Return to your originating procedure (NTP).
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NTP-G24 Set Up Name, Date, Time, and Contact Information

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 for the node you will turn up. If you are 
already logged in, continue with Step 2.

Step 2 Click the Provisioning > General tabs.

Step 3 Enter the following information in the fields listed:

• Node Name—Type a name for the node. For TL1 compliance, names must begin with an alpha 
character and have no more than 20 alphanumeric (a-z, A-Z, 0-9) characters.

Note To avoid errors when you import the Cisco MetroPlanner configuration file in the “DLP-G74 
Import a Cisco MetroPlanner Configuration File” task on page 3-59, the CTC node name 
and the MetroPlanner site name should be the same or at least easy to identify.

• Contact—Type the name of the node contact person and the phone number, up to 255 characters 
(optional).

• Latitude—Enter the node latitude: N (north) or S (south), degrees, and minutes (optional).

• Longitude—Enter the node longitude: E (east) or W (west), degrees, and minutes (optional).

CTC uses the latitude and longitude to position ONS 15454 icons on the network view map. To 
convert a coordinate in degrees to degrees and minutes, multiply the number after the decimal by 
60. For example, the latitude 38.250739 converts to 38 degrees, 15 minutes (0.250739 x 60 = 
15.0443, rounded to the nearest whole number).

• Description—Type a description of the node. The description can be a maximum of 255 characters. 

• Use NTP/SNTP Server—When checked, CTC uses a Network Time Protocol (NTP) or Simple 
Network Time Protocol (SNTP) server to set the date and time of the node. 

If you do not use an SNTP or NTP server, complete the Date and Time fields. The ONS 15454 will 
use these fields for alarm dates and times. (CTC displays all alarms in the login node’s time zone 
for cross network consistency.)

Note Using an NTP or SNTP server ensures that all ONS 15454 network nodes use the same date 
and time reference. The server synchronizes the node’s time after power outages or software 
upgrades.

If you check the Use NTP/SNTP Server check box, type the IP address of one of the following:

– an NTP/SNTP server connected to the ONS 15454

Purpose This procedure provisions identification information for the node, 
including the node name, a contact name and phone number, the location 
of the node, and the date, time, and time zone. 

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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– Another ONS 15454 with NTP/SNTP enabled that is connected to the ONS 15454

If you check gateway network element (GNE) for the ONS 15454 proxy server (see “DLP-G56 
Provision IP Settings” task on page 3-9), external ONS 15454s must reference the gateway 
ONS 15454 for NTP/SNTP timing. For more information about the ONS 15454 gateway settings, 
see Chapter 19, “CTC Connectivity Reference.”

Caution If you reference another ONS 15454 for the NTP/SNTP server, make sure the second ONS 15454 
references an NTP/SNTP server and not the first ONS 15454 (that is, do not create an NTP/SNTP timing 
loop by having two ONS 15454s reference each other).

• Date—If Use NTP/SNTP Server is not checked, type the current date in the format m/d/yyyy, for 
example, September 24, 2002 is 9/24/2002.

• Time—If Use NTP/SNTP Server is not checked, type the current time in the format hh:mm:ss, for 
example, 11:24:58. The ONS 15454 uses a 24-hour clock, so 10:00 PM is entered as 22:00:00.

• Time Zone—Click the field and choose a city within your time zone from the drop-down list. The 
menu displays the 80 World Time Zones from –11 through 0 (GMT) to +14. Continental United 
States time zones are GMT-05:00 (Eastern), GMT-06:00 (Central), GMT-07:00 (Mountain), and 
GMT-08:00 (Pacific).

• Use Daylight Savings Time—Check this check box if the time zone that you chose is using Daylight 
Savings Time.

• Insert AIS-V on STS-1 SD-P—Not used in DWDM networks.

• SD-P BER—Not used in DWDM networks.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Review the node information. If you need to make corrections, repeat Steps 3 through 5 to enter the 
corrections. If the information is correct, continue with the “NTP-G25 Set Power Monitor Thresholds” 
procedure on page 3-8.

Stop. You have completed this procedure.
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NTP-G25 Set Power Monitor Thresholds

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 for the node you will set up. If you are already 
logged in, continue with Step 2.

Step 2 In node view, click the Provisioning > General > Power Monitor tabs.

Step 3 To change the extreme low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
ELWBATVGVdc drop-down list.

Step 4 To change the low battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
LWBATVGVdc drop-down list.

Step 5 To change the high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
HIBATVGVdc drop-down list.

Step 6 To change the extreme high battery voltage threshold in 0.5 VDC increments, choose a voltage from the 
EHIBATVGVdc drop-down list.

Step 7 Click Apply.

Stop. You have completed this procedure.

NTP-G26 Set Up CTC Network Access

Purpose This procedure provisions extreme high, extreme low, and low input 
battery power thresholds within a –48 volts direct current (VDC) 
environment. When the thresholds are crossed, the TCC2 generates 
warning alarms in CTC. For ONS 15454 power specifications, see 
Appendix B, “Hardware Specifications.”

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-2

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure provisions network access for a node, including its subnet 
mask, default router, Dynamic Host Configuration Protocol (DHCP) 
server, IIOP (Internet Inter-Orb Protocol) listener port, proxy server 
settings, static routes, Open Shortest Path First (OSPF) protocol, and 
Routing Information Protocol (RIP).

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-2

Required/As Needed Required 

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-G56 Provision IP Settings” task on page 3-9 to provision the ONS 15454 IP address, 
subnet mask, default router, DHCP server, IIOP listener port, and proxy server settings.

Tip If you cannot log into the node, you can change its IP address, default router, and network mask 
by using the LCD on the ONS 15454 fan-tray assembly (unless LCD provisioning is 
suppressed). See the “DLP-G57 Set the IP Address, Default Router, and Network Mask Using 
the LCD” task on page 3-13 for instructions. However, you cannot use the LCD to provision any 
other network settings.

Step 3 If static routes are needed, complete the “DLP-G58 Create a Static Route” task on page 3-15. For more 
information about static routes, see Chapter 19, “CTC Connectivity Reference.” 

Step 4 If the ONS 15454 is connected to a LAN or WAN that uses OSPF, complete the “DLP-G59 Set Up or 
Change Open Shortest Path First Protocol” task on page 3-16.

Step 5 If the ONS 15454 is connected to a LAN or WAN that uses RIP, complete the “DLP-G60 Set Up or 
Change Routing Information Protocol” task on page 3-18.

Stop. You have completed this procedure.

DLP-G56 Provision IP Settings

Caution All network changes should be approved by your network (or LAN) administrator.

Step 1 In node view, click the Provisioning > Network tabs.

Step 2 Complete the following information in the fields listed:

• IP Address—Type the IP address assigned to the ONS 15454 node.

• Suppress CTC IP Display—Check this check box if you want to prevent the node IP address from 
being displayed in CTC to users with Provisioner, Maintenance, or Retrieve security levels. (The IP 
address suppression is not applied to users with Superuser security level.)

• LCD IP Display—Choose one of the following:

Purpose This task provisions IP settings, which includes the IP address, default 
router, DHCP access, firewall access, and proxy server settings for an 
ONS 15454 node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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– Allow Configuration—Displays the node IP address on the LCD and allows users to change the 
IP settings using the LCD. This option enables the “DLP-G57 Set the IP Address, Default 
Router, and Network Mask Using the LCD” task on page 3-13.

– Display Only—Displays the node IP address on the LCD but does not allow users to change the 
IP address using the LCD.

– Suppress Display—Suppresses the node IP address display on the LCD.

• Default Router—If the ONS 15454 must communicate with a device on a network that the 
ONS 15454 is not directly connected to, the ONS 15454 can forward the packets to the default 
router. Type the IP address of the router in this field. 

Note This field is ignored if the node is not connected to a LAN, or if you enable any of the 
gateway settings to implement the ONS 15454 proxy server feature.

• Forward DHCP Request To—Check this check box to enable DHCP. Also, enter the DHCP server 
IP address in the Request To field. Unchecked is the default. If you will enable any of the gateway 
settings to implement the ONS 15454 proxy server features, leave this field blank.

Note If you enable DHCP, computers connected to an ONS 15454 node can obtain temporary IP 
addresses from an external DHCP server. The ONS 15454 only forwards DHCP requests; it 
does not act as a DHCP server.

• MAC Address—(Display only.) Displays the ONS 15454 IEEE 802 MAC address.

• Net/Subnet Mask Length—Type the subnet mask length (decimal number representing the subnet 
mask length in bits) or click the arrows to adjust the subnet mask length. The subnet mask length is 
the same for all ONS 15454s in the same subnet.

• TCC CORBA (IIOP) Listener Port—Provisions the ONS 15454 IIOP listener port. This listener port 
enables communication with the ONS 15454 through firewalls. See the “NTP-G27 Set Up the 
ONS 15454 for Firewall Access” procedure on page 3-19 for more information.

• Gateway Settings—Provides options that enable the ONS 15454 proxy server features. In proxy 
server networks, the ONS 15454 is either an end network element (ENE), gateway network element 
(GNE), or proxy-only server. GNEs and ENEs manage their craft Ethernet ports differently. A GNE 
will connect to an entire intranet or internet through its craft Ethernet port. An ENE will only 
communicate with the hosts that have connected to it, such as a CTC computer or other 
ONS 15454 ENE. Provisioning must be consistent for each NE type. For more information, see the 
“19.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server” section on page 19-11.

• Enable proxy server on port—If checked, the ONS 15454 serves as a proxy for connections between 
CTC clients and ONS 15454s that are DCC-connected to the proxy ONS 15454. The CTC client 
establishes connections to data communications channel (DCC)-connected nodes through the proxy 
node. The CTC client does not require IP connectivity to the DCC-connected nodes, only to the 
proxy ONS 15454. If Enable proxy server on port is off, the node does not proxy for any CTC 
clients, although any established proxy connections continue until the CTC client exits. When this 
box is checked, you can set the node as an ENE or a GNE:

– End Network Element (ENE)—If selected, the CTC computer is only visible to the ONS 15454 
to which the CTC computer is connected. The computer is not visible to other DCC-connected 
nodes. In addition, firewall is enabled, which means that the node prevents IP traffic from being 
routed between the DCC and the LAN port. 
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– Gateway Network Element (GNE)—If selected, the CTC computer is visible to other 
DCC-connected nodes. The node prevents IP traffic from being routed between the DCC and 
the LAN port. 

– Proxy-only—If selected, the ONS 15454 responds to CTC requests with a list of 
DCC-connected nodes for which the node serves as a proxy. The CTC computer is visible to 
other DCC-connected nodes. The node does not prevent traffic from being routed between the 
DCC and LAN port.

Step 3 Click Apply.

Step 4 Click Yes in the confirmation dialog box.

Both TCC2 cards reboot, one at a time. During this time (approximately 5 minutes), the active and 
standby TCC2 card LEDs go through the cycle shown in Table 3-1. Eventually, a “Lost node connection, 
switching to network view” message appears.
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Step 5 Click OK. The network view appears. The node icon appears in gray, during which time you cannot 
access the node.

Step 6 Double-click the node icon when it becomes green. 

Step 7 Return to your originating procedure (NTP). 

Table 3-1 LED Behavior During TCC2 Reboot

Reboot Activity Active TCC2 LEDs Standby TCC2 LEDs

Standby TCC2 card updated with new 
network information.

Memory test (1 to 2 minutes).

If an AIC or AIC-I card is installed, 
AIC FAIL and alarm LEDs light up 
briefly when the AIC is updated. 

The standby TCC2 becomes the active 
TCC2.

ACT/STBY: Flashing green. 1. ACT/STBY: Flashing yellow.

2. FAIL LED: Solid red.

3. All LEDs on except ACT/STBY.

4. CRIT turns off.

5. MAJ and MIN turn off.

6. REM, SYNC, and ACO turn off.

7. All LEDs (except A&B PWR) 
turn off (1 to 2 minutes).

8. ACT/STBY: Solid yellow.

9. Alarm LEDs: Flash once.

10. ACT/STBY: Solid green.

Memory test (1 to 2 minutes).

TCC2 updated with new network 
information.

The active TCC2 becomes the standby 
TCC2.

1. All LEDs: Turn off (1 to 2 minutes). 
CTC displays “Lost node connection, 
switching to network view” message.

2. FAIL LED: Solid red.

3. FAIL LED: Flashing red.

4. All LEDs on except ACT/STBY.

5. CRIT turns off.

6. MAJ and MIN turn off.

7. REM, SYNC, and ACO turn off; all 
LEDs are off.

8. ACT/STBY: Solid yellow.

9. ACT/STBY: Flashing yellow.

10. ACT/STBY: Solid yellow.

ACT/STBY: Solid green.
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DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD

Note You cannot perform this task if the LCD IP Display on the node view Provisioning > Network tab is set 
to Display Only or Suppress Display. See “DLP-G56 Provision IP Settings” task on page 3-9 to view or 
change the LCD IP Display field.

Note The LCD reverts to normal display mode after 5 seconds of button inactivity.

Step 1 On the ONS 15454 front panel, repeatedly press the Slot button until Node appears on the LCD.

Step 2 Repeatedly press the Port button until the following displays:

• To change the node IP address, Status=IpAddress (Figure 3-1)

• To change the node network mask, Status=Net Mask

• To change the default router IP address, Status=Default Rtr

Figure 3-1 Selecting the IP Address Option

Step 3 Press the Status button to display the node IP address (Figure 3-2), the node subnet mask length, or the 
default router IP address.

Figure 3-2 Changing the IP Address

Step 4 Push the Slot button to move to the IP address or subnet mask digit you need to change. The selected 
digit flashes.

Purpose This task changes the ONS 15454 IP address, default router, and network 
mask using the LCD on the fan-tray assembly. Use this task if you cannot 
log into CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 Card, page 1-73

Required/As Needed Optional

Onsite/Remote Onsite

Security Level None

FAN FAIL

Slot

Slot-0
Status=IpAddress

44
08

9CRIT MAJ MIN

Status Port

FAN FAIL

Slot

172.020.214.107
<Next   Done      Mod>

44
09

0CRIT MAJ MIN

Status Port
3-13
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 3      Turn Up a Node
DLP-G57 Set the IP Address, Default Router, and Network Mask Using the LCD
Tip The Slot, Status, and Port button positions correspond to the command position on the LCD. For 
example, in Figure 3-2, you press the Slot button to invoke the Next command and the Port 
button to invoke the Done command.

Step 5 Press the Port button to cycle the IP address or subnet mask to the correct digit.

Step 6 When the change is complete, press the Status button to return to the Node menu.

Step 7 Repeatedly press the Port button until the Save Configuration option appears (Figure 3-3).

Figure 3-3 Selecting the Save Configuration Option 

Step 8 Press the Status button to choose the Save Configuration option.

A Save and REBOOT message appears (Figure 3-4).

Figure 3-4 Saving and Rebooting the TCC2/TCC2P

Step 9 Press the Slot button to apply the new IP address configuration or press Port to cancel the configuration.

Saving the new configuration causes the TCC2 cards to reboot. During the reboot, a “Saving Changes - 
TCC Reset” message displays on the LCD. The LCD returns to the normal alternating display after the 
TCC2 reboot is complete.

Note The IP address and default router must be on the same subnet. If not, you cannot apply the 
configuration. 

Step 10 Return to your originating procedure (NTP).

FAN FAIL

Slot

Slot-0
Status=Save Cfg.

44
09

1CRIT MAJ MIN

Status Port

FAN FAIL

Slot

Save and REBOOT?
<Apply            Revert>

44
09

2CRIT MAJ MIN

Status Port
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DLP-G58 Create a Static Route

Step 1 In node view, click the Provisioning > Network tabs.

Step 2 Click the Static Routing tab. Click Create.

Step 3 In the Create Static Route dialog box, enter the following: 

• Destination—Enter the IP address of the computer running CTC. To limit access to one computer, 
enter the full IP address and a subnet mask of 255.255.255.255. To allow access to all computers on 
the 192.168.1.0 subnet, enter 192.168.1.0 and a subnet mask of 255.255.255.0. You can enter a 
destination of 0.0.0.0 to allow access to all CTC computers that connect to the router.

• Mask—Enter a subnet mask. If the destination is a host route (that is, one CTC computer), enter a 
32-bit subnet mask (255.255.255.255). If the destination is a subnet, adjust the subnet mask 
accordingly, for example, 255.255.255.0. If the destination is 0.0.0.0, CTC automatically enters a 
subnet mask of 0.0.0.0 to provide access to all CTC computers. You cannot change this value.

• Next Hop—Enter the IP address of the router port or the node IP address if the CTC computer is 
connected to the node directly.

• Cost—Enter the number of hops between the ONS 15454 and the computer. 

Step 4 Click OK. Verify that the static route appears in the Static Route window.

Note Static route networking examples are provided in Chapter 19, “CTC Connectivity Reference.”

Step 5 Return to your originating procedure (NTP).

Purpose This task creates a static route to establish CTC connectivity to a computer 
on another network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed Required if either of the following conditions are is true:

• CTC computers on one subnet need to connect to ONS 15454s that are 
connected by a router to ONS 15454s residing on another subnet. 
OSPF is not enabled and the External Network Element gateway 
setting is not checked.

• You need to enable multiple CTC sessions among ONS 15454s 
residing on the same subnet and the External Network Element 
gateway setting is not enabled.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G59 Set Up or Change Open Shortest Path First Protocol

Step 1 In node view, click the Provisioning > Network > OSPF tabs.

Step 2 On the top left side of the OSPF pane, complete the following:

• DCC/GCC OSPF Area ID Table—In dotted decimal format, enter the number that identifies the 
ONS 15454s as a unique OSPF area ID. The Area ID can be any number between 000.000.000.000 
and 255.255.255.255, but must be unique to the LAN OSPF area.

• SDCC Metric—This value is normally unchanged. It sets a cost for sending packets across the 
Section DCC, which is used by OSPF routers to calculate the shortest path. This value should always 
be higher than the LAN metric. The default SDCC metric is 100. 

• LDCC Metric—Sets a cost for sending packets across the Line DCC. This value should always be 
lower than the SDCC metric. The default LDCC metric is 33. It is usually not changed.

Step 3 In the OSPF on LAN area, complete the following:

• OSPF active on LAN—When checked, enables the ONS 15454 OSPF topology to be advertised to 
OSPF routers on the LAN. Enable this field on ONS 15454s that directly connect to OSPF routers.

• LAN Port Area ID—Enter the OSPF area ID (dotted decimal format) for the router port where the 
ONS 15454 is connected. (This number is different from the DCC/GCC OSPF Area ID.)

Step 4 By default, OSPF is set to No Authentication. If the OSPF router requires authentication, complete the 
following steps. If not, continue with Step 5.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

• Enter Authentication Key—Enter the password.

• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 5 Provision the OSPF priority and interval settings.

The OSPF priority and interval defaults are ones most commonly used by OSPF routers. Verify that these 
defaults match the ones used by the OSPF router where the ONS 15454 is connected.

• Router Priority—Selects the designated router for a subnet.

Purpose This task enables the Open Shortest Path First (OSPF) routing protocol on 
the ONS 15454. Perform this task if you want to include the ONS 15454 in 
OSPF-enabled networks.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

You will need the OSPF Area ID, Hello and Dead intervals, and 
authentication key (if OSPF authentication is enabled) provisioned on the 
router to which the ONS 15454 is connected.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Hello Interval (sec)—Sets the number of seconds between OSPF hello packet advertisements sent 
by OSPF routers. Ten seconds is the default.

• Dead Interval—Sets the number of seconds that will pass while an OSPF router’s packets are not 
visible before its neighbors declare the router down. Forty seconds is the default.

• Transit Delay (sec)—Indicates the service speed. One second is the default.

• Retransmit Interval (sec)—Sets the time that will elapse before a packet is resent. Five seconds is 
the default.

• LAN Metric—Sets a cost for sending packets across the LAN. This value should always be lower 
than the SDCC metric. Ten is the default.

Step 6 Under OSPF Area Range Table, create an area range table if one is needed:

Note Area range tables consolidate the information that is outside an OSPF area border. One 
ONS 15454 in the ONS 15454 OSPF area is connected to the OSPF router. An area range table 
on this node points the router to the other nodes that reside within the ONS 15454 OSPF area. 

a. Under OSPF Area Range Table, click Create.

b. In the Create Area Range dialog box, enter the following:

• Range Address—Enter the area IP address for the ONS 15454s that reside within the OSPF area. 
For example, if the ONS 15454 OSPF area includes nodes with IP addresses 10.10.20.100, 
10.10.30.150, 10.10.40.200, and 10.10.50.250, the range address would be 10.10.0.0.

• Range Area ID—Enter the OSPF area ID for the ONS 15454s. This is either the ID in the DCC 
OSPF Area ID field or the ID in the Area ID for LAN Port field.

• Mask Length—Enter the subnet mask length. In the Range Address example, this is 16. 

• Advertise—Check if you want to advertise the OSPF range table.

c. Click OK.

Step 7 All OSPF areas must be connected to Area 0. If the ONS 15454 OSPF area is not physically connected 
to Area 0, use the following steps to create a virtual link table that will provide the disconnected area 
with a logical path to Area 0:

a. Under OSPF Virtual Link Table, click Create.

b. In the Create Virtual Link dialog box, complete the following fields. OSPF settings must match 
OSPF settings for the ONS 15454 OSPF area:

• Neighbor—The router ID of the Area 0 router.

• Transit Delay (sec)—The service speed. One second is the default.

• Hello Int (sec)—The number of seconds between OSPF hello packet advertisements sent by 
OSPF routers. Ten seconds is the default.

• Auth Type—If the router where the ONS 15454 is connected uses authentication, choose 
Simple Password. Otherwise, choose No Authentication.

• Retransmit Int (sec)—Sets the time that will elapse before a packet is resent. Five seconds is the 
default.

• Dead Int (sec)—Sets the number of seconds that will pass while an OSPF router’s packets are 
not visible before its neighbors declare the router down. Forty seconds is the default.

c. Click OK.

Step 8 After entering ONS 15454 OSPF area data, click Apply.
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If you changed the Area ID, the TCC2 cards reset, one at a time. The reset takes approximately 
10 to 15 minutes. Table 3-1 on page 3-12 shows the LED behavior during the TCC2 reset. 

Step 9 Return to your originating procedure (NTP).

DLP-G60 Set Up or Change Routing Information Protocol

Step 1 In node view, click the Provisioning > Network > RIP tabs. 

Step 2 Check the RIP Active check box if you are activating RIP. 

Step 3 Choose either RIP Version 1 or RIP Version 2 from the drop-down list, depending on which version is 
supported in your network. 

Step 4 Set the RIP metric. The RIP metric can be set to a number between 1 and 15 and represents the number 
of hops. 

Step 5 By default, RIP is set to No Authentication. If the router that the ONS 15454 is connected to requires 
authentication, complete the following steps. If not, continue with Step 6.

a. Click the No Authentication button.

b. In the Edit Authentication Key dialog box, complete the following:

• Type—Choose Simple Password.

• Enter Authentication Key—Enter the password, 

• Confirm Authentication Key—Enter the same password to confirm it.

c. Click OK.

The authentication button label changes to Simple Password.

Step 6 If you want to complete an address summary, complete the following steps. If not, continue with Step 7. 
Complete the address summary only if the ONS 15454 is a gateway NE with multiple external ONS 
15454 NEs attached with IP addresses in different subnets.

a. In the RIP Address Summary area, click Create.

b. In the Create Address Summary dialog box, complete the following:

• Summary Address—Enter the summary IP address.

• Mask Length—Enter the subnet mask length using the up and down arrows.

Purpose This task enables Routing Information Protocol (RIP) on the ONS 15454. 
Perform this task if you want to include the ONS 15454 in RIP-enabled 
networks.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

You need to create a static route to the router adjacent to the ONS 15454 
for the ONS 15454 to communicate its routing information to 
non-DCC-connected nodes.

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Hops—Enter the number of hops. The smaller the number of hops, the higher the priority.

c. Click OK.

Step 7 Return to your originating procedure (NTP).

NTP-G27 Set Up the ONS 15454 for Firewall Access

Step 1 Log into a node that is behind the firewall. See the “DLP-G46 Log into CTC” task on page 2-25 for 
instructions. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G61 Provision the IIOP Listener Port on the ONS 15454” task on page 3-20.

Figure 3-5 shows ONS 15454s in a protected network and the CTC computer in an external network. For 
the computer to access the ONS 15454s, you must provision the IIOP listener port specified by your 
firewall administrator on the ONS 15454. 

Figure 3-5 Nodes Behind a Firewall

Step 3 If the CTC computer resides behind a firewall, complete the “DLP-G62 Provision the IIOP Listener Port 
on the CTC Computer” task on page 3-22.

Figure 3-6 shows a CTC computer and ONS 15454 behind firewalls. For the computer to access the 
ONS 15454, you must provision the IIOP port on the CTC computer and on the ONS 15454. 

Purpose This procedure provisions ONS 15454s and CTC computers for access 
through firewalls.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

55
35

1

CTC computer

External network Protected network

ONS 15454
Unprotected

network
Private
network

IIOP port

IIOP port

Firewall

Port
filtering ONS 15454
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Figure 3-6 CTC Computer and ONS 15454s Residing Behind Firewalls

Stop. You have completed this procedure.

DLP-G61 Provision the IIOP Listener Port on the ONS 15454

Note If the Enable Proxy Server on port 1080 check box is checked, CTC will use port 1080 and ignore the 
configured IIOP port setting. If Enable Proxy Server is subsequently unchecked, the configured IIOP 
listener port will be used.

Step 1 In node view, click the Provisioning > Network > General tabs.

Step 2 In the TCC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - TCC Fixed—Uses Port 57790 to connect to ONS 15454s on the same side of the firewall 
or if no firewall is used (default). This option can be used for access through a firewall if Port 57790 
is open.

• Standard Constant—Uses Port 683, the CORBA default port number.

• Other Constant—If Port 683 is not used, type the IIOP port specified by your firewall administrator. 
The port cannot use any of the ports shown in Table 3-2.

55
35

0

CTC computer

Firewall

Port
filtering

Protected network External network Protected network

ONS 15454
Private
network

Unprotected
network

Private
network

IIOP port
IIOP port

IIOP port

Firewall

Port
filtering ONS 15454

Purpose This task sets the IIOP listener port on the ONS 15454, which enables you 
to access ONS 15454s that reside behind a firewall.

Tools/Equipment IIOP listener port number provided by your LAN or firewall administrator

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Click Apply.

Step 4 When the Change Network Configuration message appears, click Yes. 

Both ONS 15454 TCC2/TCC2Ps reboot, one at a time. The reboot takes approximately 15 minutes. 

Step 5 Return to your originating procedure (NTP).

Table 3-2 Ports Used by the TCC2 Cards

Port Function

0 Reserved

21 FTP control

23 Telnet

80 HTTP

111 rpc (not used; but port is in use)

513 rlogin (not used; but port is in use)

=<1023 Default CTC listener ports

1080 Proxy server

2001-2017 I/O card telnet

2018 DCC processor on active TCC2/TCC2P

2361 TL1

3082 TL1

3083 TL1

5001 Bidirectional line switched ring (BLSR) 
server port

5002 BLSR client port

7200, 7209, 7210 SNMP input port

9100 EQM port

9101 EQM port 2

9401 TCC2/TCC2P boot port

9999 Flash manager

57790 Default TCC2/TCC2P listener port
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DLP-G62 Provision the IIOP Listener Port on the CTC Computer

Step 1 From the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the Firewall tab.

Step 3 In the CTC CORBA (IIOP) Listener Port area, choose a listener port option:

• Default - Variable—Use to connect to ONS 15454s from within a firewall or if no firewall is used 
(default).

• Standard Constant—Use Port 683, the CORBA default port number.

• Other Constant—If Port 683 is not used, enter the IIOP port defined by your administrator.

Step 4 Click Apply. A warning appears telling you that the port change will apply during the next CTC login.

Step 5 Click OK. 

Step 6 In the Preferences dialog box, click OK.

Step 7 To access the ONS 15454 using the IIOP port, log out of CTC then log back in. (To log out, choose Exit 
from the File menu).

Step 8 Return to your originating procedure (NTP).

NTP-G28 Set Up SNMP

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to set up SNMP. 
If you are already logged in, continue with Step 2.

Step 2 In node view, click the Provisioning > SNMP tabs.

Step 3 In the Trap Destinations area, click Create.

Purpose This task selects the IIOP listener port on CTC.

Tools/Equipment IIOP listener port number from LAN or firewall administrator.

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-2

DLP-G46 Log into CTC, page 2-25 

Required/As Needed Required only if the computer running CTC resides behind a firewall.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure provisions the SNMP parameters so that you can use 
SNMP management software with the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G22 Verify Common Card Installation, page 3-2

Required/As Needed Required if SNMP is used at your installation.

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Complete the following in the Create SNMP Trap Destination dialog box (Figure 3-7):

• Destination IP Address—Type the IP address of your network management system. If the node you 
are logged into is an ENE, set the destination address to the GNE. 

• Community—Type the SNMP community name. For a description of SNMP community names, 
refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide. 

Note The community name is a form of authentication and access control. The community name 
assigned to the ONS 15454 is case-sensitive and must match the community name of the 
network management system (NMS).

• UDP Port—The default User Datagram Protocol (UDP) port for SNMP is 162. If the node is an ENE 
in a proxy server network, the UDP port must be set to the GNE’s SNMP relay port, which is 391. 

• Trap Version—Choose either SNMPv1 or SNMPv2. Refer to your NMS documentation to determine 
whether to use SNMP v1 or v2.

Figure 3-7 Creating an SNMP Trap

Step 5 Click OK. The node IP address of the node where you provisioned the new trap destination appears in 
the Trap Destinations area.

Step 6 Click the node IP address in the Trap Destinations area. Verify the SNMP information that appears in 
the Selected Destination list.

Step 7 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets 
check box. If this box is not checked, SET requests are rejected.

Step 8 If you want to set up the SNMP proxy feature to allow network management, message reporting, and 
performance statistic retrieval across ONS firewalls, click the Enable SNMP Proxy check box located 
on the SNMP tab.

Note The ONS firewall proxy feature only operates on nodes running Software Release 4.6 or later. 
Using this feature effectively breaches the ONS firewall to exchange management information.

For more information about the SNMP proxy feature, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide. 

Step 9 Click Apply.

Step 10 If you are setting up SNMP proxies, for each trap destination address you can set up to three relays that 
send SNMP trap error counts back to NE:

a. Click the first trap destination IP address. The address and its community name appear in the 
Destination fields.
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b. Enter up to three SNMP Proxy relay addresses and community names in the fields for Relay A, 
Relay B, and Relay C.

Note The community names specified for each relay node must match one of the provisioned 
SNMP community names in the NE. 

Note The SNMP proxy directs SNMP traps from this node through IpA to IpB to IpC to the trap 
destination. Ensure that you enter the IP addresses in the correct order so that this sequence 
runs correctly.

Step 11 Click Apply.

Stop. You have completed this procedure.

NTP-G29 Preprovision a Slot

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to preprovision 
the slots. If you are already logged in, continue with Step 2.

Step 2 If you have Cisco MetroPlanner R2.5, launch the application and continue with Step 4. If you do not 
have Cisco MetroPlanner, you must have a print out of the node layout prepared by Cisco MetroPlanner. 
R2.5. If so, continue with Step 6. Do not continue if a node layout prepared by Cisco MetroPlanner is 
not available.

Step 3 In Cisco MetroPlanner, load the network plan for your installation. (For information about using Cisco 
MetroPlanner, refer to the Cisco MetroPlanner DWDM Operations Guide.)

Purpose This procedure preprovisions the card slots in CTC based upon the network 
plan that was calculated for your site by Cisco MetroPlanner. (If you do not 
have Cisco MetroPlanner, you must enter the DWDM provisioning 
manually with a customized design.) Preprovisioning the slots ensures that 
the physical cards are installed in the slots anticipated by the automatic 
node setup parameters that will be imported from Cisco MetroPlanner.

Tools/Equipment None

Prerequisite Procedures Chapter 2, “Connect the PC and Log into the GUI”

One of the following:

• Cisco MetroPlanner Release 2.5 and the electronic site plan prepared 
for your network.

• An hard copy of the node layout prepared by Cisco MetroPlanner for 
your network.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 In Cisco MetroPlanner, display the Site Dialog window for the node you are provisioning. A site 
installation example is shown in Figure 3-8.

Figure 3-8 Cisco MetroPlanner Site Dialog Window

Step 5 Arrange the CTC and the Cisco MetroPlanner windows so you can view both windows simultaneously. 

Step 6 In CTC node view, right-click an empty slot where you will install a card.

Step 7 From the Add Card popup menu, choose the card type that will be installed based on the Cisco 
MetroPlanner Site Dialog window. Only cards that can be installed in the slot appear in the Add Card 
popup menu.

Note When you preprovision a slot, the card appears purple in the CTC shelf graphic, rather than 
white when a card is installed in the slot. NP (not present) on the card graphic indicates that the 
card is not physically installed.

Step 8 Repeat Step 7 until all the cards shown in the Cisco MetroPlanner the Site Dialog window are 
provisioned in CTC.

Stop. You have completed this procedure.
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NTP-G30 Install the DWDM Cards

Warning During this procedure, wear grounding wrist straps to avoid damaging the card. Do not directly touch 
the backplane with your hand or any metal tool due to electrical hazard.

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Class 1M Laser Product.

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments. Viewing the laser output with 
certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance 
of 100 mm may pose an eye hazard. Use of controls or adjustments or performance of procedures other 
than those specified may result in hazardous radiation exposure. 

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Display the card installation plan for the node using one of the following sources: 

• The Cisco MetroPlanner Site Dialog window (Figure 3-8) for the node you are provisioning.

• CTC node view with slots preprovisioned based on the Cisco MetroPlanner Site Dialog window.

Purpose This procedure describes how to install DWDM cards (OPT-PRE, 
OPT-BST, 32MUX-O, 32DMX-O, 32DMX, 32WSS, 4MD-xx.x, 
AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, AD-4B-xx.x, 
OSCM, and OSC-CSM). 

Tools/Equipment OPT-PRE, OPT-BST, 32MUX-O, 32DMX-O, 32DMX, 32WSS, 
4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, 
AD-4B-xx.x, OSCM, or OSC-CSM cards (as applicable)

Prerequisite Procedures DLP-G33 Install the TCC2 Card, page 1-73

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Written slot plan. The plan must be based on the Cisco MetroPlanner Site Dialog window for your 
installation.

Step 2 Double check that the card placement fits within the following installation guidelines:

• OPT-BST—Any open east and west pair of slots but usually installed in Slots 1 and 17

• OPT-PRE—Any open east and west pair of slots but usually installed in Slots 2 and 16

• OSCM—Slots 8 and 10

• OSC-CSM—Any open east and west pair of slots

• 32MUX-O, 32DMX-O, 32DMX, 32WSS—Double-slot card; any two open slots.

• AD-xB-xx.x, AD-xC-xx.x, and 4MD-xx.x—Any open slots

Step 3 Remove the DWDM card from its packaging, then remove the protective caps from the backplane 
connectors.

Step 4 Open the card latches/ejectors. 

Step 5 Use the latches/ejectors to firmly slide the card along the slot guide rails until the card plugs into the 
receptacle at the back of the slot. 

Step 6 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches/ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 7 Verify the LED activity:

• The FAIL LED turns on for approximately 35 seconds.

• The FAIL LED blinks for approximately 40 seconds.

• All LEDs turn on and then turn off within 5 seconds.

• If new software is being downloaded to the card, the ACT and SF LEDs blink for 20 seconds to 
3.5 minutes, depending on the card type.

• The ACT LED turns on.

• The signal fail (SF) LED stays on until all card ports connect to their far-end counterparts and a 
signal is present.

Step 8 If the card does not boot up properly, or the LED activity does not mimic Step 7, check the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot. If a DWDM card does not boot, open CTC and ensure that the slot is not provisioned 
for a different card type before assuming that the card is faulty.

• If the red FAIL LED does not turn on, check the power. 

• If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed. 
Remove the card and repeat Steps 3 to 7. If the card does not boot up properly the second time, it 
may be defective. Contact your next level of support.
3-27
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 3      Turn Up a Node
NTP-G31 Install the DWDM Dispersion Compensating Units
Note The DWDM node type is determined by the cards that are installed. For example, if two 
32DMX-O and two 32MUX-O cards are installed but no AD-xC or AD-xB cards are installed, 
CTC considers the node a hub node. However, if one 32DMX-O and one 32MUX-O card are 
installed with no AD-xC or AD-xB cards, CTC considers the node a terminal node. For more 
information, refer to Chapter 14, “Card Reference.”

Step 9 Repeat Steps 3 through 8 until all the DWDM cards are installed in the node.

Step 10 If you installed OPT-PRE cards, complete one of the following based upon your MetroPlanner site plan. 
If an OPT-PRE card is not installed, continue with Step 11.

• If the site plan includes DCUs, complete the “NTP-G31 Install the DWDM Dispersion 
Compensating Units” procedure on page 3-28. 

• If the site plan does not include DCUs, install a 5 dB attenuator between the OPT-PRE DC TX and 
RX ports. 

Step 11 Continue with the “NTP-G32 Install the Transponder and Muxponder Cards” procedure on page 3-30.

Stop. You have completed this procedure. 

NTP-G31 Install the DWDM Dispersion Compensating Units

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Class 1M laser product.

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments. Viewing the laser output with 
certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance 
of 100 mm may pose an eye hazard. Use of controls or adjustments or performance of procedures other 
than those specified may result in hazardous radiation exposure. 

Purpose This procedure describes how to install the dispersion compensating units 
(DCU-xx.x) for DWDM shelves and is required if OPT-PRE cards are 
installed.

Tools/Equipment DCU-xx.x cards

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-72

NTP-G30 Install the DWDM Cards, page 3-26

DLP-G27 Install the DCU Shelf Assembly, page 1-67

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note If protective clips are installed on the backplane connectors of the DCUs, remove the clips before 
installing the units.

Note If a DCU is not installed and OPT-PRE cards are installed, insert a 5 dB attenuator between the OPT-PRE 
DC TX and RX ports.

Step 1 Pull the DCU latch inward with your finger.

Step 2 Firmly slide the DCU along the guide rails until the card plugs into the receptacle at the back of the 
horizontal dispersion compensating card slot at the top of the shelf.

Note The west DCU is commonly installed on the left side and the east DCU is commonly installed 
on the right side.

Note If you install the wrong DCU in a slot, remove the DCU and install the correct one. 

Step 3 Release the finger latch.

Note It is possible to close the latch when the DCU is not completely plugged into the backplane. 
Ensure that you cannot insert the DCU any further.

Step 4 Verify that the DCU is engaged with the backplane by grasping and gently pulling the card handle. If the 
card does not move, it is fully installed. If it moves, repeat 2 and 3.

Step 5 Continue with the “NTP-G32 Install the Transponder and Muxponder Cards” procedure on page 3-30.

Stop. You have completed this procedure. 
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NTP-G32 Install the Transponder and Muxponder Cards 

Warning During this procedure, wear grounding wrist straps to avoid ESD damage to the card. Do not directly 
touch the backplane with your hand or any metal tool due to electrical hazard.

Warning Class 1 Laser Product.

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments. Viewing the laser output with 
certain optical instruments (for example, eye loupes, magnifiers, and microscopes) within a distance 
of 100 mm may pose an eye hazard. Use of controls or adjustments or performance of procedures other 
than those specified may result in hazardous radiation exposure. 

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Note If protective clips are installed on the backplane connectors of the cards, remove the clips before 
installing the cards.

Note If you install a card incorrectly, the FAIL LED flashes continuously. 

Step 1 Display card installation plan for the node using one of the following sources: 

• The Cisco MetroPlanner Site Dialog window for the node you are provisioning.

• CTC node view with slots preprovisioned based on the Cisco MetroPlanner Site Dialog window.

Purpose This procedure describes how to install the ONS 15454 transponder (TXP) 
and muxponder (MXP) cards. 

Tools/Equipment TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, TXPP_MR_2.5G, 
MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, and 
MXPP_MR_2.5G cards (as applicable)

Prerequisite Procedures NTP-G15 Install the Common Control Cards, page 1-72

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• Written slot plan. The plan must be based on the Cisco MetroPlanner Site Dialog window for your 
installation.

Step 2 Remove the TXP or MXP card from its packaging, then remove the protective clips from the backplane 
connectors.

Step 3 Open the card latches/ejectors. 

Step 4 Use the latches/ejectors to firmly slide the TXP or MXP card along the guide rails until the card plugs 
into the receptacle at the back of the slot. 

Note If you install the wrong card in a slot, complete the “NTP-G107 Remove and Replace DWDM 
Cards” procedure on page 11-12. 

Step 5 Verify that the card is inserted correctly and close the latches/ejectors on the card.

Note It is possible to close the latches and ejectors when the card is not completely plugged into the 
backplane. Ensure that you cannot insert the card any further.

Step 6 Verify the LED activity:

• The red FAIL LED turns on for 20 to 30 seconds. 

• The red FAIL LED blinks for 35 to 45 seconds.

• All LEDs blink once and turn off for 5 to 10 seconds.

• The ACT or ACT/STBY LED turns on. The SF LED can persist until all card ports connect to their 
far-end counterparts and a signal is present. 

Step 7 If the card does not boot up properly, or the LED activity does not mirror Step 6, check the following:

• When a physical card type does not match the type of card provisioned for that slot in CTC, the card 
might not boot. If a TXP or MXP card does not boot, open CTC and ensure that the slot is not 
provisioned for a different card type before assuming that the card is faulty.

• If the red FAIL LED does not turn on, check the power. 

• If you insert a card into a slot provisioned for a different card, all LEDs turn off. 

• If the red FAIL LED is on continuously or the LEDs behave erratically, the card is not installed 
properly. Remove the card and repeat Steps 3 to 6. 

Step 8 If the TXP or MXP requires a small-form pluggable (SFP), complete the “DLP-G63 Install an SFP” task 
on page 3-32. To remove an SFP, complete the “DLP-G64 Remove an SFP” task on page 3-32.

Note SFPs must be provisioned in CTC. You will be directed to the “NTP-G94 Provision Pluggable 
Port Modules” procedure on page 10-29 during network turn up. For more information about 
SFPs, see the “14.13 SFP Modules” section on page 14-123.

Stop. You have completed this procedure. 
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DLP-G63 Install an SFP

Step 1 Verify that the SFP is correct for your network and TXP or MXP card (see Table 14-67 on page 14-123). 
Check that you are installing compatible SFPs, for example, SX to SX or LX/LH to LX/LH. 

Step 2 Install the SFP:

• For a mylar tab SFP: slide the SFP into the slot.

• For an actuator/button SFP: slide the SFP all the way into the slot until you hear a click.

• For a bail clasp SFP: latch (flip upwards) the bail clasp before inserting into the slot then slide into 
the slot. 

Note SFPs are keyed to prevent incorrect installation.

Step 3 Do not remove the protective caps from the SFP until you are ready to attach the network fiber-optic 
cable.

Note SFPs must be provisioned in CTC. You will be directed to the “NTP-G94 Provision Pluggable 
Port Modules” procedure on page 10-29 during network turn up. For more information about 
SFPs, see the “14.13 SFP Modules” section on page 14-123.

Step 4 Return to your originating procedure (NTP).

DLP-G64 Remove an SFP

Step 1 Disconnect the network fiber cable from the GBIC SC-type connector or SFP/XFP LC-type connector.

Purpose This task installs SFPs into TXP and MXP cards.

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task removes SFPs from TXP and MXP cards.

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Release the SFP from the slot by performing one of the following actions (depending which latch is on 
the SFP): 

• For a mylar tab SFP: pull out the mylar tab. 

• For an actuator/button SFP: press the actuator/button.

• For a bail clasp SFP: unlatching the bail clasp and swing it downward.

Step 3 Slide the SFP out of the slot.

Step 4 Return to your originating procedure (NTP).

NTP-G33 Create a Y-Cable Protection Group

Note Loss of Pointer Path (LOP-P) alarms can occur on a split signal if the ports are not in a Y-cable protection 
group.

Step 1 Verify that the TXP or MXP cards are installed according to the Y-cable requirements specified in 
Table 3-3. This table describes the protection types available in the ONS 15454 for DWDM client cards. 

Purpose This task creates a Y-cable protection group between the client ports of two 
transponder (TXP_MR_10G, TXP_MR_10E, or TXP_MR_2.5G) or two 
muxponder (MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, 
MXPP_MR_2.5G) cards.

Tools/Equipment Installed TXP or MXP cards.

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 3-3 Protection Types

Type Cards Description and Installation Requirements

Y Cable MXP_2.5_10G

MXP_2.5_10E

TXP_MR_10G

TXP_MR_10E

TXP_MR_2.5G

MXP_MR_2.5G

Pairs a working transponder or muxponder card/port with a 
protect transponder or muxponder card/port. The protect port 
must be on a different card than the working port and it must be 
the same card type as the working port. The working and protect 
port numbers must be the same, that is, Port 1 can only protect 
Port 1, Port 2 can only protect Port 2, etc.

Splitter TXPP_MR_2.5G

MXPP_MR_2.5G

A splitter protection group is automatically created when a 
TXPP_MR_2.5G or MXPP_MR_2.5G card is installed. You can 
edit the splitter protection group name.
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Step 2 Verify that pluggable port modules (PPM) are provisioned for the same payload and payload rate on the 
TXP and MXP cards where you will create the Y-cable protection group. You can use either of the 
following methods:

• In node view, move your mouse over the TXP or MXP client port. If a PPM is provisioned, two dots 
appear in the port graphic, and the port and PPM payload and rate appear when you move the mouse 
over the port.

• Display the TXP or MXP card in card view. Click the Provisioning > Pluggable Port Module tabs. 
Verify that a PPM is provisioned in the Pluggable Port Module area, and the payload type and rate 
is provisioned for it in the Selected PPM area.

The PPM payload and payload rate must be the same for both TXP or MXP cards. 

Step 3 In node view, click the Provisioning > Protection tabs.

Step 4 In the Protection Groups area, click Create.

Step 5 In the Create Protection Group dialog box, enter the following:

• Name—Type a name for the protection group. The name can have up to 32 alphanumeric (a-z, A-Z, 
0-9) characters. Special characters are permitted. For TL1 compatibility, do not use question mark 
(?), backslash (\), or double quote (“) characters.

• Type—Choose Y Cable from the drop-down list.

• Protect Port—Choose the protect port from the drop-down list. The menu displays the available 
transponder or muxponder ports. If transponder or muxponder cards are not installed, no ports 
appear in the drop-down list. 

After you choose the protect port, a list of ports available for protection appear in the Available Ports 
list, as shown in Figure 3-9. If no cards are available, no ports appear. If this occurs, you can not 
complete this task until you install the physical cards or preprovision the ONS 15454 slots using the 
“NTP-G29 Preprovision a Slot” procedure on page 3-24.

Figure 3-9 Creating a Y-Cable Protection Group

Step 6 From the Available Ports list, choose the port that will be protected by the port you selected in 
Protect Ports. Click the top arrow button to move each port to the Working Ports list.

Step 7 Complete the remaining fields:
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• Revertive—Check this check box if you want traffic to revert to the working port after failure 
conditions remain corrected for the amount of time entered in the Reversion Time field.

• Reversion time—If Revertive is checked, select a reversion time from the drop-down list. The range 
is 0.5 to 12.0 minutes. The default is 5.0 minutes. Reversion time is the amount of time that will 
elapse before the traffic reverts to the working card. Traffic can revert when conditions causing the 
switch are cleared.

Step 8 Click OK.

Step 9 Return to your originating procedure (NTP).

NTP-G34 Install Fiber-Optic Cables on DWDM Cards

Warning Complies with 21 CFR 1040.10 and 1040.11 except for deviations pursuant to Laser Notice No. 50, dated 
July 26, 2001. 

Warning Class 1M laser product.

Note In this procedure, you will generally connect fibers in an east-to-west or west-to-east pattern. “West” 
refers to cards and ports in Slots 1, 2, 3, 4, 5, 6, and 8. “East” refers to cards and ports installed in Slots 
10, 12, 13, 14, 15, 16, and 17. 

Step 1 Display your site plan in Cisco MetroPlanner, or refer to a printed copy of the MetroPlanner internal 
connections table. For information about Cisco MetroPlanner, refer to the Cisco MetroPlanner DWDM 
Operations Guide.

Step 2 Navigate to the Internal Connections table for the node you are provisioning (Figure 3-10).The internal 
connections table identifies the patch cord that you must cable by their end points. Position 1 identifies 
the fiber start point; Position 2 indicates the fiber end point. The patch cord end points are identified by 
site, slot, and port. Information provided by the Cisco MetroPlanner internal connections table includes:

• Site—The DWDM network site number for the node where you are provisioning the internal 
connections.

• IP Address—The node IP address.

Purpose This procedure installs the fiber-optic cables to DWDM cards and 
dispersion compensating cards. 

Tools/Equipment Fiber-optic cables

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-26

NTP-G31 Install the DWDM Dispersion Compensating Units, page 3-28 
(as applicable)

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• Position-1—The first position rack, shelf, and slot. For example, Rack#1.Main Shelf.02 refers to 
Slot 2 in the Main Shelf of Rack #1. Refer to the Cisco MetroPlanner Site Dialog window for rack 
and shelf names and locations. 

• Unit-1—The ONS 15454 DWDM card (unit) that is installed in the first position slot.

• Port#-1—The port identifier shown in the CTC for the first Position-1 connection.

• Port ID-1—The port identifier shown in TL1 for the Position-1 connection.

• Port Label-1—The name of the physical port printed on the card’s front plate and shown in CTC 
card view for the Position-1 connection.

• Attenuator—Indicates whether attenuation is required.

• Patchcord Type—Indicates the level of attenuation that is required, if needed.

• Position-2—The second position rack, shelf, and slot. For example, Rack#1.Main Shelf.02 refers to 
Slot 2 in the Main Shelf of Rack #1. Refer to the Cisco MetroPlanner Site Dialog window for rack 
and shelf names and locations.

• Unit-2—The ONS 15454 DWDM card (unit) that is installed in the Position-2 slot.

• Port #2—The port identifier shown in CTC for the first Position-2 connection.

• Port ID-2—The port identifier shown in TL1 for the Position-2 connection.

• Port Label-2—The name of the physical port printed on the card’s front plate and shown in CTC 
card view for the Position-2 connection.

• Manually Set—Indicates whether you must create the connection manually in CTC.

Figure 3-10 Cisco MetroPlanner Internal Connections Table

Step 3 Export the internal connections table:

a. Click Export.

Site Position-1 Port#-1
IP Address Unit-1

Port Label-1 Patchcord Type
Port ID-1 Attenuator Position-2
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b. Enter a file name in the File Name field of the Save Table dialog box.

c. In the Files of Type field, choose HTML (to save the file as an HTML file viewable in a web 
browser), or Tab Separated Values to save the file as a tab-separated text file, which you can import 
into a spreadsheet application. 

d. Click Save.

Step 4 Open the exported Cisco MetroPlanner internal connections file in a web browser (or spreadsheet 
application), and then print the file.

Step 5 Verify that fibers are available to complete the connections shown in the Cisco MetroPlanner internal 
connections table.

Step 6 Complete the “NTP-G115 Clean Fiber Connectors” procedure on page 11-32 for all fiber connections, 
even new fiber. Dust particles can degrade performance. Put caps on any fiber connectors that are not 
used.

Step 7 Complete the “DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations on All Nodes” task on 
page 3-37.

Step 8 As required, complete the following tasks based on the DWDM node type:

• “DLP-G66 Install Fiber-Optic Cables for a Hub Node” task on page 3-40

• “DLP-G67 Install Fiber-Optic Cables for a Terminal Node” task on page 3-43.

• “DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node” task on page 3-44.

• “DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node” task on page 3-48.

• “DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node” task on page 3-46

• “DLP-G71 Install Fiber-Optic Cables for an ROADM Node” task on page 3-53

Step 9 Continue with the “NTP-G35 Route Fiber-Optic Cables” procedure on page 3-55.

Stop. You have completed this procedure. 

DLP-G65 Install Fiber-Optic Cables for OSC Link Terminations on All Nodes

Step 1 Refer to the Cisco MetroPlanner internal connections table for your site when completing OSC 
connections. Before you begin the OSC connections, read the following rules:

• The OPT-BST and the OSC-CSM are the only cards that directly interface with the line (span) fiber.

• The OSCM only carries optical service channels, not DWDM channels.

Purpose This task explains how to install fiber-optic cables for optical service 
channels creation on all DWDM shelves. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 11-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• The OSCM and the OSC-CSM cannot both be installed on the same side of the shelf (east or west). 
You can have different cards on each side, for example an OSCM on the west side and an OSC-CSM 
on the east side.

• When an OPT-BST and an OSC-CSM are both used on the same side of the node, the OPT-BST 
combines the supervision channel with the DWDM channels and the OSC-CSM acts as an OSCM; 
it does not carry DWDM traffic.

• If an OPT-BST and OSCM card are installed on the east side, the east OPT-BST OSC RX port is 
connected to the east OSCM TX port, and the east OPT-BST OSC TX port is connected to the east 
OSCM RX port.

• If you have an OPT-BST and OSC-CSM card are installed on the east side, the east OPT-BST OSC 
RX port is connected to the east OSC-CSM LINE TX port, and the east OPT-BST OSC TX port is 
connected to the east OSC-CSM LINE RX port.

• If an OPT-BST and OSCM card are installed on the west side, The west OPT-BST OSC TX port is 
connected to the west OSCM RX port, and the west OPT-BST OSC RX port is connected to the west 
OSCM TX port.

• If you have an OPT-BST and OSC-CSM card are installed on the west side, the west OPT-BST OSC 
TX port is connected to the west OSC-CSM LINE RX port, and the west OPT-BST OSC RX port is 
connected to the west OSC-CSM LINE TX port.

Figure 3-11 shows an example of OSC fibering for a hub node with OSCM cards installed.
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Figure 3-11 Fibering OSC Terminations—Hub Node with OSCM Cards

1 West OPT-BST LINE RX to east OPT-BST or OSC-CSM LINE TX on adjacent node

2 West OPT-BST LINE TX to east OPT-BST or OSC-CSM LINE RX on adjacent node

3 West OPT-BST OSC TX to west OSCM RX 

4 West OPT-BST OSC RX to west OSCM TX 

5 East OSCM TX to east OPT-BST OSC RX
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Step 2 Plug one end of a fiber into the west OPT-BST or OSC-CSM LINE TX connector and the other end into 
the adjacent node east OPT-BST or OSC-CSM LINE RX connector. Repeat in the other direction (east 
to west, TX to RX). Always connect the west line ports to the adjacent node east line ports. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
Terminations and Ring ID” procedure on page 3-60) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 3 If OSCM cards are not installed, continue with Step 4. If OSCM cards are installed. 

a. Plug one end of a fiber into the west OPT-BST OSC RX connector and the other end into west 
OSCM OSC TX connector. 

b. Plug another fiber into the west OSCM OSC RX connector and the other end to the west OPT-BST 
OSC TX connector.

c. plug one end of a fiber into the east OPT-BST OSC RX connector and the other end into east OSCM 
TX connector. 

d. Plug another fiber into the east OSCM OSC RX connector and the other end to the east OPT-BST 
OSC TX connector. 

Step 4 Repeat Steps 2 and 3 at each node in the network.

Step 5 Return to your originating procedure (NTP). 

DLP-G66 Install Fiber-Optic Cables for a Hub Node

Step 1 Refer to the Cisco MetroPlanner internal connections table for your site when completing connections. 
Before you begin hub node connections, read the following rules:

• The west OPT-BST or OSC-CSM card common (COM) TX port is connected to the west 
OPT-PRE COM RX port or the west 32DMX-O COM RX port.

• The west OPT-PRE COM TX port is connected to the west 32DMX-O COM RX port.

• The west 32MUX-O COM TX port is connected to the west OPT-BST or west OSC-CSM COM RX 
port.

6 East OSCM RX to east OPT-BST OSC TX

7 East OPT-BST LINE TX to west OPT-BST or OSC-CSM LINE RX on adjacent node

8 East OPT-BST LINE RX to west OPT-BST or OSC-CSM LINE TX on adjacent node

Purpose This task installs fiber-optic cables on a hub node DWDM shelf.

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 11-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• The east 32MUX-O COM TX port is connected to the east OPT-BST or east OSC-CSM COM RX 
port.

• The east OPT-BST or east OSC-CSM COM TX port is connected to the east OPT-PRE COM RX 
port or the east 32DMX-O COM RX port.

• The east OPT-PRE COM TX port is connected to the east 32DMX-O COM RX port.

Figure 3-12 shows an example of a hub node with cabling. In the example, OSCM cards are installed. If 
OSC-CSM are installed, they are usually installed in Slots 1and 17.
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Figure 3-12 Fibering a Hub Node

1 West DCU TX to west OPT-PRE DC RX1 

2 West DCU RX to west OPT-PRE DC TX1 

3 West OPT-BST COM TX to west OPT-PRE COM RX

4 West OPT-BST COM RX to west 32MUX-O COM TX

5 West OPT-PRE COM TX to west 32DMX-O COM RX
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Step 2 Plug one end of the fiber cable into the desired RX port and other end into the desired TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
Terminations and Ring ID” procedure on page 3-60) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 3 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 4 Return to your originating procedure (NTP). 

DLP-G67 Install Fiber-Optic Cables for a Terminal Node

Step 1 Refer to the Cisco MetroPlanner internal connections table for your site when completing connections. 
Before you begin terminal node connections, read the following rules:

• A terminal site has only one side (as compared to a hub node, which has two sides). The terminal 
side can be either east or west.

• The terminal side OPT-BST or OSC-CSM card common (COM) TX port is connected to the terminal 
side OPT-PRE COM RX port or the 32DMX-O COM RX port.

• The terminal side OPT-PRE COM TX port is connected to the terminal side 32DMX-O COM RX 
port.

• The terminal side 32MUX-O COM TX port is connected to the terminal side OPT-BST or 
OSC-CSM COM RX port.

Step 2 Plug one fiber cable end into the desired RX port and other end into the desired TX port. 

6 East 32DMX-O COM RX to east OPT-PRE COM TX

7 East 32MUX-O COM TX to east OPT-BST COM RX

8 East OPT-PRE COM RX to east OPT-BST COM TX

9 East DCU TX to east OPT-PRE DC RX1 

10 East DCU RX to east OPT-PRE DC TX1

1. If a DCU is not installed, a 5 dB attenuator loop must be installed between the OPT-PRE DC ports.

Purpose This task installs fiber-optic cables on a terminal node DWDM shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 11-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
Terminations and Ring ID” procedure on page 3-60) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 3 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 4 Return to your originating procedure (NTP). 

DLP-G68 Install Fiber-Optic Cables for a Line Amplifier Node

Step 1 Refer to the Cisco MetroPlanner internal connections table for your site when completing 
connections.Before you begin the line amplifier node connections, read the following rules:

• Line amplifier node layout allows all combinations of OPT-PRE and OPT-BST and allows you to 
use asymmetrical card choices in west-to-east and east-to-west configurations. For a given line 
direction, you can configure the four following possibilities:

– Only preamplification (OPT-PRE)

– Only booster amplification (OPT-BST)

– Both preamplification and booster amplification (where a line amplifier node has amplification 
in at least one direction)

– Neither preamplification nor booster amplification

• If a west OPT-PRE card is installed:

– The west OSC-CSM or OPT-BST COM TX is connected to the west OPT-PRE COM RX port.

– The west OPT-PRE COM TX port is connected to the east OSC-CSM or OPT-BST COM RX 
port.

• If a west OPT-PRE card is not installed, the west OSC-CSM or the OPT-BST COM TX port is 
connected to the east OSC-CSM or OPT-BST COM RX port.

• If an east OPT-PRE card is installed:

– The east OSC-CSM or OPT-BST COM TX port is connected to the east OPT-PRE COM RX 
port.

– The east OPT-PRE COM TX port is connected to the west OSC-CSM or OPT-BST COM RX 
port.

Purpose This task installs fiber-optic cables on a line amplifier node in a DWDM 
shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 11-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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• If an east OPT-PRE card is not installed, the east OSC-CSM or OPT-BST COM TX port is connected 
to the west OSC-CSM or OPT-BST COM RX port.

Figure 3-13 shows a sample line amplifier node with cabling.

Figure 3-13 Fibering a Line Amplifier Node
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DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node
Step 2 Plug one end of the fiber cable into the desired RX port and other end into the desired TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
Terminations and Ring ID” procedure on page 3-60) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 3 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 4 Return to your originating procedure (NTP). 

DLP-G69 Install Fiber-Optic Cables for an OSC Regeneration Node

Step 1 Refer to the Cisco MetroPlanner internal connections table for your site when completing connections. 
Before you begin OSC regeneration node connections, read the following rules:

• The west OSC-CSM COM TX port connects to the east OSC-CSM COM RX port.

• The west OSC-CSM COM RX port connects to the east OSC-CSM COM TX port.

• Slots 2 through 5 and 12 through 16 can be used for TXP/MXP cards.

Figure 3-14 shows a sample OSC regeneration node with cabling.

1 West DCU TX to west OPT-PRE DC RX1 

1. If a DCU is not installed, a 5 dB attenuator loop must be installed between the OPT-PRE DC ports.

5 West OPT-BST COM RX to east OPT-PRE COM TX

2 West DCU RX to west OPT-PRE DC TX1 6 West OPT-BST COM RX to east OPT-PRE COM TX

3 West OPT-BST COM TX to west OPT-PRE COM RX 7 East DCU TX to east OPT-PRE DC RX1

4 West OPT-PRE COM TX to east OPT-BST COM RX 8 East DCU RX to east OPT-PRE DC TX1

Purpose This task installs fiber-optic cables on a OSC regeneration node in a 
DWDM shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 11-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 3-14 Fibering an OSC Regeneration Node

1 West OSC-CSM LINE RX to east OSC-CSM or OPT-BST LINE TX on adjacent node

2 West OSC-CSM LINE TX to east OSC-CSM or OPT-BST LINE RX on adjacent node

3 West OSC-CSM COM TX to east OSC-CSM COM RX 
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DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node
Step 2 Plug one end of the fiber cable into the desired RX port and other end into the desired TX port. 

Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
Terminations and Ring ID” procedure on page 3-60) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 3 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 4 Return to your originating procedure (NTP). 

DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node

Note Amplified OADM nodes contain OPT-PRE cards and/or OPT-BST cards. Passive OADM nodes do not. 
Both contain add/drop channel or band cards.

Step 1 Refer to the Cisco MetroPlanner internal connections table for your site when completing connections. 
Before you begin connecting fiber-optic cabling for amplified or passive OADM nodes, read the 
following rules for all OADM connections:

• The two sides of the OADM node do not need to be symmetrical. On each side, Cisco MetroPlanner 
can create one of the following four configurations:

– OPT-BST and OPT-PRE

– OSC-CSM and OPT-PRE

– Only OSC-CSM

– Only OPT-BST

Step 2 Consult the following rules for OADM node express path cabled connections:

• TX ports should only be connected to RX ports.

4 West OSC-CSM COM RX to east OSC-CSM COM TX 

5 East OSC-CSM LINE RX to west OSC-CSM or OPT-BST LINE TX on adjacent node

6 East OSC-CSM LINE TX to west OSC-CSM or OPT-BST LINE RX on adjacent node

Purpose This task gives instructions, rules, and examples to install fiber-optic cables 
on an amplified or passive optical add/drop multiplexing (OADM) node in 
a DWDM shelf.

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 11-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
3-48
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 3      Turn Up a Node
DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node
• EXP ports are connected only to COM ports in between AD-xC or AD-xB cards that all belong to 
the east side (that is, they are daisy-chained).

• EXP ports are connected only to COM ports in between AD-xC or AD-xB cards that all belong to 
the west side (that is, they are daisy-chained).

• The EXP port of the last AD-xC or AD-xB card on the west side is connected to the EXP port of the 
first AD-xC or AD-xB card on the east side.

• The OPT-BST COM RX port is connected to the nearest (in slot position) AD-xC or AD-xB 
COM TX port.

• The OPT-PRE COM TX port is connected to the nearest (in slot position) AD-xC or AD-xB 
COM RX port.

• If OADM cards are located in adjacent slots, the TCC2 card assumes they are connected in a 
daisy-chain between the EXP ports and COM ports as noted previously.

• The first west AD-xC or AD-xB card COM RX port is connected to the west OPT-PRE or 
OSC-CSM COM TX port.

• The first west AD-xC or AD-xB card COM TX port is connected to the west OPT-BST or 
OSC-CSM COM RX port.

• The first east AD-xC or AD-xB card COM RX port is connected to the east OPT-PRE or 
OSC-CSM COM TX port.

• The first east AD-xC or AD-xB card COM TX port is connected to the east OPT-BST or 
OSC-CSM RX port.

• If a west OPT-PRE is present, the west OPT-BST or OSC-CSM COM TX port is connected to the 
west OPT-PRE COM RX port.

• If an east OPT-PRE is present, the east OPT-BST or OSC-CSM COM TX port is connected to the 
east OPT-PRE COM RX port.

Step 3 Consult the following rules for OADM node add/drop path cabled connections:

• AD-xB add/drop (RX or TX) ports are only connected to the following ports:

– 4MD COM TX or 4MD COM RX ports

– Another AD-xB add/drop port (a pass-through configuration)

• An AD-xB add/drop band port is only connected to a 4MD card belonging to the same band.

• For each specific AD-xB, the add and drop ports for that band card are connected to the COM TX 
and COM RX ports of the same 4MD card.

• The AD-xB and 4MD cards are located in the same side (the connected ports will all have the same 
line direction).

Step 4 Consult the following rules for OADM node pass-through path cabled connections:

• Pass-through connections are only established between add and drop ports on the same band or 
channel and same line direction.

• Only connect AD-xC or AD-xB add/drop ports to other AD-xC or AD-xB add/drop ports (as 
pass-through configurations).

• An add (RX) port is only connected to a drop (TX) port.

• Only connect 4MD client input/output ports to other 4MD client input/output ports.

• A west AD-xB drop (TX) port is connected to the corresponding west 4MD COM RX port.

• A west AD-xB add (RX) port is connected to the corresponding west 4MD COM TX port.
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• An east AD-xB drop (TX) port is connected to the corresponding east 4MD COM RX port.

• An east AD-xB add (RX) port is connected to the corresponding east 4MD COM TX port.

Figure 3-15 shows a sample amplified OADM node with AD-1C-xx.x cards installed. 

Figure 3-15 Fibering an Amplified OADM Node

11
54

24

DCU-xxx West DCU-xxx East

OPT
BST

FAIL

ACT

SF

R
X

M
O

N

T
X

R
X

C
O

M

T
X

R
X

O
S

C

T
X

R
X

L
IN

E

T
X

OPT
PRE

FAIL

ACT

SF

M
O

N

R
X

C
O

M

T
X

R
X

D
C

C

T
X

OPT
BST

FAIL

ACT

SF

R
X

M
O

N

T
X

R
X

C
O

M

T
X

R
X

O
S

C

T
X

R
X

L
IN

E

T
X

OPT
PRE

FAIL

ACT

SF

M
O

N

R
X

C
O

M

T
X

R
X

D
C

T
X

OSCM

FAIL

ACT

SF

U
C

R
X

T
X

TCC2

FAIL

SF

PWR

A B

CRIT

MAJ

MIN

REM

SYNC

ACO

ACO

LAMP TEST

RS-232

TCP/IP

LINK

ACT

TCC2

FAIL

SF

PWR

A B

CRIT

MAJ

MIN

REM

SYNC

ACO

ACO

LAMP TEST

RS-232

TCP/IP

LINK

ACT

OSCM

FAIL

ACT

SF

U
C

R
X

T
X

TXP
MR
2.5G

FAIL

ACT

SF

R
X

C
L

IE
N

T
D

W
D

M

T
X

R
X

T
X

TXP
MR
2.5G

FAIL

ACT

SF

R
X

C
L

IE
N

T
D

W
D

M

T
X

R
X

T
X

R
X

T
X

R
X

T
X

AD-1C
-XX.X

FAIL

ACT

SF

R
X

15
xx

.x
x

T
X

R
X

E
X

P

T
X

R
X

C
O

M

T
X

FAIL

ACT

SF

R
X

15
xx

.x
x

T
X

R
X

E
X

P

T
X

R
X

C
O

M

T
X

AD-1C
-XX.X

FAIL

ACT

INPUT/OUTPUT

AIC-I

PWR

A B

ACC

EOW

LOW

RING

RING

DCC-B

DCC-A

UDC-B

UDC-A

1

2
4

5

13

12

15

16

3
14

6

7

10

11
8

9

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17

P P

+ +
3-50
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 3      Turn Up a Node
DLP-G70 Install Fiber-Optic Cables for an Amplified or Passive OADM Node
Figure 3-16 shows an example of a passive OADM node with two AD-1C-xx.x cards installed.

1 West DCU TX to west OPT-PRE DC RX1 

1. If a DCU is not installed, a 5 dB attenuator loop must be installed between the OPT-PRE DC ports.

2 West DCU RX to west OPT-PRE DC TX1

3 West OPT-BST COM TX to west OPT-PRE COM RX

4 West OPT-BST COM RX to west AD-1C-xx.x COM TX

5 West OPT-PRE COM TX to west AD-1C-xx.x COM RX

6 West AD-1C-xx.x (15xx.xx) RX to west TXP_MR_2.5G DWDM TX

7 West AD-1C-xx.x (15xx.xx) TX to west TXP_MR_2.5G DWDM RX

8 West AD-1C-xx.x EXP TX to east AD-1C-xx.x EXP RX

9 West AD-1C-xx.x EXP RX to east AD-1C-xx.x EXP TX

10 East TXP_MR_2.5G DWDM RX to east AD-1C-xx.x (15xx.xx) TX

11 East TXP_MR_2.5G DWDM TX to east AD-1C-xx.x (15xx.xx) RX

12 East AD-1C-xx.x COM RX to OPT-PRE COM TX

13 East AD-1C-xx.x COM TX to OPT-BST COM RX

14 East OPT-PRE COM RX to east OPT-BST COM TX

15 East DCU TX to east OPT-PRE DC RX1

16 East DCU RX to east OPT-PRE DC TX1
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Figure 3-16 Fibering a Passive OADM Node

Step 5 Plug one end of the fiber cable into the desired RX port and other end into the desired TX port. 

1 West OSC-CSM COM TX to west AD-1C-xx.x COM RX

2 West OSC-CSM COM RX to west AD-1C-xx.x COM TX

3 West OSC-CSM EXP TX to east AD-1C-xx.x EXP RX

4 West OSC-CSM EXP RX to east AD-1C-xx.x EXP TX

5 East AD-1C-xx.x COM TX to east OSC-CSM COM RX

6 East AD-1C-xx.x COM RX to east OSC-CSM COM TX 
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DLP-G71 Install Fiber-Optic Cables for an ROADM Node
Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
Terminations and Ring ID” procedure on page 3-60) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 6 Repeat Step 5 until you have connected the nodes according to the site plan.

Step 7 Return to your originating procedure (NTP). 

DLP-G71 Install Fiber-Optic Cables for an ROADM Node

Note To avoid error, connect fiber-optic cable so that the farthest slot to the right represents the east port, and 
the farthest slot to the left represents the west port. Fiber connected to an east port on one node must 
plug into the west port on an adjacent node. 

Step 1 Refer to the Cisco MetroPlanner internal connections table for your site when completing connections. 
Before you begin connecting fiber-optic cabling for ROADM nodes, read the following rules:

• The west OPT-BST or OSC-CSM COM TX port is connected to the west OPT-PRE COM RX port.

• The west OPT-BST or OSC-CSM COM RX port is connected to the west 32WSS COM TX port.

• The west OPT-BST (if installed) OSC TX port is connected to the west OSCM RX port.

• The west OPT-BST (if installed) OSC RX port is connected to the west OSCM TX port.

• The west 32WSS EXP TX port is connected to the east 32WSS EXP RX port.

• The west 32WSS EXP RX port is connected to the east 32WSS EXP TX port.

• The west 32WSS DROP TX port is connected to the west 32DMX COM RX port.

• The east OPT-BST or OSC-CSM COM TX port is connected to the east OPT-PRE COM RX port.

• The east OPT-BST or OSC-CSM COM RX port is connected to the east 32WSS COM TX port.

• The east OPT-BST (if installed) OSC TX port is connected to the east OSCM RX port.

• The east OPT-BST (if installed) OSC RX port is connected to the east OSCM TX port.

• The east 32WSS DROP TX port is connected to the east 32DMX COM RX port.

Figure 3-17 shows a sample amplified ROADM node with cabling. 

Purpose This task gives instructions, rules, and examples to install fiber-optic cables 
on an reconfigurable optical add/drop multiplexing (ROADM) node in a 
DWDM shelf. 

Tools Fiber-optic cables

Prerequisite Procedures NTP-G115 Clean Fiber Connectors, page 11-32

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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DLP-G71 Install Fiber-Optic Cables for an ROADM Node
Figure 3-17 Fibering an ROADM Node

1 West DCU TX to west OPT-PRE DC RX1 

2 West DCU RX to west OPT-PRE DC TX1

3 West OPT-BST COM TX to west OPT-PRE COM RX

4 West 32WSS COM TX to west OPT-BST COM RX

5 West 32WSS COM RX to west OPT-PRE COM TX
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NTP-G35 Route Fiber-Optic Cables
Note Cards display an SF LED after the OSC terminations are created (see the “NTP-G38 Provision 
Terminations and Ring ID” procedure on page 3-60) and transmit and receive fibers are not 
connected correctly. For example, an RX port is connected to another RX port or a TX port is 
connected to another TX port. 

Step 2 Plug one end of the fiber into the desired RX port and the other into the correct TX port

Step 3 Repeat Step 2 until you have connected the nodes according to the site plan.

Step 4 Return to your originating procedure (NTP). 

NTP-G35 Route Fiber-Optic Cables 

Step 1 Open the fold-down front door on the cable-management tray.

Step 2 Route the fiber cable on the card faceplate through the fiber clip on the faceplate, if provided. Fiber clips 
are factory-attached to the faceplates of 32MUX-O, 32DMX-O, OSCM, OPT-PRE, and OPT-BST cards. 

Step 3 Route the fiber cables into the cable-management tray. 

Step 4 Route the fiber cables out either side of the cable-management tray through the cutouts on each side of 
the shelf assembly. Use the reversible fiber guides to route cables out the desired side.

6 West 32DMX COM RX to west 32WSS DROP TX

7 West 32WSS EXP TX to east 32WSS EXP RX

8 West 32WSS EXP RX to east 32WSS EXP TX

9 East 32DMX COM RX to east 32WSS DROP TX

10 East 32WSS COM RX to east OPT-PRE COM TX

11 East 32WSS COM TX to east OPT-BST COM RX

12 East OPT-BST COM TX to east OPT-PRE COM RX

13 East DCU RX to east OPT-PRE DC TX1

14 East DCU TX to east OPT-PRE DC RX1

1. If a DCU is not installed, a 5 dB attenuator loop must be installed between the OPT-PRE DC ports.

Purpose This procedure describes how to route fiber-optic cables.

Tools/Equipment None

Prerequisite Procedures NTP-G34 Install Fiber-Optic Cables on DWDM Cards, page 3-35

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 5 Close the fold-down front door when all fiber cables in the front compartment are properly routed.

Stop. You have completed this procedure.

NTP-G36 Calculate Cable Connections

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to provision the 
DWDM cable connections. If you are already logged in, continue with Step 2.

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained equipment alarms appear on the node. If alarms appear, investigate and 
resolve them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting 
Guide for procedures.

Step 3 Click the Provisioning > WDM-ANS > Connections tabs.

Step 4 Click the Calculate Connections button. 

CTC verifies that the cards installed in the ONS 15454 shelf are compatible and that all cards required 
for the DWDM node type are installed. If so, CTC calculates the fiber connections that should be 
provisioned. If the cards are not compatible or missing, for example, if an OPT-BST is installed but an 
OSCM card is not installed, the calculate connections function generates an error.

Note The connections calculation is not based on the Cisco MetroPlanner site plan. Calculations are 
based on the cards that are physically installed. If the site plan calls for a hub node but OADM 
cards are installed, CTC calculates connections based on the cards expected for an OADM node.

Step 5 If no errors were generated, continue with Step 6. If errors appear, verify that the cards installed in the 
shelf match the shelf plan calculated by Cisco MetroPlanner. If cards are installed incorrectly or are 
missing, remove the cards and install them in the correct slots following the “NTP-G30 Install the 
DWDM Cards” procedure on page 3-26. 

Step 6 Verify that the connections in the CTC Connections tab match the connections in the Cisco MetroPlanner 
internal connections file. (The CTC Connections tab will not show OPT-PRE dispersion connections, 
span connections, or connections between TXP and MXP cards and the DWDM cards.)

Purpose This procedure verifies the cards that are installed in the shelf and 
calculates the connections that should be provisioned for them.

Tools/Equipment None

Prerequisite Procedures A DWDM network plan calculated by Cisco MetroPlanner.

NTP-G22 Verify Common Card Installation, page 3-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 7 Complete the “DLP-G72 Create a DWDM Connection” task on page 3-57 for any connections that 
require manual provisioning. (Connections that require manual creation are indicated by a “Yes” in the 
Cisco MetroPlanner connections file Manually Set column.) If you need to delete a connection, complete 
the “DLP-G73 Delete a DWDM Connection” task on page 3-57

Step 8 Continue with the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58.

Stop. You have completed this procedure.

DLP-G72 Create a DWDM Connection

Step 1 In node view, click the Provisioning > WDM-ANS > Connections tabs.

Step 2 Click the Create button.

Step 3 In the Create Optical Link dialog box, choose the From and To slots and ports from the drop-down lists.

Step 4 If the connection is unidirectional, uncheck the bidirectional check box.

Step 5 Click OK. The new connection appears in the Connections table, but its State is “Uncommitted.”

Step 6 If you need to create additional connections, repeat Steps 2 through 5 for each new connection.

Step 7 Click the new connection in the table. Click the Commit button. The connection state changes to 
“Connected.”

Step 8 Return to your originating procedure (NTP).

DLP-G73 Delete a DWDM Connection

Step 1 In node view, click the Provisioning > WDM-ANS > Connection tabs.

Step 2 Click the connection you want to delete.

Purpose This task creates a DWDM connection.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task deletes a DWDM connection.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 3 Click Delete. 

Step 4 Return to your originating procedure (NTP).

NTP-G37 Run Automatic Node Setup

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to run automatic 
node setup. If you are already logged in, continue with Step 2.

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 3 Complete the “DLP-G74 Import a Cisco MetroPlanner Configuration File” task on page 3-59.

Step 4 Click the Port Status tab. Click Launch ANS. 

Step 5 In the Apply Launch ANS dialog box, click Yes. ANS adjusts the values of the VOAs to equalize the 
per-channel power at the amplifier level.

Step 6 In the Launch ANS confirmation dialog box, click OK.

Step 7 Verify that one of the following statuses appears in the Link Status column for all ports. If so, continue 
with Step 8.

• Success - Changed—The parameter setpoint was recalculated successfully.

• Success - Unchanged—The parameter setpoint did not need recalculation.

• Not Applicable—The parameter setpoint does not apply to this node type.

If one of the following statuses is shown, complete the provided instructions:

• Fail - Out of Range—The calculated setpoint is outside the expected range. Repeat the “NTP-G36 
Calculate Cable Connections” procedure on page 3-56 to verify that all connections have been 
provisioned correctly, paying attention to connections that require manual provisioning.

Purpose This procedure runs the CTC DWDM automatic node setup (ANS) 
function. ANS updates the values of the variable optical attenuators 
(VOAs) to equalize the per-channel power at the amplifier level. 

Tools/Equipment None

Prerequisite Procedures An Installation Parameters file for the node exported from 
Cisco MetroPlanner.

NTP-G36 Calculate Cable Connections, page 3-56

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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• Fail - Port in IS State—The parameter could not be calculated because the port is in-service. This 
status should normally not appear at this point in node turnup. If it does, display the card in card 
view, change the port admin state to OOS,DSLB (ANSI)/Locked,disabled (ETSI) and repeat Steps 
4 through 7. 

Note After your network is completed before you create circuits, launch ANS again at each network node to 
ensure all ports are regulated according to the network values. Individual node values may change during 
installation

Step 8 Continue with the “NTP-G39 Verify OSCM and OSC-CSM Transmit Power” procedure on page 3-63.

Stop. You have completed this procedure.

DLP-G74 Import a Cisco MetroPlanner Configuration File

Caution Importing the correct Cisco MetroPlanner configuration file is very important. Verify that have the 
correct MetroPlanner configuration file for your node before you begin this task.

Step 1 Export the Installation Parameters for your node from Cisco MetroPlanner. Refer to the Cisco 
MetroPlanner DWDM Operations Guide for procedures. If the parameters file has been exported, 
continue with Step 2.

a. In Cisco MetroPlanner, select Network > Install > Assisted Conf Setup.

b. In the dialog box, choose a location to save the Cisco MetroPlanner installation file.

Step 2 In CTC node view, click the Provisioning > WDM-ANS > Provisioning tabs.

Step 3 Click Import. The Import NE Update From File dialog box opens.

Step 4 Enter the path to the configuration file, or click Browse and navigate to the configuration file using the 
Open dialog box.

Step 5 Click OK. The Import NE Update From File dialog box closes.

The MetroPlanner configuration settings are imported and a pencil icon appears next to each parameter 
that will change.

Step 6 Verify that the imported parameters are correct according to the printout of the MetroPlanner parameters 
file, then click Apply.

Purpose This task imports a Cisco MetroPlanner configuration file into a node to 
configure the node automatically.

Tools/Equipment None

Prerequisite Procedures A Cisco MetroPlanner network configuration file must be available on a 
local or network drive.

DLP-G46 Log into CTC, page 2-25

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 7 Return to your originating procedure (NTP).

NTP-G38 Provision Terminations and Ring ID

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to provision the 
DWDM cable connections. If you are already logged in, continue with Step 2.

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear. If alarms appear, investigate and resolve them before 
continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for 
procedures.

Step 3 Complete the “DLP-G75 Create OSC Terminations” task on page 3-61.

Step 4 If you are using TXP or MXP cards, complete the “DLP-G76 Provision GCC Terminations” task on 
page 3-62

Step 5 As needed, complete the “DLP-G77 Provision the Ring ID” task on page 3-63.

Step 6 Continue with the “NTP-G39 Verify OSCM and OSC-CSM Transmit Power” procedure on page 3-63.

Stop. You have completed this procedure.

Purpose This procedure provisions the OSC/GCC terminations and the DWDM ring 
ID.

Tools/Equipment None

Prerequisite Procedures An Installation Parameters file for the node exported from 
Cisco MetroPlanner.

NTP-G36 Calculate Cable Connections, page 3-56

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G75 Create OSC Terminations

Step 1 In node view, click the Provisioning > Comm Channels > OSC tabs.

Step 2 In the OSC Terminations pane, click Create (Figure 3-18).

Figure 3-18 OSC Terminations Pane

Step 3 In the Create OSC Terminations dialog box, choose the ports where you want to create the OSC 
termination. To select more than one port, press the Shift key (to select a range of ports) or the Ctrl key 
(to select multiple individual ports).

Note OSC on the DWDM node uses a separate OC3/STM1 channel to transport the section data 
communications channel (SDCC), which is used for ONS 15454 DCC terminations. 

Purpose This task creates the terminations required by OSC channels between 
network nodes. 

Tools/Equipment None

Prerequisite Procedures NTP-G36 Calculate Cable Connections, page 3-56

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

11
57

98

Comm Channels
tab

Provisioning
tab

Create OSC Terminations
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Step 4 Click OK. Ports are automatically placed in service. Until all network OSC connections between nodes 
are created and the ports are in service, the following alarms might appear: 

• LOS-P (OSC termination failure)

• Power failure alarms on the OPT-BST and/or OSC-CSM

Note After the OSC termination is created, the line ports are placed in service and span power 
levels are checked. If power levels are low and/or the spans are not connected correctly, the 
OSC termination alarms appear.

Step 5 Return to your originating procedure (NTP).

DLP-G76 Provision GCC Terminations

Step 1 In node view click the Provisioning > Comm Channels > GCC tabs.

Step 2 In the GCC Terminations pane, click Create.

Step 3 In the Create optical transport network (OTN) GCC Terminations dialog box, click the ports where you 
want to create the GCC termination. To select more than one port, press the Shift key or the Ctrl key.

Note GCC refers to the general communications channel, which is used for ONS 15454 transponders 
and muxponders in DWDM applications. 

Step 4 (Optional) From the GCC Rate drop-down list, choose from two options:

• 192k is the line rate of Section DCC (SDCC)—This is the default option in Software R4.6.

• 576k is the line rate of Line DCC (LDCC)—This option will be supported in a future software 
release.

Step 5 Click Set to IS if you want to put ports in service.

Step 6 If the SDCC termination is to include a non-ONS node, check the Far End is Foreign check box. This 
automatically sets the far-end node IP address to 0.0.0.0, which means that any address can be specified 
by the far end. To change the default to a specific the IP address, see the “DLP-G184 Change a GCC 
Termination” task on page 9-28.

Purpose This task creates the DWDM GCC terminations required for network setup 
when using the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and 
MXP_2.5G_10G cards. Perform this task before you create circuits for 
these cards. In this task, you can also set up the node so that it has direct 
IP access to a far-end non-ONS node over the GCC network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 7 Click OK. Until all network GCC terminations are created and the ports are in service, GCC-EOC alarms 
appear.

Step 8 Return to your originating procedure (NTP).

DLP-G77 Provision the Ring ID

Step 1 In node view, click the Provisioning > Comm Channels > OSC tabs.

Step 2 Click the OSC tab.

Step 3 In the DWDM Ring ID area, click Create.

Step 4 In the DWDM Ring ID dialog box, enter the following information: 

• Ring ID—Enter the same ID for all nodes on the ring. Choose a number from 1 to 255.

• West Line—Select a card from the drop-down list. Selectable cards are OSCM or OSC-CSM. 
Slots 1 through 8 represent the west side of the node.

• East Line—Select a card from the drop-down list. Selectable cards are OSCM or OSC-CSM. 
Slots 10 through 17 represent the east side of the node.

Step 5 Click OK. 

Step 6 Return to your originating procedure (NTP).

NTP-G39 Verify OSCM and OSC-CSM Transmit Power

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to provision the 
DWDM cable connections. If you are already logged in, continue with Step 2.

Purpose This task creates a DWDM ring ID.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure verifies the transmit power of the ONS 15454 Optical 
Service Channel Module (OSCM) and the Optical Service Channel + 
Combiner Separator Module (OSC-CSM).

Tools/Equipment None

Prerequisite Procedures NTP-G37 Run Automatic Node Setup, page 3-58

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 2 In the node view shelf graphic, double-click the OSCM or OSC-CSM card.

Step 3 Click the Maintenance tab.

Step 4 From the ALS Mode drop-down list, choose Manual Start for Test. Click Apply.

Step 5 Click the Provisioning > Optical Line tabs. 

Step 6 For the TX (transmit) port entry, verify that the Power value is one of the following: 

• If the OSC-CSM is connected to the span and OPT-BST cards are not installed, Power should be the 
Poutad value or –6.5, whichever is less.

• If OSCM and OPT-BST cards are installed: –5 dBm if the OPT-PRE is set to Control Gain and the 
OPT-PRE is not provisioned or equipped; or –0.5 dBm (the maximum value) if it is set to Control 
Power. (Evaluate the power of the OPT-PRE that is installed on the same side as the OSCM card.)

• If OSC-CSM and OPT-BST cards are installed and the OPT-PRE is not provisioned or equipped: 
–5 dBm if the OPT-PRE is set to Control Gain, or –1.5 dBm (the maximum value) if it is set to 
Control Power. (Evaluate the power of the OPT-PRE that is installed on the same side as the 
OSC-CSM.)

Step 7 If the OSCM or OSC-CSM power levels are not within the ranges specified in Step 6, complete the 
following steps. Otherwise, continue with Step 8.

a. Click the Maintenance > ALS tabs. Verify that the ALS Command is set to OSRI off. 

b. In the ALS Command area, choose Manual Restart and click Apply.

c. Clean the optical connections. See the “NTP-G115 Clean Fiber Connectors” procedure on 
page 11-32.

d. Verify the optical connections inside the unit.

e. Relaunch ANS.

Step 8 Continue with the node acceptance test procedures in Chapter 4, “Perform Node Acceptance Tests”.

Stop. You have completed this procedure.

NTP-G40 Replace the Front Door 

Note Be careful not to crimp any fiber cables that are connected to the MXP/TXP cards or DWDM cards. 
Some might not have the fiber boot attached. 

Purpose This procedure replaces the front door and door ground strap after 
installing cards and fiber-optic cables. 

Tools/Equipment #2 Phillips screwdriver

Medium slot-head screwdriver 

Small slot-head screwdriver 

Prerequisite Procedures NTP-G3 Open and Remove the Front Door, page 1-20

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
3-64
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 3      Turn Up a Node
NTP-G40 Replace the Front Door
Step 1 Insert the front door into the hinges on the shelf assembly.

Step 2 Attach one end of the ground strap terminal lug (72-3622-01) to the male stud on the inside of the door. 
Attach and tighten the #6 Kepnut (49-0600-01) using the open-end wrench (Figure 3-19).

Figure 3-19 Installing the Door Ground Strap Retrofit Kit

Step 3 Attach the other end of the ground strap to the longer screw on the fiber guide.

a. Attach the lock washer.

b. Attach the terminal lug.

c. Using the open-end wrench, attach and tighten the #4 Kepnut (49-0337-01) on the terminal lug. 

Note To avoid interference with the traffic (line) card, make sure the ground strap is in a flat 
position when the door is open. To move the ground strap into a flat position, rotate the 
terminal lug counterclockwise before tightening the Kepnut.

Step 4 Replace the left cable-routing channel.

Step 5 Using a Phillips screwdriver, insert and tighten the screws for the cable-routing channel.

Figure 3-20 shows the shelf assembly with the front door and ground strap installed.

71
04

8
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Figure 3-20 Shelf Assembly with Door Ground Strap Retrofit Kit Installed

Step 6 Swing the door closed. 

Note The ONS 15454 comes with a pinned hex key tool for locking and unlocking the front door. Turn 
the key counterclockwise to unlock the door and clockwise to lock it. 

Stop. You have completed this procedure. 
71

04
6

Ground strap cable
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C H A P T E R 4

Perform Node Acceptance Tests

This chapter provides acceptance test procedures for ONS 15454 dense wavelength division 
multiplexing (DWDM) nodes.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before you begin the procedures in this chapter, complete the procedures applicable to your site plan 
from the following chapters:

• Chapter 1, “Install the Shelf and Common Control Cards”

• Chapter 2, “Connect the PC and Log into the GUI”

• Chapter 3, “Turn Up a Node”

This section lists the procedures (NTPs) that you need to complete to turn up a DWDM node. Turn to a 
procedure for applicable tasks (DLPs).

1. NTP-G41 Perform the Terminal and Hub Node with 32MUX-O and 32DMX-O Cards Acceptance 
Test, page 4-2—Complete this procedure to test terminal and hub nodes with 32MUX-O and 
32DMX-O cards installed.

2. NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test, page 
4-4—Complete this procedure to test terminal nodes with 32WSS and 32DMX cards installed.

3. NTP-G43 Perform the ROADM Node Acceptance Test, page 4-6—Complete this procedure to test 
ROADM nodes.

4. NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test, page 4-8—Complete this procedure 
to test anti-ASE hub nodes.

5. NTP-G45 Perform the Symmetric Line Node with OSCM Cards Acceptance Test, page 
4-10—Complete this procedure to test symmetric line nodes with OSCM cards.

6. NTP-G46 Perform the Symmetric Line Node with OSC-CSM Cards Acceptance Test, page 
4-12—Complete this procedure to test symmetric line nodes with OSC-CSM cards.

7. NTP-G47 Perform the Asymmetric Line Node with OSC-CSM and OSCM Cards Acceptance Test, 
page 4-13—Complete this procedure to test asymmetric line nodes with OSCM and OSC-CSM 
cards.
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8. NTP-G48 Perform the Symmetric OADM Node with OSCM Cards Acceptance Test, page 
4-16—Complete this procedure to test symmetric OADM nodes with OSCM cards.

9. NTP-G49 Perform the Symmetric OADM Node with OSC-CSM Cards Acceptance Test, page 
4-18—Complete this procedure to test symmetric OADM nodes with OSC-CSM cards.

10. NTP-G50 Perform the Symmetric Passive OADM Node with OSC-CSM Cards Acceptance Test, 
page 4-20—Complete this procedure to test symmetric passive OADM nodes with OSC-CSM cards.

NTP-G41 Perform the Terminal and Hub Node with 32MUX-O 
and 32DMX-O Cards Acceptance Test

Note This procedure tests the west side of hub nodes first, then the east side. If you are testing a terminal node, 
apply instructions for the west side of the hub node to the terminal side (east or west) of the terminal 
node.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the hub or terminal node that you want to 
test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Note If OSC terminations are created, there will be two alarms, one for low power on the Optical 
Booster (OPT-BST) card, and the other an OSC channel alarm.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Purpose This procedure tests a DWDM terminal or hub node with 32MUX-O and 
32DMX-O cards. 

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 5 Verify that the OSC link becomes active on the west Optical Service Channel Module (OSCM) or Optical 
Service Channel and Combiner/Separator Module (OSC-CSM). (The OSC Termination must already be 
provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Step 6 Create a physical loopback on the west or terminal OPT-BST amplifier by using a patch cord with 10-dB 
bulk attenuators to connect the LINE TX port to the LINE RX port.

Note The OPT-BST low power alarm should go away; the OSC channel alarm will remain.

Step 7 Tune the tunable laser to the first wavelength (1530.33 nm) of the 100-GHz ITU-T grid and connect it 
to the CHAN RX 01 port on the west (or terminal) 32-Channel Multiplexer (32MUX-O) card using the 
available patch panel. 

Step 8 Display the west (or terminal) 32MUX-O card in card view.

Step 9 Click the Provisioning > Optical Chn > Parameters tabs.

Step 10 Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 11 Verify that the Port 1 power level reaches the provisioned VOA Power Ref setpoint. 

Note The tunable laser minimum output optical power (Pout) must be 6 dBm. If the output power is 
lower than the specified value, the 32MUX-O card might not reach the provisioned setpoint.

Step 12 If an OPT-BST card is installed, complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and 
Power” task on page 4-22 on the west (or terminal side) OPT-BST to ensure that the amplifier is working 
properly.

Step 13 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 on the west 
(or terminal) OPT-PRE to ensure that the amplifier is working properly.

Step 14 Complete the “DLP-G81 Verify the 32DMX-O or 32DMX Power” task on page 4-24 on the west (or 
terminal) 32DMX-O to ensure that the card is powered correctly.

Step 15 Restore the default IS,AINS (ANSI) or Unlocked,automaticInService (ETSI) admin state to the 
32MUX-O port that was changed to OOS,MT/Locked,maintenance in Step 10.

Step 16 Repeat Steps 7 through 15 for the remaining 32 wavelengths of the 100-Ghz grid to verify the correct 
behavior of all variable optical attenuators (VOAs) inside the 32MUX-O card.

Step 17 Remove the loopback created in Step 6.

Step 18 If the node is a hub node, repeat Steps 6 through 17 for the east side cards. If the node is a terminal node, 
continue with Step 19.

Step 19 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58 to restore the original 
configuration.

Step 20 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Stop. You have completed this procedure.
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NTP-G42 Perform the Terminal Node with 32WSS and 32DMX 
Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the hub or terminal node that you want to 
test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Note If OSC terminations are created, there will be two alarms, one for low power on the Optical 
Booster (OPT-BST) card, and the other an OSC channel alarm.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 Verify that the OSC link becomes active on the west Optical Service Channel Module (OSCM) or Optical 
Service Channel and Combiner/Separator Module (OSC-CSM). (The OSC Termination must already be 
provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Step 6 Create a physical loopback on the OPT-BST amplifier by using a patch cord with 10-dB bulk attenuators 
to connect the LINE TX port to the LINE RX port.

Note The OPT-BST low power alarm should go away; the OSC channel alarm will remain.

Step 7 Tune the tunable laser to the first wavelength (1530.33 nm) of the 100-GHz ITU-T grid and connect it 
to the CHAN RX 01 port on the 32-Channel Wavelength Selective Switch (32WSS) card using the 
available patch panel. 

Step 8 Display the 32WSS card in card view.

Step 9 Click the Provisioning > Optical Chn > Parameters tabs.

Purpose This procedure tests a DWDM terminal node with 32WSS and 32DMX 
cards installed. 

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Chapter 4      Perform Node Acceptance Tests
NTP-G42 Perform the Terminal Node with 32WSS and 32DMX Cards Acceptance Test
Step 10 Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 11 Change the Port 33 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 12 Click the Maintenance tab.

Step 13 For Channel #1, change Operating Mode to Add Drop.

Step 14 Click the Provisioning > Optical Chn > Parameters tabs.

Step 15 Verify that the Port 1 power level reaches the provisioned VOA Power Ref setpoint.

Step 16 Display the OPT-BST card (if present) in card view.

Step 17 Click the Provisioning > Optical Chn > Parameters tabs.

Step 18 Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 19 Display the OPT-PRE card in card view.

Step 20 Click the Provisioning > Optical Chn > Parameters tabs.

Step 21 Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 22 Display the 32-DMX in card view.

Step 23 Click the Provisioning > Optical Chn > Parameters tabs.

Step 24 Change the Port 33 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Note The tunable laser minimum output optical power (Pout) must be 6 dBm. If the output power is 
lower than the specified value, the 32MUX-O card might not reach the provisioned setpoint.

Step 25 If an OPT-BST card is installed, complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and 
Power” task on page 4-22 on the OPT-BST to ensure that the amplifier is working properly.

Step 26 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 on the 
OPT-PRE to ensure that the amplifier is working properly.

Step 27 Complete the “DLP-G81 Verify the 32DMX-O or 32DMX Power” task on page 4-24 on the 32DMX to 
ensure that the card is powered correctly.

Step 28 Restore the default admin states to the 32WSS, OPT-BST, OPT-PRE, and 32DMX ports that were 
changed to OOS,MT/Locked,maintenance in Steps 10, 11, 18, 21, and 24.

Step 29 Repeat Steps 7 through 28 for the remaining 32 wavelengths of the 100-Ghz grid to verify the correct 
behavior of all variable optical attenuators (VOAs) inside the 32WSS and 32DMX cards.

Step 30 Remove the loopback created in Step 6.

Step 31 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58 to restore the original 
configuration.

Step 32 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Stop. You have completed this procedure.
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NTP-G43 Perform the ROADM Node Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the hub or terminal node that you want to 
test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Note If OSC terminations are created, there will be two alarms, one for low power on the Optical 
Booster (OPT-BST) card, and the other an OSC channel alarm.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are listed as Success - Changed, Success - Unchanged, or Not Applicable. If any are not, 
complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 From your Cisco MetroPlanner site configuration file, identify the dropped and added channels that are 
configured in pass-through mode in both directions. Mark these channels and skip the related optical test 
for the add and drop section involved. The channel pass-through connections are verified separately.

Note Configuring a channel pass-through mode means the channel is passes through the 32WSS card 
from the COM port to the EXP port. The channel is not terminated inside the node.

Step 6 Create a physical loopback on the west OPT-BST amplifier by connecting a patch cord the LINE TX port 
to the LINE RX port with 10-dB bulk attenuator.

Step 7 Verify that the OSC link becomes active on the west Optical Service Channel Module (OSCM) or Optical 
Service Channel and Combiner/Separator Module (OSC-CSM). (The OSC Termination must already be 
provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Step 8 For pass-through channels, continue with Step 9. If you do not have pass-through channels, continue 
with Step 34.

Purpose This procedure tests a ROADM node.

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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NTP-G43 Perform the ROADM Node Acceptance Test
Step 9 Verify the first channel connection configured in pass-through mode in both directions:

a. Set the tunable laser output power to a nominal values, such as –3 dBm, and tune it to the 
corresponding wavelength on the 100 GHz ITU-T grid.

b. Connect the tunable laser to the LINE RX port of the east OPT-BST using a 10 dB attenuator.

Step 10 Display the west 32WSS card in card view.

Step 11 Click the Provisioning > Optical Chn > Parameters tabs.

Step 12 Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 13 Change the Port 33 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 14 Click the Maintenance tab.

Step 15 For Channel #1, change Operating Mode to Pass Through.

Step 16 Repeat Steps 11 through 15 for the east 32WSS card.

Step 17 Display the west 32WSS card in card view.

Step 18 Click the Provisioning > Optical Chn > Parameters tabs.

Step 19 Verify that the Port 33 power level reaches the provisioned VOA Power Ref setpoint.

Step 20 Repeat Steps 17 through 19 for the east 32WSS card.

Step 21 Repeat Steps 9 through 20 for the remaining 32 wavelengths of the 100 GHz grid to verify all 32WSS 
VOAs.

Step 22 Display the west OPT-BST card (if present) in card view.

Step 23 Click the Provisioning > Optical Chn > Parameters tabs.

Step 24 Change the Port 1 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 25 Repeat Steps 22 through 24 for the east OPT-BST card.

Step 26 Display the west OPT-PRE card in card view.

Step 27 Click the Provisioning > Optical Chn > Parameters tabs.

Step 28 Change the Port 6 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 29 Repeat Steps 26 through 28 for the east OPT-PRE card.

Step 30 If an OPT-BST card is installed on the west, complete the “DLP-G79 Verify the OPT-BST Amplifier 
Laser and Power” task on page 4-22 OPT-BST to ensure that the amplifier is working properly.

Step 31 Repeat 30 for the east OPT-BST.

Step 32 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 on the west 
OPT-PRE to ensure that the amplifier is working properly.

Step 33 Tune the tunable laser to the first wavelength of the 100 GHz grid and connect it to the CHAN RX 30.3 
port on the west 32WSS card.

Step 34 Display the west 32-WSS in card view.

Step 35 Click the Maintenance tab.

Step 36 For Channel #1, change Operating Mode to Add Drop.

Step 37 Click the Provisioning > Optical Chn > Parameters tabs.

Step 38 Verify that the Port 1 power value reaches the provisioned VOA Power Ref setpoint.

Step 39 Display the 32DMX card in card view.

Step 40 Click the Provisioning > Optical Chn > Parameters tabs.
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Step 41 Change the Port 33 Admin State to OOS,MT (ANSI) or Locked,maintenance (ETSI).

Step 42 Verify that the Port 1 power value reaches the provisioned VOA Power Ref setpoint.

Step 43 (optional) Connect a power meter to the CHAN TX 1 port through the patch panel and verify that the 
physical optical power coming from the drop port 1 on the west 32DMX is consistent with the value read 
on the meter, within 0.5 dB.

Step 44 Repeat Steps 34 through 43 for the remaining wavelengths on the 100 GHz.

Step 45 Remove the loopback created in Step 6.

Step 46 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58 to restore the original 
configuration.

Step 47 Create a physical loopback on the east OPT-BST amplifier by connecting a patch cord the LINE TX port 
to the LINE RX port with 10-dB bulk attenuator.

Step 48 Verify that the OSC link becomes active on the east OSCM card. (The OSC Termination must already 
be provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Step 49 Repeat Steps 34 through 48 for the east side 32WSS. 

Step 50 Restore the default admin states that were changed to OOS,MT/Locked,maintenance in Steps 12, 13, 24, 
28, and 41.

Step 51 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Stop. You have completed this procedure.

NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Purpose This procedure tests an anti-ASE hub node. 

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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NTP-G44 Perform the Anti-ASE Hub Node Acceptance Test
Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 From your Cisco MetroPlanner site configuration file, identify the dropped and added channels that are 
configured in pass-through mode in both directions. Mark these channels and skip the related optical test 
for the add and drop section involved. The channel pass-through connections are verified separately.

Note Configuring a channel pass-through mode means the channel is dropped along one direction by 
a 32DMX-O (15xx.xx TX port) located on one side (west or east) of the shelf, and then added 
by another 32MUX-O (1522.22 RX port) on the opposite side of the shelf but in the same 
direction. The channel is not terminated inside the site.

Step 6 Create a loopback on the west OPT-BST amplifier by connecting a patch cord from the LINE TX port 
to the LINE RX port with 10-dB bulk attenuator.

Step 7 Verify that the OSC link becomes active on the west OSCM or OSC-CSM card. (The OSC Termination 
must already be provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on 
page 3-61.)

Step 8 For pass-through channels, continue with Step 9. For add and drop channels, continue with Step 17.

Step 9 Verify the first channel connection configured in pass-through mode in both directions:

a. Set the output power on the tunable laser to a nominal value, such as –3 dBm, and tune it on the 
correspondent wavelength of the 100-GHz ITU-T grid.

b. Connect the tunable laser to the LINE RX port of the east OPT-BST using a 10-dB bulk attenuator.

Step 10 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 for the east 
OPT-PRE amplifier.

Step 11 Complete the “DLP-G81 Verify the 32DMX-O or 32DMX Power” task on page 4-24 for the east 
32MUX-O and 32DMX-O cards.

Step 12 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the 
west OPT-BST amplifier.

Step 13 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 for the 
west OPT-PRE amplifier.

Step 14 Complete the “DLP-G78 Verify the 32MUX-O and 32DMX-O Power” task on page 4-22 for the east 
32MUX-O and 32DMX-O cards.

Step 15 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the east 
OPT-BST amplifier.

Step 16 If you have add and drop channels, continue with Step 17 to verify. If not, continue with Step 27.

Step 17 Tune the tunable laser on the first wavelength of the 100-GHz ITU-T grid that is not a pass-through 
wavelength. Connect it to the CHAN RX nn port on the west 32MUX-O, where nn is the first add or drop 
channel.
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NTP-G45 Perform the Symmetric Line Node with OSCM Cards Acceptance Test
Step 18 Display the west 32MUX-O in card view.

Step 19 Click the Provisioning > Optical Chn > Parameters tabs.

Step 20 Change the Admin State of Port nn to OOS,MT/Locked,maintenance.

Step 21 Check that the power value on Port nn reaches the provisioned setpoint (VOA Power Ref).

Step 22 Display the west 32DMX-O or 32DMX in card view.

Step 23 Click the Provisioning > Optical Chn > Parameters tabs.

Step 24 Change the Admin State of Port nn to OOS,MT/Locked,maintenance.

Step 25 Check that the power value on Port nn reaches the provisioned setpoint (VOA Power Ref).

Step 26 (Optional.) Connect a power meter to the CHAN TX nn port through the patch panel and verify that the 
physical optical power coming out of drop Port nn on the west 32DMX-O is consistent with the value 
read on the meter within 0.5 dB.

Step 27 Repeat Steps 17 through 26 for the remaining wavelengths on the 100-GHz grid that are not pass-through 
wavelengths. 

Step 28 Remove the loopback connection on the west OPT-BST.

Step 29 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58 to restore the original 
configuration.

Step 30 Create a loopback on the east OPT-BST amplifier by connecting a patch cord from the LINE TX port to 
the LINE RX port with 10-dB bulk attenuator.

Step 31 Verify that the OSC link becomes active on the east OSCM card. (The OSC termination must be already 
provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Step 32 Repeat 17 through 31 for the east side cards.

Step 33 Restore the default admin state (IS,AINS/Unlocked,automaticInService) on all the ports previously set 
to OOS,MT/Locked,maintenance.

Stop. You have completed this procedure.

NTP-G45 Perform the Symmetric Line Node with OSCM Cards 
Acceptance Test

Purpose This procedure tests a symmetric line node with OSCM cards.

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. 

Step 5 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 6 Create a loopback on the west OPT-BST amplifier by connecting a patch cord from the LINE TX port 
to the LINE RX port with 10-dB bulk attenuator.

Step 7 Verify that the OSC link becomes active on the west OSCM card. (The OSC termination must be already 
provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 8 Set the output power on the tunable laser to a nominal value, such as –3 dBm, and tune it to the first 
available wavelength of the 100-GHz ITU-T grid. Connect it to the LINE RX port of the OPT-BST-E 
using a 10-dB bulk attenuator.

Step 9 If an OPT-PRE card is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-23 for it. If not, continue with Step 10.

Step 10 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the 
west OPT-BST amplifier.

Step 11 If an OPT-PRE amplifier is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE 
Amplifier Laser and Power” task on page 4-23. It not, continue with continue with Step 12.

Step 12 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the east 
OPT-BST amplifier.

Step 13 Remove the loopback on the west OPT-BST amplifier created in Step 6.

Step 14 Repeat Steps 6 through 12 for the east side line connection.

Step 15 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58 to restore the original 
configuration.

Stop. You have completed this procedure.
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NTP-G46 Perform the Symmetric Line Node with OSC-CSM 
Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 Create a loopback on the west OSC-CSM by connecting the LINE TX port with LINE RX port using a 
patch cord and 10-dB bulk attenuator.

Step 6 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 7 If the OSC link is turned up, continue with Step 8. If not, perform the following troubleshooting 
procedure:

a. Remove 10-dB bulk attenuator between LINE TX to LINE RX connection and connect using only 
the patch cord. If the OSC becomes active, continue with Step 8, otherwise continue this 
troubleshooting procedure.

b. Display the OSC-CSM in card view.

c. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs, and change the Port 6 opwrMin (minimum power) to –40 dBm.

d. Modify the COM TX Fail Low Threshold. Change the Port 4 opwrMin (minimum power) to 
–30 dBm.

Purpose This procedure tests a symmetric line node with OSC-CSM cards.

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Note If the OSC link does not turn up, replace the card.

Step 8 Set the output power on the tunable laser to a nominal value, such as –3 dBm, and tune it on the first 
available wavelength of the 100-GHz ITU-T grid. 

Step 9 Connect the tunable laser to the east OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Step 10 If an OPT-PRE card is installed on the east side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-23 for it. If not, continue with Step 11.

Step 11 Complete the “DLP-G82 Verify the OSC-CSM Power” task on page 4-24 on the west OSC-CSM card.

Note As a consequence of OSC link activation, the 1 x 1 optical switch inside the west OSC-CSM card 
must be in closed position to enable the pass through of the optical power launched by the 
tunable laser.

Step 12 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 for the 
west OPT-PRE amplifier.

Step 13 Complete the “DLP-G84 Verify the OSC-CSM Incoming Power” task on page 4-25 on the east 
OSC-CSM card.

Step 14 Remove the loopback created on the west OSC-CSM in Step 5. 

Step 15 Repeat Steps 5 through 14 for the east side connections.

Step 16 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58 to restore the original 
configuration.

Stop. You have completed this procedure.

NTP-G47 Perform the Asymmetric Line Node with OSC-CSM and 
OSCM Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to perform the 
acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Purpose This procedure tests an asymmetric line node with an OSC-CSM card 
installed on one side and an OSCM card installed on the other.

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 Create a loopback on the OSC-CSM card by connecting the LINE TX port with LINE RX port using a 
patch cord and 10-dB bulk attenuator.

Step 6 Verify that the OSC link becomes active on the OSC-CSM card. (The OSC termination must be already 
provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 7 If the OSC link is turned up, continue with Step 8. If not, perform the following troubleshooting 
procedure:

a. Remove 10-dB bulk attenuator between LINE TX to LINE RX connection and connect using only 
the patch cord. If the OSC becomes active, continue with Step 8, otherwise continue this 
troubleshooting procedure.

b. Display the OSC-CSM in card view.

c. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs, and change the Port 6 opwrMin (minimum power) to –40 dBm.

d. Modify the COM TX Fail Low Threshold. Change the Port 4 opwrMin (minimum power) to 
–30 dBm.

Note If the OSC link does not turn up, replace the card.

Step 8 Set the output power on the tunable laser to a nominal value, such as –3 dBm, and tune it on the first 
available wavelength of the 100-GHz ITU-T grid.

Step 9 Connect the tunable laser to the OSC-CSM LINE RX port using a 10-dB bulk attenuator.

Step 10 Display the OPT-BST on the side opposite the OSC-CSM in card view.

Step 11 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 2 
(Out Com) is equal to the optical power from the tunable laser.

Step 12 If an OPT-PRE card is installed on the side opposite the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 4-23 for it. If not, continue with Step 13.

Step 13 Complete the “DLP-G82 Verify the OSC-CSM Power” task on page 4-24 on the OSC-CSM card.

Note As a consequence of OSC link activation, the 1 x 1 optical switch inside the west OSC-CSM card 
must be closed to allow the optical power from the tunable laser to pass through.

Step 14 If an OPT-PRE card is installed on the same side as the OSC-CSM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 4-23 for it. If not, continue with Step 15.
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NTP-G47 Perform the Asymmetric Line Node with OSC-CSM and OSCM Cards Acceptance Test
Step 15 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the 
OPT-BST card installed on the opposite side of the OSC-CSM.

Step 16 Remove the loopback fiber on the OSC-CSM card.

Step 17 Launch ANS:

a. In node view, click the Provisioning > WDM-ANS > Port Status tabs.

b. Click Launch ANS.

Step 18 Create a loopback on the OPT-BST card installed on the same side as the OSCM card by connecting the 
LINE TX port with LINE RX port using a patch cord and 10-dB bulk attenuator.

Step 19 Verify that the OSC link becomes active on the OSCM or OSC-CSM card. (The OSC termination must 
be already provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 20 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 for the 
OPT-PRE amplifier card installed on the same side as the OSCM.

Step 21 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the 
OPT-BST card installed on the opposite side of the OSCM.

Step 22 Display the OPT-BST on the side opposite the OSCM in card view.

Step 23 Click the Provisioning > Optical Line > Parameters tabs. Verify that the power value on Port 2 
(Out Com) is equal to the optical power from the tunable laser.

Step 24 If an OPT-PRE card is installed on the side opposite the OSCM, complete the “DLP-G80 Verify the 
OPT-PRE Amplifier Laser and Power” task on page 4-23 for it. If not, continue with Step 25.

Step 25 Remove the loopback fiber on the OPT-BST amplifier card.

Step 26 Launch ANS:

a. In node view, click the Provisioning > WDM-ANS > Port Status tabs.

b. Click Launch ANS.

Stop. You have completed this procedure.
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NTP-G48 Perform the Symmetric OADM Node with OSCM Cards Acceptance Test
NTP-G48 Perform the Symmetric OADM Node with OSCM Cards 
Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the OADM node where you want to 
perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 Check your Cisco MetroPlanner site configuration file to verify the presence of added and dropped bands 
(including four channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means the band is dropped in one direction by an 
AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB-x.xx card 
on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Purpose This procedure checks the integrity of all the optical connections inside a 
symmetric OADM node with OSCM cards. Three connection types are 
tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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NTP-G48 Perform the Symmetric OADM Node with OSCM Cards Acceptance Test
Note Configuring a channel in pass-through mode means the channel is dropped in one direction by 
an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC x.xx 
card on the opposite side in the same direction. The channel is not terminated inside the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the west OPT-BST by connecting the LINE TX port to the LINE RX port using a 
patch cord and 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the west OSCM card. (The OSC termination must be already 
provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Step 11 If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the 
following steps:

a. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

b. Modify the COM TX Fail Low Threshold. Change the Port 4 opwrMin (minimum power) to 
–30 dBm.

c. If the OSC link turns up, continue with Step 12. If the OSC link is still down, disconnect the OSCM 
card from the OPT-BST.

d. Create a loopback on the OSCM card by connecting patch cable from the OSC TX port to the 
OSC RX port using a 10-dB bulk attenuator.

e. If the OSC link turns up, replace the OPT-BST card. If the OSC link does not turn up, replace the 
OSCM card.

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 12 If the node has express bands or channels, complete the “DLP-G85 Verify Express Channel 
Connections—OADM Node with OSCM Cards” task on page 4-26. If the node does not have express 
bands or channels, continue with Step 13.

Step 13 If connections configured in pass-through mode are present (noted inSteps 5 and 7), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-29. If not, continue 
with Step 14.

Step 14 If connections have add/drop connections, complete the “DLP-G93 Verify Add and Drop Connections 
on OADM Node with OSCM Card” task on page 4-33.

Stop. You have completed this procedure.
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Chapter 4      Perform Node Acceptance Tests
NTP-G49 Perform the Symmetric OADM Node with OSC-CSM Cards Acceptance Test
NTP-G49 Perform the Symmetric OADM Node with OSC-CSM 
Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the OADM node where you want to 
perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 Check the Cisco MetroPlanner site configuration file to verify the presence of added and dropped bands 
(including 4 channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means the band is dropped in one direction by an 
AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB-x.xx card 
on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Purpose This procedure checks the integrity of all the optical connections inside a 
symmetric OADM node with OSC-CSM cards. Three connection types are 
tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
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NTP-G49 Perform the Symmetric OADM Node with OSC-CSM Cards Acceptance Test
Note Configuring a channel in pass-through mode means the channel is dropped in one direction by 
an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC x.xx 
card on the opposite side in the same direction. The channel is not terminated inside the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the west OSC-CSM card by connecting the LINE TX port to the LINE RX port 
using a patch cord and 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 11 If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 12. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 12. If it does not turn up, replace the OSC-CSM card. 

Step 12 If the node has express bands or channels, complete the “DLP-G85 Verify Express Channel 
Connections—OADM Node with OSCM Cards” task on page 4-26. If the node does not have express 
bands or channels, continue with Step 13.

Step 13 If connections configured in pass-through mode are present (noted in Steps 5 and 7), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-29. If not, continue 
with Step 14.

Step 14 If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections 
on OADM Node with OSC-CSM Card” task on page 4-35.

Stop. You have completed this procedure.
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NTP-G50 Perform the Symmetric Passive OADM Node with OSC-CSM Cards Acceptance Test
NTP-G50 Perform the Symmetric Passive OADM Node with 
OSC-CSM Cards Acceptance Test

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the OADM node where you want to 
perform the acceptance test. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View.

Step 3 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 4 In node view, click the Provisioning > WDS-ANS > Port Status tabs. Verify that all statuses under 
Link Status are Success - Changed, Success - Unchanged, or Not Applicable. If not, complete the 
“NTP-G37 Run Automatic Node Setup” procedure on page 3-58. 

Step 5 Check the Cisco MetroPlanner site configuration file to verify the presence of a dropped/added bands 
(including 4 channels at 100 GHz) configured in pass-through mode in either direction.

Note Configuring a band in pass-through mode means the band is dropped in one direction by an 
AD-xB-xx.x card on one side (east or west) of the node, then added by another AD-xB x.xx card 
on the opposite side in the same direction. The band is not terminated inside the node.

Step 6 If no bands are configured in pass-through mode, continue with Step 7. If a band is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. Band 
pass-through connections are verified separately.

Step 7 Check the site configuration file from Cisco MetroPlanner to verify the presence of dropped or added 
channels configured in pass-through mode in either direction.

Purpose This procedure checks the integrity of all the optical connections inside a 
symmetric passive OADM node with OSC-CSM cards.Three connection 
types are tested:

• Express

• Pass-through

• Add/Drop

Tools/Equipment • A tunable laser

• An optical power meter or optical spectrum analyzer

• 2 bulk attenuators (10 dB) LC

Prerequisite Procedures Chapter 3, “Turn Up a Node.”

Required/As Needed Required

Onsite/Remote Onsite

Security Level Superuser
4-20
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 4      Perform Node Acceptance Tests
NTP-G50 Perform the Symmetric Passive OADM Node with OSC-CSM Cards Acceptance Test
Note Configuring a channel in pass-through mode means the channel is dropped in one direction by 
an AD-xC-xx.x card on one side (east or west) of the node, then added by another AD-xC x.xx 
card on the opposite side in the same direction. The channel is not terminated inside the node.

Step 8 If no channels are configured in pass-through mode, continue with Step 9. If a channel is configured in 
pass-through mode, mark it and skip the related optical test for the express, add, and drop sections. 
Channel pass-through connections are verified separately.

Step 9 Create a loopback on the west OSC-CSM card by connecting the LINE TX port to the LINE RX port 
using a patch cord and 10-dB bulk attenuator.

Step 10 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 11 If the OSC link becomes active, continue with Step 12. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 12. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 12. If it does not turn up, replace the OSC-CSM card. 

Step 12 If the node has express bands or channels, complete the “DLP-G86 Verify Express Channel 
Connections—OADM Node with OSC-CSM Cards” task on page 4-27. If the node does not have express 
bands or channels, continue with Step 13.

Step 13 If connections configured in pass-through mode are present (noted in Steps 5 and 7), complete the 
“DLP-G89 Verify OADM Node Pass-Through Channel Connections” task on page 4-29. If not, continue 
with Step 14.

Step 14 If connections have add/drop connections, complete the “DLP-G94 Verify Add and Drop Connections 
on OADM Node with OSC-CSM Card” task on page 4-35.

Stop. You have completed this procedure.
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DLP-G78 Verify the 32MUX-O and 32DMX-O Power
DLP-G78 Verify the 32MUX-O and 32DMX-O Power

Step 1 Display the 32MUX-O in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the Admin State of the correspondent port to OOS,MT/Locked,maintenance.

Step 4 Check that the power value on the port reaches the provisioned setpoint (VOA Power Ref).

Step 5 Display the east 32DMX-O in card view.

Step 6 Click the Provisioning > Optical Chn > Parameters tabs. 

Step 7 Change the Admin State of correspondent port to OOS,MT/Locked,maintenance.

Step 8 Check that the power value on the port reaches the provisioned setpoint (VOA Power Ref).

Step 9 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 10 Return to your originating procedure (NTP).

DLP-G79 Verify the OPT-BST Amplifier Laser and Power

Step 1 In node view, double-click the OPT-BST amplifier to display the card view. 

Step 2 If the Laser Status displayed in the information area is “On” continue with Step 3. If not, complete the 
following steps:

a. Click the Maintenance > ALS tabs.

b. Check the OSRI setting. If it is set to On, change it to Off and click Apply.

c. Check the Laser Status. If it changes to On, continue with Step 3. If not, contact your next level of 
support. The amplifier might need to be replaced.

Step 3 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Purpose This task verifies 32MUX-O and 32DMX-O power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies that the OPT-BST amplifier laser is on and provisioned 
to the correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G80 Verify the OPT-PRE Amplifier Laser and Power
Step 4 Verify that the Port 2 Optical Power Set-Point is greater than or equal to 2 dBm. (This value includes the 
ASE power contribution.)

Note When the laser is off, the Optical Power Set-Point is –1 dBm. Disregard this value, as it is not a 
significant optical power.

If the optical power is not greater than or equal to 2 dBm, do not continue. Begin troubleshooting or 
contact your next level of support.

Step 5 Return to your originating procedure (NTP).

DLP-G80 Verify the OPT-PRE Amplifier Laser and Power

Step 1 In node view, double-click the OPT-PRE amplifier to display the card view. 

Step 2 If the Laser Status displayed in the information area is “On” continue with Step 3. If not, complete the 
following steps:

a. Click the Maintenance > ALS tabs.

b. Check the OSRI setting. If it is set to On, change it to Off and click Apply.

c. Check the Laser Status. If it changes to On, continue with Step 3. If not, contact your next level of 
support. The amplifier might need to be replaced.

Step 3 Click the Provisioning > Opt Ampli Line > Parameters tabs.

Step 4 Verify that the Port 2 Optical Power Set-Point value is greater than or equal to 2 dBm. (This value 
includes the ASE power contribution.)

Note When the laser is off, the Optical Power Set-Point is –1 dBm. Disregard this value, as it is not a 
significant optical power.

If the optical power is not greater than or equal to 2 dBm, do not continue. Begin troubleshooting or 
contact your next level of support.

Step 5 Verify that the DCU Insertion Loss value is less than or equal to 10 dB.

Step 6 Return to your originating procedure (NTP).

Purpose This task verifies that the OPT-PRE amplifier laser is on and provisioned 
to the correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G81 Verify the 32DMX-O or 32DMX Power

Step 1 Display the 32DMX-O or 32DMX card in card view.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Change the Admin State for Port 1 to OOS,MT/Locked,maintenance.

Step 4 Verify that the VOA Power Ref reaches the provisioned set point.

Step 5 (Optional.) Connect a power meter to the CHAN TX 01 port through the patch panel. Verify that the 
physical optical power value coming from drop Port 1 on the west 32DMX-O or 32DMX card is 
consistent with the value read (the maximum allowed error is +/– 0.5 dBm).

Step 6 Change the Admin State for Port 1 to OOS,DSLB (ANSI) or Locked,disabled (ETSI).

Step 7 Return to your originating procedure (NTP).

DLP-G82 Verify the OSC-CSM Power 

Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify the Port 3 power value (Out Com) is higher than the default no-power value of –30 dBm. The 
expected value on Port 3 should be one of the following:

• If an OPT-PRE amplifier is not installed on the east side: Pout tunable laser – IL02 east OSC-CSM 
(LINE RX > COM TX) – IL02 OSC-CSM-W (COM RX > LINE TX) –10 dB (bulk attenuator)

• If an OPT-PRE amplifier is installed on the east side: Pout COM TX of east OPT-PRE (2 dBm) – 
IL02 west OSC-CSM (COM RX > LINE TX) – 10 dB (bulk attenuator)

Purpose This task verifies that the 32DMX-O or 32DMX card is provisioned to the 
correct power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies OSC-CSM card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G83 Verify the OSC-CSM Power—OADM Nodes
Note Actual output power is affected by many factors. Always consider the calculated expected power 
to be a general guideline and not a precise value.

Step 4 Return to your originating procedure (NTP).

DLP-G83 Verify the OSC-CSM Power—OADM Nodes

Step 1 Display the OSC-CSM card in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the Admin State for Port 1 to OOS,MT/Locked,maintenance.

Step 4 Verify that the Power value for Port 3 is higher than the default no-power value of –30 dBm. The 
calculated expected power value for Port 3 is:

Pout COM TX of last AD-xy-xx.x – IL02 OSC-CSM (COM RX > LINE TX) – 10 dB (bulk attenuator)

Step 5 Double-check the value.

Note Actual output power is affected by many factors. Always consider the calculated expected power 
to be a general guideline and not a precise value.

Step 6 Return to your originating procedure (NTP).

DLP-G84 Verify the OSC-CSM Incoming Power

Step 1 Display the OSC-CSM card in card view.

Purpose This task verifies OSC-CSM card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies OSC-CSM card incoming power.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Verify that the Power value for Port 2 is higher than the default no-power value of –30 dBm. The 
calculated expected power value for Port 2 is:

Pout COM TX of OPT-PRE + 2 dBm 

Note Actual output power is affected by many factors. Always consider the calculated expected power 
to be a general guideline and not a precise value.

Step 4 Return to your originating procedure (NTP).

DLP-G85 Verify Express Channel Connections—OADM Node with OSCM Cards

Step 1 Set the output power on the tunable laser to a nominal value, such as –3 dBm, and connect it to the east 
OPT-BST LINE RX port.

Step 2 Based on the Cisco MetroPlanner site configuration file, tune the tunable laser to a wavelength (on the 
100-GHz ITU-T grid) that runs on the express path of all AD-xB-xx.x and AD-xC-xx.x cards on the 
east-to-west and west-to-east directions.

Step 3 If an OPT-PRE card is installed on the east side, insert a 10-dB bulk attenuator on the COM RX port and 
complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23. If an 
OPT-PRE card is not installed on the east side, continue with Step 4.

Step 4 If AD-xB-xx.x cards are installed on the east side, complete the “DLP-G87 Verify the AD-xB-xx.x 
Output Express Power” task on page 4-28 for each card. If not, continue with Step 5.

Note If AD-xB-xx.x and AD-xC-xx.x cards are both installed in one direction, the band signal is 
dropped first, then the channel signal.

Step 5 If AD-xC-xx.x cards are installed on the east side, complete the “DLP-G88 Verify the AD-xC-xx.x 
Output Express Power” task on page 4-28 for each east side card. If not, continue with Step 6.

Step 6 If AD-xC-xx.x cards are installed on the west side, complete the “DLP-G88 Verify the AD-xC-xx.x 
Output Express Power” task on page 4-28 for each west side card. If not, continue with Step 7.

Step 7 If AD-xB-xx.x cards are installed on the west side, complete the “DLP-G87 Verify the AD-xB-xx.x 
Output Express Power” task on page 4-28 for each west side card. If not, continue with Step 8.

Step 8 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the 
OPT-BST installed on the east side.

Purpose This task verifies the express channel connections during an OADM node 
acceptance.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 9 If an OPT-PRE card is installed on the west side, complete the “DLP-G80 Verify the OPT-PRE Amplifier 
Laser and Power” task on page 4-23. If an OPT-PRE card is not installed, continue with Step 10.

Step 10 Repeat Steps 1 through 9 to the AD-xB-xx.x and AD-xC-xx.x cards along the west-to-east direction.

Step 11 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 for the 
OPT-BST installed on the west side.

Step 12 Return to the originating procedure (NTP).

DLP-G86 Verify Express Channel Connections—OADM Node with OSC-CSM 
Cards

Step 1 Set the output power on the tunable laser to a nominal value, such as –3 dBm, and connect it to the 
LINE RX port of the east OSC-CSM card.

Step 2 If an OPT-PRE amplifier card is installed on the east side, install a 10-dB bulk attenuator on the 
COM RX port.

Step 3 Based on the Cisco MetroPlanner site configuration file, tune the tunable laser on a wavelength 
(belonging to the 100-GHz ITU-T grid) running on the express path of all AD-xB-xx.x and AD-xC-xx.x 
cards on the east-to-west direction.

Step 4 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 for the 
OPT-PRE amplifier card installed on the west side.

Step 5 If AD-xB-xx.x cards are installed on the east side, complete the “DLP-G87 Verify the AD-xB-xx.x 
Output Express Power” task on page 4-28 for each east side card. If not, continue with Step 6.

Note If Ad-xB-xx.xand AD-xC cards are both installed in one direction, the band signal is dropped 
first, then the channel signal.

Step 6 If AD-xC-xx.x cards are installed on the east side, complete the “DLP-G88 Verify the AD-xC-xx.x 
Output Express Power” task on page 4-28 for each east side card. If not, continue with Step 7.

Step 7 If AD-xC-xx.x cards are installed on the west side, complete the “DLP-G88 Verify the AD-xC-xx.x 
Output Express Power” task on page 4-28 for each west side card. If not, continue with Step 8.

Step 8 If AD-xB-xx.x cards are installed on the west side, complete the “DLP-G87 Verify the AD-xB-xx.x 
Output Express Power” task on page 4-28 for each west side card. If not, continue with Step 9.

Step 9 Complete the “DLP-G83 Verify the OSC-CSM Power—OADM Nodes” task on page 4-25 for the 
OSC-CSM installed on the west side.

Purpose This task verifies the express channel connections during an OADM node 
acceptance.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 10 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 for the 
OPT-PRE card installed on the east side.

Step 11 Repeat Steps 1 through 10 to the AD-xB-xx.x and AD-xC-xx.x cards along the west-to-east direction.

Step 12 Complete the “DLP-G83 Verify the OSC-CSM Power—OADM Nodes” task on page 4-25 for the 
OSC-CSM installed on the east side.

Step 13 Return to the originating procedures (NTPs).

DLP-G87 Verify the AD-xB-xx.x Output Express Power

Step 1 Display the AD-xB-xx.x in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the Output Express port Admin State to OOS,MT/Locked,maintenance. Click Apply.

Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –28 dBm.

Step 5 Return to your originating procedure (NTP).

DLP-G88 Verify the AD-xC-xx.x Output Express Power

Step 1 Display the AD-xC-xx.x in card view.

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Change the Output Express port Admin State to OOS,MT/Locked,maintenance. Click Apply.

Step 4 Verify that the Output Express port Power value is greater than the default no-power value of –30 dBm.

Purpose This task verifies the output express power of Band OADM (AD-xB-xx.x) 
cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only

Purpose This task verifies the output express power of the Channel OADM 
(AD-xC-xx.x) cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 5 Return to your originating procedure (NTP).

DLP-G89 Verify OADM Node Pass-Through Channel Connections

Step 1 Identify the first band connection configured in pass-through mode in both directions.

Step 2 Tune the tunable laser to the wavelength of the band to be tested.

Step 3 Complete the “DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power” task on page 4-30 for 
the first pass-through connection.

Step 4 (Optional.) Complete one of the following:

• If OSCM cards are installed, connect a power meter to the east OPT-BST LINE TX port and verify 
that the east amplifier is turned on by the pass-through wavelength.

• If OSC-CSM cards are installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 4-25 for the east OSC-CSM card.

Step 5 Complete Steps 2 through 4 for all band connections configured in pass-through mode in both directions.

Step 6 Test the pass-through channel connections:

• If the pass-through channel connections use an AD-xC-xx.x card, continue with Step 7.

• If pass-through channel connections use a 4MD-xx.x card, continue with Step 11.

Step 7 Tune the tunable laser on a wavelength (1 of 4) belonging to the channel to be tested.

Step 8 Complete the “DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection” task on page 4-31 for the 
first pass-through connection.

Step 9 (Optional.) Complete one of the following:

• If an OSCM card is installed, connect a power meter to LINE TX port on the front-pane and verify 
that the east OPT-BST amplifier is turned on by the pass-through wavelength.

• If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 4-25 for the east OSC-CSM card.

Step 10 If the pass-through connections use a 4-channel multiplexer/demultiplexer (4MD-xx.x), continue with 
Step 11. If not, continue with Step 15.

Step 11 Identify the first channel connection that is configured in pass-through mode using the 4MD-xx.x cards 
in both directions.

Step 12 Tune the tunable laser on the corresponding wavelength.

Step 13 Complete the “DLP-G92 Verify an 4MD-xx.x Pass-Through Connection Power” task on page 4-32.

Purpose This task verifies the pass-through channel connections during an OADM 
node acceptance test. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 14 (Optional.) Perform one of the following:

• If an OSCM card is installed, connect a power meter to LINE TX port on the card front panel and 
verify that the east OPT-BST amplifier is turned on by the pass-through wavelength.

• If an OSC-CSM card is installed, complete the “DLP-G84 Verify the OSC-CSM Incoming Power” 
task on page 4-25 for the east OSC-CSM card.

Step 15 Return to your originating procedure (NTP).

DLP-G90 Verify an AD-xB-xx.x Pass-Through Connection Power

Step 1 Verify the east AD-xB-xx.x band TX power:

a. Display the east AD-xB-xx.x in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX (east-to-west) port related to the wavelength selected on 
the tunable laser to OOS,MT/Locked,maintenance. Click Apply.

d. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 2 Verify the west AD-xB-xx.x card RX and TX power:

a. Display the west AD-xB-xx.x card (corresponding to the east AD-xB-xx.x in Step 1) in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the Power value of the BAND RX (east-to-west) port is higher than the default no-power 
value of –30 dBm.

d. Change the Admin State of the BAND TX (west-to-east) port related to the wavelength selected on 
the tunable laser to OOS,MT/Locked,maintenance. Click Apply.

e. Verify that the BAND TX port Power value is higher than the default no-power value of –30 dBm.

Step 3 Verify the band RX port on the east AD-xB-xx.x card:

a. Display the east AD-xB-xx.x in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Verify that the Power value of the BAND RX (West to East) port is higher than the default no-power 
value of –30 dBm.

Step 4 Return to your originating procedure (NTP).

Purpose This task verifies an AD-xB-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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DLP-G91 Verify an AD-xC-xx.x Pass-Through Connection

Step 1 Verify the east AD-xC-xx.x channel TX power:

a. Display the east AD-xC-xx.x in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be configured.

e. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT/Locked,maintenance. Click Apply.

f. Perform the output power check.

Step 2 Verify the channel power for the corresponding west AD-xC-xx.x card:

a. Display the west AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port related to the wavelength selected on the tunable 
laser to OOS,MT/Locked,maintenance. Click Apply.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

e. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT/Locked,maintenance. Click Apply.

f. If the AD-xC-xx.x is an AD-4C-W card, a VOA (applying to all four channels) is installed along the 
drop path and needs to be configured.

g. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT/Locked,maintenance. Click Apply.

h. Perform the output power check.

Step 3 Verify the band RX port on the east AD-xB-xx.x card:

a. Display the east AD-xB-xx.x in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the BAND RX port reaches the provisioned setpoint (VOA Power 
Ref).

Purpose This task verifies an AD-xC-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 4 Return to your originating procedure (NTP).

DLP-G92 Verify an 4MD-xx.x Pass-Through Connection Power

Step 1 Verify the TX band power on the related east AD-xB-xx.x card: 

a. Display the east AD-xB-xx.x card in card view. 

b. Click the Provisioning > Optical Band > Parameters tabs. 

c. Change the Admin State of the BAND TX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the BAND TX Power value is higher than the default no-power value of –30 dBm.

Step 2 Verify the TX power on the related east 4MD-xx.x (east-to-west) card:

a. Display the east 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. Change the Admin State of the CHAN RX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

Step 3 Verify the west 4MD-xx.x (east-to-west):

a. Display the west 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 4 Verify the west AD-xB-xx.x (west-to-east):

a. Display the west 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the BAND TX Power value is higher than the default no-power value of –30 dBm.

Step 5 Verify the west 4MD-xx.x (west-to-east):

a. Display the west 4MD-xx.x card in card view.

Purpose This task verifies an 4MD-xx.x pass-through connection. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value on the CHAN TX port is higher than the default no-power value of 
–35 dBm.

Step 6 Verify the east 4MD-xx.x (west-to-east):

a. Display the east 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 7 Return to your originating procedure (NTP).

DLP-G93 Verify Add and Drop Connections on OADM Node with OSCM Card

Note In this task, you will verify add and drop connections in the following order: east-to-west add and 
west-to-east drop, Steps 1 through 15; west-to-east add and east-to-west drop, Steps 16 through 17

Step 1 From the Cisco MetroPlanner site configuration file, identify the wavelength (belonging to the 100-GHz 
ITU-T grid) of the channel running on the first add path of the first west AD-xC-xx.x or west 4MD-xx.x 
card on the east-to-west direction.

Step 2 Connect the tunable laser to the corresponding 15xx.x RX port (on the card front panel) of the west 
AD-xC-xx.x or 4MD-xx.x card.

Step 3 Verify the west AD-xC-xx.x or 4MD-xx.x (east-to-west):

a. Display the west AD-xC-xx.x or 4MD-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength chosen on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 4 Complete the “DLP-G79 Verify the OPT-BST Amplifier Laser and Power” task on page 4-22 on the west 
OPT-BST amplifier to verify that the added wavelength turns on the laser.

Purpose This task verifies the add and drop channel connections for an OADM node 
with OSCM cards installed.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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Step 5 If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an 
AD-xC-xx.x card, move to Step 10.

Step 6 Verify the west AD-xB-xx.x:

a. Display the west AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the BAND TX port is higher than the default no-power value of 
–30 dBm.

Step 7 Display the related AD-xB-xx.x card (west-to-east direction) in card view.

Step 8 Change the admin state of the drop BAND TX port related to the wavelength selected on the tunable 
laser to OOS,MT.

Step 9 (Optional.) Connect a power meter to the proper 15xx.x TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value displayed on the Provisioning > Optical Chn > 
Parameters tab for the proper CHAN TX power value +/– 0.5 dB.

Step 10 Verify the west AD-xC-xx.x (west-to-east) card:

a. Display the west AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

a. Display the east AD-xC-xx.x in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be configured.

e. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT/Locked,maintenance. Click Apply.

f. Perform the output power check.

Step 11 (Optional.) Connect a power meter to the proper 15xx.xx TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value on the Provisioning > Optical Chn > Parameters tab for 
the proper CHAN TX power value +/– 0.5 dB.

Step 12 Repeat Steps 6 through 11 for all add paths of any west AD-xC-xx.x or 4MD-xx.x cards along the 
east-to-west direction.

Step 13 Remove the loopback on the west OPT-BST amplifier and create a loopback on the east OPT-BST 
amplifier. 

Step 14 If an OPT-PRE amplifier is installed on the east side, remove the 10-dB bulk attenuator inserted on the 
COM RX port.

Note An SDCC Termination Failure alarm might appear during to the OSC signal loopback.
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If the OSC link does not turn up, perform the following steps:

a. Display the OPT-BST card in card view.

b. Click the Provisioning > Optical Line > Optics Thresholds tabs.

c. Set the Power Low value of Port 6 to –40 dBm.

d. If the OSC link does not appear, disconnect the OSCM card from the OPT-BST amplifier.

e. Create a loopback by attaching a patch cord to the OSC TX and OSC RX ports on the front panel of 
the OSCM card using a 10-dB bulk attenuator.

f. If the OSC link turns up, replace the OPT-BST amplifier card.

g. If the OSC link does not turn up, replace the OSCM card.

Step 15 Check the site configuration file from Cisco MetroPlanner and identify the wavelength (belonging to the 
100 Ghz ITU-T grid) of the channel running on the first add path of the first AD-xC-xx.x-E or 
4MD-xx.x-E card on the west-to-east direction.

Step 16 Connect the tunable laser to the correspondent 15xx.x RX port (on the card front panel) of the east 
AD-xC-xx.x-E or east 4MD-xx.x-E card.

Step 17 Repeat Steps 3 through 16, applying the steps to the west-to-east direction.

Step 18 Restore the default admin state (IS,AINS/Unlocked,automaticInService) on all the ports previously set 
to OOS,MT/Locked,maintenance.

Step 19 Launch ANS to recover the correct Node Configuration.

Step 20 Return to your originating procedure (NTP).

DLP-G94 Verify Add and Drop Connections on OADM Node with OSC-CSM Card

Note In this task, you will verify add and drop connections in the following order: east-to-west and 
west-to-east drop: Steps 1 through 15; west-to-east add and east-to-west drop: Steps 16 through 17

Step 1 From the Cisco MetroPlanner site configuration file, identify the wavelength (belonging to the 100-GHz 
ITU-T grid) of the channel running on the first add path of the first west AD-xC-xx.x or west 4MD-xx.x 
card on the east-to-west direction.

Step 2 Connect the tunable laser to the corresponding 15xx.x RX port (on the card front panel) of the west 
AD-xC-xx.x or 4MD-xx.x card.

Step 3 Verify the west AD-xC-xx.x or 4MD-xx.x (east-to-west):

a. Display the west AD-xC-xx.x or 4MD-xx.x card in card view.

Purpose This task verifies the add and drop channel connections for an OADM node 
with OSC-CSM cards installed.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser only
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b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Change the Admin State of the CHAN RX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the CHAN RX port reaches the provisioned setpoint (VOA Power 
Ref).

Step 4 Complete the “DLP-G80 Verify the OPT-PRE Amplifier Laser and Power” task on page 4-23 on the west 
OPT-PRE amplifier to verify that the added wavelength turns on the laser.

Step 5 If the add connection uses a 4MD-xx.x card, continue with Step 6. If the add connection uses an 
AD-xC-xx.x card, move to Step 10.

Step 6 Verify the west AD-xB-xx.x:

a. Display the west AD-xB-xx.x card in card view.

b. Click the Provisioning > Optical Band > Parameters tabs.

c. Change the Admin State of the BAND TX port to OOS,MT/Locked,maintenance for the channel 
related to the wavelength selected on the tunable laser.

d. Verify that the Power value of the BAND TX port is higher than the default no-power value of 
–30 dBm.

Step 7 Display the related AD-xB-xx.x card (west-to-east direction) in card view.

Step 8 Change the admin state of the drop BAND TX port related to the wavelength selected on the tunable 
laser to OOS,MT.

Step 9 (Optional.) Connect a power meter to the proper 15xx.xs TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value displayed on the Provisioning > Optical Chn > 
Parameters tab for the proper CHAN TX power value +/– 0.5 dB.

Step 10 Verify the west AD-xC-xx.x (west-to-east) card:

a. Display the west AD-xC-xx.x card in card view.

b. Click the Provisioning > Optical Chn > Parameters tabs.

c. Verify that the Power value of the CHAN TX port is higher than the default no-power value of 
–35 dBm.

d. Display the east AD-xC-xx.x in card view.

e. Click the Provisioning > Optical Chn > Parameters tabs.

f. Verify that the power value for the CHAN TX port is higher than the default no-power value of 
–35 dBm.

g. If the AD-xC-xx.x card is an AD-4C-xx.x card, a VOA (applied to all four channels) is installed 
along the drop path and needs to be configured.

h. Change the Admin State of the CHAN TX port related to the wavelength selected on the tunable 
laser to OOS,MT/Locked,maintenance. Click Apply.

i. Perform the output power check.

Step 11 (Optional.) Connect a power meter to the proper 15xx.xx TX port on the front panel (the dual port 
compared with the port where the tunable laser is connected). Verify that the physical optical power 
value from that port is consistent with the value on Provisioning > Optical Chn > Parameters tab for the 
proper CHAN TX power value +/– 0.5 dB.

Step 12 Repeat Steps 6 through 11 for all add paths of any west AD-xC-xx.x or 4MD-xx.x cards along the 
east-to-west direction.
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Step 13 Remove the loopback on the west OSC-CSM. 

Step 14 In node view, click the Provisioning > WDM-ANS > Port Status tabs.

Step 15 Click Launch ANS.

Step 16 Create a loopback on the east OSC-CSM card by connecting the OSC-CSM LINE RX and LINE TX 
ports using a patch cord and 10-dB bulk attenuator.

Step 17 Verify that the OSC link becomes active on the west OSC-CSM card. (The OSC termination must be 
already provisioned. If not, complete the “DLP-G75 Create OSC Terminations” task on page 3-61.)

Note Due to the OSC signal loopback, a SDCC Termination Failure alarm might be raised.

Step 18 If the OSC link becomes active, continue with Step 19. If the OSC link does not turn up, perform the 
following troubleshooting steps:

a. Remove the 10-dB bulk attenuator between the LINE TX and LINE RX connection. If the OSC link 
becomes active, continue with Step 19. If not, continue with Step b.

b. Modify the OSC Fail Low thresholds. Click the Provisioning > Optical Line > Optics Thresholds 
tabs and change the Port 6 opwrMin (minimum power) to –40 dBm.

c. Modify the COM TX Fail Low Threshold. Change the Port 3 opwrMin (minimum power) to 
–30 dBm.

d. If the OSC link turns up, continue with Step 19. If it does not turn up, replace the OSC-CSM card. 

Step 19 Check the site configuration file from Cisco MetroPlanner and identify the wavelength (belonging to the 
100 Ghz ITU-T grid) of the channel running on the first add path of the first AD-xC-xx.x-E or 
4MD-xx.x-E card on the west-to-east direction.

Step 20 Connect the tunable laser to the correspondent 15xx.x RX port (on the card front panel) of the east 
AD-xC-xx.x-E or east 4MD-xx.x-E card.

Step 21 Repeat Steps 3 through 20, applying the steps to the west-to-east direction.

Step 22 Restore the default admin state (IS,AINS/Unlocked,automaticInService) on all the ports previously set 
to OOS,MT/Locked,maintenance.

Step 23 Launch ANS to recover the correct node configuration.

Step 24 Return to your originating procedure (NTP).
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Cisco ONS 15454 DWDM
November 2004
C H A P T E R 5

Turn Up Network

This chapter explains how to turn up and test a Cisco ONS 15454 dense wavelength division 
multiplexing (DWDM) network. For DWDM topology reference information and span loss tables, refer 
to Chapter 16, “DWDM Network Reference.”

There are two main DWDM network types, metro core, where the channel power is equalized and 
dispersion compensation is applied, and metro access, where the channels are not equalized and 
dispersion compensation is not applied. Metro core networks often include multiple spans and 
amplifiers, thus making optical signal-to-noise ratio (OSNR) the limiting factor for channel 
performance. Metro access networks often include a few spans with very low span loss; therefore, the 
signal link budget is the limiting factor for performance. The DWDM network topologies supported are 
hubbed rings, multihubbed rings, meshed rings, linear configurations, and single-span links.

The DWDM node types supported are hub, terminal, optical add/drop multiplexing (OADM), 
reconfigurable optical add/drop multiplexing (ROADM) anti-amplified spontaneous emissions (ASE), 
and line amplifier. For DWDM and hybrid node turn up procedures, see Chapter 3, “Turn Up a Node.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G51 Verify DWDM Node Turn Up, page 5-2—Complete this procedure before beginning 
network turn up.

2. NTP-G52 Verify Node-to-Node Connections, page 5-3—Complete this procedure next.

3. NTP-G53 Set Up Timing, page 5-4—Complete this procedure next.

4. NTP-G54 Provision and Verify a DWDM Network, page 5-7—Complete this procedure next.

5. NTP-G55 Verify the Optical Receive Power, page 5-13—Complete this procedure next.

6. NTP-G56 Verify the OSNR, page 5-14—Complete as needed.

7. NTP-G57 Create a Logical Network Map, page 5-15—Complete as needed.
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NTP-G51 Verify DWDM Node Turn Up

Step 1 Log into an ONS 15454 on the network that you will test. See the “DLP-G46 Log into CTC” task on 
page 2-25. If you are already logged in, proceed to Step 2.

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 7-32 as necessary.

b. Verify that no unexplained alarms appear. If alarms appear, investigate and resolve them before 
continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for 
procedures.

Step 3 Verify that the software version and defaults shown in the node view status area match the software 
version and NE defaults shown in your site plan. If either is not correct, complete the following 
procedures as needed:

• If the software is not the correct version, install the correct version from the ONS 15454 software 
CD. Upgrade procedures are located in the release-specific software upgrade document. Follow the 
upgrade procedures appropriate to the software currently installed on the node. TCC2 cards can also 
be ordered with the latest software release.

• If the node defaults are not correct, import the network element defaults. Refer to the 
Cisco ONS 15454 Network Element Defaults publication for Software R4.7.

Step 4 Click the Provisioning > General tabs. Verify that all general node information settings match the 
settings of your site plan. If not, see the “NTP-G80 Change Node Management Information” procedure 
on page 9-8.

Step 5 Click the Provisioning > Network tabs. Ensure that the IP settings and other Cisco Transport Controller 
(CTC) network access information is correct. If not, see the “NTP-G81 Change CTC Network Access” 
procedure on page 9-10.

Step 6 Click the Provisioning > Protection tabs. Verify that all protection groups have been created according 
to your site plan. If not, see the “NTP-G83 Modify or Delete Card Protection Settings” procedure on 
page 9-20.

Step 7 Click the Provisioning > Security tabs. Verify that all users have been created and that their security 
levels match the settings indicated by your site plan. If not, see the “NTP-G88 Modify Users and Change 
Security” procedure on page 9-34.

Step 8 If Simple Network Management Protocol (SNMP) is provisioned on the node, click the Provisioning > 
SNMP tabs. Verify that all SNMP settings match the settings of your site plan. If not, see the “NTP-G89 
Change SNMP Settings” procedure on page 9-42.

Step 9 Provision the network connections using the “NTP-G52 Verify Node-to-Node Connections” procedure 
on page 5-3.

Purpose This procedure verifies that each ONS 15454 is ready for DWDM network 
turn up before adding nodes to a network.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed Required

Onsite/Remote Onsite 

Security Level Provisioning or higher
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Stop. You have completed this procedure.

NTP-G52 Verify Node-to-Node Connections

Step 1 Verify the network fiber connections. The east ports (LINE TX and LINE RX) of one node must connect 
to the west ports (LINE RX and LINE TX respectively) of the adjacent node. If fibers are missing or 
incorrectly connected, make the correct connections. See the “NTP-G34 Install Fiber-Optic Cables on 
DWDM Cards” procedure on page 3-35 for instructions.

Step 2 Complete the “DLP-G46 Log into CTC” task on page 2-25 at a network node.

Step 3 Click the Provisioning > Comm Channels > OSC tab. Verify that OSC terminations were created for 
the east and west OSC-CSM or OSCM cards and the port state is In-Service and Normal (IS-NR 
[ANSI])/Unlocked-enabled (ETSI). If so, continue with Step 5. If OSC terminations are not created, 
complete the “DLP-G75 Create OSC Terminations” task on page 3-61.

Step 4 Repeat Step 3 at each network node.

Step 5 Complete the “DLP-G155 Verify Optical Span Loss Using CTC” task on page 9-3. 

Step 6 If the measured span loss is within the minimum and maximum expected span loss values, continue with 
the next step. If the measured span loss values are not within the minimum and maximum range, 
complete the “NTP-G115 Clean Fiber Connectors” procedure on page 11-32, then repeat Step 5. If 
necessary, complete the “DLP-G156 Measure Span Insertion Loss Using an OTDR” task on page 9-4 to 
provide a more accurate measurement.

Step 7 Repeat Step 5 at each network node.

Stop. You have completed this procedure.

Purpose This procedure verifies OSC terminations between nodes and checks span 
attenuation.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 5-2

Required/As Needed Required

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-G53 Set Up Timing

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you will set up timing. If 
you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G95 Set Up External or Line Timing” task on page 5-4 if an external building 
integrated timing supply (BITS) source is available. This is the common ONS 15454 timing setup 
procedure. 

Step 3 If you cannot complete Step 2 (an external BITS source is not available), complete the “DLP-G96 Set 
Up Internal Timing” task on page 5-6. This task can only provide Stratum 3 timing. 

Stop. You have completed this procedure.

DLP-G95 Set Up External or Line Timing

Step 1 In node view, click the Provisioning > Timing tabs.

Step 2 In the General Timing area, complete the following information:

• Timing Mode—Choose External if the ONS 15454 derives its timing from a BITS source wired to 
the backplane pins (ANSI) or a MIC-C/T/P FMEC (ETSI); choose Line if timing is derived from an 
OSC-CSM or OSCM card that is optically connected to the timing node. A third option, Mixed, 
allows you to set external and line timing references.

Note Because Mixed timing might cause timing loops, Cisco does not recommend its use. Use this 
mode with care.

• SSM Message Set—For DWDM nodes, choose the Generation 2 synchronization status messaging 
(SSM) option. Generation 1 is used only by SONET or SDH ONS 15454s that are connected to 
equipment that does not support Generation 2. 

Purpose This procedure provisions the ONS 15454 timing.

Tools/Equipment None

Prerequisite Procedures NTP-G51 Verify DWDM Node Turn Up, page 5-2

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task defines the ONS 15454 timing source (external or line).

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Quality of RES—If your timing source supports the reserved S1 byte, set the timing quality here. 
(Most timing sources do not use RES.) Qualities are displayed in descending quality order as ranges. 
For example, ST3<RES<ST2 means the timing reference is higher than a Stratum 3 and lower than 
a Stratum 2. Refer to Chapter 18, “Security and Timing” for more information about SSM, including 
definitions of the SONET timing levels.

• Revertive—Select this check box if you want the ONS 15454 to revert to a primary reference source 
after the conditions that caused it to switch to a secondary timing reference are corrected. 

• Revertive Time—If Revertive is checked, choose the amount of time the ONS 15454 will wait before 
reverting to its primary timing source. Five minutes is the default.

Step 3 In the BITS Facilities area, complete the following information:

Note The BITS Facilities section sets the parameters for your BITS-1 and BITS-2 timing references. 
Many of these settings are determined by the timing source manufacturer. If equipment is timed 
through BITS Out, you can set timing parameters to meet the requirements of the equipment.

• BITS In State—If Timing Mode is set to External or Mixed, set the BITS In State for BITS-1 and/or 
BITS-2 to IS (in service) depending whether one or both BITS input pin pairs on the backplane 
(ANSI) or FMEC (ETSI) are connected to the external timing source. If Timing Mode is set to Line, 
set the BITS In State to OOS (out of service). 

• BITS Out State—If equipment is connected to the node’s BITS output pins on the backplane (ANSI) 
or FMEC (ETSI) and you want to time the equipment from a node reference, set the BITS Out State 
for BITS-1 and/or BITS-2 to IS, depending on which BITS Out pins are used for the external 
equipment. If equipment is not attached to the BITS output pins, set the BITS Out State to OOS. 

Step 4 If the BITS In State for BITS-1 and BITS-2 is set to OOS, continue with Step 5. If the BITS In State is 
set to IS for either BITS-1 or BITS-2, complete the following information:

• Coding—Set to the coding used by your BITS reference, either B8ZS (binary 8-zero substitution) 
or AMI (alternate mark inversion).

• Framing—Set to the framing used by your BITS reference, either ESF (Extended Super Frame) or 
SF (D4) (Super Frame). 

• Sync Messaging—Check to enable SSM. SSM is not available if Framing is set to SF (D4).

• AIS Threshold—If SSM is disabled or SF (D4) is used, set the quality level where a node sends an 
alarm indication signal (AIS) from the BITS-1 Out and BITS-2 Out backplane (ANSI) or FMEC 
(ETSI) pins. An AIS is raised when the optical source for the BITS reference falls to or below the 
SSM quality level defined in this field.

• LBO—If you are timing an external device connected to the BITS Out pins, set the distance between 
the device and the ONS 15454. Options are: 0-133 ft. (default), 124-266 ft., 267-399 ft., 400-533 ft., 
and 534-655 ft. Line build out (LBO) relates to the BITS cable length.

Step 5 In the Reference Lists area, complete the following information:

Note Reference Lists defines up to three timing references for the node and up to six BITS Out 
references. BITS Out references define the timing references used by equipment that can be 
attached to the node’s BITS Out pins on the backplane (ANSI) or FMEC (ETSI). If you attach 
equipment to BITS Out pins, you normally attach it to a node with Line mode because equipment 
near the external timing reference can be directly wired to the reference. 
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• NE Reference—Allows you to define three timing references (Ref 1, Ref 2, Ref 3). The node uses 
Reference 1 unless a failure occurs to that reference, in which case the node uses Reference 2. If 
Reference 2 fails, the node uses Reference 3, which is typically set to Internal Clock. Reference 3 
is the Stratum 3 clock provided on the TCC2 card. The options displayed depend on the Timing 
Mode setting. 

– If the Timing Mode is set to External, your options are BITS-1, BITS-2, and Internal Clock.

– If the Timing Mode is set to Line, your options are the node’s working OSCM, OSC-CSM, or 
MXP cards and Internal Clock. Choose the cards/ports that are directly or indirectly connected 
to the node wired to the BITS source. Set Reference 1 to the card that is closest to the BITS 
source. For example, if Slot 5 is connected to the node wired to the BITS source, choose Slot 5 
as Reference 1.

– If the Timing Mode is set to Mixed, both BITS and OSC or MXP cards are available, allowing 
you to set a mixture of external BITS and OSC or MXP cards as timing references.

• BITS-1 Out/BITS-2 Out—Sets the timing references for equipment wired to the BITS Out 
backplane (ANSI) or FMEC (ETSI) pins. BITS-1 Out and BITS-2 Out are enabled when BITS-1 and 
BITS-2 facilities are put in service. If Timing Mode is set to external, choose the OSC or MXP card 
used to set the timing. If Timing Mode is set to Line, you can choose an OSC or MXP card or choose 
NE Reference to have the BITS-1 Out and/or BITS-2 Out follow the same timing references as the 
NE.

Note All MXP card client ports are available for timing regardless of the card’s termination mode. 
MXP trunk ports can be a timing reference when G.709 is set to OFF and the Termination 
Mode is set to LINE.

Step 6 Click Apply.

Note Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for timing-related 
alarms. 

Step 7 Return to your originating procedure (NTP).

DLP-G96 Set Up Internal Timing

Caution Internal timing is Stratum 3 and not intended for permanent use. All ONS 15454s should be timed to a 
Stratum 2 or better primary reference source. 

Purpose This task sets up internal timing (Stratum 3) for an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed (use only if a BITS source is not available) 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, click the Provisioning > Timing tabs.

Step 2 In the General Timing area, enter the following:

• Timing Mode—Set to External.

• SSM Message Set—Set to Generation 1.

• Quality of RES—Does not apply to internal timing.

• Revertive—Does not apply to internal timing.

• Revertive Time—Does not apply to internal timing.

Step 3 In the BITS Facilities area, change the BITS In State and BITS Out State to OOS. Disregard the other 
BITS Facilities settings; they are not relevant to internal timing.

Step 4 In the Reference Lists area, enter the following information:

• NE Reference 

– Ref 1—Set to Internal Clock.

– Ref 2—Set to Internal Clock.

– Ref 3—Set to Internal Clock.

• BITS-1 Out/BITS-2 Out—Set to None.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

NTP-G54 Provision and Verify a DWDM Network

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 to log into an ONS 15454 on the network.

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 7-32 as necessary.

b. Verify that no unexplained conditions appear on the network. If unexplained conditions appear, 
resolve them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting 
Guide.

c. Complete the “DLP-G114 Export CTC Data” task on page 7-4 to export alarm and condition 
information.

Purpose This procedure verifies the performance of all cable connections and cards 
in a network topology. You can also use this procedure to troubleshoot any 
problems with DWDM network setup. 

Tools/Equipment Test set or protocol analyzer

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Review the MetroPlanner file and determine the first channel (ITU wavelength) to be provisioned. Use 
the transponder, muxponder, or line card that corresponds to the selected wavelength. 

Note Provision and measure only one channel. 

Step 4 As needed, complete the “DLP-G97 Provision a Proxy Tunnel” task on page 5-10.

Step 5 As needed, complete the “DLP-G98 Provision a Firewall Tunnel” task on page 5-11.

Step 6 As needed, complete the “DLP-G99 Create a Provisionable Patchcord” task on page 5-12.

Step 7 If TXP and MXP cards are installed, provision them according to the MetroPlanner file or according to 
your site plan. For cards with tunable optical wavelengths, choose the ITU wavelength according to your 
site plan. For provisioning information, see the following:

• NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and 
TXP_MR_10E Cards, page 10-32

• NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and 
MXP_2.5G_10E Cards, page 10-43

• NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and 
TXPP_MR_2.5G Cards, page 10-55

• NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards, page 10-65

Step 8 Create the optical channels according to your site plan. Complete the “DLP-G105 Provision DWDM 
Optical Channel Network Connections” task on page 6-9.

Note The amplifiers automatically calculate the optical output power to maintain a constant power 
level on each channel every time a channel is created on the DWDM network. Automatic power 
control (APC) also starts every 60 minutes. If the span length changes, APC modifies amplifier 
gains and express variable optical attenuation (VOA). For more information about APC, see the 
“15.2 Automatic Power Control” section on page 15-14.

Step 9 If OPT-PRE amplifiers are being turned up for the first time:

a. In node view, double-click the OPT-PRE card to open card view.

b. Click the Provisioning > Opt. Ampli. Line > Parameters tabs. 

c. Verify that the Signal Output Power value for Port 2 is equal to or higher than provisioned set point 
shown in the Channel Power Ref field. The Total Output Power field includes the ASE noise 
component.

d. Click the Maintenance > ALS tabs and verify that the ALS Mode column displays Auto Restart. 
Auto Restart is the default Automatic Laser Shutdown (ALS) mode.

e. For each OPT-PRE amplifier that is turned up for the first time on your network, repeat Steps a 
through d.

Step 10 If OPT-BST amplifiers are being turned up for the first time:

a. In node view, double-click the OPT-BST card to open card view.

b. Click the Provisioning > Opt. Ampli. Line > Parameters tabs. 

c. Verify that the Signal Output Power field for Port 6 is equal to or higher than the provisioned set 
point shown in the Channel Power Ref field. The Total Output Power field includes the ASE noise 
component.
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d. Verify that the Working Mode field is the one specified by Cisco MetroPlanner, either control power 
or control gain. The MetroPlanner parameter is dwdm.rx/tx.amp.WkgModeW/E (rx for OPT-PRE 
cards; tx for OPT-BST cards). You can view the parameter on the node view Provisioning > 
WDM-ANS tab.

e. Click the Maintenance > ALS tabs and verify that the ALS Mode column displays Auto Restart. 
Auto Restart is the default ALS mode.

f. For each OPT-BST amplifier that is turned up for the first time on your network, repeat Steps a 
through e.

Step 11 If OADM nodes have a new circuit running traffic for the first time, check the power values:

Note This step checks the Pin AD Stage (dwdm.[rx/tx].amp.WkgModeW/E) value and the Pout AD 
Stage (dwdm.rx.power.InAdE/W) value that characterize every OADM node. The ANS function 
uses these values to make the VOA adjustments.

• If the circuit is terminated inside the node, go to node view and click the Provisioning > 
WDM-ANS > Provisioning tabs. In the Selector area, click West Pin field and then Pin AD Stage. 
Verify that the value matches the value for the first OADM card in your circuit heading west to east 
shown in the COM RX port, ±2 dB. If the values are outside of the error margins, contact Cisco 
qualified personnel to create another MetroPlanner file or refer to the next level of support.

• If the circuit passes through the node, go to node view and click the Provisioning > WDM-ANS > 
Provisioning tabs. Click West Pin field and then Pin AD Stage. Verify that the value matches the 
value for the first OADM card in your circuit heading west to east shown in the COM RX port, ±2 
dB. Click East Pin and Pout AD Stage. Verify the value matches the value for the first OADM card 
in your circuit heading west to east shown in the COM TX port, ±1 dB. If the values are outside of 
the error margins, contact Cisco qualified personnel to create another MetroPlanner file or refer to 
the next level of support.

• If the circuit starts from the node, go to node view and click the Provisioning > WDM-ANS > 
Provisioning tabs. Click East Pin field and then Pin AD Stage. Verify the value matches the value 
for the first OADM card in your circuit heading west to east shown in the COM TX port, ±1 dB. If 
the values are outside of the error margins, contact Cisco qualified personnel to create another 
MetroPlanner file or refer to the next level of support.

Step 12 Check the received power range:

a. Display the first TXP, MXP, or line card in card view. Complete the “DLP-G136 Clear Selected PM 
Counts” task on page 8-6.

b. Click the Performance > Optics PM tab. 

c. Record the values shown in the RX Optical Pwr field. 

d. Click the Provisioning > Optics Thresholds tabs. 

e. Compare the value recorded in Step c with the values listed in the RX Power High and RX Power 
Low columns. Verify that the received power on the transponder, muxponder, or line card is within 
the allowed receiving range according to optical card sensitivity specifications. See the Chapter 14, 
“Card Reference,” for information about card specifications.

Step 13 Perform a short-term bit error rate (BER) test:

a. Complete the “DLP-G136 Clear Selected PM Counts” task on page 8-6 for the transponder, 
muxponder, or line card.

b. Click the Payload PM tab, or, if OTN is provisioned, click the OTN PM tab. 

c. Perform a short-term BER test using a test set or protocol analyzer.
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Note To see an accurate performance monitoring count, the BER test results must be consistent with 
the transmitted bit rate for at least 10 minutes.

Note For information about using a test set or protocol analyzer, refer to the test set or protocol 
analyzer user guide.

Step 14 Repeat Steps 3 through 13 for each channel in your site plan.

Step 15 If a node fails any test, repeat the test after verifying correct setup and configuration. If the test fails 
again, refer to the next level of support.

After all tests are successfully completed and no alarms exist in the network, the network is ready for 
service.

Stop. You have completed this procedure.

DLP-G97 Provision a Proxy Tunnel

Note If the proxy server is disabled, you cannot set up a proxy tunnel. 

Step 1 Click the Provisioning > Network > Proxy subtabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following:

• Source Address—Type the IP address of the source node (32 bit length) or source subnet (any other 
length).

• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32 bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Purpose This task sets up a proxy tunnel to communicate with a non-ONS far-end 
node. Proxy tunnels are only necessary when the proxy server is enabled 
and a foreign GCC termination exists, or if static routes exist so that the 
GCC network is used to access remote networks or devices. You can 
provision a maximum of 12 proxy server tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G76 Provision GCC Terminations, page 3-62 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 5 Continue with your originating procedure (NTP).

DLP-G98 Provision a Firewall Tunnel

Note If the proxy server is configured as proxy-only or is disabled, you cannot set up a firewall tunnel. 

Step 1 Click the Provisioning > Network > Firewall subtabs.

Step 2 Click Create.

Step 3 In the Create Tunnel dialog box, complete the following:

• Source Address—Type the IP address of the source node (32 bit length) or source subnet (any other 
length).

• Length—Choose the length of the source subnet mask.

• Destination Address—Type the IP address of the destination node (32 bit length) or destination 
subnet (any other length).

• Length—Choose the length of the destination subnet mask.

Step 4 Click OK.

Step 5 Continue with your originating procedure (NTP).

Purpose This task provisions destinations that will not be blocked by the firewall. 
Firewall tunnels are only necessary when the proxy server is enabled and a 
foreign GCC termination exists, or if static routes exist so that the GCC 
network is used to access remote networks or devices. You can provision a 
maximum of 12 firewall tunnels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G76 Provision GCC Terminations, page 3-62 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G99 Create a Provisionable Patchcord

Note An optical port requires two patchcords when the remote end is Y-cable protected or is an add/drop 
multiplexer or multiplexer/demultiplexer port.

Step 1 In node view, click the Provisioning > Comm Channels > Provisionable Patchcords tabs. If you are 
in network view, click the Provisioning > Provisionable Patchcords tabs.

Step 2 Click Create. The Provisionable Patchcord dialog box appears.

Step 3 In the Origination Node area, complete the following:

a. If you are in node view, the Origination Node defaults to the current node. If you are in network 
view, click the desired origination node from the drop-down list. 

b. Type a patchcord identifier (0 through 32767) in the TX/RX ID field.

c. Click the desired origination slot/port from the list of available slots/ports. 

Step 4 In the Termination Node area, complete the following:

a. Click the desired termination node from the drop-down list. If the remote node has not previously 
been discovered by CTC but is accessible by CTC, type the name of the remote node.

b. Type a patchcord identifier (0 through 32767) in the TX/RX ID field. The origination and 
termination IDs must be different if the patchcord is set up between two cards on the same node. 

c. Click the desired termination slot/port from the list of available slots/ports. The origination port and 
the termination port must be different.

Step 5 If you need to provision transmit and receive separately for multiplexer/demultiplexer cards, check the 
Separate Tx/Rx check box. If not, continue with Step 6. The origination and termination TX ports are 
already provisioned. Complete the following to provision the RX ports:

a. In the Origination Node area, type a patchcord identifier (0 through 32767) in the RX ID field. The 
origination Tx and Rx and termination Tx and Rx IDs must be different.

b. Click the desired origination slot/port from the list of available slots/ports. 

c. In the Termination Node area, type a patchcord identifier (0 through 32767) in the RX ID field. The 
origination Tx and Rx and termination Tx and Rx IDs must be different.

d. Click the desired termination slot/port from the list of available slots/ports. 

Purpose This task creates a provisionable patchcord, also called a virtual link. They 
appear as dashed lines in CTC network view. 

For the specific situations in which a patchcord is necessary, see the 
“19.3 Provisionable Patchcords” section on page 19-19.

Tools/Equipment OC-N, transponder/muxponder, optical add/drop multiplexer, and 
multiplexer/demultiplexer cards

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

NTP-G94 Provision Pluggable Port Modules, page 10-29 for transponder 
and muxponder cards

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning and higher
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Step 6 Click OK. 

Step 7 If you provisioned a patchcord on a port in a 1+1 protection group, a dialog box appears to ask if you 
would like to provision the peer patchcord. Click Yes. Repeat Steps 3 through 6. 

Step 8 Return to your originating procedure (NTP).

NTP-G55 Verify the Optical Receive Power

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at an ONS 15454 on the network. 

Step 2 Using an optical power meter, check the receive optical power on both ends of the span: 

a. Identify a transmit port on an AD-xC-xx.x, 32DMX-O, 32DMX, or 4MD card in the node that you 
want to test and connect it to the optical power meter.

b. Read the values displayed on the optical power meter. These values must be consistent with the data 
provided by the MetroPlanner installation file, +/– 1 dB. To view MetroPlanner values, click the 
Provisioning > WDM-ANS > Provisioning tabs. For 32DMX-O and 32DMX cards, the values are 
listed in the Channel x Drop Power field (dwdm.rx.power.DropChxW/E) where x = 1 to 32. For 
OADM cards, the fields are listed in the Band [x] Drop (dwdm.rx.power.DropBxW/E) field where 
x = 1 to 8.

Note For information about using an optical power meter, refer to the optical power meter user 
guide.

Step 3 If the optical power is too low (indicated by an alarm or APC out of range or skipped condition), check 
the fiber connections as appropriate to your node configuration:

• Check the fiber connections between the OPT-BST amplifier or the OSC-CSM card and the 
OPT-PRE amplifier or the next OADM card.

• Check the fiber connections between the OADM cards and if needed clean the connectors. See the 
“NTP-G115 Clean Fiber Connectors” procedure on page 11-32.

Step 4 If the power coming from the AD-xC-xx.x card is higher than required, put an external optical attenuator 
before the client interface input in order to meet the power requirement. 

Step 5 If the power coming from the 32DMX-O card is higher or lower than required, you can regulate the VOA 
in CTC.

• From the 32DMX-O or 32DMX card view, choose the Provisioning > Optical Chn > Parameters 
tabs. The VOA columns including the VOA power and attenuation reference points can be manually 
set according to your site plan.

Purpose This procedure verifies the optical receive power.

Tools/Equipment Optical power meter

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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• Changing the VOA power and attenuation calibration values adjusts the power and attenuation 
reference settings.

Stop. You have completed this procedure.

NTP-G56 Verify the OSNR

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at an ONS 15454 on the network.

Step 2 Using an optical spectrum analyzer, check the received OSNR for each transmitted channel on both ends 
of the span: 

a. Identify the last OSC-CSM, OPT-PRE, or OPT-BST MON port before the channel is dropped. If 
OPT-PRE cards are installed with an OPT-BST or OSC-CSM card, use the OPT-PRE MON port.

b. Determine the OSNR values based on the optical spectrum retrieved. These values must be 
consistent with the OSNR values provided by the MetroPlanner installation file, +/– 1 dB. The 
MetroPlanner OSNR values are only valid for the receive locations of a dropped channel. Therefore, 
OSNR values of an OADM express channel cannot be compared to the MetroPlanner values. 

Note For OSNR values for each card class, refer to Chapter 14, “Card Reference.”

Step 3 If the OSNR is too low, check the following, depending on your node configuration:

Note The purpose of this step is not to improve the signal-to-noise ratio (SNR), but to match the 
per-channel power level within the receive (RX) port power range.

• Check the fiber connections between the OPT-BST amplifier or the OSC-CSM and the OPT-PRE 
amplifier and if needed, clean the connectors. See the “NTP-G115 Clean Fiber Connectors” 
procedure on page 11-32.

• On the near-end OPT-BST amplifier, check the equalization of the added channels at the monitor 
output.

• On the OPT-PRE amplifier, check the output power on both COM TX and DC TX ports.

• On the far-end OPT-PRE amplifier, check the amplifier gain tilt at the monitor output.

Stop. You have completed this procedure.

Purpose This procedure verifies the OSNR. The OSNR is the ratio between the signal 
power level and the noise power level.

Tools/Equipment Optical spectrum analyzer

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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NTP-G57 Create a Logical Network Map

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you want to 
create the network map. If you are already logged in, continue with Step 2.

Step 2 From the View menu, choose Go to Network View. 

Step 3 Change the position of the nodes in the network view according to your site plan.

a. Click a node to select it, then press the Ctrl key while you drag and drop a node icon to a new 
location. 

b. Repeat Step a for each node you need to position.

Step 4 On the network view map, right-click and choose Save Node Position.

Step 5 Click Yes in the Save Node Position dialog box.

CTC opens a progress bar and saves the new node positions.

Note Retrieve, Provisioning, and Maintenance users can move nodes on the network map, but only 
Superusers can save new network map configurations. To restore the view to a previously saved 
version of the network map, right-click on the network view map and choose Reset Node 
Position.

Stop. You have completed this procedure.

Purpose This procedure allows a superuser to create a consistent network view for 
all nodes on the network.

Tools None

Prerequisite Procedures This procedure assumes that network turn up is complete.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Cisco ONS 15454 DWDM
September 2004
C H A P T E R 6

Create Channels and Circuits

This chapter explains how to create Cisco ONS 15454 dense wavelength division multiplexing (DWDM) 
optical channel network connections (OCHNCs) and overhead circuits. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G58 Locate and View Optical Channel Network Connections, page 6-2—Complete as needed 
to find, view, and filter OCHNCs.

2. NTP-G59 Create and Delete Optical Channel Network Connections, page 6-8—Complete as 
needed.

3. NTP-G60 Create Overhead Circuits, page 6-12—Complete as needed to create IP-encapsulated 
tunnels, provision orderwire, or user data channel (UDC) circuits.

4. NTP-G61 Modify and Delete Overhead Circuits, page 6-17—Complete as needed to repair IP 
circuits and delete overhead circuits.

5. NTP-G62 Create a J0 Section Trace, page 6-18—Complete as needed to monitor interruptions or 
changes to traffic between two nodes.
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NTP-G58 Locate and View Optical Channel Network 
Connections

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you want to 
view the circuits. If you are already logged in, continue with Step 2.

Note Do not check Disable Circuit Management in the Login dialog box. No circuits appear if this 
option is checked.

Step 2 As needed, complete the “DLP-G100 Search for Optical Channel Network Connections” task on 
page 6-2.

Step 3 As needed, complete the “DLP-G101 View Optical Channel Network Connection Information” task on 
page 6-3.

Step 4 As needed, complete the “DLP-G102 Filter the Display of Optical Channel Network Connections” task 
on page 6-6.

Step 5 As needed, complete the “DLP-G103 View Optical Channel Network Connections on a Span” task on 
page 6-7.

Stop. You have completed this procedure.

DLP-G100 Search for Optical Channel Network Connections

Step 1 Navigate to the appropriate Cisco Transport Controller (CTC) view:

• To search the entire network, choose View > Go to Network View.

Purpose This procedure allows you to locate and view DWDM OCHNCs. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision DWDM Optical Channel Network Connections, page 
6-9

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task searches for DWDM OCHNCs and ONS 15454 circuits at the 
network, node, or card level. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• To search for circuits that originate, terminate, or pass through a specific node, choose View > 
Go to Other Node, then choose the node you want to search and click OK.

• To search for circuits that originate, terminate, or pass through a specific card, double-click the card 
on the shelf graphic in node view to open the card in card view. 

Step 2 Click the Circuits tab.

Step 3 If you are in node or card view, choose the scope for the search, Node or Network (All), in the Scope 
drop-down list located at the bottom right side of the screen. 

Step 4 Click Search.

Step 5 In the Circuit Name Search dialog box, complete the following:

• Find What—Enter the text of the circuit name you want to find.

• Match whole word only—Check this check box to instruct CTC to select circuits only if the entire 
word matches the text in the Find What field. 

• Match case—Check this check box to instruct CTC to select circuits only when the capitalization 
matches the capitalization entered in the Find What field.

• Direction—Choose the direction for the search. Searches are conducted up or down from the 
currently selected circuit.

Step 6 Click Find Next. If a match is found, click Find Next again to find the next circuit.

Step 7 Repeat Steps 5 and 6 until you are finished, then click Cancel.

Step 8 Return to your originating procedure (NTP).

DLP-G101 View Optical Channel Network Connection Information

Step 1 Navigate to the appropriate CTC view:

• To view circuits for an entire network, choose View > Go to Network View.

• To view circuits that originate, terminate, or pass through a specific node, choose View > 
Go to Other Node, then choose the node you want to search and click OK.

• To view circuits that originate, terminate, or pass through a specific card, in node view, double-click 
the card containing the circuits you want to view.

Note In node or card view, you can change the scope of the circuits that appear by choosing Card 
(in card view), Node, or Network from the Scope drop-down list in the bottom right corner 
of the Circuits window.

Purpose This task provides information about DWDM OCHNCs and ONS 15454 
circuits. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 2 Click the Circuits tab. The Circuits tab shows the following information:

• Circuit Name—Name of the circuit. The circuit name can be manually assigned or automatically 
generated.

• Type—Circuit types are OCHNC. 

STS, VT, VTT (VT tunnel), VAP (VT aggregation point), STS-v (STS VCAT circuit), and VT-v (VT 
VCAT circuit) are not applicable for ANSI DWDM nodes. HOP (high-order circuit), LOP 
(low-order circuit), VCT (VC low-order tunnel), VCA (VC low-order aggregation point), HOP_v 
(high-order virtual concatenated [VCAT] circuit), or LOP_v (low-order VCAT circuit) are not 
applicable for ETSI DWDM nodes.

• Size—Circuit size. OCHNC sizes are Equipped not specific, Multi-rate, 2.5 Gbps No FEC (forward 
error correction), 2.5 Gbps FEC, 10 Gbps No FEC, and 10 Gbps FEC. VT, STS, and VCAT circuits 
are not applicable to ANSI DWDM nodes. VC12, VC3, VC4, and VCAT circuits are not applicable 
to ETSI DWDM nodes. 

• OCHNC Wlen—For OCHNCs, the wavelength provisioned for the optical channel network 
connection. See Table 6-3 on page 6-9 for a list of channels and wavelengths.

• Direction—The circuit direction, either two-way or one-way.

• OCHNC Dir—The direction of the OCHNC, either East to West or West to East. If the direction is 
West to East, the channel exits from the node through the LINE-TX port of the OSC-CSM or 
OPT-BST card (typically in Slot 17). If the direction is East to West, the channel exits from the node 
through the LINE-TX port of OSC-CSM or OPT-BST card (typically in Slot 1).

• Protection—The type of circuit protection. See Table 6-1 for a list of protection types.

• Status—The circuit status. Table 6-2 lists the circuit statuses that can appear.

• Source—The circuit source in the format: node/slot/port “port name” (the port name will appear in 
quotes). 

• Destination—The circuit destination in same format as the circuit source. STSs, VTs, VCs, and 
tributary units are not applicable to DWDM nodes.

• # of VLANS—The number of VLANs used by an Ethernet circuit. VLANs are not applicable to 
DWDM nodes.

• # of Spans—The number of inter-node links that constitute the circuit. Right-clicking the column 
shows a shortcut menu from which you can choose to show or hide circuit span detail.

• State—The circuit service state, which is an aggregate of its cross-connects. For ANSI, the service 
states are IS, OOS, or OOS-PARTIAL. For ETSI, the service states are Unlocked, Locked, or 
Locked-partial. For more information about ANSI and ETSI service states, see the Appendix C, 
“DWDM Enhanced State Model.”

– IS/Unlocked—All cross-connects are in service and operational.

– OOS/Locked—All cross-connects are Out-of-Service and Management, Maintenance 
(OOS-MA,MT) and/or Out-of-Service and Management, Disabled (OOS-MA,DSBLD) for 
ANSI or Locked-enabled,maintenance and/or Locked-enabled,disabled for ETSI.

– OOS-PARTIAL/Locked-partial—At least one cross-connect is In-Service and Normal (IS-NR 
[ANSI]) or Unlocked-enabled (ETSI) and others are out-of-service.
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Table 6-1 Circuit Protection Types

Protection Type Description

Y-Cable The circuit is protected by a transponder or muxponder card Y-cable 
protection group.

Splitter The circuit is protected by the protect transponder splitter protection.

Unprot (black) A circuit with a source and destination on different nodes is not protected. 

N/A A circuit with connections on the same node is not protected. 

Unknown A circuit has a source and destination on different nodes and communication 
is down between the nodes. This protection type appears if not all circuit 
components are known.

Table 6-2 Cisco ONS 15454 Circuit Status

Status Definition/Activity

CREATING CTC is creating a circuit.

DISCOVERED CTC created a circuit. All components are in place and a complete path exists 
from the circuit source to the circuit destination.

DELETING CTC is deleting a circuit.

PARTIAL A CTC-created circuit is missing a cross-connect or network span, a complete 
path from source to destination(s) does not exist, or an alarm interface panel 
(AIP) change occurred on one of the circuit nodes and the circuit is in need 
of repair. (AIPs store the node MAC address.)

In CTC, circuits are represented using cross-connects and network spans. If a 
network span is missing from a circuit, the circuit status is PARTIAL. 
However, a PARTIAL status does not necessarily mean a circuit traffic failure 
has occurred, because traffic might flow on a protect path. 

Network spans are in one of two states: up or down. On CTC circuit and 
network maps, up spans are shown as green lines, and down spans are shown 
as gray lines. If a failure occurs on a network span during a CTC session, the 
span remains on the network map but its color changes to gray to indicate the 
span is down. If you restart your CTC session while the failure is active, the 
new CTC session cannot discover the span and its span line will not appear 
on the network map. 

Subsequently, circuits routed on a network span that goes down will appear 
as DISCOVERED during the current CTC session, but they will appear as 
PARTIAL to users who log in after the span failure. 

The PARTIAL status does not appear for OCHNC circuit types.

DISCOVERED_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is complete. A 
complete path from source to destination(s) exists. 

This status does not appear for OCHNC circuit types.

PARTIAL_TL1 A TL1-created circuit or a TL1-like CTC-created circuit is missing a 
cross-connect, and a complete path from source to destination(s) does not 
exist. 

This status does not appear for OCHNC circuit types.
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Step 3 Return to your originating procedure (NTP).

DLP-G102 Filter the Display of Optical Channel Network Connections

Step 1 Navigate to the appropriate CTC view:

• To filter network circuits, choose View > Go to Network View.

• To filter circuits that originate, terminate, or pass through a specific node, choose View > 
Go to Other Node, then choose the node you want to search and click OK.

• To filter circuits that originate, terminate, or pass through a specific card, double-click the card on 
the shelf graphic in node view to open the card in card view. 

Step 2 Click the Circuits tab.

Step 3 Set the attributes for filtering the circuit display:

a. Click the Filter button.

b. In the Circuit Filter dialog box, set the filter attributes by choosing one or more of the following:

• Name—Enter a complete or partial circuit name to filter circuits based on the circuit name; 
otherwise leave the field blank.

• Direction—Choose one: Any (direction not used to filter circuits), 1-way (display only one-way 
circuits), or 2-way (display only two-way circuits).

• OCHNC Dir—(DWDM optical channel network connections only.) Choose one: East to West 
(displays only east-to-west circuits); West to East (displays only west-to-east circuits).

• OCHNC Wlen—(DWDM optical channel network connections only.) Choose an OCHNC 
wavelength to filter the circuits. For example, choosing 1530.33 will display channels 
provisioned on the 1530.33-nm wavelength.

• Status—Choose one: Any (status not used to filter circuits), Discovered (display only 
discovered circuits; OCHNCs have Discovered status only) or Partial (display only partial 
circuits, that is, circuits missing a connection or span to form a complete path). 

• State—Choose one: OOS (ANSI) or Locked (ETSI) to display only out-of-service circuits; IS 
(ANSI) or Unlocked (ETSI) to display only in-service circuits (optical channel network 
connections have IS/Unlocked states only); or OOS-PARTIAL (ANSI) or 
Locked-partial (ETSI) to display only circuits with cross-connects in mixed service states.

• Slot—Enter a slot number to filter circuits based on the source or destination slot; otherwise 
leave the field blank.

Purpose This task filters the display of OCHNCs and circuits in the Circuits 
window. You can filter the circuits in network, node, or card view based on 
circuit or OCHNC name, size, type, direction, and other attributes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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• Port—Enter a port number to filter circuits based on the source or destination port; otherwise 
leave the field blank.

• Type—Choose one: Any (type not used to filter circuits) or OCHNC (displays only optical 
channel network connections). 

STS (displays only STS circuits), VT (displays only VT circuits), VT Tunnel (displays only VT 
tunnels), STS-V (displays STS VCAT circuits), VT-V (displays VT VCAT circuits), and VT 
Aggregation Point (displays only VT aggregation points) are not applicable to ANSI DWDM 
nodes.

VC_HO_PATH_CIRCUIT (displays VC4 and VC4-Nc circuits), VC_LO_PATH_CIRCUIT 
(displays only VC3 and VC12 circuits), VC_LO_PATH_TUNNEL (displays only low-order 
tunnels), VC_LO_PATH_AGGREGATION (displays only log-order aggregation points), 
VC_HO_PATH_VCAT_CIRCUIT (displays high-order VCAT circuits), 
VC_LO_PATH_VCAT_CIRCUIT (displays low-order VCAT circuits) are not applicable to 
ETSI DWDM nodes.

• Size—Click the appropriate check boxes to filter circuits based on size: Multi-rate, 
Equipment non specific, 2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, or 10 Gbps No FEC. 

VT1.5, STS-1, STS3c, STS-6c, STS-9c, STS-12c, STS-24c, STS-48c, and STS-192c are not 
applicable to ANSI DWDM nodes. VC12, VC3, VC4, VC4-2c, VC4-3c, VC4-4c, VC4-6c, 
VC4-8c, VC4-9c, VC4-16c, and VC4-64 are not applicable to ETSI DWDM nodes.

The check boxes shown depend on the Type field selection. If you chose Any, all sizes are 
available. If you chose OCHNC as the circuit type, Multi-rate, Equipment non specific, 
2.5 Gbps FEC, 2.5 Gbps No FEC, 10 Gbps FEC, and 10 Gbps No FEC appear. 

Step 4 Click OK. Circuits matching the attributes in the Filter Circuits dialog box appear in the Circuits 
window.

Step 5 To turn filtering off, click the Filter icon in the lower right corner of the Circuits window. Click the icon 
again to turn filtering on, and click the Filter button to change the filter attributes.

Step 6 Return to your originating procedure (NTP).

DLP-G103 View Optical Channel Network Connections on a Span

Step 1 In node view, choose View > Go to Network View. If you are already in network view, continue with 
Step 2.

Step 2 Right-click the green line containing the circuits you want to view and choose Circuits to view DWDM 
OCHNCs or unprotected circuits on the span.

Purpose This task allows you to view OCHNCs and circuits on an ONS 15454 span. 

Tools/Equipment None

Prerequisite Procedures DLP-G105 Provision DWDM Optical Channel Network Connections, page 
6-9

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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In the Circuits on Span dialog box, you can view information about the circuits that traverse the span. 
The information that appears depends on the circuit type. For DWDM OCHNCs, the following 
information appears:

• OCHNC Wavelength—The wavelength provisioned for the OCHNC.

• OCHNC Dir—The direction provisioned for the OCHNC, either east-to-west or west-to-east.

• Circuit—The OCHNC circuit name.

Step 3 Return to your originating procedure (NTP).

NTP-G59 Create and Delete Optical Channel Network 
Connections

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you want to 
create and delete OCHNCs. If you are already logged in, continue with Step 2.

Step 2 If you want to assign a name to the OCHNC source and destination ports before you create the circuit, 
complete the “DLP-G104 Assign a Name to a Port” task on page 6-8. If not, continue with the next step.

Step 3 Complete the “DLP-G105 Provision DWDM Optical Channel Network Connections” task on page 6-9 
as needed.

Step 4 Complete the “DLP-G106 Delete Optical Channel Network Connections” task on page 6-11 as needed.

Stop. You have completed this procedure.

DLP-G104 Assign a Name to a Port

Step 1 Double-click the card that has the port you want to provision.

Purpose This procedure creates and deletes DWDM OCHNCs.

Tools/Equipment None

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose Use this task to assign a name to a port on any ONS 15454 card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Click the Provisioning tab.

Step 3 Click the Port Name column for the port number to which you are assigning a name.

Step 4 Type the port name. 

The port name can be up to 32 alphanumeric/special characters. The field is blank by default.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G105 Provision DWDM Optical Channel Network Connections

Step 1 Choose View > Go to Network View.

Step 2 Click the Circuits tab, then click Create.

Step 3 In the Circuit Creation dialog box, choose OCHNC from the Circuit Type list. 

Step 4 Click Next.

Step 5 Define the circuit attributes:

• Name—Assign a name to the OCHNC. The name can be alphanumeric and up to 48 characters 
(including spaces). Circuit names should be 44 characters or less if you want the ability to create 
monitor circuits. If you leave the field blank, CTC assigns a default name to the circuit.

• Size—Equipped non specific is the default. You cannot change it.

• OCHNC Channel—Choose the wavelength you want to provision. Table 6-3 lists the thirty-two 
available wavelengths.

Purpose This procedure creates an OCHNC between ONS 15454s that are 
provisioned for DWDM. 

Tools/Equipment An OCHNC add port on the source node and an OCHNC drop port on 
destination node of the same wavelength are required.

DLP-G46 Log into CTC, page 2-25

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node” must be completed at all 
nodes within the OCHNC route.

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher

Table 6-3 OCHNC Channels

Channel No. Channel ID Frequency (GHz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 34.2 195.4 1534.25
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• OCHNC Direction—Choose the OCHNC direction, either East to West or West to East. If you 
choose West to East, the channel will exit the node through the LINE-TX port of the OSC-CSM or 
OPT-BST card with its line direction set to West to East. The card is usually installed in Slot 17. If 
you choose East to West, the channel will exit the node through the LINE-TX port of the OSC-CSM 
or OPT-BST card with its line direction set to East to West. The card is usually installed in Slot 1.

• Bidirectional—Check this check box to create a bidirectional OCHNC; uncheck it to create a 
unidirectional OCHNC.

Step 6 Click Next. 

Step 7 In the Circuit Source area, choose the source node from the Node drop-down list. 

Step 8 Click Next. 

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56

13 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 54.1 192.9 1554.13

26 54.9 192.8 1544.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61

Table 6-3 OCHNC Channels (continued)

Channel No. Channel ID Frequency (GHz) Wavelength (nm)
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Step 9 In the Circuit Destination area, choose the destination node from the Node drop-down list. 

Step 10 Click Finish. 

Stop. You have completed this procedure.

DLP-G106 Delete Optical Channel Network Connections

Step 1 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 2 Verify that traffic is no longer carried on the OCHNC and that the OCHNC can be safely deleted.

Step 3 Investigate all network alarms and resolve any problems that might be affected by the OCHNC deletion. 
Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Step 4 Choose View > Go to Network View. 

Step 5 Click the Circuits tab.

Step 6 Choose the OCHNCs you want to delete, then click Delete.

Step 7 In the Delete Circuits confirmation dialog box, check Notify when completed, as needed. 

If checked, the CTC Alerts confirmation dialog box indicates when the OCHNC is deleted. During this 
time, you cannot perform other CTC functions. If you are deleting many OCHNCs, waiting for 
confirmation might take a few minutes. Circuits are deleted whether or not this check box is checked.

Note The CTC Alerts dialog box will not automatically open to show a deletion error unless you 
checked All alerts or Error alerts only in the CTC Alerts dialog box. For more information, see 
the “DLP-G53 Configure the CTC Alerts Dialog Box for Automatic Popup” task on page 2-33. 
If the CTC Alerts dialog box is not set to open automatically with a notification, the red triangle 
inside the CTC Alerts toolbar icon indicates that a notification exists. 

Step 8 Complete one of the following:

• If you checked “Notify when completed,” the CTC Alerts dialog box appears. If you want to save 
the information, continue with Step 9. If you do not want to save the information, continue with 
Step 10.

• If you did not check “Notify when completed,” the Circuits window appears. Continue with Step 11.

Step 9 If you want to save the information in the CTC Alerts dialog box, complete the following steps. If you 
do not want to save it, continue with Step 10.

a. Click Save. 

b. Click Browse and navigate to the directory where you want to save the file. 

Purpose This task deletes circuits and DWDM OCHNCs. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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c. Type the file name using a .txt file extension, and click OK.

Step 10 Click Close to close the CTC Alerts dialog box. 

Step 11 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 12 Return to your originating procedure (NTP).

NTP-G60 Create Overhead Circuits

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you will create the 
overhead circuit. If you are already logged in, continue with Step 2.

Step 2 Choose View > Go to Network View.

Step 3 As needed, complete the “DLP-G107 Create an IP-Encapsulated Tunnel” task on page 6-13, then 
continue with the next step.

Step 4 After creating an IP-encapsulated tunnel, put the ports that are hosting the IP-encapsulated tunnel in 
service. See the “DLP-G108 Change the Service State for a Port” task on page 6-14.

Step 5 As needed, complete the “DLP-G109 Provision Orderwire” task on page 6-15.

Step 6 As needed, complete the “DLP-G110 Create a User Data Channel Circuit” task on page 6-16.

Stop. You have completed this procedure.

Purpose This procedure creates overhead circuits on an ONS 15454 network. 
Overhead circuits include IP-encapsulated tunnels, the Alarm Interface 
Controller (AIC) and Alarm Interface Controller–International (AIC-I) 
card orderwire, and the AIC-I card user data channel (UDC).

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G107 Create an IP-Encapsulated Tunnel

Note Each ONS 15454 can have up to ten IP-encapsulated tunnel connections. Terminated Section DCCs 
(SDCCs) used by the ONS 15454 cannot be used as a tunnel endpoint, and an SDCC that is used as a 
tunnel endpoint cannot be terminated. All tunnel connections are bidirectional. 

Step 1 Verify that IP addresses are provisioned at both the source and destination nodes of the planned tunnel. 
For more information, see the “DLP-G56 Provision IP Settings” task on page 3-9.

Step 2 In network view, click the Provisioning > Overhead Circuits tabs.

Step 3 Click Create.

Step 4 In the Overhead Circuit Creation dialog box, complete the following in the Circuit Attributes area:

• Name—Type the tunnel name.

• Type—Choose IP Tunnel-D1-D3.

• Maximum Bandwidth—Type the percentage of total SDCC bandwidth used in the IP tunnel (the 
minimum percentage is 10 percent). 

Step 5 Click Next.

Step 6 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, choose the source port.

• Channel—Displays IPT (D1-D3).

Step 7 Click Next.

Step 8 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If displayed, choose the destination port.

• Channel—Displays IPT (D1-D3).

Step 9 Click Finish.

Purpose This task creates a an IP-encapsulated tunnel to transport traffic from 
third-party SONET/SDH equipment across ONS 15454 networks. 
IP-encapsulated tunnels are created on the Section DCC channel (D1-D3) 
(if not used by the ONS 15454 as a terminated data communications 
channel [DCC]). 

Tools/Equipment An OSCM, OSC-SCM, MXP_2.5_10E, MXP_2.5_10G, 
MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 10 Return to your originating procedure (NTP).

DLP-G108 Change the Service State for a Port

Step 1 In node view on the shelf graphic, double-click the card with the port(s) you want to put in or out of 
service. The card view appears.

Step 2 Click the Provisioning > Line tabs.

Step 3 In the Admin State column for the desired port, choose one of the following from the drop-down list:

• IS (ANSI) or Unlocked (ETSI)—Places the port in the IS-NR (ANSI) or Unlocked-enabled (ETSI) 
service state. 

• OOS, DSBLD (ANSI) or Locked,disabled (ETSI)—Places the port in the 
OOS-MA,DSBLD (ANSI) or Locked-enabled,disabled (ETSI) service state. 

For ANSI nodes, traffic is not passed on the port until the service state is changed to IS-NR; 
OOS-MA,MT; or Out-of-Service and Autonomous, Automatic In-Service (OOS-AU,AINS). For 
ETSI nodes, traffic is not passed on the port until the service state is changed to Unlocked-enabled; 
Locked-enabled,maintenance; or Unlocked-disabled,automaticInService.

• OOS, MT (ANSI) or Locked,maintenance (ETSI)—Places the port in the 
OOS-MA,MT/Locked-enabled,maintenance service state. This service state does not interrupt 
traffic flow, but alarm reporting is suppressed and loopbacks are allowed. Raised fault conditions, 
whether or not their alarms are reported, can be retrieved on the CTC Conditions tab or by using the 
TL1 RTRV-COND command. Use the OOS-MA,MT/Locked-enabled,maintenance service state for 
testing or to suppress alarms temporarily. Change to the IS-NR/Unlocked-enabled or 
OOS-AU,AINS/Unlocked-disabled,automaticInService service states when testing is complete.

• IS, AINS (ANSI) or Unlocked,automaticInService (ETSI)—Places the port in the 
OOS-AU,AINS/Unlocked-enabled,automaticInService service state. In this service state, alarm 
reporting is suppressed, but traffic is carried and loopbacks are allowed. After the soak period 
passes, the port changes to IS-NR/Unlocked-enabled. Raised fault conditions, whether their alarms 
are reported or not, can be retrieved on the CTC Conditions tab or by using the TL1 RTRV-COND 
command.

For more information about service states, refer to Appendix C, “DWDM Enhanced State Model.”

Step 4 If you set the Admin State to IS-AINS/Unlocked,automaticInService, set the soak period time in the 
AINS Soak field. This is the amount of time that the port will stay in the 
OOS-AU,AINS/Unlocked-enabled,automaticInService service state after a signal is continuously 
received. When the soak period elapses, the port changes to the IS-NR/Unlocked-enabled service state.

Purpose This task puts a port in service or removes a port from service. After 
creating an IP-encapsulated tunnel, put the ports that are hosting the 
IP-encapsulated tunnel in service.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click Apply. The new port service state appears in the Service State column.

Step 6 As needed, repeat this task for each port.

Step 7 Return to your originating procedure (NTP).

DLP-G109 Provision Orderwire

Step 1 In the network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create. 

Step 3 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Circuit Type—Choose either Local Orderwire or Express Orderwire depending on the orderwire 
path that you want to create. If regenerators are not used between ONS 15454 nodes, you can use 
either local or express orderwire channels. If regenerators exist, use the express orderwire channel. 
You can provision up to four ONS 15454 OC-N ports for each orderwire path.

• PCM—Choose the Pulse Code Modulation voice coding and companding standard, either Mu_Law 
(North America, Japan) or A_Law (Europe). The provisioning procedures are the same for both 
types of orderwire.

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Step 4 Click Next.

Step 5 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, choose the source port.

Step 6 Click Next.

Purpose This task provisions orderwire on the AIC or the AIC-I card. 

Tools/Equipment An AIC or AIC-I card must be installed in Slot 9.

An OSCM, OSC-SCM, MXP_2.5_10E, MXP_2.5_10G, 
MXPP_MR_2.5G, or MXP_MR_2.5G card must be installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed 

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
6-15
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Chapter 6      Create Channels and Circuits
DLP-G110 Create a User Data Channel Circuit
Step 7 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If displayed, choose the destination port.

Step 8 Click Finish.

Step 9 Return to your originating procedure (NTP).

DLP-G110 Create a User Data Channel Circuit

Step 1 In network view, click the Provisioning > Overhead Circuits tabs.

Step 2 Click Create.

Step 3 In the Overhead Circuit Creation dialog box, complete the following fields in the Circuit Attributes area:

• Name—Assign a name to the circuit. The name can be alphanumeric and up to 48 characters 
(including spaces).

• Type—Choose either User Data-F1 or User Data D-4-D-12 from the drop-down list. 
(User Data D-4-D-12 is not available if the ONS 15454 is provisioned for DWDM.)

Step 4 Click Next.

Step 5 In the Circuit Source area, complete the following:

• Node—Choose the source node.

• Slot—Choose the source slot.

• Port—If displayed, choose the source port.

Step 6 Click Next.

Step 7 In the Circuit Destination area, complete the following:

• Node—Choose the destination node.

• Slot—Choose the destination slot.

• Port—If displayed, choose the destination port.

Step 8 Click Finish.

Step 9 Return to your originating procedure (NTP). 

Purpose This task creates a user data channel (UDC) circuit on the ONS 15454. A 
UDC circuit allows you to create a dedicated data channel between nodes. 

Tools/Equipment  OSCM, OSC-SCM, MXPP_MR_2.5G, or MXP_MR_2.5G must be 
installed. 

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G61 Modify and Delete Overhead Circuits

Caution Deleting circuits can be service affecting and should be performed during a maintenance window.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 for a node on the network where you want 
to repair or delete a circuit. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G111 Repair an IP Tunnel” task on page 6-17.

Step 3 As needed, complete the “DLP-G112 Delete Overhead Circuits” task on page 6-18.

Stop. You have completed this procedure.

DLP-G111 Repair an IP Tunnel

Step 1 Obtain the original IP address of the node in question.

Step 2 From the View menu, choose Go to Network View.

Step 3 From the Tools menu, choose Overhead Circuits > Repair IP Circuits.

Step 4 Review the text in the IP Repair wizard and click Next.

Step 5 In the Node IP address area, complete the following:

• Node—Choose the node that has an OOS-PARTIAL circuit.

• Old IP Address—Type the node’s original IP address.

Step 6 Click Next.

Step 7 Click Finish.

Purpose This procedure repairs IP circuits and deletes overhead circuits.

Tools/Equipment None

Prerequisite Procedures NTP-G60 Create Overhead Circuits, page 6-12

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task repairs circuits that have a OOS-PARTIAL status as a result of 
node IP address changes.

Tools/Equipment None

Prerequisite Procedures DLP-G107 Create an IP-Encapsulated Tunnel, page 6-13

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 8 Return to your originating procedure (NTP).

DLP-G112 Delete Overhead Circuits

Caution Deleting overhead circuits is service affecting if the circuits are in service (IS). To put circuits out of 
service (OOS), see the “DLP-G108 Change the Service State for a Port” task on page 6-14.

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Overhead Circuits tabs.

Step 3 Click the overhead circuit that you want to delete: local or express orderwire, user data, IP-encapsulated 
tunnel, or DCC tunnel.

Step 4 Click Delete.

Step 5 In the confirmation dialog box, click Yes to continue.

Step 6 Return to your originating procedure (NTP).

NTP-G62 Create a J0 Section Trace 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at a node on the network where you will 
create the section trace. If you are already logged in, continue with Step 2.

Purpose This task deletes overhead circuits. Overhead circuits include 
IP-encapsulated tunnels, AIC and AIC-I card orderwire, and user data 
channels.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure creates a repeated, fixed-length string of characters used to 
monitor interruptions or changes to traffic between nodes. 

Tools/Equipment At least one of the following cards must be installed: MXP_MR_2.5G, 
MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, MXP_2.5G_10E, 
TXP_MR_10E, MXP_2.5G_10G, or TXP_MR_10G.

Prerequisite Procedures None

Required/As Needed As needed (optional if path trace is set)

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 In node view, double-click the MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, TXPP_MR_2.5G, 
MXP_2.5G_10E, TXP_MR_10E, MXP_2.5G_10G, or TXP_MR_10G card.

Step 3 Click the Provisioning > Line > Section Trace tabs.

Step 4 From the Port drop-down list, choose the port for the section trace.

Step 5 From the Trace Mode drop-down list, enable the section trace expected string by choosing Auto or 
Manual:

• Auto—The first string received from the source port is automatically provisioned as the current 
expected string. An alarm is raised when a string that differs from the baseline is received. 

• Manual—The string entered in the Current Expected String field is the baseline. An alarm is raised 
when a string that differs from the Current Expected String is received.

Step 6 In the Section Trace String Size area, click 1 byte or 16 byte.

Step 7 In the New Transmit String field, enter the string that you want to transmit. Enter a string that makes the 
destination port easy to identify, such as the node IP address, node name, or another string. If the 
New Transmit String field is left blank, the J0 transmits a string of null characters.

Step 8 If you set the Section Trace Mode field to Manual, enter the string that the destination port should receive 
from the source port in the New Expected String field. If you set Section Trace Mode to Auto, skip this 
step.

Step 9 Click the Disable AIS and RDI if TIM-P is detected check box if you want to suppress the alarm 
indication signal (AIS) and remote defect indication (RDI) when the STS Section Trace Identifier 
Mismatch Path (TIM-P) alarm appears. Refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide for descriptions of alarms and conditions.

Step 10 Click Apply.

Step 11 After you set up the section trace, the received string appears in the Received field. The following 
options are available:

• Click Hex Mode to display section trace in hexadecimal format. The button name changes to ASCII 
Mode. Click it to return the section trace to ASCII format.

• Click the Reset button to reread values from the port. 

• Click Default to return to the section trace default settings (Section Trace Mode is set to Off and the 
New Transmit and New Expected Strings are null).

Caution Clicking Default will generate alarms if the port on the other end is provisioned with a different string.

The expect and receive strings are updated every few seconds if the Section Trace Mode field is set to 
Auto or Manual.

Stop. You have completed this procedure.
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C H A P T E R 7

Manage Alarms

This chapter contains the procedures for viewing and managing the alarms and conditions on a 
Cisco ONS 15454. 

Cisco Transport Controller (CTC) detects and reports alarms generated by the Cisco ONS 15454 and the 
Optical Networking System (ONS) network. You can use CTC to monitor and manage alarms at a card, 
node, or network level. You can also view alarm counts on the LCD front panel.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G63 Document Existing Provisioning, page 7-2—Complete this procedure as needed to print 
or export node data.

2. NTP-G64 View Alarms, History, Events, and Conditions, page 7-5—Complete this procedure as 
needed to see alarms and conditions occurring on the node and a complete history of alarm and 
condition messages.

3. NTP-G65 Delete Cleared Alarms from Display, page 7-13—Complete this procedure as needed to 
delete cleared alarm information.

4. NTP-G66 View Alarm-Affected Circuits, page 7-14—Complete this procedure as needed to find 
circuits that are affected by a particular alarm or condition.

5. NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port, page 7-16—Complete this 
procedure as needed to see a statistical count of alarms that have occurred for a slot or port.

6. NTP-G68 Create, Download, and Assign Alarm Severity Profiles, page 7-17—Complete this 
procedure as needed to change the default severity for certain alarms, to assign the new severities to 
a port, card, or node, and to delete alarm profiles.

7. NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering, page 7-29—Complete this 
procedure as needed to enable, disable, or modify alarm severity filtering in the Conditions, Alarms, 
or History screens at the node or network level.

8. NTP-G70 Suppress Alarms or Discontinue Alarm Suppression, page 7-33—Complete this 
procedure as needed to suppress reported alarms at the port, card, or node level and to disable the 
suppress command to resume normal alarm reporting.
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NTP-G63 Document Existing Provisioning
9. NTP-G71 Provision External Alarms and Controls on the Alarm Interface Controller Card, page 
7-36—Complete this procedure as needed to provision external alarms and controls on the ONS 
15454 ANIS Alarm Interface Controller (AIC) card.

10. NTP-G72 Provision External Alarms and Controls on the Alarm Interface Controller-International, 
page 7-38—Complete this procedure as needed to provision external alarms and controls on the 
Alarm Interface Controller-International (AIC-I) card.

NTP-G63 Document Existing Provisioning

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to print or export 
data. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G113 Print CTC Data” task on page 7-2.

Step 3 As needed, complete the “DLP-G114 Export CTC Data” task on page 7-4.

Stop. You have completed this procedure.

DLP-G113 Print CTC Data

Step 1 Click the tab (and subtab, if present) containing the information you want to print. For example, click 
the Alarms tab to print Alarms window data.

The print operation is available for all network, node, and card view windows.

Step 2 From the File menu choose Print. The Print dialog box opens (Figure 7-1). 

Purpose Use this procedure to document existing provisioning by printing card, 
node, or network CTC information or exporting card, node, or network 
information as delineated text files to other applications. This procedure 
is useful for network record keeping and troubleshooting.

Tools/Equipment A printer connected to the CTC computer by a direct or network 
connection

Prerequisite Procedures Chapter 3, “Turn Up a Node”

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 

Purpose This task prints CTC card, node, or network data in graphical or tabular 
format on a Windows-provisioned printer.

Tools/Equipment Printer connected to the CTC computer by a direct or network connection

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G113 Print CTC Data
Figure 7-1 Selecting CTC Data For Print

Step 3 In the Print dialog box, click a printing option:

• Entire Frame—Prints the entire CTC window including the graphical view of the card, node, or 
network. This option is available for all windows.

• Tabbed View—Prints the lower half of the CTC window containing tabs and data. The printout 
includes the selected tab (on top) and the data shown in the tab window. For example, if you print 
the History window Tabbed View, you print only history items appearing in the window. This option 
is available for all windows.

• Table Contents—Prints CTC data in table format without graphical representations of shelves, 
cards, or tabs. This option applies to all windows except:

– Provisioning > General > General and Power Monitor windows

– Provisioning > Network > General and RIP windows

– Provisioning > Security > Policy, Access, and Legal Disclaimer windows

– Provisioning > SNMP window

– Provisioning > Timing window

– Provisioning > UCP > Node window

– Maintenance > Cross-Connect > Cards window

– Maintenance > Database window

– Maintenance > Diagnostic window

– Maintenance > Protection window

– Maintenance > Timing > Source window

The Table Contents option prints all the data contained in a table and the table column headings. For 
example, if you print the History window Table Contents view, you print all data included in the 
table whether or not items appear in the window.

Tip When you print using the Tabbed View option, it can be difficult to distinguish whether the 
printout applies to the network, node, or card view. To determine the view, compare the tabs on 
the printout. The network, node, and card views are identical except that network view does not 
contain an Inventory tab or Performance tab.

Step 4 Click OK.

Step 5 In the Windows Print dialog box, click a printer and click OK.

Step 6 Repeat this task for each window that you want to print.
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DLP-G114 Export CTC Data
Step 7 Return to your originating procedure (NTP).

DLP-G114 Export CTC Data

Step 1 Click the tab containing the information you want to export (for example, the Alarms tab or the Circuits 
tab).

Step 2 Choose Export from the File menu. The Export dialog box appears (Figure 7-2).

Figure 7-2 Selecting CTC Data For Export

Step 3 In the Export dialog box, click a data format:

• As HTML—Saves data as a simple HTML table file without graphics. The file must be viewed or 
edited with applications such as Netscape Navigator, Microsoft Internet Explorer, or other 
applications capable of opening HTML files.

• As CSV—Saves the CTC table as comma-separated values (CSV). This option does not apply to the 
Maintenance > Timing > Report window.

• As TSV—Saves the CTC table as tab-separated values (TSV).

Step 4 If you want to open a file in a text editor or word processor application, procedures will vary. Typically 
you can use the File > Open command to view the CTC data, or you can double-click the file name and 
choose an application such as Notepad. 

Text editor and word processor applications format the data exactly as it is exported, including comma 
or tab separators. All applications that open the data files allow you to format the data.

Step 5 If you want to open the file in spreadsheet and database management applications, procedures will vary. 
Typically you need to open the application and choose File > Import, then choose a delimited file to 
format the data in cells.

Purpose This task exports CTC table data as delineated text to view or edit the data 
in text editor, word processing, spreadsheet, database management, or web 
browser applications.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
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Spreadsheet and database management programs also allow you to manage the exported data.

Note An exported file cannot be opened in CTC. 

The export operation applies to all tabular data except:

• Provisioning > General > General and Power Monitor windows

• Provisioning > Network > General and RIP windows

• Provisioning > Security > Policy, Access, and Legal Disclaimer windows

• Provisioning > SNMP window

• Provisioning > Timing window

• Provisioning > UCP > Node window

• Provisioning > WDM-ANS > Provisioning window

• Maintenance > Cross-Connect > Cards window

• Maintenance > Database window

• Maintenance > Diagnostic window

• Maintenance > Protection window

• Maintenance > Timing > Source and Report windows

Step 6 Click OK.

Step 7 In the Save dialog box, enter a name in the File name field using one of the following formats:

• filename.html for HTML files

• filename.csv for CSV files

• filename.tsv for TSV files

Step 8 Navigate to a directory where you want to store the file.

Step 9 Click OK.

Step 10 Repeat the task for each window that you want to export.

Step 11 Return to your originating procedure (NTP).

NTP-G64 View Alarms, History, Events, and Conditions

Purpose Use this procedure to view current or historical alarms and conditions for 
a card, node, or network. This information is useful for monitoring and 
troubleshooting hardware and software events.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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DLP-G115 View Alarms
Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25.

Step 2 Complete the “DLP-G115 View Alarms” task on page 7-6 as needed.

Step 3 Complete the “DLP-G116 View Alarm or Event History” task on page 7-8 as needed.

Step 4 Complete the “DLP-G117 Change the Maximum Number of Session Entries for Alarm History” task on 
page 7-10 as needed.

Step 5 Complete the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 7-11 as 
needed.

Step 6 Complete the “DLP-G119 Synchronize Alarms” task on page 7-11 as needed.

Step 7 Complete the “DLP-G120 View Conditions” task on page 7-12 as needed.

Stop. You have completed this procedure. 

DLP-G115 View Alarms

Step 1 In the card, node, or network view, click the Alarms tab to view the alarms for that card, node, or 
network (Figure 7-3).

Purpose Use this to view current alarms on a card, node, or network. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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DLP-G115 View Alarms
Figure 7-3 CTC Node View

Table 7-1 describes the columns in the Alarms window.

Table 7-1 Alarm Column Descriptions

Column Information Recorded

Num Sequence number of the original alarm

Ref Reference number of the original alarm

New Indicates a new alarm; to change this status, click either the Synchronize button or 
the Delete Cleared Alarms button.

Date Date and time of the alarm.

Object TL1 access identifier (AID) for the alarmed object; for an STSmon or VTmon, this is 
the monitored STS or VT.

Eqpt Type If an alarm is raised on a card, the card type in this slot.

Slot If an alarm is raised on a card, the slot where the alarm occurred (appears only in 
network and node view).

Port If an alarm is raised on a card, the port where the alarm is raised; for STSTerm and 
VTTerm, the port refers to the upstream card it is partnered with.

Path Width Indicates how many STSs are contained in the alarmed path. This information 
complements the alarm object notation, which is explained in the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Sev Severity level: CR (Critical), MJ (Major), MN (minor), NA (Not Alarmed), NR 
(Not Reported).

ST Status: R (raised), C (clear).

SA When checked, indicates a service-affecting alarm.
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DLP-G116 View Alarm or Event History
Table 7-2 lists the color codes for alarm and condition severities.

Step 2 If alarms are present, refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for 
information and troubleshooting procedures.

Step 3 Return to your originating procedure (NTP). 

DLP-G116 View Alarm or Event History

Step 1 Decide whether you want to view the alarm message history at the node, network, or card level.

Step 2 To view node alarm history:

a. In node view, click the History > Session tabs to view the alarms and conditions (events) raised 
during the current session.

b. Click the History > Node tabs. 

Cond The error message/alarm name; these names are alphabetically defined in the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Description Description of the alarm.

Table 7-1 Alarm Column Descriptions (continued)

Column Information Recorded

Table 7-2 Color Codes for Alarms and Condition Severities

Color Description

Red Raised Critical (CR) alarm

Orange Raised Major (MJ) alarm

Yellow Raised Minor (MN) alarm

Magenta (pink) Raised Not Alarmed (NA) condition

Blue Raised Not Reported (NR) condition

White Cleared (C) alarm or condition

Purpose This task is used to view past cleared and uncleared ONS 15454 alarm 
messages at the card, node, or network level. This task is useful for 
troubleshooting configuration, traffic, or connectivity issues that are 
indicated by alarms.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 
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DLP-G116 View Alarm or Event History
If you check the Alarms check box, the node’s alarm history appears. If you check the Events check 
box, the node’s Not Alarmed and transient event history appears. If you check both check boxes, you 
will retrieve node history for alarms and events. 

c. Click Retrieve to view all available messages for the History > Node tabs.

Note Alarms can be unreported when they are filtered out of the display using the Filter button in 
either tab. See the “DLP-G126 Enable Alarm Filtering” task on page 7-29 for information.

Tip Double-click an alarm in the alarm table or an event (condition) message in the history table to 
display the view that corresponds to the alarm message. For example, double-clicking a card 
alarm takes you to card view. In network view, double-clicking a node alarm takes you to node 
view.

Step 3 To view network alarm history, from node view:

a. From the View menu choose Go to Network View.

b. Click the History tab.

Alarms and conditions (events) raised during the current session appear.

Step 4 To view card alarm history, from node view:

a. From the View menu choose Go to Previous View.

b. Double-click a card on the shelf graphic to open the card-level view.

Note TCC2 cards do not have a card view.

c. Click the History > Session tab to view the alarm messages raised during the current session.

d. Click the History > Card tab to retrieve all available alarm messages for the card and click 
Retrieve.

If you check the Alarms check box, the node’s alarm history appears. If you check the Events check 
box, the node’s Not Alarmed and transient event history appears. If you check both check boxes, you 
will retrieve node history for alarms and events. 

Note The ONS 15454 can store up to 640 critical alarm messages, 640 major alarm messages, 
640 minor alarm messages, and 640 condition messages. When any of these limits is 
reached, the ONS 15454 discards the oldest events in that category.

Raised and cleared alarm messages (and events, if selected) appear.

Step 5 Return to your originating procedure (NTP).
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DLP-G117 Change the Maximum Number of Session Entries for Alarm History

Step 1 From the Edit menu, choose Preferences.

The CTC Preferences dialog box appears (Figure 7-4).

Figure 7-4 CTC Preferences Dialog Box

Step 2 Click the up or down arrow buttons next to the Maximum History Entries field to change the entry.

Step 3 Click Apply and OK.

Note Setting the Maximum History Entries value to the high end of the range uses more CTC memory 
and could impair CTC performance.

Note This task changes the maximum history entries recorded for CTC sessions. It does not affect the 
maximum number of history entries viewable for a network, node, or card.

Purpose This task changes the maximum number of session entries included in the 
alarm history. Use this task to expand the history list to save information 
for future reference or troubleshooting.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning or higher 
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Step 4 Return to your originating procedure (NTP).

DLP-G118 Display Alarms and Conditions Using Time Zone

Step 1 From the Edit menu, choose Preferences.

The CTC Preferences dialog box appears (Figure 7-4 on page 7-10).

Step 2 Check the Display Events Using Each Node’s Timezone check box. The Apply button is enabled.

Step 3 Click Apply and OK.

Step 4 Return to your originating procedure (NTP).

DLP-G119 Synchronize Alarms

Step 1 At the card, node, or network view, click the Alarms tab.

Step 2 Click Synchronize.

This button causes CTC to retrieve a current alarm summary for the card, node, or network. This step is 
optional because CTC updates the Alarms window automatically as raise/clear messages arrive from the 
node. 

Note Alarms that have been raised during the session will have a check mark in the Alarms window 
New column. When you click Synchronize, the check mark disappears.

Purpose This task changes the timestamp for events to the timezone of the ONS 
node reporting the alarm. By default, the events timestamp is set to the 
timezone for the CTC workstation.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Provisioning or higher 

Purpose This task is used to view ONS 15454 events at the card, node, or network 
level and to refresh the alarm listing so that you can check for new and 
cleared alarms and conditions.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve
7-11
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

November 2004



Chapter 7      Manage Alarms
DLP-G120 View Conditions
Step 3 Return to your originating procedure (NTP).

DLP-G120 View Conditions

Step 1 From the card, node, or network view, click the Conditions tab.

Step 2 Click Retrieve (Figure 7-5).

The Retrieve button requests the current set of fault conditions from the node, card, or network. The 
window is not updated when events change on the node. You must click Retrieve to see any changes.

Figure 7-5 Node View Conditions Window

Conditions include all fault conditions raised on the node, whether or not they are reported.

Purpose This task is used to view conditions (events with a Not Reported [NR] 
severity) at the card, node, or network level. Conditions give you a clear 
record of changes or events that do not result in alarms.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
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Note Alarms can be unreported when they are filtered out of the display. See the “DLP-G126 Enable 
Alarm Filtering” task on page 7-29 for information.

Events that are reported as Major (MJ), Minor (MN), or Critical (CR) severities are alarms. Events that 
are reported as Not-Alarmed (NA) are conditions. Conditions that are not reported at all are marked 
Not-Reported (NR) in the Conditions window severity column.

Conditions that have a default severity of Critical (CR), Major (MJ), Minor (MN), or Not-Alarmed (NA) 
but are not reported due to exclusion or suppression are shown as NR in the Conditions window. 

Note For more information about alarm suppression, see the “DLP-G129 Suppress Alarm Reporting” 
task on page 7-33.

Current conditions are shown with the severity chosen in the alarm profile, if used. For more information 
about alarm profiles, see the “NTP-G68 Create, Download, and Assign Alarm Severity Profiles” 
procedure on page 7-17.

Note When a port is placed in the Out-of-Service and Management, Maintenance 
(OOS-MA,MT) (ANSI) or Locked-enabled, maintenance (ETSI) service state, it raises an 
Alarms Suppressed for Maintenance (AS-MT) condition. For information about alarm and 
condition troubleshooting, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Step 3 If you want to apply exclusion rules, check the Exclude Same Root Cause check box at the node or 
network view, but do not check the Exclude Same Root Cause check box in card view.

An exclusion rule eliminates all lower-level alarms or conditions that originate from the same cause. For 
example, a fiber break may cause an LOS alarm, an AIS condition, and an SF condition. If you check 
the Exclude Same Root Cause check box, only the LOS alarm will appear. According to Telcordia, 
exclusion rules apply to a query of “all conditions from a node.”

Step 4 Return to your originating procedure (NTP).

NTP-G65 Delete Cleared Alarms from Display

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Purpose Use this procedure to delete Cleared (C) status alarms from the Alarms 
window or transient messages from the CTC History window.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
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Step 2 To delete cleared node-level alarms:

a. In the node view, click the Alarms tab.

b. Click Delete Cleared Alarms.

• If the Autodelete Cleared Alarms check box is checked, an alarm disappears from the window when 
it is cleared.

• If the Autodelete Cleared Alarms check box is not checked, an alarm remains in the window when 
it is cleared. The alarm appears white in the window and has a Clear (CL) severity. The alarm can 
be removed by clicking the Delete Cleared Alarms button.

This action removes any cleared ONS 15454 alarms from the Alarms tab. The rows of cleared alarms 
turn white and have a C in their status (ST) column.

Step 3 To delete cleared card-level alarms:

a. In node view, double-click the card graphic for the card you want to open.

b. Click the Alarms tab and then click Delete Cleared Alarms, referring to the note in 
Step 2.

Step 4 To delete cleared network-level alarms:

a. In node view, click View > Go to Network View.

b. Click the Alarms tab and then click Delete Cleared Alarms, referring to the note in 
Step 2.

Step 5 To remove the transient messages from the History window, click Delete Cleared Alarms. Transient 
messages are single messages, not raise-and-clear pairs (that is, they do not have companion messages 
stating they are cleared). 

Stop. You have completed this procedure.

NTP-G66 View Alarm-Affected Circuits

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 In the network, node, or card view, click the Alarms tab or Conditions tab and then right-click anywhere 
in the row of an active alarm or condition.

Purpose Use this procedure to view all Optical Channel Network Connections 
(OCHNCs) and ONS 15454 circuits, if any, that are affected by an alarm 
or condition.

Tools/Equipment None

Prerequisite Procedures NTP-G64 View Alarms, History, Events, and Conditions, page 7-5

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 
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Note The node view is the default, but you can also navigate to the Alarms tab in the network view or 
card view to perform Step 2.

The Select Affected Circuit option appears on the shortcut menu (Figure 7-6).

Figure 7-6 Select Affected Circuits Option 

Step 3 Left-click or right-click Select Affected Circuits.

The Circuits window appears with the affected Optical Channel Network Connection (OCHNC) 
highlighted (Figure 7-7).
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Figure 7-7 Viewing Alarm-Affected Circuits
.

Stop. You have completed this procedure.

NTP-G67 View Alarm Counts on the LCD for a Node, Slot, or Port

Step 1 If you want to view the entire alarm summary for the node, press either the Slot button or Port button 
on the LCD panel until “Node” appears on the LCD. You will also see the direction, “Status=Alm Ct.” 
This means that if you press the Status button at this time, as directed in Step 2, you will see an alarm 
count for the node.

Step 2 Press the Status button to see a summary of alarms and severities for the node. You will see a message 
similar to “Alm CT: 2: MJ:2 MN:2,” meaning that there are two critical alarms, two major alarms, and 
two minor alarms.

Step 3 If you want to see alarm counts for a particular slot, such as the alarms for an OC-3 card in Slot 2, press 
the Slot button until you see “Slot-3” on the LCD. You will see the direction, “Status=Alm Ct.”

Purpose Use this procedure to view an alarm summary for a node, slot, or port 
without using CTC.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Step 4 Press the Status button to see a summary of alarms and severities against the slot. For example, you 
might see “Slot-3 Alm CT:0 MJ:1 MN:2.” This means that there are no critical alarms, one major alarm, 
and two minor alarms against the slot.

Step 5 If you want to view the alarms against a port on the card, such as Port 3 of the OC-3 card you viewed 
previously, press the Port button until you see “Port-3 Status=Alm Ct.”

Step 6 Press Status to view alarm count against the port. You will see a message similar to “Port-3 Alm CT:0 
MJ:1 MN:0.” This means that there is one major alarm against this port.

Figure 7-8 shows the shelf LCD panel.

Figure 7-8 Shelf LCD Panel

To return to the previous view from the Port screen, continue to press Port until the display cycles 
through all the ports on the slot. 

To return to the node menu from the Slot screen, press Slot until you cycle through all the slots and see 
“Node.”

If you do not press any buttons, the LCD will return to its default display with the node name. However, 
if you did not cycle through the options to return to the node status, you will see the slot or port where 
you last checked status.

Note A blank LCD results when the fuse on the alarm interface panel (AIP) board has blown. If this 
occurs, log into http://www.cisco.com/tac for more information or log into 
http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml to obtain a directory of 
Cisco TAC toll-free numbers for your country.

Stop. You have completed this procedure.

NTP-G68 Create, Download, and Assign Alarm Severity Profiles

FAN FAIL

Slot

8/18/03
04.06-002L-10 

24˚C

97
75

8CRIT MAJ MIN

Status Port

Purpose Use this procedure to create a customized alarm profile at the network, 
node, or card level. This procedure also provides links to tasks that 
describe how to assign custom severities individually to each port, card, or 
node, and to delete alarm profiles.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to create an alarm 
profile. If you are already logged in, continue with Step 2 to create, clone or modify an alarm profile, or 
go to Step 3 to download an alarm profile.

Step 2 Complete the “DLP-G121 Create a New or Cloned Alarm Severity Profile” task on page 7-18. This task 
clones a current alarm profile, renames the profile, and customizes the new profile.

Step 3 Complete the “DLP-G122 Download an Alarm Severity Profile” task on page 7-22. This task downloads 
an alarm severity profile from a CD or a node.

Note After storing a created or downloaded alarm profile, you must go to the node (either by logging 
into it or clicking on it from the network view) and activate the profile by applying it to the shelf, 
one or more cards, or one or more ports. 

Step 4 As necessary, complete the “DLP-G123 Apply Alarm Profiles to Ports” task on page 7-23 or the 
“DLP-G124 Apply Alarm Profiles to Cards and Nodes” task on page 7-26.

Step 5 As necessary, complete the “DLP-G125 Delete Alarm Severity Profiles” task on page 7-27.

Stop. You have completed this procedure.

DLP-G121 Create a New or Cloned Alarm Severity Profile

Step 1 To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Step 2 To access the profile editor from node view, click the Provisioning > Alarm Profiles > 
Alarm Profile Editor tabs. 

Step 3 To access the profile editor from a card view, click the following tabs:

• If the card is an MXP, MXPP, TXP, TXPP, or WSS card, click the Provisioning > Alarm Profiles 
> Alarm Profile Editor tabs.

• If the card is an OSC-CSM card, click the Provisioning > OC3 Line > Alarm Profiles > 
Alarm Profile Editor tabs or Provisioning > Optical Line > Alarm Profiles > 
Alarm Profile Editor tabs.

• If the card is a 32MUX-O or 32DMX-O card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profile Editor tabs or the Provisioning > Optical Chn > 
Alarm Profiles > Alarm Profile Editor tabs.

Purpose This task creates a custom severity profile or clones and modifies the 
default severity profile.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• If the card is a 4MD card, click the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profile Editor tabs or the Provisioning > Optical Band > Alarm Profiles > 
Alarm Profile Editor tabs.

• If the card is an OPT-PRE or OPT-BST card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profile Editor tabs or the Provisioning > Opt. Ampli. Line > 
Alarm Profiles > Alarm Profile Editor tabs.

• If the card is an AD-1C, AD-2C, or AD-4C card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profile Editor tabs or the Provisioning > Optical Chn > 
Alarm Profiles > Alarm Profile Editor tabs.

• If the card is an AD-1B or AD-4B card, click the Provisioning > Optical Line > Alarm Profiles > 
Alarm Profile Editor tabs or the Provisioning > Optical Band > Alarm Profiles > 
Alarm Profile Editor tabs.

Step 4 If you want to create a new profile based on the default profile in use, click New. Continue with Step 10.

Step 5 If you want to create a profile using an existing profile located on the node, click Load and From Node 
in the Load Profiles dialog box.

a. Click the node name you are logged into in the Node Names list.

b. Click the name of an existing profile in the Profile Names list, such as Default. Continue with 
Step 7.

Step 6 If you want to create a profile using an existing profile located in a file that is stored locally or on a 
network drive, click From File in the Load Profiles dialog box.

a. Click Browse.

b. Navigate to the file location in the Open dialog box.

c. Click Open.

Note The Default alarm profile list contains alarm and condition severities that correspond when 
applicable to default values established in Telcordia GR-253-CORE.

Note All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to 
Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474. 

Step 7 Click OK.

The alarm severity profile appears in the Alarm Profiles window.

Note The alarm profile list contains a master list of alarms that is used for a mixed node network. 
Some of these alarms might not be used in all ONS nodes.

Step 8 Right-click anywhere in the profile column to view the profile editing shortcut menu. (Refer to Step 11 
for further information about the Default profile.)

Step 9 Click Clone in the shortcut menu.

Tip To see the full list of profiles, including those available for loading or cloning, click Available. 
You must load a profile before you can clone it. 
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Step 10 In the New Profile or Clone Profile dialog box, enter a name in the New Profile Name field.

Profile names must be unique. If you try to import or name a profile that has the same name as another 
profile, CTC adds a suffix to create a new name. Long file names are supported.

Step 11 Click OK.

A new alarm profile (named in Step 10) is created. This profile duplicates the default profile severities 
and appears at the right of the previous profile column in the Alarm Profiles window. You can select it 
and drag it to a different position.

Note Up to 10 profiles, including the two reserved profiles, Inherited and Default, can be stored in 
CTC.

The Default profile sets severities to standard Telcordia GR-253-CORE settings. If an alarm has an 
Inherited profile, it inherits (copies) its severity from the same alarm's severity at the higher level. For 
example, if you choose the Inherited profile from the network view, the severities at the lower levels 
(node, card, and port) will be copied from this selection. A card with an Inherited alarm profile copies 
the severities used by the node that contains the card. (If you are creating profiles, you can apply these 
separately at any level. To do this, refer to the “DLP-G124 Apply Alarm Profiles to Cards and Nodes” 
task on page 7-26.)

Step 12 Modify (customize) the new alarm profile:

a. In the new alarm profile column, click the alarm severity you want to change in the custom profile.

b. Choose a severity from the drop-down list.

c. Repeat Steps a and b for each severity you want to customize. Refer to the following guidelines 
when you view the alarms or conditions after making modifications:

• All Critical (CR) or Major (MJ) default or user-defined severity settings are demoted to 
Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474. 

• Default severities are used for all alarms and conditions until you create and apply a new profile. 

• Changing a severity to inherited (I) or unset (U) does not change the severity of the alarm.

Step 13 After you have customized the new alarm profile, right-click the profile column to highlight it.

Step 14 Click Store.

Step 15 In the Store Profiles dialog box, click To Node(s) and go to Step a or click To File and go to Step b 
(Figure 7-9).
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Figure 7-9 Store Profiles Dialog Box

a. Choose the node where you want to save the profile:

• If you want to save the profile to only one node, click the node in the Node Names list.

• If you want to save the profile to all nodes, click Select All.

• If you do not want to save the profile to any nodes, click Select None.

• If you want to update alarm profile information, click (Synchronize).

b. Save the profile:

• Click Browse and navigate to the profile save location.

• Enter a name in the File name field.

• Click Select to choose this name and location.

Note Long file names are supported. CTC supplies a suffix of *.pfl to stored files.

• Click OK to store the profile.

Note Click the Hide Identical Rows check box to configure the Alarm Profiles window to 
view rows with dissimilar severities.

Note Click the Hide Reference Values check box to configure the Alarm Profiles window to 
view severities that do not match the Default profile.

Note Click the Only show service-affecting severities check box to configure the 
Alarm Profiles window not to display Minor and some Major alarms that will not affect 
service.
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Step 16 Return to your originating procedure (NTP).

DLP-G122 Download an Alarm Severity Profile

Step 1 To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Step 2 To access the profile editor from node view, click the Provisioning > Alarm Profiles > 
Alarm Profile Editor tabs.

Step 3 To access the profile editor from a card view, click the following tabs:

• If the card is an MXP, MXPP, TXP, TXPP, or WSS card, click the Provisioning > Alarm Profiles 
> Alarm Profile Editor tabs.

• If the card is an OSC-CSM card, click the Provisioning > OC3 Line > Alarm Profiles > 
Alarm Profile Editor tabs or the Provisioning > Optical Line > Alarm Profiles > 
Alarm Profile Editor tabs.

• If the card is a 32MUX-O or 32DMX-O card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profile Editor tabs or the Provisioning > Optical Chn > 
Alarm Profiles > Alarm Profile Editor tabs.

• If the card is a 4MD card, click the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profile Editor tabs or the Provisioning > Optical Band > Alarm Profiles > 
Alarm Profile Editor tabs.

• If the card is an OPT-PRE or OPT-BST card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profile Editor tabs or the Provisioning > Opt. Ampli. Line > 
Alarm Profiles > Alarm Profile Editor tabs.

• If the card is an AD-1C, AD-2C, or AD-4C card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profile Editor tabs or the Provisioning > Optical Chn > 
Alarm Profiles > Alarm Profile Editor tabs.

• If the card is an AD-1B or AD-4B card, click the Provisioning > Optical Line > Alarm Profiles > 
Alarm Profile Editor tabs or the Provisioning > Optical Band > Alarm Profiles > 
Alarm Profile Editor tabs.

Step 4 Click Load.

Step 5 If you want to download a profile that exists on the node, click From Node in the Load Profiles 
dialog box.

a. Click the node name you are logged into in the Node Names list.

b. Click the name of the profile in the Profile Names list, such as Default.

Purpose This task downloads a custom alarm severity profile from a network-drive 
accessible CD-ROM, floppy disk, or hard disk location.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 6 If you want to download a profile that is stored locally or on a network drive, click From File in the 
Load Profile dialog box.

a. Click Browse.

b. Navigate to the file location in the Open dialog box.

c. Click Open.

Note The Default alarm profile list contains alarm and condition severities that correspond when 
applicable to default values established in Telcordia GR-253-CORE.

Note All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to 
Minor (MN) in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474. 

Step 7 Click OK.

The downloaded profile appears at the right side of the Alarm Profiles window.

Step 8 Right-click anywhere in the downloaded profile column to view the profile editing shortcut menu.

Step 9 Click Store.

Step 10 In the Store Profiles dialog box, click To Node(s).

a. Choose the nodes where you want to save the profile:

• If you want to save the profile to only one node, click the node in the Node Names list.

• If you want to save the profile to all nodes, click Select All.

• If you do not want to save the profile to any nodes, click Select None.

• If you want to update alarm profile information, click Synchronize.

b. Click OK.

Step 11 Return to your originating procedure (NTP).

DLP-G123 Apply Alarm Profiles to Ports

Step 1 In the node view, double-click a card to open the card view.

Purpose This task applies a custom or default alarm severity profile to a port or 
ports.

Tools/Equipment None

Prerequisite Procedures DLP-G121 Create a New or Cloned Alarm Severity Profile, page 7-18

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note You can also apply alarm profiles to cards using the “DLP-G124 Apply Alarm Profiles to Cards 
and Nodes” task on page 7-26.

Note The card view is not available for the TCC2 card.

Step 2 Depending on which card you want to apply the profile to, click the following tabs:

• If the card is an MXP, MXPP, TXP, TXPP, or WSS card, click the Provisioning > Alarm Profiles 
> Alarm Profile Editor tabs.

• If the card is an OSC-CSM card, click the Provisioning > OC3 Line > Alarm Profiles > 
Alarm Profiles tabs or the Provisioning > Optical Line > Alarm Profiles > Alarm Profiles tabs.

• If the card is a 32MUX-O or 32DMX-O card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is a 4MD card, click the Provisioning > Optical Chn > Alarm Profiles > Alarm Profiles 
tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profiles tabs.

• If the card is an OPT-PRE or OPT-BST card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Opt. Ampli. Line > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is an AD-1C, AD-2C, or AD-4C card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is an AD-1B or AD-4B card, click the Provisioning > Optical Line > Alarm Profiles > 
Alarm Profiles tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profiles tabs.

Figure 7-10 shows the alarm profile of Ethernet card ports. CTC shows Parent Card Profile: Inherited.
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Figure 7-10 AD-1C Card Alarm Profile

Go to Step 3 to apply profiles to a port. Go to Step 4 to apply profiles to all ports on a card.

Step 3 To apply profiles on a port basis:

a. In card view, click the port row in the Profile column.

b. Choose the new profile from the drop-down list.

c. Click Apply.

Step 4 To apply profiles to all ports on a card:

a. In card view, click the Force all ports to profile drop-down arrow at the bottom of the window.

b. Choose the new profile from the drop-down list.

c. Click Force (still need to “Apply”).

d. Click Apply.

In node view the Port Level Profiles column indicates port-level profiles with a notation such as 
“exist (1)” (Figure 7-11 on page 7-26). 

Step 5 To reapply a previous alarm profile after you have applied a new one, select the previous profile and click 
Apply again.

Step 6 Return to your originating procedure (NTP).
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DLP-G124 Apply Alarm Profiles to Cards and Nodes 

Step 1 In node view, click the Provisioning > Alarm Profiles > Alarm Behavior tab (Figure 7-11).

Figure 7-11 Node View Alarm Profile

Step 2 To apply profiles to a card:

a. Click a selection from the Profile column for the card.

b. Choose the new profile from the drop-down list.

c. Click Apply.

Step 3 To apply the profile to an entire node:

a. Click the Node Profile drop-down arrow at the bottom of the window (Figure 7-11).

b. Choose the new alarm profile from the drop-down list.

c. Click Apply.

Step 4 To reapply a previous alarm profile after you have applied a new one, select the previous profile and click 
Apply again.

Purpose This task applies a custom or default alarm profile to cards or nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G121 Create a New or Cloned Alarm Severity Profile, page 7-18

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Return to your originating procedure (NTP).

DLP-G125 Delete Alarm Severity Profiles

Step 1 To access the alarm profile editor from network view, click the Provisioning > Alarm Profiles tabs.

Step 2 To access the profile editor from node view, click the Provisioning > Alarm Profiles > Alarm Profile 
Editor tabs.

Step 3 To access the profile editor from a card view, click the following tabs:

• If the card is an MXP, MXPP, TXP, TXPP, or WSS card, click the Provisioning > Alarm Profiles 
> Alarm Profile Editor tabs.

• If the card is an OSC-CSM card, click the Provisioning > OC3 Line > Alarm Profiles > Alarm 
Profile Editor tabs or Provisioning > Optical Line > Alarm Profiles > Alarm Profile Editor tabs.

• If the card is a 32MUX-O or 32DMX-O card, click the Provisioning > Optical Line > Alarm 
Profiles >Alarm Profile Editor tabs or the Provisioning > Optical Chn > Alarm Profiles > Alarm 
Profile Editor tabs.

• If the card is a 4MD card, click the Provisioning > Optical Chn > Alarm Profiles > Alarm Profile 
Editor tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profile Editor tabs.

• If the card is an OPT-PRE or OPT-BST card, click the Provisioning > Optical Line > Alarm 
Profiles > Alarm Profile Editor tabs or the Provisioning > Opt. Ampli. Line > Alarm Profiles > 
Alarm Profile Editor tabs.

• If the card is an AD-1C, AD-2C, or AD-4C card, click the Provisioning > Optical Line > Alarm 
Profiles > Alarm Profile Editor tabs or the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profile Editor tabs.

• If the card is an AD-1B or AD-4B card, click the Provisioning > Optical Line > Alarm Profiles > 
Alarm Profile Editor tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profile 
Editor tabs.

Step 4 Click the profile you are deleting to select it.

Step 5 Click Delete.

The Select Node/Profile Combination for Delete dialog box appears (Figure 7-12).

Purpose This task deletes a custom or default alarm severity profile.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 7-12 Select Node/Profile Combination For Delete Dialog Box

Note You cannot delete the Inherited or Default alarm profiles.

Note A previously created alarm profile cannot be deleted unless it has been stored on the node. If the 
profile is visible on the Alarm Profiles tab but is not listed in the Select Node/Profile 
Combinations to Delete dialog box, continue with Step 10.

Step 6 Click the node names in the Node Names list to highlight the profile location.

Tip If you hold the Shift key down, you can select consecutive node names. If you hold the Ctrl key 
down, you can select any combination of nodes.

Step 7 Click the profile names you want to delete in the Profile Names list.

Step 8 Click OK.

Step 9 Click Yes in the Delete Alarm Profile dialog box.

Note If you delete a profile from a node, it still appears in the network view
Provisioning > Alarm Profile Editor window unless you remove it using the following step.

Step 10 To remove the alarm profile from the window, right-click the column of the profile you deleted and 
choose Remove from the shortcut menu.

Note If a node and profile combination is selected but does not exist, a warning appears: “One or more 
of the profiles selected do not exist on one or more of the node(s) selected.” For example, if node 
A has only profile 1 stored and the user tries to delete both profile 1 and profile 2 from node A, 
this warning appears. However, the operation still removes profile 1 from node A.

Note The Default and Inherited special profiles cannot be deleted and do not appear in the Select 
Node/Profile Combination for Delete Window.
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Step 11 Return to your originating procedure (NTP).

NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to enable alarm 
severity filtering. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G126 Enable Alarm Filtering” task on page 7-29. This task enables 
alarm filtering at the card, node, and network views for all nodes in the network. Alarm filtering can be 
enabled for alarms, conditions, or events.

Step 3 As needed, complete the “DLP-G127 Modify Alarm, Condition, and History Filtering Parameters” task 
on page 7-30 to modify the alarm filtering for network nodes to show or hide particular alarms or 
conditions.

Step 4 As needed, complete the “DLP-G128 Disable Alarm Filtering” task on page 7-32 to disable alarm profile 
filtering for all network nodes.

Stop. You have completed this procedure.

DLP-G126 Enable Alarm Filtering

Step 1 At the node, network, or card view, click the Alarms tab.

Step 2 Click the Filter tool on the left side of the bottom toolbar.

Alarm filtering is enabled if the tool is selected and disabled if the tool is raised (not selected).

Purpose Use this procedure to start, change, or stop alarm filtering for one or more 
severities in the Alarms, Conditions, and History windows in all network 
nodes.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher 

Purpose This task enables alarm filtering for alarms, conditions, or event history in 
all network nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 
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Alarm filtering will be enabled in the card, node, and network views of the Alarms tab at the node and 
for all other nodes in the network. If, for example, the Alarm Filter tool is enabled in the Alarms tab of 
the node view at one node, the Alarms tab in the network view and card view of that node will also show 
the tool enabled. All other nodes in the network will also have the tool enabled. 

If you filter an alarm in card view, the alarm will still be displayed in node view. In this view, the card 
will display the color of the highest-level alarm. The alarm is also shown for the node in the network 
view.

Step 3 If you want alarm filtering enabled when you view conditions, repeat Steps 1 and 2 using the Conditions 
window.

Step 4 If you want alarm filtering enabled when you view alarm history, repeat Steps 1 and 2 using the History 
window.

Step 5 Return to your originating procedure (NTP).

DLP-G127 Modify Alarm, Condition, and History Filtering Parameters

Step 1 At the node, network, or card view, click the Alarms tab, Conditions tab, or History tab.

Step 2 Click the Filter button on the left side of the bottom toolbar.

The filter dialog box appears, displaying the General tab. Figure 7-13 shows the Alarm Filter dialog box; 
the Conditions and History tabs have similar dialog boxes.

Purpose This task changes alarm and condition reporting in all network nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G126 Enable Alarm Filtering, page 7-29

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 
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Figure 7-13 Alarm Filter Dialog Box General Tab

In the General tab Show Severity box, you can choose which alarm severities will show through the 
alarm filter and provision a time period during which filtered alarms show through the filter. To change 
the alarm severities shown in the filter, go to Step 3. To change the time period filter for the alarms, go 
to Step 4.

Step 3 In the Show Severity area, click the check boxes for the severities [Critical (CR), Major (MJ), Minor 
(MN), or Not-Alarmed (NA)] you want to be reported at the network level. Leave severity check boxes 
deselected (unchecked) to prevent those severities from appearing.

When alarm filtering is disabled, all alarms show.

Step 4 In the Time area, click the Show alarms between time limits check box to enable it. Click the up and 
down arrows in the From Date, To Date, and Time fields to modify what period of alarms are shown.

To modify filter parameters for conditions, continue with Step 5. If you do not need to modify them, 
continue with Step 6.

Step 5 Click the filter dialog box Conditions tab (Figure 7-14).

Figure 7-14 Alarm Filter Dialog Box Conditions Tab
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When filtering is enabled, conditions in the Show list are visible and conditions in the Hide list are 
invisible.

• To move conditions individually from the Show list to the Hide list, click the > button.

• To move conditions individually from the Hide list to the Show list, click the < button.

• To move conditions collectively from the Show list to the Hide list, click the >> button.

• To move conditions collectively from the Hide list to the Show list, click the << button.

Note Conditions include alarms.

Step 6 Click Apply and OK.

Alarm and condition filtering parameters are enforced when alarm filtering is enabled (see the 
“DLP-G126 Enable Alarm Filtering” task on page 7-29), and are not enforced when alarm filtering is 
disabled (see the “DLP-G128 Disable Alarm Filtering” task on page 7-32).

Step 7 Return to your originating procedure (NTP).

DLP-G128 Disable Alarm Filtering

Step 1 At the node, network, or card view, click the Alarms tab.

Step 2 Click the Filter tool on the right side of the bottom toolbar.

Alarm filtering is enabled if the tool is indented and disabled if the tool is raised (not selected).

Step 3 If you want alarm filtering disabled when you view conditions, click the Conditions tab and click the 
Filter tool.

Step 4 If you want alarm filtering disabled when you view alarm history, click the History tab and click the 
Filter tool.

Step 5 Return to your originating procedure (NTP).

Purpose This task turns off specialized alarm filtering in all network nodes so that 
all severities are reported in CTC. 

Tools/Equipment None

Prerequisite Procedures DLP-G126 Enable Alarm Filtering, page 7-29

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed
Onsite/Remote Onsite or remote
Security Level Retrieve or higher 
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NTP-G70 Suppress Alarms or Discontinue Alarm Suppression

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “DLP-G129 Suppress Alarm Reporting” task on page 7-33 to enable the node to send 
autonomous messages that clear specific raised alarms and cause suppressed alarms to appear in the 
Conditions window.

Note Suppressing one or more alarms prevents them from appearing in Alarm or History windows or 
in any other clients. The suppress command causes CTC to display them in the Conditions 
window with their severity, their severity color code, and service-affecting status.

Step 3 Complete the “DLP-G130 Discontinue Alarm Suppression” task on page 7-35 to discontinue alarm 
suppression and resume normal alarm reporting.

Stop. You have completed this procedure.

DLP-G129 Suppress Alarm Reporting

Caution If multiple CTC/TL1 sessions are open, suppressing alarms in one session suppresses the alarms in all 
other open sessions.

Purpose Use this procedure to prevent alarms from being reported for a port, card, 
or node in circumstances when an alarm or condition is known to exist but 
you do not want to include it in the display. This procedure also provides a 
link to a task that explains how to resume normal alarm reporting by 
discontinuing the suppression.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 

Purpose This task suppresses the reporting of ONS 15454 alarms at the node, card, 
or port level.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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Note Alarm suppression at the node level does not supersede alarm suppression at the card or port level. 
Suppression can exist independently for all three entities, and each entity will raise separate alarms 
suppressed by the user command (AS-CMD) alarm.

Step 1 If you are in node view, click the Provisioning > Alarm Profiles > Alarm Profiles tabs.

Step 2 To suppress alarms for the entire node:

a. Check the Suppress Alarms check box.

b. Click Apply.

All raised alarms for the node will change color to white in the Alarms window and their status will 
change to cleared. After suppressing alarms, clicking Synchronize in the Alarms window will remove 
cleared alarms from the window. However, an AS-CMD alarm will show in node or card view to indicate 
that node-level alarms were suppressed, and the word System will appear in the Object column.

Note The only way to suppress BITS, power source, or system alarms is to suppress alarms for the 
entire node. These cannot be suppressed separately.

Step 3 To suppress alarms for individual cards:

a. Locate the card row (using the Location column for the slot number or the Eqpt Type column for the 
equipment name).

b. Check the Suppress Alarms column check box on that row.

Alarms that directly apply to this card will change appearance as described in Step 2. For example, if 
you suppressed raised alarms for an OC-48 card in Slot 16, raised alarms for this card will change in 
node or card view. The AS-CMD alarm will show the slot number in the Object number. For example, 
if you suppressed alarms for a Slot 16 OC-48 card, the AS-CMD object will be “SLOT-16.”

Click Apply.

Step 4 To suppress alarms for individual card ports, double-click the card in node view.

Step 5 Depending on which card ports you want to suppress alarm reporting on, click the following tabs:

• If the card is an MXP, MXPP, TXP, TXPP, or WSS card, click the Provisioning > Alarm Profiles 
> Alarm Profile Editor tabs.

• If the card is an OSC-CSM card, click the Provisioning > OC3 Line > Alarm Profiles > 
Alarm Profiles tabs or the Provisioning > Optical Line > Alarm Profiles > Alarm Profiles tabs.

• If the card is a 32MUX-O or 32DMX-O card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is a 4MD card, click the Provisioning > Optical Chn > Alarm Profiles > Alarm Profiles 
tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profiles tabs.

• If the card is an OPT-PRE or OPT-BST card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Opt. Ampli. Line > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is an AD-1C, AD-2C, or AD-4C card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profiles tabs.
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• If the card is an AD-1B or AD-4B card, click the Provisioning > Optical Line > Alarm Profiles > 
Alarm Profiles tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profiles tabs.

Step 6 Check the Suppress Alarms column check box for the port row where you want to suppress alarms 
(Figure 7-10 on page 7-25).

Step 7 Click Apply.

Alarms that apply directly to this port will change appearance as described in Step 2. (However, alarms 
raised on the entire card will remain raised.) A raised AS-CMD alarm that shows the port as its object 
will appear in either alarm window. For example, if you suppressed alarms for Port 1 on the Slot 16 
OC-48 card, the alarm object will show “FAC-16-1.”

Step 8 Return to your originating procedure (NTP).

DLP-G130 Discontinue Alarm Suppression

Caution If multiple CTC sessions are open, discontinuing suppression in one session will discontinue 
suppression in all other open sessions.

Step 1 To discontinue alarm suppression for the entire node:

a. In node view, click the Provisioning > Alarm Profiles > Alarm Profiles tab.

b. Uncheck the Suppress Alarms check box. 

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from 
the window using the Synchronize button.) The AS-CMD alarm with the System object will be cleared 
in all views.

Step 2 To discontinue alarm suppression for individual cards:

a. In the node view, click the Provisioning > Alarm Profiles > Alarm Profiles tabs.

b. Locate the card that was suppressed in the slot list.

c. Uncheck the Suppress Alarms column check box for that slot.

d. Click Apply.

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from 
the window using the Synchronize button.) The AS-CMD alarm with the slot object (for example, 
SLOT-16) will be cleared in all views.

Step 3 To discontinue alarm suppression for ports, click the following tabs:

Purpose This task discontinues alarm suppression and reenables alarm reporting on 
a port, card, or node.

Tools/Equipment None

Prerequisite Procedures DLP-G129 Suppress Alarm Reporting, page 7-33

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher 
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• If the card is an MXP, MXPP, TXP, TXPP, or WSS card, click the Provisioning > Alarm Profiles 
> Alarm Profile Editor tabs.

• If the card is an OSC-CSM card, click the Provisioning > OC3 Line > Alarm Profiles > 
Alarm Profiles tabs or the Provisioning > Optical Line > Alarm Profiles > Alarm Profiles tabs.

• If the card is a 32MUX-O or 32DMX-O card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is a 4MD card, click the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profiles tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profiles tabs.

• If the card is an OPT-PRE or OPT-BST card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Opt. Ampli. Line > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is an AD-1C, AD-2C, or AD-4C card, click the Provisioning > Optical Line > 
Alarm Profiles > Alarm Profiles tabs or the Provisioning > Optical Chn > Alarm Profiles > 
Alarm Profiles tabs.

• If the card is an AD-1B or AD-4B card, click the Provisioning > Optical Line > Alarm Profiles > 
Alarm Profiles tabs or the Provisioning > Optical Band > Alarm Profiles > Alarm Profiles tabs.

Step 4 Uncheck the Suppress Alarms check box for the port(s) you no longer want to suppress.

Step 5 Click Apply.

Suppressed alarms will reappear in the Alarms window. (They might have previously been cleared from 
the window using the Synchronize button.) The AS-CMD alarm with the port object (for example, 
FAC-16-1) will be cleared in all views.

Step 6 Return to your originating procedure (NTP). 

NTP-G71 Provision External Alarms and Controls on the Alarm 
Interface Controller Card

Note For information about the AIC external alarms and controls, virtual wire, and orderwire, refer to the 
“14.2.2 AIC Card” section on page 14-14 and the “20.7 External Alarms and Controls” section on 
page 20-13.

Purpose Use this procedure to create external (environmental) alarms and external 
controls on the Alarm Interface Controller (AIC). The AIC is not 
compatible with the ONS 15454 ETSI shelf. 

Tools/Equipment An AIC card must be installed in Slot 9.

Prerequisite Procedures DLP-G34 Install the AIC or AIC-I Card, page 1-76

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 Verify the backplane wiring. See the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin 
Connections” procedure on page 1-47 for information about the ONS 15454 ANSI backplane pins.

a. For external alarms, verify that the external-device relays are wired to the ENVIR ALARMS IN 
backplane pins.

b. For external controls, verify that the external relays are wired to the ENVIR ALARMS OUT 
backplane pins.

Step 2 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 4.

Step 3 In the node view, double-click the AIC card on the shelf graphic. The card view appears.

Step 4 If you are provisioning external alarms, click the Provisioning > External Alarms tab (Figure 7-15). If 
you are not provisioning external alarms, skip Steps 5 through 7 and continue with Step 8.

Figure 7-15 AIC Card External Alarms

Step 5 Complete the following fields for each external device wired to the ONS 15454 backplane:

• Enabled—Check the check box to activate the fields for the alarm input number.

• Alarm Type—Choose an alarm type from the drop-down list.

• Severity—Choose a severity from the drop-down list.

The severity you choose determines the external alarm’s severity in the Alarms and History tabs and 
determines whether the LEDs are activated. Critical (CR), Major (MJ), and Minor (MN) alarms 
activate the LEDs. Not Alarmed (NA) and Not Reported (NR) do not activate LEDs, but do report 
the information in CTC.

• Virtual Wire—Choose the virtual wire number in the drop-down list to assign the external device to 
a virtual wire. Otherwise, do not change the None default. For information about the AIC virtual 
wire, see the “20.7.3 Virtual Wires” section on page 20-14.

• Raised When—From the drop-down list, choose the contact condition (open or closed) that triggers 
the alarm.
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• Description—A default description is provided; enter a different description if needed.

Step 6 To provision up to four virtual wire inputs for external devices, complete Step 5 for each additional 
device.

Step 7 Click Apply.

Step 8 If you are provisioning external control outputs for external devices, click the External Controls subtab.

Step 9 Complete the following options for each external control wired to the ONS 15454 backplane:

• Enabled—Check this check box to activate the fields for the alarm input number.

• Control Type—Choose the control type from the drop-down list: air conditioner, engine, fan, 
generator, heat, light, sprinkler, or miscellaneous.

• Trigger Type—Choose a trigger type: a local minor, major, or critical alarm; a remote minor, major, 
or critical alarm; or a virtual wire activation.

• Description—Enter a description.

Step 10 To provision additional external controls, complete Steps 8 and 9 for each additional device.

Step 11 Click Apply.

Note If you provision an external alarm to raise upon an open contact before you physically connect 
to the ONS equipment, the alarm will raise until you do create the physical connection.

Note When you provision an external alarm, the alarm object is ENV-IN-nn. The variable nn refers to 
the external alarm’s number, regardless of the name you assign.

Note Environmental alarms that you create (and name) should be recorded locally for the NE. Both 
the Alarm name and resolution are node-specific.

Stop. You have completed this procedure.

NTP-G72 Provision External Alarms and Controls on the Alarm 
Interface Controller-International

Purpose Use this procedure to create external (environmental) alarms and external 
controls for the AIC-I card. 

Tools/Equipment An AIC-I card must be installed in Slot 9.

Prerequisite Procedures DLP-G34 Install the AIC or AIC-I Card, page 1-76

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Note On the ONS 15454 ANSI shelf, the AIC-I card alarm provides direct alarm contacts (external alarm 
inputs and external control outputs) routed through the backplane to wire-wrap pins accessible from the 
back of the shelf. If you install an Alarm Expansion Panel (AEP), the AIC-I alarm contacts cannot be 
used. Only the AEP alarm contacts can be used. For further information about the AEP, see “NTP-G9 
Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-44 and the “NTP-G11 Install an 
External Wire-Wrap Panel on the AEP (ANSI Only)” procedure on page 1-59. The ONS 15454 ETSI 
shelf is not compatible with the AEP.

Note For information about the AIC-I alarms, controls, and virtual wire, refer to the “14.2.3 AIC-I Card” 
section on page 14-17 and the “20.7.3 Virtual Wires” section on page 20-14.

Step 1 If you are using an ONS 15454 ANSI shelf, verify the backplane wiring. If you are using the AEP, see 
the “NTP-G9 Install the Alarm Expansion Panel (ANSI Only)” procedure on page 1-44. Otherwise, see 
the “NTP-G10 Attach Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on 
page 1-47 for information about the ONS 15454 backplane pins.

a. For external alarms, verify that the external device relays are wired to the ENVIR ALARMS IN 
backplane pins.

b. For external controls, verify that the external device relays are wired to the ENVIR ALARMS OUT 
backplane pins.

Step 2 If you are using an ONS 15454 ETSI shelf, verify the alarm contact wiring. See the “NTP-G10 Attach 
Wires to Alarm, Timing, LAN, and Craft Pin Connections” procedure on page 1-47 for information 
about the ONS 15454 SDH contacts.

a. For external alarms, verify that the external device relays are wired to the ENVIR ALARMS IN 
connector pins.

b. For external controls, verify the external device relays are wired to the ENVIR ALARMS OUT 
connector pins.

Step 3 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 4 In the node view, double-click the AIC-I card on the shelf graphic. The card view appears.

Step 5 Click the Provisioning > Card tabs. 

Step 6 In the Alarm Contacts area, click the Add Extension radio button if you are using the AEP. Clicking this 
option will choose the External Alarm input/output type and the AEP extension type; it will give you 
access to 16 external alarm contacts.

Step 7 If you did not click Add Extension, in the Input/Output area, choose either External Alarm or External 
Control. (External Alarm will limit your input/output options as explained in Step 6.) Choosing External 
Control will enable both external alarms and external controls. This will convert four of the external 
alarm contacts to external controls, leaving 12 available external control contacts. The extension type for 
both options is AEP.

Step 8 Click Apply.

Step 9 If you are provisioning external alarms, click the External Alarms tab (Figure 7-16). If you are not 
provisioning external alarms, skip Steps 10 through 12 and go to Step 13.
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Figure 7-16 Provisioning External Alarms on the AIC-I Card

Step 10 For external alarms, complete the following fields:

• Enabled—Check the check box to activate the fields for the alarm input number.

• Alarm Type—Choose an alarm type from the drop-down list.

• Severity—Choose a severity from the drop-down list.

The severity determines the alarm’s severity in the Alarms and History tabs and determines whether 
the LEDs are activated. Critical (CR), Major (MJ), and Minor (MN) alarms activate the LEDs. Not 
Alarmed (NA) and Not Reported (NR) do not activate LEDs, but do report the information in CTC.

• Virtual Wire—Choose the virtual wire number from the drop-down list to assign the external device 
to a virtual wire. Otherwise, do not change the None default. 

• Raised When—From the drop-down list, choose the contact condition (open or closed) that triggers 
the alarm.

• Description—A default description is provided; enter a different description if needed.

Step 11 To provision additional devices, complete Step 10 for each additional device.

Step 12 Click Apply.

Step 13 For external controls, click the External Controls tab and complete the following fields for each control 
wired to the ONS 15454 backplane (ANSI) or FMEC connector pins (ETSI):

• Enabled—Check this check box to activate the fields for the alarm input number.

• Control Type—Choose the control type from the drop-down list: air conditioner, engine, fan, 
generator, heat, light, sprinkler, or miscellaneous.

• Trigger Type—Choose a trigger type: a local minor, major, or critical alarm; a remote minor, major, 
or critical alarm; or a virtual wire activation.

• Description—Enter a description.

Step 14 To provision additional external controls, complete Step 13 for each device.
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Step 15 Click Apply.

Note When you provision an external alarm, the alarm object is ENV-IN-nn. The variable nn refers to 
the external alarm’s number, regardless of the name you assign.

Note Environmental alarms that you create (and name) should be recorded locally for the NE. Both 
the Alarm name and resolution are node-specific.

Stop. You have completed this procedure.
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September 2004
C H A P T E R 8

Monitor Performance

This chapter explains how to enable and view performance monitoring statistics for the 
Cisco ONS 15454. Performance monitoring (PM) parameters are used by service providers to gather, 
store, and set thresholds and report performance data for early detection of problems. For more PM 
information, details, and definitions, refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting 
Guide. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G73 Change the PM Display, page 8-2—Complete as needed to change the displayed PM 
counts.

2. NTP-G74 Monitor DWDM Card Performance, page 8-8—Complete as needed to monitor dense 
wavelength division multiplexing (DWDM) performance.

3. NTP-G75 Monitor Transponder and Muxponder Performance, page 8-15—Complete as needed to 
monitor multirate transport performance.

Note For additional information regarding PM parameters, refer to Telcordia’s GR-1230-CORE, 
GR-499-CORE, and GR-253-CORE documents and GR-820-CORE document titled Generic Digital 
Transmission Surveillance, and in the ANSI T1.231 document entitled Digital Hierarchy - Layer 1 
In-Service Digital Transmission Performance Monitoring.
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NTP-G73 Change the PM Display

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node that you want to monitor. If you 
are already logged in, continue with Step 2.

Step 2 In node view, double-click the DWDM or multirate card where you want to view PM counts. The card 
view appears.

Step 3 As needed, use the following tasks to change the display of PM counts:

• DLP-G131 Refresh PM Counts at 15-Minute Intervals, page 8-2 

• DLP-G132 Refresh PM Counts at One-Day Intervals, page 8-3

• DLP-G133 View Near-End PM Counts, page 8-4

• DLP-G134 View Far-End PM Counts, page 8-4

• DLP-G135 Reset Current PM Counts, page 8-5

• DLP-G136 Clear Selected PM Counts, page 8-6

• DLP-G137 Set Auto-Refresh Interval for Displayed PM Counts, page 8-6

• DLP-G138 Refresh PM Counts for a Different Port, page 8-7

Stop. You have completed this procedure.

DLP-G131 Refresh PM Counts at 15-Minute Intervals

Purpose This procedure enables you to change the display of PM counts by 
selecting drop-down list or radio button options in the Performance 
window. 

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 6, “Create Channels 
and Circuits” and Chapter 10, “Change Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task changes the window view to display PM counts in 15-minute 
intervals.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the 15 min radio button.

Step 4 Click Refresh. Performance monitoring parameters appear in 15-minute intervals synchronized with the 
time of day.

Step 5 View the Curr column to find PM counts for the current 15-minute interval.

Each monitored performance parameter has corresponding threshold values for the current time period. 
If the value of the counter exceeds the threshold value for a particular 15-minute interval, a threshold 
crossing alert (TCA) is raised. The number represents the counter value for each specific performance 
monitoring parameter.

Step 6 View the Prev-n columns to find PM counts for the previous 15-minute intervals.

Note If a complete 15-minute interval count is not possible, the value appears with a yellow 
background. An incomplete or incorrect count can be caused by monitoring for less than 
15 minutes after the counter started, changing the node timing settings, changing the time zone 
settings, replacing a card, resetting a card, or changing port service states. When the problem is 
corrected, the subsequent 15-minute interval appears with a white background.

Step 7 Return to your originating procedure (NTP).

DLP-G132 Refresh PM Counts at One-Day Intervals

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the 1 day radio button.

Step 4 Click Refresh. Performance monitoring appears in 1-day intervals synchronized with the time of day.

Step 5 View the Curr column to find PM counts for the current 1-day interval.

Each monitored performance parameter has corresponding threshold values for the current time period. 
If the value of the counter exceeds the threshold value for a particular 1-day interval, a TCA is raised. 
The number represents the counter value for each specific performance monitoring parameter.

Step 6 View the Prev-n columns to find PM counts for the previous 1-day intervals.

Purpose This task changes the window view to display PM parameters in 1-day 
intervals.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Note If a complete count over a 1-day interval is not possible, the value appears with a yellow 
background. An incomplete or incorrect count can be caused by monitoring for less than 
24 hours after the counter started, changing node timing settings, changing the time zone 
settings, replacing a card, resetting a card, or changing port service states. When the problem is 
corrected, the subsequent 1-day interval appears with a white background.

Step 7 Return to your originating procedure (NTP).

DLP-G133 View Near-End PM Counts

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click the Near End radio button.

Step 4 Click Refresh. All PM parameters occurring for the selected card on the incoming signal appear. For 
PM parameter definitions, refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Step 5 View the Curr column to find PM counts for the current time interval.

Step 6 View the Prev-n columns to find PM counts for the previous time intervals.

Step 7 Return to your originating procedure (NTP).

DLP-G134 View Far-End PM Counts

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Purpose This task enables you to view near-end PM counts for the selected card 
and port. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task enables you to view far-end PM parameters for the selected 
card and port. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 2 Click the Performance tab.

Step 3 Click the Far End radio button.

Step 4 Click Refresh. All PM parameters recorded by the far-end node for the selected card on the outgoing 
signal appear. For PM parameter definitions, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Step 5 View the Curr column to find PM counts for the current time interval.

Step 6 View the Prev-n columns to find PM counts for the previous time intervals.

Step 7 Return to your originating procedure (NTP).

DLP-G135 Reset Current PM Counts

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click Baseline.

Note The Baseline button clears the PM counts displayed in the current time interval but does not clear 
the PM counts on the card. When the current time interval expires or the window view changes, 
the total number of PM counts on the card and on the window appears in the appropriate column. 
The baseline values are discarded if you change views to a different window and then return to 
the Performance window.

Step 4 View the current statistics columns to observe changes to PM counts for the current time interval.

Step 5 Return to your originating procedure (NTP).

Purpose This task clears the current PM count, but it does not clear the 
cumulative PM count. This task allows you to see how quickly PM 
counts rise.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G136 Clear Selected PM Counts
DLP-G136 Clear Selected PM Counts

Caution Pressing the Clear button can mask problems if used incorrectly. This button is commonly used for 
testing purposes. After pressing this button, the current bin is marked invalid. Also note that the 
unavailable seconds (UAS) count is not cleared if you were counting UAS; therefore, this count could 
be unreliable when you press Clear.

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 Click Clear.

Step 4 From the Clear Statistics dialog box, click one of the following radio buttons:

• Displayed statistics: Clearing displayed statistics erases all PM counts associated with the current 
combination of statistics on the selected port from the card and the window. This means that the 
selected time interval, direction, and signal type counts are erased from the card and the window.

• All statistics for port x: Clearing all statistics for port x erases all PM counts associated with all 
combinations of the statistics on the selected port from the card and the window. This means that all 
time intervals, directions, and signal type counts are erased from the card and the window.

• All statistics for card: Clearing all statistics for card erases all PM counts for all ports from the card 
and the window.

Step 5 From the Clear Statistics dialog box, click OK to clear the selected statistics.

Step 6 Verify that the selected PM counts have been cleared.

Step 7 Return to your originating procedure (NTP).

DLP-G137 Set Auto-Refresh Interval for Displayed PM Counts

Purpose This task uses the Clear button to clear specified PM counts depending 
on the option selected.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task changes the window auto-refresh intervals for updating the 
displayed PM counts.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G138 Refresh PM Counts for a Different Port
Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 From the Auto-refresh drop-down list, choose one of the following options:

• None: This option disables the auto-refresh feature.

• 15 Seconds: This option sets the window auto-refresh to 15-second time intervals.

• 30 Seconds: This option sets the window auto-refresh to 30-second time intervals.

• 1 Minute: This option sets the window auto-refresh to 1-minute time intervals.

• 3 Minutes: This option sets the window auto-refresh to 3-minute time intervals.

• 5 Minutes: This option sets the window auto-refresh to 5-minute time intervals.

Step 4 Click Refresh. The PM counts for the newly selected auto-refresh time interval appear.

Depending on the selected auto-refresh interval, the displayed PM counts automatically update when 
each refresh interval completes. If the auto-refresh interval is set to None, the PM counts that appear are 
not updated unless you click Refresh.

Step 5 Return to your originating procedure (NTP).

DLP-G138 Refresh PM Counts for a Different Port

Step 1 In node view, double-click the card where you want to view PM counts. The card view appears.

Step 2 Click the Performance tab.

Step 3 In the Port drop-down list, choose a port.

Step 4 Click Refresh. The PM counts for the newly selected port appear.

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the window view to display PM counts for another 
port on a multiport card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-G74 Monitor DWDM Card Performance
NTP-G74 Monitor DWDM Card Performance

Step 1 Complete the “DLP-G46 Log into CTC” procedure on page 2-25 at the node that you want to monitor. 
If you are already logged in, continue with Step 2.

Step 2 Complete the following tasks as needed:

• DLP-G139 View Optical Service Channel PM Parameters, page 8-8.

• DLP-G140 View Optical Amplifier PM Parameters, page 8-10.

• DLP-G141 View PMs for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards, page 8-11.

• DLP-G142 View Channel Filter Optical Add/Drop Multiplexer PM Parameters, page 8-12.

• DLP-G143 View Band Filter Optical Add/Drop Multiplexer PM Parameters, page 8-14.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 8-2.

Stop. You have completed this procedure.

DLP-G139 View Optical Service Channel PM Parameters

Purpose This procedure enables you to view, transmit, and receive performance 
information about an Optical Service Channel, Multiplexer/Demultiplexer, 
Amplifier, and OADM card and port during selected time intervals to 
detect possible performance problems. 

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 6, “Create Channels 
and Circuits” and Chapter 10, “Change Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task enables you to view optical service channel (OSC) PM counts 
at selected time intervals on an Optical Service Channel Module 
(OSCM) or Optical Service Channel and Combiner/Separator Module 
(OSC-CSM) card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G139 View Optical Service Channel PM Parameters
Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to view PM counts. The card 
view appears.

Step 2 Click the Performance > OC3 Line tabs (Figure 8-1).

Figure 8-1 OC3 Line Tab in the Optical Service Channel Card View Performance Window

Step 3 Click Refresh. OC3 line performance monitoring statistics for the selected port appear.

Step 4 Click the Optical Line tab.

Step 5 Click Refresh. Optical line performance monitoring statistics for the selected port appear.

Step 6 Return to your originating procedure (NTP).
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DLP-G140 View Optical Amplifier PM Parameters
DLP-G140 View Optical Amplifier PM Parameters

Step 1 In node view, double-click the optical amplifier card where you want to view PM counts. The card view 
appears.

Step 2 Click the Performance > Optical Line tabs (Figure 8-2).

Figure 8-2 Optical Line Tab in the Optical Amplifier Card View Performance Window

Step 3 Click Refresh. Optical line performance monitoring statistics for the selected port appear.

Step 4 Click the Opt. Ampli. Line tab.

Step 5 Click Refresh. Optical amplifier line performance monitoring statistics for the selected port appear.

Purpose This task enables you to view optical amplifier PM counts at selected 
time intervals on an Optical Preamplifier (OPT-PRE) or Optical Booster 
(OPT-BST) amplifier card and port to detect possible performance 
problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G141 View PMs for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards
Step 6 Return to your originating procedure (NTP).

DLP-G141 View PMs for 32MUX-O, 32-WSS, 32-DMX-O, and 32DMX Cards

Step 1 In node view, double-click the 32MUX-O, 32-WSS, 32-DMX-O, or 32DMX card where you want to view 
PM counts. The card view appears.

Step 2 Click the Performance > Optical Chn tabs (Figure 8-3).

Purpose This task enables you to view multiplexer or demultiplexer PM counts 
at selected time intervals on a 32MUX-O (32-Channel Multiplexer), 
32-WSS (32-Channel Wavelength Selective Switch), 32-DMX-O, and 
32DMX (32-Channel Demultiplexer) cards and port to detect possible 
performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G142 View Channel Filter Optical Add/Drop Multiplexer PM Parameters
Figure 8-3 Optical Channel Tab in the Multiplexer/Demultiplexer Card View Performance Window

Step 3 Click Refresh. Optical channel performance monitoring statistics for the selected port appear.

Step 4 Click the Optical Line tab.

Step 5 Click Refresh. Optical line performance monitoring statistics for the selected port appear.

Step 6 Return to your originating procedure (NTP).

DLP-G142 View Channel Filter Optical Add/Drop Multiplexer PM Parameters

Purpose This task enables you to view channel filter optical add/drop channel 
multiplexer (OADM) PM counts at selected time intervals on an 
1-Channel OADM (AD-1C-xx.x), 2-Channel OADM (AD-2C-xx.x), or 
4-Channel OADM (AD-4C-xx.x) card and port to detect possible 
performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G142 View Channel Filter Optical Add/Drop Multiplexer PM Parameters
Step 1 In node view, double-click the optical AD-xC-xx.x card where you want to view PM counts. The card 
view appears.

Step 2 Click the Performance > Optical Line tabs (Figure 8-4).

Figure 8-4 Optical Line Tab in the Channel Filter OADM Card View Performance Window

Step 3 Click Refresh. Optical line performance monitoring statistics for the selected port appear.

Step 4 Click the Optical Chn tab.

Step 5 Click Refresh. Optical channel performance monitoring statistics for the selected port appear.

Step 6 Return to your originating procedure (NTP).
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DLP-G143 View Band Filter Optical Add/Drop Multiplexer PM Parameters
DLP-G143 View Band Filter Optical Add/Drop Multiplexer PM Parameters

Step 1 In node view, double-click the AD-xB-xx.x or the 4MD-xxx card where you want to view PM counts. 
The card view appears.

Step 2 Click the Performance > Optical Chn tabs (Figure 8-5).

Figure 8-5 Optical Channel Tab in the Band Filter OADM Card View Performance Window

Step 3 Click Refresh. Optical channel performance monitoring statistics for the selected port appear.

Step 4 Click the Optical Band tab.

Step 5 Click Refresh. Optical band performance monitoring statistics for the selected port appear.

Purpose This task enables you to view band filter OADM PM counts at selected 
time intervals on an 1-Band OADM (AD-1B-xx.x), 4-Band OADM 
(AD-4B-xx.x), or 4-Channel Multiplexer/Demultiplexer (4MD-xx.x) 
card and port to detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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NTP-G75 Monitor Transponder and Muxponder Performance
Step 6 Return to your originating procedure (NTP).

NTP-G75 Monitor Transponder and Muxponder Performance

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node that you want to monitor. If you 
are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G144 Enable/Disable OTN ITU-T G.709 Performance Monitoring” task on 
page 8-16 as needed to enable or disable optical transport network (OTN) ITU-T G.709 monitoring.

Step 3 Complete the “DLP-G145 Enable/Disable OTN FEC Performance Monitoring” task on page 8-17 as 
needed to enable or disable OTN forward error correction (FEC) monitoring.

Step 4 Complete the following tasks as needed to view PM parameters:

• DLP-G146 View Optics PM Parameters, page 8-18.

• DLP-G147 View Payload PM Parameters, page 8-19.

• DLP-G148 View OTN PM Parameters, page 8-21.

• DLP-G149 View Payload Statistics PM Parameters, page 8-22.

• DLP-G150 View Payload Utilization PM Parameters, page 8-24.

• DLP-G151 View Payload History PM Parameters, page 8-25.

• DLP-G152 View Payload SONET PM Parameters, page 8-26.

• DLP-G153 Create RMON Alarm Thresholds, page 8-28.

• DLP-G154 Delete RMON Alarm Thresholds, page 8-30.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” task on 
page 8-2.

Purpose This procedure enables you to view node near-end or far-end 
performance during selected time intervals on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or a muxponder (MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, 
MXP_2.5G_10G) card and port to detect possible performance 
problems. 

Tools/Equipment None

Prerequisite Procedures Before you monitor performance, be sure you have created the 
appropriate circuits and provisioned the card according to your 
specifications. For more information, see Chapter 6, “Create Channels 
and Circuits” and Chapter 10, “Change Card Settings.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G144 Enable/Disable OTN ITU-T G.709 Performance Monitoring
Stop. You have completed this procedure.

DLP-G144 Enable/Disable OTN ITU-T G.709 Performance Monitoring

Step 1 In node view, double-click the card you want to monitor. The card view appears.

Step 2 Click the Provisioning > OTN > OTN Lines tabs (Figure 8-6).

Figure 8-6 OTN Lines Tab for Enabling/Disabling OTN ITU-T G.709 Performance Monitoring

Step 3 Make an ITU-T G.709 selection based on the following rules:

• Unchecked disables ITU-T G.709 for that port (default).

• Checked enables ITU-T G.709 for that port.

Step 4 Click Apply.

Purpose This task enables or disables OTN ITU-T G.709 monitoring of near-end 
or far-end performance on a card and port during selected time intervals 
to detect possible problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

11
57

62

Provisioning
tab

OTN Lines tab

OTN tab

Card View

Help
button

Apply
button

G.709 OTN
check box
8-16
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Chapter 8      Monitor Performance
DLP-G145 Enable/Disable OTN FEC Performance Monitoring
Step 5 Click the Performance tab to view PM parameters. For PM parameter definitions, refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Step 6 Return to your originating procedure (NTP).

DLP-G145 Enable/Disable OTN FEC Performance Monitoring

Step 1 In node view, double-click the card you want to monitor. The card view appears.

Step 2 Click the Provisioning > OTN > OTN Lines tabs (Figure 8-7).

Figure 8-7 OTN Lines Tab for Enabling/Disabling OTN FEC Performance Monitoring for TXP_MR_10E 

Cards

Purpose This task enables or disables OTN FEC monitoring of node near-end or 
far-end performance on a selected card and port during selected time 
intervals.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G146 View Optics PM Parameters
Step 3 Make an FEC selection based on the following rules:

• Choose Disable to disable the OTN FEC monitoring.

• Choose Standard to enable standard FEC monitoring for that port (default).

• Choose Enhanced to enable enhanced FEC monitoring for that port.

Note For TXP_MR_10E and MXP_MR_10E cards the FEC selection options available are Disable, 
Standard, and Enhanced. For all the remaining transponder and muxponder cards the options 
available are Enable and Disable. 

Step 4 Click Apply.

Step 5 Click the Performance tab to view PM parameters. For PM parameter definitions, refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Step 6 Return to your originating procedure (NTP).

DLP-G146 View Optics PM Parameters

Step 1 In node view, double-click the transponder or muxponder card where you want to view PM counts. The 
card view appears.

Step 2 Click the Performance > Optics PM tabs (Figure 8-8).

Purpose This task enables you to view the optics PM counts on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or a muxponder (MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G, 
MXP_2.5G_10G) card and port to detect possible performance 
problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G147 View Payload PM Parameters
Figure 8-8 Viewing Optics Performance Monitoring Information

Step 3 View the PM parameter names that appear in the Param column of Current Values and History PM tabs. 
The PM parameter values appear in the Curr (current) and Prev-n (previous) columns. For PM parameter 
definitions, refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Step 4 Return to your originating procedure (NTP).

DLP-G147 View Payload PM Parameters

Step 1 In node view, double-click the transponder or muxponder card where you want to view PM counts. The 
card view appears.

Step 2 Click the Performance > Payload PM tabs (Figure 8-9).

Purpose This task enables you to view the payload PM counts on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or a muxponder (MXP_2.5G_10E, MXP_2.5G_10G) card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G147 View Payload PM Parameters
Figure 8-9 Viewing Payload Performance Monitoring Information 

Step 3 View the PM parameter names that appear in the Param column of Current Values and History PM tabs 
The PM parameter values appear in the Curr (current), and Prev-n (previous) columns. For PM parameter 
definitions, refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Note The Payload PMs for data parameters can be viewed only after creating a pluggable port module. 

Note The PM parameters that appear depend on the data payload and framing type provisioned on the 
port. Unframed data payloads such as Enterprise System Connection (ESCON), DV6000, 
DSI/D1 video, and HDTV do not provide payload performance monitoring information. The PM 
parameters that appear also depend on the PPM payload configured. The TXP_MR_10E card 
supports three payloads, MXP_2.5G_10G and MXP_2.5G_10E cards support OC48/STM16 
payload, MXP_MR_2.5G and MXPP_MR_2.5G support 1G FC, 2G FC, 1G FICON, 2G 
FICON, and 1GE payloads.

Step 4 Return to your originating procedure (NTP).
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DLP-G148 View OTN PM Parameters
DLP-G148 View OTN PM Parameters

Step 1 In node view, double-click the transponder or muxponder card where you want to view PM counts. The 
card view appears.

Step 2 Click the Performance > OTN PM > G.709 tabs (Figure 8-10).

Figure 8-10 Viewing OTN ITU-T G.709 Performance Monitoring Information

Step 3 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Curr (current) and Prev-n (previous) columns. For PM parameter definitions, refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Step 4 Click the FEC PM tab (Figure 8-11).

Purpose This task enables you to view the OTN PM counts on a transponder 
(TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, TXP_MR_10E), 
or muxponder (MXP_2.5G_10E, MXP_2.5G_10G) card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G149 View Payload Statistics PM Parameters
Figure 8-11 Viewing OTN FEC Performance Monitoring Information

Step 5 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Curr (current) and Prev-n (previous) columns. For PM parameter definitions, refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Step 6 Return to your originating procedure (NTP).

DLP-G149 View Payload Statistics PM Parameters

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Purpose This task enables you to view current statistical PM counts on an 
MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible 
performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G149 View Payload Statistics PM Parameters
Step 2 Click the Performance > Payload PM > Statistics tabs (Figure 8-12).

Figure 8-12 Statistics Tab on the Card View Performance Window

Step 3 Click Refresh. Performance monitoring statistics appear for each port on the card.

Step 4 View the PM parameter names that appear in the Param column. The current PM parameter values appear 
in the Port # columns. For PM parameter definitions, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 8-2.

Step 5 Return to your originating procedure (NTP).
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DLP-G150 View Payload Utilization PM Parameters
DLP-G150 View Payload Utilization PM Parameters

Step 1 In node view, double-click theMXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance > Payload PM > Utilization tabs (Figure 8-13).

Figure 8-13 Utilization Tab on the Card View Performance Window

Step 3 Click Refresh. Performance monitoring utilization values appear for each port on the card.

Step 4 View the Port # column to find the port you want to monitor.

Step 5 The transmit (Tx) and receive (Rx) bandwidth utilization values for the previous time intervals appear 
in the Prev-n columns. For PM parameter definitions, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Purpose This task enables you to view line utilization PM counts on an 
MXP_MR_2.5G or MXPP_MR_2.5G card and port to detect possible 
performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G151 View Payload History PM Parameters
Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 8-2.

Step 6 Return to your originating procedure (NTP).

DLP-G151 View Payload History PM Parameters

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance > Payload PM > History tabs (Figure 8-14).

Purpose This task enables you to view historical PM counts at selected time 
intervals on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Figure 8-14 History Tab on the Card View Performance Window

Step 3 Click Refresh. Performance monitoring statistics appear for each port on the card.

Step 4 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Prev-n columns. For PM parameter definitions, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 8-2.

Step 5 Return to your originating procedure (NTP).

DLP-G152 View Payload SONET PM Parameters

11
57
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Payload PM tab

Performance tab

Card View

History tab
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menu

Purpose This task enables you to view SONET PM counts at selected time 
intervals on an MXP_MR_2.5G or MXPP_MR_2.5G card and port to 
detect possible performance problems.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to view PM 
counts. The card view appears.

Step 2 Click the Performance > Payload PM > SONET PM tabs (Figure 8-15).

Figure 8-15 SONET PM Tab on the Card View Performance Window

Step 3 Click Refresh. Performance monitoring statistics appear for each port on the card.

Step 4 View the PM parameter names that appear in the Param column. The PM parameter values appear in the 
Prev-n columns. For PM parameter definitions, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Note The MXP_MR_2.5G and MXPP_MR_2.5G cards support only OC48/STM16 payload. Each 
payload has a set of PM parameters.

Note To refresh, reset, or clear PM counts, see the “NTP-G73 Change the PM Display” procedure on 
page 8-2.

Step 5 Return to your originating procedure (NTP).
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DLP-G153 Create RMON Alarm Thresholds

Step 1 In node view, double-click the card where you want to create the RMON alarm thresholds.

Step 2 In card view, click the Provisioning > Line Thresholds > RMON Thresholds tabs.

Step 3 Click Create. The Create Threshold dialog box appears.

Step 4 From the Slot menu, choose the appropriate card.

Step 5 From the Port drop-down list, choose the applicable port on the card you selected.

Step 6 From the Variable drop-down list, choose the variable. See Table 8-1 for a list of the 
MXP_MR_2.5G/MXPP_MR_2.5G threshold variables available in this field.

Purpose This procedure sets up remote monitoring (RMON) to allow network 
management systems to monitor Ethernet and Fibre Channel ports. This 
procedure applies to MXP_MR_2.5G, MXPP_MR_2.5G, TXP_MR_2.5G, 
and TXPP_MR_2.5G cards in GE/FC/FICON/ISC compact mode, and 
MXP_2.5G_10G, TXP_MR_10G, MXP_2.5G_10E, and TXP_MR_10E 
cards in Gigabit Ethernet (10GE) mode.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 8-1 MXP_MR_2.5G/MXPP_MR_2.5G Threshold Variables (MIBs)

Variable Definition

iflnOctets Total number of octets received on the interface, including 
framing octets

 ifInDiscards The number of inbound packets that were chosen to be discarded 
even though no errors had been detected to prevent their being 
deliverable to a higher-layer protocol

iflnErrors Number of inbound packets discarded because they contain 
errors

ifOutOctets Total number of transmitted octets, including framing packets

ifOutDiscards The number of outbound packets that were chosen to be 
discarded even though no errors had been detected to prevent 
their being transmitted

txTotalPkts Total number of transmit packets

rxTotalPkts Total number of receive packets

mediaIndStatsRxFramesTooLong Number of packets transmitted that are greater than 1548 bytes

mediaIndStatsRxFramesTruncated Total number of frames received that are less than 5 bytes

mediaIndStatsRxFramesBadCRC Total number of frames received with a cyclic redundancy check 
(CRC) error

mediaIndStatsTxFramesBadCRC Total number of frames transmitted with a CRC error
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Step 7 From the Alarm Type drop-down list, indicate whether the rising threshold, falling threshold, or both the 
rising and falling thresholds will trigger the event.

Step 8 From the Sample Type drop-down list, choose either Relative or Absolute. Relative restricts the 
threshold to use the number of occurrences in the user-set sample period. Absolute sets the threshold to 
use the total number of occurrences, regardless of time period.

Step 9 Enter the appropriate number of seconds for the Sample Period.

Step 10 Enter the appropriate number of occurrences for the Rising Threshold.

Note For a rising type of alarm, the measured value must move from below the falling threshold to 
above the rising threshold. For example, if a network is running below a rising threshold of 
1000 collisions every 15 seconds and a problem causes 1001 collisions in 15 seconds, the excess 
occurrences trigger an alarm. 

Step 11 Enter the appropriate number of occurrences in the Falling Threshold field. In most cases, a falling 
threshold is set lower than the rising threshold. 

Note A falling threshold is the counterpart to a rising threshold. When the number of occurrences is 
above the rising threshold and then drops below a falling threshold, it resets the rising threshold. 
For example, when the network problem that caused 1001 collisions in 15 minutes subsides and 
creates only 799 collisions in 15 minutes, occurrences fall below a falling threshold of 800 
collisions. This resets the rising threshold so that if network collisions again spike over a 1000 
per 15-minute period, an event again triggers when the rising threshold is crossed. An event is 
triggered only the first time a rising threshold is exceeded (otherwise, a single network problem 
might cause a rising threshold to be exceeded multiple times and cause a flood of events). 

Step 12 Click OK to complete the procedure.

Step 13 Return to your originating procedure (NTP).

8b10bInvalidOrderedSets Total number of ordered sets not complaint to GE/FC (Gigabit 
Ethernet/Fibre Channel) standard

8b10bStatsEncodingDispErrors Total number of code groups that violate GE/FC disparity errors

Table 8-1 MXP_MR_2.5G/MXPP_MR_2.5G Threshold Variables (MIBs) (continued)

Variable Definition
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DLP-G154 Delete RMON Alarm Thresholds

Step 1 In node view, double-click the card where you want to delete the RMON alarm thresholds.

Step 2 In card view, click the Provisioning > Line Thresholds > RMON Thresholds tabs.

Step 3 Click the RMON alarm threshold you want to delete.

Step 4 Click Delete. The Delete Threshold dialog box appears. 

Step 5 Click Yes to delete that threshold.

Step 6 Return to your originating procedure (NTP).

Purpose This task deletes RMON threshold crossing alarms for Ethernet and 
Fibre Channel ports.

Tools/Equipment None

Prerequisite Procedures DLP-G153 Create RMON Alarm Thresholds, page 8-28

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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C H A P T E R 9

Manage the Node

This chapter explains how to modify node provisioning for the Cisco ONS 15454 and perform common 
management tasks such as monitoring the dense wavelength division multiplexing (DWDM) automatic 
power control and span loss values. To provision a new node, see Chapter 3, “Turn Up a Node.” To 
change default network element settings and to view a list of those settings, refer to the Cisco ONS 15454 
Release 4.7 Network Element Defaults document.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing the following procedures, investigate all alarms and clear any trouble conditions. 
Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide as necessary.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs). 

1. NTP-G76 Verify Span Loss, page 9-2—Complete this procedure as needed to view or modify the 
DWDM span loss values. 

2. NTP-G77 Manage Automatic Power Control, page 9-4—Complete this procedure as needed to 
manage the DWDM automatic power control.

3. NTP-G78 View ROADM Node Power Equalization, page 9-6—Complete this procedure as needed 
to view and update a reconfigurable optical add/drop management node power equalization. 

4. NTP-G79 Modify Automatic Node Setup Parameters, page 9-7—Complete as needed.

5. NTP-G80 Change Node Management Information, page 9-8—Complete this procedure as needed to 
change node name, contact information, latitude, longitude, date, time, and login legal disclaimer.

6. NTP-G81 Change CTC Network Access, page 9-10—Complete this procedure as needed to change 
the IP address, default router, subnet mask, network configuration settings, and static routes.

7. NTP-G82 Customize the CTC Network View, page 9-15—As needed, complete this procedure to 
create domains and customize the appearance of the network map, including specifying a different 
default map, creating domains, selecting your own map or image, and changing the background 
color.

8. NTP-G83 Modify or Delete Card Protection Settings, page 9-20—Complete as needed.

9. NTP-G84 Initiate and Clear Y-Cable and Splitter External Switching Commands, page 
9-23—Complete as needed.
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10. NTP-G85 Modify or Delete Communications Channel Terminations and Provisionable Patchcords, 
page 9-28—Complete this procedure as needed to modify or delete generic communications channel 
(GCC) and optical service channel (OSC) terminations, and provisionable patchcords.

11. NTP-G86 Convert a Pass-Through Connection to an Add/Drop Connection, page 9-31—Complete 
this procedure as needed to convert a pass-through connection to an add/drop connection.

12. NTP-G87 Change Node Timing Parameters, page 9-32—Complete as needed.

13. NTP-G88 Modify Users and Change Security, page 9-34—Complete this procedure as needed to 
make changes to user settings, including security level and security policies, and to delete users.

14. NTP-G89 Change SNMP Settings, page 9-42—Complete as needed.

NTP-G76 Verify Span Loss

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Perform the following span loss verification tasks as needed: 

• Complete the “DLP-G155 Verify Optical Span Loss Using CTC” task on page 9-3 to check span loss 
using CTC. This task is faster than a span loss measurement using an optical time domain 
reflectometer (OTDR) and does not require fibers to be removed. However, the resolution is not as 
precise as an OTDR measurement.

• Complete “DLP-G156 Measure Span Insertion Loss Using an OTDR” task on page 9-4 to measure 
the span loss using an OTDR. 

Stop. You have completed this procedure.

Purpose This procedure verifies the span loss between two DWDM nodes using 
CTC. You perform this procedure after a node or network modification has 
occurred and you want to verify that the span loss between the nodes have 
not changed.

Tools/Equipment A node provisioning plan prepared by Cisco MetroPlanner is required.

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G155 Verify Optical Span Loss Using CTC

Step 1 In node view, click the Provisioning > Comm Channels > OSC tabs. Verify that two OSC terminations 
are provisioned and have an In-Service and Normal (IS-NR) (ANSI) or Unlocked-enabled (ETSI) 
service state. 

Step 2 Click the Maintenance > DWDM > WDM Span Check tabs. 

Step 3 Click Retrieve Span Loss Values to retrieve the latest span loss data.

Step 4 View and modify the following information:

• Side—Shows the side to which the span loss values apply, either east or west.

• Min Expected Span Loss (dBm)—Shows the expected minimum span loss (in dBm). You can change 
the minimum by entering a new value in the field.

• Meas Expected Span Loss (dBm)—Shows the measured span loss (in dBm).

• Max Expected Span Loss (dBm)—Shows the expected maximum span loss (in dBm). You can 
change the minimum by entering a new value in the field.

Note The minimum and maximum expected span loss values are calculated by Cisco 
MetroPlanner and imported to the node when you perform the “DLP-G74 Import a Cisco 
MetroPlanner Configuration File” task on page 3-59.

• Resolution (dBm)—Shows the resolution of the span loss measurement (in dBm):

– +/– 1.5 dB for measured span losses between 0 and 25 dB

– +/– 2.5 dB for measured span losses between 25 and 38 dB

Step 5 If you modified the minimum or maximum expected span losses, click Apply. If not, continue with 
Step 6.

Step 6 Return to your originating procedure (NTP).

Purpose This procedure verifies span loss values between two DWDM nodes using 
CTC.

Tools/Equipment A node provisioning plan prepared by Cisco MetroPlanner is required.

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G156 Measure Span Insertion Loss Using an OTDR

Step 1 Remove one of the fiber connections of the fiber span you will measure.

Step 2 Following the instructions in the OTDR documentation, connect the OTDR to the end of the fiber.

Step 3 Measure the insertion loss using the procedures in the OTDR documentation.

Step 4 Display your site plan in MetroPlanner. Enter the insertion loss values calculated from the insertion loss 
measurement and recalculate the site plan. If the new insertion loss values are accepted, MetroPlanner 
will create a new configuration file. If so, continue with Step 5. If the new insertion loss values require 
changes to the physical site, for example, additional cards or nodes, install the new nodes and cards 
following procedures in Chapter 1, “Install the Shelf and Common Control Cards,” and Chapter 3, “Turn 
Up a Node.”

Step 5 If the span is out of range and the MetroPlanner design changed, complete the “DLP-G74 Import a Cisco 
MetroPlanner Configuration File” task on page 3-59 at each node in the network.

Step 6 Return to your originating procedure (NTP).

NTP-G77 Manage Automatic Power Control 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the following tasks as necessary:

• DLP-G157 Disable Automatic Power Control, page 9-5

Purpose This task measures the span insertion loss using an optical time domain 
reflectometer (OTDR). You perform this task when OSC terminations fail 
to turn up properly and initial troubleshooting, including checks of the 
Optical Service Channel and Combiner/Splitter Module (OSC-CSM) or 
Optical Service Channel Module (OSCM) port states and physical fiber 
connections, do not solve the problem.

Tools/Equipment OTDR test and measurement device.

Prerequisite Procedures DLP-G75 Create OSC Terminations, page 3-61

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure manages the DWDM automatic power control (APC). 

Tools/Equipment A node provisioning plan prepared by Cisco MetroPlanner is required.

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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• DLP-G158 Enable Automatic Power Control, page 9-5

• DLP-G159 Refresh Automatic Power Control Information, page 9-6

Stop. You have completed this procedure.

DLP-G157 Disable Automatic Power Control 

Caution Disable APC only to perform specific troubleshooting or node provisioning tasks. Always enable APC 
as soon as the tasks are completed. Leaving APC disabled can cause traffic loss.

Step 1 Click the Maintenance > DWDM > APC tabs. 

Step 2 Click Disable APC, 

Step 3 On the confirmation dialog box, Click Yes.

Step 4 Return to your originating procedure.

DLP-G158 Enable Automatic Power Control 

Caution Disable APC only to perform specific troubleshooting or node provisioning tasks. Always enable APC 
as soon as the tasks are completed. Leaving APC disabled can cause traffic loss.

Step 1 Click the Maintenance > DWDM > APC tabs. 

Step 2 Click Enable APC.

Step 3 On the confirmation dialog box, Click Yes.

Purpose This task disables the DWDM automatic power control (APC). 

Tools/Equipment A node provisioning plan prepared by Cisco MetroPlanner is required.

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This procedure enables the DWDM automatic power control (APC). 

Tools/Equipment A node provisioning plan prepared by Cisco MetroPlanner is required.

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 4 Return to your originating procedure.

DLP-G159 Refresh Automatic Power Control Information

Step 1 Click the Maintenance > DWDM > APC tabs. 

Step 2 Click Refresh.

Step 3 Return to your originating procedure.

Stop. You have completed this procedure.

NTP-G78 View ROADM Node Power Equalization

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 In node view, click the Maintenance > DWDM > Power Monitoring tabs.

Step 3 On the Power Monitoring tab, view the following east-to-west (E > W) and west-to-east (W > E) power 
information:

• Padd—Add power.

• Ppt—Pass-through power.

• Pout—Output power. The output power for all wavelengths does not need to be exactly the same for 
all wavelengths, but does need to be within the same range. Figure 9-1 shows an example of 
ROADM node with equalized output power.

Purpose This procedure refreshes the DWDM automatic power control information. 

Tools/Equipment A node provisioning plan prepared by Cisco MetroPlanner is required.

Prerequisite Procedures All procedures in Chapter 3, “Turn Up a Node.”

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task allows you to view reconfigurable optical add/drop multiplexing 
(ROADM) node power equalization levels. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Figure 9-1 Equalized ROADM Power Example

Step 4 If needed, click Refresh to update the display.

Stop. You have completed this procedure.

NTP-G79 Modify Automatic Node Setup Parameters 

Caution ANS parameters are normally not changed manually. Changes to the parameters at one node often 
require adjustments at other network nodes, and anticipating the changes is difficult. In general, you 
should always enter node or network changes in Cisco MetroPlanner, recalculate the parameters, then 
import them into the node and run ANS. 

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Click the WDM-ANS > Provisioning tabs. ANS parameter groups are shown in tree view under the 
Selector area. Click a parameter group to view the individual parameters in it, for example, if you click 
the node name, all ANS parameters are shown. If you click West Side, only West Side parameters are 
shown, and if you click Amplifiers, only amplifier parameters are shown.

For a list of ANS parameters by node type, refer to Table 15-4 on page 15-26. For an ANS parameter 
summary including minimum, maximum, and default values, refer to Table 15-5 on page 15-29.

Step 3 To modify a parameter’s value, click the parameter under the Parameter column and modify its value in 
the Value column.

Step 4 Click Apply.

Purpose Use this procedure to manually modify the DWDM automatic node setup 
(ANS) parameters. 

Tools/Equipment A node provisioning plan prepared by Cisco MetroPlanner is required.

Prerequisite Procedures You must use Cisco MetroPlanner or another DWDM network calculation 
tool to prepare a configuration file for your network. 

NTP-G30 Install the DWDM Cards, page 3-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 5 Click the Port Status tab. Click Launch ANS. 

ANS (Automatic Node Setup) automatically calculates the variable optical attenuator (VOAs) setpoints 
to match the expected channel profile at the amplifier input port.

Stop. You have completed this procedure.

NTP-G80 Change Node Management Information

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 In node view, click the Provisioning > General tabs.

Step 4 Complete the “DLP-G160 Change the Node Name, Date, Time, and Contact Information” task on 
page 9-8, as needed.

Step 5 Complete the “DLP-G161 Change the Login Legal Disclaimer” task on page 9-9, as needed.

Step 6 After confirming the changes, complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G160 Change the Node Name, Date, Time, and Contact Information

Caution Changing the date, time, or time zone might invalidate the node’s performance monitoring counters.

Purpose This procedure changes the node name, date, time, contact information, 
and the login legal disclaimer.

Tools/Equipment None

Prerequisite Procedures NTP-G24 Set Up Name, Date, Time, and Contact Information, page 3-6

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This procedure changes basic information such as node name, date, time, 
and contact information.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, click the Provisioning > General tabs.

Step 2 Change any of the following:

• General: Node Name 

• General: Contact 

• Location: Latitude 

• Location: Longitude 

• Location: Description 

Note To see changes to longitude or latitude on the network map, you must go to network view 
and right-click the specified node, then click Reset Node Position.

• Time: Use NTP/SNTP Server

• Time: Date (M/D/Y)

• Time: Time (H:M:S)

• Time: Time Zone

• Time: Use Daylight Saving Time

• AIS-V Insertion On STS-1 Signal Degrade - Path: Insert AIS-V on STS-1 SD-P

• AIS-V Insertion On STS-1 Signal Degrade - Path: SD-P BER 

See the “NTP-G24 Set Up Name, Date, Time, and Contact Information” procedure on page 3-6 for 
detailed field descriptions.

Step 3 Click Apply. Confirm that the changes appear; if not, repeat the task.

Step 4 Return to your originating procedure (NTP).

DLP-G161 Change the Login Legal Disclaimer

Step 1 In node view, click the Provisioning > Security > Legal Disclaimer > HTML tabs.

Step 2 The existing statement is a default, non-customer-specific disclaimer. If you want to edit this statement 
with specifics for your company, you can change the text. Use the HTML commands in Table 9-1 to 
format the text, as needed.

Purpose This task modifies the legal disclaimer statement shown in the CTC login 
dialog box so that it will display customer-specific information when users 
log into the network.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 3 If you want to preview your changed statement and formatting, click the Preview subtab.

Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

NTP-G81 Change CTC Network Access

Note Additional ONS 15454 networking information and procedures, including IP addressing examples, static 
route scenarios, OSPF protocol, and routing information protocol options are provided in Chapter 19, 
“CTC Connectivity Reference.”

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2. 

Table 9-1 HTML Commands for the Legal Disclaimer

Command Description

<b> Begins boldface font

</b> Ends boldface font

<center> Aligns type in the center of the window

</center> Ends the center alignment

<font=n> (where n = point size) Changes the font to the new size

</font> Ends the font size command

<p> Creates a line break

<sub> Begins subscript

</sub> Ends subscript

<sup> Begins superscript

</sup> Ends superscript

<u> Begins underline

</u> Ends underline

Purpose This procedure changes or deletes network information, including IP 
settings, static routes, Open Shortest Path First (OSPF) options, proxy 
tunnels, and firewall tunnels.

Tools/Equipment None

Prerequisite Procedures NTP-G26 Set Up CTC Network Access, page 3-8

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Perform any of the following tasks as needed:

• DLP-G162 Change IP Settings, page 9-11

• DLP-G163 Modify a Static Route, page 9-12

• DLP-G164 Delete a Static Route, page 9-13

• DLP-G165 Disable OSPF, page 9-13

• DLP-G59 Set Up or Change Open Shortest Path First Protocol, page 3-16

• DLP-G166 Delete a Proxy Tunnel, page 9-14

• DLP-G167 Delete a Firewall Tunnel, page 9-14

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G162 Change IP Settings

Caution Changing the node IP address, subnet mask, or IIOP listener port causes the TCC2s to reboot. If Ethernet 
circuits using Spanning Tree Protocol (STP) originate or terminate on E-Series Ethernet cards installed 
in the node, circuit traffic will be lost for several minutes while the spanning trees reconverge. Other 
circuits are not affected by TCC2 reboots.

Step 1 In node view, click the Provisioning > Network > General tabs.

Step 2 Change any of the following:

• IP Address

• Suppress CTC IP Display

• LCD IP Setting

• Default Router

• Forward DHCP Request To

• MAC Address

• Net/Subnet Mask Length

• TCC CORBA (IIOP) Listener Port

Purpose This task changes the IP address, subnet mask, default router, DHCP 
access, firewall IIOP listener port, LCD IP display, and proxy server 
settings.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G56 Provision IP Settings, page 3-9

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G163 Modify a Static Route
• Gateway Settings

See the “DLP-G56 Provision IP Settings” task on page 3-9 for detailed field descriptions.

Step 3 Click Apply.

If you changed a network field that will cause the node to reboot, such as the IP address, subnet mask, 
or TCC CORBA Listener Port, the Change Network Configuration confirmation dialog box appears. If 
you changed a gateway setting, a confirmation appropriate to the gateway field appears.

Step 4 If a confirmation dialog box appears, click Yes.

If you changed an IP address, subnet mask length, or TCC CORBA (IIOP) Listener Port, both 
ONS 15454 TCC2 cards will reboot, one at a time. A TCC2 card reboot causes a temporary loss of 
connectivity to the node, but traffic is unaffected. 

Step 5 Confirm that the changes appear on the Provisioning > Network > General tab. If the changes do not 
appear, repeat the task. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide as 
necessary.

Step 6 Return to your originating procedure (NTP).

DLP-G163 Modify a Static Route

Step 1 In node view, click the Provisioning > Network tabs.

Step 2 Click the Static Routing tab. 

Step 3 Click the static route you want to edit. 

Step 4 Click Edit.

Step 5 In the Edit Selected Static Route dialog box, enter the following: 

• Mask

• Next Hop

• Cost

See the “DLP-G58 Create a Static Route” task on page 3-15 for detailed field descriptions.

Step 6 Click OK.

Step 7 Return to your originating procedure (NTP).

Purpose This task modifies a static route on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G58 Create a Static Route, page 3-15

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G164 Delete a Static Route

Step 1 In node view, click the Provisioning > Network > Static Routing tabs.

Step 2 Click the static route you want to delete.

Step 3 Click Delete. A confirmation dialog box appears.

Step 4 Click Yes. 

Step 5 Return to your originating procedure (NTP).

DLP-G165 Disable OSPF

Step 1 In node view, click the Provisioning > Network > OSPF tabs. The OSPF subtab has several options.

Step 2 In the OSPF on LAN area, uncheck the OSPF active on LAN check box.

Step 3 Click Apply. Confirm that the changes appear; if not, repeat the task.

Step 4 Return to your originating procedure (NTP).

Purpose This task deletes an existing static route on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G58 Create a Static Route, page 3-15

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task disables the Open Shortest Path First (OSPF) routing protocol 
process for an ONS 15454 LAN.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G59 Set Up or Change Open Shortest Path First Protocol, page 3-16

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G166 Delete a Proxy Tunnel

Step 1 Click the Provisioning > Network > Proxy subtabs.

Step 2 Click the proxy tunnel that you want to delete.

Step 3 Click Delete.

Step 4 Continue with your originating procedure (NTP).

DLP-G167 Delete a Firewall Tunnel

Step 1 Click the Provisioning > Network > Firewall subtabs.

Step 2 Click the firewall tunnel that you want to delete.

Step 3 Click Delete.

Step 4 Return to your originating procedure (NTP).

Purpose This task removes a proxy tunnel.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task removes a firewall tunnel. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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NTP-G82 Customize the CTC Network View

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the following tasks, as needed: 

• DLP-G168 Change the Network View Background Color, page 9-15

• DLP-G169 Change the Default Network View Background Map, page 9-16

• DLP-G170 Apply a Custom Network View Background Map, page 9-17

• DLP-G171 Create Domain Icons, page 9-17

• DLP-G172 Manage Domain Icons, page 9-18

• DLP-G173 Enable Dialog Box Do-Not-Display Option, page 9-19

• DLP-G174 Switch Between TDM and DWDM Network Views, page 9-20

Stop. You have completed this procedure.

DLP-G168 Change the Network View Background Color

Note If you modify background colors, the change is stored in your CTC user profile on the computer. The 
change does not affect other CTC users.

Step 1 From the View menu, choose Go to Network View.

Step 2 If you want to change a domain background, double-click the domain. If not, continue with Step 3.

Purpose This procedure modifies the CTC network view, including grouping nodes 
into domains for a less-cluttered display, changing the network view 
background color, and using a custom image for the network view 
background.

Tools/Equipment None

Prerequisite Procedures None

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the network view background color or the domain view 
background color (the area displayed when you open a domain). 

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher
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DLP-G169 Change the Default Network View Background Map
Step 3 Right-click the network view or domain map area and choose Set Background Color from the shortcut 
menu. 

Step 4 In the Choose Color dialog box, select a background color.

Step 5 Click OK.

Step 6 Return to your originating procedure (NTP).

DLP-G169 Change the Default Network View Background Map

Note If you modify the background image, the change is stored in your CTC user profile on the computer. The 
change does not affect other CTC users.

Step 1 From the Edit menu, choose Preferences > Map and check the Use Default Map check box.

Step 2 In the node view, click the Provisioning > Defaults tabs.

Step 3 In the Defaults Selector area, choose CTC and then network.

Step 4 Click the Default Value field and choose a default map from the drop-down list. Map choices are: 
Germany, Japan, Netherlands, South Korea, United Kingdom, and the United States (default).

Step 5 Click Apply. The new network map appears.

Step 6 Click OK.

Step 7 If the ONS 15454 icons are not visible, right-click the network view and choose Zoom Out. Repeat until 
all the ONS 15454 icons are visible. (You can also choose Fit Graph to Window.)

Step 8 If you need to reposition the node icons, drag and drop them one at a time to a new location on the map.

Step 9 If you want to change the magnification of the icons, right-click the network view and choose Zoom In. 
Repeat until the ONS 15454 icons are displayed at the magnification you want.

Step 10 Return to your originating procedure (NTP).

Purpose This task changes the default map of the CTC network view.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G170 Apply a Custom Network View Background Map

Note You can replace the network view background image with any JPEG or GIF image that is accessible on 
a local or network drive. If you apply a custom background image, the change is stored in your CTC user 
profile on the computer. The change does not affect other CTC users.

Step 1 From the Edit menu, choose Preferences > Map and uncheck the Use Default Map check box.

Step 2 From the View menu, choose Go to Network View.

Step 3 Right-click the network or domain map and choose Set Background Image.

Step 4 Click Browse. Navigate to the graphic file you want to use as a background.

Step 5 Select the file. Click Open.

Step 6 Click Apply and then click OK.

Step 7 If the ONS 15454 icons are not visible, right-click the network view and choose Zoom Out. Repeat this 
step until all the ONS 15454 icons are visible.

Step 8 If you need to reposition the node icons, drag and drop them one at a time to a new location on the map.

Step 9 If you want to change the magnification of the icons, right-click the network view and choose Zoom In. 
Repeat until the ONS 15454 icons are displayed at the magnification you want.

Step 10 Return to your originating procedure (NTP).

DLP-G171 Create Domain Icons 

Note Domains created by one user are visible to all users who log into the network.

Step 1 From the View menu, choose Go to Network View.

Purpose This task changes the background image or map of the CTC network view.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This task creates a domain, which is an icon that groups ONS 15454 icons 
in CTC network view.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G172 Manage Domain Icons
Step 2 Right-click the network map and choose Create New Domain from the shortcut menu. 

Step 3 When the domain icon appears on the map, click the map name and type the domain name.

Step 4 Press Enter.

Step 5 Return to your originating procedure (NTP).

DLP-G172 Manage Domain Icons 

Note All domain changes, such as added or removed nodes, are visible to all users who log into the network.

Step 1 From the View menu, choose Go to Network View.

Step 2 Locate the domain action that you want to perform in Table 9-2 and complete the appropriate steps.

Purpose This task manages CTC network view domain icons.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

DLP-G171 Create Domain Icons, page 9-17

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 9-2 Managing Domains

Domain Action Steps

Move a domain Press Ctrl and drag and drop the domain icon to the new location.

Rename a domain Right-click the domain icon and choose Rename Domain from the shortcut 
menu. Type the new name in the domain name field.

Add a node to a 
domain

Drag and drop the node icon to the domain icon.

Move a node from a 
domain to the 
network map

Open the domain and right-click a node. Choose Move Node Back to Parent 
View.

Open a domain • Double-click the domain icon, or

• Right-click the domain and choose Open Domain.

Return to network 
view

Right-click the domain view area and choose Go to Parent View from the 
shortcut menu.

Preview domain 
contents

Right-click the domain icon and choose Show Domain Overview. The domain 
icon shows a small preview of the nodes in the domain. To turn off the domain 
overview, right-click the overview and select Show Domain Overview.

Remove domain Right-click the domain icon and choose Remove Domain. Any nodes in the 
domain are returned to the network map.
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Step 3 Return to your originating procedure (NTP).

DLP-G173 Enable Dialog Box Do-Not-Display Option

Note If any user who has rights to perform an operation (for example, creating a circuit) selects the “Do not 
show this dialog again” check box in a dialog box, the dialog box is not displayed for any other users 
who perform that operation on the network from the same computer unless the command is overridden 
using the following task. (The preference is stored on the computer, not in the node database.)

Step 1 From the Edit menu, choose Preferences.

Step 2 In the Preferences dialog box, click the General tab.

The Preferences Management area field lists all dialog boxes where “Do not show this dialog again” is 
enabled. 

Step 3 Choose one of the following options, or uncheck the individual dialog boxes that you want to appear:

• Don’t Show Any—Hides all do-not-display check boxes.

• Show All—Overrides do-not-display check box selections and displays all dialog boxes.

Step 4 Click OK.

Step 5 Return to your originating procedure (NTP).

Purpose Use this task to ensure that a user-selected “Do not display” dialog box 
preference is enabled for subsequent sessions or to disable the “Do not 
display” option. 

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G174 Switch Between TDM and DWDM Network Views

Step 1 From the View menu, choose Go to Network View.

Step 2 From the Network Scope drop-down list on the toolbar, choose one of the following:

• All—Displays both TDM and DWDM nodes

• TDM—Displays only ONS 15454s with SONET or SDH cards including the transponder and 
muxponder cards.

• DWDM—Displays only ONS 15454s with DWDM cards, including the transponder and muxponder 
cards.

Step 3 Return to your originating procedure (NTP).

NTP-G83 Modify or Delete Card Protection Settings

Caution Modifying and deleting protection groups can be service affecting.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2. 

Step 3 Perform any of the following tasks as needed:

• DLP-G175 Modify a Y-Cable Protection Group, page 9-21

• DLP-G176 Modify a Splitter Protection Group, page 9-22

• DLP-G177 Delete a Y-Cable Protection Group, page 9-22

Purpose Use this task to switch between TDM (time division multiplexing) and 
DWDM (dense wavelength division multiplexing) network views.

Tools/Equipment None

Prerequisite procedures DLP-G46 Log into CTC, page 2-25

Required/As needed As needed

Onsite/Remote Onsite or remote

Security Level Retrieve or higher

Purpose This procedure modifies and deletes card protection settings.

Tools/Equipment None

Prerequisite Procedures NTP-G33 Create a Y-Cable Protection Group, page 3-33

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G175 Modify a Y-Cable Protection Group

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 In the Protection Groups area, click the Y-cable protection group that you want to modify.

Step 3 In the Selected Group area, you can modify the following, as needed:

• Name—Type the changes to the protection group name. The name can have up to 32 alphanumeric 
characters.

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions 
stay corrected for the amount of time chosen from the Reversion Time list. Uncheck this box if you 
do not want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the 
Reversion time drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is 
the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert 
when conditions causing the switch are cleared.

Step 4 Click Apply. Confirm that the changes appear; if not, repeat the task.

Step 5 Return to your originating procedure (NTP).

Purpose This task modifies a Y-cable protection group for any client port on a 
MXP_2.5G_10G, TXP_MR_2.5G, or TXP_MR_10G card.

Tools/Equipment None

Prerequisite Procedures NTP-G33 Create a Y-Cable Protection Group, page 3-33

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G176 Modify a Splitter Protection Group

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 In the Protection Groups area, click the Splitter protection group that you want to modify.

Step 3 In the Selected Group area, you can modify the following, as needed:

• Name—Type the changes to the protection group name. The name can have up to 32 alphanumeric 
characters.

• Revertive—Check this box if you want traffic to revert to the working card after failure conditions 
stay corrected for the amount of time chosen from the Reversion Time list. Uncheck this box if you 
do not want traffic to revert.

• Reversion time—If the Revertive check box is selected, choose the reversion time from the 
Reversion time drop-down list. The range is 0.5 to 12.0 minutes. The default is 5.0 minutes. This is 
the amount of time that will elapse before the traffic reverts to the working card. Traffic can revert 
when conditions causing the switch are cleared.

Step 4 Click Apply. Confirm that the changes appear; if not, repeat the task.

Step 5 Return to your originating procedure (NTP).

DLP-G177 Delete a Y-Cable Protection Group 

Step 1 In node view, click the Provisioning > Protection tabs.

Step 2 In the Protection Groups area, click the protection group you want to delete.

Step 3 Click Delete.

Purpose This task modifies a Splitter protection group for any client port on a 
TXPP_MR_2.5G card or MXPP_MR_2.5G. Splitter protection is 
automatically created when the TXPP transponder or MXPP muxponder 
card is installed.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose  This task deletes a Y-Cable protection group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Yes in the Delete Protection Group dialog box. Confirm that the changes appear; if they do not, 
repeat Steps 1 through 3. 

Step 5 Return to your originating procedure (NTP).

NTP-G84 Initiate and Clear Y-Cable and Splitter External 
Switching Commands

Note Splitter protection groups are automatically created when you install a TXPP_MR_2.5G or 
MXPP_MR_2.5G card.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 To perform a Manual protection switch, complete the “DLP-G178 Apply a Manual Y-Cable or Splitter 
Protection Switch” task on page 9-24. 

Step 3 To perform a Force protection switch, complete the “DLP-G179 Apply a Force Y-Cable or Splitter 
Protection Switch” task on page 9-24. 

Step 4 To clear a Force or Manual protection switch, complete the “DLP-G180 Clear a Manual or Force Y-Cable 
or Splitter Protection Switch” task on page 9-25.

Step 5 To prevent traffic on a working or protect card from switching to the other card in the pair, complete the 
“DLP-G181 Apply a Lock On” task on page 9-26.

Step 6 To prevent traffic from switching to the protect card, complete the “DLP-G182 Apply a Lock Out” task 
on page 9-26.

Step 7 To remove a lock-on or lockout and return a protection group to its usual switching method, complete 
the “DLP-G183 Clear a Lock On or Lock Out” task on page 9-27.

Stop. You have completed this procedure.

Purpose This procedure describes how to apply and remove a Manual and Force 
protection switches on Y-cable and splitter protection groups. It also 
describes how to apply and remove a Lock On or Lock Out protection 
command to a Y-cable protection group.

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

NTP-G33 Create a Y-Cable Protection Group, page 3-33 

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch

Caution A Manual switch will move traffic from the active to the standby card only if network conditions permit 
it. If conditions change during the switch, CTC will attempt to place traffic back on the original active 
card. 

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the Y-cable or splitter protection group where you want to apply the 
Manual protection switch.

Step 3 In the Selected Group area, click the active card or port.

Step 4 From Switch Commands, click Manual.

Step 5 In the Confirm Manual Operation dialog box, click Yes.

If conditions permit, the Manual switch will be applied. To clear the Manual switch, see the “DLP-G180 
Clear a Manual or Force Y-Cable or Splitter Protection Switch” task on page 9-25.

Step 6 Return to your originating procedure (NTP).

DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch

Caution A Force switch will move traffic from the active to the standby card or port immediately, regardless of 
network conditions. The switch will remain in effect until it is cleared. 

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups list, click the Y-cable or splitter protection group where you want to apply the 
Force protection switch.

Purpose This task performs a Manual protection switch on a Y-cable or splitter 
protection group. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This task performs a Force protection switch on a Y-cable or splitter 
protection group. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Step 3 In the Selected Group area, click the active card or port.

Step 4 From Switch Commands, click Force.

Step 5 In the Confirm Manual Operation dialog box, click Yes.

The Manual switch will be applied. To clear the Force switch, see the “DLP-G180 Clear a Manual or 
Force Y-Cable or Splitter Protection Switch” task on page 9-25.

Step 6 Return to your originating procedure (NTP).

DLP-G180 Clear a Manual or Force Y-Cable or Splitter Protection Switch

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card you want to clear.

Step 3 In the Selected Group area, click the card you want to clear.

Step 4 From Switch Commands, click Clear.

Step 5 Click Yes in the confirmation dialog box.

The Manual or Force protection switch is cleared.

Step 6 Return to your originating procedure (NTP).

Purpose This task clears a Manual or Force protection switch on a Y-Cable or 
splitter protection group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G178 Apply a Manual Y-Cable or Splitter Protection Switch, page 
9-24 or

DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch, page 
9-24

Required/As Needed As needed

Onsite/Remote Both

Security Level Maintenance or higher
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DLP-G181 Apply a Lock On

Note You can apply the Lock On command only to the working/active card or port. If the working card or port 
is standby (traffic is switched), the Lock Out button is greyed.

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card (Y-cable) or port 
(Splitter) you want to lock on.

Step 3 In the Selected Group area, click the working/active card.

Step 4 From Inhibit Switching, click Lock On.

Step 5 Click Yes in the confirmation dialog box.

The lock on has been applied. Traffic cannot switch to the protect card. To clear the lock on, see the 
“DLP-G183 Clear a Lock On or Lock Out” task on page 9-27.

Note Provisioning a lock on raises a LOCKON-REQ or an FE-LOCKON condition on CTC. Clearing 
the lockout switch request clears these conditions.

Step 6 Return to your originating procedure (NTP).

DLP-G182 Apply a Lock Out

Note You can apply the Lock Out to the protect/standby card or port. If the protect card or port is active (traffic 
is switched), the Lock Out task cannot be performed.

Purpose This task prevents traffic from being switched from the working/active 
card in a Y-cable protection group or port in a splitter protection group.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This task keeps traffic from switching to the protect/standby card or 
port. The Lock Out command overrides the Force and Manual switching 
commands.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card (Y-cable) or port 
(Splitter) you want to lock out.

Step 3 In the Selected Group area, click the protect/standby card.

Step 4 From Inhibit Switching, click Lock Out.

Step 5 Click Yes in the confirmation dialog box.

The lock out has been applied. Traffic cannot switch to the protect card. To clear the lock out, see the 
“DLP-G183 Clear a Lock On or Lock Out” task on page 9-27.

Note Provisioning a lock out raises a LOCKOUT-REQ or an FE-LOCKOUT condition on CTC. 
Clearing the lockout switch request clears these conditions.

Step 6 Return to your originating procedure (NTP).

DLP-G183 Clear a Lock On or Lock Out

Step 1 In node view, click the Maintenance > Protection tabs.

Step 2 In the Protection Groups area, click the protection group that contains the card you want to clear.

Step 3 In the Selected Group area, click the card you want to clear.

Step 4 From Inhibit Switching, click Unlock.

Step 5 Click Yes in the confirmation dialog box.

The Lock On or Lock Out is cleared.

Step 6 Return to your originating procedure (NTP).

Purpose This task clears a lock on or lock out.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

DLP-G181 Apply a Lock On, page 9-26 or

DLP-G182 Apply a Lock Out, page 9-26

Required/As Needed As needed

Onsite/Remote Both

Security Level Maintenance or higher
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NTP-G85 Modify or Delete Communications Channel 
Terminations and Provisionable Patchcords

Caution Deleting a OSC termination can cause you to lose visibility of nodes that do not have other OSCs or 
network connections to the CTC computer.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 In node view, complete the following tasks as needed:

• To modify a GCC termination, complete the “DLP-G184 Change a GCC Termination” task on 
page 9-28.

• To delete a GCC termination, complete the “DLP-G185 Delete a GCC Termination” task on 
page 9-29.

• To delete an OSC termination, complete the “DLP-G186 Delete an OSC Termination” task on 
page 9-30.

• To delete a provisioning patchcord, complete the “DLP-G187 Delete a Provisionable Patchcord” 
task on page 9-30.

Stop. You have completed this procedure.

DLP-G184 Change a GCC Termination

Step 1 Click the Provisioning > Comm Channels > GCC tabs.

Purpose This procedure modifies and deletes GCC and OSC terminations, as well 
as deletes provisionable patchcords on the ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G76 Provision GCC Terminations, page 3-62 or

DLP-G75 Create OSC Terminations, page 3-61

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task modifies a GCC termination. You can enable or disable OSPF and 
enable or disable the foreign node setting.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Remote

Security Level Provisioning or higher
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Step 2 Click the GCC that you want to change.

Step 3 Click Edit.

Step 4 In the GCC Termination Editor dialog box, complete the following as necessary:

• GCC Rate—(Display only.) Indicates the GCC rate. 

• Disable OSPF on SDCC Link—If checked, Open Shortest Path First is disabled on the link. OSPF 
should be disabled only when the slot and port connect to third-party equipment that does not 
support OSPF. 

• Far End is Foreign—Check this box to specify that the GCC termination is a non-ONS node.

• Far end IP—If you checked the Far End is Foreign check box, type the IP address of the far-end node 
or leave the 0.0.0.0 default. An IP address of 0.0.0.0 means that any address can be used by the far 
end. 

Step 5 Click OK.

Step 6 Return to your origination procedure (NTP).

DLP-G185 Delete a GCC Termination

Step 1 Click the Provisioning > Comm Channel > GCC tabs.

Step 2 In the GCC Terminations pane, click Delete.

Step 3 In the Delete GCC Terminations dialog box, check Set port OOS check box if you want to place ports 
out of service.

Step 4 Click Yes. GCC-EOC alarms appear until all network GCC terminations are deleted and the ports are 
out of service. 

Step 5 Return to your originating procedure (NTP).

Purpose This task deletes the DWDM GCC terminations required for network setup 
when using the TXP_MR_10G, TXP_MR_2.5G, TXPP_MR_2.5G, and 
MXP_2.5G_10G cards.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G186 Delete an OSC Termination

Caution Deleting a OSC termination might cause node isolation and loss of visibility to nodes that do not have 
other OSCs or network connections to the CTC computer.

Step 1 Click the OSC tab.

Step 2 Click the OSC termination you want to delete and click Delete. 

Step 3 In the Delete OSC Termination confirmation box, click Yes. Confirm that the changes appear; if not, 
repeat the task.

Until all network OSC terminations are deleted, loss of signal (LOS) or power failure alarms on the 
Optical Booster (OPT-BST) amplifier, OSCM card, and OSC-CSM card might appear.

Step 4 Return to your originating procedure (NTP).

DLP-G187 Delete a Provisionable Patchcord

Note Deleting the GCC termination on a port also deletes the provisionable patchcord link on the port. 

Step 1 In node view, click the Provisioning > Comm Channels > Provisionable Patchcords tabs. If you are 
in network view, click Provisioning > Provisionable Patchcords tabs.

Step 2 Click the provisionable patchcord that you want to delete.

Step 3 Click Delete. 

Step 4 In the confirmation dialog box, click Yes.

Step 5 Return to your originating procedure (NTP).

Purpose This task deletes an OSC termination on the ONS 15454. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task deletes a provisionable patchcord. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning and higher
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NTP-G86 Convert a Pass-Through Connection to an Add/Drop 
Connection

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at an ONS 15454 on the network.

Step 2 In node view, click the Circuits tab. Delete the unidirectional or bidirectional pass-through optical 
channel network connection (OCHNC) that applies to the pass-through connection to be removed. 

Step 3 Remove the physical pass-through cabling. Click the Provisioning > WDM-ANS > Connections tabs 
to identify the card ports to be removed. The pass-through connection you are removing can be 
connected in both OADM and hub nodes. 

• For a hub node—Connect the 32DMX-O or 32DMX output port to the 32MUX-O input port.

• For an OADM node—Connect the AD-xC-xx.x drop (TX) port to the AD-xC-xx.x add (RX) port.

Step 4 Physically connect the proper client interface to the correct add and drop ports. 

Step 5 Delete the filter connections related to the pass-through connection that is being converted to an 
add/drop connection:

a. In node view, click the Provisioning > WDM-ANS > Port Status tabs.

b. Highlight the pass-through connections between ITU channel add and drop ports filters.

c. Click Delete.

Step 6 Create two new unidirectional OCHNCs (one heading east, the other heading west) to support the new 
add/drop channels. See the “DLP-G105 Provision DWDM Optical Channel Network Connections” task 
on page 6-9.

Step 7 As necessary, complete the “DLP-G99 Create a Provisionable Patchcord” task on page 5-12.

Step 8 As necessary, add an optical attenuator between the channel TX port of the OADM, 4MD-xx.x, or 
32DMX-O card and the DWDM RX port on the TXP, MXP, or OC-N line card.

Note If the channel is coming from a 32DMX-O, the optical power can be adjusted in CTC by 
modifying the value of the internal per-channel VOA. 

Purpose This procedure converts a pass-through connection into add/drop 
connections (one on the add side and the other on the drop side). Use this 
procedure during a network upgrade. Pass-through channel connections 
can be provided between channel input and output ports for the Channel 
OADM (AD-xC-xx.x), 4-Channel Multiplexer/Demultiplexer 
(4MD-xx.x), 32-Channel Multiplexer (32MUX-O), and 32-Channel 
Demultiplexer (32DMX-O and 32DMX) cards. You can set up 
pass-through connections in nodes that might require more add or drop 
channel capability or configuration.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 9 (Optional) The following verification steps might be needed for an intermediate node when a 
pass-through connection is converted: 

a. Verify that the received channels are at the specified power level. See the “NTP-G76 Verify Span 
Loss” procedure on page 9-2 for instructions.

b. Verify that the added channels are equalized with the express channels within +/– 1 dB. 

c. If the channels are not equalized with the express channels within +/– 1 dB, check the attenuation 
of the VOAs. 

d. Check all the fiber adapters to minimize their insertion losses. See the “NTP-G115 Clean Fiber 
Connectors” procedure on page 11-32 for instructions.

Stop. You have completed this procedure.

NTP-G87 Change Node Timing Parameters

Caution The following procedure might be service affecting and should be performed during a scheduled 
maintenance window.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Click the Provisioning > Timing > General tabs.

Step 4 In the General Timing section, change any of the following information:

• Timing Mode

Note Because mixed timing can cause timing loops, Cisco does not recommend using the 
Mixed Timing option. Use this mode with care.

• SSM Message Set

• Quality of RES

• Revertive

• Revertive Time

See the “NTP-G53 Set Up Timing” task on page 5-4 for field descriptions.

Purpose This procedure changes the timing parameters for the ONS 15454. To 
switch the timing reference, see the “NTP-G112 Change the Node Timing 
Reference” procedure on page 11-24.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 5-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 In the Reference Lists area, you can change the following information:

Note Reference lists define up to three timing references for the node and up to six BITS Out 
references. BITS Out references define the timing references used by equipment that can be 
attached to the node’s BITS Out pins on the backplane. If you attach equipment to BITS Out 
pins, you normally attach it to a node with Line mode because equipment near the external 
timing reference can be directly wired to the reference. 

• NE Reference

• BITS 1 Out

• BITS 2 Out

Step 6 Click the Provisioning > Timing > General tabs. 

Step 7 In the BITS In section, you can change the following information:

Note The BITS Facilities section sets the parameters for your BITS1 and BITS2 timing references. 
Many of these settings are determined by the timing source manufacturer. If equipment is timed 
through BITS Out, you can set timing parameters to meet the requirements of the equipment.

• BITS In State

• Coding

• State

• Framing

• Sync Messaging

• Admin SSM

Step 8 In the BITS In section, you can change the following information:

• BITS Out State

• Coding

• Framing

• AIS Threshold

• LBO

Step 9 Click Apply. Confirm that the changes appear; if not, repeat the task.

Caution Internal timing is Stratum 3 and not intended for permanent use. All ONS 15454s should be timed to a 
Stratum 2 or better primary reference source. 

Step 10 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.
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NTP-G88 Modify Users and Change Security

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G188 Change Security Policy—Single Node, page 9-34

• DLP-G189 Change Security Policy—Multiple Nodes, page 9-36

• DLP-G190 Change Node Access and PM Clearing Privilege, page 9-37

• DLP-G191 Change User Password and Security Level—Single Node, page 9-38

• DLP-G192 Change User Password and Security Level—Multiple Nodes, page 9-38

• DLP-G193 Delete User—Single Node, page 9-39

• DLP-G194 Delete User—Multiple Nodes, page 9-40

• DLP-G195 Log Out a User—Single Node, page 9-40

• DLP-G196 Log Out a User—Multiple Nodes, page 9-41

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G188 Change Security Policy—Single Node

Step 1 In node view, click the Provisioning > Security > Policy tabs.

Purpose This procedure modifies user and security properties for the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G23 Create Users and Assign Security, page 3-3

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task changes the security policy for a single node, including idle user 
timeouts, user lockouts, password changes, and concurrent login policies. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 2 If you want to modify the idle user timeout period, click the hour (H) and minute (M) arrows in the Idle 
User Timeout area for the security level you want to provision: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. The idle period time range is 0 and 16 hours, and 0 and 59 minutes. 
The user is logged out after the idle user timeout period is reached.

Step 3 In the User Lockout area, you can modify the following:

• Failed Logins Before Lockout—The number of failed login attempts a user can make before the user 
is locked out from the node. You can choose a value between 0 and 10.

• Manual Unlock by Superuser—Allows a user with Superuser privileges to manually unlock a user 
who has been locked out from a node.

• Lockout Duration—Sets the amount of time the user will be locked out after a failed login. You can 
choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

Step 4 In the Password Change area, you can modify the following:

• Prevent Reusing Last [ ] Passwords—Choose a value between 1 and 10 to set the number of different 
passwords the user must create before they can reuse a password.

• Cannot Change New Password for [ ] days—If checked, prevents users from changing their 
password for the specified period. The range is 20 to 95 days.

• Require Password Change on First Login to New Account—If checked, requires users to change 
their password the first time they log into their account.

Step 5 To require users to change their password at periodic intervals, check the Enforce Password Aging check 
box in the Password Aging area. If checked, provision the following parameters: 

• Aging Period—Sets the amount of time that must pass before the user must change their password 
for each security level: RETRIEVE, MAINTENANCE, PROVISIONING, and SUPERUSER. The 
range is 20 to 95 days.

• Warning—Sets the number days the user will be warned to change his or her password for each 
security level. The range is 2 to 20 days.

Step 6 In the Other area, you can provision the following: 

• Single Session Per User—If checked, limits users to one login session at one time.

• Disable Inactive User—If checked, disables users who do not log into the node for the period of time 
specified in the Inactive Duration box. The Inactive Duration range is 45 to 90 days.

Step 7 Click Apply. Confirm that the changes appear; if not, repeat the task.

Step 8 Return to your originating procedure (NTP).
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DLP-G189 Change Security Policy—Multiple Nodes

Step 1 From the View menu, choose Go to Network View.

Step 2 Click the Provisioning > Security > Policy tabs. A read-only table of nodes and their policies appears.

Step 3 Click a node on the table that you want to modify, then click Change.

Step 4 If you want to modify the idle user timeout period, click the hour (H) and minute (M) arrows in the Idle 
User Timeout area for the security level you want to provision: RETRIEVE, MAINTENANCE, 
PROVISIONING, or SUPERUSER. The idle period time range is 0 and 16 hours, and 0 and 59 minutes. 
The user is logged out after the idle user timeout period is reached.

Step 5 In the User Lockout area, you can modify the following:

• Failed Logins Before Lockout—The number of failed login attempts a user can make before the user 
is locked out from the node. You can choose a value between 0 and 10.

• Manual Unlock by Superuser—Allows a user with Superuser privileges to manually unlock a user 
who has been locked out from a node.

• Lockout Duration—Sets the amount of time the user will be locked out after a failed login. You can 
choose a value between 0 and 10 minutes, and 0 and 55 seconds (in five-second intervals).

Step 6 In the Password Change area, you can modify the following:

• Prevent Reusing Last [ ] Passwords—Choose a value between 1 and 10 to set the number of different 
passwords the user must create before they can reuse a password.

• Cannot Change New Password for [ ] days—If checked, prevents users from changing their 
password for the specified period. The range is 20 to 95 days.

• Require Password Change on First Login to New Account—If checked, requires users to change 
their password the first time they log into their account.

Step 7 To require users to change their password at periodic intervals, check the Enforce Password Aging check 
box in the Password Aging area. If checked, provision the following parameters: 

• Aging Period—Sets the amount of time that must pass before the user must change his or her 
password for each security level: RETRIEVE, MAINTENANCE, PROVISIONING, and 
SUPERUSER. The range is 20 to 95 days.

• Warning—Sets the number days the user will be warned to change their password for each security 
level. The range is 2 to 20 days.

Step 8 In the Other area, you can provision the following: 

• Single Session Per User—If checked, limits users to one login session at one time.

• Disable Inactive User—If checked, disables users who do not log into the node for the period of time 
specified in the Inactive Duration box. The Inactive Duration range is 45 to 90 days.

Purpose This task changes the security policy for multiple nodes including idle user 
timeouts, user lockouts, password change, and concurrent login policies. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 9 In the Select Applicable Nodes area, uncheck any nodes where you do not want to apply the changes.

Step 10 Click OK. 

Step 11 In the Security Policy Change Results dialog box, confirm that the changes are correct, then click OK.

Step 12 Return to your originating procedure (NTP).

DLP-G190 Change Node Access and PM Clearing Privilege

Step 1 In node view, click the Provisioning > Security > Access tabs. 

Step 2 In the Access area, provision the following: 

• LAN access—Sets the access paths to the node: 

– No LAN Access—Allows access to the node only through DCC connections. Access through 
the TCC2 RJ-45 port and backplane is not permitted.

– Backplane only—Allows access through DCC connections and the backplane. Access through 
the TCC2 RJ-45 port is not allowed.

– Front and Backplane—Allows access through DCC, TCC2 RJ-45, and backplane connections.

• Restore Timeout—Sets a time delay for the enabling of front and backplane access when DCC 
connections are lost and “DCC only” is chosen in LAN Access. Front and backplane access is 
enabled after the restore timeout period has passed. Front and backplane access is disabled as soon 
as DCC connections are restored. 

Step 3 In the Shell Access area, set the shell program used to access the node:

• Telnet—If chosen, allows access to the node using Telnet. Telnet is the terminal-remote host Internet 
protocol developed for the Advanced Agency Research Project Network (ARPANET). If chosen, 
choose the Telnet port. Port 23 is the default.

• SSH—If chosen, allows access to the node using the Secure Shell (SSH) program. SSH is a 
terminal-remote host Internet protocol that uses encrypted links. If chosen, Port 22 is the default 
port. It cannot be changed.

Step 4 In the PM Clearing Privilege field, choose the minimum security level that can clear node PM data: 
RETRIEVE, PROVISIONING, MAINTENANCE, or SUPERUSER.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task provisions the physical access points and shell programs used to 
connect to the ONS 15454 and sets the user security level that can clear 
node performance monitoring (PM) data.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G191 Change User Password and Security Level—Single Node

Step 1 In node view, click the Provisioning > Security > Users tabs.

Step 2 Click the user whose settings you want to modify, then click Change.

Step 3 In the Change User dialog box, you can:

• Change a user password.

• Modify the user security level.

• Lock out the user.

See the “DLP-G54 Create a New User—Single Node” procedure on page 3-4 for field descriptions.

Step 4 Click OK.

Note User settings that you changed during this task will not appear until that user logs off and logs 
back in.

Step 5 Return to your originating procedure (NTP).

DLP-G192 Change User Password and Security Level—Multiple Nodes

Note You must add the same user name and password to each node the user will access.

Step 1 From the View menu, choose Go to Network View. Verify that you can access all the nodes where you 
want to add users.

Step 2 Click the Provisioning > Security > Users tabs. Highlight the user’s name whose settings you want to 
change.

Step 3 Click Change. The Change User dialog box appears.

Purpose This task changes settings for an existing user at one node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task changes settings for an existing user at multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 4 In the Change User dialog box, you can:

• Change a user’s password.

• Modify the user’s security level.

• Lock out the user.

See the “DLP-G55 Create a New User—Multiple Nodes” task on page 3-4 for field descriptions.

Step 5 In the Select Applicable Nodes area, uncheck any nodes where you do not want to change the user’s 
settings (all network nodes are selected by default).

Step 6 Click OK. A Change Results confirmation dialog box appears. 

Step 7 Click OK to acknowledge the changes. Confirm that the changes appear; if not, repeat the task.

Step 8 Return to your originating procedure (NTP).

DLP-G193 Delete User—Single Node

Note You cannot delete a user who is currently logged in. To log out a user, you can complete the “DLP-G195 
Log Out a User—Single Node” task on page 9-40, or you can choose the “Logout before delete” option 
in the Delete User dialog box.

Note CTC will allow you to delete other Superusers if one Superuser remains. For example, you can delete 
the CISCO15 user if you have created another Superuser. Use this option with caution.

Step 1 In node view, click the Provisioning > Security > Users tabs.

Step 2 Choose the user you want to delete.

Step 3 Click Delete.

Step 4 In the Delete User dialog box, verify that the user name displayed is the one you want to delete. Click 
Logout before delete if the user is currently logged in. (You cannot delete users if they are logged in.)

Step 5 Click OK. Confirm that the changes appear; if not, repeat the task.

Step 6 Return to your originating procedure (NTP).

Purpose This task deletes an existing user from a single node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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DLP-G194 Delete User—Multiple Nodes

Note You cannot delete a user who is currently logged in. To log out a user, you can complete the “DLP-G196 
Log Out a User—Multiple Nodes” task on page 9-41, or you can choose the “Logout before delete” 
option in the Delete User dialog box.

Note CTC will allow you to delete other Superusers if one Superuser remains. For example, you can delete 
the CISCO15 user if you have created another Superuser. Use this option with caution.

Step 1 From the View menu, choose Go to Network View. 

Step 2 Click the Provisioning > Security tabs. Highlight the name of the user you want to delete.

Step 3 Click Delete. The Delete User dialog box appears.

Step 4 In the Select Applicable Nodes area, uncheck any nodes where you do not want to delete this user.

Step 5 Click OK. A User Deletion Results confirmation dialog box appears. 

Step 6 Click OK to acknowledge the changes. Confirm that the changes appear; if not, repeat the task.

Step 7 Return to your originating procedure (NTP).

DLP-G195 Log Out a User—Single Node

Step 1 In node view, click the Provisioning > Security > Active Logins tabs.

Step 2 Choose the user that you want to log out and click Logout.

Purpose This task deletes an existing user from multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task logs out a user from a single node.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 3 In the Logout User dialog box, check Lockout before Logout if you want to lock the user out. This 
prevents the user from logging in after logout based on parameters provided in the user lockouts in the 
Policy tab. A manual unlock by a Superuser is required, or the user is locked out for the amount of time 
specified in the Lockout Duration field. See the “DLP-G188 Change Security Policy—Single Node” task 
on page 9-34 for more information.

Step 4 Click OK.

Step 5 Click Yes to confirm the logout.

Step 6 Return to your originating procedure (NTP).

DLP-G196 Log Out a User—Multiple Nodes

Step 1 From the View menu, chose Go to Network View. 

Step 2 Click the Provisioning > Security > Active Logins tabs.

Step 3 Choose the user you want to log out.

Step 4 Click Logout.

Step 5 In the Logout User dialog box, check the nodes where you want to log out the user.

Step 6 Check Lockout before Logout if you want to lock the user out prior to logout. This prevents the user 
from logging in after logout based on user lockout parameters provisioned in the Policy tab. A manual 
unlock by a Superuser is required, or the user is locked out for the amount of time specified in the 
Lockout Duration field. See the “DLP-G189 Change Security Policy—Multiple Nodes” task on 
page 9-36 for more information.

Step 7 In the Select Applicable Nodes area, uncheck any nodes where you do not want to change the user’s 
settings (all network nodes are selected by default).

Step 8 Click OK.

Step 9 Return to your originating procedure (NTP).

Purpose This task logs out a user from multiple nodes.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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NTP-G89 Change SNMP Settings

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25. If you are already logged in, continue with 
Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G197 Modify SNMP Trap Destinations, page 9-42

• DLP-G198 Delete SNMP Trap Destinations, page 9-43

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G197 Modify SNMP Trap Destinations

Step 1 In node view, click the Provisioning > SNMP tabs.

Step 2 Select a trap from the Trap Destinations area.

For a description of SNMP traps, refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting 
Guide.

Step 3 Highlight the Destination row field entry under the Community column and change the entry to another 
valid community name.

Purpose This procedure modifies Simple Network Management Protocol (SNMP) 
settings for the ONS 15454.

Tools/Equipment None

Prerequisite Procedures NTP-G28 Set Up SNMP, page 3-22

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task modifies the SNMP trap destinations on an ONS 15454 including 
community name, default User Datagram Protocol (UDP) port, SNMP trap 
version, and maximum traps per second.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G198 Delete SNMP Trap Destinations
Note The community name is a form of authentication and access control. The community name 
assigned to the ONS 15454 is case-sensitive and must match the community name of the network 
management system.

Note The default UDP port for SNMP is 162. 

Step 4 Set the Trap Version field for either SNMPv1 or SNMPv2. 

Refer to your network management system (NMS) documentation to determine whether to use SNMPv1 
or SNMPv2.

Step 5 If you want the SNMP agent to accept SNMP SET requests on certain MIBs, click the Allow SNMP Sets 
check box. If this box is not checked, SET requests are rejected.

Step 6 If you want to set up the SNMP proxy feature to allow network management, message reporting, and 
performance statistics retrieval across ONS firewalls, click the Enable SNMP Proxy check box located 
on the SNMP tab.

Step 7 Click Apply.

Step 8 SNMP settings are now modified. To view SNMP information for each node, highlight the node IP 
address in the Trap Destinations area of the Trap Destinations area. Confirm that the changes appear; if 
not, repeat the task.

Step 9 Return to your originating procedure (NTP).

DLP-G198 Delete SNMP Trap Destinations 
 

Step 1 In node view, click the Provisioning > SNMP tabs.

Step 2 In the Trap Destinations area, click the trap you want to delete.

Step 3 Click Delete. A confirmation dialog box appears.

Step 4 Click Yes. Confirm that the changes appear; if not, repeat the task.

Step 5 Return to your originating procedure (NTP).

Purpose This task deletes SNMP trap destinations on an ONS 15454.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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C H A P T E R 10

Change Card Settings 

This chapter explains how to change line, performance monitoring (PM), and threshold settings on 
Cisco ONS 15454 cards. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide as necessary.

Caution Changing card settings can be service affecting. You should make all changes during a scheduled 
maintenance window.

This section lists the chapter procedures (NTPs). Turn to a procedure for applicable tasks (DLPs).

1. NTP-G90 Modify Line Settings and PM Parameter Thresholds for Optical Service Channel Cards, 
page 10-2—As needed, complete this procedure to change the optical service channel (OSC) card 
settings.

2. NTP-G91 Modify Line Settings and PM Parameter Thresholds for Amplifier Cards, page 10-10—As 
needed, complete this procedure to change the amplifier card settings.

3. NTP-G92 Modify Line Settings and PM Parameter Thresholds for Multiplexer and Demultiplexer 
Cards, page 10-16—As needed, complete this procedure to change the multiplexer and 
demultiplexer card settings.

4. NTP-G93 Modify Line Settings and PM Parameter Thresholds for 32WSS Cards, page 10-22—As 
needed, complete this procedure to change the 32WSS card settings.

5. NTP-G94 Provision Pluggable Port Modules, page 10-29—As needed, complete this procedure to 
provision pluggable port modules (PPMs) for transponder (TXP) and muxponder (MXP) cards.

6. NTP-G95 Delete Pluggable Port Modules, page 10-31—As needed, complete this procedure to 
delete PPMs for TXP and MXP cards.

7. NTP-G96 Modify Line Settings and PM Parameter Thresholds for TXP_MR_10G and 
TXP_MR_10E Cards, page 10-32—As needed, complete this procedure to change line and 
threshold settings for TXP_MR_10G and TXP_MR_10E transponder cards.
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NTP-G90 Modify Line Settings and PM Parameter Thresholds for Optical Service Channel Cards
8. NTP-G97 Modify Line Settings and PM Parameter Thresholds for MXP_2.5G_10G and 
MXP_2.5G_10E Cards, page 10-43—As needed, complete this procedure to change line and 
threshold settings for MXP_2.5G_10G and MXP_2.5G_10E muxponder cards.

9. NTP-G98 Modify Line Settings and PM Parameter Thresholds for TXP_MR_2.5G and 
TXPP_MR_2.5G Cards, page 10-55—As needed, complete this procedure to change line and 
threshold settings for TXP_MR_2.5G and TXPP_MR_2.5G transponder cards.

10. NTP-G99 Modify Line Settings and PM Parameter Thresholds for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards, page 10-65—As needed, complete this procedure to change line and 
threshold settings for MXP_MR_2.5G and MXPP_MR_2.5G muxponder cards.

11. NTP-G100 Modify Alarm Interface Controller Settings (ANSI Only), page 10-77—As needed, 
complete this procedure to change settings for external alarms, controls, and orderwire for the AIC 
card.

12. NTP-G101 Modify Alarm Interface Controller–International Settings, page 10-80—As needed, 
complete this procedure to change settings for external alarms, controls, and orderwire for the AIC-I 
card.

13. NTP-G102 Change Card Service State, page 10-83—As needed, complete this procedure to change 
card service state. 

NTP-G90 Modify Line Settings and PM Parameter Thresholds for 
Optical Service Channel Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
OSCM or OSC-CSM card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G199 Change Optical Line Settings for OSCM and OSC-CSM Cards, page 10-3

• DLP-G200 Change Line Threshold Settings for OSCM and OSC-CSM Cards, page 10-5

• DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards, page 10-6

• DLP-G202 Change Optical Channel Threshold Settings for OSCM and OSC-CSM Cards, page 10-8

• DLP-G203 Change Maintenance Settings for Automatic Laser Shutdown, page 10-9

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure. 

Purpose This procedure changes the line and threshold settings for optical service 
channel cards (OSCM and OSC-CSM). 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G199 Change Optical Line Settings for OSCM and OSC-CSM Cards
DLP-G199 Change Optical Line Settings for OSCM and OSC-CSM Cards

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the OC-3 optical 
line settings.

Step 2 Click the Provisioning > OC3 Line > OC3 Line tabs. 

Step 3 Modify any of the settings described in Table 10-1. 

Purpose This task changes the OC-3 optical line settings for OSCM and OSC-CSM 
cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-1 OSCM and OSC-CSM Card OC-3 Optical Line Settings

Parameter Description Options

Port # Displays the port number. Display only

Port Name Provides the ability to assign the specified port 
a name.

User-defined. Name can be up to 32 alphanumeric/ special 
characters. Blank by default. 

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

SF BER Sets the signal fail bit error rate. • 1E-3

• 1E-4 

• 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

Provides 
Synch

Display only. If checked, the card is 
provisioned as a network element timing 
reference.

• Checked 

• Unchecked

Enable Synch 
Messages

Enables synchronization status messages (S1 
byte), which allow the node to choose the best 
timing source.

• Checked

• Unchecked

Send Do Not 
Use

When checked, sends a DUS (do not use) 
message on the S1 byte.

• Checked

• Unchecked

PJSTSMon # Display only. Sets the STS that will be used for 
pointer justification. If set to 0, no STS is 
monitored. Only one STS can be monitored on 
each OC-N port. 

• On

• Off
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DLP-G199 Change Optical Line Settings for OSCM and OSC-CSM Cards
Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State 
Model.”

• IS (ANSI) or Unlocked (ETSI)—Puts the port 
in-service. The port service state changes to IS-NR 
(ANSI) or Unlocked-enabled (ETSI).

• IS,AINS (ANSI) or 
Unlocked,automaticInService (ETSI)—Puts the port in 
automatic in-service. The port service state changes to 
OOS-AU,AINS (ANSI) or 
Unlocked-disabled,automaticInService (ETSI).

• OOS,DSBLD (ANSI) or Locked,disabled 
(ETSI)—Removes the port from service and disables it. 
The port service state changes to OOS-MA,DSBLD 
(ANSI) or Locked-enabled,disabled (ETSI).

• OOS,MT (ANSI) or Locked,maintenance 
(ETSI)—Removes the port from service for 
maintenance. The port service state changes to 
OOS-MA,MT (ANSI) or Locked-enabled,maintenance 
(ETSI).

Service State Identifies the autonomously generated state 
that gives the overall condition of the port. 
Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary 
State. For more information about service 
states, see Appendix C, “DWDM Enhanced 
State Model.”

• IS-NR (In-Service and Normal [ANSI]) or 
Unlocked-enabled (ETSI)— The port is fully 
operational and performing as provisioned.

• OOS-AU,AINS (Out-Of-Service and Autonomous, 
Automatic In-Service [ANSI]) or 
Unlocked-disabled,automaticInService (ETSI)— The 
port is out-of-service, but traffic is carried. Alarm 
reporting is suppressed. The ONS node monitors the 
ports for an error-free signal. After an error-free signal 
is detected, the port stays in the 
OOS-AU,AINS/Unlocked-disabled,automaticInService 
state for the duration of the soak period. After the soak 
period ends, the port service state changes to 
IS-NR/Unlocked-enabled. 

• OOS-MA,DSBLD (Out-of-Service and Management, 
Disabled [ANSI]) or Locked-enabled,disabled 
(ETSI)— The port is out-of-service and unable to carry 
traffic. 

• OOS-MA,MT (Out-of-Service and Management, 
Maintenance [ANSI]) or Locked-enabled,maintenance 
(ETSI)— The port is out-of-service for maintenance. 
Alarm reporting is suppressed, but traffic is carried and 
loopbacks are allowed.

Table 10-1 OSCM and OSC-CSM Card OC-3 Optical Line Settings (continued)

Parameter Description Options
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DLP-G200 Change Line Threshold Settings for OSCM and OSC-CSM Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G200 Change Line Threshold Settings for OSCM and OSC-CSM Cards

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the optical line 
threshold settings.

Step 2 Click the Provisioning > OC3 Line > SONET Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-2.

AINS Soak Sets the automatic in-service soak period. • Duration of valid input signal, in hh.mm format, after 
which the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments 

Type Defines the port as SONET or SDH. The 
Enable Sync Msg field and the Send Do Not 
Use field must be disabled before the port can 
be set to SDH.

• Sonet 

• SDH

Purpose This task changes the optical line threshold settings for OSCM and 
OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-2 OSCM and OSC-CSM Cards Optical Line Threshold Settings

Parameter Description Options

Port Displays the port number Display only

CV Coding violations Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. 

ES Errored seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. 

SES Severely errored seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. 

Table 10-1 OSCM and OSC-CSM Card OC-3 Optical Line Settings (continued)

Parameter Description Options
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DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the optical line 
parameters.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 10-3. 

SEFS (Section only.) Severely 
errored framing seconds

Numeric. Can be set for Far End, for 15-minute or one-day 
intervals for Section only. Select the bullet and click Refresh. 

FC Failure count Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section. Select the bullet and click Refresh or Path 
(Near and Far End).

UAS Unavailable seconds Numeric. Can be set for 15-minute or one-day intervals for 
Line or Section (Near and Far End). Select the bullet and click 
Refresh. 

Purpose This task changes the optical line parameters for OSCM and OSC-CSM 
cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-3 OSCM and OSC-CSM Card Optical Line Parameter Settings

Parameter Description Options

Port # Displays the port number and TX or RX. Read-only

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 6-8.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Table 10-2 OSCM and OSC-CSM Cards Optical Line Threshold Settings (continued)

Parameter Description Options
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DLP-G201 Change Optical Line Parameters for OSCM and OSC-CSM Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Line Direction Provides the ability to associate a card with the line 
direction. Use this field if you have two cards and 
must designate which one will carry the traffic flow 
from east to west. The second card will carry traffic 
from west to east. 

• East to West

• West to East

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service states 
appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information 
about service states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Type Identifies the type of port. Display only. • Input Com

• Output Com

• Input Line

• Output Line

• Input OSC

• Output OSC.

Power Shows the current power level per port. Display 
only. 

—

VOA Mode Shows the current functional mode of the variable 
optical attenuator (VOA). Display only. 

• Constant gain mode

• Constant power mode

• Not in use (N/A)

VOA Power 
Ref.

Shows the value of the optical output power going to 
a VOA when constant power mode is active. 
Automatic node setup (ANS) is the only function 
that can modify this value. Display only. 

—

VOA Power 
Calib.

The user can modify the optical output power to the 
VOA if necessary. This feature is normally used 
when the system is configured as “access” in 
Provisioning > WDM-ANS.

Numeric

VOA 
Attenuation 
Ref.

Shows the attenuation value of the VOA when the 
VOA is set in constant attenuation mode. ANS and 
amplifier power control (APC) are the only functions 
that can modify this value. Display only. 

—

VOA 
Attenuation 
Calib.

The user can modify the attenuation value of the 
VOA if necessary when the VOA mode is set for 
constant attenuation.

Numeric

Table 10-3 OSCM and OSC-CSM Card Optical Line Parameter Settings (continued)

Parameter Description Options
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DLP-G202 Change Optical Channel Threshold Settings for OSCM and OSC-CSM Cards
DLP-G202 Change Optical Channel Threshold Settings for OSCM and OSC-CSM 
Cards

Step 1 In node view, double-click the OSCM or OSC-CSM card where you want to change the optical channel 
threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-4.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the optical channel threshold settings for OSCM and 
OSC-CSM cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-4  OSCM and OSC-CSM Cards Optical Channel Thresholds Settings

Parameter Description Options

Port Display only. Displays the port number. —

Power Low 
(dBm)

Set the low power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 

Power High 
(dBm)

Set the high power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 
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DLP-G203 Change Maintenance Settings for Automatic Laser Shutdown

Step 1 In node view, double-click the OSC-CSM, OSCM, or OPT-BST amplifier where you want to change the 
ALS maintenance settings.

Step 2 Click the Maintenance > ALS tabs. 

Step 3 Modify any of the settings described in Table 10-5. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the maintenance settings for the automatic laser 
shutdown (ALS) feature on the OSC-CSM, OSCM, and OPT-BST 
amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-5  OSC-CSM, OSCM, or OPT-BST Amplifier Maintenance Settings

Parameter Description Options

OSRI Optical safety remote interlock. Shuts 
down the optical output power. When set 
to On, the amplifier cannot be 
unknowingly turned on.

On and off

ALS Mode Automatic laser shutdown. Provides the 
ability to automatically shut a potentially 
hazardous laser off.

• Disable

• Auto Restart

• Manual Restart

• Manual Restart for Test

Recovery Pulse 
Duration

Displays the duration of the optical power 
pulse that begins when an amplifier 
restarts. Display only. 

—

Recovery Pulse 
Interval

Displays the interval between optical 
power pulses. Display only. 

—

Currently 
Shutdown

Displays the current status of the laser. 
Display only. 

—

Request Laser 
Restart

If checked, allows you to restart the laser. 
Display only. 

Checked or unchecked
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NTP-G91 Modify Line Settings and PM Parameter Thresholds for 
Amplifier Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
OPT-PRE or OPT-BST amplifier card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers, page 10-10

• DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers, page 
10-12

• DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers, page 
10-13

• DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and OPT-BST Amplifiers, 
page 10-15

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure. 

DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers

Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 10-6. 

Purpose This procedure changes the line and threshold settings for the OPT-PRE 
and OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the optical line settings for OPT-PRE and OPT-BST 
amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G204 Change Optical Line Settings for OPT-PRE and OPT-BST Amplifiers
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 10-6 OPT-PRE and OPT-BST Amplifier Optical Line Settings

Parameter Description Options

Port # Displays the port number. Display only. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a name. User-defined. Name can be up to 
32 alphanumeric/special characters. Blank by 
default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 6-8.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the line 
direction. Use this field if you have two cards in the 
same shelf and must designate which one will carry the 
traffic flow from east to west. The second card will 
carry traffic from west to east. 

• East to West

• West to East

Service State Identifies the autonomously generated state that gives 
the overall condition of the port. Service states appear 
in the format: Primary State-Primary State Qualifier, 
Secondary State. For more information about service 
states, see Appendix C, “DWDM Enhanced State 
Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Type Identifies the type of port. Display only. • Input Com

• Output Com

• Input Line

• Output Line

• Input OSC

• Output OSC.

Power Shows the current power level per port. Display only. —
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DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST Amplifiers
DLP-G205 Change Optical Line Threshold Settings for OPT-PRE and OPT-BST 
Amplifiers

Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-7.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the optical line threshold settings for OPT-PRE and 
OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-7 OPT-PRE and OPT-BST Amplifiers Optical Line Thresholds Settings

Parameter Description Options

Port Display only. Displays the port number. —

Power Low 
(dBm)

Set the low power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 

Power High 
(dBm)

Set the high power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 
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DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers
DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST 
Amplifiers

Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
amplifier line settings.

Step 2 Click the Provisioning > Opt. Ampli. Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 10-8. 

Purpose This task changes the optical amplifier line settings for OPT-PRE and 
OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-8 OPT-PRE and OPT-BST Optical Amplifier Line Settings

Parameter Description Options

Port # Display only. Displays the port number. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the 
line direction. Use this field if you have two cards 
in the same shelf and must designate which one 
will carry the traffic flow from east to west. The 
second card will carry traffic from west to east. 

• East to West

• West to East

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
10-13
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 10      Change Card Settings
DLP-G206 Change Optical Amplifier Line Settings for OPT-PRE and OPT-BST Amplifiers
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Type Identifies the type of port. Display only. • Input Com

• Output Com

• Input Line

• Output Line

• Input OSC

• Output OSC.

Power Shows the current power level per port. Display 
only. 

—

Power Ref. Shows the optical power per channel leaving to the 
amplifier. Display only. 

—

Power Calib. The user can manually set the total optical power 
going to the amplifiers.

Numeric

Gain The current gain of the amplifiers. Display only. —

Gain Set Point The value of the gain that the amplifier must 
achieve. 

Display only or numeric depending on mode setting. 
When the system is configured as metro core, this field 
is Display only. When the system is configured as metro 
access this field can be changed by the user.

Tilt Reference This field is set to zero. It represents the default 
value for the amplifier tilt. In a future software 
release this value will be managed by APC. 
Display only. 

—

Tilt Calibration The user can manually set the amplifier tilt. Numeric

Mode Shows the working mode of the amplifier. Display 
only. 

Control gain

Control power

Table 10-8 OPT-PRE and OPT-BST Optical Amplifier Line Settings (continued)

Parameter Description Options
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DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and OPT-BST Amplifiers
DLP-G207 Change Optical Channel Threshold Settings for OPT-PRE and 
OPT-BST Amplifiers

Step 1 In node view, double-click the OPT-PRE or OPT-BST amplifier where you want to change the optical 
channel threshold settings.

Step 2 Click the Provisioning > Opt. Ampli. Line > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-9.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the optical channel threshold settings for OPT-PRE and 
OPT-BST amplifier cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-9 OPT-PRE and OPT-BST Amplifier Optical Channel Threshold Settings

Parameter Description Options

Port Display only. Displays the port number. —

Power Low 
(dBm)

Set the low power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 

Power High 
(dBm)

Set the high power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 
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NTP-G92 Modify Line Settings and PM Parameter Thresholds for 
Multiplexer and Demultiplexer Cards

Note Refer to the “Performance Monitoring” chapter in the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide for more information on MUX and DMX parameters.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
32MUX-O, 32DMX, or 4MD-xx.x card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer Cards, page 10-17

• DLP-G209 Change Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards, page 
10-18

• DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer Cards, page 10-19

• DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards, 
page 10-21

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure. 

Purpose This procedure changes the line and PM parameter threshold settings for 
the multiplexer and demultiplexer cards. The cards included in this 
category are the 32MUX-O,32DMX-O,32DMX, and4MD-xx.x cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer Cards
DLP-G208 Change Optical Line Settings for Multiplexer and Demultiplexer 
Cards

Step 1 In node view, double-click the multiplexer or demultiplexer cards where you want to change the optical 
line settings.

Step 2 Click the Provisioning > Optical Line > Parameters tabs. 

Step 3 Modify any of the settings described in Table 10-10. 

Purpose This task changes the optical line settings for 32MUX-O, 32DMX-O, 
32DMX, and 4MD xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-10 Multiplexer and Demultiplexer Card Optical Line Settings

Parameter Description Options

Port # Displays the port number. Display only. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the line 
direction. Use this field if you have two cards in the 
same shelf and must designate which one will carry 
the traffic flow from east to west. The second card 
will carry traffic from west to east. 

• East to West

• West to East

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
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DLP-G209 Change Optical Line Threshold Settings for Multiplexer and Demultiplexer Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G209 Change Optical Line Threshold Settings for Multiplexer and 
Demultiplexer Cards

Step 1 In node view, double-click the multiplexer or demultiplexer cards where you want to change the optical 
line threshold settings.

Step 2 Click the Provisioning > Optical Line > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-11.

Type  Identifies the type of port. Display only. • Input Com

• Output Com

• Input Line

• Output Line

• Input OSC

• Output OSC

Power Display only. Shows the current power level per 
port.

—

Purpose This task changes the optical line threshold settings for 32MUX-O, 
32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-11 Multiplexer and Demultiplexer Card Optical Line Thresholds Settings

Parameter Description Options

Port Display only. Displays the port number. —

Power Low 
(dBm)

Set the low power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 

Power High 
(dBm)

Set the high power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 

Table 10-10 Multiplexer and Demultiplexer Card Optical Line Settings (continued)

Parameter Description Options
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DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G210 Change Optical Channel Settings for Multiplexer and Demultiplexer 
Cards

Step 1 In node view, double-click the multiplexer or demultiplexer card where you want to change the optical 
channel settings.

Step 2 Click the Provisioning > Optical Chn > Parameters tabs. 

Step 3 Modify any of the settings described in Table 10-12. 

Purpose This task changes the optical channel settings for 32MUX-O, 32DMX-O, 
32DMX, and 4MD-xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-12 Multiplexer and Demultiplexer Card Optical Channel Settings

Parameter Description Options

Port # Display only. Displays the port number. Displays port number and TX or RX.

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Line Direction Provides the ability to associate a card with the line 
direction. Use this field if you have two cards in the 
same shelf and must designate which one will carry 
the traffic flow from east to west. The second card 
will carry traffic from west to east. 

• East to West

• West to East

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
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Type Display only. Identifies the type of port. • Input Com

• Output Com

• Input Line

• Output Line

• Input OSC

• Output OSC.

Power Display only. Shows the current power level per 
port.

—

VOA Mode Display only. Shows the current functional mode of 
the VOA: constant power or constant attenuation.

—

VOA Power 
Ref.

Display only. Shows the value of the optical output 
power going to a VOA when constant power mode 
is active. 

Dmux shows the reference value of the desired 
optical power going to the client. ANS is the only 
function that can modify this value (using the Pdrop 
parameter on the Provisioning tab).

Mux show the reference value of the desired 
per-channel optical power. ANS is the only 
function that can modify this value (using the Port 
Mux Stage parameter on the Provisioning tab).

—

VOA Power 
Calib.

The user can modify the optical output power to the 
VOA if necessary. The VOA power calibration 
offsets the VOA power reference.

Dmux allows you to modify the optical output 
power to the client if necessary. Mux allows you to 
modify the output power per channel.

This feature is normally used when the system is 
configured as “access” in Provisioning > 
WDM-ANS.

Numeric

VOA 
Attenuation 
Ref.

Display only. Shows the attenuation value of the 
VOA when the VOA is set in attenuation mode. 
ANS and APC are the only functions that can 
modify this value.

—

VOA 
Attenuation 
Calib.

Allows the user to modify the attenuation value of 
the VOA if necessary when the VOA mode is set for 
constant attenuation.

Numeric

Table 10-12 Multiplexer and Demultiplexer Card Optical Channel Settings (continued)

Parameter Description Options
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DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and Demultiplexer Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G211 Change Optical Channel Threshold Settings for Multiplexer and 
Demultiplexer Cards

Step 1 In node view, double-click the multiplexer or demultiplexer cards where you want to change the optical 
threshold settings.

Step 2 Click the Provisioning > Optical Chn > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-13.

Actual 
Wavelength

Display only. Shows the wavelength specified by 
the manufacturing data. This field cannot be set 
manually.

—

Expected 
Wavelength

Shows the preprovisioned wavelength. This field is 
used to preprovsion cards. For example, you can 
specify a generic AD-1C in Slot 15 and set the 
expected wavelength to 1552.52. The result is a 
AD-1C-52.5. If the actual equipment installed does 
not match the preprovisioned slot, a Mismatch 
Equipment Alarm (MEA) occurs.

Numeric

Purpose This task changes the optical channel threshold settings for 32MUX-O, 
32DMX-O, 32DMX, and 4MD-xx.x multiplexer and demultiplexer cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-13 Multiplexer and Demultiplexer Cards Optical Channel Threshold Settings

Parameter Description Options

Port Display only. Displays the port number. —

Power Low 
(dBm)

Set the low power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 

Power High 
(dBm)

Set the high power settings. Numeric. Can be set for 15-minute or 
one-day intervals for Warning or Alarm. 
Select the bullet and click Refresh. 

Table 10-12 Multiplexer and Demultiplexer Card Optical Channel Settings (continued)

Parameter Description Options
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NTP-G93 Modify Line Settings and PM Parameter Thresholds for 32WSS Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

NTP-G93 Modify Line Settings and PM Parameter Thresholds for 
32WSS Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
32WSS card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G212 Change Optical Channel Parameters for the 32WSS Card, page 10-23

• DLP-G213 Change Optical Channel Optics Thresholds for the 32WSS Card, page 10-25

Note To use the alarm profile tab, including creating alarm profiles and suppressing alarms, see 
Chapter 7, “Manage Alarms.”

• DLP-G214 Change Optical Line Parameters for the 32WSS Card, page 10-26

• DLP-G215 Change Optical Line Optics Thresholds for the 32WSS Card, page 10-28

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for the 32WSS card.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-26

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G212 Change Optical Channel Parameters for the 32WSS Card

Step 1 In node view, double-click the 32WSS card where you want to change the optical channel parameter 
settings.

Step 2 Click the Provisioning > Optical Chn: Optical Connector tab for one of the four optical channel: 
optical connector tabs (1 to 4) that are available.

Step 3 Modify any of the settings described in Table 10-14. 

Purpose This task changes the optical channel parameter settings for the 32WSS 
card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-14 32WSS Optical Channel Parameter Settings

Parameter Description Options

Port Display only. Port designation information. 
Each Optical Channel has a unique receive (RX) 
and a pass-through (PT) port in this field. For 
example, with the first two ports of Optical Chn: 
Optical Connector 1 are designated as 
1 CHAN-16-1-RX and 33 CHAN-16-1-PT. 
These ports are shown in the 32WSS display 
windows in top row of ADD RX ports as 01 and 
33.

—

Port Name The user can assign a logical name for each of 
the ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/special 
characters. Blank by default.

• See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. 
For more information about service states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
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DLP-G212 Change Optical Channel Parameters for the 32WSS Card
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Line Direction Display only. Displays the direction that the 
optical signal flows.

• West to East (the direction in which channels are 
added)

• East to West (the direction in which channels are 
dropped)

Type Port type • Add

• Passthrough

Power Power value read by the photodiode after the 
VOA.

• Numeric value (dB)

VOA Mode Displays VOA power mode. • Constant Power

VOA Power 
Reference

Display only. Displays VOA power reference. • Numeric value (dB)

VOA Power 
Calibration

Displays VOA power calibration. • Numeric value (dB)

• –37 dB to –2 dB

VOA 
Attenuation 
Reference

Display only. Displays VOA attenuation 
reference.

• Numeric value (dB)

VOA 
Attenuation 
Calibration

Displays VOA attenuation calibration. • Numeric value (dB)

• –30 dB to +30 dB

Actual 
Wavelength

Display only. Displays the actual wavelength 
utilized by the channel.

• Actual measured value (nm)

• UNKNOWN

Expected 
Wavelength

Display only. Displays the expected wavelength 
assigned for the channel.

• Value (nm) from the ITU-T grid specification

• UNKNOWN

Power ADD Display only. Displays Power Add, which is the 
value read by the photodiode before the VOA. 
Applicable only for ADD channels.

• Numeric value (dB)

Path Value Display only. Displays Path value. • Standby

AINS Soak Display only. Sets the automatic in-service soak 
period.

• Duration of valid input signal, in hh.mm format, after 
which the card becomes in service (IS) automatically

• 0 to 48 hours, 15-minute increments 

Table 10-14 32WSS Optical Channel Parameter Settings (continued)

Parameter Description Options
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DLP-G213 Change Optical Channel Optics Thresholds for the 32WSS Card
DLP-G213 Change Optical Channel Optics Thresholds for the 32WSS Card

Step 1 In node view, double-click the 32WSS card where you want to change the optical channel optics 
threshold settings.

Step 2 Click the Provisioning > Optical Chn: Optical Connector tab for one of the four optical channel: 
optical connector tabs (1 to 4) that are available.

Step 3 Click the Optics Thresholds tab to display the warnings thresholds settings for each port.

Step 4 Modify any of the settings described in Table 10-15. 

Step 5 Select the threshold alert type by clicking either the Warning or the Alarm radio button.

Step 6 Select the warning threshold interval by selecting either the 15 Min or 1 Day radio button.

Step 7 Click the Refresh button.

Step 8 Return to your originating procedure (NTP).

Purpose This task changes the optical channel optics threshold settings for the 
32WSS card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-15 32WSS Card Optical Channel Optics Threshold Settings

Parameter Description Options

Port Display only. Port designation information. 
Each Optical Channel has a unique RX and a 
PT port in this field. For example, the first two 
ports of Optical Ch: Optical Connector 1 are 
designated as 1 CHAN-16-1-RX and 
33 CHAN-16-1-PT. These two corresponding 
ports are shown in the 32WSS display 
windows in the top row as ADD RX Port 01 
and PT Port 33.

—

opwrMin 
(dBm)

Sets the warning thresholds minimum value 
(dBm).

User-defined value. Typically a negative 
optical power setting.

opwrMin 
(dBm)

Sets the warning thresholds maximum value 
(dBm).

User-defined value. Typically a positive 
optical power setting.
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DLP-G214 Change Optical Line Parameters for the 32WSS Card
DLP-G214 Change Optical Line Parameters for the 32WSS Card

Step 1 In node view, double-click the 32WSS card where you want to change the optical line parameter settings.

Step 2 Click the Provisioning > Optical Line > Parameters tab.

Step 3 Modify any of the settings described in Table 10-16. 

Purpose This task changes the optical line parameter settings for the 32WSS card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-16 32WSS Optical Line Parameter Settings

Parameter Description Options

Port Display only. Line designation information is 
read-only. 

The EXP-RX port receives an optical signal from 
another 32WSS module in the same network 
element. The EXP-TX port sends an optical signal to 
the other 32WSS module within the network 
element. For example, the two EXP ports are 
designated as 66 LINE-16-1-RX and 
65 LINE-16-1-TX.

The COM-TX port sends an aggregate optical signal 

to a booster card (for example, OSC-CSM or 
OSCM) for transmission outside of the network 
element. The COM-RX port receives the optical 

signal from a preamplifier and sends it to the optical 
splitter. For example, the two COM ports are 
designated as 67 LINE-16-2-TX and 
68 LINE-16-2-RX.

The DROP-TX port sends the split-off optical signal 

that contains drop channels to the 32DMX card, 
where the channels are further processed and 
dropped. For example, the DROP-TX port is 
designated as 69 LINE-16-3-TX.

—

Port Name The user can assign a logical name for each of the 
ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.
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Step 4 Return to your originating procedure (NTP).

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service states 
appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information 
about service states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

Line 
Direction

Display only. Displays the direction that the optical 
signal flows.

• West to East (the direction in which channels are 
added)

• East to West (the direction in which channels are 
dropped)

Type Port type. • Output Express

• Input Express

• Out Com

• Input Com

• Drop

Power Power value read by the photodiode associated with 
the port.

• Numeric value (dB)

AINS Soak Sets the automatic in-service soak period. • Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Table 10-16 32WSS Optical Line Parameter Settings (continued)

Parameter Description Options
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DLP-G215 Change Optical Line Optics Thresholds for the 32WSS Card

Step 1 In node view, double-click the 32WSS card where you want to change the optical line optics warning 
threshold settings.

Step 2 Click the Provisioning > Optical Line tab.

Step 3 Click the Optics Thresholds tab to display the warnings thresholds settings for each line.

Step 4 Modify any of the settings described in Table 10-17. 

Step 5 Select the threshold alert type by clicking either the Warning or the Alarm radio button.

Step 6 Select the warning threshold interval by selecting either the 15 Min or 1 Day radio button.

Purpose This task changes the optical line optics threshold settings for the 32WSS 
card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-17 32WSS Card Optical Line Optics Threshold Settings

Parameter Description Options

Port Display only. Line designation information is read-only. 

The EXP-RX port receives an optical signal from another 
32WSS module in the same network element. The EXP-TX 
port sends an optical signal to the other 32WSS module 
within the network element. For example, the two EXP 
ports are designated as 66 LINE-16-1-RX and 
65 LINE-16-1-TX.

The COM-TX port sends an aggregate optical signal to a 
booster card (for example, OSC-CSM or OSCM) for 
transmission outside of the network element. The 
COM-RX port receives the optical signal from a 
preamplifier and sends it to the optical splitter. For 
example, the two COM ports are designated as 
67 LINE-16-2-TX and 68 LINE-16-2-RX.

The DROP-TX port sends the split-off optical signal that 
contains drop channels to the 32DMX card where the 
channels are further processed and dropped. For example, 
the DROP-TX port is designated as 69 LINE-16-3-TX.

—

opwrMin 
(dBm)

Sets the warning thresholds minimum value (dBm). User-defined value. Typically a negative 
optical power setting.

opwrMin 
(dBm)

Sets the warning thresholds maximum value (dBm). User-defined value. Typically a positive 
optical power setting.
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Step 7 Click the Refresh button.

Step 8 Return to your originating procedure (NTP).

NTP-G94 Provision Pluggable Port Modules

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 to log into an ONS 15454 on the network.

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 7-32 as necessary.

b. Verify that no unexplained conditions appear on the network. If unexplained conditions appear, 
resolve them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting 
Guide.

c. Complete the “DLP-G114 Export CTC Data” task on page 7-4 to export alarm and condition 
information.

Step 3 In node view, double-click the card where you want to provision PPM settings. 

Step 4 Click the Provisioning > Pluggable Port Modules tabs. 

Step 5 In the Pluggable Port Modules pane, click Create. The Create PPM dialog box appears.

Step 6 In the Create PPM dialog box, complete the following:

• PPM—Click the slot number where the SFP is installed from the drop-down list.

• PPM Type—Click the number of ports supported by your SFP from the drop-down list. If only one 
port is supported, PPM (1 port) is the only menu option. 

Step 7 Click OK. The newly created port appears in the Pluggable Port Modules pane and the Pluggable Ports 
pane. 

Step 8 Repeat Steps 5 through 7 to create as many ports as needed.

Step 9 Click the PPM port row that appears in the Pluggable Port Modules pane. The highlight changes to dark 
blue.

Step 10 In the Selected PPM pane, click Create. The Create Port dialog box appears.

Step 11 In the Create Port dialog box, complete the following:

Purpose This procedure provisions pluggable port modules (PPMs) such as Small 
Form-factor Pluggables (SFPs) for TXP and MXP cards. Only the 
TXP_MR_10G does not accept PPMs. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

DLP-G63 Install an SFP, page 3-32

Required/As Needed Required

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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• Port—Click the PPM number and port number from the drop-down list. The first number indicates 
the PPM and the second number indicates the number of ports. For example, the first PPM with one 
port displays as 1-1 and the second PPM with one port displays as 2-1.

• Port Type—Click the type of port from the drop-down list. The port type menu displays supported 
port rates per card. See Table 10-18 for definitions of the supported rates per card. 

Step 12 Repeat Steps 9 through 11 to configure the port rates as needed.

Table 10-18 PPM Port Types

Card Port Type

TXP_MR_2.5G and 
TXPP_MR_2.5G

• OC-3/STM1—155 Mbps

• OC-12/STM4—622 Mbps

• OC-48/STM16—2.48 Gbps

• ONE_GE—One Gigabit Ethernet 1,125 Gbps

• ESCON—Enterprise System Connection (IBM signal)

• DV6000—Proprietary signal from video vendor

• SDI_D1_VIDEO—Serial Digital Interface and Digital Video 
signal type 1

• HDTV—High Definition Television

• PASS-THRU—Not specified

• FC1G—Fiber Channel 1,06 Gbps

• FC2G—Fiber Channel 2,125 Gbps

• FICON1G—Fiber CON 1,06 Gbps (IBM signal)

• FICON2G—Fiber CON 2,125 Gbps (IBM signal)

• ETR_CLO—IBM Sysplex timer

• ISC compat—InterSystem Coupling link (IBM signal)

• ISC peer—InterSystem Coupling link (IBM signal)

MXP_2.5G_10G and 
MXP_2.5G_10E

• OC-48/STM16—2.48 Gbps

TXP_MR_10E • OC-192/STM-64—10 Gbps

• 10G Ethernet LAN Phy—10 Gbps Ethernet

• 10G Fiber Channel—10 Gbps Fiber Channel

MXP_MR_2.5G and 
MXPP_MR_2.5G

• FC1G—Fiber Channel 1,06 Gbps

• FC2G—Fiber Channel 2,125 Gbps

• FICON1G—Fiber CON 1,06 Gbps (IBM signal)

• FICON2G—Fiber CON 2,125 Gbps (IBM signal)

• ONE_GE—One Gigabit Ethernet 1,125 Gbps
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Step 13 Click OK.

Stop. You have completed this procedure.

NTP-G95 Delete Pluggable Port Modules

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 to log into an ONS 15454 on the network.

Step 2 Click the Alarms tab:

a. Verify that the alarm filter is not turned on. See the “DLP-G128 Disable Alarm Filtering” task on 
page 7-32 as necessary.

b. Verify that no unexplained conditions appear on the network. If unexplained conditions appear, 
resolve them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting 
Guide.

c. Complete the “DLP-G114 Export CTC Data” task on page 7-4 to export alarm and condition 
information.

Step 3 In node view, double-click the card where you want to delete PPM settings. 

Step 4 Click the Provisioning > Pluggable Port Modules tabs. 

Step 5 To delete all PPM provisioning on a card:

a. Click the PPM line that appears in the Pluggable Port Modules pane. The highlight changes to dark 
blue.

b. Click Delete. The Delete PPM dialog box appears.

c. Click Yes. The PPM provisioning is removed from the Pluggable Port Modules pane and the 
Selected PPM pane.

Step 6 To delete PPM provisioning on a port:

a. Click the PPM line that appears in the Selected PPM pane. The highlight changes to dark blue.

b. Click Delete. The Delete Port dialog box appears.

c. Click Yes. The PPM provisioning is removed from the Selected PPM pane.

Stop. You have completed this procedure.

Purpose This procedure deletes PPMs such as SFPs for TXP and MXP cards. Only 
the TXP_MR_10G does not accept PPMs.

Tools/Equipment None

Prerequisite Procedures NTP-G94 Provision Pluggable Port Modules, page 10-29

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G96 Modify Line Settings and PM Parameter Thresholds for 
TXP_MR_10G and TXP_MR_10E Cards

Note The TXP_MR_10G card does not support PPMs.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
transponder card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards, page 10-33

• DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards, page 10-34

• DLP-G219 Change Line Threshold Settings for TXP_MR_10G and TXP_MR_10E Cards, page 
10-38

• DLP-G220 Change Optical Thresholds Settings for TXP_MR_10G and TXP_MR_10E Cards, page 
10-39

• DLP-G218 Change Section Trace Settings for the TXP_MR_10G Card, page 10-37

• DLP-G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards, page 10-40

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for TXP_MR_10G 
and TXP_MR_10E transponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

DLP-G63 Install an SFP, page 3-32

NTP-G94 Provision Pluggable Port Modules, page 10-29. 

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G216 Change Card Settings for TXP_MR_10G and TXP_MR_10E Cards

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the card 
settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 10-19. 

Purpose This task changes the card settings for TXP_MR_10G and TXP_MR_10E 
multirate (10 Gbps) transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-19 TXP_MR_10G and TXP_MR_10E Transponder Card Settings

Parameter Description Options

Termination 
Mode

Sets the mode of operation. See the 
“14.12 Transponder and Muxponder 
Termination Modes” section on 
page 14-122 for more information.

• Transparent

• Section (only for TXP_MR_10E)

• Line

AIS/Squelch 
Configuration

(TXP_MR_10E only.) Sets the 
transparent termination mode 
configuration.

• Squelch

• AIS

Wavelength Sets the wavelength of the dense 
wavelength division multiplexing 
(DWDM) side optical transmitter.

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
spacing

• Supported wavelengths are in white 
and marked by asterisks (**); 
unsupported wavelengths are gray 
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G217 Change Line Settings for TXP_MR_10G and TXP_MR_10E Cards

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the line 
settings.

Step 2 Click the Provisioning > Line > SONET (including 10G Ethernet WAN phy) tab. 

Step 3 Modify any of the settings described in Table 10-20. 

Regeneration 
Peer Slot

Sets the regeneration peer slot. • None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17

Regeneration 
Group Name

Sets the name of the regeneration group. Type the name in the field.

Card Parameters Displays available tunable wavelengths. Information field

Purpose This task changes the line settings for TXP_MR_10G and TXP_MR_10E 
transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-19 TXP_MR_10G and TXP_MR_10E Transponder Card Settings (continued)

Parameter Description Options
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Note In Table 10-20, some parameter tabs do not always apply to both the TXP_MR_10G and TXP_MR_10E 
cards. When the tabs do not apply, they will not appear to the user.

Table 10-20 TXP_MR_10G and TXP_MR_10E Transponder Card Line Settings

Parameter Description Options

Port Display only. Displays the port number. • 1-1 (OC192)

• 2 (Trunk)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 
32 alphanumeric/special characters. Blank by 
default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

SF BER (Cards with no PPM only.) Sets the signal fail bit 
error rate.

• 1E-3

• 1E-4 

• 1E-5

SD BER (Cards with no PPM only.) Sets the signal degrade 
bit error rate.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

AINS Soak (Cards with no PPM only.) Sets the automatic 
in-service soak period. Double click the time and 
use the up and down arrows to change settings.

• Duration of valid input signal, in hh.mm 
format, after which the card becomes in 
service (IS) automatically

• 0 to 48 hours, 15-minute increments 

Type (Cards with no PPM only.) The optical transport 
type.

• SONET

• SDH
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

ALS Mode Sets the automatic laser shutdown function mode. 
The DWDM transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or be 
set for three mode options.

•  Disable: ALS is off; the laser is not 
automatically shut down when traffic outages 
(LOS) occur.

•  Auto Restart: ALS is on; the laser 
automatically shuts down when traffic 
outages (LOS) occur. It automatically restarts 
when the conditions that caused the outage are 
resolved.

•  Manual Restart: ALS is on; the laser 
automatically shuts down when traffic 
outages (LOS) occur. However, the laser must 
be manually restarted when conditions that 
caused the outage are resolved.

•  Manual Restart for Test: Manually restarts 
the laser for testing.

ProvidesSync (TXP_MR_10E, OC192 only.) Sets the 
ProvidesSync card parameter. If checked, the card 
is provisioned as a network element timing 
reference.

Checked or unchecked

SyncMsgIn (TXP_MR_10E, OC192 only.) Sets the 
EnableSync card parameter. Enables 
synchronization status messages (S1 byte), which 
allow the node to choose the best timing source.

Checked or unchecked

Send DoNotUse (TXP_MR_10E, OC192 only.) Sets the Send 
DoNotUse card state. When checked, sends a DUS 
(do not use) message on the S1 byte.

Checked or unchecked

Max Size (TXP_MR_10E, 10_GE only.) Sets the maximum 
Ethernet packet size.

• 1548 bytes

• Jumbo (64 to 9,216 bytes)

Incoming MAC 
Address

(TXP_MR_10E, 10_GE only.) Sets the incoming 
MAC address

Value of MAC address. 6 bytes in hexadecimal 
format.

Table 10-20 TXP_MR_10G and TXP_MR_10E Transponder Card Line Settings (continued)

Parameter Description Options
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DLP-G218 Change Section Trace Settings for the TXP_MR_10G Card

Step 1 In node view, double-click the TXP_MR_10G card where you want to change the section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tab.

Note The Section Trace tab is available for the TXP_MR_10G card only if no PPM has been created or if only 
an OC192 PPM has been created. The tab is not available if a TEN_GE or FC10G PPM has been created.

Step 3 Modify any of the settings described in Table 10-21. 

Step 4 Click Apply. 

Purpose This task changes the section trace settings for the TXP_MR_10G 
transponder card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-21 TXP_MR_10G Transponder Card Section Trace Settings

Parameter Description Options

Port Sets the port number. • 1-1 (OC-192)

• 2 (Trunk)

Trace Mode Sets the trace mode. • Off/None

• Manual

Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; 
sets a new transmit string. You can select 
the Hex Mode or ASCII Mode button to 
change string input type.

String of trace string size

Expected Displays the current expected string; 
sets a new expected string. You can select 
the Hex Mode or ASCII Mode button to 
change string input type.

String of trace string size

Received Display only. Displays the current 
received string. You can press the Refresh 
button to manually refresh this display, or 
select the Auto-refresh every 5 sec check 
box to keep this panel updated.

String of trace string size
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Step 5 Return to your originating procedure (NTP).

DLP-G219 Change Line Threshold Settings for TXP_MR_10G and TXP_MR_10E 
Cards

Step 1 In node view, double-click the TXP_MR_10G card where you want to change the line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-22. 

Note The Line Thresholds setting are available for the TXP_MR_10E card only if no PPM has been created 
or if only an OC192 PPM has been created. The settings are not available if a TEN_GE or FC10G PPM 
has been created.

Purpose This task changes the line threshold settings for TXP_MR_10G and 
TXP_MR_10E transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-22 TXP_MR_10G and TXP_MR_10E Transponder Card Line Threshold Settings

Parameter Description Options

Port Display only. Port number • 1-1 (OC192)

• 2 (Trunk)

CV Coding violations Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Line, or 
Section. Select a bullet and click Refresh. 

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Line, or 
Section. Select a bullet and click Refresh.

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Line, or 
Section. Select a bullet and click Refresh.

SEFS (Section only.) Severely errored framing 
seconds

Numeric. Can be set for Far End, for 
15-minute or one-day intervals for 
Section only. Select the bullet and click 
Refresh. 
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G220 Change Optical Thresholds Settings for TXP_MR_10G and 
TXP_MR_10E Cards

Step 1 In node view, double-click the transponder card where you want to change the optical threshold settings.

Step 2 Click the Provisioning > Optical Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-23. 

FC Failure count Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Line, or 
Section. Select a bullet and click Refresh.

UAS Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Line, or 
Section. Select a bullet and click Refresh.

Purpose This task changes the optical threshold settings for TXP_MR_10G and 
TXP_MR_10E transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-23 TXP_MR_10G and TXP_MR_10E Transponder Card Optical Thresholds Settings

Parameter Description Options

Port Display only. Displays the port number 
and name.

• 1

• 2

Laser Bias 
High (%)

Sets the warning threshold for low laser 
bias current.

Numeric, in percent
Range 0 to 100 

RX Power 
High (dBm)

Sets the warning threshold for high 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 

RX Power Low 
(dBm)

Sets the warning threshold for low 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 

Table 10-22 TXP_MR_10G and TXP_MR_10E Transponder Card Line Threshold Settings (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Select the TCA or Alarm radio button.

Step 6 Select a 15 Min or 1 Day performance monitoring interval radio button (available for threshold crossing 
alerts [TCA] only), and then click Refresh.

Step 7 Return to your originating procedure (NTP).

DLP-G221 Change OTN Settings for TXP_MR_10G and TXP_MR_10E Cards

Step 1 In node view, double-click the TXP_MR_10G or TXP_MR_10E card where you want to change the OTN 
settings.

Step 2 Click lone of the Provisioning > OTN tabs (OTN Lines, G.709 Thresholds, FEC Thresholds, or Trail 
Trace Identifier). 

Step 3 Modify any of the settings described in Tables 10-24 through 10-27. 

Table 10-24 describes the values on the Provisioning > OTN > OTN Lines tab.

TX Power 
High (dBm)

Sets the warning threshold for high 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 

TX Power Low 
(dBm)

Sets the warning threshold for low 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 

Purpose This task changes the line optical transport network (OTN) settings for 
TXP_MR_10G and TXP_MR_10E transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-23 TXP_MR_10G and TXP_MR_10E Transponder Card Optical Thresholds Settings 

Parameter Description Options

Table 10-24 TXP_MR_10G and TXP_MR_10E Transponder Card OTN Settings

Parameter Description Options

Port # Display only. Displays the port number. 2

G.709 OTN Sets the OTN lines according to ITU-T 
G.709. Check box to enable.

• Enabled

• Disabled

FEC Sets the OTN lines FEC mode. FEC mode 
can be Disabled, Enabled or Enhanced 
FEC mode can be enabled (to provide 
greater range and lower bit error rate).

• Disabled (FEC OFF)

• Standard (FEC ON

• Enhanced (E-FEC ON)

SF BER Sets the signal fail bit error rate. • 1E-5
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Table 10-25 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 10-26 describes the values on the Provisioning > OTN > FEC Thresholds tab.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Asynch/Synch 
Mapping

(TXP_MR_10E only.) The card can 
perform multiplexing per ITU-T G.709. 
The ODUk (client SONET/SDH payload) 
can be mapped to the Optical Channel 
(OTUk) either asynchronously or 
synchronously with this setting.

• Asynch mapping

• Synch mapping

Table 10-24 TXP_MR_10G and TXP_MR_10E Transponder Card OTN Settings (continued)

Parameter Description Options

Table 10-25 TXP_MR_10G and TXP_MR_10E Transponder Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port Display only. Port number. 2

ES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC and 
overhead management and performance 
monitoring using OTUk. Selecting the 
PM radio button selects path performance 
monitoring using ODUk.

Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
the bullet and click Refresh. 
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Table 10-27 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 10-26 TXP_MR_10G and TXP_MR_10E Transponder Card FEC Threshold Settings

Parameter Description Options

Port Display only. Displays the port number 
and optional name.

2

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Uncorrectable 
Words

Displays the number of uncorrectable 
words in the selected time period.

Numeric display. Can be set for 
15-minute or one-day intervals. 

Table 10-27 TXP_MR_10G and TXP_MR_10E Transponder Card Trail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. • 1

• 2

Level Sets the level. • Section

• Path

Trace Mode Sets the trace mode. • Off/None

• Auto

• Manual

Transmit Displays the current transmit string;
sets a new transmit string.

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string;
sets a new expected string.

String of trace string size

Received Display only. Displays the current 
received string. You can press the Refresh 
button to manually refresh this display, or 
select the Auto-refresh every 5 sec check 
box to keep this panel updated.

String of trace string size
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NTP-G97 Modify Line Settings and PM Parameter Thresholds for 
MXP_2.5G_10G and MXP_2.5G_10E Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
muxponder card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP 2.5G_10E Cards, page 10-44

• DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP 2.5G_10E Cards, page 10-45

• DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 
10-47

• DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 10-48

• DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP 2.5G_10E Cards, page 
10-49

• DLP-G227 Change Optical Threshold Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, 
page 10-51

• DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards, page 10-52

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for 
MXP_2.5G_10G and MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30.

DLP-G63 Install an SFP, page 3-32

NTP-G94 Provision Pluggable Port Modules, page 10-29.

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G222 Change Card Settings for MXP_2.5G_10G and MXP 2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10G or and MXP_2.5G_10E card where you want to change 
the card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 10-28. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the card settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards, including payload type, termination 
mode, and wavelength. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-28 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Settings

Parameter Description Options

Termination 
Mode

Sets the mode of operation. Options that 
do not apply to a card do not display. See 
“14.12 Transponder and Muxponder 
Termination Modes” section on 
page 14-122 for more information.

• Transparent

• Section

• Line

Wavelength Sets the wavelength of the DWDM trunk 
side of the optical transmitter.

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
grid specification

• Supported wavelengths are in white 
and marked by asterisks (**); 
unsupported wavelengths are gray 

Card 
Parameters

Displays the settings for the card. Information only.
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DLP-G223 Change Line Settings for MXP_2.5G_10G and MXP 2.5G_10E Cards

Step 1 Double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the line settings.

Step 2 Click the Provisioning > Line > SONET tab. 

Note The SONET tab appears only if you have created a PPM for the card.

Step 3 Modify any of the settings described in Table 10-29. 

Purpose This task changes the line settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-29 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings

Parameter Description Options

Port # Display only. Displays the port number. Ports 1 to 
4 are client ports (OC-48/STS-16) and Port 5 is the 
DWDM trunk (OC-192/STS-64) that provides 
wavelength services.

• 1

• 2

• 3

• 4

• 5

Port Name Provides the ability to assign the specified port a 
logical name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

ALS Mode Sets the automatic laser shutdown function mode. 
The DWDM transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or be 
set for three mode options.

•  Disable: ALS is off; the laser is not automatically 
shut down when traffic outages (LOS) occur.

•  Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

•  Manual Restart: ALS is on; the laser 
automatically shuts down when traffic outages 
(LOS) occur. However, the laser must be manually 
restarted when conditions that caused the outage 
are resolved.

•  Manual Restart for Test: Manually restarts the 
laser for testing.

SF BER (Cards with no PPM only.) Sets the signal fail bit 
error rate.

• 1E-3

• 1E-4

• 1E-5

SD BER (Cards with no PPM only.) Sets the signal degrade 
bit error rate.

• 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

AINS Soak (Cards with no PPM only.) Sets the automatic 
in-service soak period. Double click the time and 
use the up and down arrows to change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type (Cards with no PPM only.) The optical transport 
type

• SONET

• SDH

ProvidesSync (Cards with no PPM only.) Sets the ProvidesSync 
card parameter. If checked, the card is provisioned 
as a network element timing reference.

Checked or unchecked

Enable Sync 
Msg

(Cards with no PPM only.) Enables 
synchronization status messages (S1 byte), which 
allow the node to choose the best timing source.

• Yes

• No

Send 
DoNotUse

(Cards with no PPM only.) When checked, sends a 
DUS (do not use) message on the S1 byte.

• Yes

• No 

Table 10-29 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Settings (continued)

Parameter Description Options
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DLP-G224 Change Section Trace Settings for MXP_2.5G_10G and 
MXP_2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10E or MXP_2.5G_10E card where you want to change the 
section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tab. 

Note The Section Trace tab appears only if you have created a PPM for the card.

Step 3 Modify any of the settings described in Table 10-30. 

Purpose This task changes the section trace settings for MXP_2.5G_10G and 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-30 TXP_MR_10G and MXP_MR_10E Muxponder Card Section Trace Settings

Parameter Description Options

Port Sets the port number. • 1

• 2

• 3

• 4

Trace Mode Sets the trace mode. • Off/None

• Manual

Section Trace 
String Size

Sets the trace string size. Select either 
radio button.

• 1 byte

• 16 byte

Transmit Displays the current transmit string; 
sets a new transmit string. You can select 
the Hex Mode or ASCII Mode button to 
change string input type.

String of trace string size

Expected Displays the current expected string; 
sets a new expected string. You can select 
the Hex Mode or ASCII Mode button to 
change string input type.

String of trace string size

Received Display only. Displays the current 
received string. You can press the Refresh 
button to manually refresh this display, or 
select the Auto-refresh every 5 sec check 
box to keep this panel updated.

String of trace string size
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G225 Change Trunk Settings for MXP_2.5G_10G and MXP_2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10E or MXP_2.5G_10E card where you want to change the 
section trace settings.

Step 2 Click the Provisioning > Line > Trunk tab. 

Step 3 Modify any of the settings described in Table 10-31. 

Purpose This task changes the trunk settings for MXP_2.5G_10G and 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-31 TXP_MR_10G and MXP_MR_10E Muxponder Card Trunk Settings

Parameter Description Options

Port # Display only. Displays the port number. Ports 1 to 4 
are client ports (OC-48/STS-16) and Port 5 is the 
DWDM trunk (OC-192/STS-64) that provides 
wavelength services

• 5

Port Name Provides the ability to assign the specified port a 
logical name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 6-8.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G226 Change Line Thresholds Settings for MXP_2.5G_10G and MXP 
2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-32. 

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service states 
appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information 
about service states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

ALS Mode Sets the automatic laser shutdown function mode. 
The DWDM transmitter supports ALS according to 
ITU-T G.644 (06/99). ALS can be disabled or be set 
for three mode options.

•  Disable: ALS is off; the laser is not 
automatically shut down when traffic outages 
(LOS) occur.

•  Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

•  Manual Restart: ALS is on; the laser 
automatically shuts down when traffic outages 
(LOS) occur. However, the laser must be 
manually restarted when conditions that caused 
the outage are resolved.

•  Manual Restart for Test: Manually restarts the 
laser for testing.

Purpose This task changes the line threshold settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-31 TXP_MR_10G and MXP_MR_10E Muxponder Card Trunk Settings (continued)

Parameter Description Options
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Note In Table 10-32, some parameter tabs or selections do not always apply to both the MXP_2.5G_10G and 
MXP_2.5G_10E cards. When the tabs or selections do not apply they do not appear to the user.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 10-32 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line Threshold Settings

Parameter Description Options

Port Display only. Port number • 1

• 2

• 3

• 4

• 5

CV Coding violations Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select a bullet and click Refresh. 

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SEFS (Section only.) Severely errored framing 
seconds 

Numeric. Can be set for Far End, for 
15-minute or one-day intervals for 
Section only. Select the bullet and click 
Refresh. 

FC (Line only.) Failure count Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh. 

UAS (Line only.) Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.
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DLP-G227 Change Optical Threshold Settings for MXP_2.5G_10G and 
MXP_2.5G_10E Cards

Step 1 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
optical threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-33. 

Step 4 Click Apply. 

Step 5 Select the TCA or Alarm radio button.

Step 6 Select a 15 Min or 1 Day interval radio button (available for TCA only), and then click Refresh.

Step 7 Return to your originating procedure (NTP).

Purpose This task changes the optical threshold settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-33 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Optical Threshold Settings

Parameter Description Options

Port Display only. Displays the port number. • 1

• 2

• 3

• 4

• 5

Laser Bias 
Low (%)

Sets the warning threshold for low laser 
bias current.

Numeric, in percent
Range 0 to 100 

RX Power 
High (dBm)

Sets the warning threshold for high 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 

RX Power Low 
(dBm)

Sets the warning threshold for low 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 

TX Power 
High (dBm)

Sets the warning threshold for high 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 

TX Power Low 
(dBm)

Sets the warning threshold for low 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 
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DLP-G228 Change Line OTN Settings for MXP_2.5G_10G and MXP_2.5G_10E 
Cards

Step 1 In node view, double-click the MXP_2.5G_10G or MXP_2.5G_10E card where you want to change the 
line OTN settings.

Step 2 Click one of the Provisioning > OTN tabs (OTN Lines, OTN G.709 Thresholds, FEC Thresholds, or 
Trail Trace Identifier tab). 

Step 3 Modify any of the settings described in Tables 10-34 through 10-37. 

Table 10-34 describes the values on the Provisioning > OTN > OTN Lines tab.

Note In Table 10-34, some parameter tabs or values do not always apply to both the MXP_2.5G_10G 
and MXP_2.5G_10E cards. When the tabs or values do not apply, they do not appear to the user.

Purpose This task changes the line OTN settings for MXP_2.5G_10G or 
MXP_2.5G_10E muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-34 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line OTN Settings

Parameter Description Options

Port # Display only. Displays the port number. 5

G.709 OTN Sets the OTN lines according to ITU-T 
G.709.

• Enabled

• Disabled

FEC Sets the OTN line FEC mode. FEC mode 
can be Disabled or Enabled. Enhanced 
FEC mode can be enabled (to provide 
greater range and lower bit error rate). 
E-FEC applies only to the 
MXP_2.5G_10E card.

• Disabled (FEC OFF)

• Standard (FEC ON)

• Enhanced (E-FEC ON)

SF BER Sets the signal fail bit error rate. • 1E-5
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Table 10-35 describes the values on the Provisioning > OTN > OTN G.709 Thresholds tab.

Table 10-36 describes the values on the Provisioning > OTN > FEC Thresholds tab.

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Asynch/Synch 
Mapping

The MXP_2.5G_10E can perform 
standard ODU multiplexing according to 
ITU-T G.709. The card uses this to 
aggregate the four OC-48 client signals.

• ODU Multiplex

Table 10-34 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Line OTN Settings (continued)

Parameter Description Options

Table 10-35 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card G.709 Threshold Settings

Parameter Description Options

Port Display only. Port number 5

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

SES Severely errored seconds. Two types of 
thresholds can be asserted. Selecting the 
SM (OTUk) radio button selects FEC and 
overhead management and performance 
monitoring using OTUk. Selecting the 
PM radio button selects path performance 
monitoring using ODUk.

Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for SM (OTUk) or PM (ODUk). Select 
a bullet and click Refresh. 
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Table 10-37 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 10-36 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card FEC Threshold Settings

Parameter Description Options

Port Display only. Displays the port number. 5

Bit Errors 
Corrected

Displays the number of bit errors 
corrected during the interval selected. 
The interval can be set for 15 minutes or 
one day.

Numeric

Uncorrectable 
Words

Displays the number of uncorrectable 
words during the interval selected. The 
interval can be set for 15 minutes or one 
day.

Numeric 

Table 10-37 MXP_2.5G_10G or MXP_2.5G_10E Muxponder Card Trail Trace Identifier Settings

Parameter Description Options

Port Sets the port number. The trail trace 
identifier is applicable only to the trunk 
interface, which handles G.709 frames.

• 5

Level Sets the level. • Section

• Path

Trace Mode Sets the trace mode. • Off/None

• Manual

Transmit Displays the current transmit string;
sets a new transmit string.

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string;
sets a new expected string.

String of trace string size

Received Display only. Displays the current 
received string. You can press the Refresh 
button to manually refresh this display, or 
select the Auto-refresh every 5 sec box to 
keep this panel updated.

String of trace string size
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NTP-G98 Modify Line Settings and PM Parameter Thresholds for 
TXP_MR_2.5G and TXPP_MR_2.5G Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
transponder card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 10-55

• DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 10-57

• DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 
10-58

• DLP-G232 Change Line Threshold Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 
10-59

• DLP-G233 Change Optical Thresholds Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, 
page 10-61

• DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards, page 10-62

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G229 Change Card Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Purpose This procedure changes the line and threshold settings for TXP_MR_2.5G 
and TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

DLP-G63 Install an SFP, page 3-32

NTP-G94 Provision Pluggable Port Modules, page 10-29

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes the card settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 10-38. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 10-38 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Settings

Parameter Description Options

Termination 
Mode

Sets the mode of operation (option only 
supported for SONET/SDH payloads). 
See “14.12 Transponder and Muxponder 
Termination Modes” section on 
page 14-122 for more information.

• Transparent

• Section

• Line

Wavelength Sets the wavelength of the DWDM side 
optical transmitter.

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
spacing

• Supported wavelengths are in white 
and marked by asterisks (**); 
unsupported wavelengths are gray.

Note The four available wavelengths 
are listed in the Card Parameters 
section of the window.

Regeneration 
Peer Slot

Sets the regeneration peer slot. • None

• 1

• 2

• 3

• 4

• 5

• 6

• 12

• 13

• 14

• 15

• 16

• 17

Regeneration 
Group Name

Sets the regeneration peer group name. User defined.
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DLP-G230 Change Line Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
line settings.

Step 2 Click the Provisioning > Line > tab and any additional PPM tabs (OC12, OC48, and so on). Tabs and 
parameter selections vary according to PPM provisioning.

Step 3 Modify any of the settings described in Table 10-39. 

Purpose This task changes the line settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-39 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings

Parameter Description Options

Port # Display only. Displays the port number. • 1

• 2 

• 3 (TXPP_MR_2.5G card only)

Port Name The user can assign a logical name for each of the 
ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task 
on page 6-8.

Admin State Sets the port service state unless network conditions 
prevent the change. For more information about 
administrative states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service states 
appear in the format: Primary State-Primary State 
Qualifier, Secondary State. For more information 
about service states, see Appendix C, “DWDM 
Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

ALS Mode Sets the automatic laser shutdown function. • Disabled

• Auto Restart

• Manual Restart

• Manual Restart for Test
10-57
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 10      Change Card Settings
DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G231 Change Section Trace Settings for TXP_MR_2.5G and 
TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
section trace settings.

Step 2 Click the Provisioning > Line > Section Trace tab. 

Step 3 Modify any of the settings described in Table 10-40. 

SF BER (OC-N and STM-N payloads only.) Sets the signal 
fail bit error rate.

• 1E-3

• 1E-4

• 1E-5

SD BER (OC-N and STM-N payloads only.) Sets the signal 
degrade bit error rat.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

AINS Soak (OC-N and STM-N payloads only.) Sets the 
automatic in-service soak period.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type The optical transport type. • SONET

• SDH

Purpose This task changes the section trace settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-39 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Settings (continued)

Parameter Description Options
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DLP-G232 Change Line Threshold Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G232 Change Line Threshold Settings for TXP_MR_2.5G 
and TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings as follows:

• For OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 payloads, see Table 10-41. 

• For 1G Ethernet, 1G, and 2G Fiber Channel/FICON payloads, see Table 10-42.

Table 10-40 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Section Trace Settings

Parameter Description Options

Port Sets the port number. • 1

• 2

• 3 (TXPP_MR_2.5G only)

Trace Mode Sets the trace mode. • Off/None

• Manual

Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; 
sets a new transmit string.

String of trace string size

Expected Displays the current expected string; 
sets a new expected string.

String of trace string size

Received Display only. Displays the current 
received string.

String of trace string size

Purpose This task changes the line threshold settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 10-41 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings

for OC-3/STM-1, OC-12/STM-4, and OC-48/STM-16 Payloads

Parameter Description Options

Port Display only. Port number • 1

• 2

• 3 (TXPP_MR_2.5G card only)

CV Coding violations Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

ES Errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SEFS (Section only.) Severely errored framing 
seconds 

Numeric. Can be set for Far End, for 
15-minute or one-day intervals for 
Section only. Select the bullet and click 
Refresh. 

FC (Line only.) Failure count Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals 
for Line only. Select the bullet and click 
Refresh. 

UAS (Line only.) Unavailable seconds Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Table 10-42 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings

for 1G Ethernet, 1G, and Fiber Channel/FICON Payloads

Parameter Description Options

Port Display only. Port number • 1

• 2

• 3 (TXPP_MR_2.5G card only)

Valid Packets (Line only.) Number of valid packets Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.
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DLP-G233 Change Optical Thresholds Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards
Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G233 Change Optical Thresholds Settings for TXP_MR_2.5G 
and TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
optical threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-43. 

Invalid Packets (Line only.) Number of invalid packets Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Code Group 
Violations

(Line only.) Number of code group 
violations

Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Idle Ordered 
Sets

(Line only.) Number of idle ordered sets Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Non Idle 
Ordered Sets

(Line only.) Number of non-idle ordered 
sets

Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Data Code 
Groups

(Line only.) Number of data code groups 
(excluding ordered sets)

Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

Purpose This task changes the optical threshold settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-42 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Line Thresholds Settings

for 1G Ethernet, 1G, and Fiber Channel/FICON Payloads (continued)

Parameter Description Options
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Step 4 Click Apply. 

Step 5 Click the Alarm radio button and click Refresh.

Step 6 Click Apply. 

Step 7 Return to your originating procedure (NTP).

DLP-G234 Change OTN Settings for TXP_MR_2.5G and TXPP_MR_2.5G Cards

Step 1 In node view, double-click the TXP_MR_2.5G or TXPP_MR_2.5G card where you want to change the 
OTN settings.

Step 2 Click one of the Provisioning > OTN tabs (OTN Lines, G.709 Thresholds, FEC Thresholds, or Trail 
Trace Identifier tab). 

Table 10-43 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Optics Thresholds Settings

Parameter Description Options

Port Display only. Displays the port number. • 1

• 2

• 3 (TXPP_MR_2.5G only)

Laser Bias 
Low (%)

Sets the warning threshold for low laser 
bias current.

Numeric, in percent
Range 0 to 100 (client side)
Range 0 to 100 (trunk side)

RX Power 
High (dBm)

Sets the warning threshold for high 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Range –40.0 to +30.0 (trunk side)

RX Power Low 
(dBm)

Sets the warning threshold for low 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Range –40.0 to +30.0 (trunk side)

TX Power 
High (dBm)

Sets the warning threshold for high 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Not applicable (trunk side)

TX Power Low 
(dBm)

Sets the warning threshold for low 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Not applicable (trunk side)

Purpose This task changes the OTN settings for TXP_MR_2.5G and 
TXPP_MR_2.5G transponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Modify any of the settings described in Tables 10-44 through 10-47. 

Table 10-44 describes the values on the Provisioning > OTN > OTN Lines tab.

Table 10-45 describes the values on the Provisioning > OTN > G.709 Thresholds tab.

Table 10-46 describes the values on the Provisioning > OTN > FEC Threshold tab.

Table 10-44 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card OTN Line Settings

Parameter Description Options

Port # Display only. Displays the port number. 2

G.709 OTN Sets the OTN lines according to ITU-T 
G.709.

• Enabled

• Disabled

FEC Sets the OTN lines to FEC. • Enabled

• Disabled

SF BER Sets the signal fail bit error rate. • 1E-5

SD BER Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7

• 1E-8

• 1E-9

Table 10-45 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card ITU-T G.709 Threshold Settings

Parameter Description Options

Port1 

1. Latency for 1G-FC payload without ITU-T G.709 is 4 microseconds, with ITU-T G.709 is 40 microseconds. Latency for 
2G-FC payload without ITU-T G.709 is 2 microseconds, with ITU-T G.709 is 20 microseconds. Consider these values when 
planning a FC network that is sensitive to latency.

Display only. Port number 2

ES Errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) 
or PM (ODUk). Select a bullet and click Refresh. 

SES Severely errored seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) 
or PM (ODUk). Select a bullet and click Refresh. 

UAS Unavailable seconds Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) 
or PM (ODUk). Select a bullet and click Refresh. 

BBE Background block errors Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) 
or PM (ODUk). Select a bullet and click Refresh. 

FC Failure counter Numeric. Can be set for Near End or Far End, for 
15-minute or one-day intervals, or for SM (OTUk) 
or PM (ODUk). Select a bullet and click Refresh. 
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Table 10-47 describes the values on the Provisioning > OTN > Trail Trace Identifier tab.

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Table 10-46 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card FEC Threshold Settings

Parameter Description Options

Port Display only. Displays the port number. 2

Bit Errors 
Corrected

Sets the value for bit errors corrected. Numeric. Can be set for 15-minute or 
one-day intervals. 

Uncorrectable 
Words

Sets the value for uncorrectable words. Numeric. Can be set for 15-minute or 
one-day intervals. 

Table 10-47 TXP_MR_2.5G and TXPP_MR_2.5G Transponder Card Trail Trace Identifier Settings

Parameter Description Options

Level Sets the level. • Section

• Path

Trace Mode Sets the trace mode. • Off/None

• Manual

Transmit Displays the current transmit string;
sets a new transmit string.

String of trace string size;
trail trace identifier is 64 bytes in length.

Expected Displays the current expected string;
sets a new expected string.

String of trace string size

Received Display only. Displays the current 
received string.

String of trace string size
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NTP-G99 Modify Line Settings and PM Parameter Thresholds for 
MXP_MR_2.5G and MXPP_MR_2.5G Cards

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
muxponder card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 10-66

• DLP-G236 Change Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 10-67

• DLP-G237 Change Distance Extension Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, 
page 10-69

• DLP-G238 Change OC48 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 10-70

• DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 
10-72

• DLP-G240 Change Line Threshold Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, page 
10-73

• DLP-G241 Change Optical Thresholds Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards, 
page 10-75

Note To use the Alarm Profiles tab, including creating alarm profiles and suppressing alarms, see 
Chapter 7, “Manage Alarms.”

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

Purpose This procedure changes the line and threshold settings for MXP_MR_2.5G 
and MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

DLP-G63 Install an SFP, page 3-32

NTP-G94 Provision Pluggable Port Modules, page 10-29

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G235 Change Card Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Note Card settings can be changed only if the facilities are out-of-service (OOS).

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
card settings.

Step 2 Click the Provisioning > Card tabs. 

Step 3 Modify any of the settings described in Table 10-48. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Purpose This task changes the card settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-48 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Settings

Parameter Description Options

Card Mode Sets the mode of operation (option only 
supported for SONET/SDH payloads). 

Note: this setting is not currently 
supported. The only option available 
currently is FC-GE.

• FC-GE

Wavelength Sets the wavelength of the DWDM side 
optical transmitter.

• First Tunable Wavelength

• Further wavelengths in 100-GHz ITU 
spacing

• Supported wavelengths are in white 
and marked by asterisks (**); 
unsupported wavelengths are gray.

Note The four available wavelengths 
are listed in the Card Parameters 
section of the window.
10-66
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 10      Change Card Settings
DLP-G236 Change Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards
DLP-G236 Change Line Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
line settings.

Step 2 Click the Provisioning > Line > tab and any additional tabs (Client, Distance Extension, OC48, Section 
Trace, and so on). Tabs and parameter selections vary according to PPM provisioning.

Step 3 Modify any of the settings for the Client tab as described in Table 10-49. 

Purpose This task changes the line settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-49 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Client Tab Settings

Parameter Description Options

Port # Display only. Displays the port number. • 1

• 2 

• 3

• 4

• 5

• 6

• 7

• 8

• 9 (trunk for MXP_MR_2.5G) or 9-10 (trunk for 
MXPP_MR_2.5G)

Port Name The user can assign a logical name for each of the 
ports shown by filling in this field.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary State-Primary 
State Qualifier, Secondary State. For more 
information about service states, see Appendix C, 
“DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

ALS Mode Sets the automatic laser shutdown function. • Disabled

• Auto Restart

• Manual Restart

• Manual Restart for Test

SF BER1 (OC-N and STM-N payloads only.) Sets the signal 
fail bit error rate threshold.

• 1E-3

• 1E-4

• 1E-5

SD BER1 (OC-N and STM-N payloads only.) Sets the signal 
degrade bit error rate threshold.

• 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

AINS Soak (OC-N and STM-N payloads only.) Sets the 
automatic in-service soak period.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type The optical transport type • SONET

• SDH

1. BER and SD thresholds apply only to trunk ports (Port 9 for MXP_MR_2.5G and Ports 9-10 for MXPP_MR_2.5G).

Table 10-49 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Client Tab Settings (continued)

Parameter Description Options
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DLP-G237 Change Distance Extension Settings for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards

Note Distance extension settings can be changed only if the facilities are out-of-service (OOS).

Note The distance extension parameters only apply to client ports (1 to 8) and not to trunk ports (9 for 
MXP_MR_2.5G or 9 and 10 for MXPP_MR_2.5G).

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
distance extension settings.

Step 2 Click the Provisioning > Line > Distance Extension tab. Tabs and parameter selections vary according 
to PPM provisioning.

Step 3 Modify any of the settings for the Distance Extension tab as described in Table 10-50. 

Purpose This task changes the distance extension settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-50 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Distance Extension Settings

Parameter Description Options

Port # Display only. Displays the port number. • 1

• 2 

• 3

• 4

• 5

• 6

• 7

• 8

• 9 (trunk for MXP_MR_2.5G) or 9-10 
(trunk for MXPP_MR_2.5G)

Enable 
Distance 
Extension

Allows end-to-end distances of up to 
1600 km for 1GFC and up to 800 km for 
2GFC.

Checked or unchecked

Auto Detect 
Credits

Allows automatic detection of buffer 
credits for FC flow control.

Checked or unchecked
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G238 Change OC48 Settings for MXP_MR_2.5G and MXPP_MR_2.5G Cards

Note OC48 settings apply only to the trunk ports (9 for MXP_MR_2.5G and 9 and 10 for MXPP_MR_2.5G)

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
OC48 settings.

Step 2 Click the Provisioning > Line > OC48 tab. Tabs and parameter selections vary according to PPM 
provisioning.

Step 3 Modify any of the settings for the OC48 Extension tab as described in Table 10-51. 

Credits 
Available

Display only. Displays the number of 
buffer credits available.

• Numeric (range depends on the client 
equipment attached to the card)

Autothreshold 
GFP Buffers

This parameter allows the threshold of the 
GFP buffer between two MXP_MR_2.5G 
or two MXPP_MR_2.5G cards to be 
automatically adjust ed.

Checked or unchecked

GFP Buffers 
Available

Displays the number of GFP buffers 
available between two MXP_MR_2.5G 
or two MXPP_MR_2.5G cards.

• Numeric

Purpose This task changes the OC48 settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-50 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Distance Extension Settings 

Parameter Description Options
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Table 10-51 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line OC48 Tab Settings

Parameter Description Options

Port # Display only. Displays the port number. • 1

• 2 

• 3

• 4

• 5

• 6

• 7

• 8

• 9 (trunk for MXP_MR_2.5G) or 9-10 (trunk for 
MXPP_MR_2.5G)

Port Name Provides the ability to assign the specified port a 
name.

User-defined. Name can be up to 32 alphanumeric/ 
special characters. Blank by default.

See the “DLP-G104 Assign a Name to a Port” task on 
page 6-8.

Admin State Sets the port service state unless network 
conditions prevent the change. For more 
information about administrative states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS/Unlocked

• IS,AINS/Unlocked,automaticInService

• OOS,DSBLD/Locked,disabled

• OOS,MT/Locked,maintenance

Service State Identifies the autonomously generated state that 
gives the overall condition of the port. Service 
states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. 
For more information about service states, see 
Appendix C, “DWDM Enhanced State Model.”

• IS-NR/Unlocked-enabled

• OOS-AU,AINS/Unlocked-disabled,
automaticInService

• OOS-MA,DSBLD/Locked-enabled,disabled

• OOS-MA,MT/Locked-enabled,maintenance

ALS Mode Sets the automatic laser shutdown function mode. 
The DWDM transmitter supports ALS according 
to ITU-T G.644 (06/99). ALS can be disabled or 
be set for three mode options.

•  Disable: ALS is off; the laser is not automatically 
shut down when traffic outages (LOS) occur.

•  Auto Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that 
caused the outage are resolved.

•  Manual Restart: ALS is on; the laser automatically 
shuts down when traffic outages (LOS) occur. 
However, the laser must be manually restarted when 
conditions that caused the outage are resolved.

•  Manual Restart for Test: Manually restarts the laser 
for testing.

SF BER1 Sets the signal fail bit error rate. • 1E-3

• 1E-4 

• 1E-5
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G239 Change Section Trace Settings for MXP_MR_2.5G and 
MXPP_MR_2.5G Cards

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
section trace settings.

SD BER1 Sets the signal degrade bit error rate. • 1E-5

• 1E-6

• 1E-7 

• 1E-8

• 1E-9

AINS Soak Sets the automatic in-service soak period. Double 
click the time and use the up and down arrows to 
change settings.

• Duration of valid input signal, in hh.mm format, 
after which the card becomes in service (IS) 
automatically

• 0 to 48 hours, 15-minute increments 

Type The optical transport type. • SONET

• SDH

ProvidesSync Sets the ProvidesSync card parameter. If 
checked, the card is provisioned as a network 
element timing reference.

Checked or unchecked

SyncMsgIn Sets the EnableSync card parameter. Enables 
synchronization status messages (S1 byte), which 
allow the node to choose the best timing source.

Checked or unchecked

Send 
DoNotUse

Sets the Send DoNotUse card state. When 
checked, sends a DUS (do not use) message on 
the S1 byte.

Checked or unchecked

1. BER and SD thresholds apply only to trunk ports (Port 9 for MXP_MR_2.5G and Ports 9 and 10 for MXPP_MR_2.5G).

Purpose This task changes the section trace settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-51 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line OC48 Tab Settings (continued)

Parameter Description Options
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Step 2 Click the Provisioning > Line > Section Trace tab. Tabs and parameter selections vary according to 
PPM provisioning.

Step 3 Modify any of the settings in the Section Trace tab as described in Table 10-52. 

Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G240 Change Line Threshold Settings for MXP_MR_2.5G 
and MXPP_MR_2.5G Cards

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
line threshold settings.

Step 2 Click the Provisioning > Line Thresholds tabs. 

Step 3 Modify any of the settings as shown in Table 10-53.

Table 10-52 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Section Trace Tab Settings

Parameter Description Options

Port Sets the port number. • 9 (trunk for MXP_MR_2.5G) or 9 
and 10 (trunk for MXPP_MR_2.5G)

Trace Mode Sets the trace mode. • Off/None

• Auto

• Manual

Section Trace 
String Size

Sets the trace string size. • 1 byte

• 16 byte

Transmit Displays the current transmit string; 
sets a new transmit string.

String of trace string size

Expected Displays the current expected string; 
sets a new expected string.

String of trace string size

Received Display only. Displays the current 
received string.

String of trace string size

Purpose This task changes the line threshold settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Table 10-53 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Threshold Settings

RMON Thresholds1

Index Identifies the threshold. Numeric

Slot/Port Identifies the slot and port to which the 
threshold applies.

Sx/Px, where x is a numeric value

Variable The particular remote monitoring 
(RMON) count under consideration for 
the threshold definition.

A text mnemonic, for example:
“gfpStatsRxSBitErrors”

Alarm Type The direction for which the alarm is to 
activate.

• Rising

• Falling

Sample Type Whether the samples should be absolute 
or relative.

• Absolute

• Relative

Sample Period The number of seconds for which the 
RMON count for the variable is 
accumulated.

Numeric (seconds)

Rising 
Threshold

The rising threshold value. Numeric

Falling 
Threshold

The falling threshold value. Numeric

SONET Thresholds2

Port Display only. Port number. • 9 (trunk for MXP_MR_2.5G)

• 9-10 (trunk for MXPP_MR_2.5G)

CV Coding violations. Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

ES Errored seconds. Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SES Severely errored seconds. Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
or for Line (Far End only), Section, or 
Path. Select the bullet and click Refresh. 

SEFS (Section only.) Severely errored framing 
seconds.

Numeric. Can be set for Far End, for 
15-minute or one-day intervals for 
Section only. Select the bullet and click 
Refresh. 
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Step 4 Click Apply. 

Step 5 Return to your originating procedure (NTP).

DLP-G241 Change Optical Thresholds Settings for MXP_MR_2.5G 
and MXPP_MR_2.5G Cards

Step 1 In node view, double-click the MXP_MR_2.5G or MXPP_MR_2.5G card where you want to change the 
optical threshold settings.

Step 2 Click the Provisioning > Optics Thresholds tabs. 

Step 3 Modify any of the settings described in Table 10-43. 

FC (Line only.) Failure count. Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals 
for Line only. Select the bullet and click 
Refresh. 

UAS (Line only.) Unavailable seconds. Numeric. Can be set for Near End or Far 
End, for 15-minute or one-day intervals, 
for Line only. Select the bullet and click 
Refresh.

1. RMON thresholds apply to all data types. A PPM must be defined for the port to be able to define a line threshold. This only 
applies to client Ports 1 to 8 and GFP facilities (trunk Port 9 for MXP_MR_2.5G or trunk Ports 9 to 10 for MXPP_MR_2.5G).

2. SONET thresholds apply only to trunk ports (9 for MXP_MR_2.5G or 9 to 10 for MXPP_MR_2.5G).

Purpose This task changes the optical threshold settings for MXP_MR_2.5G and 
MXPP_MR_2.5G muxponder cards. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Table 10-53 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Line Threshold Settings (continued)

RMON Thresholds1
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Step 4 Click Apply. 

Step 5 Select the TCA (Threshold Crossing Alert) or Alarm radio button.

Step 6 Select a 15 Min or 1 Day performance monitoring interval radio button (available for TCA only), and 
then click Refresh.

Step 7 Return to your originating procedure (NTP).

Table 10-54 MXP_MR_2.5G and MXPP_MR_2.5G Muxponder Card Optical Threshold Settings

Parameter Description Options

Port Display only. Displays the port number. • 1

• 2

• 3

• 4

• 5

• 6

• 7

• 8

• 9 (trunk for MXP_MR_2.5G)

• 9-10 (trunk for MXPP_MR_2.5G)

Laser Bias 
Low (%)

Sets the warning threshold for low laser 
bias current.

Numeric, in percent
Range 0 to 100 (client side)
Range 0 to 100 (trunk side)

RX Power 
High (dBm)

Sets the warning threshold for high 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Range –40.0 to +30.0 (trunk side)

RX Power Low 
(dBm)

Sets the warning threshold for low 
receiver input power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Range –40.0 to +30.0 (trunk side)

TX Power 
High (dBm)

Sets the warning threshold for high 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Not applicable (trunk side)

TX Power Low 
(dBm)

Sets the warning threshold for low 
transmitter output power.

Numeric, in dBm
Range –40.0 to +30.0 (client side)
Not applicable (trunk side)
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NTP-G100 Modify Alarm Interface Controller Settings (ANSI 
Only)

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
AIC card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G242 Change External Alarms Using the AIC Card, page 10-77

• DLP-G243 Change External Controls Using the AIC Card, page 10-78

• DLP-G244 Change Orderwire Settings Using the AIC Card, page 10-79

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G242 Change External Alarms Using the AIC Card 

Step 1 Confirm that external-device relays are wired to the ENVIR ALARMS IN backplane pins. See the 
“DLP-G23 Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-53 for more information.

Step 2 In node view, double-click the AIC card to display it in card view.

Step 3 Click the Provisioning > External Alarms tabs.

Purpose This procedure provisions the AIC card to receive input from, or send 
output to, external devices wired to the backplane (called external alarms 
and controls or environmental alarms) or to change orderwire settings.

Note that the AIC card is not compatible with the ETSI shelf.

Tools/Equipment None

Prerequisite Procedures NTP-G71 Provision External Alarms and Controls on the Alarm Interface 
Controller Card, page 7-36 

DLP-G109 Provision Orderwire, page 6-15

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes external alarm settings on the AIC card. This task applies 
to ONS 15454 ANSI shelves only. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Modify any of the following fields for each external device wired to the ONS 15454 backplane. For 
definitions of these fields, see the “NTP-G71 Provision External Alarms and Controls on the Alarm 
Interface Controller Card” procedure on page 7-36.

• Enabled

• Alarm Type

• Severity

• Virtual Wire

• Raised When 

• Description

Step 5 To provision additional devices, complete Step 4 for each additional device.

Step 6 Click Apply.

Step 7 Return to your originating procedure (NTP).

DLP-G243 Change External Controls Using the AIC Card

Step 1 Verify the external control relays to the ENVIR ALARMS OUT backplane pins. See the “DLP-G23 
Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-53 for more information. 

Step 2 In node view, double-click the AIC card to display it in card view.

Step 3 Click the Provisioning > External Controls tabs.

Step 4 Modify any of the following fields for each external control wired to the ONS 15454 backplane. For 
definitions of these fields, see the “NTP-G71 Provision External Alarms and Controls on the Alarm 
Interface Controller Card” procedure on page 7-36.

• Enabled 

• Trigger Type

• Control Type

• Description

Step 5 To provision additional controls, complete Step 4 for each additional device.

Step 6 Click Apply.

Step 7 Return to your originating procedure (NTP).

Purpose This task changes external control settings on the AIC card. This task 
applies to ONS 15454 ANSI shelves only. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G244 Change Orderwire Settings Using the AIC Card

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Step 1 In node view, double-click the AIC card to display it in card view.

Step 2 Click the Provisioning > Local Orderwire tabs or Provisioning > Express Orderwire tabs, depending 
on the orderwire path that you want to create. 

Step 3 If needed, adjust the transmit (Tx) and receive (Rx) decibel referred to one milliwatt (dBm) values by 
moving the slider to the right or left for the headset type (four-wire or two-wire) that you will use. In 
general, you should not need to adjust the dBm values.

Step 4 Click Apply.

Step 5 Return to your originating procedure (NTP).

Purpose This task changes orderwire settings on the AIC card. This task applies to 
ONS 15454 ANSI shelves only. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G101 Modify Alarm Interface Controller–International 
Settings

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
AIC-I card settings. If you are already logged in, proceed to Step 2.

Step 2 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Step 3 Perform any of the following tasks as needed:

• DLP-G245 Change External Alarms Using the AIC-I Card, page 10-80

• DLP-G246 Change External Controls Using the AIC-I Card, page 10-81

• DLP-G247 Change AIC-I Card Orderwire Settings, page 10-82

Step 4 Complete the “NTP-G103 Back Up the Database” procedure on page 11-2.

Stop. You have completed this procedure.

DLP-G245 Change External Alarms Using the AIC-I Card

Note The procedure is the same if you are using the alarm expansion panel (AEP). In this case, the number of 
contacts that are shown on the screen is changed accordingly. 

Step 1 Confirm that external-device relays are wired to the ENVIR ALARMS IN pins. See the “DLP-G20 
Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-48 (ETSI) or “DLP-G23 Install Alarm 
Wires on the Backplane (ANSI Only)” task on page 1-53 (ANSI) for more information.

Purpose This procedure provisions the AIC-I card to receive input from or send 
output to external devices wired to the backplane (called external alarms 
and controls or environmental alarms), or to change orderwire settings. 

Tools/Equipment None

Prerequisite Procedures NTP-G72 Provision External Alarms and Controls on the Alarm Interface 
Controller-International, page 7-38 

DLP-G109 Provision Orderwire, page 6-15

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task changes external alarm settings on the AIC-I card. 

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 2 Double-click the AIC-I card to display it in card view.

Step 3 Click the Provisioning > External Alarms tabs.

Step 4 Modify any of the following fields for each external device wired to the ONS 15454 backplane. For 
definitions of these fields, see the “NTP-G72 Provision External Alarms and Controls on the Alarm 
Interface Controller-International” procedure on page 7-38.

• Enabled

• Alarm Type

• Severity

• Virtual Wire

• Raised When 

• Description

Step 5 To provision additional devices, complete Step 4 for each additional device.

Step 6 Click Apply.

Step 7 Return to your originating procedure (NTP).

DLP-G246 Change External Controls Using the AIC-I Card

Note The procedure is the same if you are using the AEP. In this case, the number of contacts that are shown 
on the screen is changed accordingly. 

Step 1 Verify the external control relays to the ENVIR ALARMS OUT backplane pins. See the “DLP-G20 
Install Alarm Wires on the MIC-A/P (ETSI Only)” task on page 1-48 (ETSI) or “DLP-G23 Install Alarm 
Wires on the Backplane (ANSI Only)” task on page 1-53 (ANSI) for more information. 

Step 2 In node view, double-click the AIC-I card to display it in card view.

Step 3 On the External Controls subtab, modify any of the following fields for each external control wired to 
the ONS 15454 backplane. For definitions of these fields, see the “NTP-G72 Provision External Alarms 
and Controls on the Alarm Interface Controller-International” procedure on page 7-38.

• Enabled

• Trigger Type

• Control Type

• Description

Step 4 To provision additional controls, complete Step 3 for each additional device.

Purpose This task changes external control settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

DLP-G247 Change AIC-I Card Orderwire Settings

Caution When provisioning orderwire for ONS 15454s residing in a ring, do not provision a complete orderwire 
loop. For example, a four-node ring typically has east and west ports provisioned at all four nodes. 
However, to prevent orderwire loops, provision two orderwire ports (east and west) at all but one of the 
ring nodes.

Tip Before you begin, make a list of the ONS 15454 slots and ports that require orderwire communication.

Step 1 In node view, double-click the AIC-I card to display it in card view.

Step 2 Click the Provisioning > Local Orderwire tabs or the Provisioning > Express Orderwire tabs, 
depending on the orderwire path that you want to change. Provisioning steps are the same for both types 
of orderwire.

Step 3 If needed, adjust the Tx and Rx dBm values by moving the slider to the right or left for the headset type 
(four-wire or two-wire) that you will use. In general, you should not need to adjust the dBm values.

Step 4 If you want to turn on the audible alert (buzzer) for the orderwire, check the Buzzer On check box.

Step 5 Click Apply.

Step 6 Return to your originating procedure (NTP).

Purpose This task changes orderwire settings on the AIC-I card.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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NTP-G102 Change Card Service State

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to change the 
card service state.

Step 2 Click the Inventory tab.

Step 3 Click Admin State for the card you want to change, and choose an Admin state from the drop-down list:

• IS (In-Service [ANSI]) or Unlocked (ETSI)

• OOS,MT (Out-of-Service,Maintenance [ANSI]) or Locked-enabled (ETSI)

Step 4 Click Apply.

Step 5 If an error message appears indicating that the card state cannot be changed from its current state, click 
OK.

For information about the enhanced state model and card state transitions, refer to the “DWDM 
Enhanced State Model” section on page C-1.

Stop. You have completed this procedure.

Purpose This procedure changes card service state. 

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-26 or
NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Cisco ONS 15454 DWDM
September 2004
C H A P T E R 11

Maintain the Node

This chapter provides procedures for maintaining the Cisco ONS 15454, including database backups and 
restoration, removing and replacing cards, viewing the ONS 15454 audit trail, and hardware 
maintenance procedures such as cleaning fibers, changing the fan tray filter, and other maintenance 
procedures.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Before You Begin
Before performing any of the following procedures, investigate all alarms and clear any trouble 
conditions. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide as necessary for 
general troubleshooting information and alarm or error descriptions. 

This section lists the chapter procedures (NTPs). Turn to a procedure to view its tasks (DLPs).

1. NTP-G103 Back Up the Database, page 11-2—Complete as needed.

2. NTP-G104 Restore the Database, page 11-3—Complete as needed.

3. NTP-G105 Restore the Node to Factory Configuration, page 11-5—Complete as needed to clear the 
database and upload a blank database and the latest software.

4. NTP-G106 Reset Cards Using CTC, page 11-10—Complete as needed to reset the Advanced 
Timing, Communications, and Control (TCC2) and dense wavelength division multiplexing 
(DWDM) cards.

5. NTP-G107 Remove and Replace DWDM Cards, page 11-12—Complete as needed

6. NTP-G108 Viewing the Audit Trail Records, page 11-19—Complete as needed.

7. NTP-G109 Off-Load the Audit Trail Record, page 11-21—Complete as needed.

8. NTP-G110 Off-Load the Diagnostics File, page 11-22—Complete as needed. 

9. NTP-G111 Revert to an Earlier Software Load, page 11-22—Complete as needed.

10. NTP-G112 Change the Node Timing Reference, page 11-24—Complete as needed.

11. NTP-G113 View the ONS 15454 Timing Report, page 11-25—Complete as needed.

12. NTP-G114 Inspect, Clean, and Replace the Air Filter, page 11-29—Complete as needed.

13. NTP-G115 Clean Fiber Connectors, page 11-32—Complete as needed.

14. NTP-G116 Replace the Fan-Tray Assembly, page 11-35—Complete as needed.
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NTP-G103 Back Up the Database
15. NTP-G117 Replace the ANSI Shelf Alarm Interface Panel, page 11-40—Complete as needed.

16. NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane Cover, page 11-44—Complete as 
needed.

NTP-G103 Back Up the Database

Note You must back up and restore the database for each node on a circuit path in order to maintain a complete 
circuit.

Note The following parameters are not backed up and restored: node name, IP address, subnet mask and 
gateway, and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a 
backed up database with a different node name, the circuits map to the new node name. Cisco 
recommends keeping a record of the old and new node names.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node you want to back up. If you are 
already logged in, continue with Step 2.

Step 2 Click the Maintenance > Database tabs.

Step 3 Click Backup.

Step 4 Save the database on the workstation’s hard drive or on network storage. Use an appropriate file name 
with the db file extension; for example, database.db.

Step 5 Click Save.

Step 6 Click OK in the confirmation dialog box.

Stop. You have completed this procedure.

Purpose This procedure stores a backup version of the TCC2 (software) database 
on the workstation running Cisco Transport Controller (CTC) or on a 
network server.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed Required. Cisco recommends performing a database backup at 
approximately weekly intervals and prior to and after configuration 
changes.

Onsite/Remote Onsite or remote

Security Level Maintenance
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NTP-G104 Restore the Database

Note The following parameters are not backed up and restored: node name, IP address, subnet mask and 
gateway, and IIOP port. If you change the node name and then restore a backed up database with a 
different node name, the circuits map to the new renamed node. Cisco recommends keeping a record of 
the old and new node names.

Caution If you are restoring the database on multiple nodes, wait approximately one minute after the TCC2 
reboot has completed on each node before proceeding to the next node.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you are restoring the 
database. If you are already logged in, continue with Step 2.

Step 2 Click the Circuits tab. Verify that no OCHNC circuits have a PARTIAL_OOS state. If any do, investigate 
and resolve the partial state before continuing.

Step 3 Complete the “DLP-G157 Disable Automatic Power Control” task on page 9-5.

Step 4 In node view, click the Maintenance > Database tabs.

Step 5 Click Restore.

Step 6 Locate the database file stored on the workstation hard drive or on network storage. 

Note To clear all existing provisioning, locate and upload the database found on the latest ONS 15454 
software CD.

Step 7 Click the database file to highlight it. 

Step 8 Click Open. The DB Restore dialog box appears. Opening a restore file from another node or from an 
earlier backup might affect traffic on the login node (Figure 11-1).

Purpose This procedure restores the TCC2 software database.

Tools/Equipment None

Prerequisite Procedures NTP-G103 Back Up the Database, page 11-2

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Figure 11-1 Restoring the Database—Traffic Loss Warning

Step 9 Click Yes.

The Restore Database dialog box monitors the file transfer (Figure 11-2).

Figure 11-2 Restoring the Database—In-Process Notification

Step 10 Wait for the file to complete the transfer to the TCC2 card.

Step 11 Click OK when the “Lost connection to node, changing to Network View” dialog box appears. Wait for 
the node to reconnect.

Step 12 Complete the “DLP-G158 Enable Automatic Power Control” task on page 9-5.

Stop. You have completed this procedure.
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NTP-G105 Restore the Node to Factory Configuration

Caution Cisco strongly recommends that you keep different node databases in separate folders. This is because 
the reinit tool chooses the first product-specific software package in the specified directory if you use 
the Search Path field instead of the Package and Database fields. You might accidentally copy an 
incorrect database if multiple databases are kept in the specified directory.

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution If you are restoring the database on multiple nodes, wait until the TCC2 cards have rebooted on each 
node before proceeding to the next node.

Caution Restoring a node to factory configuration on a Windows or UNIX workstation should only be carried out 
on a standby TCC2 card.

Caution Cisco recommends that you save the node database to safe location if you will not be restoring the node 
using the database provided on the software CD.

Note The following parameters are not backed up and restored when you delete the database and restore the 
factory settings: node name, IP address, subnet mask and gateway, and IIOP port. If you change the node 
name and then restore a backed up database with a different node name, the circuits map to the new 
renamed node. Cisco recommends keeping a record of the old and new node names.

Step 1 If you need to install or replace one or more TCC2 cards, see the “DLP-G33 Install the TCC2 Card” task 
on page 1-73.

Step 2 If you are using Microsoft Windows, complete the “DLP-G248 Use the Reinitialization Tool to Clear the 
Database and Upload Software (Windows)” task on page 11-6.

Purpose This procedure clears the TCC2 database and restores customer or 
factory defaults by uploading the most recent software package and a 
blank database. This process is performed using the RE-INIT.jar utility, 
also called the reinitialization (reinit) tool. 

Tools/Equipment Software CD containing Software Release 4.7, the node NE defaults, 
and the reinit tool. JRE 1.3.2 must be installed on the computer you use 
to perform this procedure.

Prerequisite Procedures NTP-G103 Back Up the Database, page 11-2

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Superuser
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Step 3 If you are using UNIX, complete the “DLP-G249 Use the Reinitialization Tool to Clear the Database 
and Upload Software (UNIX)” task on page 11-8.

Stop. You have completed this procedure.

DLP-G248 Use the Reinitialization Tool to Clear the Database and Upload 
Software (Windows)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution Restoring a node to factory configuration on a Windows workstation should only be carried out on a 
standby TCC2 card.

Note The TCC2 cards reboot several times during this procedure. Wait until they are completely rebooted 
before continuing.

Step 1 Insert the system software CD containing the reinit tool, software, and defaults database into the 
computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Step 2 To find the recovery tool file, go to Start > Run > Browse and select the CD drive.

Step 3 On the CD drive, go to the CISCO15454 folder and choose All Files from the Files of Type drop-down 
list. 

Step 4 Select the RE-INIT.jar file and click Open to open the reinit tool (Figure 11-3).

Purpose This procedure describes how to use the reinitialization (reinit) tool in 
Windows. Use this tool to clear the database on the TCC2, upload 
software, and restore factory or customer defaults.

Tools/Equipment Software CD containing Software R3.4 or later, the NE defaults, and the 
reinit tool

Straight-through (CAT-5) LAN cable

JRE 1.4.2 must be installed on your PC

Prerequisite Procedures NTP-G103 Back Up the Database, page 11-2

Required/As Needed As needed to clear the existing database from a TCC2 and restore the 
node default settings.

Onsite/Remote Onsite

Security Level Superuser
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Figure 11-3 Reinitialization Tool in Windows

Step 5 If the node you are reinitializing is an end network element (ENE) in a proxy server network, enter the 
IP address of the gateway network element (GNE) in the GNE IP field. If not, leave it blank.

Step 6 Enter the node name or IP address of the node you are reinitializing in the Node IP field (Figure 11-3).

Step 7 If the User ID field does not contain your user ID, enter the ID. Enter your password in the Password 
field.

Step 8 Verify that the Re-Init Database, Upload Package, and Confirm check boxes are checked. If one is not 
checked, check the check box.

Step 9 In the Search Path field, verify that the path to the CISCO15454 folder on the CD drive is listed.

Caution Before you perform the next step, be sure you are uploading the correct database. You cannot reverse the 
upload process after you click Yes.

Step 10 Click Go. A confirmation dialog box appears (Figure 11-4). 

Figure 11-4 Confirming NE Restoration

Step 11 Click Yes. 

Step 12 The status bar at the bottom of the screen displays Complete when the node has activated the software 
and uploaded the database. 

Note The Complete message only indicates that the TCC2 successfully uploaded the database, not that 
the database restore was successful. The TCC2 then tries to restore the database after it reboots.
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Step 13 If you are logged into CTC, close the browser window and disconnect the straight-through LAN cable 
from the RJ-45 (LAN) port on the TCC2 card or on the hub or switch to which the ONS 15454 is 
physically connected. Reconnect your straight-through LAN cable to the LAN port and log back into 
CTC. 

Step 14 Manually set the node name and network configuration to site-specific values. See the “NTP-G24 Set 
Up Name, Date, Time, and Contact Information” procedure on page 3-6 and “NTP-G26 Set Up CTC 
Network Access” procedure on page 3-8 for information on setting the node name, IP address, subnet 
mask and gateway, and IIOP port.

Step 15 Return to your originating procedure (NTP).

DLP-G249 Use the Reinitialization Tool to Clear the Database and Upload 
Software (UNIX)

Caution Restoring a node to the factory configuration deletes all cross-connects on the node.

Caution Restoring a node to factory configuration on a UNIX workstation should only be carried out on a standby 
TCC2 card.

Note The TCC2 cards reboot several times during this procedure. Wait until they are completely rebooted 
before continuing.

Note JRE 1.4.2 must be installed on the computer you use to perform this procedure.

Step 1 Insert the system software CD containing the reinit tool, software, and defaults database into the 
computer CD-ROM drive. If the CTC Installation Wizard appears, click Cancel.

Purpose This task describes how to use the reinitialization (reinit) tool in a UNIX 
environment. Use this tool to clear the database on the TCC2 card and 
restore factory or customer defaults.

Tools/Equipment Software CD containing Software R3.4 or later, the node NE defaults, 
and the reinit tool.

JRE 1.4.2 must be installed on the computer that you use to perform this 
procedure.

Prerequisite Procedures NTP-G103 Back Up the Database, page 11-2

Required/As Needed As needed to clear the existing database from a TCC2 card and restore 
the node default settings.

Onsite/Remote Onsite or remote

Security Level Superuser
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Step 2 To find the recovery tool file, go to the CISCO15454 directory on the CD (usually 
/cdrom/cdrom0/CISCO15454).

Step 3 If you are using a file explorer, double-click the RE-INIT.jar file to open the reinit tool (Figure 11-5). 
If you are working with a command line interface, run java -jar RE-INIT.jar.

Figure 11-5 Reinitialization Tool in UNIX

Step 4 If the node you are reinitializing is an ENE in a proxy server network, enter the IP address of the GNE 
in the GNE IP field. If not, leave it blank.

Step 5 Enter the node name or IP address of the node you are reinitializing in the Node IP field.

Step 6 If the User ID field does not contain your user ID, enter the ID. Enter your password in the Password 
field.

Step 7 Verify that the Re-Init Database, Upload Package, and Confirm check boxes are checked. If any are not 
checked, check them.

Step 8 In the Search Path field, verify that the path to the CISCO15454 folder on the CD-ROM drive is listed.

Caution Before you perform the next step, be sure you are uploading the correct database. You cannot reverse the 
upload process after you click Yes.

Step 9 Click Go. A confirmation dialog box appears (Figure 11-4 on page 11-7). 

Step 10 Click Yes.

Step 11 The status bar at the bottom of the screen displays Complete when the node has activated the software 
and uploaded the database. 

Note The Complete message only indicates that the TCC2 successfully uploaded the database, not that 
the database restore was successful. The TCC2 then tries to restore the database after it reboots.

Step 12 If you are logged into CTC, close the browser window and disconnect the straight-through LAN cable 
from the RJ-45 (LAN) port on the TCC2 card or on the hub or switch where the ONS 15454 is physically 
connected. Reconnect your straight-through LAN cable to the LAN port and log back into CTC. 
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Step 13 Set the node name and network configuration to site-specific values. See the “NTP-G80 Change Node 
Management Information” procedure on page 9-8 and the “NTP-G81 Change CTC Network Access” 
procedure on page 9-10 for information on provisioning the node name, IP address, subnet mask and 
gateway, and IIOP port.

Step 14 Return to your originating procedure (NTP).

NTP-G106 Reset Cards Using CTC

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you are performing the 
TCC2 reset. If you are already logged in, continue with Step 2.

Step 2 As needed, complete the “DLP-G250 Reset the TCC2 Card” task on page 11-10.

Step 3 As needed, complete the “DLP-G251 Reset DWDM Cards Using CTC” task on page 11-11.

Stop. You have completed this procedure. 

DLP-G250 Reset the TCC2 Card

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Note Before you reset the TCC2, you should wait at least 60 seconds after the last provisioning change you 
made to avoid losing any changes to the database.

Purpose This procedure resets the TCC2 and DWDM cards using CTC.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 Card, page 1-73

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser

Purpose This task resets the TCC2 card and switches the node to the redundant 
TCC2.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 Card, page 1-73

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Note When a software reset is performed on an active TCC2, the AIC-I card goes through an initialization 
process and also resets. The AIC-I card reset is normal and happens each time an active TCC2 card goes 
through a software-initiated reset.

Step 1 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 2 In node view, right-click the TCC2 card to reveal a drop-down list.

Step 3 Click Reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

Step 5 Click OK when the “Lost connection to node, changing to Network View” dialog box appears.

Note For LED behavior during a TCC2 reboot, see Table 3-1 on page 3-12.

Step 6 Confirm that the TCC2 card LED is amber (standby).

Step 7 Return to your originating procedure (NTP).

DLP-G251 Reset DWDM Cards Using CTC

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Purpose This task resets the OSCM, OSC-CSM, 32MUX-O, 32DMX-O, 
32DMX, 32WSS, OPT-BST, OPT-PRE, AD-xC.xx.x, AD-xB.xx.x, 
TXP, and MXP cards using CTC.

Tools/Equipment None

Prerequisite Procedures NTP-G30 Install the DWDM Cards, page 3-26

NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Superuser
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Caution For TXP or MXP cards placed in a Y-cable protection group, do not perform a software reset on both 
cards simultaneously. Doing so will cause a traffic hit of more than one minute. For more information 
about Y-cable protection groups, refer to the “NTP-G33 Create a Y-Cable Protection Group” procedure 
on page 3-33.

Caution Resetting the active card in a Y-cable group will cause a traffic outage if the standby card is down for 
any reason. 

Note ONS 15454 cards normally do not need to be reset. However, you may occasionally need to reset a card 
for testing or as an initial trouble-clearing step. For additional information, see the Cisco ONS 15454 
SONET and DWDM Troubleshooting Guide.

Step 1 If you will switch an active TXP or MXP card that is in a Y-Cable protection group, complete the 
“DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 9-24. If not, continue 
with Step 2.

Step 2 Right-click the card you want to reset to reveal a drop-down list.

Step 3 Click Reset Card.

Step 4 Click Yes when the confirmation dialog box appears.

The card LED on the ONS 15454 shelf graphic will go through the following sequence: Fail (white 
LED), Ldg (white LED), and Act (green LED). The reset should complete within 1 to 2 minutes.

Step 5 If you performed a Y-Cable protection group switch in Step 1, complete the “DLP-G180 Clear a Manual 
or Force Y-Cable or Splitter Protection Switch” task on page 9-25. If not, continue with Step 6.

Step 6 Return to your originating procedure (NTP).

NTP-G107 Remove and Replace DWDM Cards

Caution Do not use this procedure to replace a TCC2 card. To replace a TCC2 card, refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Purpose This procedure removes and replaces DWDM cards housed in the 
ONS 15454 shelf and rack.

Tools/Equipment None

Prerequisite Procedures A card installation procedure

Required/As Needed As needed

Onsite/Remote Onsite

Security Level Provisioning or higher
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Step 1 If you are not connected to the ONS 15454 through an onsite connection and logged into CTC, complete 
the following tasks. If you are logged into CTC through an onsite connection, continue with Step 2.

• “DLP-G45 Connect Computer to the ONS 15454” task on page 2-24

• “DLP-G46 Log into CTC” task on page 2-25

Note If you cannot log into CTC and you need to remove a card, remove the card as described in 
Step 6. After you log into CTC, troubleshoot the mismatched equipment alarm (MEA) with the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide. 

Step 2 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them before continuing. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for procedures.

Step 3 Complete the following tasks, as needed: 

• If the card you want to replace is the active card in a Y-Cable protection group, complete the 
“DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on page 9-24 to force traffic 
away from the card that you will remove. If the card you want to replace is the standby card in a 
Y-Cable protection group, complete the “DLP-G182 Apply a Lock Out” task on page 9-26 to keep 
traffic from switching to the card that you will remove.

• If the card carries circuits, you must delete them. Complete the “DLP-G106 Delete Optical Channel 
Network Connections” task on page 6-11.

• If the card is an OSCM or OSC-CSM that is used as a node timing reference, complete the 
“NTP-G112 Change the Node Timing Reference” procedure on page 11-24.

• If the card is an OSCM or OSC-CSM with an OSC or GCC termination, complete the “NTP-G85 
Modify or Delete Communications Channel Terminations and Provisionable Patchcords” procedure 
on page 9-28.

Note If you delete a card in CTC but do not remove it from the shelf, it will reboot and reappear 
in CTC. 

Step 4 Place the ports out of service using one of the following tasks:

• “DLP-G252 Place TXP and MXP Ports Out of Service” task on page 11-14

• “DLP-G253 Place OSCM and OSC-CSM Ports Out of Service” task on page 11-15

• “DLP-G254 Place OPT-BST and OPT-BST Ports Out of Service” task on page 11-16

• “DLP-G255 Place 32MUX-0, 32WSS, 32DMX-O, and 32DMX Ports Out of Service” task on 
page 11-16

• “DLP-G256 Place 4MD-xx.x Ports Out of Service” task on page 11-17

• “DLP-G257 Place Band OADM Ports Out of Service” task on page 11-18

• “DLP-G258 Place Channel OADM Ports Out of Service” task on page 11-18
11-13
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 11      Maintain the Node
DLP-G252 Place TXP and MXP Ports Out of Service
Step 5 Click the Alarms tab. Verify that alarms unrelated to tasks performed in Step 3 do not appear. If 
unexplained alarms appear, investigate and resolve them before continuing. Refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for procedures.

Step 6 Physically remove the card:

a. Open the card latches/ejectors. 

b. Use the latches/ejectors to pull the card forward and away from the shelf.

Step 7 Insert the new card using one of the following procedures as applicable:

• NTP-G30 Install the DWDM Cards, page 3-26

• NTP-G32 Install the Transponder and Muxponder Cards, page 3-30

Step 8 Continue with the “NTP-G34 Install Fiber-Optic Cables on DWDM Cards” procedure on page 3-35.

Step 9 Complete the “NTP-G37 Run Automatic Node Setup” procedure on page 3-58.

Step 10 Complete the following tasks, as needed: 

• If you switched a Y-Cable protection group in Step 3, complete the “DLP-G180 Clear a Manual or 
Force Y-Cable or Splitter Protection Switch” task on page 9-25.

• If you deleted circuits in Step 3, complete the “DLP-G105 Provision DWDM Optical Channel 
Network Connections” task on page 6-9.

• If you switched the timing reference in Step 3, complete the “NTP-G112 Change the Node Timing 
Reference” procedure on page 11-24.

• If you deleted an OSC or GCC termination in Step 3, complete the “NTP-G85 Modify or Delete 
Communications Channel Terminations and Provisionable Patchcords” procedure on page 9-28.

Step 11 Click the Alarms tab. 

a. Verify that the alarm filter is not on. See the “DLP-G128 Disable Alarm Filtering” task on page 7-32 
as necessary.

b. Verify that no unexplained alarms appear on the network. If alarms appear, investigate and resolve 
them. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for procedures.

Stop. You have completed this procedure. 

DLP-G252 Place TXP and MXP Ports Out of Service

Step 1 On the node view shelf graphic, double-click the TXP or MXP card with the ports you want to put out 
of service. 

Step 2 Click the Provisioning > Line tabs.

Purpose This task places TXP and MXP ports out of service in preparation for 
card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 3 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Return to your originating procedure (NTP).

DLP-G253 Place OSCM and OSC-CSM Ports Out of Service

Step 1 On the shelf graphic in CTC, double-click the OSCM or OSC-CSM card with the ports you want to put 
out of service. 

Step 2 Click the Provisioning > OC3 > OC3 tabs.

Step 3 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Click the Provisioning > Optical Line > Parameters tabs.

Step 7 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 8 Click Apply.

Step 9 In the confirmation dialog box, click Yes.

Step 10 Return to your originating procedure (NTP).

Purpose This task places OSCM and OSC-CSM card ports out of service in 
preparation for card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G254 Place OPT-BST and OPT-BST Ports Out of Service

Step 1 On the shelf graphic in CTC, double-click the OPT-BST or OPT-PRE card with the ports you want to 
put out of service. 

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Click the Provisioning > Opt Apli Line > Parameters tabs.

Step 7 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 8 Click Apply.

Step 9 In the confirmation dialog box, click Yes.

Step 10 Return to your originating procedure (NTP).

DLP-G255 Place 32MUX-0, 32WSS, 32DMX-O, and 32DMX Ports Out of Service

Step 1 On the shelf graphic in CTC, double-click the 32MUX-O or 32DMX card with the ports you want to put 
out of service. 

Step 2 Click the Provisioning > Optical Chn > Parameters tabs. (For 32WSS cards, the tabs are Provisioning 
> Optical Chn Optical Connector 1 > Parameters.)

Step 3 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Purpose This task places OPT-BST and OPT-PRE card ports out of service in 
preparation for card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task places 32MUX-O, 32WSS, 32DMX-O, and 32DMX card ports 
out of service in preparation for card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 If the card is a 32WSS, repeat Steps 3 through 5 for the Optical Chn Optical Connector [2...4] tabs.

Step 7 Click the Provisioning > Optical Line > Parameters tabs.

Step 8 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 9 Click Apply.

Step 10 In the confirmation dialog box, click Yes.

Step 11 Return to your originating procedure (NTP).

DLP-G256 Place 4MD-xx.x Ports Out of Service

Step 1 On the shelf graphic in CTC, double-click the 4MD card with the ports you want to put out of service. 

Step 2 Click the Provisioning > Optical Chn > Parameters tabs.

Step 3 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Click the Provisioning > Optical Band > Parameters tabs.

Step 7 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 8 Click Apply.

Step 9 In the confirmation dialog box, click Yes.

Step 10 Return to your originating procedure (NTP).

Purpose This task places 4MD-xx.x card ports out of service in preparation for 
card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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DLP-G257 Place Band OADM Ports Out of Service

Step 1 On the shelf graphic in CTC, double-click the AD-1B-xx.x or AD-4B-xx.x card with the ports you want 
to put out of service. 

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Click the Provisioning > Optical Band > Parameters tabs.

Step 7 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 8 Click Apply.

Step 9 In the confirmation dialog box, click Yes.

Step 10 Return to your originating procedure (NTP).

DLP-G258 Place Channel OADM Ports Out of Service

Step 1 On the shelf graphic in CTC, double-click the AD-1C-xx.x, AD-2C-xx.x, or AD-4C-xx.x card with the 
ports you want to put out of service. 

Step 2 Click the Provisioning > Optical Line > Parameters tabs.

Step 3 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Purpose This task places the AD-1B-xx.x and AD-4B-xx.x card ports out of 
service in preparation for card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher

Purpose This task places the AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x card 
ports out of service in preparation for card removal.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Step 4 Click Apply.

Step 5 In the confirmation dialog box, click Yes.

Step 6 Click the Provisioning > Optical Chn > Parameters tabs.

Step 7 Under Admin State, choose OOS,DSLB for each port that does not have an OOS-MA,DSLB service 
state.

Step 8 Click Apply.

Step 9 In the confirmation dialog box, click Yes.

Step 10 Return to your originating procedure (NTP).

NTP-G108 Viewing the Audit Trail Records

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to view the audit 
trail log. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Audit tabs.

Step 3 Click Retrieve.

A window containing the most recent audit trail records appears as shown in Figure 11-6.

Purpose This procedure describes how to view audit trail records.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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Figure 11-6 Viewing the Audit Trail Records

A definition of each column in the audit trail log is listed in Table 11-1.

Right-click on the column headings to display the list in ascending-to-descending or 
descending-to-ascending order. 

Left-click on the column heading to display the following options:

• Reset Sorting—Resets the column to the default setting

• Hide Column—Hides the column from view

• Reset Columns Order/Visibility—Displays all hidden columns

• Row Count—Provides a numerical count of log entries

Shift-click on the column heading for an incremental sort of the list.

Stop. You have completed this procedure.

Table 11-1 Audit Trail Column Definitions

Column Definition

Date Date when the action occurred in the format MM/dd/yy HH:mm:ss

Num Incrementing count of actions

User User ID that initiated the action

P/F Pass/Fail (that is, whether or not the action was executed)

Operation Action that was taken
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NTP-G109 Off-Load the Audit Trail Record

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to off-load the 
audit trail log. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Audit tabs.

Step 3 Click Retrieve.

Step 4 Click Archive.

Step 5 In the Archive Audit Trail dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 6 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is readable in any application that 
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 7 Click Save.

The 640 entries are saved in this file. The next entries continue with the next number in the sequence, 
rather than starting over.

Note Archiving does not delete entries from the CTC audit trail log. However, entries can be 
self-deleted by the system after the log maximum is reached. If you archived the entries, you 
cannot reimport the log file back into CTC and will have to view the log in a different 
application.

Stop. You have completed this procedure.

Purpose This procedure describes how to off-load up to 640 audit trail log entries 
in a local or network drive file to maintain a record of actions performed 
for the node. If the audit trail log is not off-loaded, the oldest entries are 
overwritten after the log reaches capacity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning
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NTP-G110 Off-Load the Diagnostics File

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to off-load the 
diagnostics file. If you are already logged in, continue with Step 2.

Step 2 In the node view, click the Maintenance > Diagnostic tabs.

Step 3 Click Retrieve Diagnostics File.

Step 4 In the Saving Diagnostic File dialog box, navigate to the directory (local or network) where you want to 
save the file.

Step 5 Enter a name in the File Name field. 

You do not have to give the archive file a particular extension. It is readable in any application that 
supports text files, such as WordPad, Microsoft Word (imported), etc.

Step 6 Click Save.

The Get Diagnostics status window shows a progress bar indicating the percentage of the file being 
saved, then shows “Get Diagnostics Complete.”

Step 7 Click OK.

Stop. You have completed this procedure.

NTP-G111 Revert to an Earlier Software Load

Tip The revert feature is useful if a maintenance window closes while you are upgrading CTC software. You 
can revert to the protect software load without losing traffic. When the next maintenance window 
appears, complete the upgrade and activate the new software load.

Purpose This task describes how to off-load a diagnostics file.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance

Purpose This procedure reverts the ONS 15454 database to an earlier software 
load.

Tools/Equipment None

Prerequisite Procedures DLP-G33 Install the TCC2 Card, page 1-73

Required/As Needed As needed

Onsite/Remote On site or remote

Security Level Superuser
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Caution Provisioning performed after a software load is activated (upgraded to a higher software release) will not 
reinstate with a revert. The database configuration at the time of activation is reinstated by a revert.

Note Circuits created and provisioning performed after a software load is activated (upgraded to a later 
software release) do not reinstate with a revert. The database configuration at the time of activation is 
reinstated after a revert. This note does not apply to maintenance reverts (for example, R2.2.2 to R2.2.1), 
because maintenance releases use the same database.

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 to log into the node you want to revert. If you 
are already logged in, continue with Step 2.

Step 2 Record the IP address of that node; the IP address is displayed on the left side of the node view window.

Note To find the IP address, you can also click the Provisioning > Network > General tabs.

Step 3 If you are reverting to a previous software release (not a maintenance release), record any new circuits 
created since the previous software upgrade because these circuits have to be manually recreated after 
the software reversion if you still need to have them.

Step 4 Click the Maintenance > Software tabs.

Step 5 Click Revert. The Revert button activates the protect software load.

Step 6 Click Yes in the revert confirmation dialog box. The ONS 15454 reboots and loses the connection to 
CTC.

Step 7 Wait until the software upgrade finishes. This might take as long as 30 minutes.

Step 8 When the software upgrade is finished, click the Delete CTC Cache button in the browser window.

Step 9 Completely close the browser.

Step 10 Restart the browser and log back into the node using the IP address recorded in Step 2. 

The browser downloads the CTC applet for the protect software load.

Step 11 If needed, recreate the circuits recorded in Step 3. See Chapter 6, “Create Channels and Circuits” for 
specific circuit creation procedures.

Stop. You have completed this procedure.
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NTP-G112 Change the Node Timing Reference

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to enable timing 
switching. If you are already logged in, continue with Step 2.

Step 2 Complete the “DLP-G259 Manual or Force Switch the Node Timing Reference” task on page 11-24 as 
needed.

Step 3 Complete the “DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference” task on 
page 11-25 as needed.

Stop. You have completed this procedure.

DLP-G259 Manual or Force Switch the Node Timing Reference

Step 1 In node view, click the Maintenance > Timing > Source tabs.

Step 2 From the Reference drop-down list for the desired Clock, choose the desired reference.

Step 3 From the Operation drop-down list for the desired Clock, choose one of the following options:

• Manual—This operation commands the node to switch to the reference you have selected if the 
SSM quality of the reference is not lower than the current timing reference.

• Force—This operation commands the node to switch to the reference you have selected, regardless 
of the SSM quality (if the reference is valid).

Note For information about the Clear option, see the “DLP-G260 Clear a Manual or Force Switch 
on a Node Timing Reference” task on page 11-25.

Step 4 Click Apply next to the timing source.

Purpose This procedure enables automatic timing reference switching or returns 
the node timing to normal operation.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 5-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This task commands the node to switch to the timing reference you have 
selected.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
11-24
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 11      Maintain the Node
DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference
Step 5 Click Yes in the confirmation dialog box. If the selected timing reference is an acceptable valid 
reference, the node switches to the selected timing reference. If the selected timing reference is invalid, 
a warning dialog box appears. Click OK; the node will not switch to the new timing reference. 

Step 6 Return to your originating procedure (NTP).

DLP-G260 Clear a Manual or Force Switch on a Node Timing Reference

Step 1 In node view, click the Maintenance > Timing > Source tabs.

Step 2 Find the Clock reference that is currently set to Manual or Force in the Operation menu.

Step 3 From the Operation drop-down list, choose Clear.

Step 4 Click Apply.

Step 5 Click Yes in the confirmation dialog box. If the normal timing reference is an acceptable valid reference, 
the node switches back to the normal timing reference as defined by the system configuration. If the 
normal timing reference is invalid or has failed, a warning dialog box appears. Click OK; the timing 
reference will not revert.

Step 6 Return to your originating procedure (NTP).

NTP-G113 View the ONS 15454 Timing Report

Step 1 Complete the “DLP-G46 Log into CTC” task on page 2-25 at the node where you want to view the node 
timing status. If you are already logged in, continue with Step 2.

Step 2 Click the Maintenance > Timing > Report tabs.

Purpose This task clears a Manual or Force switch on a node timing reference and 
reverts the timing reference to its provisioned reference.

Tools/Equipment None

Prerequisite Procedures DLP-G46 Log into CTC, page 2-25

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher

Purpose This procedure displays the current status of the ONS 15454 timing 
references.

Tools/Equipment None

Prerequisite Procedures NTP-G53 Set Up Timing, page 5-4

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Maintenance or higher
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Step 3 In the Timing Report area, you can view node timing information. The date and time of the report appear 
at the top of the report. The time stamp is the same as the alarms time stamp and can be configured using 
the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on page 7-11. Table 11-2 
describes the report fields and entries. 

Step 4 To update the report, click Refresh.

Table 11-2 ONS 15454 Timing Report

Item Description Option Option Description

Clock Indicates the 
timing clock. The 
report section that 
follows applies to 
the timing clock 
indicated.

NE The node timing clock.

BITS-1 Out The BITS-1 Out timing clock.

BITS-2 Out The BITS-2 Out timing clock.
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Status Indicates the 
status of the 
timing clock.

INIT_STATE The timing reference has not been provisioned. For an NE 
reference, this status appears just before the first 
provisioning messages when the TCC2 is booting. Timing 
is provisioned to the internal clock of the node.

HOLDOVER_STATE The clock was locked onto a valid timing reference for 
more than 140 seconds when a failure occurred. Holdover 
state timing is a computation based on timing during 
normal state combined with the node’s internal clock. The 
node holds onto this frequency until the valid reference is 
restored. This status appears for NE references only.

FREERUN_STATE The node is running off its internal clock without any 
modification except the calibrated value to bring timing to 
0 PPM. Freerun state can occur when a Force switch to the 
Internal clock is initiated, when all references fail without 
the 140 seconds of holdover data, or when only Internal 
timing references are defined. This status appears for NE 
references only.

NO_SYNC_STATE A synchronization timing reference is not defined. 
BITS-1 Out or BITS-2 Out default to this status until an 
OC-N card is defined as its reference on the 
Provisioning > Timing tab. This status appears for external 
references only.

NE_SYNCH_STATE BITS-1 Out and BITS-2 Out use the same timing source as 
the NE. This is displayed when NE Reference is selected 
in the BITS-1 Out and BITS-2 Out Reference List on the 
Provisioning > Timing tab.

NORMAL_STATE The timing reference is locked onto one of its provisioned 
references. The reference cannot be Internal or 
NO SYNC STATE.

FAST_START_STATE The node has switched references, but the reference is too 
far away to reach NORMAL_STATE within an acceptable 
amount of time. FAST_START_STATE is a fast 
acquisition mode to allow the node to quickly acquire the 
reference. After it achieves this goal, the node progresses 
to the normal state.

FAST_START_FAILED_STATE A timing reference is too far away to reach in normal state. 
The FAST_START_STATE could not acquire sufficient 
timing information within the allowable amount of time.

Status 
Changed 
At

Date and time of 
the last status 
change.

— —

Switch 
Type

Type of switch. AUTOMATIC The timing switch was system-generated.

Manual The timing switch was a user-initiated Manual switch.

Force The timing switch was user-initiated Force switch.

Table 11-2 ONS 15454 Timing Report (continued)

Item Description Option Option Description
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Stop. You have completed this procedure.

Reference Indicates the 
timing reference.

Three timing references are 
available on the Provisioning > 
Timing tab.

—

Selected Indicates whether 
the reference is 
selected.

Selected references are indicated 
with an X.

—

Facility Indicates the 
timing facility 
provisioned for 
the reference on 
the Provisioning > 
Timing tab.

BITS-1 The timing facility is a building integrated timing supply 
(BITS) clock attached to the node’s BITS-1 pins.

BITS-2 The timing facility is a BITS clock attached to the node’s 
BITS-2 pins.

OC-N/STM-N card with port 
number

If the node is set to line timing, this is the OC-N /STM-N 
card and port provisioned as the timing reference.

Internal clock The node is using its internal clock.

State Indicates the 
timing reference 
state.

IS The timing reference is in service.

OOS The timing reference is out of service.

Condition Indicates the 
timing reference 
state.

OKAY The reference is valid to use as a timing reference.

OOB Out of bounds; the reference is not valid and cannot be 
used as a timing reference, for example, a BITS clock is 
disconnected.

Condition 
Changed

Indicates the date 
and time of the 
last status change 
in MM/DD/YY 
HH:MM:SS 
format.

— —

SSM Indicates whether 
SSM is enabled 
for the timing 
reference.

Enabled SSM is enabled.

Disabled SSM is not enabled.

SSM 
Quality

Indicates the SSM 
timing quality.

8 to 10 SSM quality messages 
might be displayed.

For a list of SSM message sets, see the 
“18.2.2 Synchronization Status Messaging” section on 
page 18-8.

SSM 
Changed

Indicates the date 
and time of the 
last SSM status 
change in 
MM/DD/YY 
HH:MM:SS 
format.

— —

Table 11-2 ONS 15454 Timing Report (continued)

Item Description Option Option Description
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NTP-G114 Inspect, Clean, and Replace the Air Filter

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Note Although the filter can work if it is installed with either side facing up, Cisco recommends that you 
install it with the metal bracing facing up to preserve the surface of the filter. 

Step 1 Verify that you are replacing a reusable air filter. The reusable filter is made of a gray, open-cell, 
polyurethane foam that is specially coated to provide fire and fungi resistance.

Step 2 If the air filter is installed in the external filter brackets, slide the filter out of the brackets while being 
careful not to dislodge any dust that might have collected on the filter and proceed to Step 9. Figure 11-7 
shows the reusable fan-tray air filter in an external filter bracket on an ANSI shelf. Figure 11-8 shows 
the reusable fan-tray air filter in an external filter bracket on an ETSI shelf. 

Step 3 If the filter is installed below the fan tray and not in the external filter brackets, open the front door of 
the shelf assembly. If the front door is already open, proceed to Step 4.

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 4 Remove the front door (optional). If you do not want to remove the door or it is already removed, proceed 
to Step 5.

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Purpose This procedure explains how to inspect, clean, and replace the reusable 
fan tray air filter. This procedure ensures that the air filter is free from 
dirt and dust, which allows optimum air flow and prevents dirt and dust 
from entering the shelf.

Tools/Equipment Vacuum or detergent and water faucet, spare filter, pinned hex key tool

Prerequisite Procedures None

Required/As Needed Inspection required every 30 days. Clean as needed.

Onsite/Remote Onsite

Security Level None
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Figure 11-7 ANSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

Figure 11-8 ETSI Shelf Fan-Tray Air Filter in an External Filter Bracket (Front Door Removed)

Step 5 Push the outer side of the handles on the fan-tray assembly to expose the handles. 
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Step 6 Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait 
until the fans stop. 

Step 7 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly.

Step 8 Gently remove the air filter from the shelf assembly. Be careful not to dislodge any dust that might have 
collected on the filter.

Step 9 Visually inspect the air filter material for dirt and dust.

Step 10 If the reusable air filter contains a concentration of dirt and dust, replace the dirty air filter with a clean 
air filter (spare filters should be kept in stock) and reinsert the fan-tray assembly. Then, vacuum the dirty 
air filter or wash it under a faucet with a light detergent. 

Caution Do not leave the fan tray out of the chassis for an extended period of time because excessive heat can 
damage the ONS 15454 cards.

Note Cleaning should take place outside of the operating environment to avoid releasing dirt and dust 
near the equipment.

Step 11 If you washed the filter, allow it to completely air dry for at least eight hours.

Warning Do not put a damp filter back in the ONS 15454.

Step 12 Replace the clean filter:

a. If the air filter is installed in the external filter brackets, slide the dry air filter all the way to the back 
of the brackets to complete the procedure.

b. If the filter is installed below the fan-tray assembly, remove the fan-tray assembly and slide the 
dry/clean air filter into the recessed compartment at the bottom of the shelf assembly. Put the front 
edge of the air filter flush against the front edge of the recessed compartment. Push the fan tray back 
into the shelf assembly.

Caution If the fan tray does not slide all the way to the back of the shelf assembly, pull the fan tray out and 
readjust the position of the reusable filter until the fan tray fits correctly.

Note On a powered-up ONS 15454, the fans start immediately after the fan-tray assembly is correctly 
inserted. 

Step 13 To verify that the tray is plugged into the backplane, ensure that the LCD on the front of the fan-tray 
assembly is activated and displays node information.

Step 14 Rotate the retractable handles back into their compartments.

Step 15 If you replace the door, also reattach the ground strap.

Step 16 Close and lock the door.

Step 17 Return to your originating procedure (NTP).
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NTP-G115 Clean Fiber Connectors

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments.

Step 1 Using an inspection microscope, inspect each fiber connector for dirt, cracks, or scratches.

Step 2 Replace any damaged fiber connectors.

Note Replace all dust caps whenever the equipment is unused for 30 minutes or more.

Step 3 Complete the “DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and Dry 
Wipes” task on page 11-33 as necessary.

Step 4 Complete the “DLP-G262 Clean Fiber Connectors with CLETOP” task on page 11-34 as necessary.

Step 5 Complete the “DLP-G263 Clean the Fiber Adapters” task on page 11-34 as necessary. 

Caution Do not reuse optical swabs. Keep unused swabs off of work surfaces.

Stop. You have completed this procedure.

Purpose This procedure cleans the fiber connectors.

Tools/Equipment Inspection microscope

Compressed air/duster

Type A Fiber Optic Connector Cleaner (CLETOP reel)

Isopropyl alcohol 70 percent or higher

Optical swab

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-G261 Scope and Clean Fiber Connectors and Adapters with Alcohol and 
Dry Wipes

Warning Invisible laser radiation may be emitted from the end of the unterminated fiber cable or connector. Do 
not stare into the beam or view directly with optical instruments.

Step 1 Remove the dust cap from the fiber connector.

Step 2 Wipe the connector tip with the premoistened alcohol wipe.

Step 3 Blow-dry using filtered air.

Step 4 Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the 
connector is not clean, repeat Steps 1 to 3.

Step 5 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

Note If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the 
dust cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap 
using a CLETOP stick swab (14100400).

Step 6 Return to your originating procedure (NTP).

Purpose This task cleans the fiber connectors and adapters with alcohol and dry 
wipes.

Tools/Equipment Compressed air/duster

Isopropyl alcohol 70 percent or higher

Optical swab

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
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DLP-G262 Clean Fiber Connectors with CLETOP

Step 1 Remove the dust cap from the fiber connector.

Step 2 Press the lever down to open the shutter door. Each time you press the lever, you expose a clean wiping 
surface.

Step 3 Insert the connector into the CLETOP cleaning cassette slot, rotate one quarter turn, and gently swipe 
downwards.

Step 4 Use an inspection microscope to inspect each fiber connector for dirt, cracks, or scratches. If the 
connector is not clean, repeat Steps 1 to 3.

Step 5 Insert the fiber connector into the applicable adapter or attach a dust cap to the fiber connector.

Note If you must replace a dust cap on a connector, first verify that the dust cap is clean. To clean the 
dust cap, wipe the outside of the cap using a dry, lint-free wipe and the inside of the dust cap 
using a CLETOP stick swab (14100400).

Step 6 Return to your originating procedure (NTP).

DLP-G263 Clean the Fiber Adapters

Step 1 Remove the dust plug from the fiber adapter.

Step 2 Insert a CLETOP stick swab (14100400) into the adapter opening and rotate the swab.

Step 3 Place dust plugs on the fiber adapters when not in use.

Step 4 Return to your originating procedure (NTP).

Purpose This task cleans the fiber connectors with CLETOP.

Tools/Equipment Type A Fiber Optic Connector Cleaner (CLETOP reel)

Optical receiver cleaning stick

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None

Purpose This task cleans the fiber adapters.

Tools/Equipment CLETOP stick swab

Prerequisite Procedures None

Required/As Needed Required

Onsite/Remote Onsite

Security Level None
11-34
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 11      Maintain the Node
NTP-G116 Replace the Fan-Tray Assembly
NTP-G116 Replace the Fan-Tray Assembly

Caution The 15454-FTA3 fan-tray assembly can only be installed in ONS 15454 R3.1 and later shelf assemblies 
(15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). It includes a pin that does not 
allow it to be installed in ONS 15454 shelf assemblies released before ONS 15454 R3.1 
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1, P/N: 800-07149). Equipment damage can 
result from attempting to install the 15454-FTA3 in a incompatible shelf assembly.

Caution Do not force a fan-tray assembly into place. Doing so can damage the connectors on the fan tray and/or 
the connectors on the backplane.

Note To replace the fan-tray assembly (FTA), it is not necessary to move any of the cable management 
facilities. 

Step 1 Review Table 11-3 (ANSI) or Table 11-4 (ETSI) to ensure that you have compatible components when 
replacing the fan-tray assembly. Note the alarms that will be generated when an incompatibility occurs.

Note If you need to determine the hardware that has been installed on a node, click the Inventory tab 
in node view.

Purpose This procedure replaces a malfunctioning fan-tray assembly.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None

Table 11-3 Incompatibility Alarms for ONS 15454 ANSI

Shelf Assembly1 Fan Tray2 AIP3 10G Cards4 Ethernet Cards5 Alarms

— — No fuse — — Mismatch of 
Equipment Attributes 
(MEA) on alarm 
interface panel (AIP)

NEBS3E or NEBS3 2A 2A No — None

NEBS3E or NEBS3 2A 2A Yes — MEA on 10G

NEBS3E or NEBS3 2A 5A No — None

NEBS3E or NEBS3 2A 5A Yes — MEA on 10G

ANSI or HD 2A 2A No — None
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ANSI or HD 2A 2A Yes 2.5G compatible MEA on fan tray, AIP, 
and Ethernet

ANSI or HD 2A 2A Yes 10G compatible MEA on fan tray and 
AIP

ANSI or HD 2A 5A No Either None

ANSI or HD 2A 5A Yes 2.5G compatible MEA on fan tray and 
Ethernet

ANSI or HD 2A 5A Yes 10G compatible MEA on fan tray

ANSI or HD 5A 2A No Either MEA on AIP

ANSI or HD 5A 2A Yes 2.5G compatible MEA on AIP and 
Ethernet

ANSI or HD 5A 2A Yes 10G compatible MEA on AIP

ANSI or HD 5A 5A No Either None

ANSI or HD 5A 5A Yes Either None

1. 15454-SA-NEBS3E (P/N: 800-07149-xx) or 15454-SA-NEBS3 (P/N: 800-06741-xx) = shelf assemblies released before 
ONS 15454 Release 3.1
15454-SA-ANSI (P/N: 800-19857-01) = ONS 15454 Release 3.1 and later shelf assembly
15454-SA-HD (P/N: 800-24848) = ONS 15454 Release 3.1 and later shelf assembly

2. 5A Fan Tray = 15454-FTA3 (P/N: 800-19858-xx) or 15454-FTA3-T (P/N: 800-21448-xx)
2A Fan Tray = 15454-FTA2 (P/Ns: 800-07145-xx, 800-07385-xx, 800-19591-xx, 800-19590-xx)

3. 5A AIP (P/N: 73-7665-01), 2A AIP (P/N: 73-5262-01)

4. 10G cards = XC-10G, OC-192, OC-48 AS

5. 2.5G compatible Ethernet cards = E1000-T, E1000-2, E1000T-G, E10002-G, G1000-4, G1K-4
10G compatible Ethernet cards = E1000T-G, E10002-G, G1000-4, G1K-4, ML100T-12, ML1000-2

Table 11-4 Incompatibility Alarms for ONS 15454 ETSI 

Shelf Assembly 1 Fan Tray2 10G Cards3 Ethernet Cards4 Alarms

15454E-SA-ETSI 2A No — None

15454E-SA-ETSI 2A Yes — MEA on 10G

15454E-SA-ETSI 2A No — None

15454E-SA-ETSI 2A Yes — MEA on 10G

15454E-SA-ETSI 5A No — MEA on fan tray

15454E-SA-ETSI 5A Yes — MEA on fan tray and 10G 
cards

15454E-SA-ETSI 5A No — None

15454E-SA-ETSI 5A Yes — MEA on 10G

ETSI 2A No — None

ETSI 2A Yes 2.5G compatible MEA on fan tray or 
Ethernet

ETSI 2A Yes 10G compatible MEA on fan tray

Table 11-3 Incompatibility Alarms for ONS 15454 ANSI (continued)

Shelf Assembly1 Fan Tray2 AIP3 10G Cards4 Ethernet Cards5 Alarms
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Step 2 Open the front door of the shelf assembly. If the shelf assembly does not have a front door, continue with 
Step 4. 

a. Open the front door lock.

The ONS 15454 comes with a pinned hex key for locking and unlocking the front door. Turn the key 
counterclockwise to unlock the door and clockwise to lock it. 

b. Press the door button to release the latch. 

c. Swing the door open. 

Step 3 Remove the front door (optional). If you do not want to remove the door, proceed to Step 4.

a. Detach the ground strap from either the door or the chassis by removing one of the Kepnuts.

b. Place the Kepnut back on the stud after the ground strap is removed to avoid misplacement.

c. Secure the dangling end of the ground strap to the door or chassis with tape.

Step 4 Push the outer side of the handles on the fan-tray assembly to expose the handles. 

Step 5 Fold out the retractable handles at the outside edges of the fan tray.

Step 6 Pull the handles and slide the fan-tray assembly one inch (25.4 mm) out of the shelf assembly and wait 
until the fans stop. 

Step 7 When the fans have stopped, pull the fan-tray assembly completely out of the shelf assembly. 
Figure 11-9 shows the location of the fan tray on the ONS 15454 ANSI shelf.

ETSI 2A No Either None

ETSI 2A Yes 2.5G compatible MEA on fan tray, Ethernet

ETSI 2A Yes 10G compatible MEA on fan tray

ETSI 5A Yes 2.5G compatible MEA on Ethernet

ETSI 5A No Either None

ETSI 5A Yes Either None

1. 15454-SA-ETSI (P/N: 800-08708-XX) = ONS 15454 SDH Release 3.3 and later shelf assembly

2. 5A Fan Tray = 15454E-FTA-60V
2A Fan Tray = 15454E-FTA-48V 

3. 10G cards = XC-10G, XC-VXL-10G, STM-64, STM-16 AS

4. 2.5G compatible Ethernet cards = E1000-T, E1000-2, E1000T-G, E10002-G, G1000-4, G1K-4
10G compatible Ethernet cards = E1000T-G, E10002-G, G1000-4, G1K-4, ML100T-12, ML1000-2

Table 11-4 Incompatibility Alarms for ONS 15454 ETSI  (continued)

Shelf Assembly 1 Fan Tray2 10G Cards3 Ethernet Cards4 Alarms
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Figure 11-9 Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ANSI)

Figure 11-10 shows the location of the fan tray on the ONS 15454 ETSI shelf. 
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Figure 11-10 Removing or Replacing the Fan-Tray Assembly (Front Door Removed) (ETSI)

Step 8 If you are replacing the fan-tray air filter and it is installed beneath the fan-tray assembly, slide the 
existing air filter out of the shelf assembly and replace it before replacing the fan-tray assembly.

If you are replacing the fan-tray air filter and it is installed in the external bottom bracket (ANSI shelf 
only), you can slide the existing air filter out of the bracket and replace it at anytime. For more 
information on the fan-tray air filter, see the “NTP-G114 Inspect, Clean, and Replace the Air Filter” 
procedure on page 11-29.

Step 9 Slide the new fan tray into the shelf assembly until the electrical plug at the rear of the tray plugs into 
the corresponding receptacle on the backplane.

Step 10 To verify that the tray has plugged into the backplane, check that the LCD on the front of the fan tray is 
activated.

Step 11 If you replace the door on an ANSI shelf, be sure to reattach the ground strap.

Stop. You have completed this procedure.
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NTP-G117 Replace the ANSI Shelf Alarm Interface Panel

Caution Do not use a 2A AIP with a 5A fan-tray assembly; doing so will cause a blown fuse on the AIP.

Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

Caution Do not perform this procedure on a node with live traffic. Hot-swapping the AIP can affect traffic and 
result in a loss of data. For assistance with AIP replacement, contact Cisco TAC at (800) 553-2447.

Step 1 Review Table 11-3 on page 11-35 to ensure that you have compatible components when replacing the 
fan-tray assembly and note the alarms that will occur when an incompatibility occurs.

Step 2 Ensure that all nodes in the affected network are running the same software version before replacing the 
AIP and repairing circuits:

a. In network view, click the Maintenance > Software tabs. The working software version for each 
node is listed in the Working Version column.

b. If you need to upgrade the software on a node, refer to the release-specific software upgrade 
document. No hardware should be changed or circuit repair performed until after the software 
upgrade is complete. If you do not need to upgrade software or have completed the software 
upgrade, proceed to Step 3.

Step 3 Record the MAC address of the old AIP:

a. Log into the node where you will replace the AIP. See the “DLP-G46 Log into CTC” task on 
page 2-25.

b. In node view, click the Provisioning > Network tabs.

c. Record the MAC address shown in the General tab (Figure 11-11).

Purpose This procedure replaces the alarm interface panel (AIP) on the 
ONS 15454 ANSI shelf assembly.

Tools/Equipment #2 Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite or remote

Security Level Provisioning or higher
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Figure 11-11 Find the MAC Address

Step 4 Call Cisco TAC at (800) 553-2447 for assistance in replacing the AIP and maintaining the original MAC 
address.

Step 5 Unscrew the five screws that hold the lower backplane cover in place (Figure 11-12).

Figure 11-12 Lower Backplane Cover

Step 6 Grip the lower backplane cover and gently pull it away from the backplane.

Step 7 Unscrew the two screws that hold the AIP cover in place.

Step 8 Grip the cover and gently pull away from the backplane.

Note On the 15454-SA-HD (P/N: 800-24848), 15454-SA-NEBS3E, 15454-SA-NEBS3, and 
15454-SA-R1 (P/N: 800-07149) shelves, the AIP cover is clear plastic. On the 15454-SA-ANSI 
shelf (P/N: 800-19857), the AIP cover is metal.
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Step 9 Grip the AIP and gently pull it away from the backplane.

Step 10 Disconnect the fan-tray assembly power cable from the AIP.

Step 11 Set the old AIP aside for return to Cisco.

Caution The type of shelf the AIP resides in determines the version of AIP that should replace the failed AIP. The 
15454-SA-ANSI shelf (P/N: 800-19857) and 15454-SA-HD (P/N: 800-24848) currently use the 5A AIP, 
(P/N: 73-7665-01). The 15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1 (P/N: 800-07149) 
shelves and earlier use the 2A AIP (P/N: 73-5262-01). 

Caution Do not put a 2A AIP (P/N: 73-5262-01) into a 15454-SA-ANSI (P/N: 800-19857) or 15454-SA-HD 
(P/N: 800-24848) shelf; doing so will cause a blown fuse on the AIP.

Step 12 Attach the fan-tray assembly power cable to the new AIP.

Step 13 Place the new AIP on the backplane by plugging the panel into the backplane using the DIN connector.

Step 14 Replace the AIP cover over the AIP and secure the cover with the two screws.

Step 15 Replace the lower backplane cover and secure the cover with the five screws.

Step 16 In node view, click the Provisioning > Network tabs.

Caution Cisco recommends that TCC2 card resets be performed in a maintenance window to avoid any potential 
service disruptions.

Step 17 Reset the standby TCC2 card:

a. Right-click the standby TCC2 card and choose Reset Card.

b. Click Yes in the Resetting Card dialog box. As the card resets, a loading (Ldg) indication appears 
on the card in CTC.

Note The reset takes approximately five minutes. Do not perform any other steps until the reset is 
complete.

Step 18 Complete the “DLP-G250 Reset the TCC2 Card” task on page 11-10 to reset the active TCC2 card.

Step 19 From the File drop-down list, choose Exit to exit the CTC session.

Step 20 Log back into the node. At the Login dialog box, choose (None) from the Additional Nodes drop-down 
list. 

Step 21 Record the new MAC address:

a. In node view, click the Provisioning > Network tabs.

b. Record the MAC address shown in the General tab.

Step 22 In node view, click the Circuits tab. Note that all circuits listed have a status of PARTIAL.

Step 23 In node view, choose Repair Circuits from the Tools drop-down list. The Circuit Repair dialog box 
appears.

Step 24 Read the instructions in the Circuit Repair dialog box (Figure 11-13). If all the steps in the dialog box 
have been completed, click Next. Ensure that you have the old and new MAC addresses.
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Figure 11-13 Repairing Circuits

Step 25 The Node MAC Addresses dialog box appears (Figure 11-14):

a. From the Node drop-down list, choose the name of the node where you replaced the AIP.

b. In the Old MAC Address field, enter the old MAC address that was recorded in Step 3.

c. Click Next.

Figure 11-14 Recording the Old MAC Address Before Replacing the AIP

Step 26 The Repair Circuits dialog box appears (Figure 11-15). Read the information in the dialog box and click 
Finish.
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Figure 11-15 Circuit Repair Information

Note The CTC session freezes until all circuits are repaired. Circuit repair can take up to five minutes 
or more depending on the number of circuits provisioned.

When the circuit repair is complete, the Circuits Repaired dialog box appears.

Step 27 Click OK.

Step 28 In the node view of the new node, click the Circuits tab. Check to ensure that all circuits listed have a 
status of DISCOVERED. If all circuits listed are not DISCOVERED, call the Cisco TAC at 
(800) 553-2447 to open a Return Material Authorization (RMA).

Stop. You have completed this procedure.

NTP-G118 Replace the ANSI Shelf Plastic Lower Backplane 
Cover

Step 1 Use the Phillips screwdriver to unscrew the five retaining screws that hold the metal cover in place. 

Step 2 Grasp the metal cover on each side.

Step 3 Gently pull the metal cover away from the backplane.

Step 4 Place the plastic cover against the shelf assembly and align the screw holes on the cover and the shelf 
assembly (Figure 11-16).

Purpose This procedure replaces the plastic cover located at the bottom rear of 
the ONS 15454 ANSI shelf.

Tools/Equipment Phillips screwdriver

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level None
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Figure 11-16 Attaching Plastic Lower Backplane Cover

Step 5 Tighten the five retaining screws that hold the plastic cover in place.

Stop. You have completed this procedure.

7
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4
0

0
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Power Down the Node

This chapter explains how to power down a node and stop all node activity on the Cisco ONS 15454 
ANSI or ETSI.

NTP-G119 Power Down the Node

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Caution The following procedure is designed to minimize traffic outages when powering down nodes, but traffic 
will be lost if you delete and recreate circuits that passed through a working node.

Note Always use the supplied ESD wristband when working with the Cisco ONS 15454. Plug the wristband 
into the ESD jack located on the fan-tray assembly or on the lower right outside edge of the shelf on the 
NEBS 3 shelf assembly. To access the ESD plug on the NEBS 3 shelf assembly, open the front door of 
the Cisco ONS 15454. The front door is grounded to prevent electrical shock.

Step 1 Identify the node that you want to power down. If no cards are installed, go to Step 16. If cards are 
installed, log into the node. See the “DLP-G46 Log into CTC” task on page 2-25 for instructions.

Step 2 In node view, choose Go to Network View from the View menu. 

Purpose This procedure stops all node activity.

Tools/Equipment None

Prerequisite Procedures None

Required/As Needed As needed

Onsite/Remote Onsite

Security Level For software steps, provisioning level or higher is required. 
For hardware steps, any level is allowed.
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Step 3 Verify that the node is not connected to a network.

a. If the node is part of a Software R4.7 or later Multi-Service Transport Platform (MSTP) 
configuration, consult your network administrator to remove the node from the network. Continue 
with Step 4.

b. If the node is not connected to a working network and the current configurations are no longer 
required, proceed to Step 4.

Note The MSTP and the fiber spans connected around it must be disconnected from the network 
for work to continue. This is to prevent the accidental disconnection of wavelengths that pass 
through the shelf. A good indication that the shelf has been disconnected from the network 
is optical service channel (OSC) alarms, or no OSC channels provisioned.

Note Current configurations will be saved if Steps 4 to 16 are skipped.

Step 4 In node view, click the Circuits tab and verify that no circuits appear, then proceed to Step 5. If circuits 
appear, delete all the circuits that originate or terminate in the node. Complete the “DLP-G106 Delete 
Optical Channel Network Connections” task on page 6-11 or the “DLP-G112 Delete Overhead Circuits” 
task on page 6-18 as needed.

Note When deleting circuits from a node, make sure that the node is not connected to any network.

Step 5 In node view, click the Provisioning > Protection tabs and delete all protection groups:

a. Click the protection group that needs to be deleted and click Delete.

b. Click Yes.

Repeat until no protection groups appear.

Step 6 In node view, click the Provisioning > Comm Channels tabs and delete all communications channel 
terminations:

a. Click the section data communications channel (SDCC), line data communications channel 
(LDCC), generic communications channel (GCC), or OSC termination that needs to be deleted and 
click Delete.

b. Click Yes.

Repeat until no SDCC, LDCC, GCC, or OSC terminations are present.

Note Before deleting the OSC termination, make sure the Ring ID is deleted. Click the Provisioning 
> Comm Channels > OSC tabs. Select the Ring ID and click Delete.

Step 7 Before deleting any installed MSTP cards, the optical patch cords have to be deleted. In the node view, 
click Provisioning > WDM-ANS > Connections tabs.

a. Select all the connections and click Delete.

b. Click Yes.
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Step 8 For each installed MSTP channel-bearing card (AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x, where xx.x 
refers to the specific wavelengths), make sure all lines and bands are in the Out-of-Service and 
Management, Disabled (OOS-MA,DSBLD [ANSI]) or Locked-enabled,disabled (ETSI) service state:

a. In the card view, click the Provisioning > Optical Line > Parameters tabs.

b. In the Admin State column for each line, make sure that OOS,DSBLD (ANSI) or 
Locked,disabled (ETSI) is selected.

c. Click the Provisioning > Optical Chn > Parameters tabs.

d. In the Admin State column for each line, make sure that OOS,DSBLD/Locked,disabled is selected.

Step 9 For each installed MSTP band-bearing card (AD-1B-xx.x and AD-4B-xx.x, where xx.x refers to the 
specific wavelengths), make sure all lines and bands are in the 
OOS-MA,DSBLD/Locked-enabled,disabled service state:

a. In the card view, click the Provisioning > Optical Line > Parameters tabs.

b. In the Admin State column for each line, make sure that OOS,DSBLD/Locked,disabled is selected.

c. Click the Provisioning > Optical Band > Parameters tabs.

d. In the Admin State column for each line, make sure that OOS,DSBLD/Locked,disabled is selected.

Step 10 For each installed dense wavelength division multiplexing (DWDM) transponder (TXP), muxponder 
(MXP), multiplexer, demultiplexer or amplifier card (32MUX-O, 32DMX-0, 32DMX, 32WSS, 
4MD-xx.x, OPT-BST, OPT-PRE, TXP_MR_10G, TXP_MR_10E, TXP_MR_2.5G, TXPP_MR_2.5G, 
MXP_2.5G_10G, MXP_2.5G_10E, MXP_MR_2.5G, MXPP_MR_2.5G), make sure all lines are in the 
OOS-MA,DSBLD/Locked-enabled,disabled service state:

a. In card view, click the appropriate tab depending on the card:

• For MXP_2.5G_10G, TXP_MR_10G, TXP_MR_10E cards, click the Provisioning > Line > 
SONET tabs if the card was provisioned for a SONET payload, or the Provisioning > Line > 
SDH tabs if the card was provisioned for an SDH payload. 

• For TXP_MR_2.5G, TXPP_MR_2.5G, and MXPP_MR_2.5G cards, click the Provisioning > 
Line > OC48 tabs.

• For MXP_2.5G_10E cards, click the Provisioning > Line > Trunk tabs.

• For MXP_MR_2.5G cards, click the Provisioning > Line > Client tabs.

• For 32MUX-O, 32DMX-0, 32DMX, 32WSS, OPT-BST, OPT-PRE cards, click the 
Provisioning > Optical Line > Parameters tabs.

• For 32DMX and 32DMX-O cards, click the Provisioning > Optical Chn > Parameters tabs.

• For 4MD-xx.x cards, click the Provisioning > Optical Band > Parameters tabs.

• For OPT-BST and OPT-PRE cards, click the Provisioning > Optical Ampli Line > Parameters 
tabs.

b. In the Admin State column for each line, make sure that OOS,DSBLD/Locked,disabled is selected.

c. Repeat Steps a and b for each installed DWDM card.

Note Ports are put in service when circuits are provisioned, and put out of service when circuits are deleted. 
When circuits are deleted the Admin State displays as OOS,DSBLD/Locked,disabled and the 
Service State displays OOS-MA,DSBLD/Locked-enabled,disabled.

Step 11 Remove all fiber connections to the cards.

Step 12 In node view, right-click an installed card and click Delete.
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Step 13 Click Yes.

Step 14 After you have deleted the card, open the card ejectors and remove it from the node. 

Step 15 Repeat Step 11 through Step 14 for each installed card.

Note You cannot delete an Advanced Timing, Communications, and Control (TCC2) card in 
Cisco Transport Controller (CTC). Physically remove it after all the other cards have been 
deleted and removed.

Step 16 Shut off the power from the power supply that feeds the node.

Step 17 Disconnect the node from its external fuse source.

Step 18 Store all of the cards that you removed and update inventory records according to local site practice.

Stop. You have completed this procedure. 
12-4
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Cisco ONS 15454 DWDM
September 2004
C H A P T E R 13

Shelf Hardware Reference

This chapter provides a description of Cisco ONS 15454 hardware for the ANSI and ETSI shelf 
assemblies. For card descriptions, see Chapter 14, “Card Reference.” To install equipment, see 
Chapter 1, “Install the Shelf and Common Control Cards.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 13.1 Overview, page 13-2

• 13.2 ONS 15454 ANSI Rack Installation, page 13-3 

• 13.3 ONS 15454 ETSI Rack Installation, page 13-7

• 13.4 FlexLayer and Y-Cable Protection, page 13-10

• 13.5 Typical DWDM Rack Layouts, page 13-16

• 13.6 Front Door, page 13-19 

• 13.7 ONS 15454 ANSI Backplane Covers, page 13-26

• 13.8 ONS 15454 ETSI Front Mount Electrical Connection, page 13-30

• 13.9 ONS 15454 ANSI Alarm Expansion Panel, page 13-30

• 13.10 Cable Routing and Management, page 13-36

• 13.11 Fan-Tray Assembly, page 13-41

• 13.12 Power and Ground Description, page 13-43

• 13.13 ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin Connections, page 13-44

• 13.14 Cards and Slots, page 13-49

Note The Cisco ONS 15454 shelf assemblies are intended for use with telecommunications equipment only.

Warning Only trained and qualified personnel should be allowed to install, replace, or service this equipment.
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13.1   Overview
Warning This equipment must be installed and maintained by service personnel as defined by AS/NZS 3260. 
Incorrectly connecting this equipment to a general purpose outlet could be hazardous. The 
telecommunications lines must be disconnected 1) before unplugging the main power connector 
and/or 2) while the front door is open.

Warning The ONS 15454 is intended for installation in restricted access areas. A restricted access area is 
where access can only be gained by service personnel through the use of a special tool, lock, key, or 
other means of security. A restricted access area is controlled by the authority responsible for the 
location.

Warning The ONS 15454 is suitable for mounting on concrete or other non-combustible surfaces only.

Caution Unused card slots should be filled with a blank faceplate (Cisco P/N 15454-BLANK for ANSI shelves 
and 15454E-BLANK for ETSI shelves). The blank faceplate ensures proper airflow when operating the 
ONS 15454 without the front door attached, although Cisco recommends that the front door remain 
attached.

13.1 Overview
This section provides an introduction to the Cisco ONS 15454 ANSI and the Cisco ONS 15454 ETSI. 

Install the ONS 15454 in compliance with your local and national electrical codes:

• United States: National Fire Protection Association (NFPA) 70; United States National Electrical 
Code.

• Canada: Canadian Electrical Code, Part I, CSA C22.1.

• Other countries: If local and national electrical codes, are not available, refer to IEC 364, Part 1 
through Part 7.

Warning Dispose of this product according to all national laws and regulations.

13.1.1 Cisco ONS 15454 ANSI
When installed in an equipment rack, the ONS 15454 ANSI assembly is typically connected to a fuse 
and alarm panel to provide centralized alarm connection points and distributed power for the 
ONS 15454 ANSI. Fuse and alarm panels are third-party equipment and are not described in this 
documentation. If you are unsure about the requirements or specifications for a fuse and alarm panel, 
consult the user documentation for the related equipment. The front door of the ONS 15454 ANSI allows 
access to the shelf assembly, fan-tray assembly, and cable-management area. The backplanes provide 
access to alarm contacts, external interface contacts, power terminals, and BNC/SMB connectors.
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13.1.2   Cisco ONS 15454 ETSI
Warning The ONS 15454 ANSI relies on the protective devices in the building installation to protect against 
short circuit, overcurrent, and grounding faults. Ensure that the protective devices are properly rated 
to protect the system, and that they comply with national and local codes. 

You can mount the ONS 15454 ANSI in a 19- or 23-inch rack (482.6 or 584.2 mm). The shelf assembly 
weighs approximately 55 pounds (24.94 kg) with no cards installed.

The ONS 15454 ANSI is powered using –48 VDC power. Negative, return, and ground power terminals 
are accessible on the backplane. 

Note The ONS 15454 ANSI is designed to comply with Telcordia GR-1089-CORE Type 2 and Type 4. Install 
and operate the ONS 15454 ANSI only in environments that do not expose wiring or cabling to the 
outside plant. Acceptable applications include Central Office Environments (COEs), Electronic 
Equipment Enclosures (EEEs), Controlled Environment Vaults (CEVs), huts, and Customer Premise 
Environments (CPEs).

13.1.2 Cisco ONS 15454 ETSI
When installed in an equipment rack, the ONS 15454 ETSI assembly is typically connected to a fuse and 
alarm panel to provide centralized alarm connection points and distributed power for the 
ONS 15454 ETSI. Fuse and alarm panels are third-party equipment and are not described in this 
documentation. If you are unsure about the requirements or specifications for a fuse and alarm panel, 
consult the user documentation for the related equipment. The front door of the ONS 15454 ETSI allows 
access to the shelf assembly, fan-tray assembly, and cable-management area. The FMEC cover at the top 
of the shelf allows access to power connectors, external alarms and controls, timing input and output, 
and craft interface terminals. 

You can mount the ONS 15454 ETSI in an ETSI rack. The shelf assembly weighs approximately 26 kg 
(57 pounds) with no cards installed. The shelf assembly includes a front door and a Front Mount 
Electrical Connection (FMEC) cover for added security, a fan tray module for cooling, and extensive 
cable-management space.

The ONS 15454 ETSI is powered using –48 VDC power. Negative, return, and ground power terminals 
are connected via the MIC-A/P and the MIC-C/T/P FMECs. 

13.2 ONS 15454 ANSI Rack Installation 

Warning To prevent the equipment from overheating, do not operate it in an area that exceeds the maximum 
recommended ambient temperature of 131°F (55°C) unless configured for industrial temperature 
(I-temp). All I-temp rated components are –40°F to +149°F (–40°C to +65°C). To prevent airflow 
restriction, allow at least 1 inch (25.4 mm) of clearance around the ventilation openings.

The ONS 15454 ANSI is mounted in a 19- or 23-in. (482.6- or 584.2-mm) equipment rack. The shelf 
assembly projects five inches (127 mm) from the front of the rack. It mounts in both Electronic Industries 
Alliance (EIA) standard and Telcordia-standard racks. The shelf assembly is a total of 17 inches (431.8 
mm) wide with no mounting ears attached. Ring runs are not provided by Cisco and might hinder 
side-by-side installation of shelves where space is limited.
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13.2   ONS 15454 ANSI Rack Installation
The ONS 15454 ANSI measures 18.5 inches (469.9 mm) high, 19 or 23 inches (482.6 or 584.2 mm) wide 
(depending on which way the mounting ears are attached), and 12 inches (304.8 mm) deep. You can 
install up to four ONS 15454 ANSIs in a seven-foot (2133.6 mm) equipment rack. The 
ONS 15454 ANSI must have one inch (25.4 mm) of airspace below the installed shelf assembly 
to allow air flow to the fan intake. If a second ONS 15454 ANSI is installed underneath the shelf 
assembly, the air ramp on top of the lower shelf assembly provides the air spacing needed and 
should not be modified in any way. Figure 13-1 shows the dimensions of the ONS 15454 ANSI.

Note A 10-Gbps-compatible shelf assembly (15454-SA-ANSI or 15454-SA-HD) and fan-tray assembly 
(15454-FTA3 or 15454-FTA3-T) are required if ONS 15454 ANSI 10-Gbps Cross-Connect (XC10G) 
cards are installed in the shelf. 

Warning The ONS 15454 ANSI should be installed in the lower rack position or mounted above another 
ONS 15454 ANSI shelf assembly.

Warning The ONS 15454 ANSI must have 1 inch (25.4 mm) of airspace below the installed shelf assembly to 
allow air flow to the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf 
assembly) provides this spacing and should not be modified in any way. 
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13.2.1   Reversible Mounting Bracket
Figure 13-1 Cisco ONS 15454 ANSI Dimensions

13.2.1 Reversible Mounting Bracket

Caution Use only the fastening hardware provided with the ONS 15454 ANSI shelf to prevent loosening, 
deterioration, and electromechanical corrosion of the hardware and joined material.

Caution When mounting the ONS 15454 ANSI shelf in a frame with a nonconductive coating (such as paint, 
lacquer, or enamel) either use the thread-forming screws provided with the ONS 15454 ANSI shipping 
kit, or remove the coating from the threads to ensure electrical continuity.

The shelf assembly comes preset for installation in a 23-inch (584.2 mm) rack, but you can reverse the 
mounting bracket to fit the smaller 19-inch (482.6 mm) rack. 

Front ViewSide View

Top View

18.5 in.
(46.99 cm)

12 in. (30.48 cm)

12 in.
(30.48 cm)

5 in.(12.7 cm)

22 in. (55.88 cm) total width

19 in. (48.26 cm) or 23 in. (58.42 cm)
between mounting screw holes

22 in. (55.88 cm) total width

19 in. (48.26 cm) or 23 in. (58.42 cm)
between mounting screw holes
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13.2.2 Mounting a Single Node
Mounting the ONS 15454 ANSI shelf in a rack requires a minimum of 18.5 inches (469.9 mm) of 
vertical rack space and one additional inch (25.4 mm) for air flow. To ensure the mounting is secure, use 
two to four #12-24 mounting screws for each side of the shelf assembly. Figure 13-2 shows the rack 
mounting position for the ONS 15454 ANSI shelf.

Figure 13-2 Mounting an ONS 15454 ANSI Shelf in a Rack

Two people should install the shelf assembly; however, one person can install it using the temporary set 
screws included. The shelf assembly should be empty for easier lifting. The front door can also be 
removed to lighten the shelf assembly.

13.2.3 Mounting Multiple Nodes
Most standard (Telcordia GR-63-CORE, 19-inch [482.6-mm] or 23-inch [584.2-mm]) seven-foot 
(2,133-mm) racks can hold four ONS 15454 ANSI shelves and a fuse and alarm panel. However, unequal 
flange racks are limited to three ONS 15454 ANSI shelves and a fuse and alarm panel, or four 
ONS 15454 ANSI shelves using a fuse and alarm panel from an adjacent rack. 

If you are using the external (bottom) brackets to install the fan-tray air filter, you can install three shelf 
assemblies in a standard seven-foot (2.133-m) rack. If you are not using the external (bottom) brackets, 
you can install four shelf assemblies in a rack. The advantage of using the bottom brackets is that you 
can replace the filter without removing the fan tray.
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13.2.4   ONS 15454 ANSI Bay Assembly
13.2.4 ONS 15454 ANSI Bay Assembly
The Cisco ONS 15454 ANSI bay assembly simplifies ordering and installing the ONS 15454 ANSI 
shelf because it allows you to order shelf assemblies preinstalled in a seven-foot (2,133 mm) rack. The 
bay assembly is available in a three- or four-shelf configuration. The three-shelf configuration includes 
three ONS 15454 ANSI shelf assemblies, a prewired fuse and alarm panel, and two cable-management 
trays. The four-shelf configuration includes four ONS 15454 ANSI shelf assemblies and a prewired fuse 
and alarm panel. You can order optional fiber channels with either configuration. Installation procedures 
are included in the Unpacking and Installing the Cisco ONS 15454 Four-Shelf and Zero-Shelf Bay 
Assembly document that ships with the bay assembly.

13.3 ONS 15454 ETSI Rack Installation 

Warning To prevent the equipment from overheating, do not operate it in an area that exceeds the maximum 
recommended ambient temperature of 131°F (55°C) unless configured for industrial temperature 
(I-temp). All I-temp rated components are –40°F to +149°F (–40°C to +65°C). To prevent airflow 
restriction, allow at least 1 inch (25.4 mm) of clearance around the ventilation openings.

The ONS 15454 ETSI (15454-SA-ETSI) is mounted in a 600 x 600-mm (23-inch) or 600 x 300-mm 
(11.8-inch) equipment cabinet/rack. The shelf assembly projects 240 mm (9.45 inches) from the front of 
the rack. It mounts in ETSI-standard racks. The shelf assembly is a total of 435 mm (17.35 inches) wide 
with no mounting ears attached. Ring runs are not provided by Cisco and might hinder side-by-side 
installation of shelves where space is limited. 

The ONS 15454 ETSI measures 616.5 mm (24.27 inches) high, 535 mm (21.06 inches) wide, and 280 
mm (11.02 inches) deep. You can install up to three ONS 15454 ETSI shelves in a seven-foot (2133.6 
mm) equipment rack. The ONS 15454 ETSI must have one inch (25.4 mm) of airspace below the 
installed shelf assembly to allow air flow to the fan intake. If a second ONS 15454 ETSI is installed 
underneath the first shelf assembly, an ETSI air ramp unit must be assembled between the two shelves 
to ensure adequate air flow.

Figure 13-3 provides the dimensions of the ONS 15454 ETSI.

Caution The standard ETSI racks can hold three ONS 15454 ETSI shelf assemblies and two air ramps. When 
mounting a shelf assembly in a partially filled rack, load the rack from the bottom to the top with the 
heaviest component at the bottom of the rack. If the rack is provided with stabilizing devices, install the 
stabilizers before mounting or servicing the unit in the rack.

Caution The ONS 15454 ETSI must have 1 inch (25.4 mm) of airspace below the installed shelf assembly to 
allow air flow to the fan intake. The air ramp (the angled piece of sheet metal on top of the shelf 
assembly) provides this spacing and should not be modified in any way.
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13.3.1   Mounting a Single Node
Figure 13-3 ONS 15454 ETSI Dimensions

13.3.1 Mounting a Single Node
The ONS 15454 ETSI requires 616.5 mm (24.24 inch) minimum of vertical rack space and 25 mm 
(1 inch) below the installed shelf assembly to allow air flow to the fan intake. If a second 
ONS 15454 ETSI is installed above a shelf assembly, the air ramp between the shelves provides space 
for air flow. To ensure the mounting is secure, use two to four M6 mounting screws for each side of the 
shelf assembly. A shelf assembly should be mounted at the bottom of the rack if it is the only unit in the 
rack.

Figure 13-4 shows the rack mounting position for the ONS 15454 ETSI shelf.

Front ViewSide View

Top View

616.5 mm
(24.27 in.)

61
21

3
280 mm (11.02 in.)

280 mm
(11.02 in.)

40 mm (1.57 in.)

535 mm (21.06 in.) total width

535 mm (21.06 in.) total width
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13.3.2   Mounting Multiple Nodes
Figure 13-4 Mounting an ONS 15454 ETSI Shelf in a Rack

Two people should install the shelf assembly; however, one person can install it using the temporary set 
screws included. The shelf assembly should be empty for easier lifting. The front door can also be 
removed to lighten the shelf assembly.

13.3.2 Mounting Multiple Nodes
Most standard (Telcordia GR-63-CORE, 23-inch [584.2 mm]) seven-foot (2,133 mm) racks can hold 
three ONS 15454 ETSI shelves, two air ramps, and a fuse and alarm panel. Figure 13-5 shows a 
three-shelf ONS 15454 ETSI bay assembly.
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13.4   FlexLayer and Y-Cable Protection
Figure 13-5 Three-Shelf ONS 15454 ETSI Bay Assembly

13.4 FlexLayer and Y-Cable Protection
The Cisco ONS 15454 FlexLayer DWDM system includes the following components:

• Two-channel add or drop flex module

• FlexLayer shelf assembly

• Y-cable FlexLayer module

The FlexLayer shelf assembly is 1 rack unit (RU) high and can be mounted in a 19-inch (482.6-mm) or 
23-inch (584.2-mm) rack (two-way mounting brackets). The FlexLayer shelf assembly is used to house 
the FlexLayer and Y-Cable modules.
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mountable in the rack
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13-10
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 13      Shelf Hardware Reference
13.4.1   FlexLayer Modules
13.4.1 FlexLayer Modules
The two-channel add/drop FlexLayer module is a completely passive unidirectional component that 
allows the insertion or the extraction of two channels within the ONS 15454 channel plan. This module 
is used only in point-to-point, one-channel, amplified system configurations. 

Sixteen specific modules are available to cover the whole 32-channel bandwidth. Table 13-1 shows how 
the FlexLayer add/drop modules are grouped in relation to the supported channels.

Table 13-1 ONS 15454 R4.7 100-GHz Channel Plan

ITU Channel ID Frequency (THz) Wavelength (nm)
Two-Channel A/D 
Flex Module

59 30.3 195.9 1530.33 15216-FLB-2-31.1=

58 31.1 195.8 1531.12

57 31.9 195.7 1531.90 15216-FLB-2-32.6=

56 32.6 195.6 1532.68

54 34.2 195.4 1534.25 15216-FLB-2-35.0=

53 35.0 195.3 1535.04

52 35.8 195.2 1535.82 15216-FLB-2-36.6=

51 36.6 195.1 1536.61

49 38.1 194.9 1538.19 15216-FLB-2-38.9=

48 38.9 194.8 1538.98

47 39.7 194.7 1539.77 15216-FLB-2-40.5=

46 40.5 194.6 1540.56

44 42.1 194.4 1542.14 15216-FLB-2-42.9=

43 42.9 194.3 1542.94

42 43.7 194.2 1543.73 15216-FLB-2-44.5=

41 44.5 194.1 1544.53

39 46.1 193.9 1546.12 15216-FLB-2-46.9=

38 46.9 193.8 1546.92

37 47.7 193.7 1547.72 15216-FLB-2-48.5=

36 48.5 193.6 1548.51

34 50.1 193.4 1550.12 15216-FLB-2-50.9=

33 50.9 193.3 1550.92

32 51.7 193.2 1551.72 15216-FLB-2-52.5=

31 52.5 193.1 1552.52

29 54.1 192.9 1554.13 15216-FLB-2-54.9=

28 54.9 192.8 1554.94

27 55.7 192.7 1555.75 15216-FLB-2-56.5=

26 56.5 192.6 1556.55
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13.4.1   FlexLayer Modules
Figure 13-6 shows the unit functional block diagram. In Figure 13-6, the signal flows from left to right 
when the card is used as a drop component and from right to left when the card is used as an add 
component.

Figure 13-6 Two-Channel Add/Drop FlexLayer Module Block Diagram

When the unit is used as a drop component, the wave-division multiplexing (WDM) composite signal 
coming from the DROP-COM-RX port is filtered sequentially by two filters and the filtered channels are 
dropped at the two DROP-CH-TX ports. The rest of the WDM composite signal is sent to the 
DROP-COM-TX port. A two-percent tap coupler, DROP-MON, is used to monitor the input WDM 
composite signal.

When the unit is used as an add component, the added channels coming from the two ADD-CH-RX ports 
are combined with the WDM composite signal coming from the ADD-COM-RX port. The multiplexed 
WDM composite signal is sent to the ADD-COM-TX port. A two-percent tap coupler, ADD-MON, is 
used to monitor the multiplexed WDM composite signal. 

Figure 13-7 shows the physical appearance of the ONS 15454 two-channel add/drop FlexLayer module.

24 58.1 192.4 1558.17 15216-FLB-2-58.9=

23 58.9 192.3 1558.98

22 59.7 192.2 1559.79 15216-FLB-2-60.6=

21 60.6 192.1 1560.61

Table 13-1 ONS 15454 R4.7 100-GHz Channel Plan (continued)

ITU Channel ID Frequency (THz) Wavelength (nm)
Two-Channel A/D 
Flex Module

90
94

7

DROP-MON

DROP-COM-RX
ADD-COM-TX

ADD-MON

DROP-COM-TX
ADD-COM-RX

Connector
Channel Filter

ADD CH-RX
DROP CH-TX

DROP
ADD
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13.4.1   FlexLayer Modules
Figure 13-7 ONS 15454 Two-Channel Optical Add/Drop FlexLayer Module

Labels are provided to show how the unit ports are mapped. It is the end user’s responsibility to label the 
unit for its intended use (drop or add component). 

Figure 13-8 shows how the connectors are mapped and labeled on the front panel when the component 
is used as a drop component. The COM-RX is mapped to Port 1, the COM-TX is mapped to Port 12, and 
the two dropped channel TX ports are mapped to Ports 9 and 10. The two-percent tap MON port is 
mapped to Port 6. Port 7 is not active.

Figure 13-8 Two-Channel Drop Component Connector Mapping and Labeling

Figure 13-9 shows how the connectors are mapped and labeled in the front panel when the component 
is used as an add component. The COM-TX is mapped to Port 1, the COM-RX is mapped to Port 12, and 
the added channels are mapped to the two RX Ports 9 and 10. The two-percent tap MON port is mapped 
to Port 7. Port 6 is not active.

Front Panel
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94

8
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6 9 10

2 Channel Drop Module 15216-FLB-2-XX.X

MON 15XX.XX
TX

15XX.XX
TX
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13.4.2   Y-Cable Protection Module
Figure 13-9 Two-Channel Add Component Connector Mapping and Labeling

13.4.2 Y-Cable Protection Module
The Y-cable protection module is a bidirectional module. It is equipped with two passive star couplers: 
one that is used as a splitter and one that is used as a coupler. 

Note Neither this unit nor the other modules of this equipment release can be used for video on demand (VoD) 
applications.

The purpose of this module is to provide Y-cable protection for transponder cards such as the ONS 15454 
multirate and 10-Gbps transponders. (See Figure 13-10.) There are two versions of this unit, one for 
multimode applications (CS-MM-Y) and one for single-mode applications (CS-SM-Y).

Figure 13-10 Typical Y-Cable Protection Module Configuration

When the module is used in the coupler direction, the individual signals enter the module from the 
CPL-RXn ports and pass through a passive star coupler to the CPL-TX port.

1

7 9 10

2 Channel Add Module 15216-FLB-2-XX.X
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RX

15XX.XX
RX
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13.4.2   Y-Cable Protection Module
The coupler is not meant to combine both the protect and working client card signals. The module allows 
a path for the working client transmit interface to connect to the network in the event the opposite 
interface in the protection pair should fail (the protect interface switches to the working interface).

When the module is used in the splitter direction, the signal enters the module from the SPL-RX port 
and is split through a passive star coupler to the SPL-TXn ports. This module, although designed to pass 
wavelengths associated with the ONS 15454 32-channel plan, is not selective to specific wavelengths 
(units do not filter wavelengths).

Figure 13-11 shows the unit block diagram of the Y-cable protection module. 

Figure 13-11 1:2 Splitter and 2:1 Coupler (Y-Cable Protection) Module Block Diagram

Figure 13-12 and Figure 13-13 show the physical appearance of the ONS 15454 Y-Cable Protection 
FlexLayer Module. This module has two versions, one for single-mode applications and the other for 
multimode applications.

Figure 13-12 ONS 15454 Y-Cable Protection FlexLayer Module (Single Mode)

SPLb
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13.5   Typical DWDM Rack Layouts
Figure 13-13 ONS 15454 Y-Cable Protection FlexLayer Module (Multimode)

Figure 13-14 shows how the module front panel ports are mapped and labeled. The multimode unit is 
mapped and labeled the same as the single mode unit.

Figure 13-14 Y-Cable Protection Component Connector Mapping and Labeling

The following muxponder and transponder cards can use Y-cable protection: 

• MXP_2.5_10G

• MXP_2.5_10E

• MXP_MR_2.5G 

• TXP_MR_10G

• TXP_MR_10E

• TXP_MR_2.5G

13.5 Typical DWDM Rack Layouts
Typical dense wavelength division multiplexing (DWDM) applications might include:

• 3 ONS 15454 shelves

Front Panel
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13.5   Typical DWDM Rack Layouts
• 1 Dispersion Compensating Unit (DCU)

• 7 patch panels (or fiber storage tray[s])

Or, alternatively:

• 3 ONS 15454 shelves

• 2 DCUs

• 6 patch panels (or fiber storage tray[s])

See Figure 13-15 for a typical rack layout. 
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13.5   Typical DWDM Rack Layouts
Figure 13-15 Typical DWDM Equipment Layout in an ONS 15454 ANSI Rack

If you are installing a patch panel or fiber storage tray below the ONS 15454 shelf, you must install the 
air ramp between the shelf and patch panel/fiber tray or leave one rack unit (RU) space open.
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13.6   Front Door
13.6 Front Door 
The Critical, Major, and Minor alarm LEDs visible through the front door indicate whether a critical, 
major, or minor alarm is present anywhere on the ONS 15454 shelf. These LEDs must be visible so 
technicians can quickly determine if any alarms are present on the ONS 15454 shelf or the network. You 
can use the LCD to further isolate alarms. The front door (Figure 13-16) provides access to the shelf 
assembly, cable-management tray, fan-tray assembly, and LCD screen. 

Figure 13-16 The ONS 15454 Front Door

The ONS 15454 ANSI ships with a standard door but can also accommodate a deep door and extended 
fiber clips (15454-DOOR-KIT) to provide additional room for cabling (Figure 13-17). The 
ONS 15454 ETSI does not support the deep door. 

Door lock Door button

Viewholes for Critical, Major and Minor alarm LEDs

33
92
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13.6   Front Door
Figure 13-17 Cisco ONS 15454 ANSI Deep Door
.

The ONS 15454 door locks with a pinned hex key that ships with the shelf assembly. A button on the 
right side of the shelf assembly releases the door. You can remove the front door to provide unrestricted 
access to the front of the shelf assembly. 

Before you remove the ONS 15454 front door, you must remove the ground strap of the front door 
(Figure 13-18). 

11
50

11
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13.6   Front Door
Figure 13-18 ONS 15454 ANSI Front Door Ground Strap

Figure 13-19 shows how to remove the ONS 15454 ANSI front door.
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13.6   Front Door
Figure 13-19 Removing the ONS 15454 ANSI Front Door

Figure 13-20 shows how to remove the ONS 15454 ETSI front door.
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13.6   Front Door
Figure 13-20 Removing the ONS 15454 ETSI Front Door

An erasable label is pasted on the inside of the front door. You can use the label to record slot 
assignments, port assignments, card types, node ID, rack ID, and serial number for the ONS 15454. 
Figure 13-21 shows the erasable label on the ONS 15454 ANSI shelf. 
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13.6   Front Door
Figure 13-21 ONS 15454 ANSI Front-Door Erasable Label

Figure 13-22 shows the erasable label on the ONS 15454 ETSI shelf.
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13.6   Front Door
Figure 13-22 ONS 15454 ETSI Front-Door Erasable Label

The front door label also includes the Class I and Class 1M laser warning. See Figure 13-23 for the 
ONS 15454 ANSI laser warning and Figure 13-24 for the ONS 15454 ETSI laser warning.

Figure 13-23 Laser Warning on the ONS 15454 ANSI Front-Door Label
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13.7   ONS 15454 ANSI Backplane Covers
Figure 13-24 Laser Warning on the ONS 15454 ETSI Front-Door Label

13.7 ONS 15454 ANSI Backplane Covers
If a backplane does not have an electrical interface assembly (EIA) panel installed, it should have two 
sheet metal backplane covers (one on each side of the backplane). See Figure 13-25. Each cover is held 
in place with nine 6-32 x 3/8 inch Phillips screws. 
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13.7.1   Lower Backplane Cover
Figure 13-25 Backplane Covers

13.7.1 Lower Backplane Cover
The lower section of the ONS 15454 ANSI backplane is covered by either a clear plastic protector 
(15454-SA-ANSI) or a sheet metal cover (15454-SA-HD), which is held in place by five 6-32 x 1/2 inch 
screws. Remove the lower backplane cover to access the alarm interface panel (AIP), alarm pin fields, 
frame ground, and power terminals (Figure 13-26).

Figure 13-26 Removing the Lower Backplane Cover

B A

32
07

4

Lower Backplane 
Cover

Backplane Sheet Metal 
Covers

32
06

9

Retaining
screws
13-27
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 13      Shelf Hardware Reference
13.7.2   Rear Cover
13.7.2 Rear Cover 
The ONS 15454 ANSI has an optional clear plastic rear cover. This clear plastic cover provides 
additional protection for the cables and connectors on the backplane. Figure 13-27 shows the rear cover 
screw locations. 

Figure 13-27 Backplane Attachment for Cover

You can also install the optional spacers if more space is needed between the cables and rear cover 
(Figure 13-28).
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13.7.3   Alarm Interface Panel
Figure 13-28 Installing the Plastic Rear Cover with Spacers

13.7.3 Alarm Interface Panel
The AIP is located above the alarm contacts on the lower section of the backplane. The AIP provides 
surge protection for the ONS 15454 ANSI. It also provides an interface from the backplane to the 
fan-tray assembly and LCD. The AIP plugs into the backplane using a 96-pin DIN connector and is held 
in place with two retaining screws. The panel has a nonvolatile memory chip that stores the unique node 
address (MAC address).

Note The 5-A AIP (73-7665-XX) is required when installing the new fan-tray assembly (15454-FTA3), which 
comes preinstalled on the shelf assembly (15454-SA-ANSI or 15454-SA-HD). 

Note The MAC address identifies the nodes that support circuits. It allows Cisco Transport Controller (CTC) 
to determine circuit sources, destinations, and spans. The TCC2 cards in the ONS 15454 ANSI also use 
the MAC address to store the node database. 

Note A blown fuse on the AIP board can cause the LCD display to go blank.
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13.7.4   Alarm Interface Panel Replacement
13.7.4 Alarm Interface Panel Replacement
If the AIP fails, a MAC Fail alarm displays on the CTC Alarms menu and/or the LCD display on the 
fan-tray assembly goes blank. To perform an in-service replacement of the AIP, you must contact the 
Cisco Technical Assistance Center (Cisco TAC). For contact information, see Obtaining Technical 
Assistance, page lx.

You can replace the AIP on an in-service system without affecting traffic (except Ethernet traffic on 
nodes running a software release earlier than Release 4.0). The circuit repair feature allows you to repair 
circuits affected by MAC address changes on one node at a time. Circuit repair works when all nodes are 
running the same software version. Each individual AIP upgrade requires an individual circuit repair; if 
AIPs are replaced on two nodes, the circuit repair must be performed twice. Always replace an AIP 
during a maintenance window.

Caution Do not use a 2-A AIP with a 5-A fan-tray assembly; doing so causes a blown fuse on the AIP.

Note Ensure that all nodes in the affected network are running the same software version before replacing the 
AIP and repairing circuits. If you need to upgrade nodes to the same software version, no hardware 
should be changed or circuit repair performed until after the software upgrade is complete.

13.8 ONS 15454 ETSI Front Mount Electrical Connection
The ONS 15454 ETSI positive and negative power terminals are located on FMEC cards in the Electrical 
Facility Connection Assembly (EFCA). The ground connection is the grounding receptacle on the side 
panel of the shelf. 

The ONS 15454 ETSI EFCA at the top of the shelf has 12 FMEC slots numbered sequentially from left 
to right (18 to 29). Slots 18 to 22 and 25 to 29 provide electrical connections. Slots 23 and 24 host the 
MIC-A/P and MIC-C/T/P cards, respectively. The MIC-A/P and the MIC-C/T/P cards are also used to 
connect alarm, timing, LAN, and craft connections to the ONS 15454 ETSI. 

For more information about the MIC-A/P and MIC-C/T/P, which are required for power supply as well 
as alarm, timing, and LAN connections, see Chapter 14, “Card Reference.”

13.9 ONS 15454 ANSI Alarm Expansion Panel
The optional ONS 15454 ANSI alarm expansion panel (AEP) can be used with the Alarm Interface 
Controller–International card (AIC-I) card to provide an additional 48 dry alarm contacts for the 
ONS 15454 ANSI: 32 inputs and 16 outputs. The AEP is a printed circuit board assembly that is installed 
on the backplane. Figure 13-29 shows the AEP board; the left connector is the input connector and the 
right connector is the output connector. 

The AIC-I without an AEP already contains direct alarm contacts. These direct AIC-I alarm contacts are 
routed through the backplane to wire-wrap pins accessible from the back of the shelf. If you install an 
AEP, you cannot use the alarm contacts on the wire-wrap pins. For further information about the AIC-I, 
see Chapter 14, “Card Reference.”
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13.9.1   Wire-Wrap and Pin Connections
Figure 13-29 AEP Printed Circuit Board Assembly

Figure 13-30 shows the AEP block diagram. 

Figure 13-30 AEP Block Diagram

Each AEP alarm input port has provisionable label and severity. The alarm inputs have optocoupler 
isolation. They have one common 32-VDC output and a maximum of 2 mA per input. Each opto metal 
oxide semiconductor (MOS) alarm output can operate by definable alarm condition, a maximum open 
circuit voltage of 60 VDC, anda maximum current of 100 mA. See the “20.7 External Alarms and 
Controls” section on page 20-13 for further information.

13.9.1 Wire-Wrap and Pin Connections
Figure 13-31 shows the wire-wrapping connections on the backplane.
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13.9.1   Wire-Wrap and Pin Connections
Figure 13-31 AEP Wire-Wrap Connections to Backplane Pins

Table 13-2 shows the backplane pin assignments and corresponding signals on the AIC-I and AEP.

Figure 13-32 is a circuit diagram of the alarm inputs. (Inputs 1 and 32 are shown in the example.)
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Table 13-2 Pin Assignments for the AEP

AEP Cable Wire Backplane Pin AIC-I Signal AEP Signal

Black A1 GND AEP_GND

White A2 AE_+5 AEP_+5

Slate A3 VBAT– VBAT–

Violet A4 VB+ VB+

Blue A5 AE_CLK_P AE_CLK_P

Green A6 AE_CLK_N AE_CLK_N

Yellow A7 AE_DIN_P AE_DOUT_P

Orange A8 AE_DIN_N AE_DOUT_N

Red A9 AE_DOUT_P AE_DIN_P

Brown A10 AE_DOUT_N AE_DIN_N
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Figure 13-32 Alarm Input Circuit Diagram

Table 13-3 lists the connections to the external alarm sources. 
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Station

48 V

max. 2 mA

AEP/AIE

GND

VBAT–

VBAT–

Input 1

Input 48

Table 13-3 Alarm Input Pin Association

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name

1 ALARM_IN_1– 27 GND

2 GND 28 ALARM_IN_2–

3 ALARM_IN_3– 29 ALARM_IN_4–

4 ALARM_IN_5– 30 GND

5 GND 31 ALARM_IN_6–

6 ALARM_IN_7– 32 ALARM_IN_8–

7 ALARM_IN_9– 33 GND

8 GND 34 ALARM_IN_10–

9 ALARM_IN_11– 35 ALARM_IN_12–

10 ALARM_IN_13– 36 GND

11 GND 37 ALARM_IN_14–

12 ALARM_IN_15– 38 ALARM_IN_16–

13 ALARM_IN_17– 39 GND

14 GND 40 ALARM_IN_18–

15 ALARM_IN_19– 41 ALARM_IN_20–

16 ALARM_IN_21– 42 GND

17 GND 43 ALARM_IN_22–

18 ALARM_IN_23– 44 ALARM_IN_24–

19 ALARM_IN_25– 45 GND
13-33
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



 

Chapter 13      Shelf Hardware Reference
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Figure 13-33 is a circuit diagram of the alarm outputs. (Outputs 1 and 16 are shown in the example.)

Figure 13-33 Alarm Output Circuit Diagram

Use the pin numbers in Table 13-4 to connect to the external elements being switched by external 
controls. 

20 GND 46 ALARM_IN_26–

21 ALARM_IN_27– 47 ALARM_IN_28–

22 ALARM_IN_29– 48 GND

23 GND 49 ALARM_IN_30–

24 ALARM_IN_31– 50 —

25 ALARM_IN_+ 51 GND1

26 ALARM_IN_0– 52 GND2

Table 13-3 Alarm Input Pin Association (continued)

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name

78
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Station

max. 60 V/100 mA

AEP/AIE

Output 1

Output 16

Table 13-4 Pin Association for Alarm Output Pins

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name

1 — 27 COM_0

2 COM_1 28 —

3 NO_1 29 NO_2

4 — 30 COM_2

5 COM_3 31 —

6 NO_3 32 NO_4
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13.9.2 AEP Specifications
The AEP has the following specifications:

• Alarm inputs

– Number of inputs: 32

– Optocoupler isolated

– Label customer provisionable

– Severity customer provisionable

– Common 32 V output for all alarm inputs

– Each input limited to 2 mA

– Termination: 50-pin AMP champ connector

• Alarm outputs

– Number of outputs: 16

– Switched by opto MOS (metal oxide semiconductor) 

7 — 33 COM_4

8 COM_5 34 —

9 NO_5 35 NO_6

10 — 36 COM_6

11 COM_7 37 —

12 NO_7 38 NO_8

13 — 39 COM_8

14 COM_9 40 —

15 NO_9 41 NO_10

16 — 42 COM_10

17 COM_11 43 —

18 NO_11 44 NO_12

19 — 45 COM_12

20 COM_13 46 —

21 NO_13 47 NO_14

22 — 48 COM_14

23 COM_15 49 —

24 NO_15 50 —

25 — 51 GND1

26 NO_0 52 GND2

Table 13-4 Pin Association for Alarm Output Pins (continued)

AMP Champ 
Pin Number Signal Name

AMP Champ 
Pin Number Signal Name
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13.10   Cable Routing and Management
– Triggered by definable alarm condition

– Maximum allowed open circuit voltage: 60 VDC

– Maximum allowed closed circuit current: 100 mA

– Termination: 50-pin AMP champ connector

• Environmental

– Overvoltage protection: as in ITU-T G.703 Annex B

– Operating temperature: –40 to +65 degrees Celsius (–40 to +149 degrees Fahrenheit)

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 3.00 W max., from +5 VDC from AIC-I, 10.2 BTU/hr max. 

• Dimensions of AEP board

– Height: 20 mm (0.79 in.) 

– Width: 330 mm (13.0 in.)

– Depth: 89 mm (3.5 in.) 

– Weight: 0.18 kg (0.4 lb) 

• Compliance: Installed ONS 15454 cards comply with these safety standards:

IEC 60950, EN 60950, UL 60950, CSA C22.2 No. 60950, TS 001, AS/NZS 3260

13.10 Cable Routing and Management
The ONS 15454 cable management facilities include the following:

• Fiber patch panels

• A cable-routing channel (behind the fold-down door) that runs the width of the shelf assembly 
(Figure 13-34 on page 13-37)

• Plastic horseshoe-shaped fiber guides at each side opening of the cable-routing channel that ensure 
that the proper bend radius is maintained in the fibers (Figure 13-35 on page 13-38)

Note You can remove the fiber guide, if necessary, to create a larger opening (if you need to route 
CAT-5 Ethernet cables out the side, for example). To remove the fiber guide, take out the 
three screws that anchor it to the side of the shelf assembly. 

• A fold-down door that provides access to the cable-management tray

• Cable tie-wrap facilities on EIAs that secure cables to the cover panel (ANSI only)

• Reversible jumper routing fins that enable you to route cables out either side by positioning the fins 
as desired

• Jumper slack storage reels (2) on each side panel that reduce the amount of slack in cables that are 
connected to other devices

Note To remove the jumper slack storage reels, take out the screw in the center of each reel.

• Optional fiber management tray (recommended for DWDM nodes)
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13.10.1   Fiber Management
• Optional tie-down bar (ANSI only)

Figure 13-34 shows the cable management facilities that you can access through the fold-down front 
door, including the cable-routing channel and the jumper routing fins. 

Figure 13-34 Managing Cables on the Front Panel 

13.10.1 Fiber Management
The jumper routing fins are designed to route fiber jumpers out of both sides of the shelf. Slots 1 to 6 
exit to the left, and Slots 12 to 17 exit to the right. Figure 13-35 shows fibers routed from cards in the 
left slots, down through the fins, then exiting out the fiber channel to the left. The maximum capacity of 
the fiber routing channel depends on the size of the fiber jumpers. 
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13.10.1   Fiber Management
Figure 13-35 Fiber Capacity

Table 13-5 provides the maximum capacity of the fiber channel for one side of an ANSI shelf, depending 
on fiber size and number of Ethernet cables running through that fiber channel.

Table 13-6 provides the maximum capacity of the fiber channel for one side of an ETSI shelf, depending 
on fiber size and number of Ethernet cables running through that fiber channel.

Fiber guides

96
51

8

Table 13-5 ANSI Fiber Channel Capacity (One Side of the Shelf)

Fiber Diameter

Maximum Number of Fibers Exiting Each Side

No Ethernet Cables One Ethernet Cable Two Ethernet Cables

1.6 mm (0.6 inch) 144 127 110

2 mm (0.7 inch) 90 80 70

3 mm (0.11 inch) 40 36 32

Table 13-6 ETSI Fiber Channel Capacity (One Side of the Shelf)

Fiber Diameter

Maximum Number of Fibers Exiting Each Side

No Ethernet Cables One Ethernet Cable Two Ethernet Cables

1.6 mm (0.6 inch) 126 110 94

2 mm (0.7 inch) 80 70 60

3 mm (0.11 inch) 36 31 26
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13.10.2   Fiber Management Using the Optional Patch-Panel Module
Plan your fiber size according to the number of cards/ports installed in each side of the shelf. For 
example, if your port combination requires 36 fibers, 3-mm (0.11-inch) fiber is adequate. If your port 
combination requires 68 fibers, you must use 2-mm (0.7-inch) or smaller fibers.

13.10.2 Fiber Management Using the Optional Patch-Panel Module
The patch-panel module manages the connections between multiplexer/demultiplexer and transponder 
modules by splitting patch cords into single connections. The patch-panel shelf assembly consists of a 
shelf, pull-out drawer, and drop-in patch-panel module. It can host up to eight ribbon cables (with eight 
fibers each) entering the drawer or 64 cables (with a maximum outer diameter of 2 mm [0.079 inches]). 

Because the patch-panel module can host 64 connections, a hub node will typically require two 
patch-panel modules, and other DWDM nodes typically require one. The module fits 19- and 23-inch 
(482.6-mm and 584.2-mm) ANSI racks and 600 mm (23.6 inch) x 300 mm (11.8 inch) ETSI racks, using 
reversible brackets.

Figure 13-36 shows a fully fibered patch-panel module.

Figure 13-36 Patch-Panel Module

13.10.3 Fiber Management Using the Optional DWDM Fiber Tray
Cisco recommends installing a fiber storage tray in multinode racks to facilitate fiber management for 
DWDM applications. Refer to Figure 13-15 for typical mounting locations.

Table 13-7 provides the fiber capacity for each tray.
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13.10.4   Fiber Management Using the Optional ANSI Tie-Down Bar
Figure 13-37 shows a DWDM fiber tray.

Figure 13-37 DWDM Fiber Tray

13.10.4 Fiber Management Using the Optional ANSI Tie-Down Bar
You can install a 5-inch (127-mm) tie-down bar on the rear of the ANSI chassis. You can use tie-wraps 
or other site-specific material to bundle the cabling and attach it to the bar so that you can more easily 
route the cable away from the rack.

Figure 13-38 shows the tie-down bar, the ONS 15454 ANSI, and the rack.

Table 13-7 Fiber Tray Capacity

Fiber Diameter Maximum Number of Fibers Exiting Each Side

1.6 mm (0.6 inch) 62

2 mm (0.7 inch) 48

3 mm (0.11 inch) 32
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13.11   Fan-Tray Assembly
Figure 13-38 Tie-Down Bar on the Cisco ONS 15454 ANSI Shelf Assembly

13.11 Fan-Tray Assembly 
The fan-tray assembly is located at the bottom of the ONS 15454 shelf assembly. The fan tray is a 
removable drawer that holds fans and fan-control circuitry for the ONS 15454. The front door can be left 
in place or removed before installing the fan-tray assembly. After you install the fan tray, you should 
only need to access it if a fan failure occurs or if you need to replace or clean the fan-tray air filter. Refer 
to Chapter 11, “Maintain the Node” to clean and replace the fan-tray assembly.

The front of the fan-tray assembly has an LCD screen that provides slot- and port-level information for 
all card slots, including the number of Critical, Major, and Minor alarms. 

The fan-tray assembly features an air filter at the bottom of the tray that you can install and remove by 
hand. Remove and visually inspect this filter every 30 days and keep spare filters in stock. Refer to 
Chapter 11, “Maintain the Node,” for information about cleaning and maintaining the fan-tray air filter.

Caution Do not operate an ONS 15454 without the mandatory fan-tray air filter. 

Caution The 15454-FTA3-T fan-tray assembly can only be installed in ONS 15454 Release 3.1 and later shelf 
assemblies (15454-SA-ANSI, P/N: 800-19857; 15454-SA-HD, P/N: 800-24848). It includes a pin that 
does not allow it to be installed in ONS 15454 shelf assemblies released before ONS 15454 Release 3.1 
(15454-SA-NEBS3E, 15454-SA-NEBS3, and 15454-SA-R1). Equipment damage can result from 
attempting to install the 15454-FTA3 in a noncompatible shelf assembly. 

10
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12

Tie-down bar
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13.11.1   Fan Speed and Power Requirements
Note The 15454-FTA3 is not I-temp compliant. To obtain an I-temp fan tray, install the 15454-FTA3-T 
fan-tray assembly in an ONS 15454 Release 3.1 shelf assembly (15454-SA-ANSI or 15454-SA-HD). 
However, do not install the ONS 15454 SONET XC10G cross-connect cards with the 15454-FTA2 
fan-tray assembly.

See Figure 13-39 for the position of the ONS 15454 ETSI fan-tray assembly. 

Figure 13-39 Position of the ONS 15454 ETSI Fan-Tray Assembly

13.11.1 Fan Speed and Power Requirements
Fan speed is controlled by the TCC2 card’s temperature sensors. The sensors measure the input air 
temperature at the fan-tray assembly. Fan speed options are low, medium, and high. If the TCC2 card 
fails, the fans automatically shift to high speed. The temperature measured by the TCC2 sensors appears 
on the LCD screen.

Table 13-8 lists power requirements for the fan-tray assembly.
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13.11.2   Fan Failure
13.11.2 Fan Failure
If one or more fans fail on the fan-tray assembly, replace the entire assembly. You cannot replace 
individual fans. The red Fan Fail LED on the front of the fan tray illuminates when one or more fans fail. 
For fan tray replacement instructions, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide. The red Fan Fail LED clears after you install a working fan tray. 

13.11.3 Air Filter 
The ONS 15454 contains a reusable air filter (for ANSI: 15454-FTF2; for ETSI: 15454E-ETSI-FTF) that 
is installed either beneath the fan-tray assembly or, for the ONS 15454 ANSI, in the optional external 
filter brackets. 

The reusable filter is made of a gray, open-cell, polyurethane foam that is specially coated to provide fire 
and fungi resistance. All versions of the ONS 15454 can use the reusable air filter. Spare filters should 
be kept in stock. Inspect the air filter every 30 days, and clean the filter every three to six months. 
Replace the air filter every two to three years. Avoid cleaning the air filter with harsh cleaning agents or 
solvents.

Earlier versions of the ONS 15454 ANSI shelf used a disposable air filter that is installed beneath the 
fan-tray assembly only. However, the reusable air filter is backward compatible.

13.12 Power and Ground Description
Ground the equipment according to Telcordia standards or local practices. The following sections 
describe power and ground for the ONS 15454 shelves.

13.12.1 ONS 15454 ANSI Power and Ground
Cisco recommends the following wiring conventions, but customer conventions prevail:

• Red wire for battery connections (–48 VDC).

• Black wire for battery return connections (0 VDC). 

• The battery return connection is treated as DC-I, as defined in Telcordia GR-1089-CORE, Issue 3.

The ONS 15454 ANSI has redundant –48 VDC #8 power terminals on the shelf-assembly backplane. 
The terminals are labeled BAT1, RET1, BAT2, and RET2 and are located on the lower section of the 
backplane behind a clear plastic cover. 

Table 13-8 Fan Tray Assembly Power Requirements

Fan Tray Assembly Watts Amps BTU/Hr

FTA2 53 1.21 198

FTA3 -T 86.4 1.8 295
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13.12.2   ONS 15454 ETSI Power and Ground
To install redundant power feeds, use four power cables and one ground cable. For a single power feed, 
only two power cables (#10 AWG, 2.588 mm² [0.1018 inch], copper conductor, 194°F [90°C]) and one 
ground cable (#6 AWG, 4.115 mm² [0.162 inch]) are required. Use a conductor with low impedance to 
ensure circuit overcurrent protection. However, the conductor must have the capability to safely conduct 
any faulty current that might be imposed. 

Note If you are installing power on a Release 3.0 ONS 15454 ANSI shelf assembly (15454-SA-NEBS3E, 
15454-SA-NEBS3, and 15454-SA-R1), the #12 to #14 AWG (2.053 to 1.628 mm²) power cable and #14 
AWG (1.628 mm²) ground cable are required.

The existing ground post is a #10-32 bolt. The nut provided for a field connection is also a #10 AWG 
(2.588 mm² [0.1018 inch]), with an integral lock washer. The lug must be a dual-hole type and rated to 
accept the #6 AWG (4.115 mm² [0.162 inch]) cable. Two posts are provided on the ONS 15454 ANSI to 
accommodate the dual-hole lug. Figure 13-40 shows the location of the ground posts.

Figure 13-40 Ground Posts on the ONS 15454 ANSI Backplane

13.12.2 ONS 15454 ETSI Power and Ground
The ONS 15454 ETSI has redundant –48 VDC power connectors on the MIC-A/P and MIC-C/T/P 
faceplates. 

To install redundant power feeds, use the two power cables shipped with the ONS 15454 ETSI and one 
ground cable. 

For details, see the “14.3.1 MIC-A/P FMEC” section on page 14-21 and the “14.3.2 MIC-C/T/P 
FMEC” section on page 14-24. 

Caution Only use the power cables shipped with the ONS 15454 ETSI.

13.13 ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin 
Connections

Pin connections are provided on the ONS 15454 ANSI backplane. For information about 
ONS 15454 ETSI connections, see the “13.8 ONS 15454 ETSI Front Mount Electrical Connection” 
section on page 13-30.

FRAME GROUND 61
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13.13   ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin Connections
Caution Always use the supplied ESD wristband when working with a powered ONS 15454. Plug the wristband 
cable into the ESD jack located on the lower-right outside edge of the shelf assembly.

The ONS 15454 ANSI has a backplane pin field located at the bottom of the backplane. The backplane 
pin field provides 0.045 inch2 (29 mm2) wire-wrap pins for enabling external alarms, timing input and 
output, and craft interface terminals. This section describes the backplane pin field and the pin 
assignments for the field. Figure 13-41 shows the wire-wrap pins on the backplane pin field. Beneath 
each wire-wrap pin is a frame ground pin. Frame ground pins are labeled FG1, FG2, FG3, etc. Install the 
ground shield of the cables connected to the backplane to the ground pin that corresponds to the pin field 
used. 

Note The AIC-I requires a shelf assembly running Software Release 3.4.0 or later. The backplane of the ANSI 
shelf contains a wire-wrap field with pin assignment according to the layout in Figure 13-41. The shelf 
assembly might be an existing shelf that has been upgraded to R3.4 or later. In this case the backplane 
pin labeling appears as indicated in Figure 13-42 on page 13-47, but you must use the pin assignments 
provided by the AIC-I as shown in Figure 13-41.
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13.13   ONS 15454 ANSI Alarm, Timing, LAN, and Craft Pin Connections
Figure 13-41 ONS 15454 ANSI Backplane Pinouts (Release 3.4 or Later)
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Field Pin Function Field Pin Function

BITS A1 BITS Output 2 negative (–)   ENVIR
 ALARMS 
IN/OUT

N/O

A1/A13 Normally open output pair number 1

B1 BITS Output 2 positive (+) B1/B13

A2 BITS Input 2 negative (–) A2/A14 Normally open output pair number 2

B2 BITS Input 2 positive (+) B2/B14

A3 BITS Output 1 negative (–) A3/A15 Normally open output pair number 3

B3 BITS Output 1 positive (+) B3/B15

A4 BITS Input 1 negative (–) A4/A16 Normally open output pair number 4

B4 BITS Input 1 positive (+) B4/B16

LAN Connecting to a hub, or switch  ACO A1 Normally open ACO pair

A1 B1

B1 CRAFT A1 Receive (PC pin #2)

A2 A2  Transmit (PC pin #3)

B2 A3 Ground (PC pin #5)

A4 DTR (PC pin #4)

  LOCAL
ALARMS 

AUD
(Audible)

N/O

N/O

A1 Alarm output pair number 1: Remote 
audible alarm.B1 B1

 ENVIR
ALARMS 

IN

A2 Alarm output pair number 2: Critical 
audible alarm.B2

A3 Alarm output pair number 3: Major 
audible alarm.

A1

B3B1

A4 Alarm output pair number 4: Minor 
audible alarm.

A2

B4B2

 LOCAL
ALARMS 

VIS
(Visual)

A1 Alarm output pair number 1: Remote
visual alarm.

A3

B1

A2 Alarm output pair number 2:  Critical
visual alarm.B2

A3  Alarm output pair number 3: Major
visual alarm.B3

A4  Alarm output pair number 4: Minor 
visual alarm.B4

A1

A2

B3

A4

B4

RJ-45 pin 2 TX–

RJ-45 pin 1 TX+

RJ-45 pin 2 RX–

RJ-45 pin 1 RX+

RJ-45 pin 6 TX–

Alarm input pair number 1: Reports 
closure on connected wires.

Alarm input pair number 2: Reports 
closure on connected wires.

Alarm input pair number 3: Reports 
closure on connected wires.

Alarm input pair number 4: Reports
closure on connected wires.

A5

B5

Alarm input pair number 5: Reports
closure on connected wires.

A6

B6

Alarm input pair number 6: Reports
closure on connected wires.

A7

B7

Alarm input pair number 7: Reports
closure on connected wires.

A8

B8

Alarm input pair number 8: Reports
closure on connected wires.

A9

B9

Alarm input pair number 9: Reports
closure on connected wires.

A10

B10

Alarm input pair number 10: Reports
closure on connected wires.

A11

B11

Alarm input pair number 11: Reports
closure on connected wires.

A12

B12

Alarm input pair number 12: Reports
closure on connected wires.

Connecting to a PC/Workstation or router

RJ-45 pin 3 TX+B2

RJ-45 pin 3 RX+

RJ-45 pin 6 RX–

If you are using an 
AIC-I card, contacts 
provisioned as OUT 
are 1-4. Contacts 
provisioned as IN 
are 13-16.
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13.13.1   Alarm Contact Connections
Figure 13-42 ONS 15454 ANSI Backplane Pinouts

13.13.1 Alarm Contact Connections
The alarm pin field supports up to 17 alarm contacts, including four audible alarms, four visual alarms, 
one alarm cutoff (ACO), and four user-definable alarm input and output contacts. 

Audible alarm contacts are in the LOCAL ALARM AUD pin field and visual contacts are in the LOCAL 
ALARM VIS pin field. Both of these alarms are in the LOCAL ALARMS category. User-definable 
contacts are in the ENVIR ALARM IN (external alarm) and ENVIR ALARM OUT (external control) 
pin fields. These alarms are in the ENVIR ALARMS category; you must have the AIC card installed to 
use the ENVIR ALARMS. Alarm contacts are Normally Open (N/O), meaning that the system closes the 
alarm contacts when the corresponding alarm conditions are present. Each alarm contact consists of two 
wire-wrap pins on the shelf assembly backplane. Visual and audible alarm contacts are classified as 
Critical, Major, Minor, and Remote. Figure 13-42 on page 13-47 shows alarm pin assignments. 

Field Pin Function Field Pin Function

BITS A1 BITS Output 2 negative (-)   ENVIR
 ALARMS 

OUT

N/O

A1 Normally open output pair number 1

B1 BITS Output 2 positive (+) B1

A2 BITS Input 2 negative (-) A2 Normally open output pair number 2

B2 BITS Input 2 positive (+) B2

A3 BITS Output 1 negative (-) A3 Normally open output pair number 3

B3 BITS Output 1 positive (+) B3

A4 BITS Input 1 negative (-) A4 Normally open output pair number 4

B4 BITS Input 1 positive (+) B4

LAN Connecting to a hub, or switch  ACO A1 Normally open ACO pair

A1 B1

B1 CRAFT A1 Receive (PC pin #2)

A2 A2 Transmit (PC pin #3)

B2 A3 Ground (PC pin #5)

A4 DTR (PC pin #4)

  LOCAL
ALARMS 

AUD
(Audible)

N/O

N/O

A1 Alarm output pair number 1: Remote 
audible alarm.B1 B1

 ENVIR
ALARMS 

IN

A2 Alarm output pair number 2: Critical 
audible alarm.B2

A3 Alarm output pair number 3: Major 
audible alarm.

A1

B3B1

A4 Alarm output pair number 4: Minor 
audible alarm.

A2

B4B2

 LOCAL
ALARMS 

VIS
(Visual)

A1 Alarm output pair number 1: Remote
visual alarm.

A3

B1

A2 Alarm output pair number 2:  Critical
visual alarm.B2

A3 Alarm output pair number 3: Major
visual alarm.B3

A4 Alarm output pair number 4: Minor 
visual alarm.B4

A1

A2

B3

A4

B4

RJ-45 pin 2 TX-

RJ-45 pin 1 TX+

RJ-45 pin 2 RX-

RJ-45 pin 1 RX+

RJ-45 pin 6 TX-

Alarm input pair number 1: Reports 
closure on connected wires.

Alarm input pair number 2: Reports 
closure on connected wires.

Alarm input pair number 3: Reports 
closure on connected wires.

Alarm input pair number 4: Reports
closure on connected wires.

Connecting to a PC/Workstation or router

RJ-45 pin 3 TX+B2

RJ-45 pin 3 RX+

RJ-45 pin 6 RX-
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13.13.2   Timing Connections
Visual and audible alarms are typically wired to trigger an alarm light or bell at a central alarm collection 
point when the corresponding contacts are closed. You can use the ACO pins to activate a remote ACO 
for audible alarms. You can also activate the ACO function by pressing the ACO button on the TCC2 
card faceplate. The ACO function clears all audible alarm indications. After clearing the audible alarm 
indication, the alarm is still present and viewable in the Alarms tab in CTC. 

13.13.2 Timing Connections
The ONS 15454 ANSI backplane supports two building integrated timing supply (BITS) clock pin 
fields. The first four BITS pins, rows 3 and 4, support output and input from the first external timing 
device. The last four BITS pins, rows 1 and 2, perform the identical functions for the second external 
timing device. Table 13-9 lists the pin assignments for the BITS timing pin fields.

Note For timing connection, use 100-ohm shielded BITS clock cable pair #22 or #24 AWG (0.51 mm² 
[0.020 inch] or 0.64 mm² [0.0252 inch]), twisted-pair T1-type.

Note Refer to Telcordia SR-NWT-002224 for rules about provisioning timing references.

13.13.3 LAN Connections
Use the LAN pins on the ONS 15454 ANSI backplane to connect the ONS 15454 ANSI to a workstation 
or Ethernet LAN, or to a LAN modem for remote access to the node. You can also use the LAN port on 
the TCC2 faceplate to connect a workstation or to connect the ONS 15454 ANSI to the network. 
Table 13-10 shows the LAN pin assignments.

Before you can connect an ONS 15454 ANSI to other ONS 15454 ANSI shelves or to a LAN, you must 
change the default IP address that is shipped with each ONS 15454 ANSI (192.1.0.2). 

Table 13-9 BITS External Timing Pin Assignments

External Device Contact Tip and Ring Function

First external device A3 (BITS 1 Out) Primary ring (–) Output to external device

B3 (BITS 1 Out) Primary tip (+) Output to external device

A4 (BITS 1 In) Secondary ring (–) Input from external device

B4 (BITS 1 In) Secondary tip (+) Input from external device

Second external device A1 (BITS 2 Out) Primary ring (–) Output to external device

B1 (BITS 2 Out) Primary tip (+) Output to external device

A2 (BITS 2 In) Secondary ring (–) Input from external device

B2 (BITS 2 In) Secondary tip (+) Input from external device
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13.13.4   TL1 Craft Interface Installation
13.13.4 TL1 Craft Interface Installation
You can use the craft pins on the ONS 15454 ANSI backplane or the EIA/TIA-232 port on the TCC2 
faceplate to create a VT100 emulation window to serve as a TL1 craft interface to the ONS 15454 ANSI. 
Use a straight-through cable to connect to the EIA/TIA-232 port. Table 13-11 shows the pin assignments 
for the CRAFT pin field.

Note You cannot use the craft backplane pins and the EIA/TIA-232 port on the TCC2 card simultaneously.

13.14 Cards and Slots 
ONS 15454 cards have electrical plugs at the back that plug into electrical connectors on the shelf 
assembly backplane. When the ejectors are fully closed, the card plugs into the assembly backplane. 
Figure 13-43 shows card installation for an ONS 15454 ANSI shelf. 

Table 13-10 LAN Pin Assignments

Pin Field Backplane Pins RJ-45 Pins

LAN 1 
Connecting to data circuit-terminating 
equipment (DCE1, a hub or switch)

1. The Cisco ONS 15454 ANSI is DCE.

B2 1

A2 2

B1 3

A1 6

LAN 1
Connecting to data terminal equipment 
(DTE) (a PC/workstation or router)

B1 1

A1 2

B2 3

A2 6

Table 13-11 Craft Interface Pin Assignments

Pin Field Contact Function

Craft A1 Receive

A2 Transmit

A3 Ground

A4 DTR
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13.14   Cards and Slots
Figure 13-43 Installing Cards in the ONS 15454 ANSI

Figure 13-44 shows card installation in the ONS 15454 ETSI shelf. 
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13.14.1   Card Slot Requirements
Figure 13-44 Installing Cards in the ONS 15454 ETSI Shelf

13.14.1 Card Slot Requirements
The ONS 15454 shelf assemblies have 17 card slots numbered sequentially from left to right. Slots 7 and 
11 are dedicated to TCC2 cards. Slot 9 is reserved for the optional AIC or AIC-I card. 

Caution Do not operate the ONS 15454 with a single TCC2 card. Always operate the shelf assembly with one 
working and one protect card of the same type.

Shelf assembly slots have symbols indicating the type of cards that you can install in them. Each 
ONS 15454 card has a corresponding symbol. The symbol on the card must match the symbol on the slot.

Table 13-12 shows the slot and card symbol definitions.

61
23

9

FAN FAIL
CRIT

MAJ
MIN

Guide railEjector

Table 13-12 Slot and Card Symbols

Symbol Color/Shape Definition

Orange/Circle Slots 1 to 6 and 12 to 17. Only install cards with a circle symbol on the faceplate.

Blue/Triangle Slots 5, 6, 12, and 13. Only install cards with circle or a triangle symbol on the 
faceplate.
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13.14.2   Card Replacement
13.14.2 Card Replacement
To replace an ONS 15454 card with another card of the same type, you do not need to make any changes 
to the database; remove the old card and replace it with a new card. To replace a card with a card of a 
different type, physically remove the card and replace it with the new card, then delete the original card 
from CTC. For specifics, see Chapter 11, “Maintain the Node.”

Caution Removing any active card from the ONS 15454 can result in traffic interruption. Use caution when 
replacing cards and verify that only inactive or standby cards are being replaced. If the active card needs 
to be replaced, switch it to standby prior to removing the card from the node. For traffic switching 
procedures, refer to the “DLP-G179 Apply a Force Y-Cable or Splitter Protection Switch” task on 
page 9-24. 

Note An improper removal (IMPROPRMVL) alarm is raised whenever a card pull (reseat) is performed, 
unless the card is deleted in CTC first. The alarm clears after the card replacement is complete.

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

13.15 Ferrites (ANSI Only)
Place third-party ferrites on certain cables to dampen electromagnetic interference (EMI) from the 
ONS 15454 ANSI. Ferrites must be added to meet the requirements of Telcordia GR-1089-CORE. Refer 
to the ferrite manufacturer documentation for proper use and installation of the ferrites. Ferrite 
placements on the ONS 15454 ANSI can include power cables, AMP Champ connectors, baluns, 
BNC/SMB connectors, and the wire-wrap pin field.

Purple/Square TCC2 slot, Slots 7 and 11. Only install cards with a square symbol on the 
faceplate.

Green/Cross Cross-connect (XC/XCVT/XC10G) slot, Slots 8 and 10. Only install 
ONS 15454 cards with a cross symbol on the faceplate.

Red/P Protection slot in 1:N protection schemes.

Red/Diamond AIC/AIC-I slot, Slot 9. Only install cards with a diamond symbol on the 
faceplate.

Gold/Star Slots 1 to 4 and 14 to 17. Only install cards with a star symbol on the faceplate. 

Blue/Hexagon (Only used with the 15454-SA-HD shelf assembly.) Slots 3 and 15. Only install 
ONS 15454 ANSI cards with a blue hexagon symbol on the faceplate.

Table 13-12 Slot and Card Symbols (continued)

Symbol Color/Shape Definition
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C H A P T E R 14

Card Reference

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This chapter describes Cisco ONS 15454 dense wavelength division multiplexing (DWDM) card and 
client card features and functions. It also describes the common control cards needed to support them as 
well as the optical plug-in modules (SFPs). For installation and card turn-up procedures, refer to 
Chapter 3, “Turn Up a Node.” For card safety and compliance information, refer to the Cisco Optical 
Transport Products Safety and Compliance Information document.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 14.1 Card Overview, page 14-2

• 14.2 Common Control Cards, page 14-11

• 14.3 Front Mount Electrical Connections, page 14-21

• 14.4 Optical Service Channel Cards, page 14-26

• 14.5 Optical Amplifier Cards, page 14-35

• 14.6 Multiplexer and Demultiplexer Cards, page 14-44

• 14.7 Optical Add/Drop Multiplexer Cards, page 14-62

• 14.8 Transponder and Muxponder Cards, page 14-86

• 14.9 Transponder and Muxponder Protection, page 14-119

• 14.10 Far-End Laser Control (FELC), page 14-121

• 14.11 Transponder and Muxponder Jitter Considerations, page 14-121

• 14.12 Transponder and Muxponder Termination Modes, page 14-122

• 14.13 SFP Modules, page 14-123
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14.1 Card Overview
14.1 Card Overview
The card overview section lists the cards described in this chapter and summarizes card functions, power 
consumption, and temperature ranges of the optical cards covered in this reference section. 

Note Each card is marked with a symbol that corresponds to a slot (or slots) on the ONS 15454 shelf assembly. 
The cards are then installed into slots displaying the same symbols. See the “13.14.1 Card Slot 
Requirements” section on page 13-51 for a list of slots and symbols. 

14.1.1 Common Control Cards
The following common control cards are needed to support the functions of the DWDM, transponder, 
and muxponder cards:

• TCC2

• AIC-I

• AIC (ANSI only)

14.1.2 Front Mount Electrical Connections (ETSI only)
The following front mount electrical connections (FMECs) are needed to support the functions of the 
DWDM, transponder, and muxponder cards:

• MIC-A/P

• MIC-C/T/P

14.1.3 DWDM Cards
ONS 15454 DWDM cards are grouped into the following categories: 

• Optical service channel cards—These cards provide bidirectional channels that connect ONS 15454 
DWDM nodes and transport general-purpose information (including CTC management) without 
affecting the client traffic. ONS 15454 optical service channel cards include the Optical Service 
Channel Module (OSCM) and the Optical Service Channel and Combiner/Separator Module 
(OSC-CSM).

• Optical amplifier cards—These cards are used in amplified DWDM nodes, including hub nodes, 
amplified OADM nodes, and line amplified nodes. Optical amplifier cards include the Optical 
Preamplifier (OPT-PRE) and Optical Booster (OPT-BST) amplifier.

• Dispersion compensation units—These cards are installed in the ONS 15454 dispersion 
compensation shelf when optical preamplifier cards are installed in the DWDM node. Each DCU 
module can compensate a maximum of 65 km of single-mode fiber (SMF-28) span. DCUs can be 
cascaded to extend the compensation to 130 km.

• Multiplexer and demultiplexer cards—These cards multiplex and demultiplex DWDM optical 
channels. ONS 15454 multiplexer and demultiplexer cards include the 32-Channel Multiplexer 
(32MUX-O), the 32-Channel Demultiplexer (32DMX-O), the single-slot 32-Channel Demultiplexer 
(32DMX), and the 4-Channel Multiplexer/Demultiplexer (4MD-xx.x).
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14.1.4 Transponder and Muxponder Cards
• Optical Add/Drop Multiplexer (OADM) cards—These cards are mainly divided into two groups: 
band OADM and channel OADM cards. Band OADM cards add and drop one or four bands of 
adjacent channels; they include the 4-Band OADM (AD-4B-xx.x) and the 1-Band OADM 
(AD-1B-xx.x). Channel OADM cards add and drop one, two, or four adjacent channels; they include 
the 4-Channel OADM (AD-4C-xx.x), the 2-Channel OADM (AD-2C-xx.x), and the 1-Channel 
OADM (AD-1C-xx.x). This section also covers the 32-Channel Wavelength Selective Switch 
(32WSS) used to implement Reconfigurable OADM (ROADM) functionality.

14.1.4 Transponder and Muxponder Cards
The purpose of a transponder (TXP) or muxponder (MXP) card is to convert the “gray” optical client 
interface signals into trunk signals that operate in the “colored” DWDM wavelength range1. 
Transponding or muxponding is the process of converting the signals between the client and trunk 
wavelengths. 

A muxponder generally handles several client signals. It aggregates, or multiplexes, lower rate client 
signals together and sends them out over a higher rate trunk port. Likewise, it demultiplexes optical 
signals coming in on a trunk and sends them out to individual client ports. A transponder converts a 
single client signal to a single trunk signal and converts a single incoming trunk signal to a single client 
signal.

All of the TXP and MXP cards perform optical to electrical to optical (OEO) conversion. As a result, 
they are not optically transparent cards. The reason for this is that the cards must operate on the signals 
passing through them, so it is necessary to do an OEO conversion.

On the other hand, the termination mode for all of the TXPs and MXPs, which is done at the electrical 
level, can be configured to be transparent. In this case, neither the Line nor the Section overhead is 
terminated. The cards can also be configured so that either Line or Section overhead can be terminated, 
or both can be terminated.

Note The MXP_2.5G_10G card, by design, when configured in the transparent termination mode, actually 
does terminate some of the bytes. See Table 14-66 on page 14-122 for details.

14.1.5 Card Summary
Table 14-1 lists and summarizes the functions of each Cisco ONS 15454 DWDM and client card.

1. Client-facing gray optical signals generally operate at shorter wavelengths, whereas DWDM colored optical 
signals are in the longer wavelength range (for example, 1490 nm = violet; 1510 nm = blue; 1530 nm = green; 
1550 nm = yellow; 1570 nm = orange; 1590 nm = red; 1610 nm = brown). Some of the newer client-facing 
SFPs, however, operate in the colored region.

Table 14-1 DWDM and Client Cards for the ONS 15454

Card Port Description For Additional Information

Optical Service Channel Cards

OSCM The OSCM has one set of optical ports and one 
Ethernet port located on the faceplate. It operates 
in Slots 8 and 10.

See the “14.4.1 OSCM Card” 
section on page 14-26.
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14.1.5 Card Summary
OSC-CSM The OSC-CSM has three sets of optical ports and 
one Ethernet port located on the faceplate. It 
operates in Slots 1 to 6 and 12 to 17.

See the “14.4.2 OSC-CSM 
Card” section on page 14-30.

Optical Amplifier Cards

OPT-PRE The OPT-PRE amplifier has five optical ports 
(three sets) located on the faceplate. It operates in 
Slots 1 to 6 and 12  to 17.

See the “14.5.1 OPT-PRE 
Amplifier” section on 
page 14-35.

OPT-BST The OPT-BST amplifier has four sets of optical 
ports located on the faceplate. It operates in 
Slots 1 to 6 and 12  to 17.

See the “14.5.2 OPT-BST 
Amplifier Card” section on 
page 14-39.

Multiplexer and Demultiplexer Cards

32MUX-O The 32MUX-O has five sets of ports located on the 
faceplate. It operates in Slots 1 to 5 and 12 to 16.

See the “14.6.1 32MUX-O 
Card” section on page 14-44.

32DMX-O The 32DMX-O has five sets of ports located on the 
faceplate. It operates in Slots 1 to 5 and 12 to 16

See the “14.6.2 32DMX-O 
Card” section on page 14-48.

32DMX The 32DMX has five sets of ports located on the 
faceplate. It operates in Slots 1 to 6 and 12 to 17

See the 14.6.3 32DMX Card, 
page 14-52

4MD-xx.x The 4MD-xx.x card has five sets of ports located 
on the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “14.6.4 4MD-xx.x 
Card” section on page 14-57.

Optical Add/Drop Multiplexer Cards

AD-1C-xx.x The AD-1C-xx.x card has three sets of ports 
located on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “14.7.1 AD-1C-xx.x 
Card” section on page 14-62.

AD-2C-xx.x The AD-2C-xx.x card has four sets of ports 
located on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “14.7.2 AD-2C-xx.x 
Card” section on page 14-65.

AD-4C-xx.x The AD-4C-xx.x card has six sets of ports located 
on the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “14.7.3 AD-4C-xx.x 
Card” section on page 14-69.

AD-1B-xx.x The AD-1B-xx.x card has three sets of ports 
located on the faceplate. It operates in Slots 1 to 6 
and 12 to 17.

See the “14.7.4 AD-1B-xx.x 
Card” section on page 14-74.

AD-4B-xx.x The AD-4B-xx.x card has six sets of ports located 
on the faceplate. It operates in Slots 1 to 6 and 
12 to 17.

See the “14.7.5 AD-4B-xx.x 
Card” section on page 14-78.

32WSS The 32WSS card has seven sets of ports located on 
the faceplate. It operates in Slots 1 to 5 and 
12 to 16.

See the 14.7.6 32WSS Card, 
page 14-81

Transponder and Muxponder Cards

TXP_MR_10G The TXP_MR_10G card has two sets of ports 
located on the faceplate.

See the 14.8.1 TXP_MR_10G 
Card, page 14-87

Table 14-1 DWDM and Client Cards for the ONS 15454 (continued)

Card Port Description For Additional Information
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14.1.5 Card Summary
TXP_MR_10E The TXP_MR_10E card has two sets of ports 
located on the faceplate.

See the 14.8.2 TXP_MR_10E 
Card, page 14-90

TXP_MR_2.5G The TXP_MR_2.5G card has two sets of ports 
located on the faceplate.

See the 14.8.3 TXP_MR_2.5G 
and TXPP_MR_2.5G Cards, 
page 14-94

TXPP_MR_2.5G The TXPP_MR_2.5G card has three sets of ports 
located on the faceplate.

See the 14.8.3 TXP_MR_2.5G 
and TXPP_MR_2.5G Cards, 
page 14-94

MXP_2.5G_10G The MXP_2.5G_10G card has 9 sets of ports 
located on the faceplate.

See the 14.8.4 MXP_2.5G_10G 
Card, page 14-101.

MXP_2.5G_10E The MXP_2.5G_10E card has 9 sets of ports 
located on the faceplate.

See the 14.8.5 MXP_2.5G_10E 
Card, page 14-104

MXP_MR_2.5G The MXP_MR_2.5G card has 9 sets of ports 
located on the faceplate.

See the 14.8.6 MXP_MR_2.5G 
and MXPP_MR_2.5G Cards, 
page 14-113

MXPP_MR_2.5G The MXPP_MR_2.5G card has 10 sets of ports 
located on the faceplate.

See the 14.8.6 MXP_MR_2.5G 
and MXPP_MR_2.5G Cards, 
page 14-113

Table 14-1 DWDM and Client Cards for the ONS 15454 (continued)

Card Port Description For Additional Information
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14.1.6 Card Compatibility
14.1.6 Card Compatibility
Table 14-2 lists the Cisco Transport Controller (CTC) software compatibility for each DWDM and client 
card.

Table 14-2 DWDM and Client Card CTC Software Release Compatibility

Card Type

Compatibility

R4.5 R4.6 R4.7

Optical Service Channel Cards Yes Yes Yes

OSCM Yes Yes Yes

OSC-CSM Yes Yes Yes

Optical Amplifier Cards Yes Yes Yes

OPT-PRE Yes Yes Yes

OPT-BST Yes Yes Yes

Multiplexer and Demultiplexer Cards Yes Yes Yes

32MUX-O Yes Yes Yes

32DMX-O Yes Yes Yes

32DMX No No Yes

4MD-xx.x Yes Yes Yes

Optical Add/Drop Multiplexer Cards Yes Yes Yes

AD-1C-xx.x Yes Yes Yes

AD-2C-xx.x Yes Yes Yes

AD-4C-xx.x Yes Yes Yes

AD-1B-xx.x Yes Yes Yes

AD-4B-xx.x Yes Yes Yes

32WSS No No Yes

Transponder and Muxponder Cards Yes Yes Yes

TXP_MR_10G Yes Yes Yes

TXP_MR_10E No No Yes

TXP_MR_2.5G Yes Yes Yes

TXPP_MR_2.5G Yes Yes Yes

MXP_2.5G_10G Yes Yes Yes

MXP_2.5G_10E No No Yes

MXP_MR_2.5G No No Yes

MXPP_MR_2.5G No No Yes
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14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes
14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes
The 32MUX-O, 32WSS, 32DMX, 32DMX-O, 4MD-xx.x, AD-1C-xx.x, AD-2C-xx.x, and AD-4C-xx.x 
cards have different input and output optical channel signals, depending upon the interface card where 
the input signal originates. The input interface cards have been grouped in classes listed in Table 14-3. 
The subsequent tables list the optical performances and output power of each interface class. 

10-Gbps cards that provide signal input to OADM cards have the optical performances listed in 
Table 14-4. 2.5-Gbps card interface performances are listed in Table 14-5 on page 14-8 and Table 14-6 
on page 14-9.

Table 14-3 ONS 15454 Card Interfaces Assigned to Input Power Classes

Input Power Class Card

A 10 Gbps multirate transponder (TXP_MR_10G or TXP_MR_10E) with forward 
error correction (FEC) enabled or 10 Gbps muxponder (MXP_2.5G_10G or 
MXP_2.5G_10E) with FEC enabled

B 10 Gbps multirate transponder (TXP_MR_10G) without FEC or 10 Gbps 
muxponder (MXP_2.5G_10G) with FEC disabled

C OC-192 LR ITU, TXP_MR_10E without FEC

D 2.5-Gbps multirate transponder (TXP_MR_2.5G), both protected and 
unprotected, with FEC enabled

E 2.5-Gbps multirate transponder (TXP_MR_2.5G), both protected and 
unprotected, with FEC disabled and reshape, regenerate, and retime (3R) mode 
enabled, or OC-48 100 GHz DWDM muxponder (MXP_MR_2.5G)

F 2.5-Gbps multirate transponder (TXP_MR_2.5G), both protected and 
unprotected, in regenerate and reshape (2R) mode

G OC-48 ELR 100 GHz

H 2/4 port GbE Transponder (GBIC WDM 100GHz)

I TXP_MR_10E with extended FEC (E-FEC) or MXP_2.5G_10E with E-FEC

Table 14-4 10-Gbps Interface Optical Performances

Parameter Class A Class B Class C Class I

Type
Power 
limited

OSNR1 
limited

Power 
limited

OSNR 
limited OSNR limited

Power 
limited

OSNR 
limited

Maximum bit rate 10 Gbps 10 Gbps 10 Gbps 10 Gbps

Regeneration 3R2 3R 3R 3R

FEC Yes No No Yes (E-FEC)

Threshold Optimum Average Average Optimum

Maximum BER3 10–15 10–12 10–12 10–15

OSNR1 sensitivity 23 dB 9 dB 23 dB 19 dB 19 dB 20 dB 8 dB

Power sensitivity –24 dBm –18 dBm –21 
dBm

–20 
dBm

–22 dBm –26 
dBm

–18 
dBm

Power overload -8 dBm -8 dBm -9 dBm -8 dBm
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14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface Classes
Transmitted Power Range4

10-Gbps multirate 
transponder/10Gbps 
FEC transponder 
(TXP_MR_10G)

+2.5 to 3.5 dBm +2.5 to 3.5 dBm – –

OC-192 LR ITU – – +3.0 to 6.0 dBm –

10-Gbps multirate 
transponder/10Gbps 
FEC transponder 
(TXP_MR_10E)

+3.0 to 6.0 dBm +3.0 to 6.0 dBm – +3.0 to 6.0 dBm

Dispersion 
compensation 
tolerance

±800 ps/nm ±1,000 ps/nm ±1,000 ps/nm ±800 ps/nm

1. OSNR = optical signal-to-noise ratio

2. 3R = retime, reshape, and regenerate

3. BER = bit error rate

4. These values, decreased by patch cord and connector losses, are also the input power values for the OADM cards.

Table 14-5 2.5-Gbps Interface Optical Performances  (Part 1)

Parameter Class D Class E Class F Class G

Type
Power 
limited

OSNR1 
limited

Power 
limited

OSNR 
limited OSNR limited

Power 
limited

OSNR 
limited

Maximum bit rate 2.5 Gbps 2.5 Gbps 2.5 Gbps 2.5 Gbps

Regeneration 3R2 3R 2R 3R

FEC Yes No No No

Threshold Average Average Average Average

Maximum BER3 10–15 10–12 10–12 10–12

OSNR1 sensitivity 14 dB 6 dB 14 dB 10 dB 15 dB 14 dB 11 dB

Power sensitivity –31 dBm –25 dBm –30 dBm –23 dBm –24 dBm –27 
dBm

–33 
dBm

Power overload -9 dBm -9 dBm -9 dBm -9 dBm

Transmitted Power Range4

Table 14-4 10-Gbps Interface Optical Performances (continued)

Parameter Class A Class B Class C Class I

Type
Power 
limited

OSNR1 
limited

Power 
limited

OSNR 
limited OSNR limited

Power 
limited

OSNR 
limited
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14.1.8 DWDM Card Channel Allocation Plan
14.1.8 DWDM Card Channel Allocation Plan
ONS 15454 DWDM multiplexers, demultiplexers, channel OADM, and band OADM cards are designed 
for use with specific channels. In most cases, the channels for these cards are either numbered (1 to 32) 
or delimited (odd or even). Client interfaces must comply with these channel assignments to be 
compatible with ONS 15454.

TXP_MR_2.5G –1.0 to 1.0 dBm –1.0 to 1.0 dBm –1.0 to 1.0 dBm

–2.0 to 0 dBm
TXPP_MR_2.5G –4.5 to –2.5 dBm –4.5 to –2.5 dBm –4.5 to –2.5 dBm

MXP_MR_2.5G – +2.0 to +4.0 dBm –

MXPP_MR_2.5G – -1.5 to +0.5 dBm –

Dispersion 
compensation 
tolerance

 -1200 to +5400 
ps/nm

 -1200 to +5400 
ps/nm

 -1200 to +3300 
ps/nm

 -1200 to +3300 
ps/nm

1. OSNR = optical signal-to-noise ratio

2. 3R = retime, reshape, and regenerate

3. BER = bit error rate

4. These values, decreased by patch cord and connector losses, are also the input power values for the OADM cards.

Table 14-6 2.5-Gbps Interface Optical Performances  (Part 2)

Parameter Class H Class J

Type Power limited OSNR1 limited

1. OSNR = optical signal-to-noise ratio

Power limited

Maximum bit rate 1.25 Gbps 2.5 Gbps

Regeneration 3R2

2. 3R = retime, reshape, and regenerate

3R

FEC No No

Threshold Average Average

Maximum BER3

3. BER = bit error rate

10–12 10–12

OSNR1 sensitivity 13 dB 8 dB 12 dB

Power sensitivity –28 dBm –18 dBm –26 dBm

Power overload -7 dBm -17 dBm

Transmitted Power Range

2/4 port GbE Transponder (GBIC WDM 100GHz) +2.5 to 3.5 dBm –

Dispersion compensation tolerance -1000 to +3600 ps/nm -1000 to 
+3200 ps/nm

Table 14-5 2.5-Gbps Interface Optical Performances (continued) (Part 1)

Parameter Class D Class E Class F Class G

Type
Power 
limited

OSNR1 
limited

Power 
limited

OSNR 
limited OSNR limited

Power 
limited

OSNR 
limited
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14.1.8 DWDM Card Channel Allocation Plan
Table 14-7 lists the channel IDs and wavelengths assigned to the DWDM channels.

Table 14-7 DWDM Channel Allocation Plan

Channel Number Channel ID Frequency (THz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56

13 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 54.1 192.9 1554.13

26 54.9 192.8 1554.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61
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14.2 Common Control Cards
This section describes the common control cards (TCC2, AIC, and AIC-I).

14.2.1 TCC2 Card
The Advanced Timing, Communications, and Control (TCC2) card performs system initialization, 
provisioning, alarm reporting, maintenance, diagnostics, IP address detection/resolution, SONET 
section overhead (SOH) data communications channel/generic communications channel (DCC/GCC) 
termination, optical service channel (OSC) DWDM data communications network (DCN) termination, 
and system fault detection for the ONS 15454. The TCC2 also ensures that the system maintains Stratum 
3 (Telcordia GR-253-CORE) timing requirements. It monitors the supply voltage of the system. 

Note The TCC2 card requires Software Release 4.0.0 or later. 

Note The LAN interface of the TCC2 card meets the standard Ethernet specifications by supporting a cable 
length of 328 ft (100 m) at temperatures from 32 to 149 degrees Fahrenheit (0 to 65 degrees Celsius).

Figure 14-1 shows the faceplate and block diagram for the TCC2. 
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Figure 14-1 TCC2 Faceplate and Block Diagram

14.2.1.1 TCC2 Functionality

The TCC2 card terminates up to 32 DCCs. The TCC2 hardware is prepared for 84 DCCs, which will be 
available in a future software release. 

The node database, IP address, and system software are stored in TCC2 nonvolatile memory, which 
allows quick recovery in the event of a power or card failure.

The TCC2 performs all system-timing functions for each ONS 15454. The TCC2 monitors the recovered 
clocks from each traffic card and two building integrated timing supply (BITS) ports for frequency 
accuracy. The TCC2 selects a recovered clock, a BITS, or an internal Stratum 3 reference as the 
system-timing reference. You can provision any of the clock inputs as primary or secondary timing 
sources. A slow-reference tracking loop allows the TCC2 to synchronize with the recovered clock, 
which provides holdover if the reference is lost. 

The TCC2 monitors both supply voltage inputs on the shelf. An alarm is generated if one of the supply 
voltage inputs has a voltage out of the specified range. 
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Install TCC2 cards in Slots 7 and 11 for redundancy. If the active TCC2 fails, traffic switches to the 
protect TCC2.

The TCC2 card has two built-in interface ports for accessing the system: an RJ-45 10BaseT LAN 
interface and an EIA/TIA-232 ASCII interface for local craft access. It also has a 10BaseT LAN port for 
user interfaces via the backplane. 

Note Cisco does not support operation of the ONS 15454 with only one TCC2 card. For full functionality and 
to safeguard your system, always operate with two TCC2 cards. 

Note When a second TCC2 card is inserted into a node, it synchronizes its software, its backup software, and 
its database with the active TCC2. If the software version of the new TCC2 does not match the version 
on the active TCC2, the newly inserted TCC2 copies from the active TCC2, taking about 15 to 20 
minutes to complete. If the backup software version on the new TCC2 does not match the version on the 
active TCC2, the newly inserted TCC2 copies the backup software from the active TCC2 again, taking 
about 15 to 20 minutes. Copying the database from the active TCC2 takes about 3 minutes. Depending 
on the software version and backup version the new TCC2 started with, the entire process can take 
between 3 and 40 minutes. 

14.2.1.2 TCC2 Card-Level Indicators

The TCC2 faceplate has eight LEDs. Table 14-8 describes the two card-level LEDs on the TCC2 
faceplate.

14.2.1.3 Network-Level Indicators

Table 14-9 describes the six network-level LEDs on the TCC2 faceplate.

Table 14-8 TCC2 Card-Level Indicators 

Card-Level LEDs Definition

Red FAIL LED This LED is on during reset. The FAIL LED flashes during the boot and 
write process. Replace the card if the FAIL LED persists. 

ACT/STBY LED

Green (Active)

Yellow (Standby)

Indicates the TCC2 is active (green) or in standby (yellow) mode. The 
ACT/STBY LED also provides the timing reference and shelf control. When 
the active TCC2 is writing to its database or to the standby TCC2 database, 
the card LEDs blink. To avoid memory corruption, do not remove the TCC2 
when the active or standby LED is blinking. 

Table 14-9 TCC2 Network-Level Indicators

System-Level LEDs Definition

Red CRIT LED Indicates critical alarms in the network at the local terminal.

Red MAJ LED Indicates major alarms in the network at the local terminal.

Yellow MIN LED Indicates minor alarms in the network at the local terminal.

Red REM LED Provides first-level alarm isolation. The remote (REM) LED turns red when 
an alarm is present in one or more of the remote terminals.
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14.2.2 AIC Card
The optional Alarm Interface Controller (AIC) card provides customer-defined alarm input/output (I/O) 
and supports local and express orderwire. Figure 14-2 shows the AIC faceplate and a block diagram of 
the card. 

Figure 14-2 AIC Faceplate and Block Diagram

Green SYNC LED Indicates that node timing is synchronized to an external reference.

Green ACO LED After pressing the alarm cutoff (ACO) button, the ACO LED turns green. 
The ACO button opens the audible alarm closure on the backplane. ACO is 
stopped if a new alarm occurs. After the originating alarm is cleared, the 
ACO LED and audible alarm control are reset.

Table 14-9 TCC2 Network-Level Indicators (continued)
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14.2.2.1 External Alarms and Controls

The AIC card provides provisionable input/output alarm contact closures for up to four external alarms 
and four external controls. The physical connections are made using the backplane wire-wrap pins. The 
alarms are defined using CTC and Transaction Language One (TL1). For instructions, see the “DLP-G23 
Install Alarm Wires on the Backplane (ANSI Only)” task on page 1-53. 

Each alarm contact has a corresponding LED on the front panel of the AIC that indicates the status of 
the alarm. External alarms (input contacts) are typically used for external sensors such as open doors, 
temperature sensors, flood sensors, and other environmental conditions. External controls (output 
contacts) are typically used to drive visual or audible devices such as bells and lights, but they can 
control other devices such as generators, heaters, and fans.

You can program each of the four input alarm contacts separately. Choices include:

• Alarm on Closure or Alarm on Open

• Alarm severity of any level (Critical, Major, Minor, Not Alarmed, Not Reported)

• Service Affecting or Non-Service Affecting alarm-service level

• 63-character alarm description for CTC display in the alarm log. You cannot assign the fan-tray 
abbreviation for the alarm; the abbreviation reflects the generic name of the input contacts. The 
alarm condition remains raised until the external input stops driving the contact or you provision the 
alarm input.

The output contacts can be provisioned to close on a trigger or to close manually. The trigger can be a 
local alarm severity threshold, a remote alarm severity, or a virtual wire:

• Local NE alarm severity: A hierarchy of Not Reported, Not Alarmed, Minor, Major, and Critical 
alarm severities that you set to cause output closure. For example, if the trigger is set to Minor, a 
Minor alarm or above is the trigger.

• Remote NE alarm severity: Same as the local NE alarm severity but applies to remote alarms only.

• Virtual wire entities: You can provision any environmental alarm input to raise a signal on any 
virtual wire on external outputs 1 through 4 when the alarm input is an event. You can provision a 
signal on any virtual wire as a trigger for an external control output.

You can also program the output alarm contacts (external controls) separately. In addition to 
provisionable triggers, you can manually force each external output contact to open or close. Manual 
operation takes precedence over any provisioned triggers that might be present.

14.2.2.2 Orderwire

Orderwire allows a craftsperson to plug a phoneset into an ONS 15454 and communicate with 
craftspeople working at other ONS 15454s or other facility equipment. The orderwire is a pulse code 
modulation (PCM) encoded voice channel that uses E1 or E2 bytes in section/line overhead.

The AIC allows simultaneous use of both local (section overhead signal) and express (line overhead 
channel) orderwire channels on a SONET ring or particular optics facility. Local orderwire also allows 
communication at regeneration sites when the regenerator is not a Cisco device.

You can provision orderwire functions with CTC similar to the current provisioning model for 
DCC/GCC channels. In CTC, you provision the orderwire communications network during ring turn-up 
so that all NEs on the ring can reach one another. Orderwire terminations (that is, the optics facilities 
that receive and process the orderwire channels) are provisionable. Both express and local orderwire can 
be configured as on or off on a particular SONET facility. The ONS 15454 supports up to four orderwire 
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channel terminations per shelf, which allow linear, single ring, dual ring, and small hub-and-spoke 
configurations. Orderwire is not protected in ring topologies such as bidirectional line switch ring 
(BLSR) and path protection.

Caution Do not configure orderwire loops. Orderwire loops cause feedback that disables the orderwire channel.

The ONS 15454 implementation of both local and express orderwire is broadcast in nature. The line acts 
as a party line. There is no signaling for private point-to-point connections. Anyone who picks up the 
orderwire channel can communicate with all other participants on the connected orderwire subnetwork. 
The local orderwire party line is separate from the express orderwire party line. Up to four OC-N 
facilities for each local and express orderwire are provisionable as orderwire paths.

The AIC supports a “call” button on the module front panel which, when pressed, causes all ONS 15454 
AICs on the orderwire subnetwork to “ring.” The ringer/buzzer resides on the AIC. There is also a “ring” 
LED that mimics the AIC ringer. It flashes when any “call” button is pressed on the orderwire 
subnetwork. The “call” button and ringer LED allow a remote craftsperson to get the attention of 
craftspeople across the network.

Table 14-10 shows the pins on the orderwire ports that correspond to the tip and ring orderwire 
assignments.

When provisioning the orderwire subnetwork, make sure that an orderwire loop does not exist. Loops 
cause oscillation and an unusable orderwire channel. Figure 14-3 shows the standard RJ-11 orderwire 
pins. 

Figure 14-3 RJ-11 Connector

Table 14-10 Orderwire Pin Assignments

RJ-11 Pin Number Description

1 Four-wire receive ring

2 Four-wire transmit tip

3 Two-wire ring

4 Two-wire tip

5 Four-wire transmit ring

6 Four-wire receive tip
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14.2.3 AIC-I Card
The optional Alarm Interface Controller–International (AIC-I) card provides customer-defined 
(environmental) alarms and controls and supports local and express orderwire. It provides 
12 customer-defined input and 4 customer-defined input/output contacts. The physical connections are 
via the backplane wire-wrap pin terminals. If you use the additional alarm expansion panel (AEP), the 
AIC-I card can support up to 32 inputs and 16 outputs, which are connected on the AEP connectors. A 
power monitoring function monitors the supply voltage (–48 VDC). Figure 14-4 shows the AIC-I 
faceplate and a block diagram of the card. 

Note After you have upgraded a shelf to the AIC-I card and set new attributes, you cannot downgrade the shelf 
back to the AIC card.

Figure 14-4 AIC-I Faceplate and Block Diagram
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14.2.3.1 AIC-I Card-Level Indicators

Table 14-11 describes the eight card-level LEDs on the AIC-I card faceplate. 

14.2.3.2 External Alarms and Controls

The AIC-I card provides input/output alarm contact closures. You can define up to 12 external alarm 
inputs and 4 external alarm inputs/outputs (user configurable). The physical connections are made using 
the backplane wire-wrap pins or FMEC connections. See the “13.9 ONS 15454 ANSI Alarm Expansion 
Panel” section on page 13-30 for information about increasing the number of input/output contacts.

LEDs on the front panel of the AIC-I indicate the status of the alarm lines, one LED representing all of 
the inputs and one LED representing all of the outputs. External alarms (input contacts) are typically 
used for external sensors such as open doors, temperature sensors, flood sensors, and other 
environmental conditions. External controls (output contacts) are typically used to drive visual or 
audible devices such as bells and lights, but they can control other devices such as generators, heaters, 
and fans.

You can program each of the twelve input alarm contacts separately. You can program each of the 
sixteen input alarm contacts separately. Choices include:

• Alarm on Closure or Alarm on Open

• Alarm severity of any level (Critical, Major, Minor, Not Alarmed, Not Reported)

• Service Affecting or Non-Service Affecting alarm-service level

• 63-character alarm description for CTC display in the alarm log. You cannot assign the fan-tray 
abbreviation for the alarm; the abbreviation reflects the generic name of the input contacts. The 
alarm condition remains raised until the external input stops driving the contact or you unprovision 
the alarm input.

Table 14-11 AIC-I Card-Level Indicators 

Card-Level LEDs Description

Red FAIL LED Indicates that the card’s processor is not ready. The FAIL LED is on during 
Reset and flashes during the boot process. Replace the card if the red FAIL 
LED persists.

Green ACT LED Indicates the AIC-I card is provisioned for operation.

Green/red PWR A LED The PWR A LED is green when a supply voltage within a specified range 
has been sensed on supply input A. It is red when the input voltage on supply 
input A is out of range. 

Green/red PWR B LED The PWR B LED is green when a supply voltage within a specified range 
has been sensed on supply input B. It is red when the input voltage on supply 
input B is out of range.

Yellow INPUT LED The INPUT LED is yellow when there is an alarm condition on at least one 
of the alarm inputs. 

Yellow OUTPUT LED The OUTPUT LED is yellow when there is an alarm condition on at least 
one of the alarm outputs. 

Green RING LED The RING LED on the local orderwire (LOW) side is flashing green when a 
call is received on the LOW.

Green RING LED The RING LED on the express orderwire (EOW) side is flashing green when 
a call is received on the EOW.
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You cannot assign the fan-tray abbreviation for the alarm; the abbreviation reflects the generic name of 
the input contacts. The alarm condition remains raised until the external input stops driving the contact 
or you provision the alarm input.

The output contacts can be provisioned to close on a trigger or to close manually. The trigger can be a 
local alarm severity threshold, a remote alarm severity, or a virtual wire:

• Local NE alarm severity: A hierarchy of Not Reported, Not Alarmed, Minor, Major, or Critical 
alarm severities that you set to cause output closure. For example, if the trigger is set to Minor, a 
Minor alarm or above is the trigger.

• Remote NE alarm severity: Same as the local NE alarm severity but applies to remote alarms only.

• Virtual wire entities: You can provision any environmental alarm input to raise a signal on any 
virtual wire on external outputs 1 through 4 when the alarm input is an event. You can provision a 
signal on any virtual wire as a trigger for an external control output.

You can also program the output alarm contacts (external controls) separately. In addition to 
provisionable triggers, you can manually force each external output contact to open or close. Manual 
operation takes precedence over any provisioned triggers that might be present.

Note The number of inputs and outputs can be increased using the AEP. The AEP is connected to the shelf 
backplane and requires an external wire-wrap panel. 

14.2.3.3 Orderwire

Orderwire allows a craftsperson to plug a phoneset into an ONS 15454 and communicate with 
craftspeople working at other ONS 15454s or other facility equipment. The orderwire is a pulse code 
modulation (PCM) encoded voice channel that uses E1 or E2 bytes in section/line overhead.

The AIC-I allows simultaneous use of both local (section overhead signal) and express (line overhead 
channel) orderwire channels on a SONET ring or particular optics facility. Express orderwire also allows 
communication via regeneration sites when the regenerator is not a Cisco device.

You can provision orderwire functions with CTC similar to the current provisioning model for 
DCC/GCC channels. In CTC, you provision the orderwire communications network during ring turn-up 
so that all NEs on the ring can reach one another. Orderwire terminations (that is, the optics facilities 
that receive and process the orderwire channels) are provisionable. Both express and local orderwire can 
be configured as on or off on a particular SONET facility. The ONS 15454 supports up to four orderwire 
channel terminations per shelf. This allows linear, single ring, dual ring, and small hub-and-spoke 
configurations. Keep in mind that orderwire is not protected in ring topologies such as BLSR and Path 
Protection.

Caution Do not configure orderwire loops. Orderwire loops cause feedback that disables the orderwire channel.

The ONS 15454 implementation of both local and express orderwire is broadcast in nature. The line acts 
as a party line. Anyone who picks up the orderwire channel can communicate with all other participants 
on the connected orderwire subnetwork. The local orderwire party line is separate from the express 
orderwire party line. Up to four OC-N facilities for each local and express orderwire are provisionable 
as orderwire paths.

Note The OC3 IR 4/STM1 SH 1310 card does not support the express orderwire channel. 
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The AIC-I supports selective dual tone multifrequency (DTMF) dialing for telephony connectivity, 
which causes one AIC-I card or all ONS 15454 AIC-I cards on the orderwire subnetwork to “ring.” The 
ringer/buzzer resides on the AIC-I. There is also a “ring” LED that mimics the AIC-I ringer. It flashes 
when a call is received on the orderwire subnetwork. A party line call is initiated by pressing *0000 on 
the DTMF pad. Individual dialing is initiated by pressing * and the individual four-digit number on the 
DTMF pad. 

Table 14-12 shows the pins on the orderwire connector that correspond to the tip and ring orderwire 
assignments. 

When provisioning the orderwire subnetwork, make sure that an orderwire loop does not exist. Loops 
cause oscillation and an unusable orderwire channel. 

Figure 14-5 shows the standard RJ-11 connectors used for orderwire ports.

Figure 14-5 RJ-11 Connector

14.2.3.4 Power Monitoring

The AIC-I card provides a power monitoring circuit that monitors the supply voltage of –48 VDC for 
presence, undervoltage, or overvoltage. 

14.2.3.5 User Data Channel 

The user data channel (UDC) features a dedicated data channel of 64 kbps (F1 byte) between two nodes 
in an ONS 15454 network. Each AIC-I card provides two user data channels, UDC-A and UDC-B, 
through separate RJ-11 connectors on the front of the AIC-I card. Each UDC can be routed to an 
individual optical interface in the ONS 15454. For instructions, refer to the Cisco ONS 15454 Procedure 
Guide. 

The UDC ports are standard RJ-11 receptacles. Table 14-13 lists the UDC pin assignments.

Table 14-12 Orderwire Pin Assignments

RJ-11 Pin Number Description

1 Four-wire receive ring

2 Four-wire transmit tip

3 Two-wire ring

4 Two-wire tip

5 Four-wire transmit ring

6 Four-wire receive tip
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14.2.3.6 Data Communications Channel

The DCC features a dedicated data channel of 576 kbps (D4 to D12 bytes) between two nodes in an 
ONS 15454 network. Each AIC-I card provides two data communications channels, DCC-A and 
DCC-B, through separate RJ-45 connectors on the front of the AIC-I card. Each DCC can be routed to 
an individual optical interface in the ONS 15454. For instructions, see the “DLP-G110 Create a User 
Data Channel Circuit” task on page 6-16.

The DCC ports are standard RJ-45 receptacles. Table 14-14 lists the DCC pin assignments. 

14.3 Front Mount Electrical Connections
This section describes the front mount electrical connections (FMECs), MIC-A/P and MIC-C/T/P, that 
provide power, external alarm, and timing connections for the ONS 15454 ETSI shelf.

14.3.1 MIC-A/P FMEC
The MIC-A/P FMEC provides connection for the BATTERY B input, one of the two possible redundant 
power supply inputs. It also provides connection for eight alarm outputs (coming from the TCC2 card), 
sixteen alarm inputs, and four configurable alarm inputs/outputs. Its position is in Slot 23 in the center 
of the subrack Electrical Facility Connection Assembly (EFCA) area. Figure 14-6 shows the MIC-A/P 
faceplate and block diagram.

Table 14-13 UDC Pin Assignments

RJ-11 Pin Number Description

1 For future use

2 TXN

3 RXN

4 RXP

5 TXP

6 For future use

Table 14-14 DCC Pin Assignments

RJ-45 Pin Number Description

1 TCLKP

2 TCLKN

3 TXP

4 TXN

5 RCLKP

6 RCLKN

7 RXP

8 RXN
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Figure 14-6 MIC-A/P Faceplate and Block Diagram

The MIC-A/P FMEC has the following features:

• Connection for one of the two possible redundant power supply inputs

• Connection for eight alarm outputs (coming from the TCC2 card)

• Connection for four configurable alarm inputs/outputs 

• Connection for sixteen alarm inputs 

• Storage of manufacturing and inventory data

Note For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the 
ONS 15454 ETSI shelf. 

14.3.1.1 MIC-A/P Connector Pinouts

Table 14-15 shows the alarm interface pinouts on the MIC-A/P DB-62 connector. 
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Table 14-15 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector

Pin No. Signal Name Signal Description

1 ALMCUTOFF N Alarm cutoff, normally open ACO pair

2 ALMCUTOFF P Alarm cutoff, normally open ACO pair

3 ALMINP0 N Alarm input pair 1, reports closure on connected wires

4 ALMINP0 P Alarm input pair 1, reports closure on connected wires

5 ALMINP1 N Alarm input pair 2, reports closure on connected wires

6 ALMINP1 P Alarm input pair 2, reports closure on connected wires

7 ALMINP2 N Alarm input pair 3, reports closure on connected wires

8 ALMINP2 P Alarm input pair 3, reports closure on connected wires

9 ALMINP3 N Alarm input pair 4, reports closure on connected wires

10 ALMINP3 P Alarm input pair 4, reports closure on connected wires
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11 EXALM0 N External customer alarm 1

12 EXALM0 P External customer alarm 1

13 GND Ground

14 EXALM1 N External customer alarm 2

15 EXALM1 P External customer alarm 2

16 EXALM2 N External customer alarm 3

17 EXALM2 P External customer alarm 3

18 EXALM3 N External customer alarm 4

19 EXALM3 P External customer alarm 4

20 EXALM4 N External customer alarm 5

21 EXALM4 P External customer alarm 5

22 EXALM5 N External customer alarm 6

23 EXALM5 P External customer alarm 6

24 EXALM6 N External customer alarm 7

25 EXALM6 P External customer alarm 7

26 GND Ground

27 EXALM7 N External customer alarm 8

28 EXALM7 P External customer alarm 8

29 EXALM8 N External customer alarm 9

30 EXALM8 P External customer alarm 9

31 EXALM9 N External customer alarm 10

32 EXALM9 P External customer alarm 10

33 EXALM10 N External customer alarm 11

34 EXALM10 P External customer alarm 11

35 EXALM11 N External customer alarm 12

36 EXALM11 P External customer alarm 12

37 ALMOUP0 N Normally open output pair 1

38 ALMOUP0 P Normally open output pair 1

39 GND Ground

40 ALMOUP1 N Normally open output pair 2

41 ALMOUP1 P Normally open output pair 2

42 ALMOUP2 N Normally open output pair 3

43 ALMOUP2 P Normally open output pair 3

44 ALMOUP3 N Normally open output pair 4

45 ALMOUP3 P Normally open output pair 4

46 AUDALM0 N Normally open Minor audible alarm

Table 14-15 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

Pin No. Signal Name Signal Description
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14.3.2 MIC-C/T/P FMEC 
The MIC-C/T/P FMEC provides connection for the BATTERY A input, one of the two possible 
redundant power supply inputs. It also provides connection for system management serial port, system 
management LAN port, modem port (for future use), and system timing inputs and outputs. Install the 
MIC-C/T/P in Slot 24. Figure 14-7 shows the MIC-C/T/P FMEC faceplate and block diagram.

47 AUDALM0 P Normally open Minor audible alarm

48 AUDALM1 N Normally open Major audible alarm

49 AUDALM1 P Normally open Major audible alarm

50 AUDALM2 N Normally open Critical audible alarm

51 AUDALM2 P Normally open Critical audible alarm

52 GND Ground

53 AUDALM3 N Normally open Remote audible alarm

54 AUDALM3 P Normally open Remote audible alarm

55 VISALM0 N Normally open Minor visual alarm

56 VISALM0 P Normally open Minor visual alarm

57 VISALM1 N Normally open Major visual alarm

58 VISALM1 P Normally open Major visual alarm

59 VISALM2 N Normally open Critical visual alarm

60 VISALM2 P Normally open Critical visual alarm

61 VISALM3 N Normally open Remote visual alarm

62 VISALM3 P Normally open Remote visual alarm

Table 14-15 Alarm Interface Pinouts on the MIC-A/P DB-62 Connector (continued)

Pin No. Signal Name Signal Description
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14.3.2 MIC-C/T/P FMEC
Figure 14-7 MIC-C/T/P Faceplate and Block Diagram

The MIC-C/T/P FMEC has the following features:

• Connection for one of the two possible redundant power supply inputs

• Connection for two serial ports for local craft/modem (for future use)

• Connection for one LAN port

• Connection for two system timing inputs

• Connection for two system timing outputs

• Storage of manufacturing and inventory data

Note For proper system operation, both the MIC-A/P and MIC-C/T/P FMECs must be installed in the shelf. 
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14.4 Optical Service Channel Cards
14.3.2.1 MIC-C/T/P Port-Level Indicators

The MIC-C/T/P FMEC has one pair of LEDs located on the RJ45 LAN connector. The green LED is on 
when a link is present, and the amber LED is on when data is being transferred. 

14.4 Optical Service Channel Cards
This section describes the optical service channel cards. An optical service channel (OSC) is a 
bidirectional channel connecting two adjacent nodes in a DWDM ring. For every DWDM node (except 
terminal nodes), two different OSC terminations are present, one for the West side and another for the 
East side. The channel transports OSC overhead that is used to manage ONS 15454 DWDM networks. 
An OSC signal uses the 1510-nm wavelength and does not affect client traffic. The primary purpose of 
this channel is to carry clock synchronization and orderwire channel communications for the DWDM 
network. It also provides transparent links between each node in the network. The OSC is an OC-3 
formatted signal. 

There are two versions of the OSC modules: the OSCM, and the OSC-CSM, which contains the OSC 
wavelength combiner and separator component in addition to the OSC module.

14.4.1 OSCM Card
This section describes the OSCM card.

14.4.1.1 Faceplate

Figure 14-8 shows the OSCM faceplate.
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14.4.1 OSCM Card
Figure 14-8 OSCM Faceplate

14.4.1.2 Block Diagram

Figure 14-9 shows the OSCM block diagram.
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14.4.1 OSCM Card
Figure 14-9 OSCM Block Diagram

The OSCM is used in amplified nodes that include the OPT-BST booster amplifier. The OPT-BST 
includes the required OSC wavelength combiner and separator component. The OSCM cannot be used 
in nodes where you use OC-N cards, electrical cards, or cross-connect cards. The OSCM uses Slots 8 
and 10, which are also cross-connect card slots. 

The OSCM supports the following features:

• OC-3 formatted OSC

• Supervisory data channel (SDC) forwarded to the TCC2 cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT far-end (FE) user data channel (UDC)

• Monitoring functions such as orderwire support and optical safety

The OC-3 section data communications channel (SDCC) overhead bytes are used for network 
communications. An optical transceiver terminates the OC-3, then it is regenerated and converted into 
an electrical signal. The SDCC bytes are forwarded to the active and standby TCC2 cards for processing 
via the system communication link (SCL) bus on the backplane. Orderwire bytes (E1, E2, F1) are also 
forwarded via the SCL bus to the TCC2 for forwarding to the AIC-I card.

The payload portion of the OC-3 is used to carry the fast Ethernet UDC. The frame is sent to a 
packet-over-SONET (POS) processing block that extracts the Ethernet packets and makes them 
available at the RJ-45 connector.

The OSCM, which resides in the cross-connect slots and follows the ONS 15454 backplane architecture, 
distributes the reference clock information by removing it from the incoming OC-3 signal and then 
sending it to the DWDM cards. The DWDM cards then forward the clock information to the active and 
standby TCC2 cards.
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14.4.1 OSCM Card
Figure 14-10 shows the block diagram of the VOA within the OSCM.

Figure 14-10 OSCM VOA Optical Module Functional Block Diagram

14.4.1.3 Power Monitoring

Physical photodiode P1 monitors the power for the OSCM card. The returned power level value is 
calibrated to the OSC TX port. See Table 14-16.

14.4.1.4 OSCM Card-Level Indicators

The OSCM card has three card-level LED indicators, described in Table 14-17.
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Table 14-16 OSCM VOA Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 Output OSC OSC TX

Table 14-17 OSCM Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OSCM is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as loss of 
signal (LOS), loss of frame alignment (LOF), line alarm indication signal 
(AIS-L), or high BER on one or more of the card’s ports. The amber signal 
fail (SF) LED also illuminates when the transmit and receive fibers are 
incorrectly connected. When the fibers are properly connected, the light 
turns off.
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14.4.2 OSC-CSM Card
14.4.1.5 OSCM Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OSCM has one OC-3 optical port located on the faceplate. One long-reach 
OSC transmits and receives the OSC to and from another DWDM node. Both data communications 
network (DCN) data and FE payload are carried on this link.

14.4.2 OSC-CSM Card
This section describes the OSC-CSM card. 

14.4.2.1 Faceplate

Figure 14-11 shows the OSC-CSM faceplate.
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14.4.2 OSC-CSM Card
Figure 14-11 OSC-CSM Faceplate

14.4.2.2 Block Diagram

Figure 14-12 shows the OSC-CSM block diagram.

96
46

5

OSC
CSM

FAIL

ACT

SF

U
C

R
X

M
O

N

T
X

R
X

C
O

M

T
X

R
X

L
IN

E

T
X

14-31
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

December 2004



 

Chapter 14      Card Reference
14.4.2 OSC-CSM Card
Figure 14-12 OSC-CSM Block Diagram

Figure 14-13 shows the OSC-CSM optical module functional block diagram.
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14.4.2 OSC-CSM Card
Figure 14-13 OSC-CSM Optical Module Functional Block Diagram

The OSC-CSM is used in unamplified nodes. This means that the booster amplifier with the OSC 
wavelength combiner and separator is not required for OSC-CSM operation. The OSC-CSM can be 
installed in Slots 1 to 6 and 12 to 17. The cross-connect cards enable functionality on the OC-N cards 
and electrical cards.

The OSC-CSM supports the following features:

• Optical combiner and separator module for multiplexing and demultiplexing the optical service 
channel to or from the wavelength division multiplexing (WDM) signal

• OC-3 formatted OSC

• SDC forwarded to the TCC2 cards for processing

• Distribution of the synchronous clock to all nodes in the ring

• 100BaseT FE UDC

• Monitoring functions such as orderwire support

• Optical safety: Signal loss detection and alarming, fast transmitted power shut down by means of an 
optical 1x1 switch

• Optical safety remote interlock (OSRI), a feature capable of shutting down the optical output power
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14.4.2 OSC-CSM Card
• Automatic laser shutdown (ALS), a safety mechanism used in the event of a fiber cut

The wave division multiplexing (WDM) signal coming from the line is passed through the OSC 
combiner and separator, where the OSC signal is extracted from the WDM signal. The WDM signal is 
sent along with the remaining channels to the COM port (label on the front panel) for routing to the 
OADM or amplifier units, while the OSC signal is sent to an optical transceiver.

The OSC is an OC-3 formatted signal. The OC-3 SDCC overhead bytes are used for network 
communications. An optical transceiver terminates the OC-3, and then it is regenerated and converted 
into an electrical signal. The SDCC bytes are forwarded to the active and standby TCC2 cards for 
processing via the SCL bus on the backplane. Orderwire bytes (E1, E2, F1) are also forwarded via the 
SCL bus to the TCC2 for forwarding to the AIC-I card.

The payload portion of the OC-3 is used to carry the fast Ethernet UDC. The frame is sent to a POS 
processing block that extracts the Ethernet packets and makes them available at the RJ-45 front panel 
connector.

The OSC-CSM distributes the reference clock information by removing it from the incoming OC-3 
signal and then sending it to the active and standby TCC2s. The clock distribution is different form the 
OSCM card because the OSC-CSM does not use Slot 8 or 10 (cross-connect card slots). 

Note S1 and S2 (see Figure 14-13) are optical splitters with a splitter ratio of 2:98. The result is that the power 
at the MON TX port is about 17 dB lower than the relevant power at the COM RX port, and the power 
at the MON RX port is about 20 dB lower than the power at the COM TX port. The difference is due to 
the presence of a tap coupler for the P1 photodiode.

14.4.2.3 Power Monitoring

Physical photodiodes P1, P2, P3, and P5 monitor the power for the OSC-CSM card. Their function is as 
follows:

• P1 and P2: The returned power value is calibrated to the LINE RX port, including the insertion loss 
of the previous filter (the reading of this power dynamic range has been brought backward towards 
the LINE RX output).

• P3: The returned value is calibrated to the COM RX port.

• P5: The returned value is calibrated to the LINE TX port, including the insertion loss of the 
subsequent filter.

The returned power level values are calibrated to the ports as shown in Table 14-18.

14.4.2.4 OSC-CSM Card-Level Indicators

The OSC-CSM card has three card-level LED indicators, described in Table 14-19.

Table 14-18 OSC-CSM Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 Out Com LINE RX

P2 Input OSC LINE RX

P3 In Com COM RX

P5 Output Osc LINE TX
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14.5 Optical Amplifier Cards
14.4.2.5 OSC-CSM Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OSC-CSM has a OC3 port and three other sets of ports located on the 
faceplate.

14.5 Optical Amplifier Cards
This section describes the optical amplifier cards. Optical amplifiers are used in amplified nodes, such 
as hub nodes, amplified OADM nodes, and line amplifier nodes. There are two forms of amplifiers, the 
Optical Preamplifier (OPT-PRE) and the Optical Booster (OPT-BST) amplifier. The optical amplifier 
card architecture includes an optical plug-in module with a controller that manages optical power, laser 
current, and temperature control loops. The amplifier also manages communication with the TCC2, and 
operations, administration, maintenance, and provisioning (OAM&P) functions such as provisioning, 
controls, and alarms. 

Optical amplifiers have a linear power feature that enables them to be kept in the constant gain mode if 
the gain is less than 28 dB. However, for longer span solutions it is necessary to place the amplifier in 
constant power mode. In constant power mode, automatic power control (APC) requirements change. 
This is because span loss degradation does not affect the system and amplifiers are not able to 
automatically modify the output power for variations in the number of channels when provisioning 
changes and a failure occurs. 

14.5.1 OPT-PRE Amplifier
This section describes the OPT-PRE Amplifier card. 

14.5.1.1 Faceplate

Figure 14-14 shows the OPT-PRE amplifier faceplate.

Table 14-19 OSC-CSM Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OSC-CSM is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
AIS-L, or high BER on one or more of the card’s ports. The amber SF LED 
also illuminates when the transmit and receive fibers are incorrectly 
connected. When the fibers are properly connected, the light turns off.
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14.5.1 OPT-PRE Amplifier
Figure 14-14 OPT-PRE Faceplate

14.5.1.2 Block Diagrams

Figure 14-15 shows the OPT-PRE block diagram.
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14.5.1 OPT-PRE Amplifier
Figure 14-15 OPT-PRE Block Diagram

Figure 14-16 shows the OPT-PRE optical module functional block diagram.

Figure 14-16 OPT-PRE Optical Module Functional Block Diagram

The OPT-PRE is designed to support 64 channels at 50-GHz channel spacing, but currently limited to 
32 channels at 100 GHz. The OPT-PRE is a C-band DWDM, two-stage erbium-doped fiber amplifier 
(EDFA) with mid-amplifier loss (MAL) for allocation to a dispersion compensation unit (DCU). To 
control the gain tilt, the OPT-PRE is equipped with a built-in VOA. The VOA can also be used to pad 
the DCU to a reference value. You can install the OPT-PRE in Slots 1 to 6 and 12 to 17. 

The OPT-PRE features:

• Fixed gain mode with programmable tilt

• True variable gain

• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• MAL for fiber-based DCU
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14.5.1 OPT-PRE Amplifier
• Amplified spontaneous emissions (ASE) compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• Optical safety features that include signal loss detection and alarming, fast power down control and 
reduced maximum output power in safe power mode

• Four signal photodiodes to monitor the input and output optical power of the two amplifier stages 
through CTC

• An optical output port for external monitoring

Note The optical splitter has a ratio of 1:99. The result is that the power at the MON port is about 20 dB lower 
than the power at the COM TX port.

14.5.1.3 Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-PRE card. The returned power 
level values are calibrated to the ports as shown in Table 14-20.

14.5.1.4 OPT-PRE Amplifier Card-Level Indicators

The OPT-PRE amplifier has three card-level LED indicators, described in Table 14-21.

Table 14-20 OPT-PRE Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 Input Com COM RX

P2 Output DC DC TX

P3 Input DC DC RX

P4 Output COM (Total Output) COM TX

Output COM (Signal Output)

Table 14-21 OPT-PRE Amplifier Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OPT-PRE is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS on 
one or more of the card’s ports. The amber SF LED also illuminates when 
the transmit and receive fibers are incorrectly connected. When the fibers are 
properly connected, the light turns off.
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14.5.2 OPT-BST Amplifier Card
14.5.1.5 OPT-PRE Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OPT-PRE amplifier has five optical ports located on the faceplate. MON is 
the output monitor port. COM Rx (receive) is the input signal port. COM Tx (transmit) is the output 
signal port. DC Rx is the MAL input signal port. DC Tx is the MAL output signal port.

14.5.2 OPT-BST Amplifier Card
This section describes the OPT_BST Amplifier card. The OPT-BST gain range is 5 to 20 dB in constant 
gain mode and output power mode. 

14.5.2.1 Faceplate

Figure 14-17 shows the OPT-BST amplifier faceplate.
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14.5.2 OPT-BST Amplifier Card
Figure 14-17 OPT-BST Faceplate

14.5.2.2 Block Diagrams

Figure 14-18 shows the OPT-BST amplifier block diagram.
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14.5.2 OPT-BST Amplifier Card
Figure 14-18 OPT-BST Block Diagram

Figure 14-19 shows the OPT-BST optical module functional block diagram.

Figure 14-19 OPT-BST Optical Module Functional Block Diagram

The OPT-BST is designed to support 64 channels at 50-GHz channel spacing, but currently is limited to 
32 channels at 100 GHz. The OPT-BST is a C-band DWDM EDFA with OSC add-and-drop capability. 
When an ONS 15454 has an OPT-BST installed, it is only necessary to have the OSCM to process the 
OSC. You can install the OPT-BST in Slots 1 to 6 and 12 to 17. To control the gain tilt, the OPT-BST 
is equipped with a built-in VOA. 

The OPT-BST features include:

• Fixed gain mode (with programmable tilt)

• True variable gain
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14.5.2 OPT-BST Amplifier Card
• Fast transient suppression

• Nondistorting low-frequency transfer function

• Settable maximum output power

• Fixed output power mode (mode used during provisioning)

• ASE compensation in fixed gain mode

• Full monitoring and alarm handling with settable thresholds

• Optical safety features, including signal loss detection and alarming, fast power down control, and 
reduced maximum output power in safe power mode

• OSRI, which is a software feature capable (through CTC) of shutting down the optical output power 
or reducing the power to a safe level (automatic power reduction)

• ALS, which is a safety mechanism used in the event of a fiber cut

Note The optical splitters each have a ratio of 1:99. The result is that the power at the MON TX and MON RX 
ports is about 20 dB lower than the power at the COM TX and COM RX ports.

14.5.2.3 Power Monitoring

Physical photodiodes P1, P2, P3, and P4 monitor the power for the OPT-BST card. The returned power 
level values are calibrated to the ports as shown in Table 14-22.

14.5.2.4 OPT-BST Amplifier-Level Indicators

The OPT-BST amplifier has three card-level LED indicators, described in Table 14-23.

Table 14-22 OPT-BST Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 Input Com COM RX

P2 Output Line (Total Output) LINE TX

Output Line (Signal Output)

P3 Output COM LINE RX

P4 Output OSC

Table 14-23 OPT-BST Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the OPT-BST is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS on 
one or more of the card’s ports. The amber SF LED also illuminates when 
the transmit and receive fibers are incorrectly connected. When the fibers are 
properly connected, the light turns off.
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14.5.2 OPT-BST Amplifier Card
14.5.2.5 OPT-BST Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The OPT-BST amplifier has eight optical ports located on the faceplate. 
MON RX is the output monitor port (receive section). MON TX is the output monitor port. COM RX is 
the input signal port. LINE TX is the output signal port. LINE RX is the input signal port (receive 
section). COM TX is the output signal port (receive section). OSC RX is the OSC add input port. 
OSC TX is the OSC drop output port.
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14.6 Multiplexer and Demultiplexer Cards
14.6 Multiplexer and Demultiplexer Cards
This section describes the multiplexer and demultiplexer cards.

14.6.1 32MUX-O Card
The 32-Channel Multiplexer (32MUX-O) card multiplexes 32 100-GHz-spaced channels identified in 
the channel plan. The 32MUX-O card takes up two slots in an ONS 15454 and can be installed in 
Slots 1 to 5 and 12 to 16. 

The 32MUX-O is typically used in hub nodes and provides the multiplexing of 32 channels, spaced at 
100 GHz, into one fiber before their amplification and transmission along the line. The channel plan is 
shown in Table 14-24.

Table 14-24 32MUX_O Channel Plan

Channel Number1 Channel ID Frequency (GHz) Wavelength (nm)

1 30.3 195.9 1530.33

2 31.2 195.8 1531.12

3 31.9 195.7 1531.90

4 32.6 195.6 1532.68

5 34.2 195.4 1534.25

6 35.0 195.3 1535.04

7 35.8 195.2 1535.82

8 36.6 195.1 1536.61

9 38.1 194.9 1538.19

10 38.9 194.8 1538.98

11 39.7 194.7 1539.77

12 40.5 194.6 1540.56

13 42.1 194.4 1542.14

14 42.9 194.3 1542.94

15 43.7 194.2 1543.73

16 44.5 194.1 1544.53

17 46.1 193.9 1546.12

18 46.9 193.8 1546.92

19 47.7 193.7 1547.72

20 48.5 193.6 1548.51

21 50.1 193.4 1550.12

22 50.9 193.3 1550.92

23 51.7 193.2 1551.72

24 52.5 193.1 1552.52

25 54.1 192.9 1554.13
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14.6.1 32MUX-O Card
14.6.1.1 Key Features

The 32MUX-O features include:

• Arrayed waveguide grating (AWG) device that enables full multiplexing functions for the channels.

• Each single-channel port is equipped with VOAs for automatic optical power regulation prior to 
multiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation for 
safety purposes. A manual VOA setting is also available.

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.

• An additional optical monitoring port with 1/99 splitting ratio is available.

14.6.1.2 Faceplate

Figure 14-20 shows the 32MUX-O faceplate.

26 54.9 192.8 1554.94

27 55.7 192.7 1555.75

28 56.5 192.6 1556.55

29 58.1 192.4 1558.17

30 58.9 192.3 1558.98

31 59.7 192.2 1559.79

32 60.6 192.1 1560.61

1. Channel # is only for reference purposes. The channel ID is consistent with ONS 15454 and will 
be used in unit identification.

Table 14-24 32MUX_O Channel Plan

Channel Number1 Channel ID Frequency (GHz) Wavelength (nm)
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14.6.1 32MUX-O Card
Figure 14-20 32MUX-O Faceplate

The 32MUX-O has four multifiber push-on (MPO) 8-fiber optical ribbon connectors on its front panel 
for the client input interfaces and two LC-PC-II optical connectors, one for the main output and the other 
for the monitor port.
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14.6.1 32MUX-O Card
14.6.1.3 Block Diagrams

Figure 14-21 shows the 32MUX-O block diagram.

Figure 14-21 32MUX-O Block Diagram

Figure 14-22 shows the 32MUX-O optical module functional block diagram.

Figure 14-22 32MUX-O Optical Module Functional Block Diagram
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14.6.2 32DMX-O Card
14.6.1.4 Power Monitoring

Physical photodiodes P1 through P32 monitor the power for the 32MUX-O card. The returned power 
level values are calibrated to the ports as shown in Table 14-25.

14.6.1.5 32MUX-O Card-Level Indicators

The 32MUX-O card has three card-level LED indicators, described in Table 14-26.

14.6.1.6 32MUX-O Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The 32MUX-O card has five sets of ports located on the faceplate. 

COM Tx is the line output. MON is the optical monitoring port. The xx.x-yy.y RX ports represent the 
four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to the channel 
plan.

14.6.2 32DMX-O Card
The 32-Channel Demultiplexer (32DMX-O) card demultiplexes 32 100-GHz-spaced channels identified 
in the channel plan. The 32DMX-O takes up two slots in an ONS 15454 and can be installed in 
Slots 1 to 5 and 12 to 16.

14.6.2.1 Key Features

The DMX-O features include:

• AWG that enables channel demultiplexing functions.

Table 14-25 32MUX-O Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 - P32 ADD COM TX

Table 14-26 32MUX-O Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32MUX-O is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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• Each single-channel port is equipped with VOAs for automatic optical power regulation after 
demultiplexing. In the case of electrical power failure, the VOA is set to its maximum attenuation 
for safety purposes. A manual VOA setting is also available. 

Note In contrast, the single-slot 32DMX card does not have VOAs on each drop port for optical power 
regulation. The 32DMX optical demultiplexer module is used in conjunction with the 
32-Channel Wavelength Selective Switch (32WSS) card in ONS 15454 Multiservice Transport 
Platform (MSTP) nodes.

• Each single-channel port is monitored using a photodiode to enable automatic power regulation.
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14.6.2 32DMX-O Card
14.6.2.2 Faceplate

Figure 14-23 shows the 32DMX-O card faceplate.

Figure 14-23 32DMX-O Faceplate
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14.6.2 32DMX-O Card
14.6.2.3 Block Diagrams

Figure 14-24 shows the 32DMX-O block diagram.

Figure 14-24 32DMX-O Block Diagram

Figure 14-25 shows the 32DMX-O optical module functional block diagram.

Figure 14-25 32DMX-O Optical Module Functional Block Diagram
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14.6.3 32DMX Card
14.6.2.4 Power Monitoring

Physical photodiodes P1 through P32 and P33 monitor the power for the 32DMX-O card. The returned 
power level values are calibrated to the ports as shown in Table 14-27.

14.6.2.5 32DMX-O Card-Level Indicators

The 32DMX-O card has three card-level LED indicators, described in Table 14-28.

14.6.2.6 32DMX-O Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The 32DMX-O card has five sets of ports located on the faceplate. MON is the 
output monitor port. COM RX is the line input. The xx.x-yy.y Tx ports represent the four groups of eight 
channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.

14.6.3 32DMX Card
The 32-Channel Demultiplexer card (32DMX) is a single-slot optical demultiplexer. The card receives 
an aggregate optical signal on its COM RX port and demultiplexes it into to 32 100-GHz-spaced 
channels. The 32DMX card can be installed in Slots 1 to 6 and in Slots 12 to 17. 

The 32DMX card is designed specifically for use in ONS 15454 DWDM nodes. The 32DMX card works 
in conjunction with the 32WSS card to create a software-controlled network element with ROADM 
functionality. ROADM functionality requires two 32DMX single-slot cards and two 32WSS double-slot 
cards (six slots in the ONS 15454 chassis). 

Equipped with ROADM functionality, ONS 15454 MSTP nodes can be configured at the optical channel 
level using CTC, Cisco MetroPlanner, and Cisco Transport Manager (CTM). Both the 32DMX card and 
32WSS card utilize planar lightwave circuit (PLC) technology to perform wavelength-level processing. 

Table 14-27 32DMX-O Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 - P32 DROP DROP TX

P33 INPUT COM COM RX

Table 14-28 32DMX-O Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32DMX-O is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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14.6.3 32DMX Card
14.6.3.1 Key Features

The 32DMX includes these high-level features:

• COM RX port: COM RX is the input port for the aggregate optical signal being demultiplexed. This 
port is supported by both a VOA for optical power regulation and a photodiode for optical power 
monitoring.

• DROP ports (1-32): On its output, the 32DMX provides 32 drop ports that are typically used for 
dropping channels within the ROADM node. Each drop port has a photodiode for optical power 
monitoring. Unlike the two-slot 32DMX-O demultiplexer, the drop ports on the 32DMX do not have 
a VOA per channel for optical power regulation.

A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east or 
west side of the shelf.

14.6.3.2 Faceplate

Figure 14-26 shows the 32DMX card front panel and the basic traffic flow through the ports.
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14.6.3 32DMX Card
Figure 14-26 32DMX Faceplate and Ports

The 32DMX front panel has connectors for 32 DROP TX ports. These ports are connected using four 
8-fiber multifiber push-on (MPO) ribbon connectors. The incoming optical signal to the demultiplexer 
comes into the COM RX. This input port is connected using a single LC duplex optical connector.

14.6.3.3 Block Diagrams

A block diagram of the 32DMX card is shown in Figure 14-27.
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14.6.3 32DMX Card
Figure 14-27 32DMX Block Diagram

Figure 14-28 shows the 32DMX optical module functional block diagram.

Figure 14-28 32DMX Optical Module Functional Block Diagram

Optical
module

30.3 to 36.6
8 CHS TX

38.1 to 44.5
8 CHS TX

46.1 to 52.5
8 CHS TX

54.1 to 60.6
8 CHS TX

96
48

0

Processor

MON

COM RX

FPGA
For SCL Bus
management

SCL Bus
TCCi M

SCL Bus
TCCi P

DC/DC
Power supply
Input filters

BAT A&B

1

32

Physical photodiode

Variable optical attenuator

COM RX

20 dB max
attenuation

DROP TX

P4

P3

P2

P1

P32

P31

P30

P29

P33 P34

P 12
49

67
14-55
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

December 2004



 

Chapter 14      Card Reference
14.6.3 32DMX Card
14.6.3.4 Power Monitoring

Physical photodiodes P1 through P32 and P33 monitor the power for the 32DMX card. The returned 
power level values are calibrated to the ports as shown in Table 14-29.

14.6.3.5 32DMX Card-Level Indicators

Table 14-30 describes the three card-level LED indicators on the 32DMX card.

14.6.3.6 32DMX Port-Level Indicators

You can find the status of the 32DMX ports using the LCD screen on the ONS 15454 fan-tray assembly. 
Use the LCD to view the status of any port or card slot; the screen displays the number and severity of 
alarms for a given port or slot. 

The 32DMX card has five ports located on the faceplate. The port labeled COM RX is the line input (it 
typically receives DROP TX from the 32WSS module). The TX ports are 32 drop ports. The connectors 
provide four groups of eight channels ranging from xx.x wavelength to yy.y wavelength according to 
the channel plan.

Table 14-29 32DMX Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 - P32 DROP DROP TX Channel

P33 INPUT COM COM RX

Table 14-30 32DMX Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32DMX card is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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14.6.4 4MD-xx.x Card
The 4-Channel Multiplexer/Demultiplexer (4MD-xx.x) card multiplexes and demultiplexes four 
100-GHz-spaced channels identified in the channel plan. The 4MD-xx.x card is designed to be used with 
band OADMs (both AD-1B-xx.x and AD-4B-xx.x). 

The card is bidirectional. The demultiplexer and multiplexer functions are implemented in two different 
sections of the same card. In this way, the same card can manage signals flowing in opposite directions.

There are eight versions of this card that correspond with the eight sub-bands specified in Table 14-31. 
The 4MD-xx.x can be installed in Slots 1 to 6 and 12 to 17.

14.6.4.1 Key Features

The 4MD-xx.x has the following features implemented inside a plug-in optical module:

• Passive cascade of interferential filters perform the channel multiplex/demultiplex function.

• Software controlled VOAs at every port of the multiplex section to regulate the optical power of 
each multiplexed channel.

• Software monitored photodiodes at the input and output multiplexer and demultiplexer ports for 
power control and safety purposes.

• Software-monitored “virtual photodiodes” at the common DWDM output and input ports. A “virtual 
photodiode” is a firmware calculation of the optical power at that port. This calculation is based on 
the single channel photodiode reading and insertion losses of the appropriated paths.

Table 14-31 shows the band IDs and the add/drop channel IDs for the 4MD-xx.x card.

14.6.4.2 Faceplate

Figure 14-29 shows the 4MD-xx.x faceplate.

Table 14-31 4MD-xx.x Channel Sets

Band ID Add/Drop Channel IDs

Band 30.3 (A) 30.3, 31.2, 31.9, 32.6

Band 34.2 (B) 34.2, 35.0, 35.8, 36.6

Band 38.1 (C) 38.1, 38.9, 39.7, 40.5

Band 42.1 (D) 42.1, 42.9, 43.7, 44.5

Band 46.1 (E) 46.1, 46.9, 47.7, 48.5

Band 50.1 (F) 50.1, 50.9, 51.7, 52.5

Band 54.1 (G) 54.1, 54.9, 55.7, 56.5

Band 58.1 (H) 58.1, 58.9, 59.7, 60.6
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Figure 14-29 4MD-xx.x Faceplate
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14.6.4 4MD-xx.x Card
14.6.4.3 Block Diagrams

Figure 14-30 shows the 4MD-xx.x block diagram.

Figure 14-30 4MD-xx.x Block Diagram
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14.6.4 4MD-xx.x Card
Figure 14-31 shows the 4MD-xx.x optical module functional block diagram.

Figure 14-31 4MD-xx.x Optical Module Functional Block Diagram

The Optical Module shown in Figure 14-31 is optically passive and consists of a cascade of interferential 
filters that perform the channel mux/demux functions.

VOAs are present in every input path of the multiplex section in order to regulate the optical power of 
each multiplexed channel. Some optical input and output ports are monitored by means of photodiodes 
implemented both for power control and for safety purposes. An internal control manages VOA settings 
and functionality as well as photodiode detection and alarm thresholds. The power at the main output 
and input ports is monitored through the use of “virtual photodiodes.” A virtual photodiode is 
implemented in the firmware of the plug-in module. This firmware calculates the power on a port, 
summing the measured values from all single channel ports (and applying the proper path insertion loss) 
then providing the TCC2 with the obtained value. 

14.6.4.4 Power Monitoring

Physical photodiodes P1 through P8, and virtual photodiodes V1 and V2 monitor the power for the 
4MD-xx.x card. The returned power level values are calibrated to the ports as shown in Table 14-32.
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Table 14-32 4MD-xx.x Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 - P4 ADD COM TX

P5 - P8 DROP DROP TX Channel

V1 OUT COM COM TX

V2 IN COM COM RX
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14.6.4.5 4MD-xx.x Card-Level Indicators

The 4MD-xx.x card has three card-level LED indicators, described in Table 14-33.

14.6.4.6 4MD-xx.x Port-Level Indicators

You can find the status of the card ports using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The 4MD-xx.x card has five sets of ports located on the faceplate. COM RX is 
the line input. COM TX is the line output. The 15xx.x TX ports represent demultiplexed channel 
outputs 1 to 4. The 15xx.x RX ports represent multiplexed channel inputs 1 to 4.

Table 14-33 4MD-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 4MD-xx.x card is carrying traffic or 
is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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14.7 Optical Add/Drop Multiplexer Cards
This section discusses the optical add/drop multiplexer cards.

14.7.1 AD-1C-xx.x Card
The 1-Channel OADM (AD-1C-xx.x) card passively adds or drops one of the 32 channels utilized within 
the 100-GHz-spacing of the DWDM card system. Thirty-two versions of this card—each designed only 
for use with one wavelength—are used in the ONS 15454 DWDM system. Each wavelength version of 
the card has a different part number.

The AD-1C-xx.x can be installed in Slots 1 to 6 and 12 to 17.

The AD-1C-xx.x has the following internal features:

• Two cascaded passive optical interferential filters perform the channel add and drop functions.

• One software-controlled VOA regulates the optical power of the inserted channel.

• Software-controlled VOA regulates the insertion loss of the express optical path.

• Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiodes (firmware calculations of port optical power) at the 
common DWDM output and input ports. 

14.7.1.1 Faceplate

Figure 14-32 shows the AD-1C-xx.x faceplate.
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14.7.1 AD-1C-xx.x Card
Figure 14-32 AD-1C-xx.x Faceplate

14.7.1.2 Block Diagrams

Figure 14-33 shows the AD-1C-xx.x block diagram.
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14.7.1 AD-1C-xx.x Card
Figure 14-33 AD-1C-xx.x Block Diagram

Figure 14-34 shows the AD-1C-xx.x optical module functional block diagram.

Figure 14-34 AD-1C-xx.x Optical Module Functional Block Diagram
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14.7.2 AD-2C-xx.x Card
14.7.1.3 Power Monitoring

Physical photodiodes P1 through P4, and virtual photodiodes V1 and V2 monitor the power for the 
AD-1C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 14-34.

14.7.1.4 AD-1C-xx.x Card-Level Indicators

The AD-1C-xx.x card has three card-level LED indicators, described in Table 14-35.

14.7.1.5 AD-1C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-1C-xx.x has six LC-PC-II optical ports: two for add/drop channel client 
input and output, two for express channel input and output, and two for communication.

14.7.2 AD-2C-xx.x Card
The 2-Channel OADM (AD-2C-xx.x) card passively adds or drops two adjacent 100-GHz channels 
within the same band. Sixteen versions of this card—each designed for use with one pair of 
wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in 
two different sections on the same card to manage signal flow in both directions. Each version of the 
card has a different part number.

Table 14-34 AD-1C-xx.x Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 ADD COM TX

P2 DROP DROP TX Channel

P3 IN EXP EXP RX

P4 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 14-35 AD-1C-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-1C-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The SF LED also illuminates 
when the transmitting and receiving fibers are incorrectly connected. When 
the fibers are properly connected, the LED turns off.
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14.7.2 AD-2C-xx.x Card
14.7.2.1 Key Features

The AD-2C-xx.x has the following features:

• Passive cascade of interferential filters perform the channel add and drop functions.

• Two software-controlled VOAs in the add section, one for each add port, regulate the optical power 
of inserted channels. 

• Software-controlled VOAs regulate insertion loss on express channels.

• Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common 
DWDM output and input ports. 

The AD-2C-xx.x cards are provisioned for the wavelength pairs in Table 14-36. In this table, channel 
IDs are given rather than wavelengths. To compare channel IDs with the actual wavelengths they 
represent, see Table 14-7 on page 14-10.

14.7.2.2 Faceplate

Figure 14-35 shows the AD-2C-xx.x faceplate.

Table 14-36 AD-2C-xx.x Channel Pairs

Band ID Add/Drop Channel ID

Band 30.3 (A) 30.3, 31.2

31.9, 32.6

Band 34.2 (B) 34.2, 35.0

35.8, 36.6

Band 38.1 (C) 38.1, 38.9

39.7, 40.5

Band 42.1 (D) 42.1, 42.9

43.7, 44.5

Band 46.1 (E) 46.1, 46.9

47.7, 48.5

Band 50.1 (F) 50.1, 50.9

51.7, 52.5

Band 54.1 (G) 54.1, 54.9

55.7, 56.5

Band 58.1 (H) 58.1, 58.9

59.7, 60.6
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14.7.2 AD-2C-xx.x Card
Figure 14-35 AD-2C-xx.x Faceplate
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14.7.2 AD-2C-xx.x Card
14.7.2.3 Block Diagrams

Figure 14-36 shows the AD-2C-xx.x block diagram.

Figure 14-36 AD-2C-xx.x Block Diagram

Figure 14-37 shows the AD-2C-xx.x optical module functional block diagram.

Figure 14-37 AD-2C-xx.x Optical Module Functional Block Diagram
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14.7.3 AD-4C-xx.x Card
14.7.2.4 Power Monitoring

Physical photodiodes P1 through P6, and virtual photodiodes V1 and V2 monitor the power for the 
AD-2C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 14-37.

14.7.2.5 AD-2C-xx.x Card-Level Indicators

The AD-2C-xx.x card has three card-level LED indicators, described in Table 14-38.

14.7.2.6 AD-2C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-2C-xx.x card has eight LC-PC-II optical ports: four for add/drop channel 
client input and output, two for express channel input and output, and two for communication.

14.7.3 AD-4C-xx.x Card
The 4-Channel OADM (AD-4C-xx.x) card passively adds or drops all four 100-GHz-spaced channels 
within the same band. Eight versions of this card—each designed for use with one band of 
wavelengths—are used in the ONS 15454 DWDM system. The card bidirectionally adds and drops in 
two different sections on the same card to manage signal flow in both directions. There are eight versions 
of this card with eight part numbers. 

Table 14-37 AD-2C-xx.x Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 and P2 ADD COM TX

P3 and P4 DROP DROP TX Channel

P5 IN EXP EXP RX

P6 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 14-38 AD-2C-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-2C-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The amber SF LED also 
illuminates when the transmit and receive fibers are incorrectly connected. 
When the fibers are properly connected, the light turns off.
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14.7.3 AD-4C-xx.x Card
14.7.3.1 Key Features

The AD-4C-xx.x has the following features:

• Passive cascade of interferential filters perform the channel add and drop functions.

• Four software-controlled VOAs in the add section, one for each add port, regulate the optical power 
of inserted channels. 

• Two software-controlled VOAs regulate insertion loss on express and drop path, respectively.

• Internal control of the VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiodes (firmware calculation of port optical power) at the common 
DWDM output and input ports.

The AD-4C-xx.x cards are provisioned for the wavelength pairs in Table 14-39 on page 14-70. In this 
table, channel IDs are given rather than wavelengths. To compare channel IDs with the actual 
wavelengths they represent, see Table 14-7 on page 14-10.

14.7.3.2 Faceplate

Figure 14-38 shows the AD-4C-xx.x faceplate.

Table 14-39 AD-4C-xx.x Channel Sets

Band ID Add/Drop Channel IDs

Band 30.3 (A) 30.3, 31.2, 31.9, 32.6

Band 34.2 (B) 34.2, 35.0, 35.8, 36.6

Band 38.1 (C) 38.1, 38.9, 39.7 40.5

Band 42.1 (D) 42.1, 42.9, 43.7, 44.5

Band 46.1 (E) 46.1, 46.9, 47.7, 48.5

Band 50.1 (F) 50.1, 50.9, 51.7, 52.5

Band 54.1 (G) 54.1, 54.9, 55.7, 56.5

Band 58.1 (H) 58.1, 58.9, 59.7, 60.6
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14.7.3 AD-4C-xx.x Card
Figure 14-38 AD-4C-xx.x Faceplate

14.7.3.3 Block Diagram

Figure 14-39 shows the AD-4C-xx.x block diagram.
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14.7.3 AD-4C-xx.x Card
Figure 14-39 AD-4C-xx.x Block Diagram

Figure 14-40 shows the AD-4C-xx.x optical module functional block diagram.

Figure 14-40 AD-4C-xx.x Optical Module Functional Block Diagram
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14.7.3 AD-4C-xx.x Card
14.7.3.4 Power Monitoring

Physical photodiodes P1 through P10, and virtual photodiodes V1 and V2 monitor the power for the 
AD-4C-xx.x card. The returned power level values are calibrated to the ports as shown in Table 14-40.

14.7.3.5 AD-4C-xx.x Card-Level Indicators

The AD-4C-xx.x card has three card-level LED indicators, described in Table 14-41.

14.7.3.6 AD-4C-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-4C-xx.x card has 12 LC-PC-II optical ports: eight for add/drop channel 
client input and output, two for express channel input and output, and two for communication.

Table 14-40 AD-4C-xx.x Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 - P4 ADD COM TX

P5 - P8 DROP DROP TX Channel

P9 IN EXP EXP RX

P10 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 14-41 AD-4C-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-4C-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure or condition. The amber SF 
LED also illuminates when the transmit and receive fibers are incorrectly 
connected. When the fibers are properly connected, the light turns off.
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14.7.4 AD-1B-xx.x Card
The 1-Band OADM (AD-1B-xx.x) card passively adds or drops a single band of four adjacent 
100-GHz-spaced channels. Eight versions of this card with eight different part numbers—each version 
designed for use with one band of wavelengths—are used in the ONS 15454 DWDM system. The card 
bidirectionally adds and drops in two different sections on the same card to manage signal flow in both 
directions. This card can be used when there is asymmetric adding and dropping on each side (east or 
west) of the node; a band can be added or dropped on one side but not on the other.

The AD-1B xx.x can be installed in Slots 1 to 6 and 12 to17.

14.7.4.1 Key Features

The AD-1B-xx.x has the following features:

• Passive cascaded interferential filters perform the channel add and drop functions.

• Two software-controlled VOAs regulate the optical power flowing in the express and drop OADM 
paths (drop section). 

• Output power of the dropped band is set by changing the attenuation of the VOA drop.

• The VOA express is used to regulate the insertion loss of the express path.

• Internal controlled VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiode (firmware calculation of port optical power) at the common 
DWDM output. 

14.7.4.2 Faceplate

Figure 14-41 shows the AD-1B-xx.x faceplate.
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14.7.4 AD-1B-xx.x Card
Figure 14-41 AD-1B-xx.x Faceplate

14.7.4.3 Block Diagram

Figure 14-33 shows the AD-1B-xx.x block diagram.
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14.7.4 AD-1B-xx.x Card
Figure 14-42 AD-1B-xx.x Block Diagram

Figure 14-43 shows the AD-1B-xx.x optical module functional block diagram.

Figure 14-43 AD-1B-xx.x Optical Module Functional Block Diagram
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14.7.4 AD-1B-xx.x Card
14.7.4.4 Power Monitoring

Physical photodiodes P1 through P4, and virtual photodiodes V1 and V2 monitor the power for the 
AD-1B-xx.x card. The returned power level values are calibrated to the ports as shown in Table 14-42.

14.7.4.5 AD-1B-xx.x Card-Level Indicators

The AD-1B-xx.x card has three card-level LED indicators, described in Table 14-43.

14.7.4.6 AD-1B-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-1B-xx.x has six LC-PC-II optical ports: two for add/drop channel client 
input and output, two for express channel input and output, and two for communication.

Table 14-42 AD-1B-xx.x Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 ADD BAND RX

P2 DROP BAND TX

P3 IN EXP EXP RX

P4 OUT EXP EXP TX

V1 IN COM COM RX

V2 OUT COM COM TX

Table 14-43 AD-1B-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-1B-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The amber SF LED also 
illuminates when the transmit and receive fibers are incorrectly connected. 
When the fibers are properly connected, the light turns off.
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14.7.5 AD-4B-xx.x Card
The 4-Band OADM (AD-4B-xx.x) card passively adds or drops four bands of four adjacent 
100-GHz-spaced channels. Two versions of this card with different part numbers—each version 
designed for use with one set of bands—are used in the ONS 15454 DWDM system. The card 
bidirectionally adds and drops in two different sections on the same card to manage signal flow in both 
directions. This card can be used when there is asymmetric adding and dropping on each side (east or 
west) of the node; a band can be added or dropped on one side but not on the other.

The AD1B-xx.x can be installed in Slots 1 to 6 and 12 to 17.

14.7.5.1 Key Features

The AD-4B-xx.x has the following features:

• Five software-controlled VOAs regulate the optical power flowing in the OADM paths. 

• Output power of each dropped band is set by changing the attenuation of each VOA drop.

• The VOA express is used to regulate the insertion loss of the express path.

• Internal controlled VOA settings and functions, photodiode detection, and alarm thresholds.

• Software-monitored virtual photodiode (firmware calculation of port optical power) at the common 
DWDM output port.

14.7.5.2 Faceplate

Figure 14-44 shows the AD-4B-xx.x faceplate.
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14.7.5 AD-4B-xx.x Card
Figure 14-44 AD-4B-xx.x Faceplate

14.7.5.3 Block Diagram

Figure 14-45 shows the AD-4B-xx.x block diagram.
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14.7.5 AD-4B-xx.x Card
Figure 14-45 AD-4B-xx.x Block Diagram

Figure 14-46 shows the AD-4B-xx.x optical module functional block diagram.

Figure 14-46 AD-4B-xx.x Optical Module Functional Block Diagram
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14.7.6 32WSS Card
14.7.5.4 Power Monitoring

Physical photodiodes P1 through P11, and virtual photodiode V1 monitor the power for the AD-4B-xx.x 
card. The returned power level values are calibrated to the ports as shown in Table 14-44.

14.7.5.5 AD-4B-xx.x Card-Level Indicators

The AD-4B-xx.x card has three card-level LED indicators, described in Table 14-45.

14.7.5.6 AD-4B-xx.x Port-Level Indicators

You can find the status of the card port using the LCD screen on the ONS 15454 fan-tray assembly. Use 
the LCD to view the status of any port or card slot; the screen displays the number and severity of alarms 
for a given port or slot. The AD-4B-xx.x has 12 LC-PC-II optical ports: eight for add/drop band client 
input and output, two for express channel input and output, and two for communication.

14.7.6 32WSS Card 
The 32-Channel Wavelength Selective Switch (32WSS) card performs channel add/drop processing 
within the ONS 15454 DWDM node. The 32WSS works in conjunction with the 32DMX to implement 
ROADM functionality. Equipped with ROADM functionality, the ONS 15454 DWDM can be 
configured to add or drop individual optical channels using CTC, Cisco MetroPlanner, and CTM.

Table 14-44 AD-4B-xx.x Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 - P4 ADD COM TX

P5 - P8 DROP DROP Channel TX

P9 IN EXP EXP RX

P10 OUT EXP EXP TX

P11 IN COM COM RX

V1 OUT COM COM TX

Table 14-45 AD-4B-xx.x Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the AD-4B-xx.x card is carrying traffic 
or is traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure. The amber SF LED also 
illuminates when the transmit and receive fibers are incorrectly connected. 
When the fibers are properly connected, the light turns off.
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14.7.6 32WSS Card
A ROADM network element utilizes two 32WSS cards (two slots each) and two 32DMX cards (one slot 
each), for a total of six slots in the chassis. For a diagram of a typical ROADM configuration, see 
“ROADM Node” on page -8. The 32WSS card can be installed in slots 1-2, 3-4, 5-6, or in slots 12-13, 
14-15, or 16-17. 

The 32WSS has six types of ports: 

• ADD RX ports (1-32): These ports are used for adding channels. Each add channel is associated with 
an individual switch element that selects whether an individual channel is added. Each add port has 
optical power regulation provided by a VOA. 

• EXP RX port: The EXP RX port receives an optical signal from another 32WSS module in the same 
network element.

• EXP TX port: The EXP TX port sends an optical signal to the other 32WSS module within the 
network element.

• COM TX port: The COM TX port sends an aggregate optical signal to a booster card (for example, 
OPT_BST) for transmission outside of the network element.

• COM RX port: The COM RX port receives the optical signal from a pre-amplifier and sends it to 
the optical splitter.

• DROP TX port: The DROP TX port sends the split off optical signal that contains drop channels to 
the 32DMX card where the channels are further processed and dropped. 

A terminal site can be configured using only a 32WSS card and a 32DMX card plugged into the east or 
west side of the shelf.

14.7.6.1 Faceplate

Figure 14-47 shows the 32WSS module front panel and identifies the traffic flow through the ports. 
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14.7.6 32WSS Card
Figure 14-47 32WSS Faceplate and Ports
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14.7.6 32WSS Card
14.7.6.2 Block Diagrams

Figure 14-48 provides a high-level functional block diagram of the 32WSS card.

Figure 14-48 32WSS Block Diagram

Aggregate optical signals that enter the EXP RX and COM RX port are processed in two ways. The 
optical processing stages are shown in Figure 14-49, which provides a detailed optical functional 
diagram of the 32WSS card.
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14.7.6 32WSS Card
Figure 14-49 32WSS Optical Block Diagram
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by the splitter. The DROP TX port on the 32WSS is typically connected to the COM RX port of the 
32DMX where the drop channels are dropped. Channels that are not dropped pass through the 
optical splitter and flow out of the EXP TX port of the 32WSS. This optical signal is typically 
connected to the other 32WSS module within the network element.
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14.7.6.3 Power Monitoring

Physical photodiodes P1 through P69 monitor the power for the 32WSS card. The returned power level 
values are calibrated to the ports as shown in Table 14-46.

14.7.6.4 32WSS Card-Level Indicators

Table 14-47 describes the three card-level LED indicators on the 32WSS card.

14.7.6.5 32WSS Port-Level Indicators

You can find the status of the 32WSS card’s ports using the LCD screen on the ONS 15454 fan-tray 
assembly. Use the LCD to view the status of any port or card slot; the screen displays the number and 
severity of alarms for a given port or slot. The 32WSS card has five sets of ports located on the faceplate. 
COM RX is the line input, COM TX is the line output, EXP RX is the port where a channel can be added 
or passed through, EXP TX is the port that passes through the channels that are not dropped, and DROP 
TX is the port for the dropped channels. The xx.x-yy.y TX ports represent the four groups of eight 
channels ranging from xx.x wavelength to yy.y wavelength according to the channel plan.

14.8 Transponder and Muxponder Cards
This section describes the transponder and muxponder cards.

Table 14-46 32WSS Port Calibration

Photodiode CTC “Type” Name Calibrated to Port

P1 - P32 ADD (Power) COM TX

ADD (Power ADD) ADD Channel RX

P33 - P64 PASS THROUGH COM TX

P65 OUT EXP EXP TX

P66 IN EXP EXP RX

P67 OUT COM COM TX

P68 IN COM COM RX

P69 DROP DROP TX

Table 14-47 32WSS Card-Level Indicators 

Card-Level Indicators Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready or that 
there is an internal hardware failure. Replace the card if the red FAIL LED 
persists.

Green ACT LED The green ACT LED indicates that the 32WSS card is carrying traffic or is 
traffic-ready.

Amber SF LED The amber SF LED indicates a signal failure on one or more of the card’s 
ports. The amber SF LED also illuminates when the transmit and receive 
fibers are incorrectly connected. When the fibers are properly connected, the 
light turns off.
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14.8.1 TXP_MR_10G Card

Warning High-performance devices on this card can get hot during operation. To remove the card, hold it by 
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before 
placing it in an antistatic bag.

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

The 10-Gbps Transponder–100-GHz–Tunable xx.xx-xx.xx card (TXP_MR_10G) processes one 
10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM signal (trunk side). It provides one 
10-Gbps port per card that can be provisioned for an STM64/OC-192 short reach (1310nm) signal, 
compliant with ITU-T G.707, G.709, ITU-T G.691, Telcordia GR-253-CORE, or to 10 GE BASE-LR, 
compliant to IEEE 802.3 

The TXP_MR_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz 
range. It is available in 16 different versions, covering 32 different wavelengths in the 1550-nm range. 

Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 

The trunk port operates at 9.95328 Gbps (or 10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC) 
and at 10.3125 Gbps (or 11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC) over unamplified 
distances up to 80 km(50 miles) with different types of fiber such as C-SMF or dispersion compensated 
fiber limited by loss and/or dispersion.

Caution Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_10G 
card does not display circuits under card view. 

For the TXP_MR_10G card, protection is done using Y-cable protection. Two TXP_MR_10G cards can 
be joined in a Y-cable protection group. In Y-cable protection, the client ports of the two cards are joined 
by Y-cables. A single incoming Rx client signal is injected into the Rx Y-cable port and is split between 
the two TXP_MR_10G cards (connected to the Rx client ports) in the protection group. The transmit 
(Tx) client signals from the two protection group TXP_MR_10G cards are connected to the 
correspondent ports of the Tx Y-cable. Only the Tx client port of the Active TXP_MR_10G card is 
turned on and transmits the signal towards the receiving client equipment. See the “14.9 Transponder 
and Muxponder Protection” section on page 14-119 for more information.

Note If you create a GCC on either card of the protection group, the trunk (span) port stays permanently 
active, regardless of the switch state. When you provision a GCC, you are provisioning unprotected 
overhead bytes. The GCC is not protected by the protect group. 
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14.8.1 TXP_MR_10G Card
14.8.1.1 Faceplate and Block Diagram

Figure 14-51 shows the TXP_MR_10G faceplate and block diagram.

Figure 14-50 TXP_MR_10G Faceplate and Block Diagram

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G card. Using direct 
fiber loopbacks causes irreparable damage to the TXP_MR_10G card.

You can install TXP_MR_10G cards in Slots 1 to 6 and 12 to 17. You can provision this card in a linear 
configuration. TXP_MR_10G cards cannot be provisioned as a BLSR, a path protection, or a 
regenerator. They can be used in the middle of BLSR or 1+1 spans. They can only be used in the middle 
of BLSR and 1+1 spans when the card is configured for transparent termination mode.

The TXP_MR_10G port features a 1550-nm laser for the trunk port and a 1310-nm laser for the for the 
client port and contains two transmit and receive connector pairs (labeled) on the card faceplate.

The TXP_MR_10G card detects SF, LOS, or LOF conditions on the optical facility. Refer to the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for a description of these conditions. The 
card also counts section and line bit interleaved parity (BIP) errors from B1 and B2 byte registers in the 
section and line overhead.

14.8.1.2 TXP_MR_10G Card-Level Indicators

Table 14-50 lists the three card-level LEDs on the TXP_MR_10G card.
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14.8.1.3 TXP_MR_10G Port-Level Indicators

Table 14-51 lists the four port-level LEDs in the TXP_MR_10G card. 

Table 14-48 TXP_MR_10G Card-Level Indicators 

Card-Level LED Description

FAIL LED (Red) Red indicates that the card’s processor is not ready. This LED is on during 
reset. The FAIL LED flashes during the boot process. Replace the card if the 
red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

Green indicates that the card is operational (one or both ports active) and 
ready to carry traffic. 

Amber indicates that the card is operational and in standby (protect) mode.

SF LED (Amber) Amber indicates a signal failure or condition such as LOS, LOF, or high 
BERs on one or more of the card’s ports. The amber SF LED is also 
illuminated if the transmit and receive fibers are incorrectly connected. If the 
fibers are properly connected and the link is working, the LED turns off.

Table 14-49 TXP_MR_10G Port-Level Indicators 

Port-Level LED Description

Green Client LED The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Green Wavelength 1 LED Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the card is 
configured for Wavelength 1. 

Green Wavelength 2 LED Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the card is 
configured for Wavelength 2.
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14.8.2 TXP_MR_10E Card 

Warning High-performance devices on this card can get hot during operation. To remove the card, hold it by 
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before 
placing it in an antistatic bag.

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

The 10-Gbps Transponder–100-GHz–Tunable xx.xx-xx.xx (TXP_MR_10E) card is a multirate 
transponder for the ONS 15454 platform. The card is fully backward compatible with the 
TXT_MR_10G card. It processes one 10-Gbps signal (client side) into one 10-Gbps, 100-GHz DWDM 
signal (trunk side) that is tunable on four wavelength channels (ITU-T 100-GHz grid).

The TXP_MR_10E card can be used in any of the twelve I/O slots in the ONS 15454, including both 
high-speed and multirate ports (Slots 1 to 6 and Slots 12 to 17 can be used).

You can provision this card in a linear configuration, or as a BLSR, a Path Protection or a regenerator. 
The card can be used in the middle of BLSR or 1+1 spans when the card is configured for transparent 
termination mode.

The TXP_MR_10E port features a 1550-nm laser for the trunk port and a ONS-XC-10G-S1 XFP module 
for the client port and contains two transmit and receive connector pairs (labeled) on the card faceplate.

The TXP_MR_10E card detects SF, LOS, or LOF conditions on the optical facility. Refer to the Cisco 
ONS 15454 SONET and DWDM Troubleshooting Guide for a description of these conditions. The card 
also counts section and line BIP errors from the B1 and B2 byte registers in the section and line 
overhead.

14.8.2.1 Key Features 

The key features of the TXP_MR_10G card are:

• A tri-rate XFP client interface

– OC-192 (SR1) 

– 10GE (10GBASE-LR)

– 10G-FC (1200-SM-LL-L)

• OC-192 to G.709 OTU2 provisionable synchronous and asynchronous mapping
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14.8.2 TXP_MR_10E Card
14.8.2.2 Faceplate and Block Diagram

Figure 14-51 shows the TXP_MR_10E faceplate and block diagram.

Figure 14-51 TXP_MR_10E Faceplate and Block Diagram

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10E card. Using direct 
fiber loopbacks causes irreparable damage to the TXP_MR_10E card.

14.8.2.3 Client Interface

The client interface is implemented by an on-board XFP module, a tri-rate transponder that provides a 
single port that can be configured in the field to support STM-64/OC-192 (with an SR-1 optics module 
that plugs into the XFP module), 10GE (10GBASE-LR), or 10G FC protocols. The XFP module supports 
10 GE LAN PHY, 10 GE WAN PHY, STM-64, and OC-192 client signals.

Two types of pluggable client-side optics modules are available for the XFP module on the 
TXP_MR_10E card: an OC-192 SR-1/I-64.2 interface (ITU-T G.691) or an S-64.2 optical interface 
(ITU-T G.691). The SR-1 is a 1310-nm optical interface that utilizes LC connectors. SR-1 is typically 
used in short-reach intra-office applications with ranges typically up to 7 km.
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14.8.2.4 DWDM Trunk Interface

On the trunk side, the TXP_MR_10E card provides a 10 Gbps STM-64/OC-192 interface. There are four 
tunable channels available in the 1550-nm band on the 100-GHz ITU grid for the DWDM interface. The 
TXP_MR_10E card provides 3R transponder functionality for this 10 Gbps trunk interface. Therefore, 
the card is suited for use in long range amplified systems. The DWDM interface is complaint with 
ITU-T G.707, ITU-T G.709, and Telcordia GR-253-CORE standards.

The DWDM trunk port operates at a rate that is dependent on the input signal and the presence or absence 
of the ITU-T G.709 Digital Wrapper/FEC (see bullet list below). The maximum system reach in filterless 
applications without the use of optical amplification or regenerators is nominally rated at 23 dB over 
C-SMF fiber. This rating is not a product specification, but is given for informational purposes, and it is 
subject to change.

The possible trunk rates are:

• OC192 (9.95328 Gbps)

• OTU2 (10.70923 Gbps)

• 10GE (10.3125 Gbps) or 10GE into OTU2 (non-standard 11.0957 Gbps)

• 10G FC (10.51875 Gbps) or 10G FC into OTU2 (non-standard 11.31764 Gbps).

14.8.2.5 Y-Cable Protection

The TXP_MR_10E card supports Y-cable protection, which provides transponder equipment protection 
without client terminal equipment interface protection. A single client interface can be split between two 
transponder cards using a Y-protection device. 

With Y-cable protection, two TXP_MR_10E transponder cards can be joined in a Y-cable protection 
group. In Y-cable protection, the client ports of the two cards are joined by Y-cables. An incoming client 
signal is injected into the Rx Y-cable port and is split between the two TXP_MR_10E cards (connected 
to Rx client ports) in the protection group. The Tx client signals from the two protection group 
TXP_MR_10E cards are connected to the correspondent ports of the Tx Y-cable. Only the Tx client port 
of the active TXP_MR_10E card is turned on and transmits the signal towards the receiving client 
equipment. See the “14.9.1 Y-Cable Protection” section on page 14-119 for more details.

Note If you create a GCC using a digital wrapper and apply it to either card of the Y-cable protect group, the 
DWDM trunk (span) port stays permanently active, regardless of the switch’s state. When you provision 
a GCC, you are provisioning unprotected overhead (OH) bytes. The GCC is not protected by the 
protection group. 

14.8.2.6 Enhanced FEC (E-FEC) Feature

A key feature of the TXP_MR_10E is the availability to configure the Forward Error correction in three 
modes: NO FEC, FEC, and E-FEC. The output bit rate are always 10.7092 Gbps as defined in G.709, 
but the error coding performance can be provisioned as follows:

• NO FEC: no forward error correction

• FEC: standard G.975 Reed-Solomon algorithm
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• E-FEC: standard G.975.1 two orthogonally concatenated Bose-Chaudhuri-Hochquenghem (BCH) 
super FEC code. This FEC scheme contains three parameterizations of the same scheme of two 
orthogonally interleaved block codes (BCH). The constructed code is decoded iteratively to achieve 
the expected performance.

14.8.2.7 FEC and E-FEC Modes

As client side traffic passes through the TXP_MR_10E card, it can be digitally wrapped using FEC mode 
error correction or E-FEC mode error correction (or no error correction at all). The FEC mode setting 
provides a lower level of error detection and correction than the E-FEC mode setting of the card. As a 
result, using E-FEC mode allows higher sensitivity (lower OSNR) with a lower bit error rate than FEC 
mode. E-FEC enables longer distance trunk-side transmission than with FEC. 

The E-FEC feature is one of three basic modes of FEC operation. FEC can be turned off, FEC can be 
turned on, or E-FEC can be turned on to provide greater range and lower bit error rate. The default mode 
is FEC on and E-FEC off. E-FEC is provisioned using CTC.

Caution Because the transponder has no visibility into the data payload and detect circuits, a TXP_MR_10E card 
does not display circuits under the card view. 

14.8.2.8 Client-to-Trunk Mapping

A key feature of the TXP_MR_10E card is the ability to perform ODU2-to-OCh mapping, which allows 
operators to provision data payloads in a standard way across 10-Gbps optical links. 

Digital wrappers that define client side interfaces are called ODU2 (Optical Data Channel Unit 2) 
entities in the ITU-T G.709. Digital wrappers that define trunk side interfaces are called OCh (Optical 
Channels) in ITU-T G.709. ODU2 digital wrappers can include Generalized Multiprotocol Label 
Switching (G-MPLS) signaling extensions to ITU-T G.709 (such as Least Significant Part (LSP) and 
Generalized Payload Identifier (G-PID) values) to define client interfaces and payload protocols.

14.8.2.9 TXP_MR_10E Card-Level Indicators

Table 14-50 lists the three card-level LEDs on the TXP_MR_10E card.

Table 14-50 TXP_MR_10E Card-Level Indicators 

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or both ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.
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14.8.2.10 TXP_MR_10E Port-Level Indicators

Table 14-51 lists the four port-level LEDs in the TXP_MR_10E card. 

14.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards
The 2.5-Gbps Multirate Transponder–100-GHz–Tunable xx.xx-xx.xx (TXP_MR_2.5G) card processes 
one 8-Mbps to 2.488-Gbps signal (client side) into one 8-Mbps to 2.5-Gbps, 100-GHz DWDM signal 
(trunk side). It provides one long-reach STM-16/OC-48 port per card, compliant with ITU-T G.707, 
ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE. 

The 2.5-Gbps Multirate Transponder–Protected–100-GHz–Tunable xx.xx-xx.xx (TXPP_MR_2.5G) 
card processes one 8-Mbps to 2.488-Gbps signal (client side) into two 8-Mbps to 2.5-Gbps, 100-GHz 
DWDM signals (trunk side). It provides two long-reach STM-16/OC-48 ports per card, compliant with 
ITU-T G.707, ITU-T G.957, and Telcordia GR-253-CORE.

The TXP_MR_2.5G and TXPP_MR_2.5G cards are tunable over four wavelengths in the 1550-nm, 
ITU 100-GHz range. They are available in eight versions, covering 32 different wavelengths in the 
1550-nm range. 

Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it, and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 

The trunk/line port operates at up to 2.488 Gbps (or up to 2.66 Gbps with ITU-T G.709 Digital 
Wrapper/FEC) over unamplified distances up to 360 km (223.7 miles) with different types of fiber such 
as C-SMF or higher if dispersion compensation is used. 

Caution Because the transponder has no capability to look into the payload and detect circuits, a TXP_MR_2.5G 
or TXPP_MR_2.5G card does not display circuits under card view. 

For the TXP_MR_2.5G card, protection is done using Y-cable protection. Two TXP_MR_2.5G cards 
can be joined in a Y-cable protection group. In Y-cable protection, the client ports of the two cards are 
joined by Y-cables. A single incoming Rx client signal is injected into the Rx Y-cable port and is split 
between the two TXP_MR_2.5G cards (connected to the Rx client ports) in the protection group. The 
transmit (Tx) client signals from the two protection group TXP_MR_2.5G cards are connected to the 
correspondent ports of the Tx Y-cable. Only the Tx client port of the Active TXP_MR_2.5G card is 
turned on and transmits the signal towards the receiving client equipment. See the “14.9 Transponder 
and Muxponder Protection” section on page 14-119 for more information.

Table 14-51 TXP_MR_10E Port-Level Indicators

Port-Level LED Description

Green Client LED The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.
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Note If you create a GCC on either card of the protect group, the trunk (span) port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

For the TXPP_MR_2.5G card, protection is done using splitter protection. In splitter protection, the 
single client signal is injected into the client Rx port. It is then split into two separate signals on the two 
trunk Tx ports. The two signals are transmitted over diverse paths. The far-end TXPP_MR_2.5G card 
chooses one of the two trunk Rx port signals and injects it into the Tx client port. The TXPP_MR_2.5G 
card switches the selected trunk Rx port signal in case of failure. See the “14.9 Transponder and 
Muxponder Protection” section on page 14-119 for more details.

The TXP_MR_2.5G and TXPP_MR_2.5G cards support 2R and 3R modes of operation where the client 
signal is mapped into a ITU-T G.709 frame. The mapping function is simply done by placing a digital 
wrapper around the client signal. Only OC-48/STM-16 client signals are fully ITU-T G.709 compliant, 
and the output bit rate depends on the input client signal. Table 14-52 shows the possible combinations 
of client interfaces, input bit rates, 2R and 3R modes, and ITU-T G.709 monitoring.

The output bit rate is calculated for the trunk bit rate by using the 255/238 ratio as specified in 
ITU-T G.709 for OTU1. Table 14-53 lists the calculated trunk bit rates for the client interfaces with 
ITU-T G.709 enabled.

Table 14-52 2R and 3R Mode and ITU-T G.709 Compliance by Client Interface

Client Interface Input Bit Rate 3R vs. 2R ITU-T G.709

OC-48/STM-16 2.488 Gbps 3R On or Off

DV-6000 2.38 Gbps 2R —

2 Gigabit Fibre Channel (2G-FC)/FICON 2.125 Gbps 3R1

1. No monitoring

On or Off

High definition television (HDTV) 1.48 Gbps 2R —

Gigabit Ethernet (GE) 1.25 Gbps 3R On or Off

1 Gigabit Fibre Channel (1G-FC)/FICON 1.06 Gbps 3R On or Off

OC-12/STM-4 622 Mbps 3R On or Off

OC-3/STM-1 155 Mbps 3R On or Off

ESCON 200 Mbps 2R —

SDI/D1 video 270 Mbps 2R —

ISC-1 Compact 1.06 Gbps 3R Off

ISC-3 1.06 or 
2.125 Gbps

2R —

ETR/CLO 16 Mbps 2R —

Table 14-53 Trunk Bit Rates With ITU-T G.709 Enabled

Client Interface ITU-T G.709 Disabled ITU-T G.709 Enabled

OC-48/STM-16 2.488 Gbps 2.66 Gbps

2G-FC 2.125 Gbps 2.27 Gbps
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14.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards
For 2R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards have the ability to pass data 
through transparently from client side interfaces to a trunk side interface, which resides on an ITU grid. 
The data might vary at any bit rate from 200-Mbps up to 2.38-Gbps, including Enterprise System 
Connection (ESCON) and video signals. In this pass-through mode, no performance monitoring (PM) 
or digital wrapping of the incoming signal is provided, except for the usual PM outputs from the Small 
Form-factor Pluggable (SFPs). Similarly, this card has the ability to pass data through transparently from 
the trunk side interfaces to the client side interfaces with bit rates varying from 200-Mbps up to 
2.38-Gbps. Again, no performance monitoring or digital wrapping of received signals is available in this 
pass-through mode.

For 3R operation mode, the TXP_MR_2.5G and TXPP_MR_2.5G cards apply a digital wrapper to the 
incoming client interface signals (OC-N, 1G-FC, 2G-FC, GE). Performance monitoring is available on 
all of these signals except for 2G-FC, and varies depending upon the type of signal. For client inputs 
other than OC-48/STM-16, a digital wrapper might be applied but the resulting signal is not 
ITU-T G.709 compliant. The card applies a digital wrapper that is scaled to the frequency of the input 
signal.

The TXP_MR_2.5G and TXPP_MR_2.5G card has the ability to take digitally wrapped signals in from 
the trunk interface, remove the digital wrapper, and send the unwrapped data through to the client 
interface. Performance monitoring of the ITU-T G.709 OH and SONET/SDH OH is implemented.

14.8.3.1 Faceplate

Figure 14-52 shows the TXP_MR_2.5G and TXPP_MR_2.5G faceplates. 

GE 1.25 Gbps 1.34 Gbps

1G-FC 1.06 Gbps 1.14 Gbps

OC-12/STM-3 622 Mbps 666.43 Mbps

OC-3/STM-1 155 Mbps 166.07 Mbps

Table 14-53 Trunk Bit Rates With ITU-T G.709 Enabled (continued)

Client Interface ITU-T G.709 Disabled ITU-T G.709 Enabled
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14.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards
Figure 14-52 TXP_MR_2.5G and TXPP_MR_2.5G Faceplates

14.8.3.2 Block Diagram

Figure 14-53 shows a block diagram of the TXP_MR_2.5G and TXPP_MR_2.5G cards.
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14.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards
Figure 14-53 TXP_MR_2.5G and TXPP_MR_2.5G Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the TXP_MR_2.5G and 
TXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks with the 
TXP_MR_2.5G and TXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable damage to 
the TXP_MR_2.5G and TXPP_MR_2.5G cards.

You can install TXP_MR_2.5G and TXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17. You can 
provision this card in a linear configuration. TXP_MR_10G and TXPP_MR_2.5G cards cannot be 
provisioned as a BLSR, a path protection, or a regenerator. They can be used in the middle of BLSR or 
1+1 spans. They can only be used in the middle of BLSR and 1+1 spans when the card is configured for 
transparent termination mode.

The TXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm laser for the 
client port and contains two transmit and receive connector pairs (labeled) on the card faceplate. The 
card uses dual LC connectors for optical cable termination. 

The TXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm 
laser (depending on the SFP) for the client port and contains three transmit and receive connector pairs 
(labeled) on the card faceplate. The card uses dual LC connectors for optical cable termination.

The TXP_MR_2.5G and TXPP_MR_2.5G cards detect SF, LOS, or LOF conditions on the optical 
facility. Refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide for a description of 
these conditions. The card also counts section and line BIP errors from B1 and B2 byte registers in the 
section and line overhead.

14.8.3.3 TXP_MR_2.5G and TXPP_MR_2.5G Safety Labels

The TXP_MR_2.5G and TXPP_MR_2.5G cards have several safety labels that provide laser radiation 
and electrical shock warnings. 
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Figure 14-54 shows the laser radiation warning hazard level label. The faceplate of these cards are 
clearly labeled with warnings about the equipment radiation level. Personnel must understand all 
warning labels before working with these cards. The hazard level label warns the personnel against 
exposure to laser radiation of Class 1 limits calculated in accordance with IEC60825-1 Ed.1.2.

Figure 14-54 Laser Radiation Warning—Hazard Level Label

Figure 14-55 shows the laser source connector label. This label indicates a laser source at the optical 
connectors where it has been placed.

Figure 14-55 Laser Radiation Warning—Laser Source Connector Label

Figure 14-56 shows the FDA compliance label. This label shows the statement of compliance to FDA 
standards and that the hazard level classification is in accordance with IEC60825-1 Am.2 or Ed.1.2.

Figure 14-56 FDA Compliance Statement Label

Figure 14-57 shows the electrical energy hazard label. This label alerts personnel to electrical hazards 
within the card. The potential of shock hazard exists when adjacent cards are removed during 
maintenance and touching exposed electrical circuitry on the card itself.
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14.8.3 TXP_MR_2.5G and TXPP_MR_2.5G Cards
Figure 14-57 Electrical Energy Hazard Label

14.8.3.4 TXP_MR_2.5G and TXPP_MR_2.5G Card-Level Indicators

Table 14-54 lists the three card-level LEDs on the TXP_MR_2.5G and TXPP_MR_2.5G cards.

14.8.3.5 TXP_MR_2.5G and TXPP_MR_2.5G Port-Level Indicators

Table 14-55 lists the four port-level LEDs on the TXP_MR_2.5G and TXPP_MR_2.5G cards.

65
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Table 14-54 TXP_MR_10G and TXPP_MR_2.5G Card-Level Indicators

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or both ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.

Table 14-55 TXP_MR_10G Port-Level Indicators 

Port-Level LED Description

Green Client LED The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Green TX LED The green TX LED indicates that indicated the DWDM port is in service and 
that it is currently transmitting a recognized signal.

Green RX LED The green RX LED indicates that the indicated DWDM port is in service and 
that it is currently receiving a recognized signal.
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14.8.4 MXP_2.5G_10G Card

Warning High-performance devices on this card can get hot during operation. To remove the card, hold it by 
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before 
placing it in an antistatic bag.

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

The 2.5-Gbps–10-Gbps Muxponder–100 GHz–Tunable xx.xx-xx.xx (MXP_2.5G_10G) card 
multiplexes/demultiplexes four 2.5-Gbps signals (client side) into one 10-Gbps, 100-GHz DWDM 
signal (trunk side). It provides one extended long-range STM-64/OC-192 port per card on the trunk side 
(compliant with ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE) and four 
intermediate- or short-range OC-48/STM-16 ports per card on the client side. The port operates at 
9.95328 Gbps over unamplified distances up to 80 km (50 miles) with different types of fiber such as 
C-SMF or dispersion compensated fiber limited by loss and/or dispersion. 

Client ports on the MXP_2.5G_10G card are also interoperable with OC-1 (STS-1) fiber optic signals 
defined in Telcordia GR.252-CORE. An OC-1 signal is the equivalent of one DS-3 channel transmitted 
across optical fiber. OC-1 is primarily used for trunk interfaces to phone switches in the United States. 
There is no SDH equivalent for OC-1.

The MXP_2.5G_10G card is tunable over two neighboring wavelengths in the 1550-nm, ITU 100-GHz 
range. It is available in four different versions, covering eight different wavelengths in the 1550-nm 
range.

Note ITU-T G.709 specifies a form of FEC that uses a “wrapper” approach. The digital wrapper lets you 
transparently take in a signal on the client side, wrap a frame around it and restore it to its original form. 
FEC enables longer fiber links because errors caused by the optical signal degrading with distance are 
corrected. 

The port can also operate at 10.70923 Gbps in ITU-T G.709 Digital Wrapper/FEC mode. 

Caution Because the transponder has no capability to look into the payload and detect circuits, an 
MXP_2.5G_10G card does not display circuits under card view. 

14.8.4.1 Y-Cable Protection

For the MXP_2.5G_10G card, protection is done using Y-cable protection. Two MXP_2.5G_10G cards 
can be joined in a Y-cable protection group. In Y-cable protection, the client ports of the two cards are 
joined by Y-cables. A single Rx client signal is injected into the Rx Y-cable and is split between the two 
MXP_2.5G_10G cards in the protection group. The Tx client signals from the two protection group 
MXP_2.5G_10G cards are connected via the TX Y-cable with only the active card signal passing 
through as the single TX client signal. See the “14.9.1 Y-Cable Protection” section on page 14-119 for 
more details.
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Note If you create a GCC on either card of the protect group, the trunk port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

14.8.4.2 Faceplate

Figure 14-58 shows the MXP_2.5G_10G faceplate.

Figure 14-58 MXP_2.5G_10G Faceplate

14.8.4.3 Block Diagram

Figure 14-59 shows a block diagram of the MXP_2.5G_10G card.
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14.8.4 MXP_2.5G_10G Card
Figure 14-59 MXP_2.5G_10G Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10G card. Using 
direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10G card.

You can install MXP_2.5G_10G cards in Slots 1 to 6 and 12 to 17. You can provision this card in a linear 
configuration. MXP_2.5G_10G cards cannot be provisioned as a BLSR, a path protection, or a 
regenerator. They can be used in the middle of BLSR or 1+1 spans. They can only be used in the middle 
of BLSR and 1+1 spans when the card is configured for transparent termination mode.

The MXP_2.5G_10G port features a 1550-nm laser on the trunk port and four 1310-nm lasers on the 
client ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The 
card uses a dual LC connector on the trunk side and SFP connectors on the client side for optical cable 
termination.

The MXP_2.5G_10G card detects SF, LOS, or LOF conditions on the optical facility. Refer to the Cisco 
ONS 15454 SONET and DWDM Troubleshooting Guide for a description of these conditions. The card 
also counts section and line BIP errors from B1 and B2 byte registers in the section and line overhead.

14.8.4.4 Timing Synchronization

The MXP_2.5G_10G card is synchronized to the TCC2 clock during normal conditions and transmits 
the ITU-T G.709 frame using this clock. The TCC2 can operate from an external BITS clock, an internal 
Stratum 3 clock, or from clock recovered from one of the four valid client clocks. If clocks from both 
TCC2 cards are not available, the MXP_2.5G_10G card switches automatically (with errors, not hitless) 
to an internal 19.44 MHz clock that does not meet SONET clock requirements. This will result in a clock 
alarm.

14.8.4.5 MXP_2.5G_10G Card-Level Indicators

Table 14-59 describes the three card-level LEDs on the MXP_2.5G_10G card.
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14.8.4.6 MXP_2.5G_10G Port-Level Indicators

Table 14-60 describes the seven port-level LEDs on the MXP_2.5G_10G card. 

14.8.5 MXP_2.5G_10E Card 

Warning High-performance devices on this card can get hot during operation. To remove the card, hold it by 
the faceplate and bottom edge. Allow the card to cool before touching any other part of it or before 
placing it in an antistatic bag.

Warning Do not reach into a vacant slot or chassis while you install or remove a module or a fan. Exposed 
circuitry could constitute an energy hazard.

Table 14-56 MXP_2.5G_10G Card-Level Indicators 

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or more ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.

Table 14-57 MXP_2.5G_10G Port-Level Indicators 

Port-Level LED Description

Green Client LED
(four LEDs)

The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. The card has four client ports, and so has four 
Client LEDs. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.

Green Wavelength 1 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the board is 
configured for Wavelength 1. 

Green Wavelength 2 
LED

Each port supports two wavelengths on the DWDM side. Each wavelength 
LED matches one of the wavelengths. This LED indicates that the board is 
configured for Wavelength 2.
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The 2.5-Gbps–10-Gbps Muxponder–100 GHz–Tunable xx.xx-xx.xx (MXP_2.5G_10E) card is a 
DWDM muxponder for the ONS 15454 platform that supports full optical transparency on the client 
side. The card multiplexes four 2.5 Gbps client signals (4 x OC48/STM-16 SFP) into a single 10-Gbps 
DWDM optical signal on the trunk side. The MXP_2.5G_10E provides wavelength transmission service 
for the four incoming 2.5 Gbps client interfaces. The MXP_2.5G_10E muxponder passes all 
SONET/SDH overhead bytes transparently. 

The digital wrapper function (ITU-T G.709 compliant) formats the DWDM wavelength so that it can be 
used to set up general communication channels (GCC) for data communications, enable forward error 
correction, or facilitate performance monitoring.

The MXP_2.5G_10E works with Optical Transparent Network (OTN) devices defined in ITU-T G.709. 
The card supports Optical Data Channel Unit 1 (ODU1) to Optical Channel Transport Unit (OTU2) 
multiplexing, an industry standard method for asynchronously mapping a SONET/SDH payload into a 
digitally wrapped envelope. See the “14.8.5.5 Multiplexing Function” section on page 14-108.

The MXP_2.5G_10E card is not compatible with the MXP_2.5G_10G card, which does not supports full 
optical transparency. The faceplate designation of the card is “4x2.5G 10E MXP.”

You can install MXP_2.5G_10E cards in Slots 1 to 6 and 12 to 17. You can provision this card in a linear 
configuration, as a BLSR, a path protection, or a regenerator. The card can be used in the middle of 
BLSR or 1+1 spans when the card is configured for transparent termination mode.

The MXP_2.5G_10E features a 1550-nm laser on the trunk port and four 1310-nm lasers on the client 
ports and contains five transmit and receive connector pairs (labeled) on the card faceplate. The card 
uses a dual LC connector on the trunk side and uses SFP modules on the client side for optical cable 
termination. The SFP pluggable modules are short reach (SR) or intermediate reach (IR) and support an 
LC fiber connector.

The MXP_2.5G_10E card detects SF, LOS, or LOF conditions on the optical facility. Refer to the Cisco 
ONS 15454 SONET and DWDM Troubleshooting Guide for a description of these conditions. The card 
also counts section and line BIP errors from B1 and B2 byte registers in the section and line overhead.

14.8.5.1 Key Features

The MXP_2.5G_10E card has the following high level features:

• Four 2.5 Gbps client interfaces (OC-48/STM-16) and one 10 Gbps trunk. The four OC-48 signals 
are mapped into a ITU-T G.709 OTU2 signal using standard ITU-T G.709 multiplexing.

• Onboard Enhanced Forward Error Correction (E-FEC) processor: The processor supports both 
standard RS (specified in ITU-T G.709) and E-FEC, which allows an improved gain on trunk 
interfaces with a resultant extension of the transmission range on these interfaces. The E-FEC 
functionality increases the correction capability of the transponder to improve performance, 
allowing operation at a lower OSNR compared to the standard RS (237,255) correction algorithm. 
A new BCH algorithm implemented in E-FEC allows recovery of an input BER up to 1E-3.

• Pluggable client interface optic modules: The MXP_MP_10E card has modular interfaces. Two 
types of optics modules can be plugged into the card. These include an OC-48/STM 16 SR-1 
interface with a 7 km nominal range (for short range and intra-office applications) and an IR-1 
interface with a range up to 40 km. SR-1 is defined in Telcordia GR-253 and in I-16 (ITU- G.957). 
IR-1 is defined in Telcordia GR-253 and in S-16-1 (ITU G.957).

• High level provisioning support: The MXP_MP_10E card is initially provisioned using 
Cisco MetroPlanner software. Subsequently, the card may be monitored and provisioned using CTC 
software.
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• Link monitoring and management: The MXP_MP_10E card uses standard OC-48 OH (overhead) 
bytes to monitor and manage incoming interfaces. The card passes the incoming SDH/SONET data 
stream and its overhead bytes transparently. 

• Control of layered SONET/SDH transport overhead: The card is provisionable to terminate 
regenerator section overhead. This is used to eliminate forwarding of unneeded layer overhead. It 
can help reduce the number of alarms and help isolate faults in the network.

• Automatic timing source synchronization: The MXP_MP_10E normally synchronizes from the 
TCC2 card. If for some reason, such as maintenance or upgrade activity, the TCC2 is not available, 
the MXP_MP_10E automatically synchronizes to one of the input client interface clocks.

• Configurable squelching policy: The card can be configured to squelch the client interface output if 
there is LOS at the DWDM receiver or if there is a remote fault. In the event of a remote fault, the 
card manages multiplex section alarm indication signal (MS-AIS) insertion.
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14.8.5.2 Faceplate

Figure 14-60 shows the MXP_2.5G_10E faceplate and ports.

Figure 14-60 MXP_2.5G_10E Faceplate and Ports

14.8.5.3 Client Interfaces

The MXP_2.5G_10E provides four intermediate- or short-range OC-48/STM-16 ports per card on the 
client side. Both SR-1 or IR-1 optics can be supported and the ports utilize SFP connectors. The client 
interfaces use four wavelengths in the 1310-nm, ITU 100-MHz spaced channel grid. 

14.8.5.4 DWDM Interface

The MXP_MP_10E serves as an OTN multiplexer, transparently mapping four OC-48 channels 
asynchronously to ODU1 into one 10-Gbps trunk. The DWDM trunk is tunable for transmission over 
four wavelengths in the 1550-nm, ITU 100-GHz spaced channel grid.

Figure 14-61 shows the block diagram for the MXP_2.5G_10E card.
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Figure 14-61 MXP_2.5G_10E Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MP_10E card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_MP_10E card. Using direct 
fiber loopbacks causes irreparable damage to the MXP_MP_10E card.

14.8.5.5 Multiplexing Function

The muxponder is an integral part of the optically transparent ROADM network in which data payload 
channels and wavelengths are processed exclusively at the optical level without electrical to optical 
(E-O) conversion. The key function of MXP_MP_10E is to multiplex 4 OC-48/STM16 signals onto one 
ITU-T G.709 OTU2 optical signal (DWDM transmission). The multiplexing mechanism allows the 
signal to be terminated at a far-end node by another MXP_2.5G_10E card.

Optical transparency on the muxponder is configured using OTUx and ODUx OH bytes. The 
ITU-T G.709 specification defines OH byte formats that are used to configure, set and monitor frame 
alignment, FEC mode, section monitoring, tandem connection monitoring, and optical transparency.

The MXP_2.5G_10E card performs ODU to OTU multiplexing as defined in ITU-T G.709. The ODU is 
the framing structure and byte definition (ITU-T G.709 digital wrapper) used to define the data payload 
coming into one of the SONET/SDH client interfaces on MXP_2.5G_10E. The term ODU1 refers to an 
ODU that operates at 2.5-Gbps line rate. On the MXP_2.5G_10E, there are four client interfaces that can 
be defined using ODU1 framing structure and format by asserting a ITU-T G.709 digital wrapper. 

The output of the muxponder is a single 10-Gbps DWDM trunk interface defined using OTU2. It is 
within the OTU2 framing structure that FEC or E-FEC information is appended to enable error checking 
and correction.
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14.8.5 MXP_2.5G_10E Card
14.8.5.6 Timing Synchronization

The MXP_2.5G_10E card is synchronized to the TCC2 clock during normal conditions and transmits 
the ITU-T G.709 frame using this clock. No holdover function is implemented. If clocks from both TCC2 
cards are not available, the MXP_2.5G_10E switches automatically (hitless) to the first of the four valid 
client clocks with no time restriction as to how long it can run on this clock. The MXP_2.5G_10E 
continues to monitor the TCC2. If a TCC2 is restored to working order, the MXP_2.5G_10E reverts to 
the normal working mode of running from the TCC2 clock. If there is no valid TCC2 clock and all of 
the client channels become invalid, the card waits (no valid frames processed) until one of the TCC2 
cards supplies a valid clock. In addition, the card is allowed to select the recovered clock from one active 
and valid client channel and supply that clock to the TCC2.

14.8.5.7 Y-Cable Protection

The MXP_2.5G_10E card supports Y-cable protection. Two MXP_2.5G_10E cards can be joined in a 
Y-cable protection group with one card assigned as the working card and the other defined as the 
protection card. This protection mechanism provides redundant bidirectional paths. See the 
“14.9.1 Y-Cable Protection” section on page 14-119 for more detailed information.

The Y-protection mechanism is provisionable and can be set ON or OFF (OFF is the default mode). 
When a signal fault is detected (LOS, LOF, signal degrade [SD], or SF on the DWDM receiver port in 
the case of ITU-T G.709 mode) the protection mechanism software automatically switches between 
paths.

Note If you create a GCC on either card of the protect group, the trunk port stays permanently active, 
regardless of the switch state. When you provision a GCC, you are provisioning unprotected overhead 
bytes. The GCC is not protected by the protect group. 

14.8.5.8 Enhanced FEC (E-FEC) Capability

A key feature of the MXP_2.5G_10E is the availability to configure the Forward Error correction in 
three modes: NO FEC, FEC, and E-FEC. The output bit rate are always 10.7092 Gbps as defined in 
G.709, but the error coding performance can be provisioned as follows:

• NO FEC: no forward error correction

• FEC: standard G.975 Reed-Solomon algorithm

• E-FEC: standard G.975.1 two orthogonally concatenated BCH super FEC code. This FEC scheme 
contains three parameterizations of the same scheme of two orthogonally interleaved block codes 
(BCH). The constructed code is decoded iteratively to achieve the expected performance.

14.8.5.9 FEC and E-FEC Modes

As client side traffic passes through the MXP_2.5G_10E card, it can be digitally wrapped using FEC 
mode error correction or E-FEC mode error correction (or no error correction at all). The FEC mode 
setting provides a lower level of error detection and correction than the E-FEC mode setting of the card. 
As a result, using E-FEC mode allows higher sensitivity (lower OSNR) with a lower bit error rate than 
FEC mode. E-FEC enables longer distance trunk-side transmission than with FEC. 

The E-FEC feature is one of three basic modes of FEC operation. FEC can be turned off, FEC can be 
turned on, or E-FEC can be turned on to provide greater range and lower BER. The default mode is FEC 
on and E-FEC off. E-FEC is provisioned using CTC.
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14.8.5.10 SONET/SDH Overhead Byte Processing

The card passes the incoming SDH/SONET data stream and its overhead bytes for the client signal 
transparently. The card can be provisioned to terminate regenerator section overhead. This is used to 
eliminate forwarding of unneeded layer overhead. It can help reduce the number of alarms and help 
isolate faults in the network.

14.8.5.11 Client Interface Monitoring

The following parameters are monitored on the MXP_2.5G_10E card:

• Laser bias current is measured as a performance monitoring parameter

• LOS is detected and signaled

• Rx and Tx power are monitored

The following parameters are monitored in real time mode (1 second):

• Optical power transmitted (client)

• Optical power received (client)

In case of loss of communication (LOC) at the DWDM receiver or far-end LOS, the client interface 
behavior is configurable. AIS can be invoked or the client signal can be squelched.

14.8.5.12 Wavelength Identification

The card shall uses trunk lasers that are wave-locked, which allows the trunk transmitter to operate on 
the ITU grid effectively. Table 14-58 describes the required trunk transmit laser wavelengths. The laser 
is tunable over eight wavelengths at 50 GHz spacing or four at 100 GHz.

Table 14-58 MXP_2.5G_10E Trunk Wavelengths

Band Wavelength (nm)

30.3 1530.33

30.3 1531.12

30.3 1531.90

30.3 1532.68

34.2 1534.25

34.2 1535.04

34.2 1535.82

34.2 1536.61

38.1 1538.19

38.1 1538.98

38.1 1539.77

38.1 1540.56

42.1 1542.14

42.1 1542.94

42.1 1543.73
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14.8.5.13 Automatic Laser Shutdown

The automatic laser shutdown (ALS) procedure is supported on both client and trunk interfaces. On the 
client interface, ALS is be compliant with ITU-T G.664 (6/99). On the data application and trunk 
interface, the switch on and off pulse duration is greater than 60 seconds. The on and off pulse duration 
is user-configurable.

14.8.5.14 Jitter

For SONET and SDH signals, the MXP_2.5G_10E card complies to GR-253-CORE, ITU-T G.825, and 
ITU-T G.873 for jitter generation, jitter tolerance, and jitter transfer.

14.8.5.15 Lamp Test

The MXP_2.5G_10E card supports a lamp test function that is activated from the ONS 15454 front panel 
or through CTC to ensure that all LEDs are functional.

14.8.5.16 Onboard Traffic Generation

The MXP_2.5G_10E card provides internal traffic generation for testing purposes according to 
pseudo-random bit sequence (PRBS), SONET/SDH, or ITU-T G.709.

42.1 1544.53

46.1 1546.12

46.1 1546.92

46.1 1547.72

46.1 1548.51

50.1 1550.12

50.1 1550.92

50.1 1551.72

50.1 1552.52

54.1 1554.13

54.1 1554.94

54.1 1555.75

54.1 1556.55

58.1 1558.17

58.1 1558.98

58.1 1559.79

58.1 1560.61

Table 14-58 MXP_2.5G_10E Trunk Wavelengths (continued)

Band Wavelength (nm)
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14.8.5.17 MXP_2.5G_10E Card-Level Indicators

Table 14-59 describes the three card-level LEDs on the MXP_2.5G_10E card.

14.8.5.18 MXP_2.5G_10E Port-Level Indicators

Table 14-60 describes the seven port-level LEDs on the MXP_2.5G_10E card. 

Table 14-59 MXP_2.5G_10E Card-Level Indicators 

Card-Level LED Description

Red FAIL LED The red FAIL LED indicates that the card’s processor is not ready. This LED 
is on during reset. The FAIL LED flashes during the boot process. Replace 
the card if the red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

If the ACT/STBY LED is green, the card is operational (one or more ports 
active) and ready to carry traffic. If the ACT/STBY LED is amber, the card 
is operational and in standby (protect) mode.

Amber SF LED The amber SF LED indicates a signal failure or condition such as LOS, LOF, 
or high BERs on one or more of the card’s ports. The amber SF LED is also 
on if the transmit and receive fibers are incorrectly connected. If the fibers 
are properly connected and the link is working, the light turns off.

Table 14-60 MXP_2.5G_10E Port-Level Indicators 

Port-Level LED Description

Green Client LED
(four LEDs)

The green Client LED indicates that the client port is in service and that it is 
receiving a recognized signal. The card has four client ports, and so has four 
Client LEDs. 

Green DWDM LED The green DWDM LED indicates that the DWDM port is in service and that 
it is receiving a recognized signal.
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14.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards 
The 2.5-Gbps Multirate Muxponder-100 GHz-Tunable 15xx.xx-15yy.yy (MXP_MR_2.5G) card 
aggregates a mix and match of client Storage Area Network (SAN) service client inputs (GE, FICON, 
and Fibre Channel) into one 2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides one 
long-reach STM-16/OC-48 port per card and is compliant with Telcordia GR-253-CORE.

The 2.5-Gbps Multirate Muxponder–Protected–100 GHz–Tunable 15xx.xx-15yy.yy (MXPP_MR_2.5G) 
card aggregates various client SAN service client inputs (GE, FICON, and Fibre Channel) into one 
2.5 Gbps STM-16/OC-48 DWDM signal on the trunk side. It provides two long-reach STM-16/OC-48 
ports per card and is compliant with ITU-T G.957 and Telcordia GR-253-CORE.

Because the cards are tunable to one of four adjacent grid channels on a 100 GHz spacing, each card is 
available in eight versions, with 15xx.xx representing the first wavelength and 15yy.yy representing the 
last wavelength of the four available on the board. In total, 32 DWDM wavelengths are covered in 
accordance with the ITU-T 100GHz grid standard, G.692, and Telcordia GR-2918-CORE, Issue 2. The 
card versions along with their corresponding wavelengths are shown in Table 14-61.

The muxponders are intended to be used in applications with long DWDM metro or regional 
unregenerated spans. Long transmission distances are achieved through the use of flat gain optical 
amplifiers. 

The client interface supports the following payload types: 

• GE

• 1G FC

• 2G FC

• 1G FICON

• 2G FICON

Note Because the client payload cannot oversubscribe the trunk, a mix of client signals can be accepted, up 
to a maximum limit of 2.5 Gbps. 

Table 14-62 shows the input data rate for each client interface, and the encapsulation method. The 
current version of the Transparent Generic Framing Procedure (GFP-T) G.7041 supports transparent 
mapping of 8B/10B block-coded protocols, including Gigabit Ethernet, Fibre Channel, and FICON.

Table 14-61 Card Versions

Card Version Frequency Channels at 100 GHz (0.8 nm) Spacing

1530.33 - 1532.68 1530.33 nm 1531.12 nm 1531.90 nm  1532.68 nm

1534.25 - 1536.61 1534.25 nm  1535.04 nm  1535.82 nm  1536.61 nm

1538.19 - 1540.56 1538.19 nm 1538.98 nm 1539.77 nm 1540.56 nm

1542.14 - 1544.53 1542.14 nm 1542.94 nm 1543.73 nm 1544.53 nm

1546.12 - 1548.51 1546.12 nm 1546.92 nm 1547.72 nm 1548.51 nm

1550.12 - 1552.52 1550.12 nm 1550.92 nm 1551.72 nm 1552.52 nm

1554.13 - 1556.55 1554.13 nm  1554.94 nm 1555.75 nm  1556.55 nm

1558.17 - 1560.61 1558.17 nm 1558.98 nm 1559.79 nm 1560.61 nm
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In addition to the GFP mapping, 1 Gbps traffic on port 1 or port 2 of the high-speed SERDES is mapped 
to an STS-24c channel. If two 1 Gbps client signals are present at port 1 and port 2 of the high-speed 
SERDES, the port 1 signal is mapped into the first STS-24c channel and the port 2 signal into the second 
STS-24c channel. The two channels are then mapped into an OC-48 trunk channel.

Table 14-63 shows some of the mix and match possibilities on the various client ports. The table is 
intended to show the full client payload configurations for the card.

For the MXP_MR_2.5G card, protection is done using Y-cable protection. Two MXP_MR_2.5G cards 
can be joined in a Y-cable protection group, which provides protection against failures both on the fiber 
and in the muxponders.

For the MXPP_MR_2.5G card, protection is done using splitter protection, which provides protection 
against failures due to fiber cuts or unacceptable signal degradation on the trunk side. See the 
“14.9 Transponder and Muxponder Protection” section on page 14-119 for more detailed information.

Note Switching is performed only if the protect line is error free.

Generic Framing Procedure Transparent Performance Monitoring (GFP-T PM) is available via remote 
monitoring (RMON), and trunk PM is managed according to Telcordia GR-253 and ITU G.783/826. 
Client PM is achieved through RMON for FC and GE.

A buffer-to-buffer credit management scheme provides FC flow control. With this feature enabled, a 
port indicates the number of frames that can be sent to it (its buffer credit), before the sender is required 
to stop transmitting and wait for the receipt of a “ready” indication The MXP_MR_2.5G and 
MXPP_MR_2.5 cards support FC credit based flow control with a buffer-to-buffer credit extension of 
up to 1600 km for 1G FC and up to 800 km for 2G FC. The feature can be enabled or disabled. 

Table 14-62 MXP_MR_2.5G and MXP_MR_2.5G Client Interface Data Rates and Encapsulation

Client Interface Input Data Rate GFP-T G.7041 Encapsulation

GE 1.25 Gbps Yes

1G FC 1.06 Gbps Yes

2G FC 2.125 Gbps Yes

1G FICON 1.06 Gbps Yes

2G FICON 2.125 Gbps Yes

Table 14-63 Client Data Rates and Ports

Mode Port(s) Aggregate Data Rate

GE 1, 2 2.5 Gbps

1G FC 1, 2 2.125 Gbps

2G FC 1 2.125 Gbps

1G FICON 1, 2 2.125 Gbps

2G FICON 1 2.125 Gbps
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14.8.6.1 Faceplates

Figure 14-62 shows the MXP_MR_2.5G and MXPP_MR_2.5G faceplates. 

Figure 14-62 MXP_MR_2.5G and MXPP_MR_2.5G Faceplates

14.8.6.2 Block Diagram

Figure 14-63 shows a block diagram of the MXP_MR_2.5G card. The diagram shows that there are eight 
SFP client interfaces. Ports 1 and 2 can be used for GE, FC, or FICON. Ports 3 through 8 are for future 
use. There are two serializer/deserializer (SERDES) blocks dedicated to the high-speed interfaces (GE, 
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14.8.6 MXP_MR_2.5G and MXPP_MR_2.5G Cards
FC, and FICON) and two SERDES blocks for future interfaces. An FPGA is provided to support 
different configurations for different modes of operation. This FPGA has a Universal Test and 
Operations Physical Interface for ATM (UTOPIA) interface. A transceiver add-drop multiplexer 
(TADM) chip supports framing. Finally the output signal is serialized and connected to the trunk front 
end with a direct modulation laser. The trunk receive signal is converted into an electrical signal with 
an avalanche photodiode (APD), deserialized, then sent to the TADM framer and FPGA. 

The MXPP_MR_2.5G is the same, except at the trunk interface, the output power is split using a 50/50 
splitter. On the receive direction, there are two APDs, two SERDES blocks, and two TADM framers. 
This is necessary to monitor both the Main and Protect paths. A switch selects which of the two paths 
are connected to the client interfaces.

Figure 14-63 MXP_MR_2.5G and MXPP_MR_2.5G Block Diagram

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G and 
MXPP_MR_2.5G cards in a loopback configuration on the trunk port. Do not use direct fiber loopbacks 
with the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes irreparable 
damage to the MXP_MR_2.5G and MXPP_MR_2.5G cards.

You can install MXP_MR_2.5G and MXPP_MR_2.5G cards in Slots 1 to 6 and 12 to 17. The cards must 
be able to be inserted into any of the transport slots of either the ONS 15454 ANSI or ETSI products. 
The TCC2 card is the only other card required to be used with these muxponder cards. The XC and 
XCVT cards are not required. The existence of XC/XCVT/XC10G does not affect the operation of the 
muxponder cards.

The MXP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm laser 
(depending on the SFP) for the client ports. The card contains eight 12.5 degree downward tilt SFP 
modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are 
labeled TX and RX on the faceplate. The trunk port is dual LC connector with a 45 degree downward 
angle.
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The MXPP_MR_2.5G card features a 1550-nm laser for the trunk/line port and a 1310-nm or 850-nm 
laser (depending on the SFP) for the client port. The card contains eight 12.5 degree downward tilt SFP 
modules for the client interfaces. For optical termination, each SFP uses two LC connectors, which are 
labeled TX and RX on the faceplate. There are two trunk port connectors (one for working and one for 
protect). Each is a dual LC connector with a 45 degree downward angle.

The MXP_MR_2.5G and MXPP_MR_2.5G cards detect SF, LOS, or LOF conditions on the trunk 
interface of the optical facility. Refer to the Cisco ONS 15454 Troubleshooting Guide for a description 
of these conditions. The card also counts section and line BIP errors for the trunk interface from the B1 
and B2 byte registers in the section and line overhead.

14.8.6.3 MXP_MR_2.5G and MXPP_MR_2.5G Safety Labels

The MXP_MR_2.5G and MXPP_MR_2.5G cards have several safety labels that provide laser radiation 
and electrical shock warnings. 

Figure 14-64 shows the laser radiation warning hazard level label. The faceplate of these cards are 
clearly labeled with warnings about the equipment radiation level. Personnel must understand all 
warning labels before working with these cards. The hazard level label warns the personnel against 
exposure to laser radiation of Class 1 limits calculated in accordance with IEC60825-1 Ed.1.2.

Figure 14-64 Laser Radiation Warning—Hazard Level Label

Figure 14-65 shows the laser source connector label. This label indicates a laser source at the optical 
connectors where it has been placed.

Figure 14-65 Laser Radiation Warning—Laser Source Connector Label

Figure 14-66 shows the FDA compliance label. This label shows the statement of compliance to FDA 
standards and that the hazard level classification is in accordance with IEC60825-1 Am.2 or Ed.1.2.
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Figure 14-66 FDA Compliance Statement Label

Figure 14-67 shows the electrical energy hazard label. This label alerts personnel to electrical hazards 
within the card. The potential of shock hazard exists when adjacent cards are removed during 
maintenance and touching exposed electrical circuitry on the card itself.

Figure 14-67 Electrical Energy Hazard Label

14.8.6.4 MXP_MR_2.5G and MXPP_MR_2.5G Card-Level Indicators

Table 14-64 lists the four card-level LEDs on the MXP_MR_2.5G and MXPP_MR_2.5G cards.

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR

DEVIATIONS PURSUANT TO
LASER NOTICE NO.50,
DATED JULY 26, 2001

96
63

4

65
54

1

Table 14-64 MXP_MR_10G and MXPP_MR_2.5G Card-Level Indicators

Card-Level LED Description

FAIL LED (Red) Red indicates that the card’s processor is not ready. This LED is on during 
reset. The FAIL LED flashes during the boot process. Replace the card if the 
red FAIL LED persists.

ACT/STBY LED

Green (Active)

Amber (Standby)

Green indicates that the card is operational (one or both ports active) and 
ready to carry traffic. 

Amber indicates that the card is operational and in standby (protect) mode.

SF LED (Amber) Amber indicates a signal failure or condition such as LOS, LOF, or high 
BERs on one or more of the card’s ports. The amber SF LED is also 
illuminated if the transmit and receive fibers are incorrectly connected. If the 
fibers are properly connected and the link is working, the LED turns off.

DWDM LED

Green (Active)

Amber (Protect Traffic)

Red (LOS)

Green indicates that the board is carrying traffic (active) on the interface. 

When the LED is amber, it indicates that the interface is carrying protect 
traffic in a splitter protection card (MXPP_MR_2.5G). A red LED indicates 
that the interface has detected an LOS or LOC.
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14.8.6.5 MXP_MR_2.5G and MXPP_MR_2.5G Port-Level Indicators

Table 14-65 lists the eight port-level LEDs on the MXP_MR_2.5G and MXPP_MR_2.5G cards.

14.9 Transponder and Muxponder Protection
Two types of protection are available:

• Y-cable protection

• Splitter protection

14.9.1 Y-Cable Protection
Y-cable protection is available for the following ONS 15454 transponder and muxponder cards:

• TXP_MR_10G

• TXP_MR_2.5G

• MXP_MR_2.5G

• MXP_2.5G_10G

To create Y-cable protection, you create a Y-cable protection group for two TXP or MXP cards using 
the CTC software, then connect the client ports of the two cards physically with a Y-cable. The single 
client signal is sent into the Rx Y-cable and is split between the two TXP or MXP cards. The two Tx 
signals from the client side of the TXP or MXP cards are combined in the TX Y-cable into a single client 
signal. Only the active card signal passes through as the single TX client signal. The other card must 
have its laser turned off to avoid signal degradation where the Y-cable joins. Figure 14-68 shows the 
Y-cable signal flow.

Note Loss of Signal–Payload (LOS-P) alarms, also called Incoming Payload Signal Absent alarms, can occur 
on a split signal if the ports are not in a Y-cable protection group.

Table 14-65 MXP_MR_10G and MXPP_MR_2.5G Port-Level Indicators

Port-Level LED Description

Client LEDs (eight LEDs) Green indicates that the port is carrying traffic (active) on the interface. 
Amber indicates that the port is carrying protect traffic (MXPP_MR_2.5G). 
Red indicates that the port has detected a loss of signal.
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14.9.2 Splitter Protection
Figure 14-68 Y-Cable Protection

14.9.2 Splitter Protection
Splitter protection, shown in Figure 14-69, is provided with TXPP and MXPP cards. To implement 
splitter protection, a client injects a single signal into the client Rx port. An optical splitter internal to 
the card then splits the signal into two separate signals and routes them to the two trunk Tx ports. The 
two signals are transmitted over diverse optical paths. The far-end MXPP or TXPP card uses an optical 
switch to choose one of the two trunk Rx port signals and injects it into the Tx client port. When using 
splitter protection with two MXPP or TXPP cards, there are two different optical signals that flow over 
diverse paths in each direction. In case of failure. the far-end switch must choose the appropriate signal 
using its built-in optical switch. The triggers for a protection switch are LOS, LOF, SF, or SD.
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14.10 Far-End Laser Control (FELC)
Figure 14-69 Splitter Protection

You create and modify protection schemes using CTC software.

14.10 Far-End Laser Control (FELC)
The 15454 DWDM cards provide a transparent mode that accurately conveys the client input signal to 
the far-end client output signal. The client signal is normally carried as payload over the DWDM signals. 
Certain client “signals”, however, cannot be conveyed as payload. In particular, client LOS or LOF 
cannot be carried. Far-end laser control is the ability to convey an LOS or LOF from the near-end client 
input to the far-end client output.

If an LOS is detected on the near-end client input, the near-end trunk sets the appropriate bytes in the 
OTN overhead of the DWDM line. These bytes are received by the far-end trunk, and cause the far-end 
client laser to be turned off. When the laser is turned off, it is said to be squelched. If the near-end LOS 
clears, the near-end trunk clears the appropriate bytes in the OTN overhead, the far-end detects the 
changed bytes, and the far-end client squelch is removed.

FELC also covers the situation in which the trunk port detects that it has an invalid signal; the client is 
squelched so as not to propagate the invalid signal.

Some payload types preclude the use of OTN overhead bytes. These modes are the 2R modes. In 2R 
mode, an LOS on the client port causes the trunk laser to turn off. The far end detects the LOS on its 
trunk receiver and squelches the client.

FELC is not provisionable. It is always enabled when the DWDM card is in Transparent mode. However, 
FELC signaling to the far-end is only possible when G.709 is enabled on both ends of the trunk span.

14.11 Transponder and Muxponder Jitter Considerations
Jitter introduced by the SFPs used in the transponders and muxponders must be considered when 
cascading several cards. In the case of the TXP_MR_2.5G (and TXPP_MR_2.5G), MXP_MR_2.5G (and 
MXPP_MR_2.5G), and TXP_MR_10E cards, several transponders may be cascaded before the 
cumulative jitter violates the jitter specification. The recommended limit is 20 cards.
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14.12 Transponder and Muxponder Termination Modes
In the case of the TXP_MR_10G cards, you may also cascade several cards, although the recommended 
limit is 12 cards.

In the case of the MXP_2.5G_10G and MXP_2.5G_10E cards, any number of cards may be cascaded as 
long as the maximum reach between any two is not exceeded. This is because any time the signal is 
demultiplexed, the jitter is eliminated as a limiting factor.

The maximum reach between one transponder and the other must be halved if a Y-cable is used. For 
more information on Y-cable operation, see the “14.9.1 Y-Cable Protection” section on page 14-119.

14.12 Transponder and Muxponder Termination Modes
DWDM transponder and muxponder cards have various SONET and SDH termination modes that can 
be configured using CTC (see Chapter 10, “Change Card Settings”). The termination modes are 
summarized in Table 14-66.

Table 14-66 DWDM Transponder and Muxponder Termination Modes

Card Termination Modes Description

All TXP and MXP 
cards, with the 
exception of the 
MXP_2.5G_10G 
card (see next 
section of this 
table)

Transparent Termination

Section Termination

Line Termination

All the bytes of the payload pass transparently through the cards.

The SONET Transport Overhead (TOH) section bytes and the SDH 
regenerator section overhead bytes are terminated. None of these section 
overhead bytes are passed through. They are all regenerated, including the 
SONET TOH section data communication channel (DCC) bytes and the SDH 
data communications channel regenerator (DCCr) bytes. In the section 
termination mode, the SONET TOH line and SDH multiplex section overhead 
bytes are passed transparently.

In the line termination mode, the section and line overhead bytes for SONET 
and the overhead bytes for the SDH multiplex and regenerator sections are 
terminated. None of the overhead bytes are passed through. They are all 
regenerated, including the SONET SDCC and line data communication 
channel (LDCC) bytes and the SDH DCCr and data communications channel 
multiplexer (DCCm) bytes.

MXP_2.5G_10G1

1. The clients operating at rates of OC48/STM16 are multiplexed into an OC192/STM64 frame before going to OTN or DWDM.

Transparent Termination

Section Termination

Line Termination

All of the client bytes pass transparently through except the following: B1 is 
rebuilt, S1 is rewritten, A1–A2 are regenerated, and H1–H3 are regenerated.

The SONET TOH section bytes and the SDH regenerator section overhead 
bytes are terminated. None of these section overhead bytes are passed through. 
They are all regenerated, including the SONET TOH section DCC bytes and 
the SDH DCCr bytes. In the section termination mode, the SONET TOH line 
and SDH multiplex section overhead bytes are passed transparently.

In the line termination mode, the section and line overhead bytes for SONET 
and the overhead bytes for the SDH multiplex and regenerator sections are 
terminated. None of the overhead bytes are passed through. They are all 
regenerated, including the SONET SDCC and LDCC bytes and the SDH DCCr 
and DCCm bytes.
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14.13 SFP Modules
14.13 SFP Modules
This section describes the small-form factor pluggables (SFPs) that can be used with certain transponder 
and muxponder cards.

14.13.1 Compatibility by Card
Table 14-67 lists the transponder and muxponder cards and their compatible SFPs.

Caution Only use SFP certified for use in Cisco Optical Networking Systems. The qualified Cisco SFP pluggable 
module’s top assembly numbers (TANs) are provided in Table 14-67.

14.13.2 SFP Description
SFPs are integrated fiber optic transceivers that provide high-speed serial links from a port or slot to the 
network. Various latching mechanisms can be utilized on the SFP modules. There is no correlation 
between the type of latch to the model type (such as SX or LX/LH) or technology type (such as Gigabit 
Ethernet). See the label on the SFP for technology type and model. One type of latch available is a mylar 
tab as shown in Figure 14-70, a second type of latch available is an actuator/button (Figure 14-71), and 
a third type of latch is a bail clasp (Figure 14-72). 

SFP dimensions are: 

• Height 0.03 in. (8.5 mm)

Table 14-67 SFP Card Compatibility

Card
Compatible SFP
(Cisco Product ID) Cisco Top Assembly Number (TAN)

MXP_2.5G_10G (ONS 15454 SONET/SDH)
MXP_2.5G_10E (ONS 15454 SONET/ SDH)

15454-SFP-OC48-IR=
ONS-SE-2G-S1=

10-1975-01
10-2017-01

MXP_MR_2.5G
MXPP_MR_2.5G

15454-SFP-GE+-LX=
15454E-SFP-GE+-LX=
15454-SFP-GEFC-SX=
15454E-SFP-GEFC-S=

10-1832-03
10-1832-03
10-1833-01
10-1833-02

TXP_MR_2.5G (ONS 15454 SONET/ SDH)
TXPP_MR_2.5G (ONS 15454 SONET/ SDH) 

15454-SFP3-1-IR=
15454E-SFP-L.1.1=
15454-SFP12-4-IR=
15454E-SFP-L.4.1=
15454-SFP-OC48-IR=
15454E-SFP-L.16.1=
ONS-SE-2G-S1=
15454-SFP-200=
15454E-SFP-200=
15454-SFP-GEFC-SX=
15454E-SFP-GEFC-S=
15454-SFP-GE+-LX=
15454E-SFP-GE+-LX=

10-1828-01
10-1828-01
10-1976-01
10-1976-01
10-1975-01
10-1975-01
10-2017-01
10-1750-01
10-1750-01
10-1833-01
10-1833-02
10-1832-01
10-1832-02
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14.13.2 SFP Description
• Width 0.53 in. (13.4 mm)

• Depth 2.22 in. (56.5 mm)

SFP temperature ranges for are:

• COM—commercial operating temperature range -5°C to 70°C

• EXT—extended operating temperature range -5°C to 85°C

• IND—industrial operating temperature range -40°C to 85°C

Figure 14-70 Mylar Tab SFP

Figure 14-71 Actuator/Button SFP

Figure 14-72 Bail Clasp SFP
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C H A P T E R 15

DWDM Node Reference

This chapter explains the ONS 15454 dense wavelength division multiplexing (DWDM) node types that 
are available for the ONS 15454. The DWDM node type is determined by the type of amplifier and filter 
cards that are installed in an ONS 15454. The chapter also explains the DWDM automatic power control, 
ROADM power equalization, span loss verification, and automatic node setup functions. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 15.1 DWDM Node Configurations, page 15-1

• 15.2 Automatic Power Control, page 15-14

• 15.3 ROADM Power Equalization Monitoring, page 15-18

• 15.4 Span Loss Verification, page 15-18

• 15.5 Automatic Node Setup, page 15-19

15.1 DWDM Node Configurations
The ONS 15454 supports the following DWDM node configurations: hub, terminal, OADM, 
reconfigurable OADM, anti-ASE, line amplifier, and OSC regeneration line. 

Note The Cisco MetroPlanner tool creates a plan for amplifier placement and proper node equipment. 

15.1.1 Hub Node
A hub node is a single ONS 15454 node equipped with two TCC2 (Timing Control Card) cards and one 
of the following combinations:

• Two 32MUX-O (32-Channel Multiplexer) and two 32DMX-O (32-Channel Demultiplexer) or 
32DMX cards

• Two 32WSS (32-Channel Wavelength Selective Switch) and two 32DMX or 32DMX-O cards
15-1
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15.1.1   Hub Node
Note The 32WSS and 32DMX are normally installed in reconfigurable OADM (ROADM) nodes, but they can 
be installed in hub and terminal nodes. If the cards are installed in a hub node, the 32WSS express 
(EXP RX and EXP TX) ports are not cabled.

A Dispersion Compensation Unit (DCU) can also be added, if necessary. The hub node does not support 
both DWDM and time-division multiplexing (TDM) applications since the DWDM slot requirements do 
not leave room for TDM cards. Figure 15-1 shows a hub node configuration with 32MUX-O and 
32DMX-O cards installed. 

Note The optical add/drop multiplexing (OADM) AD-xC-xx.x or AD-xB-xx.x cards are not part of a hub node 
because the 32MUX-O and 32DMX-O cards drop and add all 32 channels; therefore, no other cards are 
necessary.

Figure 15-1 Hub Node Configuration Example

Figure 15-2 shows the channel flow for a hub node. Up to 32-channels from the client ports are 
multiplexed and equalized onto one fiber using the 32MUX-O card. Then, multiplexed channels are 
transmitted on the line in the eastward direction and fed to the Optical Booster (OPT-BST) amplifier. 
The output of this amplifier is combined with an output signal from the Optical Service Channel Modem 
(OSCM) card, and transmitted toward the east line. 

Received signals from the east line port are split between the OSCM card and an Optical Preamplifier 
(OPT-PRE). Dispersion compensation is applied to the signal received by the OPT-PRE amplifier, and 
it is then sent to the 32DMX-O card, which demultiplexes and attenuates the input signal. The west 
receive fiber path is identical through the west OPT-BST amplifier, the west OPT-PRE amplifier, and the 
west 32DMX-O card.
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15.1.2   Terminal Node
Figure 15-2 Hub Node Channel Flow Example

15.1.2 Terminal Node
A terminal node is a single ONS 15454 node equipped with two TCC2 cards and one of the following 
combinations:

• One 32MUX-O card and one 32DMX-O card

• One 32WSS and either a 32DMX or a 32DMX-O cards

Terminal nodes can be either east or west. In west terminal nodes, the cards are installed in the east slots 
(Slots 1 through 6). In east terminal nodes, cards are installed in the west slots (Slots 12 through 17). 
Figure 15-3 shows an example of an east terminal configuration with a 32MUX-O and 32DMX-O cards 
installed. The channel flow for a terminal node is the same as the hub node (see Figure 15-2).
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15.1.3   OADM Node
Figure 15-3 Terminal Node Configuration Example

15.1.3 OADM Node
An OADM node is a single ONS 15454 node equipped with cards installed on both sides and at least one 
AD-xC-xx.x card or one AD-xB-xx.x card and two TCC2 cards. 32MUX-O or 32DMX-O cards cannot 
be installed in an OADM node. In an OADM node, channels can be added or dropped independently 
from each direction, and then passed through the reflected bands of all OADMs in the DWDM node 
(called express path). They can also be passed through one OADM card to another OADM card without 
using a TDM ITU line card (called optical pass through) if an external patchcord is installed. 

Unlike express path, an optical pass-through channel can be converted later to an add/drop channel in an 
altered ring without affecting another channel. OADM amplifier placement and required card placement 
is determined by the Cisco MetroPlanner tool or your site plan.

OADM nodes can be amplified or passive. In amplified OADMs, the OPT-PRE and the OPT-BST 
amplifiers are installed on the east and west sides of the node. Figure 15-4 shows an example of an 
amplified OADM node configuration. 
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15.1.3   OADM Node
Figure 15-4 Amplified OADM Node Configuration Example

Figure 15-5 shows an example of the channel flow on the amplified OADM node. Since the 
32-wavelength plan is based on eight bands (each band contains four channels), optical adding and 
dropping can be performed at the band level and/or at the channel level (meaning individual channels 
can be dropped). 
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15.1.3   OADM Node
Figure 15-5 Amplified OADM Node Channel Flow Example

Figure 15-6 shows an example of a passive OADM node configuration. The passive OADM node is 
equipped with a band filter, one four-channel multiplexer/demultiplexer, and a channel filter on each side 
of the node. 
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15.1.3   OADM Node
Figure 15-6 Passive OADM Node Configuration Example

Figure 15-7 shows an example of traffic flow on the passive OADM node. The signal flow of the 
channels is the same as the amplified OADM, except that the Optical Service Channel and 
Combiner/Separator Module (OSC-CSM) card is used instead of the OPT-BST amplifier and the OSCM 
card.

Figure 15-7 Passive OADM Node Channel Flow Example
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15.1.4   ROADM Node
15.1.4 ROADM Node
A reconfigurable OADM (ROADM) node allows you to add and drop wavelengths without changing the 
physical fiber connections. ROADM nodes are equipped with two 32WSS cards. 32DMX or 32DMX-O 
demultiplexers are typically installed, but are not required. Transponders (TXPs) and muxponders 
(MXPs) can be installed in Slots 6 and 12 and, if amplification is not used, in any open slot. Figure 15-4 
shows an example of an amplified ROADM node configuration. 

Figure 15-8 ROADM Node with BST-PRE, OPT-BST, and 32DMX Cards Installed

If the ROADM node receives a tilted optical signal, you can replace the single-slot 32DMX card with 
the double-slot 32DMX-O card to equalize the signal at the optical channel layer instead of the transport 
section layer. However, if 32DMX-O cards are installed, Slots 6 and 12 cannot be used for TXP or MXP 
cards. Figure 15-6 shows an example of an ROADM with 32DMX-O cards installed. 
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15.1.4   ROADM Node
Figure 15-9 ROADM Node with BST-PRE, OPT-BST, and 32DMX-O Cards Installed

Figure 15-10 shows an example of a reconfigurable OADM east-to-west optical signal flow. The 
west-to-east optical signal flow follows an identical path through the west OSC-CSM and west 32WSS 
modules. In this example, OSC-CSM modules are installed so OPT-BST modules are not needed.
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15.1.5   Anti-ASE Node
Figure 15-10 ROADM East to West Optical Signal Flow Example

15.1.5 Anti-ASE Node
In a meshed ring network, the ONS 15454 requires a node configuration that prevents amplified 
spontaneous emission (ASE) accumulation and lasing. An anti-ASE node can be created by configuring 
a hub node or an OADM node with some modifications. No channels can travel through the express path, 
but they can be demultiplexed and dropped at the channel level on one side and added and multiplexed 
on the other side. 

The hub node is the preferred node configuration when some channels are connected in pass-through 
mode. For rings that require a limited number of channels, combine AD-xB-xx.x and 4MD-xx.x cards, 
or cascade AD-xC-xx.x cards. See Figure 15-5 on page 15-6.

Figure 15-11 shows an anti-ASE node that uses all wavelengths in the pass-through mode. Use 
Cisco MetroPlanner to determine the best configuration for anti-ASE nodes.

1 The OSC-CSM receives the optical signal. It separates the optical service channel from the optical payload and sends the 
payload to the OPT-PRE module.

2 The OPT-PRE compensates for chromatic dispersion, amplifies the optical payload, and sends it to the 32WSS.

3 The 32WSS splits the signal into two components, one is sent to the DROP-TX port and the other is sent to the EXP-TX 
port. 

4 The drop component goes to the 32DMX where it is attenuated, de-multiplexed, and dropped.

5 The express wavelength set goes to the 32WSS on the other side where it is de-multiplexed. Channels are stopped or 
forwarded based upon their switch states. Forwarded wavelengths are multiplexed and sent to the OSC-CSM module.

6 The OSC-CSM combines the multiplexed payload with the OSC and sends the signal out the transmission line.
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15.1.6   Line Amplifier Node
Figure 15-11 Anti-ASE Node Channel Flow Example

15.1.6 Line Amplifier Node
A line amplifier node is a single ONS 15454 node equipped with OPT-PRE amplifiers or OPT-BST 
amplifiers and TCC2 cards. Attenuators might also be required between each preamplifier and booster 
amplifier to match the optical input power value and to maintain the amplifier gain tilt value. 

Two OSCM cards are connected to the east or west ports of the booster amplifiers to multiplex the optical 
service channel (OSC) signal with the pass-though channels. If the node does not contain OPT-BST 
amplifiers, you must use OSC-CSM cards rather than OSCM cards in your configuration. Figure 15-12 
shows an example of a line node configuration. 
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15.1.7   OSC Regeneration Node
Figure 15-12 Line Amplifier Node Configuration Example

15.1.7 OSC Regeneration Node
The OSC regeneration node is added to the DWDM networks for two purposes: 

• To electrically regenerate the OSC channel whenever the span links are 37 dB or longer and payload 
amplification and add/drop capabilities are not present. Cisco MetroPlanner places an OSC 
regeneration node in spans longer than 37 dB. 31 dB is the longest span between the OSC 
regeneration node and the next DWDM network site. 

• To add data communications network (DCN) capability wherever needed within the network.

OSC regeneration nodes require two OSC-CSM cards, as shown in Figure 15-13. 
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Figure 15-13 OSC Regeneration Line Node Configuration Example

Figure 15-14 shows the OSC regeneration node OSC signal flow. 

Figure 15-14 OSC Regeneration Line Site Example
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15.2 Automatic Power Control
The ONS 15454 automatic power control (APC) feature performs the following functions:

• Maintains constant per-channel power when changes to the number of channels occur.

• Compensates for optical network degradation (aging effects).

• Simplifies the installation and upgrade of DWDM optical networks by automatically calculating the 
amplifier setpoints.

Note APC functions are performed by software algorithms on the OPT-BST, OPT-PRE, and TCC2 cards.

Amplifier software uses a control gain loop with fast transient suppression to keep the channel power 
constant regardless of any changes in the number of channels. Amplifiers monitor the changes to the 
input power and change the output power according to the calculated gain setpoint. The shelf controller 
software emulates the control output power loop to adjust for fiber degradation. To perform this function, 
the TCC2 needs to know the channel distribution, which is provided by a signaling protocol, and the 
expected per-channel power, which you can provision. The TCC2 compares the actual amplifier output 
power with the expected amplifier output power and modifies the setpoints if any discrepancies occur.

15.2.1 APC at the Amplifier Card Level
In constant gain mode, the amplifier power out control loop performs the following input and output 
power calculations, where G represents the gain and t represents time.

Pout (t) = G * Pin (t) (mW)

Pout (t) = G + Pin (t) (dB)

In a power-equalized optical system, the total input power is proportional to the number of channels. The 
amplifier software compensates for any variation of the input power due to changes in the number of 
channels carried by the incoming signal. 

Amplifier software identifies changes in the read input power in two different instances, t1 and t2 as a 
change in the carried traffic. The letters m and n in the following formula represent two different channel 
numbers. Pin/ch represents the per-channel input power:

Pin (t1)= nPin/ch

Pin (t2) = mPin/ch

Amplifier software applies the variation in the input power to the output power with a reaction time that 
is a fraction of a millisecond. This keeps the power constant on each channel at the output amplifier, even 
during a channel upgrade or a fiber cut.

Amplifier parameters are configured using east and west conventions for ease of use. Selecting west 
provisions parameters for the preamplifier receiving from the west and the booster amplifier transmitting 
to the west. Selecting east provisions parameters for the preamplifiers receiving from the east and the 
booster amplifier transmitting to the east. 

Starting from the expected per-channel power, the amplifiers automatically calculate the gain setpoint 
after the first channel is provisioned. An amplifier gain setpoint is calculated in order to make it equal 
to the loss of the span preceding the amplifier itself. After the gain is calculated, the setpoint is no longer 
changed by the amplifier. Amplifier gain is recalculated every time the number of provisioned channels 
returns to zero. If you need to force a recalculation of the gain, move the number of channels back to 
zero.
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15.2.2 APC at the Node and Network Levels
The amplifier adjusts the gain to compensate for span loss. Span loss changes due to aging fiber and 
components, or changes in operating conditions. To correct the gain or express variable optical 
attenuator (VOA) setpoints, APC calculates the difference between the power value read by the 
photodiodes and the expected power value. The expected power values is calculated using:

• Provisioned per-channel power value

• Channel distribution (the number of express, add, and drop channels in the node)

• ASE estimation

Channel distribution is determined by the sum of the provisioned and failed channels. Information about 
provisioned wavelengths is sent to APC on the applicable nodes during circuit creation. Information 
about failed channels is collected through a signaling protocol that monitors alarms on ports in the 
applicable nodes and distributes that information to all the other nodes in the network.

ASE calculations purify the noise from the power level reported from the photodiode. Each amplifier can 
compensate for its own noise, but cascaded amplifiers cannot compensate for ASE generated by 
preceding nodes. The ASE effect increases when the number of channels decreases; therefore, a 
correction factor must be calculated in each amplifier of the ring to compensate for ASE build-up.

APC is a network-level feature. The APC algorithm designates a master node that is responsible for 
starting APC hourly or every time a new circuit is provisioned or removed. Every time the master node 
signals for APC to start, gain and VOA setpoints are evaluated on all nodes in the network. If corrections 
are needed in different nodes, they are always performed sequentially following the optical paths starting 
from the master node.

APC corrects the power level only if the variation exceeds the hysteresis thresholds of +/– 0.5 dB. Any 
power level fluctuation within the threshold range is skipped since it is considered negligible. Because 
APC is designed to follow slow time events, it skips corrections greater than 3 dB. This is the typical 
total aging margin that is provisioned during the network design phase. After you provision the first 
channel or the amplifiers are turned up for the first time, APC does not apply the 3 dB rule. In this case, 
APC corrects all the power differences to turn up the node. 

Note Software R4.7 does not report corrections that are not performed and exceed the 3 dB correction factor 
to management interfaces (Cisco Transport Controller [CTC], Cisco Transport Manager [CTM], and 
Transaction Language One [TL1]).

To avoid large power fluctuations, APC adjusts power levels incrementally. The maximum power 
correction is +/– 0.5 dB. This is applied to each iteration until the optimal power level is reached. For 
example, a gain deviation of 2 dB is corrected in four steps. Each of the four steps requires a complete 
APC check on every node in the network. APC can correct up to a maximum of 3 dB on an hourly basis. 
If degradation occurs over a longer time period, APC will compensate for it by using all margins that 
you provision during installation.

When no margin is available, adjustments cannot be made because setpoints exceed ranges. APC 
communicates the event to CTC, CTM, and TL1 through an APC Fail condition. APC will clear the APC 
fail condition when the setpoints return to the allowed ranges.

APC automatically disables itself when:

• A HW FAIL alarm is raised by any card in any of the network nodes.

• A Mismatch Equipment Alarm (MEA) is raised by any card in any of the network nodes.

• An Improper Removal alarm is raised by any card in any of the network nodes.
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• Gain Degrade, Power Degrade, and Power Fail Alarms are raised by the output port of any amplifier 
card in any of the network nodes.

• A VOA degrade or Fail alarm is raised by any of the cards in any of the network nodes.

The APC state (Enable/Disable) is located on every node and can be retrieved by the CTC or TL1 
interfaces. If an event that disables APC occurs in one of the network nodes, APC is disabled on all the 
others and the APC state changes to DISABLE - INTERNAL. The disabled state is raised only by the 
node where the problem occurred to simplify troubleshooting. 

APC raises the following standing conditions at the port level in CTC, TL1, and SNMP:

• APC Out of Range—APC cannot assign a new setpoint for a parameter this is allocated to a port 
because the new setpoint exceeds the parameter range.

• APC Correction Skipped—APC skipped a correction to one parameter allocated to a port because 
the difference between the expected and current values exceeds the +/– 3 dB security range.

After the error condition is cleared, signaling protocol enables APC on the network and the APC 
DISABLE - INTERNAL condition is cleared. Because APC is required after channel provisioning to 
compensate for ASE effects, all optical channel network connection (OCHNC) circuits that you 
provision during the disabled APC state are kept in the Out-of-Service and Autonomous, Automatic 
In-Service (OOS-AU,AINS [ANSI]) or Unlocked-disabled,automaticInService (ETSI) service state 
until APC is enabled. OCHNCs automatically go into the In-Service and Normal (IS-NR [ANSI]) or 
Unlocked-enabled (ETSI) service state only after APC is enabled.

15.2.3 Managing APC
The automatic power control status is indicated by four APC states shown in the node view status area:

• Enable—APC is enabled.

• Disable - Internal—APC has been automatically disabled for an internal cause.

• Disable - User—APC was disabled manually by a user. 

• Not Applicable—The node is provisioned to Metro Access or Not DWDM, which do not support 
APC.

You can view the automatic power control information and disable and enable APC manually on the 
Maintenance > DWDM > APC subtab (Figure 15-15). 

Caution When APC is disabled, aging compensation is not applied and circuits cannot be activated. Do not 
disable APC unless it is required for specific maintenance or troubleshooting tasks. Always enable APC 
as soon as the tasks are completed.
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Figure 15-15 Automatic Power Control

The APC subtab provides the following information:

• Slot ID—The ONS 15454 slot number for which APC information is shown.

• Port—The port number for which APC information is shown.

• Card—The card for which power control information is shown.

• Last Modification—Date and time APC last modified a setpoint for the parameters shown in 
Table 15-1. 

• Last Check—Date and time APC last verified the setpoints for the parameters shown in Table 15-1.

APC State

11
59

57

Table 15-1 APC-Managed Parameters

Card Port Parameters

OPT-BST LINE-3-TX • Gain

• Total Signal Output Power

OPT-PRE LINE-1-TX • Gain

• Total Signal Output Power

AD-xB-xx.x LINE-1-TX

BAND-i-TX

VOA Target Attenuation

AD-1C-xx.x

AD-2C-xx.x

LINE-1-TX VOA Target Attenuation
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15.3 ROADM Power Equalization Monitoring
Reconfigurable OADM (ROADM) nodes allow you to monitor the 32WSS card equalization functions 
on the Maintenance > DWDM > Power Monitoring subtab (Figure 15-16). The tab shows the input 
channel power (Padd), the express or pass-through (Ppt) power and the power level at output (Pout).

Figure 15-16 Power Monitoring Subtab

15.4 Span Loss Verification
Span loss measurements can be performed from the Maintenance > DWDM > WDM Span Check subtab 
(Figure 15-17). The CTC span check compares the far-end OSC power with the near-end OSC power. A 
“Span Loss Out of Range” condition is raised when the measured span loss is higher than the maximum 
expected span loss. It is also raised when the measured span loss is lower than the minimum expected 
span loss and the difference between the minimum and maximum span loss values is greater than 1 dB. 
The minimum and maximum expected span loss values are calculated by Cisco MetroPlanner for the 
network and imported into CTC. However, you can manually change the minimum and expected span 
loss values.

AD-4C-xx.x LINE-1-TX

CHAN-i-TX

VOA Target Attenuation

32-DMX LINE-1-TX VOA Target Attenuation

Table 15-1 APC-Managed Parameters (continued)

Card Port Parameters
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CTC span loss measurements provide a quick span loss check and are useful whenever changes to the 
network occur, for example after you install equipment or repair a broken fiber. CTC span loss 
measurement resolutions are:

• +/– 1.5 dB for measured span losses between 0 and 25 dB

• +/– 2.5 dB for measured span losses between 25 and 38 dB

For ONS 15454 span loss measurements with higher resolutions, an optical time domain reflectometer 
(OTDR) must be used. 

Figure 15-17 Span Loss Verification

15.5 Automatic Node Setup
Automatic node setup (ANS) is a TCC2 function that adjusts values of the VOAs on the DWDM channel 
paths to equalize the per-channel power at the amplifier input. This power equalization means that at 
launch, all the channels have the same amplifier power level, independent from the input signal on the 
client interface and independent from the path crossed by the signal inside the node. This equalization 
is needed for two reasons:

• Every path introduces a different penalty on the signal that crosses it.

• Client interfaces add their signal to the ONS 15454 DWDM ring with different power levels.
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To support ANS, the integrated VOAs and photodiodes are provided in the following ONS 15454 
DWDM cards:

• OADM band cards (AD-xB-xx.x) express and drop path

• OADM channel cards (AD-xC-xx.x) express and add path

• 4-Channel Terminal Multiplexer/Demultiplexer (4MD-xx.x) input port

• 32-Channel Terminal Multiplexer (32MUX-O) input port

• 32-Channel Wavelength Selective Switch (32WSS) input port

• 32-Channel Terminal Demultiplexer (32DMX-O and 32DMX) output port 

Optical power is equalized by regulating the VOAs. Based on the expected per-channel power, ANS 
automatically calculates the VOA values by:

• Reconstructing the different channels paths

• Retrieving the path insertion loss (stored in each DWDM transmission element) 

VOAs operate in one of three working modes:

• Automatic VOA Shutdown—In this mode, the VOA is set at maximum attenuation value. Automatic 
VOA shutdown mode is set when the channel is not provisioned to ensure system reliability in the 
event that power is accidentally inserted.

• Constant Attenuation Value—In this mode, the VOA is regulated to a constant attenuation 
independent from the value of the input signal. Constant attenuation value mode is set on the 
following VOAs:

– OADM band card VOAs on express and drop paths (as operating mode)

– OADM channel card VOAs during power insertion startup

– The multiplexer/demultiplexer card VOAs during power insertion startup

• Constant Power Value—In this mode, the VOA values are automatically regulated to keep a constant 
output power when changes occur to the input power signal. This working condition is set on OADM 
channel card VOAs as “operating” and on 32MUX-O, 32WSS, 32DMX-O, and 32DMX card VOAs 
as “operating mode.”

In the normal operating mode, OADM band card VOAs are set to a constant attenuation, while OADM 
channel card VOAs are set to a constant power. ANS requires the following VOA provisioning 
parameters to be specified:

• Target attenuation (OADM band card VOA and OADM channel card startup)

• Target power (channel VOA)

To allow you to modify ANS values based on your DWDM deployment, provisioning parameters are 
divided into two contributions:

• Reference Contribution (read only)—Set by ANS.

• Calibration Contribution (read and write)—Set by user.

The ANS equalization algorithm requires the following knowledge of the DWDM transmission element 
layout:

• The order in which the DWDM elements are connected together on the express paths

• Channels that are dropped and added

• Channels or bands that have been configured as pass through
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ANS assumes that every DWDM port has a line direction parameter that is either west to east (W-E) or 
east to west (E-W). ANS automatically configures the mandatory optical connections according to 
following main rules: 

• Cards equipped in Slots 1 to 6 have a drop section facing west.

• Cards equipped in Slots 12 to 17 have a drop section facing east.

• Contiguous cards are cascaded on the express path.

• 4MD-xx.x and AD-xB-xx.x are always optically coupled.

• A 4MD-xx.x absence forces an optical pass-through connection.

• Transmit (Tx) ports are always connected to receive (Rx) ports.

Optical patch cords are passive devices that are not autodiscovered by ANS. However, optical patch 
cords are used to build the alarm correlation graph. From CTC or TL1 you can:

• Calculate the default connections on the NE.

• Retrieve the list of existing connections.

• Retrieve the list of free ports.

• Create new connections or modify existing ones.

• Launch ANS.

After you launch ANS, the following status are provided for each ANS parameter:

• Success - Changed—The parameter setpoint was recalculated successfully.

• Success - Unchanged—The parameter setpoint did not need recalculation.

• Not Applicable—The parameter setpoint does not apply to this node type.

• Fail - Out of Range—The calculated setpoint is outside the expected range. 

• Fail - Port in IS State—The parameter could not be calculated because the port is in-service. 

Optical connections are identified by the two termination points, each with an assigned slot and port. 
ANS checks that a new connection is feasible (according to embedded connection rules) and returns a 
denied message in the case of a violation.

ANS requires provisioning of the expected wavelength. When provisioning the expected wavelength, the 
following rules apply:

• The card name is generically characterized by the card family, and not the particular wavelengths 
supported (for example, AD-2C for all 2-channel OADMs).

• At the provisioning layer, you can provision a generic card for a specific slot using CTC or TL1. 

• Wavelength assignment is done at the port level.

• An equipment mismatch alarm is raised when a mismatch between the identified and provisioned 
value occurs. The default value for the provisioned attribute is AUTO.

15.5.1 Automatic Node Setup Parameters
All ONS 15454 ANS parameters are calculated by Cisco MetroPlanner for nodes configured for metro 
core networks. (Parameters must be configured manually for metro access nodes.) Cisco MetroPlanner 
exports the calculated parameters to an ASCII file called “NE Update.” In CTC, you can import the NE 
Update file to automatically provision the node. Table 15-2 shows ANS parameters arranged in east and 
west, transmit and receive groups.
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Table 15-2 ANS Parameters

Direction ANS Parameters

West Side - Receive • West Side Rx Max Expected Span Loss

• West Side Rx Min Expected Span Loss

• West Side Rx Amplifier Working Mode

• West Side Rx Amplifier Ch Power

• West Side Rx Amplifier Gain

• West Side Rx Amplifier Tilt

• West Side OSC LOS Threshold 

• West Side Channel LOS Threshold

• West Side Rx Amplifier Input Power Fail Th

• West Side Add and Drop Stage Input Power

• West Side Add and Drop Stage Drop Power

• West Side Add and Drop Stage Band (i) Drop Power (i = 1..8)

• West Side Add and Drop Stage Channel (i) Drop Power (i = 1..32)

East Side - Receive • East Side Rx Max Expected Span Loss

• East Side Rx Min Expected Span Loss

• East Side Rx Amplifier Working Mode

• East Side Rx Amplifier Ch Power

• East Side Rx Amplifier Gain

• East Side Rx Amplifier Tilt

• East Side OSC LOS Threshold 

• East Side Channel LOS Threshold

• East Side Rx Amplifier Input Power Fail Th

• East Side Add and Drop Stage Input Power

• East Side Add and Drop Stage Drop Power

• East Side Add and Drop Stage Band (i) Drop Power (i = 1..8

• East Side Add and Drop Stage Channel (i) Drop Power (i = 1..32)
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15.5.2 Viewing and Provisioning ANS Parameters
All ANS parameters can be viewed and provisioned from the node view Provisioning > WDM-ANS > 
Provisioning subtab, shown in Figure 15-18. The WDM-ANS > Provisioning > Provisioning subtab 
presents the parameters in the following tree view:

root

+/– East

• +/– Receiving

– +/– Amplifier

– +/– Power

– +/– Threshold

• +/– Transmitting

– +/– Amplifier

– +/– Power

– +/– Threshold

+/– West

• +/– Receiving

– +/– Amplifier

– +/– Power

– +/– Threshold

• +/– Transmitting

West Side - Transmit • West Side Tx Amplifier Working Mode

• West Side Tx Amplifier Ch Power

• West Side Tx Amplifier Gain

• West Side Tx Amplifier Tilt

• West Side Fiber Stage Input Threshold

• West Side Add and Drop Stage Output Power

• West Side Add and Drop Stage By-Pass Power

East Side - Transmit • East Side Tx Amplifier Working Mode

• East Side Tx Amplifier Ch Power

• East Side Tx Amplifier Gain

• East Side Tx Amplifier Tilt

• East Side Fiber Stage Input Threshold

• East Side Add and Drop Stage Output Power

• East Side Add and Drop Stage By-Pass Power

Table 15-2 ANS Parameters (continued)

Direction ANS Parameters
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– +/– Amplifier

– +/– Power

– +/– Threshold

Figure 15-18 WDM-ANS Provisioning

Table 15-3 shows the parameter IDs based on platform, line-direction, and functional group.
11

57
17

Parameter tree view ANS parameters Parameter values

Table 15-3 ANS-WDM > Provisioning Subtab Parameters

Tree Element Parameters

root Network Type (dwdm)

root +/– East +/– Receiving East Side Rx Max Expected Span Loss

East Side Rx Min Expected Span Loss

root +/– East +/– Receiving +/– Amplifier East Side Rx Amplifier Working Mode

East Side Rx Amplifier Ch Power

East Side Rx Amplifier Gain

East Side Rx Amplifier Tilt
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root +/– East +/– Receiving +/– Power East Side Add and Drop Input Power

East Side Add and Drop Drop Power

East Side Band n Drop Power (n = 1-8)

East Side Channel n Drop Power East (n = 1-32)

root +/– East +/– Receiving +/– Thresholds East Side OSC LOS Threshold

East Side Channel LOS Threshold

East Side Rx Amplifier In Power Fail Th

root +/– East +/– Transmitting +/– Amplifier East Side Tx Amplifier Working Mode

East Side Tx Amplifier Ch Power

East Side Tx Amplifier Gain

East Side Tx Amplifier Tilt

root +/– East +/– Transmitting +/– Power East Side Add and Drop Output Power

East Side Add and Drop By-Pass Power

root +/– East +/– Transmitting +/– Thresholds East Side Fiber Stage Input Threshold

root +/– West +/– Receiving West Side Rx Max Expected Span Loss

West Side Rx Min Expected Span Loss

root +/– West +/– Receiving +/– Amplifier West Side Rx Amplifier Working Mode

West Side Rx Amplifier Ch Power

West Side Rx Amplifier Gain

West Side Rx Amplifier Tilt

root +/– West +/– Receiving +/– Power West Side Add and Drop Input Power

West Side Add and Drop Drop Power

West Side Band n Drop Power (n = 1-8)

West Side Channel n Drop Power (n = 1-32)

root +/– West +/– Receiving +/– Thresholds West Side OSC LOS Threshold

West Side Channel LOS Threshold

West Side Rx Amplifier In Power Fail Th

root +/– West +/– Transmitting +/– Amplifier West Side Tx Amplifier Working Mode

West Side Tx Amplifier Ch Power

West Side Tx Amplifier Gain

West Side Tx Amplifier Tilt

root +/– East +/– Transmitting +/– Power West Side Add and Drop Output Power

West Side Add and Drop By-Pass Power

root +/– West +/– Transmitting +/– Thresholds West Side Fiber Stage Input Threshold

Table 15-3 ANS-WDM > Provisioning Subtab Parameters (continued)

Tree Element Parameters
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The ANS parameters that appear in the WDM-ANS > Provisioning subtab depend on the node type. 
Table 15-4 shows the DWDN node types and their ANS parameters.

Table 15-4 ANS Parameters By Node Type

Node Type Parameter Group Parameters

Hub Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power 

East and West Side Add and Drop Output Power 

East and West Side Add and Drop By-Pass Power

East and West Side Channel (n) Drop Power
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Terminal Network Network Type

Span Loss East or West Expected Span Loss

Amplifier Tx East or West Side Transmit Amplifier Working Mode

East or West Side Transmit Amplifier Channel Power

East or West Side Transmit Amplifier Gain

East or West Side Transmit Amplifier Tilt

Amplifier Rx East or West Side Receive Amplifier Working Mode

East or West Side Receive Amplifier Channel Power

East or West Side Receive Amplifier Gain

East or West Side Receive Amplifier Tilt

Thresholds Tx East or West Side Fiber Stage Input Threshold

Thresholds Rx East or West Side Osc Los Threshold

East or West Side Channel Los Threshold

East or West Side Receive Amplifier Input Power Fail

Power East or West Side Add and Drop Input Power 

East or West Side Add and Drop Output Power 

East or West Side Channel (n) Drop Power (n = 1-32)

Flexible Channel 
Count Terminal

Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power 

East and West Side Add and Drop Output Power

East and West Side Band (n) Drop Power (n = 1-8)

Table 15-4 ANS Parameters By Node Type (continued)

Node Type Parameter Group Parameters
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OADM Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power 

East and West Side Add and Drop Output Power 

East and West Side Band (n) Drop Power (n = 1-8)

Line Amplifier Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Table 15-4 ANS Parameters By Node Type (continued)

Node Type Parameter Group Parameters
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15.5.2   Viewing and Provisioning ANS Parameters
Table 15-5 shows the following information for all ONS 15454 ANS parameters: 

• Min—Minimum value in decibels.

• Max—Maximum value in decibels.

• Def—Default value in decibels. Other defaults include MC (metro core), CG (control gain), 
U (unknown).

• Group—Group(s) to which the parameter belongs: ES (east side), WS (west side), Rx (receive), 
Tx (transmit), Amp (amplifier), P (power), DB (drop band), DC (drop channel), A (attenuation), 
Th (threshold).

• Network Type—Parameter network type: MC (metro core), MA (metro access), ND (not DWDM)

• Optical Type—Parameter optical type: TS (32 channel terminal), FC (flexible channel count 
terminal), O (OADM), H (hub), LS (line amplifier), R (ROADM), U (unknown)

ROADM Network Network Type

Span Loss East and West Expected Span Loss

Amplifier Tx East and West Side Transmit Amplifier Working Mode

East and West Side Transmit Amplifier Channel Power

East and West Side Transmit Amplifier Gain

East and West Side Transmit Amplifier Tilt

Amplifier Rx East and West Side Receive Amplifier Working Mode

East and West Side Receive Amplifier Channel Power

East and West Side Receive Amplifier Gain

East and West Side Receive Amplifier Tilt

Thresholds Tx East and West Side Fiber Stage Input Threshold

Thresholds Rx East and West Side Osc Los Threshold

East and West Side Channel Los Threshold

East and West Side Receive Amplifier Input Power Fail

Power East and West Side Add and Drop Input Power (if 32DMX 
East/West is installed)

East and West Side Add and Drop Output Power 

East and West Side Add and Drop Drop Power (if 32DMX 
East/West is installed)

East and West Side Channel (n) Drop Power (if 32DMX-O 
East/West is installed)

Table 15-4 ANS Parameters By Node Type (continued)

Node Type Parameter Group Parameters

Table 15-5 ANS Parameters Summary

General Name Min Max Def Group Network Type Optical Type

Network Type – – MC Root MC, MA, ND U, TS, FC, O, H, LS, R

West Side Rx Max Expected Span Loss 0 60 60 WS, Rx MC, MA TS, FC, O, H, LS, R
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15.5.2   Viewing and Provisioning ANS Parameters
East Side Rx Max Expected Span Loss 0 60 60 ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Rx Min Expected Span Loss 0 60 60 WS, Rx MC, MA TS, FC, O, H, LS, R

East Side Rx Min Expected Span Loss 0 60 60 ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Tx Amplifier Working Mode – – CG WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Tx Amplifier Working Mode – – CG ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Rx Amplifier Working Mode – – CG WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Rx Amplifier Working Mode – – CG ES, Rx MC, MA TS, FC, O, H, LS, R

West Side Tx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Tx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

West Side Rx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

East Side Rx Amplifier Ch Power –10 17 2 WS, Tx, Amp MC, MA, ND TS, FC, O, H, LS, R

West Side Tx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS, R

East Side Tx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS. R

West Side Rx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS, R

East Side Rx Amplifier Gain 0 30 0 WS, Tx, Amp MA TS, FC, O, H, LS, R

West Side Tx Amplifier Tilt 0 30 0 WS, Tx, Amp MC, MA TS, FC, O, H, LS, R

East Side Tx Amplifier Tilt 0 30 0 WS, Tx, Amp MC, MA TS, FC, O, H, LS, R

West Side Rx Amplifier Tilt 0 30 0 WS, Rx, Amp MC, MA TS, FC, O, H, LS, R

East Side Rx Amplifier Tilt 0 30 0 WS, Rx, Amp MC, MA TS, FC, O, H, LS, R

West Side OSC LOS Threshold –50 30 U WS, Rx, Th MC, MA TS, FC, O, H, LS, R

East Side OSC LOS Threshold –50 30 U WS, Rx, Th MC, MA TS, FC, O, H, LS, R

West Side Channel LOS Threshold –50 30 U WS, Rx, Th MC, MA TS, FC, O, H, LS, R

East Side Channel LOS Threshold –50 30 U ES, Rx, Th MC, MA, ND TS, FC, O, H, LS, R

West Side Fiber State Input Threshold –50 30 U WS, Tx, Th MC, MA, ND TS, FC, O, H, LS, R

East Side Fiber State Input Threshold –50 30 U ES, Tx, Th MC, MA, ND TS, FC, O, H, LS, R

West Side Add and Drop Output Power –50 30 –14 WS, Tx, P MC TS, FC, O, H, R

East Side Add and Drop Output Power –50 30 –14 ES, Tx, P MC TS, FC, O, H, R

West Side Add and Drop Input Power –50 30 –14 WS, Rx, P MC TS, FC, O, H, R

East Side Add and Drop Input Power –50 30 –14 ES, Rx, P MC TS, FC, O, H, R

West Side Add and Drop By-Pass Power –50 30 –14 WS, Tx, P MC H

East Side Add and Drop By-Pass Power –50 30 –14 ES, Tx, P MC H

West Side Add and Drop Drop Power –50 30 –14 WS, Tx, P MC R

East Side Add and Drop Drop Power –50 30 –14 ES, Tx, P MC R

West Side Band 1...8 Drop Power –50 30 –14 WS, Rx, P, DB MC FC, O

East Side Band 1...8 Drop Power –50 30 –14 ES, Rx, P, DB MC FC, O

Table 15-5 ANS Parameters Summary (continued)

General Name Min Max Def Group Network Type Optical Type
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15.5.2   Viewing and Provisioning ANS Parameters
West Side Channel 1...32 Drop Power –50 30 –14 WS, Rx, P, DC, B1 MC, MA TS, H, R

East Side Channel 1...32 Drop Power –50 30 –14 ES, Rx, P, DC, B1 MC, MA TS, H, R

Table 15-5 ANS Parameters Summary (continued)

General Name Min Max Def Group Network Type Optical Type
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15.5.2   Viewing and Provisioning ANS Parameters
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C H A P T E R 16

DWDM Network Reference

This chapter explains the ONS 15454 dense wavelength division multiplexing (DWDM) network 
applications and topologies. The chapter also provides network-level optical performance references. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 16.1 Network Applications, page 16-1

• 16.2 Network Topologies, page 16-1

• 16.3 Optical Performance, page 16-6

• 16.4 Network Optical Safety - Automatic Laser Shutdown, page 16-18

16.1 Network Applications
Cisco ONS 15454s can be provisioned for metro access and metro core DWDM network applications. 
Metro access networks are 60 km or less in size. Channels are not equalized and dispersion compensation 
is not applied. Metro access networks have few spans and very low span loss, so the signal link budget 
is the limiting factor for performance. Metro core networks can be up to 400 km in size. The channel 
power is equalized and dispersion compensation is applied. Metro core networks often include multiple 
spans and amplifiers, so the optical signal-to-noise ratio (OSNR) is the limiting factor for channel 
performance in metro core networks.

Within DWDM networks, the ONS 15454 uses a communications protocol, called node services protocol 
(NSP), to communicate with other nodes. NSP automatically updates nodes whenever a change in the 
network occurs. Each ONS 15454 DWDM node can: 

• Identify other ONS 15454 DWDM nodes in the network.

• Identify the different types of DWDM networks.

• Identify when the DWDM network is complete and when it is incomplete.

16.2 Network Topologies
The ONS 15454 DWDM network topologies include hubbed, multihubbed, and meshed rings, and linear 
and single-span networks
16-1
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16.2.1   Hubbed Rings
16.2.1 Hubbed Rings
In the hubbed ring topology (Figure 16-1), a hub node terminates all the DWDM channels. A channel 
can be provisioned to support protected traffic between the hub node and any node in the ring. Both 
working and protected traffic use the same wavelength on both sides of the ring. Protected traffic can 
also be provisioned between any pair of optical add/drop multiplexing (OADM) nodes, except that either 
the working or the protected path must be regenerated in the hub node. 

Protected traffic saturates a channel in a hubbed ring, that is, no channel reuse is possible. However, the 
same channel can be reused in difference sections of the ring by provisioning unprotected multihop 
traffic. From a transmission point of view, this network topology is similar to two bidirectional 
point-to-point links with OADM nodes.

For more information about hub nodes, see the “15.1.1 Hub Node” section on page 15-1.

Figure 16-1 Hubbed Ring

16.2.2 Multihubbed Rings
A multihubbed ring (Figure 16-2) is based on the hubbed ring topology, except that two or more hub 
nodes are added. Protected traffic can only be established between the two hub nodes. Protected traffic 
can be provisioned between a hub node and any OADM node only if the allocated wavelength channel 
is regenerated through the other hub node. Multihop traffic can be provisioned on this ring. From a 
transmission point of view, this network topology is similar to two or more point-to-point links with 
OADM nodes.
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16.2.3   Any-to-Any Rings
Figure 16-2 Multihubbed Ring

16.2.3 Any-to-Any Rings
The any-to-any ring topology (Figure 16-2) contains only reconfigurable OADM (ROADM) nodes, or 
ROADM nodes with Optical Service Channel (OSC) regeneration or amplifier nodes. This topology 
potentially allows you to route every wavelength from any source to any destination node inside the 
network.

For more information about ROADM nodes, see the “15.1.4 ROADM Node” section on page 15-8.
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16.2.4   Meshed Rings
Figure 16-3 Any-to-Any Ring

16.2.4 Meshed Rings
The meshed ring topology (Figure 16-4) does not use hubbed nodes; only amplified and passive OADM 
nodes are present. Protected traffic can be provisioned between any two nodes; however, the selected 
channel cannot be reused in the ring. Unprotected multihop traffic can be provisioned in the ring. A 
meshed ring must be designed to prevent amplified spontaneous emission (ASE) lasing. This is done by 
configuring a particular node as an anti-ASE node. An anti-ASE node can be created in two ways:

• Equip an OADM node with 32MUX-O cards and 32DMX-O cards. This solution is adopted when 
the total number of wavelengths deployed in the ring is higher than ten. OADM nodes equipped with 
32MUX-O cards and 32DMX-O cards are called full OADM nodes.

• When the total number of wavelengths deployed in the ring is lower than ten, the anti-ASE node is 
configured by using an OADM node where all the channels that are not terminated in the node are 
configured as “optical pass-through.” In other words, no channels in the anti-ASE node can travel 
through the express path of the OADM node. 

For more information about OADM nodes, see the “15.1.3 OADM Node” section on page 15-4. For 
more information about anti-ASE nodes, see the “15.1.5 Anti-ASE Node” section on page 15-10.
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16.2.5   Linear Configurations
Figure 16-4 Meshed Ring

16.2.5 Linear Configurations
Linear configurations are characterized by the use of two terminal nodes (west and east). The terminal 
nodes can be equipped with a 32MUX-O card and a 32DMX-O card, or a 32WSS card with 32DMX or 
32DMX-O card. OADM or line amplifier nodes can be installed between the two terminal nodes. Only 
unprotected traffic can be provisioned in a linear configuration. Figure 16-5 shows five ONS 15454 
nodes in a linear configuration with an amplified and a passive OADM node. 

Figure 16-5 Linear Configuration with an OADM Node

Figure 16-6 shows five ONS 15454 nodes in a linear configuration without an OADM node.

For more information about terminal nodes, see the “15.1.2 Terminal Node” section on page 15-3.
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16.2.6   Single-Span Link
Figure 16-6 Linear Configuration without an OADM Node

16.2.6 Single-Span Link
Single-span link is a type of linear configuration characterized by a single-span link with 
pre-amplification and post-amplification. A single-span link is also characterized by the use of two 
terminal nodes (west and east). The terminal nodes are usually equipped with a 32MUX-O card and a 
32DMX-O card. However, a 32WSS card and a 32DMX or a 32DMX-O card can be installed. Software 
R4.7 also supports single-span links with AD-4C-xx.x cards. Only unprotected traffic can be provisioned 
on a single-span link. 

Figure 16-7 shows ONS 15454s in a single-span link. Eight channels are carried on one span. 
Single-span link losses apply to OC-192 LR ITU cards. The optical performance values are valid 
assuming that the sum of the OADM passive node insertion losses and the span losses does not exceed 
35 dB.

Figure 16-7 Single-Span Link

16.3 Optical Performance
This section provides optical performance information for ONS 15454 DWDM networks. The 
performance data is a general guideline based upon the network topology, node type, client cards, fiber 
type, number of spans, and number of channels. The maximum number of nodes that can be in an 
ONS 15454 DWDM network is 16. The DWDM topologies and node types that are supported are shown 
in Table 16-1.
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16.3   Optical Performance
DWDM client cards are grouped into nine classes, shown in Table 16-2. Span loss estimates are based 
on the number of spans in the network and the client card class. Some cards belong to more than one 
class depending on whether forward error correction (FEC) is enabled and on the payload data type 
provisioned for the card.

Table 16-1 Supported Topologies, and Node Types

Number of Channels Fiber Topologies Node Type

32 channels SMF-281

E-LEAF2

TW-RS3

1. SMF-28 = single-mode fiber 28

2. E-LEAF = enhanced large effective area fiber

3. TW-RS = TrueWave reduced slope fiber

Ring

Linear

Linear without OADM

Hub

Active OADM

Passive OADM

Terminal

Line

OSC regeneration

16 channels SMF-28 Ring

Linear

Linear without OADM

Hub

Active OADM

Passive OADM

Terminal

Line

OSC regeneration

8 channels SMF-28 Linear without OADM Terminal

Line

Table 16-2 ONS 15454 Client Card Classes

Class Rate Clients

A 10 Gbps TXP_2.5G_10G—FEC enabled

TXP_2.5G_10E—FEC enabled

TXP_MR_10G—FEC enabled

TXP_MR_10E—FEC enabled

B 10 Gbps TXP_2.5G_10G—FEC not enabled

TXP_MR_10G—FEC not enabled

C 10 Gbps OC-192 LR ITU

TXP_2.5G_10E—FEC not enabled

D 2.5 Gbps TXP_MR_2.5G—FEC enabled

TXPP_MR_2.5G—FEC enabled
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16.3.1   Optical Performance for Rings and Linear Networks with OADM Nodes
16.3.1 Optical Performance for Rings and Linear Networks with OADM Nodes
The following tables provide optical performance estimates for open and closed ONS 15454 rings and 
linear networks with OADM nodes. Table 16-3 shows the optical performance for 32-channel networks 
using SMF fiber. Span losses shown in the table assume:

• OADM nodes have a loss of 16 dB and equal span losses.

• Optical Preamplifier (OPT-PRE) and Optical Booster (OPT-BST/OPT-BST-E) amplifiers are 
installed in all nodes.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

Note See Table 16-2 for a list of cards in each class. A dash (—) indicates spans that are not supported.

E 2.5 Gbps TXP_MR_2.5G—3R payload data type; FEC disabled

TXPP_MR_2.5G—3R payload data type; FEC disabled

MXP_MR_2.5G

MXPP_MR_2.5G

F 2.5 Gbps TXP_MR_2.5G—2R payload data type

TXPP_MR_2.5G—2R payload data type

G 2.5 Gbps OC-48 ELR ITU

H 2.5 Gbps 2/4 port Gigabit Ethernet Transponder (GBIC WDM 100 GHz)

I 10 Gbps TXP_2.5G_10E—E-FEC1 enabled

TXP_MR_10E—E-FEC enabled

1. Forward error correction

Table 16-2 ONS 15454 Client Card Classes (continued)

Class Rate Clients

Table 16-3 Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 34 dB 26 dB 26 dB 36 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 28 dB 21 dB 20 dB 30 dB 31 dB 28 dB 25 dB 27 dB 29 dB 25 dB

3 26 dB 17 dB 15 dB 28 dB 29 dB 26 dB 23 dB 25 dB 26 dB 23 dB

4 24 dB — — 25 dB 26 dB 23 dB 20 dB 22 dB 24 dB 20 dB

5 22 dB — — 24 dB 25 dB 22 dB 16 dB 20 dB 23 dB 16 dB

6 20 dB — — 22 dB 24 dB 19 dB — 17 dB 21 dB —

7 181 dB

1. 0.5 dB of OSNR impairment recovered by FEC margin @ BER > 10-6

— — 21 dB 23 dB 16 dB — — 19 dB —
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16.3.1   Optical Performance for Rings and Linear Networks with OADM Nodes
Table 16-4 shows the optical performance for 16-channel networks using SMF fiber. Span loss values 
assume the following:

• OADM nodes have a loss of 16 dB and equal span losses.

• All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

Note See Table 16-2 for client card class definitions. A dash (—) indicates the spans are not available for that 
client class.

Table 16-5 shows the optical performance for 32-channel networks using TW-RS fiber. Span loss values 
assume the following:

• OADM nodes have a loss of 16 dB and equal span losses.

• All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

Note See Table 16-2 for client card class definitions. A dash (—) indicates the spans are not available for that 
client class.

Table 16-4 Span Loss for 16-Channel Ring and Linear Networks with OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 37 dB 29 dB 29 dB 37 dB 37 dB 36 dB 33 dB 35 dB 37 dB 33 dB

2 31 dB 25 dB 24 dB 33 dB 34 dB 31 dB 28 dB 30 dB 32 dB 28 dB

3 28 dB 22 dB 21 dB 30 dB 31 dB 28 dB 26 dB 27 dB 29 dB 26 dB

4 26 dB 19 dB 17 dB 28 dB 29 dB 26 dB 24 dB 25 dB 27 dB 24 dB

5 25 dB — — 26 dB 27 dB 25 dB 22 dB 24 dB 25 dB 22 dB

6 24 dB — — 25 dB 26 dB 24 dB 21 dB 23 dB 24 dB 21 dB

7 23 dB — — 25 dB 25 dB 23 dB 19 dB 22 dB 24 dB 19 dB

Table 16-5 Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using TW-RS Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 34 dB 26 dB 25 dB 36 dB 34 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 29 dB 21 dB 20 dB 31 dB 32 dB 29 dB 26 dB 28 dB 30 dB 26 dB

3 27 dB 17 dB 15 dB 29 dB 30 dB 26 dB 23 dB 25 dB 27 dB 23 dB

4 24 dB — — 26 dB 28 dB 23 dB 20 dB 22 dB 24 dB 20 dB

5 22 dB — — 24 dB 26 dB 22 dB 16 dB 20 dB 23 dB 16 dB

6 20 dB — — 22 dB 24 dB 19 dB — 17 dB 21 dB —

7 18 dB — — 21 dB 23 dB 16 dB — — 19 dB —
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16.3.2   Optical Performance for Linear Networks Without OADM Nodes
Table 16-6 shows the optical performance for 32-channel networks using E-LEAF fiber. Span loss values 
assume the following:

• OADM nodes have a loss of 16 dB and equal span losses.

• All nodes have OPT-PRE and OPT-BST/OPT-BST-E amplifiers installed.

• The OPT-PRE amplifier switches to control power whenever the span loss is higher than 27 dB.

Note See Table 16-2 for client card class definitions. A dash (—) indicates the spans are not available for that 
client class.

16.3.2 Optical Performance for Linear Networks Without OADM Nodes
The following tables list the reference optical performances for linear networks without OADM nodes. 
Table 16-7 shows the optical performance for 32-channel linear networks using SMF fiber. Span loss 
values assume the following:

• No OADM nodes are installed.

• Only OPT-PRE amplifiers are installed.

• Span losses are equal.

Note See Table 16-2 for client card class definitions. A dash (—) indicates the spans are not available for that 
client class.

Table 16-6 Span Loss for 32-Channel Ring and Linear Networks with OADM Nodes Using E-LEAF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 34 dB 26 dB 26 dB 36 dB 34 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 29 dB 21 dB 20 dB 31 dB 32 dB 29 dB 26 dB 28 dB 30 dB 26 dB

3 27 dB 17 dB 15 dB 29 dB 30 dB 26 dB 23 dB 25 dB 27 dB 23 dB

4 23 dB — — 25 dB 28 dB 23 dB 20 dB 22 dB 24 dB 20 dB

5 21 dB — — 23 dB 26 dB 22 dB 16 dB 20 dB 23 dB 16 dB

6 18 dB — — 21 dB 24 dB 19 dB — 17 dB 21 dB —

7 15 dB — — 19 dB 23 dB 16 dB — — 19 dB —

Table 16-7 Span Loss for 32-Channel Linear Networks without OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 34 dB 26 dB 26 dB 36 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 27 dB 21 dB 20 dB 29 dB 30 dB 27 dB 24 dB 26 dB 27 dB 24 dB

3 24 dB 18 dB 18 dB 26 dB 26 dB 24 dB 21 dB 23 dB 24 dB 21 dB

4 23 dB 17 dB 16 dB 24 dB 24 dB 22 dB 20 dB 21 dB 23 dB 20 dB
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16.3.2   Optical Performance for Linear Networks Without OADM Nodes
Table 16-8 shows the optical performance for 32-channel linear networks using TW-RS fiber. Span loss 
values assume the following:

• No OADM nodes are installed.

• Only OPT-PRE amplifiers are installed.

• Span losses are equal.

Note See Table 16-2 for client card class definitions. A dash (—) indicates the spans are not available for that 
client class.

Table 16-9 shows the optical performance for 32-channel linear networks using E-LEAF fiber. Span loss 
values assume the following:

• No OADM nodes are installed.

• Only OPT-PRE amplifiers are installed.

• Span losses are equal.

Note See Table 16-2 for client card class definitions. A dash (—) indicates the spans are not available for that 
client class.

5 21 dB — — 22 dB 23 dB 20 dB 19 dB 20 dB 21 dB 19 dB

6 20 dB — — 21 dB 22 dB 20 dB 18 dB 19 dB 20 dB 18 dB

7 19 dB — — 20 dB 21 dB 19 dB 17 dB 18 dB 19 dB 17 dB

Table 16-7 Span Loss for 32-Channel Linear Networks without OADM Nodes Using SMF Fiber (continued)

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

Table 16-8 Span Loss for 32-Channel Linear Networks without OADM Nodes Using TW-RS Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 34 dB 26 dB 26 dB 36 dB 34 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 28 dB 21 dB 21 dB 30 dB 31 dB 28 dB 25 dB 27 dB 28 dB 25 dB

3 26 dB 18 dB 18 dB 27 dB 28 dB 25 dB 23 dB 24 dB 26 dB 23 dB

4 24 dB 17 dB 16 dB 26 dB 26 dB 24 dB 21 dB 23 dB 24 dB 21 dB

5 23 dB — — 24 dB 25 dB 23 dB 19 dB 22 dB 23 dB 19 dB

6 23 dB — — 24 dB 24 dB 22 dB 18 dB 21 dB 23 dB 18 dB

7 21 dB — — 23 dB 23 dB 20 dB 17 dB 19 dB 21 dB 15 dB
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16.3.2   Optical Performance for Linear Networks Without OADM Nodes
Table 16-10 shows the optical performance for 16-channel linear networks using SMF fiber. Span loss 
values assume the following:

• No OADM nodes are installed.

• Only OPT-PRE amplifiers are installed.

• Span losses are equal.

• The minimum channel power is 4 dBm. 

• Wavelengths are picked up without any restriction from Bands 4 and 5 (1542.14 to 1545.51 nm).

Note See Table 16-2 for client card class definitions.

Table 16-11 shows the optical performance for 8-channel linear networks using SMF fiber. Span loss 
values assume the following:

• No OADM nodes are installed.

• Only OPT-PRE amplifiers are installed.

• Span losses are equal.

Table 16-9 Span Loss for 32-Channel Linear Networks without OADM Nodes Using E-LEAF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 34 dB 26 dB 26 dB 36 dB 34 dB 33 dB 30 dB 32 dB 34 dB 30 dB

2 28 dB 21 dB 21 dB 30 dB 31 dB 28 dB 25 dB 27 dB 28 dB 25 dB

3 26 dB 18 dB 18 dB 27 dB 28 dB 25 dB 23 dB 24 dB 26 dB 23 dB

4 24 dB 17 dB 16 dB 25 dB 26 dB 24 dB 21 dB 23 dB 24 dB 21 dB

5 23 dB — — 24 dB 25 dB 23 dB 19 dB 22 dB 23 dB 19 dB

6 21 dB — — 23 dB 24 dB 22 dB 18 dB 21 dB 23 dB 18 dB

7 20 dB — — 21 dB 23 dB 20 dB 17 dB 19 dB 21 dB 15 dB

Table 16-10 Span Loss for 16-Channel Linear Networks without OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 37 dB 29 dB 29 dB 37 dB 37 dB 36 dB 33 dB 35 dB 37 dB 33 dB

2 32 dB 24 dB 24 dB 33 dB 34 dB 31 dB 28 dB 30 dB 32 dB 28 dB

3 28 dB 21 dB 21 dB 30 dB 31 dB 27 dB 25 dB 27 dB 28 dB 25 dB

4 26 dB 20 dB 19 dB 28 dB 28 dB 25 dB 23 dB 24 dB 26 dB 23 dB

5 25 dB 19 dB 18 dB 26 dB 27 dB 24 dB 22 dB 23 dB 25 dB 22 dB

6 24 dB 18 dB 17 dB 25 dB 26 dB 23 dB 21 dB 22 dB 24 dB 21 dB

7 22 dB 16 dB 15 dB 24 dB 24 dB 22 dB 20 dB 21 dB 22 dB 20 dB
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16.3.3   Optical Performance for ROADM Rings and Linear Networks
Note See Table 16-2 for client card class definitions. A dash (—) indicates the spans are not available for that 
client class.

16.3.3 Optical Performance for ROADM Rings and Linear Networks
The following tables list the reference optical performances for ROADM rings and linear networks. 
Table 16-12 shows the optical performance for 32-channel linear or ring networks using SMF fiber with 
only ROADM nodes installed. Span loss values assume the following:

• All nodes in the ring or linear network are ROADM.

• OPT-PRE and OPT-BST/OPT-BST-E amplifiers are installed.

• Span losses are equal.

Note See Table 16-2 for client card class definitions. A dash (—) indicates spans that are not available for that 
client class.

Table 16-11 Span Loss for 8-Channel Linear Networks without OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 37 dB 31 dB 31 dB 37 dB 37 dB 37 dB 35 dB 37 dB 37 dB 35 dB

2 34 dB 27 dB 26 dB 36 dB 37 dB 33 dB 30 dB 32 dB 34 dB 30 dB

3 31 dB 24 dB 23 dB 33 dB 34 dB 30 dB 27 dB 29 dB 31 dB 27 dB

4 29 dB — — 31 dB 31 dB 28 dB 25 dB 27 dB 29 dB 25 dB

5 27 dB — — 29 dB 30 dB 27 dB 24 dB 26 dB 27 dB 24 dB

6 — — — 28 dB — — — — — —

Table 16-12 Span Loss for 32-Channel Linear or Ring Networks with all ROADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 34 dB 26 dB 26 dB 36 dB 37 dB 33 dB 27 dB 32 dB 34 dB —

2 29 dB 21 dB 21 dB 32 dB 33 dB 29 dB 27 dB 28 dB 30 dB —

3 28 dB 19 dB 18 dB 30 dB 31 dB 27 dB 25 dB 26 dB 27 dB —

4 25 dB — — 28 dB 29 dB 25 dB 23 dB 24 dB 26 dB —

5 24 dB — — 27 dB 28 dB 24 dB 22 dB 22 dB 24 dB —

6 23 dB — — 26 dB 27 dB 22 dB 21 dB 21 dB 23 dB —

7 22 dB — — 25 dB 26 dB 21 dB 20 dB 20 dB 22 dB —

8 21 dB — — 24 dB 25 dB 20 dB — 18 dB 20 dB —

9 20 dB — — 23 dB 24 dB 19 dB 27 dB 17 dB 19 dB —

10 19 dB — — 23 dB 23 dB 18 dB 25 dB 14 dB 18 dB —
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16.3.3   Optical Performance for ROADM Rings and Linear Networks
Table 16-13 shows the optical performance for 32-channel linear or ring network with ROADM and 
OADM nodes using SMF fiber. Span loss values assume the following:

• All nodes in the ring or linear network are ROADM or OADM.

• OPT-PRE and OPT-BST/OPT-BST-E amplifiers are installed.

• Span losses are equal.

Note See Table 16-2 for client card class definitions. A dash (—) indicates spans that are not available for that 
client class.

The following tables show the pass/fail criteria for eight and sixteen ROADM nodes. Table 16-14 shows 
the pass/fail criteria for eight ROADM nodes (seven spans) required for any-to-any node circuit 
reconfigurations:

• All nodes in the ring are ROADM.

• Span losses are equal.

Note See Table 16-2 for client card class definitions. A dash (—) indicates spans that are not available for that 
client class.

11 16 dB — — 22 dB 23 dB 16 dB 23 dB — 19 dB —

12 — — — 21 dB 22 dB 14 dB 22 dB — 18 dB —

13 — — — 21 dB 22 dB — 21 dB — — —

14 — — — 20 dB 21 dB — 20 dB — — —

15 — — — 20 dB 20 dB — 20 dB — — —

Table 16-12 Span Loss for 32-Channel Linear or Ring Networks with all ROADM Nodes Using SMF Fiber (continued)

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

Table 16-13 Span Loss for 32-Channel Ring and Linear Networks with ROADM and OADM Nodes Using SMF Fiber

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 30 dB 23 dB 24 dB 31 dB 34 dB 31 dB 28 dB 29 dB 30 dB 28 dB

2 26 dB 19 dB 19 dB 27 dB 27 dB 26 dB 23 dB 26 dB 27 dB 23 dB

3 23 dB — — 25 dB 26 dB 23 dB 21 dB 23 dB 24 dB 21 dB

4 21 dB — — 23 dB 24 dB 22 dB 18 dB 21 dB 22 dB 18 dB

5 20 dB — — 22 dB 23 dB 20 dB 13 dB 20 dB 21 dB 13 dB

6 17 dB — — 19 dB 22 dB 18 dB — 17 dB 18 dB —

7 151 dB

1. 0.5 dB of OSNR impairment recovered by FEC margin @ BER>10-6

— — 17 dB 21 dB 16 dB — 151 16 dB —
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16.3.3   Optical Performance for ROADM Rings and Linear Networks
Table 16-15 shows the pass/fail criteria for 16 ROADM nodes (15 spans) required for any-to-any node 
circuit reconfigurations.

• All nodes in the ring are ROADM.

• Span losses are equal.

Table 16-14 Pass/Fail Criteria for 32-Channel, 8-Node ROADM Rings Using SMF Fiber

Span 
Loss (dB)

Amplifiers 
Installed

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 OPT-PRE only Yes <7 <7 Yes Yes Yes Yes Yes Yes —

2 OPT-PRE only Yes <7 <7 Yes Yes Yes Yes Yes Yes —

3 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

4 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

5 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

6 OPT-PRE only Yes <7 <7 Yes Yes Yes <7 Yes Yes —

7 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes <7 Yes Yes —

8 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes <7 Yes Yes —

9 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

10 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

11 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

12 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

13 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

14 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —

15 OPT-PRE and 
OPT-BST/OPT-
BST-E

Yes <7 <7 Yes Yes Yes Yes Yes Yes —
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16.3.3   Optical Performance for ROADM Rings and Linear Networks
Note See Table 16-2 for client card class definitions. A dash (—) indicates spans that are not available for that 
client class.

Table 16-15 Pass/Fail Criteria for 32-Channel, 16-Node ROADM Rings Using SMF Fiber

Span 
Loss (dB)

Amplifiers 
Installed

10 Gbps 2.5 Gbps

Class A Class B Class C Class I Class D Class E Class F Class G Class H Class J

1 OPT-PRE only <151 <151 <151

1. Cisco MetroPlanner calculates the maximum ring circumference and number of nodes that can be supported.

Yes Yes <151 <151 <151 <151 —

2 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

3 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

4 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

5 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

6 OPT-PRE only <151 <151 <151 Yes Yes <151 <151 <151 <151 —

7 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

8 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

9 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

10 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

11 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

12 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

13 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

14 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —

15 OPT-PRE and 
OPT-BST/OPT-
BST-E

<151 <151 <151 Yes Yes <151 <151 <151 <151 —
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16.3.4   Optical Performance for Single-Span Networks
16.3.4 Optical Performance for Single-Span Networks
Table 16-16 lists the span loss for a single-span link configuration with eight channels. The optical 
performance for this special configuration is given only for Classes A and C. This configuration assumes 
a maximum channel capacity of eight channels (8-dBm nominal channel power) used without any 
restrictions on the 32 available channels.

Table 16-17 lists the span loss for a single-span link configuration with 16 channels. The optical 
performance for this special configuration is given only for Class A and Class C. This configuration 
assumes a maximum channel capacity of 16 channels (5-dBm nominal channel power) used without any 
restrictions on the 32 available channels.

Table 16-18 lists the span loss for a single-span link configuration with AD-1C-x.xx cards, OPT-PRE 
amplifiers, and OPT-BST/OPT-BST-E amplifiers. The single-span link with a flexible channel count is 
used both for transmitting and receiving. If dispersion compensation is required, a DCU can be used with 
an OPT-PRE amplifier. The optical performance for this special configuration is given for Classes A 
through G (8-dBm nominal channel power) used without any restrictions on the 32 available channels. 

Table 16-19 lists the span loss for a single-span link configuration with one channel and 
OPT-BST/OPT-BST-E amplifiers. The optical performance for this special configuration is given for 
Classes A through G. Classes A, B, and C use 8-dBm nominal channel power. Classes D, E, F, and G use 

Table 16-16 Span Loss for Single-Span Link with Eight Channels

Node Configuration
Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

With OSCM card 1 37 dB — 37 dB — — — —

With OSC-CSM card 1 35 dB — 35 dB — — — —

Table 16-17 Span Loss for Single-Span Link with 16 Channels

Node Configuration
Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

With OSCM or 
OSC-SCM cards

1 35 dB — 35 dB — — — —

Table 16-18 Span Loss for Single-Span Link with AD-1C-xx.x Cards, OPT-PRE Amplifiers, and 

OPT-BST/OPT-BST-E Amplifiers

Node Configuration
Number 
of Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

With OSCM cards1

1. OSCM sensitivity limits the performance to 37 dB.

1 37 dB 31 dB 31 dB 37 dB 37 dB 37 dB 37 dB

Hybrid with OSC-CSM 
cards2

2. OSC-CSM sensitivity limits the performance to 35 dB when it replaces the OSCM.

1 35 dB 31 dB 31 dB 35 dB 35 dB 35 dB 35 dB
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16.4   Network Optical Safety - Automatic Laser Shutdown
12-dBm nominal channel power. There are no restriction on the 32 available channels. That is, a line 
card, transponder, or muxponder wavelength can be extracted from the 32 available wavelengths. Also, 
the optical service channel is not required.

Table 16-20 lists the span loss for a single-span link configuration with one channel, 
OPT-BST/OPT-BST-E amplifiers, OPT-PRE amplifiers, and ONS 15216 FlexLayer filters. ONS 15216 
FlexLayer filters are used instead of the AD-1C-xx.x cards to reduce equipment costs and increase the 
span length, since the optical service channel is not necessary. The optical performance for this special 
configuration is given for Classes A through G. Classes A, B, and C use 8-dBm nominal channel power. 
Classes D, E, F, and G use 12-dBm nominal channel power. There are no restriction on the first 16 
available wavelengths (from 1530.33 to 1544.53 nm).

16.4 Network Optical Safety - Automatic Laser Shutdown
Automatic laser shutdown (ALS) is a technique used to automatically shut down the output power of 
laser transmitters and optical amplifiers in the event of a fiber break. Cards with laser transmitters can 
be provisioned as follows with respect to ALS:

• Disable: ALS is off; the laser is not automatically shut down when a traffic outage loss of signal 
(LOS) occurs

• Auto Restart: ALS is on. The laser automatically shuts down when traffic outages (LOS) occur. It 
automatically restarts when the conditions that caused the outage are resolved.

Note Auto Restart is the default ALS provisioning

• Manual Restart: ALS is on. The laser automatically shuts down when traffic outages (LOS) occur. 
However, the laser must be manually restarted when conditions that caused the outage are resolved.

• Manual Restart for Test: Manually restarts the laser for testing.

In the following paragraphs, two ALS scenarios are given:

• Nodes using OPT-BT cards (amplified nodes)

Table 16-19 Span Loss for Single-Span Link with One Channel and OPT-BST/OPT-BST-E Amplifiers

Number 
of Spans

10 Gbps 2.5 Gbps

Class A Class B Class C Class D Class E Class F Class G

1 20 to 
30 dB

17 to 
26 dB

17 to 
28 dB

Unprotected 
from 29 to 41 dB

Protected from 
25 to 41 dB

Unprotected 
from 28 to 37 dB

Protected from 
24 to 40 dB

Unprotected 
from 21 to 34 dB

Protected from 
18 to 34 dB

From 23 
to 36 dB

Table 16-20 Span Loss for Single-Span Link with One Channel, OPT-BST/OPT-BST-E Amplifiers, 

OPT-PRE Amplifiers, and ONS 15216 FlexLayer Filters

Number of 
Spans

10 Gbps 2.5 Gbps

Class A Class B1 Class C1 Class D1 Class E1 Class F1 Class G1

1x 38 dB 30 dB 30 dB 44 dB 40 dB 38 dB 40 dB
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16.4.1   Scenario 1: Fiber Cut in Nodes Using OPT-BST or OPT-BST-E Cards
• Nodes using OSC-CSM cards (passive nodes)

16.4.1 Scenario 1: Fiber Cut in Nodes Using OPT-BST or OPT-BST-E Cards
Figure 16-8 shows nodes using OPT-BST or OPT-BST-E cards with a fiber cut between them.

Figure 16-8 Nodes Using OPT-BST/OPT-BST-E Cards

Two photodiodes at Node B monitor the received signal strength for the optical payload and optical 
service channel (OSC) signals. When the fiber is cut, a loss of signal (LOS) is detected at both of the 
photodiodes. The AND function then indicates an overall LOS condition, which causes the 
OPT-BST/OPT-BST-E transmitter, OPT-PRE transmitter, and OSCM lasers to shut down. This in turn 
leads to a LOS for both the optical payload and OSC at Node A, which causes Node A to turn off the 
OSCM, OPT-PRE transmitter, and OPT-BST/OPT-BST-E transmitter lasers. The sequence of events 
after a fiber cut is as follows (refer to the numbered circles in Figure 16-8):

1. Fiber is cut

2. Power monitoring photodiode detects a LOS on the OSC and OSCM detects LOS

3. Power monitoring photodiode detects a LOS for the optical payload

4. LOS is declared

5. The OPT-BST/OPT-BST-E amplifier laser is shut down in less than three seconds

6. The OSCM laser is shut down

7. The OPT-PRE laser is shut down
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16.4.2   Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards
8. Power monitoring photodiode detects a LOS on the OSC and OSCM detects LOS

9. Power monitoring photodiode detects a LOS for the optical payload

10. LOS is declared

11. The OPT-BST/OPT-BST-E amplifier laser is shut down

12. The OSCM laser is shut down

13. The OPT-PRE laser is shut down

When the fiber is repaired, either an automatic or manual restart at the Node A OPT-BST/OPT-BST-E 
transmitter or at the Node B OPT-BST/OPT-BST-E transmitter is required. A system that has been shut 
down is reactivated through the use of a restart pulse. The pulse is used to signal that the optical path has 
been restored and transmission can begin. For example, when the far end, Node B, receives a pulse, it 
signals to the Node B OPT-BST/OPT-BST-E transmitter to begin transmitting an optical signal. The 
OPT-BST/OPT-BST-E receiver at Node A receives that signal and signals the Node A 
OPT-BST/OPT-BST-E transmitter to resume transmitting.

Note During a laser restart pulse, automatic power reduction (APR) is disabled and the laser power does not 
exceed Class 1 limits.

16.4.2 Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards
Figure 16-9 shows nodes using OSC-CSM cards with a fiber cut between them.
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16.4.2   Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards
Figure 16-9 Nodes Using OSC-CSM Cards

Two photodiodes at the Node B OSC-CSM card monitor the received signal strength for the received 
optical payload and OSC signals. When the fiber is cut, LOS is detected at both of the photodiodes. The 
AND function then indicates an overall LOS condition, which causes the Node B OSC laser to shut down 
and the optical switch to block traffic coming into the node. This in turn leads to LOS for both the optical 
payload and OSC signals at Node A, which causes Node A to turn off the OSC laser and the optical 
switch to block incoming traffic. The sequence of events after a fiber cut is as follows (refer to the 
numbered circles in Figure 16-9):

1. Fiber is cut

2. Power monitoring photodiode detects a LOS on the OSC and OSC-CSM detects LOS

3. Power monitoring photodiode detects a LOS for the optical payload

4. LOS is declared

5. The optical switch blocks incoming traffic

6. The OSC laser is shut down

7. Power monitoring photodiode detects a LOS on the OSC and OSC-CSM detects LOS

8. Power monitoring photodiode detects a LOS for the optical payload

9. LOS is declared

10. The OSC laser is shut down

The optical switch blocks incoming traffic
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16.4.2   Scenario 2: Fiber Cut in Nodes Using OSC-CSM Cards
When the fiber is repaired, either an automatic or manual restart at the Node A OSC-CSM OSC or at the 
Node B OSC-CSM OSC is required. A system that has been shut down is reactivated through the use of 
a restart pulse. The pulse is used to signal that the optical path has been restored and transmission can 
begin. For example, when the far end, Node B, receives a pulse, it signals to the Node B OSC to begin 
transmitting its optical signal and for the optical switch to pass incoming traffic. The OSC-CSM at Node 
A then receives the signal and tells the Node A OSC to resume transmitting and for the optical switch to 
pass incoming traffic. 
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Cisco Transport Controller Operation

This chapter describes Cisco Transport Controller (CTC), the software interface for the 
Cisco ONS 15454. For CTC setup and login information, refer to Chapter 2, “Connect the PC and Log 
into the GUI.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 17.1 CTC Software Delivery Methods, page 17-1

• 17.2 CTC Installation Overview, page 17-3

• 17.3 PC and UNIX Workstation Requirements, page 17-4

• 17.4 ONS 15454 Connections, page 17-6

• 17.5 CTC Window, page 17-7

• 17.6 TCC2 Card Reset, page 17-14

• 17.7 TCC2 Card Database, page 17-15

• 17.8 Software Revert, page 17-15

17.1 CTC Software Delivery Methods
ONS 15454 provisioning and administration is performed using the CTC software. CTC is a Java 
application that is installed in two locations: it is stored on the Advanced Timing, Communications, and 
Control (TCC2) card and it is downloaded to your workstation the first time you log into the ONS 15454 
with a new software release.

17.1.1 CTC Software Installed on the TCC2 Card
CTC software is preloaded on the ONS 15454 TCC2 cards; therefore, you do not need to install software 
on the TCC2 cards. When a new CTC software version is released, use the release-specific software 
upgrade document to upgrade the ONS 15454 software on the TCC2 card. 
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17.1.1   CTC Software Installed on the TCC2 Card
When you upgrade CTC software, the TCC2 cards store the new CTC version as the protect CTC 
version. When you activate the new CTC software, the TCC2 cards store the older CTC version as the 
protect CTC version, and the newer CTC release becomes the working version. You can view the 
software versions that are installed on an ONS 15454 by selecting the Maintenance > Software tabs in 
node view (Figure 17-1). 

Figure 17-1 CTC Software Versions, Node View

Select the Maintenance > Software tabs in network view to display the software versions installed on all 
the network nodes (Figure 17-2).
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17.1.2   CTC Software Installed on the PC or UNIX Workstation
Figure 17-2 CTC Software Versions, Network View

17.1.2 CTC Software Installed on the PC or UNIX Workstation
CTC software is downloaded from the TCC2 cards and installed on your computer automatically after 
you connect to the ONS 15454 with a new software release for the first time. Downloading the CTC 
software files automatically ensures that your computer is running the same CTC software version as the 
TCC2 cards you are accessing. The CTC files are stored in the temporary directory designated by your 
computer operating system. You can use the Delete CTC Cache button to remove files stored in the 
temporary directory. If the files are deleted, they download the next time you connect to an ONS 15454. 
Downloading the Java archive (JAR) files for CTC takes several minutes depending on the bandwidth 
of the connection between your workstation and the ONS 15454. For example, JAR files downloaded 
from a modem or a data communications channel (DCC) network link require more time than JAR files 
downloaded over a LAN connection.

17.2 CTC Installation Overview
To connect to an ONS 15454 using CTC, you enter the ONS 15454 IP address in the URL field of 
Netscape Navigator or Microsoft Internet Explorer. After connecting to an ONS 15454, the following 
occurs automatically:

1. A CTC launcher applet is downloaded from the TCC2 card to your computer.

2. The launcher determines whether your computer has a CTC release matching the release on the 
ONS 15454 TCC2 card. 

3. If the computer does not have CTC installed, or if the installed release is older than the TCC2 card’s 
version, the launcher downloads the CTC program files from the TCC2 card.
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17.3   PC and UNIX Workstation Requirements
4. The launcher starts CTC. The CTC session is separate from the web browser session, so the web 
browser is no longer needed. Always log into nodes having the latest software release. If you log 
into an ONS 15454 that is connected to ONS 15454s with older versions of CTC, or to 
Cisco ONS 15327s or Cisco ONS 15600s, CTC files are downloaded automatically to enable you to 
interact with those nodes. The CTC file download occurs only when necessary, such as during your 
first login. You cannot interact with nodes on the network that have a software version later than the 
node that you used to launch CTC.

Each ONS 15454 can handle up to five concurrent CTC sessions. CTC performance can vary, depending 
upon the volume of activity in each session, network bandwidth, and TCC2 card load.

Note You can also use TL1 commands to communicate with the Cisco ONS 15454 through VT100 terminals 
and VT100 emulation software, or you can telnet to an ONS 15454 using TL1 port 3083. Refer to the 
Cisco ONS 15454 and Cisco ONS 15327 TL1 Command Guide for a comprehensive list of TL1 
commands. 

17.3 PC and UNIX Workstation Requirements
To use CTC for the ONS 15454, your computer must have a web browser with the correct Java Runtime 
Environment (JRE) installed. The correct JRE for each CTC software release is included on the 
Cisco ONS 15454 software CD and the ONS 15454 documentation CD. If you are running multiple CTC 
software releases on a network, the JRE installed on the computer must be compatible with the different 
software releases. 

You can change the JRE version on the Preferences dialog box JRE tab. When you change the JRE 
version on the JRE tab, you must exit and restart CTC for the new JRE version to take effect. Table 17-1 
shows JRE compatibility with ONS 15454 software releases.

Table 17-1 JRE Compatibility

ONS Software Release JRE 1.2.2 Compatible JRE 1.3 Compatible JRE 1.4 Compatible

ONS 15454 Release 2.2.1 and earlier Yes No No

ONS 15454 Release 2.2.2 Yes Yes No

ONS 15454 Release 3.0 Yes Yes No

ONS 15454 Release 3.1 Yes Yes No

ONS 15454 Release 3.2 Yes Yes No

ONS 15454 Release 3.3 Yes Yes No

ONS 15454 Release 3.4 No Yes No

ONS 15454 Release 4.0 1

1. Software Releases 4.0 and later notify you if an older version of the JRE is running on your PC or UNIX workstation.

No Yes No

ONS 15454 Release 4.1 No Yes No

ONS 15454 Release 4.5 No Yes No

ONS 15454 Release 4.6 No Yes Yes

ONS 15454 Release 4.7 No No Yes
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17.3   PC and UNIX Workstation Requirements
Table 17-2 lists the requirements for PCs and UNIX workstations. In addition to the JRE, the Java 
plug-in and modified java.policy file are also included on the ONS 15454 software CD and the ONS 
15454 documentation CD.

Table 17-2 Computer Requirements for CTC

Area Requirements Notes

Processor Pentium III 700 MHz, UltraSPARC, or 
equivalent

700 MHz is the recommended 
processor speed. You can use 
computers with a lower processor 
speed; however, you might experience 
longer response times and slower 
performance.

RAM 384 MB RAM recommended, 512 MG RAM 
optimum

—

Hard drive 20 GB hard drive with 50 MB of space 
available

—

Operating 
System

• PC: Windows 98 (1st and 2nd editions), 
Windows ME, Windows NT 4.0 (with 
Service Pack 6a), Windows 2000 (with 
Service Pack 3), or Windows XP Home

• Workstation: Solaris versions 8 or 9

—

Java Runtime 
Environment

JRE 1.4.2 JRE 1.4.2 is installed by the CTC 
Installation Wizard included on the 
Cisco ONS 15454 software and 
documentation CDs. JRE 1.4.2 
provides enhancements to CTC 
performance, especially for large 
networks with numerous circuits.

If CTC must be launched directly from 
nodes running software earlier than 
R4.6, uninstall JRE 1.4.2 and reinstall 
JRE 1.3.1_02, then, to run R4.7, 
uninstall JRE 1.3.1_02 and reinstall 
JRE 1.4.2.

Web browser Netscape 7.x or Internet Explorer 6.x Netscape 7.x is available at the 
following site: 
http://channels.netscape.com/ns/brows
ers/default.jsp

Internet Explorer 6.x is available at the 
following site: 
http://www.microsoft.com

Cable User-supplied CAT-5 straight-through cable 
with RJ-45 connectors on each end to 
connect the computer to the ONS 15454 
directly or through a LAN

—
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17.4 ONS 15454 Connections
You can connect to the ONS 15454 in multiple ways. You can connect your PC directly to the ONS 
15454 (local craft connection) using the RJ-45 port on the TCC2 card or, for the ANSI shelf, the LAN 
pins on the backplane (the ETSI shelf provides a LAN connection via the RJ-45 jack on the MIC-T/C/P 
FMEC). Alternatively, you can connect your PC to a hub or switch that is connected to the ONS 15454, 
connect to the ONS 15454 through a LAN or modem, or establish TL1 connections from a PC or TL1 
terminal. Table 17-3 lists the ONS 15454 connection methods and requirements.

Table 17-3 ONS 15454 Connection Methods

Method Description Requirements

Local craft Refers to onsite network connections 
between the CTC computer and the 
ONS 15454 using one of the following:

• The RJ-45 (LAN) port on the TCC2 card

• The LAN pins on the ONS 15454 
backplane (ANSI)

• The RJ-45 jack on the MIC-T/C/P 
FMEC (ETSI)

• A hub or switch to which the ONS 15454 
is connected

If you do not use Dynamic Host 
Configuration Protocol (DHCP), you must 
change the computer IP address, subnet 
mask, and default router, or use automatic 
host detection. 

Corporate 
LAN

Refers to a connection to the ONS 15454 
through a corporate or network operations 
center (NOC) LAN.

• The ONS 15454 must be provisioned 
for LAN connectivity, including IP 
address, subnet mask, and default 
gateway.

• The ONS 15454 must be physically 
connected to the corporate LAN.

• The CTC computer must be connected 
to the corporate LAN that has 
connectivity to the ONS 15454.

TL1 Refers to a connection to the ONS 15454 
using TL1 rather than CTC. TL1 sessions can 
be started from CTC, or you can use a TL1 
terminal. The physical connection can be a 
craft connection, corporate LAN, or a TL1 
terminal. 

Refer to the Cisco ONS 15454 and Cisco 
ONS 15327 TL1 Command Guide.

Remote Refers to a connection made to the 
ONS 15454 using a modem.

• A modem must be connected to the 
ONS 15454.

• The modem must be provisioned for 
the ONS 15454. To run CTC, the 
modem must be provisioned for 
Ethernet access.
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17.5 CTC Window
The CTC window appears after you log into an ONS 15454 (Figure 17-3). The window includes a menu 
bar, a toolbar, and a top and bottom pane. The top pane provides status information about the selected 
objects and a graphic of the current view. The bottom pane provides tabs and subtab to view ONS 15454 
information and perform ONS 15454 provisioning and maintenance. From this window, you can display 
three ONS 15454 views: network, node, and card. 

Figure 17-3 Node View (Default Login View)

17.5.1 Node View
Node view, shown in Figure 17-3, is the first view that appears after you log into an ONS 15454. The 
login node is the first node shown, and it is the “home view” for the session. Node view allows you to 
manage one ONS 15454 node. The status area shows the node name; IP address; session boot date and 
time; number of Critical (CR), Major (MJ), and Minor (MN) alarms; name and security level of the 
current logged-in user; software version; and network element default setup. 

17.5.1.1 CTC Card Colors

The graphic area of the CTC window depicts the ONS 15454 shelf assembly. The colors of the cards in 
the graphic reflect the real-time status of the physical card and slot (Table 17-4).

96
94

1

Menu bar

Top pane

Tool bar

Status area

Graphic area

Tabs

Status bar

Subtabs Bottom pane

Table 17-4 Node View Card Colors

Card Color Status

Gray Slot is not provisioned; no card is installed.

Violet Slot is provisioned; no card is installed.
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On the ONS 15454 ETSI, the colors of the Front Mount Electrical Connection (FMEC) cards reflect the 
real-time status of the physical FMEC cards. Table 17-5 lists the FMEC card colors. The FMEC ports 
shown in CTC do not change color.

Note You cannot preprovision FMECs. 

The wording on a card in node view shows the status of a card (Active, Standby, Loading, or 
Not Provisioned). Table 17-6 lists the card statuses.

Port color in both card and node view indicates the port service state. Table 17-7 lists the port colors and 
their service states. For more information about port service states, refer to Appendix C, “DWDM 
Enhanced State Model.”

White Slot is provisioned; a functioning card is installed.

Yellow Slot is provisioned; a Minor alarm condition exists.

Orange Slot is provisioned; a Major alarm condition exists.

Red Slot is provisioned; a Critical alarm exists.

Table 17-4 Node View Card Colors (continued)

Card Color Status

Table 17-5 Node View FMEC Color 

Upper Shelf FMEC Color Status

White Functioning card is installed.

Yellow Minor alarm condition exists.

Orange (Amber) Major alarm condition exists.

Red Critical alarm exists.

Table 17-6 Node View Card Statuses

Card Status Description

Sty Card is in standby mode.

Act Card is active.

NP Card is not present.

Ldg Card is resetting.
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Figure 17-4 Terminal Loopback Indicator

Table 17-7 Node View Card Port Colors and Service States

Port Color Service State Description

Cyan (blue) Out-of-Service and Management, Loopback 
(OOS-MA,LPBK [ANSI])

Locked-enabled,loopback (ETSI)

Port is in a loopback state. On the card in node view, a 
line between ports indicates that the port is in terminal or 
facility loopback (see Figure 17-4 and Figure 17-5). 
Traffic is carried and alarm reporting is suppressed. 
Raised fault conditions, whether or not their alarms are 
reported, can be retrieved on the CTC Conditions tab or 
by using the TL1 RTRV-COND command. 

Cyan (blue) Out-of-Service and Management, Maintenance 
(OOS-MA,MT [ANSI])

Locked-enabled,maintenance (ETSI)

Port is out-of-service for maintenance. Traffic is carried 
and loopbacks are allowed. Alarm reporting is 
suppressed. Raised fault conditions, whether or not their 
alarms are reported, can be retrieved on the CTC 
Conditions tab or by using the TL1 RTRV-COND 
command. Use this service state for testing or to suppress 
alarms temporarily. Change the state to 
IS-NR/Unlocked-enabled; 
OOS-MA,DSBLD/Locked-enabled,disabled; or 
OOS-AU,AINS/Unlocked-disabled,automaticInService 
when testing is complete.

Gray Out-of-Service and Management, Disabled 
(OOS-MA,DSBLD [ANSI])

Locked-enabled,disabled (ETSI)

The port is out-of-service and unable to carry traffic. 
Loopbacks are not allowed in this service state. 

Green In-Service and Normal (IS-NR [ANSI])

Unlocked-enabled (ETSI)

The port is fully operational and performing as 
provisioned. The port transmits a signal and displays 
alarms; loopbacks are not allowed. 

Violet Out-of-Service and Autonomous, Automatic 
In-Service (OOS-AU,AINS [ANSI])

Unlocked-disabled,automaticInService (ETSI)

The port is out-of-service, but traffic is carried. Alarm 
reporting is suppressed. The node monitors the ports for 
an error-free signal. After an error-free signal is detected, 
the port stays in this service state for the duration of the 
soak period. After the soak period ends, the port service 
state changes to IS-NR/Unlocked-enabled. 

Raised fault conditions, whether or not their alarms are 
reported, can be retrieved on the CTC Conditions tab or 
by using the TL1 RTRV-COND command. The AINS 
port will automatically transition to 
IS-NR/Unlocked-enabled when a signal is received for 
the length of time provisioned in the soak field.
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Figure 17-5 Facility Loopback Indicator

17.5.1.2 Node View Card Shortcuts

If you move your mouse over cards in the graphic, popups display additional information about the card 
including the card type; the card status (active or standby); the type of alarm, such as Critical, Major, or 
Minor (if any); the alarm profile used by the card; and for transponder (TXP) or muxponder (MXP) 
cards, the wavelength of the dense wavelength division multiplexing (DWDM) port. Right-click a card 
to reveal a shortcut menu, which you can use to open, reset, delete, or change a card. Right-click a slot 
to preprovision a card (that is, provision a slot before installing the card). 

17.5.1.3 Node View Tabs

Table 17-8 lists the tabs and subtabs available in the node view.

Table 17-8 Node View Tabs and Subtabs

Tab Description Subtabs

Alarms Lists current alarms (CR, MJ, MN) for the node 
and updates them in real time.

—

Conditions Displays a list of standing conditions on the 
node.

—

History Provides a history of node alarms including date, 
type, and severity of each alarm. The Session 
subtab displays alarms and events for the current 
session. The Node subtab displays alarms and 
events retrieved from a fixed-size log on the 
node.

Session, Node

Circuits Creates, deletes, edits, and maps circuits. —

Provisioning Provisions the ONS 15454 node. General, Ether Bridge, Network, 
Protection, BLSR, Security, SNMP, 
Comm Channels, Timing, Alarm 
Profiles, Defaults, UCP, WDM-ANS

Inventory Provides inventory information (part number, 
serial number, Common Language Equipment 
Identification [CLEI] codes) for cards installed 
in the node. Allows you to delete and reset cards 
and change the card service state. 

—

Maintenance Performs maintenance tasks for the node. Database, Ether Bridge, Protection, 
BLSR (ANSI), MS-SPRing (ETSI), 
Software, Cross-Connect, Overhead 
XConnect, Diagnostic, Timing, 
Audit, Routing Table, RIP Routing 
Table, Test Access, DWDM
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17.5.2 Network View
Network view allows you to view and manage ONS 15454s that have DCC connections to the node that 
you logged into and any login node groups you have selected (Figure 17-6). 

Figure 17-6 Network in CTC Network View 

Note Nodes with DCC connections to the login node do not appear if you checked the Disable Network 
Discovery check box in the Login dialog box. 

The graphic area displays a background image with colored ONS 15454 icons. A Superuser can set up 
the logical network view feature, which enables each user to see the same network view. 

The lines show DCC connections between the nodes (Table 17-9). DCC connections can be green 
(active) or gray (fail). The lines can also be solid (circuits can be routed through this link) or dashed 
(circuits cannot be routed through this link). Circuit provisioning uses active/routable links. Selecting a 
node or span in the graphic area displays information about the node and span in the status area.

96
93

9

Bold letters indicate
login node, asterisk

indicates topology host
Icon color indicates

node status
Dots indicate
selected node

Table 17-9 DCC Colors Indicating State in Network View

Color and Line Style State

Green and solid Active/Routable

Green and dashed Active/Nonroutable

Gray and solid Failed/Routable

Gray and dashed Failed/Nonroutable
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The color of a node in network view, shown in Table 17-10, indicates the node alarm status. 

Table 17-11 lists the tabs and subtabs available in network view.

17.5.3 Card View
The card view provides information about individual ONS 15454 cards. Use this window to perform 
card-specific maintenance and provisioning (Figure 17-7). A graphic showing the ports on the card is 
shown in the graphic area. The status area displays the node name, slot, number of alarms, card type, 
equipment type, card status (active or standby), card service state if the card is present, and port service 
state (described in Table 17-7 on page 17-9). The information that appears and the actions you can 
perform depend on the card. For more information about card service states, refer to Appendix C, 
“DWDM Enhanced State Model.”

Table 17-10 Node Status Shown in Network View

Color Alarm Status

Green No alarms

Yellow Minor alarms

Orange Major alarms

Red Critical alarms

Gray with 
Unknown#

Node initializing for the first time (CTC displays Unknown# because CTC has 
not discovered the name of the node yet)

Table 17-11 Network View Tabs and Subtabs

Tab Description Subtabs

Alarms Lists current alarms (CR, MJ, MN) for the 
network and updates them in real time.

—

Conditions Displays a list of standing conditions on the 
network.

—

History Provides a history of network alarms including 
date, type, and severity of each alarm.

—

Circuits Creates, deletes, edits, filters, and searches for 
network circuits.

—

Provisioning Provisions security, alarm profiles, 
bidirectional line switched rings (BLSRs) 
(ANSI), multiplex section-shared protection 
rings (MS-SPRing) (ETSI), and overhead 
circuits.

Security, Alarm Profiles, BLSR 
(ANSI), MS-SPRing (ETSI), 
Overhead Circuits, Provisionable 
Patchcords

Maintenance Displays the type of equipment and the status 
of each node in the network; displays working 
and protect software versions; and allows 
software to be downloaded.

Software
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Figure 17-7 CTC Card View Showing a 32DMX-O Card

Note CTC provides a card view for all ONS 15454 cards except the TCC2 card.

Use the card view tabs and subtabs shown in Table 17-12 to provision and manage the ONS 15454. The 
subtabs, fields, and information shown under each tab depend on the card type selected. The 
Performance tab is not available for the Alarm Interface Controller (AIC) or Alarm Interface 
Controller–International (AIC-I) cards.

Table 17-12 Card View Tabs and Subtabs

Tab Description Subtabs

Alarms Lists current alarms (CR, MJ, MN) for the card 
and updates them in real time.

—

Conditions Displays a list of standing conditions on the 
card.

—

History Provides a history of card alarms including 
date, object, port, and severity of each alarm.

Session (displays alarms and events 
for the current session), Card 
(displays alarms and events retrieved 
from a fixed-size log on the card)

Circuits Creates, deletes, edits, and search circuits. —
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17.6 TCC2 Card Reset
You can reset the ONS 15454 TCC2 card by using CTC (a soft reset) or by physically reseating a TCC2 
card (a hard reset). A soft reset reboots the TCC2 card and reloads the operating system and the 
application software. Additionally, a hard reset temporarily removes power from the TCC2 card and 
clears all buffer memory. 

You can apply a soft reset from CTC to either an active or standby TCC2 card without affecting traffic. 
If you need to perform a hard reset on an active TCC2 card, put the TCC2 card into standby mode first 
by performing a soft reset.

Note When a CTC reset is performed on an active TCC2 card, the AIC and AIC-I cards go through an 
initialization process and also reset because the AIC and AIC-I cards are controlled by the active TCC2. 

Provisioning Provisions an ONS 15454 card. DS-N and OC-N cards: Line, Line 
Thresholds (different threshold 
options are available for DS-N and 
OC-N cards), Elect Path Thresholds, 
SONET Thresholds, SONET STS, 
and Alarm Profiles

TXP and MXP cards: Card, Line, 
Line Thresholds, Optics Thresholds, 
OTN, and Alarm Profiles

DWDM cards (subtabs depend on 
card type): Optical Line, Optical 
Chn, Optical Amplifier, Parameters, 
Optics Thresholds, and Alarm 
Profiles

Maintenance Performs maintenance tasks for the card. Loopback, Info, Protection, J1 Path 
Trace, AINS Soak (options depend 
on the card type), Automatic Laser 
Shutdown

Performance Performs performance monitoring for the card. DS-N and OC-N cards: no subtabs

TXP and MXP cards: Optics PM, 
Payload PM, OTN PM

DWDM cards (subtabs depend on 
card type): Optical Line, Optical 
Chn, Optical Amplifier Line, OC3 
Line, Parameters, Optics Thresholds

Inventory Displays an Inventory screen of the ports (TXP 
and MXP cards only).

—

Table 17-12 Card View Tabs and Subtabs (continued)

Tab Description Subtabs
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17.7 TCC2 Card Database
When dual TCC2 cards are installed in the ONS 15454, each TCC2 card hosts a separate database; 
therefore, the protect card database is available if the database on the working TCC2 fails. You can also 
store a backup version of the database on the workstation running CTC. This operation should be part 
of a regular ONS 15454 maintenance program at approximately weekly intervals, and should also be 
completed when preparing an ONS 15454 for a pending natural disaster, such as a flood or fire.

Note The following parameters are not backed up and restored: node name, IP address, mask and gateway, 
and Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up 
database with a different node name, the circuits map to the new node name. Cisco recommends keeping 
a record of the old and new node names.

17.8 Software Revert 
When you click the Activate button after a software upgrade, the TCC2 copies the current working 
database and saves it in a reserved location in the TCC2 flash memory. If you later need to revert to the 
original working software load from the protect software load, the saved database installs automatically. 
You do not need to restore the database manually or recreate circuits. 

The revert feature is useful if a maintenance window closes while you are upgrading CTC software. You 
can revert to the protect software load without losing traffic. During the next maintenance window, 
complete the upgrade and activate the new software load.

Circuits created or provisioning done after a software load is activated (upgraded to a higher release) do 
not reinstate with a revert (for example, 4.0 to 3.4). The database configuration at the time of activation 
is reinstated after a revert. This does not apply to maintenance reverts (for example, 2.2.2 to 2.2.1), 
because maintenance releases use the same database.
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Security and Timing

This chapter provides information about Cisco ONS 15454 users and node timing. To provision security 
and timing, see the “NTP-G23 Create Users and Assign Security” procedure on page 3-3.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 18.1 Users and Security, page 18-1

• 18.2 Node Timing, page 18-6

18.1 Users and Security
The Cisco Transport Controller (CTC) ID is provided with the ONS 15454 system, but the system does 
not display the user ID when you sign into CTC. This ID can be used to set up other ONS 15454 users. 

You can have up to 500 user IDs on one ONS 15454. Each CTC or TL1 user can be assigned one of the 
following security levels:

• Retrieve—Users can retrieve and view CTC information but cannot set or modify parameters.

• Maintenance—Users can access only the ONS 15454 maintenance options.

• Provisioning—Users can access provisioning and maintenance options.

• Superusers—Users can perform all of the functions of the other security levels as well as set names, 
passwords, and security levels for other users.

By default, multiple concurrent user ID sessions are permitted on the node, that is, multiple users can 
log into a node using the same user ID. However, you can provision the node to allow only a single login 
per user and prevent concurrent logins for all users. 

Note You must add the same user name and password to each node the user accesses.

18.1.1 Security Requirements 
Table 18-1 shows the actions that each user privilege level can perform in node view.
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Table 18-1 ONS 15454 Security Levels—Node View

CTC Tab Subtab [Subtab]:Actions Retrieve Maintenance Provisioning Superuser

Alarms — Synchronize/Filter/Delete 
Cleared Alarms

X X X X

Conditions — Retrieve/Filter X X X X

History Session Filter X X X X

Node Retrieve/Filter X X X X

Circuits — Create/Edit/Delete — — X X

Filter/Search X X X X

Provisioning General General: Edit — — Partial1 X

Power Monitor: Edit — — X X

EtherBridge Spanning trees: Edit — — X X

Network General: All — — — X

Static Routing: Create/Edit/ 
Delete

— — X X

OSPF: Create/Edit/Delete — — X X

RIP: Create/Edit/Delete — — X X

Proxy: Create/Delete — — — X

Firewall: Create/Delete — — — X

Protection Create/Delete/Edit — — X X

View X X X X

BLSR (ANSI)

MS-SPRing (ETSI)

Create/Edit/Delete — — X X

Ring Map/Squelch Table/RIP 
Table

X X X X

Security Users: Create/Delete — — — X

Users: Change Same user Same user Same user All users

Users: Clear Security Intrusion — — — X

Active Logins: Logout — — — X

Policy: Edit — — — X

Access: Edit — — — X

Legal Disclaimer: Edit — — — X

SNMP Create/Delete/Edit — — X X

Browse trap destinations X X X X
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Provisioning 
(continued)

Comm Channels SDCC: Create/Edit/Delete — — X X

LDCC: Create/Edit/Delete — — X X

GCC: Create/Edit/Delete — — X X

OSC: OSC Terminations: 
Create/Edit/Delete

— — X X

OSC: DWDM Ring ID: 
Create/Edit/Delete

— X X X

Provisionable Patchcords: 
Create/Delete

— — X X

Alarm Profiles Alarm Behavior: Edit — — X X

Alarm Profiles Editor: 
Load/Store/Delete2

— — X X

Alarm Profile Editor: 
New/Compare/Available/Usage

X X X X

Defaults Edit/Import — — — X

Export X X X X

UCP Node: Edit/Provision — — X X

Neighbor: Create/Edit/Delete — — X X

IPCC: Create/Edit/Delete — — X X

Interface: Create/Edit/Delete — — X X

Circuit: Create/Edit/Delete — — X X

WDM-ANS Provisioning: Import — — — X

Provisioning: Export X X X X

Connections: 
Create/Edit/Delete/Commit/ 
Calculate

— — X X

Port Status: Launch — — X X

Inventory — Delete — — X X

Reset — X X X

Maintenance Database Backup — X X X

Restore — — — X

EtherBridge Spanning Trees: View X X X X

MAC Table: Retrieve X X X X

MAC Table: Clear/Clear All — X X X

Trunk Utilization: Refresh X X X X

Circuits: Refresh X X X X

Table 18-1 ONS 15454 Security Levels—Node View (continued)

CTC Tab Subtab [Subtab]:Actions Retrieve Maintenance Provisioning Superuser
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Table 18-2 shows the actions that each user privilege level can perform in network view.

Maintenance 
(continued)

Protection Switch/Lock out/Lockon/ Clear/ 
Unlock

X X X X

BLSR (ANSI)

MS-SPRing (ETSI)

West/East Switches — — X X

Reset — X X X

Software Download — X X X

Activate/Revert — — — X

Cross-Connect Cards: Switch/Lock/Unlock — X X X

Resource Usage: Delete — — X X

Overhead 
XConnect

View X X X X

Diagnostic Retrieve/Lamp Test — X X X

Timing Source: Edit — X X X

Timing Report: View/Refresh X X X X

Audit Retrieve/Archive — — — X

Routing Table Retrieve X X X X

RIP Routing Table Retrieve X X X X

Test Access Read-only X X X X

DWDM APC: Run/Disable/Refresh — X X X

WDM Span Check: Retrieve 
Span Loss values, Reset

X X X X

Power Monitoring: Refresh X X X X

1. Provisioner user cannot change node name, contact, or AIS-V insertion on STS-1 signal degrade (SD) parameters.

2. The action buttons in the subtab are active for all users, but the actions can be completely performed only by the users assigned with the required security 
levels.

Table 18-1 ONS 15454 Security Levels—Node View (continued)

CTC Tab Subtab [Subtab]:Actions Retrieve Maintenance Provisioning Superuser

Table 18-2 ONS 15454 Security Levels—Network View

CTC Tab Subtab [Subtab]: Actions Retrieve Maintenance Provisioning Superuser

Alarms — Synchronize/Filter/Delete 
cleared alarms

X X X X

Conditions — Retrieve/Filter X X X X

History — Filter X X X X

Circuits — Create/Edit/Delete — — X X

Filter/Search X X X X
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18.1.2   Security Policies
18.1.2 Security Policies
Users with Superuser security privilege can provision security policies on the ONS 15454. These 
security policies include idle user timeouts, password changes, password aging, and user lockout 
parameters. In addition, a Superuser can access the ONS 15454 through the TCC2 RJ-45 port, the 
backplane LAN connection, or both. 

18.1.2.1 Idle User Timeout

Each ONS 15454 CTC or TL1 user can be idle during his or her login session for a specified amount of 
time before the CTC window is locked. The lockouts prevent unauthorized users from making changes. 
Higher-level users have shorter default idle periods and lower-level users have longer or unlimited 
default idle periods, as shown in Table 18-3. The user idle period can be modified by a Superuser; refer 
to the “NTP-G88 Modify Users and Change Security” procedure on page 9-34.

Provisioning Security Users: Create/Delete — — — X

Users: Change Same User Same User Same User All Users

Active logins: Logout — — — X

Policy: Change — — — X

Alarm Profiles New/Load/Store/Delete1 — — X X

Compare/Available/Usage X X X X

BLSR (ANSI)

MS-SPRing (ETSI)

Create/Edit/Delete/Upgrade — — X X

Overhead Circuits Create/Delete/Edit/Merge — — X X

Search X X X X

Provisionable 
Patchcords

Create/ Delete — — X X

Maintenance Software Download/Cancel X X X X

1. The action buttons in the subtab are active for all users, but the actions can be completely performed only by the users assigned with the required security 
levels.

Table 18-2 ONS 15454 Security Levels—Network View (continued)

CTC Tab Subtab [Subtab]: Actions Retrieve Maintenance Provisioning Superuser

Table 18-3 ONS 15454 Default User Idle Times

Security Level Idle Time

Superuser 15 minutes

Provisioning 30 minutes

Maintenance 60 minutes

Retrieve Unlimited
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18.2   Node Timing
18.1.2.2 User Password, Login, and Access Policies

Superusers can view real-time lists of users who are logged into CTC or TL1 user logins by node. 
Superusers can also provision the following password, login, and node access policies:

• Password expirations and reuse—Superusers can specify when users must change their passwords 
and when they can reuse them.

• Login attempts—Superusers can specify the maximum number of times a user is allowed to attempt 
to login to CTC.

• Locking out and disabling users—Superusers can provision the number of invalid logins that are 
allowed before locking out users and the length of time before inactive users are disabled. The 
number of allowed lockout attempts is set to the number of allowed login attempts.

• Node access and user sessions—Superusers can limit the number of CTC sessions one user can have, 
and they can prohibit access to the ONS 15454 using the LAN or TCC2 RJ-45 connections. 

In addition, a Superuser can select secure shell (SSH) instead of Telnet at the CTC Provisioning > 
Security > Access tabs. SSH is a terminal-remote host Internet protocol that uses encrypted links. It 
provides authentication and secure communication over unsecure channels. Port 22 is the default 
port and cannot be changed.

18.1.2.3 Audit Trail

Audit trails prove useful for maintaining security, recovering lost transactions, and enforcing 
accountability. Accountability refers to tracing user activities; that is, associating a process or action 
with a specific user.

The ONS 15454 maintains a 640-entry, human-readable audit trail of user or system actions such as 
login, logout, circuit creation or deletion, and user- or system-generated actions. Login events include 
authorized Cisco logins using the ONS 15454 command line interface (CLI) or CTC, the ONS 15454 
graphical user interface. You can move the log to a local or network drive for later review. The 
ONS 15454 generates an event to indicate when the log is 80 percent full, and another event to indicate 
that the oldest log entries are being overwritten.

Table 18-4 contains the columns listed in Audit Trail window.

18.2 Node Timing
SONET timing parameters must be set for each ONS 15454. Each ONS 15454 independently accepts its 
timing reference from one of three sources:

• The building integrated timing supply (BITS) pins on the ONS 15454 backplane (ANSI) or 
MIC-C/T/P coaxial connectors (ETSI).

Table 18-4 Audit Trail Window Columns

Heading Explanation

Date Date when the action occurred

Num Incrementing count of actions

User User ID that initiated the action

P/F Pass/Fail (whether or not the action was executed)

Operation Action that was taken
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18.2.1   Network Timing Example
• An OC-N/STM-N card installed in the ONS 15454. The card is connected to a node that receives 
timing through a BITS source. 

• The internal ST3 clock on the TCC2 card.

You can set ONS 15454 timing to one of three modes: external, line, or mixed. If timing is coming from 
the BITS pins, set ONS 15454 timing to external. If the timing comes from an OC-N/STM-N card, set 
the timing to line. In typical ONS 15454 networks:

• One node is set to external. The external node derives its timing from a BITS source wired to the 
BITS backplane pins. The BITS source, in turn, derives its timing from a primary reference source 
(PRS) such as a Stratum 1 clock or global positioning satellite (GPS) signal.

• The other nodes are set to line. The line nodes derive timing from the externally timed node through 
the OC-N trunk (span) cards. The MSTP normally derives timing from the line using the OSCM or 
OSC-CSM card that are inside an OC-3/STM-1 channel.

You can set three timing references for each ONS 15454. The first two references are typically two 
BITS-level sources, or two line-level sources optically connected to a node with a BITS source. The 
third reference is usually assigned to the internal clock provided on every ONS 15454 TCC2 card. 
However, if you assign all three references to other timing sources, the internal clock is always available 
as a backup timing reference. The internal clock is a Stratum 3 (ST3), so if an ONS 15454 node becomes 
isolated, timing is maintained at the ST3 level.

The CTC Maintenance > Timing > Report tabs show current timing information for an ONS 15454, 
including the timing mode, clock state and status, switch type, and reference data. 

Caution Mixed timing allows you to select both external and line timing sources. However, Cisco does not 
recommend its use because it can create timing loops. Use this mode with caution.

18.2.1 Network Timing Example
Figure 18-1 shows an ONS 15454 network timing setup example. Node 1 is set to external timing. Two 
timing references are set to BITS. These are Stratum 1 timing sources wired to the BITS input pins on 
the Node 1 backplane. The third reference is set to internal clock. The BITS output pins on the backplane 
of Node 3 are used to provide timing to outside equipment, such as a digital access line access 
multiplexer.

In the example, Slots 5 and 6 contain the trunk (span) cards. Timing at Nodes 2, 3, and 4 is set to line, 
and the timing references are set to the trunk cards based on distance from the BITS source. Reference 1 
is set to the trunk card closest to the BITS source. At Node 2, Reference 1 is Slot 5 because it is 
connected to Node 1. At Node 4, Reference 1 is set to Slot 6 because it is connected to Node 1. At 
Node 3, Reference 1 could be either trunk card because they are equal distance from Node 1. 
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18.2.2   Synchronization Status Messaging
Figure 18-1 ONS 15454 Timing Example

18.2.2 Synchronization Status Messaging
Synchronization status messaging (SSM) is a SONET protocol that communicates information about the 
quality of the timing source. SSM messages are carried on the S1 byte of the SONET Line layer. They 
enable SONET devices to automatically select the highest quality timing reference and to avoid timing 
loops.

SSM messages are either Generation 1 or Generation 2. Generation 1 is the first and most widely 
deployed SSM message set. Generation 2 is a newer version. If you enable SSM for the ONS 15454, 
consult your timing reference documentation to determine which message set to use. Table 18-5 and 
Table 18-6 on page 18-9 show the Generation 1 and Generation 2 message sets.

Node 4
Timing Line
Ref 1: Slot 6
Ref 2: Slot 5
Ref 3: Internal (ST3)

Node 2
Timing Line
Ref 1: Slot 5
Ref 2: Slot 6
Ref 3: Internal (ST3)

Node 1
Timing External
Ref 1: BITS1
Ref 2: BITS2
Ref 3: Internal (ST3)

Node 3
Timing Line
Ref 1: Slot 5
Ref 2: Slot 6
Ref 3: Internal (ST3)

BITS1
out

BITS2
out

BITS1
source

BITS2
source

Third party
equipment

34
72

6

Slot 5

Slot 5

Slot 5

Slot 5

Slot 6

Slot 6

Slot 6

Slot 6

Table 18-5 SSM Generation 1 Message Set

Message Quality Description

PRS 1 Primary reference source—Stratum 1

STU 2 Synchronization traceability unknown

ST2 3 Stratum 2
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18.2.2   Synchronization Status Messaging
ST3 4 Stratum 3

SMC 5 SONET minimum clock

ST4 6 Stratum 4

DUS 7 Do not use for timing synchronization

RES — Reserved; quality level set by user

Table 18-6 SSM Generation 2 Message Set

Message Quality Description

PRS 1 Primary reference source—Stratum 1

STU 2 Synchronization traceability unknown

ST2 3 Stratum 2

TNC 4 Transit node clock

ST3E 5 Stratum 3E

ST3 6 Stratum 3

SMC 7 SONET minimum clock

ST4 8 Stratum 4

DUS 9 Do not use for timing synchronization

RES — Reserved; quality level set by user

Table 18-5 SSM Generation 1 Message Set (continued)

Message Quality Description
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C H A P T E R 19

CTC Connectivity Reference

This chapter provides eight scenarios showing Cisco ONS 15454s in common IP network 
configurations. The chapter does not provide a comprehensive explanation of IP networking concepts 
and procedures. For IP setup instructions, see the “DLP-G56 Provision IP Settings” task on page 3-9.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 19.1 IP Networking Overview, page 19-1

• 19.2 IP Addressing Scenarios, page 19-2

• 19.3 Provisionable Patchcords, page 19-19

• 19.4 Routing Table, page 19-21

• 19.5 External Firewalls, page 19-22

• 19.6 Open GNE, page 19-24

Note To connect ONS 15454s to an IP network, you must work with a LAN administrator or other individual 
at your site who has IP networking training and experience. 

19.1 IP Networking Overview
ONS 15454s can be connected in many different ways within an IP environment:

• They can be connected to LANs through direct connections or a router.

• IP subnetting can create ONS 15454 node groups that allow you to provision non-data 
communication channel (DCC) connected nodes in a network. 

• Different IP functions and protocols can be used to achieve specific network goals. For example, 
Proxy Address Resolution Protocol (ARP) enables one LAN-connected ONS 15454 to serve as a 
gateway for ONS 15454s that are not connected to the LAN. 

• Static routes can be created to enable connections among multiple Cisco Transport Controller (CTC) 
sessions with ONS 15454s that reside on the same subnet with multiple CTC sessions. 

• ONS 15454s can be connected to Open Shortest Path First (OSPF) networks so ONS 15454 network 
information is automatically communicated across multiple LANs and WANs.
19-1
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19.2   IP Addressing Scenarios
• The ONS 15454 proxy server can control the visibility and accessibility between CTC computers 
and ONS 15454 element nodes.

19.2 IP Addressing Scenarios
ONS 15454 IP addressing generally has eight common scenarios or configurations. Use the scenarios as 
building blocks for more complex network configurations. Table 19-1 provides a general list of items to 
check when setting up ONS 15454s in IP networks.

19.2.1 Scenario 1: CTC and ONS 15454s on Same Subnet
Scenario 1 shows a basic ONS 15454 LAN configuration (Figure 19-1). The ONS 15454s and CTC 
computer reside on the same subnet. All ONS 15454s connect to LAN A, and all ONS 15454s have DCC 
connections.

Table 19-1 General ONS 15454 IP Troubleshooting Checklist

Item What to Check

Link integrity Verify that link integrity exists between:

• CTC computer and network hub/switch

• ONS 15454s (backplane [ANSI] or MIC-C/T/P [ETSI] wire-wrap pins or 
RJ-45 port) and network hub/switch

• Router ports and hub/switch ports

ONS 15454 
hub/switch ports

If connectivity problems occur, set the hub or switch port that is connected to 
the ONS 15454 to 10 Mbps half-duplex.

Ping Ping the node to test connections between computers and ONS 15454s.

IP addresses/subnet 
masks

Verify that ONS 15454 IP addresses and subnet masks are set up correctly.

Optical connectivity Verify that ONS 15454 optical trunk ports are in service and that a DCC is 
enabled on each trunk port.
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19.2.2   Scenario 2: CTC and ONS 15454s Connected to a Router
Figure 19-1 Scenario 1: CTC and ONS 15454s on Same Subnet (ANSI and ETSI)

19.2.2 Scenario 2: CTC and ONS 15454s Connected to a Router
In Scenario 2, the CTC computer resides on a subnet (192.168.1.0) and attaches to LAN A (Figure 19-2). 
The ONS 15454s reside on a different subnet (192.168.2.0) and attach to LAN B. A router connects LAN 
A to LAN B. The IP address of router interface A is set to LAN A (192.168.1.1), and the IP address of 
router interface B is set to LAN B (192.168.2.1). The routers each have a subnet mask of 255.255.255.0.

On the CTC computer, the default gateway is set to router interface A. If the LAN uses DHCP (Dynamic 
Host Configuration Protocol), the default gateway and IP address are assigned automatically. In the 
Figure 19-2 example, a DHCP server is not available.

CTC Workstation
IP Address 192.168.1.100
Subnet Mask 255.255.255.0
Default Gateway = N/A
Host Routes = N/A

ONS 15454 #1
IP Address 192.168.1.10

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #2
IP Address 192.168.1.20
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.1.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN A

Ring

12
42

44
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19.2.3   Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway
Figure 19-2 Scenario 2: CTC and ONS 15454s Connected to Router (ANSI and ETSI)

19.2.3 Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway
ARP matches higher-level IP addresses to the physical addresses of the destination host. It uses a lookup 
table (called ARP cache) to perform the translation. When the address is not found in the ARP cache, a 
broadcast is sent out on the network with a special format called the ARP request. If one of the machines 
on the network recognizes its own IP address in the request, it sends an ARP reply back to the requesting 
host. The reply contains the physical hardware address of the receiving host. The requesting host stores 
this address in its ARP cache so that all subsequent datagrams (packets) to this destination IP address 
can be translated to a physical address.

Proxy ARP enables one LAN-connected ONS 15454 to respond to the ARP request for ONS 15454s not 
connected to the LAN. (ONS 15454 proxy ARP requires no user configuration.) For this to occur, the 
DCC-connected ONS 15454s must reside on the same subnet as the LAN-connected (gateway) 
ONS 15454. When a LAN device sends an ARP request to an ONS 15454 that is not connected to the 
LAN, the gateway ONS 15454 (the one connected to the LAN) returns its MAC address to the LAN 
device. The LAN device then sends the datagram for the remote ONS 15454 to the MAC address of the 
proxy ONS 15454. The proxy ONS 15454 uses its routing table to forward the datagram to the non-LAN 
ONS 15454.

ONS 15454 #2
IP Address 192.168.2.20
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router
IP Address  of interface “A” to LAN “A” 192.168.1.1
IP Address of interface “B” to LAN “B”  192.168.2.1
Subnet Mask 255.255.255.0
Default Router = N/A
Host Routes =  N/A

ONS 15454 #1
IP Address 192.168.2.10

Subnet Mask 255.255.255.0
Default Router = 192.168.2.1

Static Routes = N/A

ONS 15454 #3
IP Address 192.168.2.30
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes = N/A

LAN B

LAN A

Int "A"

Int "B"

Ring

12
42

45
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19.2.3   Scenario 3: Using Proxy ARP to Enable an ONS 15454 Gateway
Scenario 3 is similar to Scenario 1, but only one ONS 15454 (Node 1) connects to the LAN 
(Figure 19-3). Two ONS 15454s (Node 2 and Node 3) connect to ONS 15454 Node 1 through the section 
DCC. Because all three ONS 15454s are on the same subnet, proxy ARP enables ONS 15454 Node 1 to 
serve as a gateway for ONS 15345 Node 2 and Node 3.

Note This scenario assumes all CTC connections are to Node 1. If you connect a laptop to either ONS 15454 
Node 2 or Node 3, network partitioning occurs; neither the laptop or the CTC computer can see all nodes. 
If you want laptops to connect directly to end network elements, you must create static routes (see 
Scenario 5) or enable the ONS 15454 proxy server (see Scenario 7). 

Be aware that:

• GNE and ENE 15454 proxy ARP is disabled.

• There is exactly one proxy ARP server on any given Ethernet segment; however, there may be more 
than one server in an ANSI or ETSI topology.

• The proxy ARP server does not perform the proxy ARP function for any node or host that is on the 
same Ethernet segment.

• It is important in Figure 19-3 that the CTC workstation be located within the same subnet and on 
the same Ethernet segment as the proxy ARP server.

Figure 19-3 Scenario 3: Using Proxy ARP (ANS and ETSII

You can also use proxy ARP to communicate with hosts attached to the craft Ethernet ports of 
DCC-connected nodes (Figure 19-4). The node with an attached host must have a static route to the host. 
Static routes are propagated to all DCC peers using OSPF. The existing proxy ARP node is the gateway 

CTC Workstation
IP Address 192.168.1.100
Subnet Mark at CTC Workstation 255.255.255.0
Default Gateway = N/A

ONS 15454 #2
IP Address 192.168.1.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.1.10
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.1.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN A

Ring
12

42
46
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19.2.4   Scenario 4: Default Gateway on CTC Computer
for additional hosts. Each node examines its routing table for routes to hosts that are not connected to 
the DCC network but are within the subnet. The existing proxy server replies to ARP requests for these 
additional hosts with the node MAC address. The existence of the host route in the routing table ensures 
that the IP packets addressed to the additional hosts are routed properly. Other than establishing a static 
route between a node and an additional host, no provisioning is necessary. The following restrictions 
apply:

• Only one node acts as the proxy ARP server for any given additional host. 

• A node cannot be the proxy ARP server for a host connected to its Ethernet port. 

In Figure 19-4, Node 1 announces to Node 2 and 3 that it can reach the CTC host. Similarly, Node 3 
announces that it can reach the ONS 152xx. The ONS 152xx is shown as an example; any network 
element can be set up as an additional host. 

Figure 19-4 Scenario 3: Using Proxy ARP with Static Routing (ANSI and ETSI)

19.2.4 Scenario 4: Default Gateway on CTC Computer
Scenario 4 is similar to Scenario 3, but Nodes 2 and 3 reside on different subnets, 192.168.2.0 and 
192.168.3.0, respectively (Figure 19-5). Node 1 and the CTC computer are on subnet 192.168.1.0. Proxy 
ARP is not used because the network includes different subnets. For the CTC computer to communicate 
with Nodes 2 and 3, Node 1 is entered as the default gateway on the CTC computer.

CTC Workstation
IP Address 192.168.1.100
Subnet Mark at CTC Workstation 255.255.255.0
Default Gateway = N/A

ONS 15454 #2
IP Address 192.168.1.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.1.10
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = Destination 192.168.1.100

Mask 255.255.255.0
Next Hop 192.168.1.30

ONS 15454 #3
IP Address 192.168.1.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = Destination 192.168.1.31

Mask 255.255.255.255
Next Hop 192.168.1.30

ONS 152xx
IP Address 192.168.1.31
Subnet Mask 255.255.255.0

LAN A

Ring

12
42

47
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19.2.5   Scenario 5: Using Static Routes to Connect to LANs
Figure 19-5 Scenario 4: Default Gateway on a CTC Computer (ANSI and ETSI)

19.2.5 Scenario 5: Using Static Routes to Connect to LANs
Static routes are used for two purposes: 

• To connect ONS 15454s to CTC sessions on one subnet connected by a router to ONS 15454s 
residing on another subnet. (These static routes are not needed if OSPF is enabled. Scenario 6 shows 
an OSPF example.)

• To enable multiple CTC sessions among ONS 15454s residing on the same subnet.

In Figure 19-6, one CTC residing on subnet 192.168.1.0 connects to a router through interface A (the 
router is not set up with OSPF). ONS 15454s residing on different subnets are connected through Node 
1 to the router through interface B. Because Nodes 2 and 3 are on different subnets, proxy ARP does not 
enable Node 1 as a gateway. To connect to CTC computers on LAN A, a static route is created on 
Node 1. 

ONS 15454 #1
IP Address 192.168.1.10
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

CTC Workstation
IP Address 192.168.1.100
Subnet Mask at CTC Workstation 255.255.255.0
Default Gateway  = 192.168.1.10
Host Routes = N/A

ONS 15454 #2
IP Address 192.168.2.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #3
IP Address 192.168.3.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN A

Ring

12
42

48
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19.2.5   Scenario 5: Using Static Routes to Connect to LANs
Figure 19-6 Scenario 5: Static Route With One CTC Computer Used as a Destination (ANSI and ETSI)

The destination and subnet mask entries control access to the ONS 15454s:

• If a single CTC computer is connected to a router, enter the complete CTC “host route” IP address 
as the destination with a subnet mask of 255.255.255.255. 

• If CTC computers on a subnet are connected to a router, enter the destination subnet (in this 
example, 192.168.1.0) and a subnet mask of 255.255.255.0.

• If all CTC computers are connected to a router, enter a destination of 0.0.0.0 and a subnet mask of 
0.0.0.0. Figure 19-7 shows an example.

The IP address of router interface B is entered as the next hop, and the cost (number of hops from source 
to destination) is 2.

CTC Workstation
IP Address 192.168.1.100

Subnet Mask 255.255.255.0
Default Gateway = 192.168.1.1

Host Routes = N/A

Router
IP Address  of interface ”A” to  LAN “A”  192.168.1.1
IP Address of interface  “B” to LAN  “B”   192.168.2.1
Subnet Mask 255.255.255.0

ONS 15454 #2
IP Address 192.168.3.20

Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

ONS 15454 #1
IP Address 192.168.2.10
Subnet Mask 255.255.255.0
Default Router = 192.168.2.1
Static Routes
    Destination 192.168.1.0
    Mask 255.255.255.0
    Next Hop 192.168.2.1
    Cost = 2

ONS 15454 #3
IP Address 192.168.4.30
Subnet Mask 255.255.255.0
Default Router = N/A
Static Routes = N/A

LAN B

LAN A

Int "A"

Int "B"

Ring

12
42

49
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19.2.6   Scenario 6: Using OSPF
Figure 19-7 Scenario 5: Static Route With Multiple LAN Destinations (ANSI and ETSI)

19.2.6 Scenario 6: Using OSPF
Open Shortest Path First (OSPF) is a link state Internet routing protocol. Link state protocols use a “hello 
protocol” to monitor their links with adjacent routers and to test the status of their links to their 
neighbors. Link state protocols advertise their directly connected networks and their active links. Each 
link state router captures the link state “advertisements” and puts them together to create a topology of 
the entire network or area. From this database, the router calculates a routing table by constructing a 
shortest path tree. Routes are recalculated when topology changes occur.

ONS 15454s use the OSPF protocol in internal ONS 15454 networks for node discovery, circuit routing, 
and node management. You can enable OSPF on the ONS 15454s so that the ONS 15454 topology is 
sent to OSPF routers on a LAN. Advertising the ONS 15454 network topology to LAN routers 
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Static Routes
    Destination 0.0.0.0
    Mask 0.0.0.0
    Next Hop 192.168.2.1
    Cost = 2

LAN C

LAN D
Router #3

Router #2
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19.2.6   Scenario 6: Using OSPF
eliminates the need to manually enter static routes for ONS 15454 subnetworks. Figure 19-8 shows a 
network enabled for OSPF. Figure 19-9 shows the same network without OSPF. Static routes must be 
manually added to the router for CTC computers on LAN A to communicate with Nodes 2 and 3 because 
these nodes reside on different subnets.

OSPF divides networks into smaller regions, called areas. An area is a collection of networked end 
systems, routers, and transmission facilities organized by traffic patterns. Each OSPF area has a unique 
ID number, known as the area ID. Every OSPF network has one backbone area called “area 0.” All other 
OSPF areas must connect to area 0.

When you enable an ONS 15454 OSPF topology for advertising to an OSPF network, you must assign 
an OSPF area ID in decimal format to the ONS 15454 network. An area ID is a “dotted quad” value that 
appears similar to an IP address. Coordinate the area ID number assignment with your LAN 
administrator. All DCC-connected ONS 15454s should be assigned the same OSPF area ID. 

Note It is recommended that the number of 15454s in an OSPF area be limited, because this allows faster 
loading into a CTC an is less likely to incur any problems.

Figure 19-8 Scenario 6: OSPF Enabled (ANSI and ETSI)
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19.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 19-9 Scenario 6: OSPF Not Enabled (ANSI and ETSI)

19.2.7 Scenario 7: Provisioning the ONS 15454 Proxy Server
The ONS 15454 proxy server is a set of functions that allows you to network ONS 15454s in 
environments where visibility and accessibility between ONS 15454s and CTC computers must be 
restricted. For example, you can set up a network so that field technicians and network operating center 
(NOC) personnel can both access the same ONS 15454s while preventing the field technicians from 
accessing the NOC LAN. To do this, one ONS 15454 is provisioned as a GNE and the other ONS 15454s 
are provisioned as end network elements (ENEs). The GNE ONS 15454 tunnels connections between 
CTC computers and ENE ONS 15454s, providing management capability while preventing access for 
non-ONS 15454 management purposes.
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19.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
The ONS 15454 gateway setting performs the following tasks:

• Isolates DCC IP traffic from Ethernet (craft port) traffic and accepts packets based on filtering rules. 
The filtering rules (see Table 19-3 on page 19-16 and Table 19-4 on page 19-17) depend on whether 
the packet arrives at the ONS 15454 DCC or TCC2 Ethernet interface.

• Processes Simple Network Time Protocol (SNTP) and Network Time Protocol (NTP) requests. 
ONS 15454 ENEs can derive time-of-day from an SNTP/NTP LAN server through the GNE 
ONS 15454.

• Processes Simple Network Management Protocol version 1 (SNMPv1) traps. The GNE ONS 15454 
receives SNMPv1 traps from the ENE ONS 15454s and forwards or relays the traps to SNMPv1 trap 
destinations or ONS 15454 SNMP relay nodes.

The ONS 15454 proxy server is provisioned using the Enable proxy server on port check box on the 
Provisioning > Network > General tab (see Figure 19-10 and Figure 19-11). If checked, the ONS 15454 
serves as a proxy for connections between CTC clients and ONS 15454s that are DCC-connected to the 
proxy ONS 15454. The CTC client establishes connections to DCC-connected nodes through the proxy 
node. The CTC client can connect to nodes that it cannot directly reach from the host on which it runs. 
If not selected, the node does not proxy for any CTC clients, although any established proxy connections 
continue until the CTC client exits. In addition, you can set the proxy server as an ENE or a GNE:

• End Network Element (ENE)—If set as an ENE, the ONS 15454 neither installs nor advertises 
default or static routes that go through its Ethernet port. However, an ENE does install and advertise 
routes that go through the DCC. CTC computers can communicate with the ONS 15454 using the 
TCC2 craft port, but they cannot communicate directly with any other DCC-connected ONS 15454. 

In addition, firewall is enabled, which means that the node prevents IP traffic from being routed 
between the DCC and the LAN port. The ONS 15454 can communicate with machines connected to 
the LAN port or connected through the DCC. However, the DCC-connected machines cannot 
communicate with the LAN-connected machines, and the LAN-connected machines cannot 
communicate with the DCC-connected machines. A CTC client using the LAN to connect to the 
firewall-enabled node can use the proxy capability to manage the DCC-connected nodes that would 
otherwise be unreachable. A CTC client connected to a DCC-connected node can only manage other 
DCC-connected nodes and the firewall itself. 

• Gateway Network Element (GNE)—If set as a GNE, the CTC computer is visible to other 
DCC-connected nodes and firewall is enabled.

• Proxy-only—If Proxy-only is selected, firewall is not enabled. CTC can communicate with any 
other DCC-connected ONS 15454s. 

Note If you launch CTC against a node through a Network Address Translation (NAT) or Port Address 
Translation (PAT) router and that node does not have proxy enabled, your CTC session starts and 
initially appears to be fine. However CTC never receives alarm updates and disconnects and reconnects 
every two minutes. If the proxy is accidentally disabled, it is still possible to enable the proxy during a 
reconnect cycle and recover your ability to manage the node, even through a NAT/PAT firewall.
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19.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 19-10 Proxy Server Gateway Settings (ANSI only)

Figure 19-11 Proxy Server Gateway Settings (ETSI only)
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19.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 19-12 shows an ONS 15454 proxy server implementation. A GNE ONS 15454 is connected to a 
central office LAN and to ENE ONS 15454s. The central office LAN is connected to a NOC LAN, which 
has CTC computers. The NOC CTC computer and craft technicians must both be able to access the 
ONS 15454 ENEs. However, the craft technicians must be prevented from accessing or seeing the NOC 
or central office LANs.

In the example, the ONS 15454 GNE is assigned an IP address within the central office LAN and is 
physically connected to the LAN through its LAN port. ONS 15454 ENEs are assigned IP addresses that 
are outside the central office LAN and given private network IP addresses. If the ONS 15454 ENEs are 
collocated, the craft LAN ports could be connected to a hub. However, the hub should have no other 
network connections. 

Figure 19-12 ONS 15454 Proxy Server with GNE and ENEs on the Same Subnet (ANSI and ETSI)

Table 19-2 shows recommended settings for ONS 15454 GNEs and ENEs in the configuration shown in 
Figure 19-12.
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Table 19-2 ONS 15454 Gateway and End NE Settings

Setting ONS 15454 Gateway NE ONS 15454 End NE

OSPF Off Off
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19.2.7   Scenario 7: Provisioning the ONS 15454 Proxy Server
Figure 19-13 shows the same proxy server implementation with ONS 15454 ENEs on different subnets. 
Figure 19-14 shows the implementation with ONS 15454 ENEs in multiple rings. In each example, 
ONS 15454 GNEs and ENEs are provisioned with the settings shown in Table 19-2.

Figure 19-13 Scenario 7: ONS 15454 Proxy Server with GNE and ENEs on Different Subnets (ANSI and 

ETSI)

SNTP server (if used) SNTP server IP address Set to ONS 15454 GNE IP address

SNMP (if used) SNMPv1 trap destinations Set SNMPv1 trap destinations to 
ONS 15454 GNE, port 391

Table 19-2 ONS 15454 Gateway and End NE Settings

Setting ONS 15454 Gateway NE ONS 15454 End NE
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Figure 19-14 Scenario 7: ONS 15454 Proxy Server With ENEs on Multiple Rings (ANSI and ETSI)

Table 19-3 shows the rules the ONS 15454 follows to filter packets for the firewall when nodes are 
configured as ENEs and GNEs. If the packet is addressed to the ONS 15454, additional rules, shown in 
Table 19-4, are applied. Rejected packets are silently discarded.
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Table 19-3 Proxy Server Firewall Filtering Rules

Packets Arriving At: Are Accepted if the Destination IP Address is:

TCC2 Ethernet 
interface

• The ONS 15454 itself

• The ONS 15454’s subnet broadcast address

• Within the 224.0.0.0/8 network (reserved network used for standard 
multicast messages)

• Subnet mask = 255.255.255.255

DCC interface • The ONS 15454 itself

• Any destination connected through another DCC interface

• Within the 224.0.0.0/8 network
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19.2.8   Scenario 8: Dual GNEs on a Subnet
If you implement the proxy server, note that all DCC-connected ONS 15454s on the same Ethernet 
segment must have the same gateway setting. Mixed values produce unpredictable results, and might 
leave some nodes unreachable through the shared Ethernet segment. 

If nodes become unreachable, correct the setting by performing one of the following:

• Disconnect the craft computer from the unreachable ONS 15454. Connect to the ONS 15454 
through another network ONS 15454 that has a DCC connection to the unreachable ONS 15454.

• Disconnect all DCCs to the node by disabling them on neighboring nodes. Connect a CTC computer 
directly to the ONS 15454 and change its provisioning.

19.2.8 Scenario 8: Dual GNEs on a Subnet
The ONS 15454 provides GNE load balancing, which allows CTC to reach ENEs over multiple GNEs 
without the ENEs being advertised over OSPF. This feature allows a network to quickly recover from 
the loss of GNE, even if the GNE is on a different subnet. If a GNE fails, all connections through that 
GNE fail. CTC disconnects from the failed GNE and from all ENEs for which the GNE was a proxy, and 
then reconnects through the remaining GNEs. GNE load balancing reduces the dependency on the launch 
GNE and DCC bandwidth, both of which enhance CTC performance. Figure 19-15 shows a network with 
dual GNEs on the same subnet. Figure 19-16 shows a network with dual GNEs on different subnets. 

Note Dual GNEs do not need special provisioning

Table 19-4 Proxy Server Firewall Filtering Rules When Packet Addressed to ONS 15454

Packets Arriving At Rejects

TCC2 Ethernet 
interface

• UDP1 packets addressed to the 
SNMP trap relay port (391)

1. UDP = User Datagram Protocol

DCC interface • TCP2 packets addressed to the 
proxy server port (1080)

2. TCP = Transmission Control Protocol
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Figure 19-15 Scenario 8: Dual GNEs on the Same Subnet (ANSI and ETSI)
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19.3   Provisionable Patchcords
Figure 19-16 Scenario 8: Dual GNEs on Different Subnets (ANSI and ETSI)

19.3 Provisionable Patchcords
A provisionable patchcord is a user-provisioned link that is advertised by OSPF throughout the network. 
Provisionable patchcords, also called virtual links, are needed in the following situations:

• An optical port is connected to a transponder or muxponder client port provisioned in transparent 
mode. 

• An optical ITU port is connected to a DWDM optical channel card.

• Two transponder or muxponder trunk ports are connected to a DWDM optical channel card and the 
generic control channel (GCC) is carried transparently through the ring. 

• Transponder or muxponder client and trunk ports are in a regenerator group, the cards are in 
transparent mode, and DCC/GCC termination is not available.

Provisionable patchcords are required on both ends of a physical link. The provisioning at each end 
includes a local patchcord ID, slot/port information, remote IP address, and remote patchcord ID. 
Patchcords appear as dashed lines in CTC network view.
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19.3   Provisionable Patchcords
Table 19-5 lists the supported card combinations for client and trunk ports in a provisionable patchcord.

Note If the OCSM card is installed in Slot 8, provisionable patchcords from OC-N ports to the following cards 
are not supported on the same node: MXP_2.5G_10G, TXP_MR_10G, TXP_MR_2.5G, 
TXPP_MR_2.5G, MXP_2.5G_10E, TXP_MR_10E, 32MUX-O, 32DMX-O, 32WSS, or 32DMX.

Table 19-6 lists the supported card combinations for client-to-client ports in a patchcord. 

Table 19-7 lists the supported card combinations for trunk-to-trunk ports in a patchcord. 

Table 19-5 Cisco ONS 15454 Client/Trunk Card Combinations for Provisionable Patchcords

Trunk Cards 

Client Cards

MXP_2.5G_10G/
TXP_MR_10G

TXP_MR_2.5G/
TXPP_MR_2.5G

MXP_2.5G_10E/
TXP_MR_10E

32MUX-O
32DMX-O

32WSS/
32DMX AD-xC-xx.x 4MD-xx.x

MXP_2.5G_10G/
TXP_MR_10G

— — — Yes Yes Yes Yes

TXP_MR_2.5G/
TXPP_MR_2.5G

— — — Yes Yes Yes Yes

MXP_2.5G_10E/
TXP_MR_10E

— — — Yes Yes Yes Yes

MXP_MR_2.5G/
MXPP_MR_2.5G

— — — Yes Yes Yes Yes

OC-192 Yes — Yes — — — —

OC-48 Yes Yes Yes — — — —

OC-192 ITU — — — Yes Yes Yes Yes

OC-48 ITU — — — Yes Yes Yes Yes

Table 19-6 Cisco ONS 15454 Client/Client Card Combinations for Provisionable Patchcords

Client Cards
MXP_2.5G_10G/
TXP_MR_10G

TXP_MR_2.5G/
TXPP_MR_2.5G

MXP_2.5G_10E/
TXP_MR_10E

MXP_2.5G_10G/TXP_MR_10G Yes — Yes

TXP_MR_2.5G/TXPP_MR_2.5G — Yes —

MXP_2.5G_10E/TXP_MR_10E Yes — Yes

Table 19-7 Cisco ONS 15454 Trunk/Trunk Card Combinations for Provisionable Patchcords

Trunk Cards
MXP_2.5G_10G/
TXP_MR_10G

TXP_MR_2.5G/
TXPP_MR_2.5G

MXP_2.5G_10E/
TXP_MR_10E

MXP_2.5G_10G/TXP_MR_10G Yes — Yes

TXP_MR_2.5G/TXPP_MR_2.5G — Yes —

MXP_2.5G_10E/TXP_MR_10E Yes — Yes
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Optical ports have the following requirements when used in a provisionable patchcord:

• An optical port connected to transponder/muxponder port or add/drop multiplexer or 
multiplexer/demultiplexer port requires section DCC/line DCC (SDCC/LDCC) termination. 

• If the optical port is the protection port in a 1+1 group, the working port must have SDCC/LDCC 
termination provisioned. 

• If the remote end of a patchcord is Y-cable protected or is an add/drop multiplexer or 
multiplexer/demultiplexer port, an optical port requires two patchcords.

Transponder and muxponder ports have the following requirements when used in a provisionable 
patchcord:

• Two patchcords are required when a transponder/muxponder port is connected to an add/drop 
multiplexer or multiplexer/demultiplexer port. CTC automatically prompts the user to set up the 
second patchcord.

• If a patchcord is on a client port in a regenerator group, the other end of the patchcord must be on 
the same node and on a port within the same regenerator group. 

• A patchcord is allowed on a client port only if the card is in transparent mode. 

DWDM cards support provisionable patchcords only on optical channel ports. Each DWDM optical 
channel port can have only one provisionable patchcord.

19.4 Routing Table
ONS 15454 routing information is displayed on the Maintenance > Routing Table tabs. The routing table 
provides the following information:

• Destination—Displays the IP address of the destination network or host.

• Mask—Displays the subnet mask used to reach the destination host or network.

• Gateway—Displays the IP address of the gateway used to reach the destination network or host.

• Usage—Shows the number of times the listed route has been used.

• Interface—Shows the ONS 15454 interface used to access the destination. Values are:

– motfcc0—The ONS 15454 Ethernet interface, that is, the RJ-45 jack on the TCC2 and, for 
ANSI shelves, the LAN 1 pins on the backplane or, for ETSI shelves, the LAN connection on 
the MIC-C/T/P.

– pdcc0—An SDCC interface, that is, an OC-N trunk card identified as the SDCC termination.

– lo0—A loopback interface.

Table 19-8 shows sample routing entries for an ONS 15454.

Table 19-8 Sample Routing Table Entries

Entry Destination Mask Gateway Usage Interface

1 0.0.0.0 0.0.0.0 172.20.214.1 265103 motfcc0

2 172.20.214.0 255.255.255.0 172.20.214.92 0 motfcc0

3 172.20.214.92 255.255.255.255 127.0.0.1 54 lo0

4 172.20.214.93 255.255.255.255 0.0.0.0 16853 pdcc0

5 172.20.214.94 255.255.255.255 172.20.214.93 16853 pdcc0
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19.5   External Firewalls
Entry 1 shows the following:

• Destination (0.0.0.0) is the default route entry. All undefined destination network or host entries on 
this routing table are mapped to the default route entry.

• Mask (0.0.0.0) is always 0 for the default route.

• Gateway (172.20.214.1) is the default gateway address. All outbound traffic that cannot be found in 
this routing table or is not on the node’s local subnet is sent to this gateway.

• Interface (motfcc0) indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 2 shows the following:

• Destination (172.20.214.0) is the destination network IP address.

• Mask (255.255.255.0) is a 24-bit mask, meaning all addresses within the 172.20.214.0 subnet can 
be a destination.

• Gateway (172.20.214.92) is the gateway address. All outbound traffic belonging to this network is 
sent to this gateway. 

• Interface (motfcc0) indicates that the ONS 15454 Ethernet interface is used to reach the gateway.

Entry 3 shows the following:

• Destination (172.20.214.92) is the destination host IP address.

• Mask (255.255.255.255) is a 32 bit mask, meaning only the 172.20.214.92 address is a destination.

• Gateway (127.0.0.1) is a loopback address. The host directs network traffic to itself using this 
address.

• Interface (lo0) indicates that the local loopback interface is used to reach the gateway. 

Entry 4 shows the following:

• Destination (172.20.214.93) is the destination host IP address.

• Mask (255.255.255.255) is a 32 bit mask, meaning only the 172.20.214.93 address is a destination.

• Gateway (0.0.0.0) means the destination host is directly attached to the node.

• Interface (pdcc0) indicates that a DCC interface is used to reach the destination host.

Entry 5 shows a DCC-connected node that is accessible through a node that is not directly connected:

• Destination (172.20.214.94) is the destination host IP address.

• Mask (255.255.255.255) is a 32-bit mask, meaning only the 172.20.214.94 address is a destination.

• Gateway (172.20.214.93) indicates that the destination host is accessed through a node with IP 
address 172.20.214.93.

• Interface (pdcc0) indicates that a DCC interface is used to reach the gateway.

19.5 External Firewalls
This section provides sample access control lists for external firewalls. Table 19-9 lists the ports that are 
used by the TCC2. 
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The following access control list (ACL) example shows a firewall configuration when the proxy server 
gateway setting is not enabled. In the example, the CTC workstation's address is 192.168.10.10. and the 
ONS 15454 address is 10.10.10.100. The firewall is attached to the GNE, so inbound is CTC to the GNE 
and outbound is from the GNE to CTC. The CTC Common Object Request Broker Architecture 
(CORBA) Standard constant is 683 and the TCC CORBA Default is TCC Fixed (57790).

access-list 100 remark *** Inbound ACL, CTC -> NE *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq www 
access-list 100 remark *** allows initial contact with ONS 15454 using http (port 80) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq 57790 
access-list 100 remark *** allows CTC communication with ONS 15454 GNE (port 57790) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 established 
access-list 100 remark *** allows ACKs back from CTC to ONS 15454 GNE *** 

access-list 101 remark *** Outbound ACL, NE -> CTC *** 
access-list 101 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 eq 683 

Table 19-9 Ports Used by the TCC2

Port Function

0 Reserved

21 FTP control

23 Telnet

80 HTTP

111 rpc (not used; but port is in use)

513 rlogin (not used; but port is in use)

>1023 Default CTC listener ports

1080 Proxy server

2001–2017 Input/Output (I/O) card Telnet

2018 Reserved

2361 TL1

3082 TL1

3083 TL1

5001 BLSR server port (ANSI) 
MS-SPRing server port (ETSI)

5002 BLSR client port (ANSI) 
MS-SPRing client port (ANSI) 

7200 SNMP input port

9100 EQM port

9101 EQM port 2

9401 TCC boot port

10240-12288 Proxy client

57790 Default TCC listener port
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access-list 101 remark *** allows alarms etc., from the 15454 (random port) to the CTC 
workstation (port 683) *** 
access-list 100 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 established 
access-list 101 remark *** allows ACKs from the 15454 GNE to CTC *** 

The following ACL example shows a firewall configuration when the proxy server gateway setting is 
enabled. As with the first example, the CTC workstation address is 192.168.10.10 and the ONS 15454 
address is 10.10.10.100. The firewall is attached to the GNE, so inbound is CTC to the GNE and 
outbound is from the GNE to CTC. CTC CORBA Standard constant is 683 and TCC CORBA Default is 
TCC Fixed (57790).

access-list 100 remark *** Inbound ACL, CTC -> NE *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq www 
access-list 100 remark *** allows initial contact with the 15454 using http (port 80) *** 
access-list 100 remark 
access-list 100 permit tcp host 192.168.10.10 host 10.10.10.100 eq 1080
access-list 100 remark *** allows CTC communication with the 15454 GNE (port 1080) *** 
access-list 100 remark 

access-list 101 remark *** Outbound ACL, NE -> CTC *** 
access-list 101 remark 
access-list 101 permit tcp host 10.10.10.100 host 192.168.10.10 established 
access-list 101 remark *** allows ACKs from the 15454 GNE to CTC *** 

19.6 Open GNE
The ONS 15454 can communicate with non-ONS nodes that do not support Point-to-Point Protocol 
(PPP) vendor extensions or OSPF type 10 opaque link-state advertisements (LSA), both of which are 
necessary for automatic node and link discovery. An open GNE configuration allows a GCC-based 
network to function as an IP network for non-ONS nodes. 

To configure an open GNE network, you can provision GCC terminations to include a far-end, non-ONS 
node using either the default IP address of 0.0.0.0 or a specified IP address. You provision a far-end, 
non-ONS node by checking the “Far End is Foreign” check box during GCC creation. The default 0.0.0.0 
IP address allows the far-end, non-ONS node to identify itself with any IP address; if you set an IP 
address other than 0.0.0.0, a link is established only if the far-end node identifies itself with that IP 
address, providing an extra level of security. 

By default, the proxy server only allows connections to discovered ONS peers and the firewall blocks 
all IP traffic between the GCC network and LAN. You can, however, provision proxy tunnels to allow 
up to 12 additional destinations for SOCKS version 5 connections to non-ONS nodes. You can also 
provision firewall tunnels to allow up to 12 additional destinations for direct IP connectivity between 
the GCC network and LAN. Proxy and firewall tunnels include both a source and destination subnet. 
The connection must originate within the source subnet and terminate within the destination subnet 
before either the SOCKS connection or IP packet flow is allowed. A proxy connection is allowed if the 
CTC client is in a source subnet and the requested destination is in the destination subnet. Firewall 
tunnels allow IP traffic to route between the node Ethernet and pdcc interfaces. A inbound Ethernet 
packet is allowed through the firewall if its source address matches a tunnel source and its destination 
matches a tunnel destination. An inbound pdcc packet is allowed through the firewall if its source 
address matches a tunnel destination and its destination address matches a tunnel source. Tunnels only 
affect TCP and UDP packets.

To set up proxy and firewall subnets in CTC, see the “DLP-G97 Provision a Proxy Tunnel” task on 
page 5-10 and the “DLP-G98 Provision a Firewall Tunnel” task on page 5-11. The availability of proxy 
and/or firewall tunnels depends on the network access settings of the node:
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• If the node is configured with the proxy server enabled in GNE or ENE mode, you must set up a 
proxy tunnel and/or a firewall tunnel. 

• If the node is configured with the proxy server enabled in proxy-only mode, you can set up proxy 
tunnels. Firewall tunnels are not allowed.

• If the node is configured with the proxy server disabled, neither proxy tunnels or firewall tunnels 
are allowed. 

Figure 19-17 shows an example of a foreign node connected to the GCC network. Proxy and firewall 
tunnels are useful in this example because the GNE would otherwise block IP access between the PC 
and the foreign node.

Figure 19-17 Proxy and Firewall Tunnels for Foreign Terminations

Figure 19-18 shows a remote node connected to an ENE Ethernet port. Proxy and firewall tunnels are 
useful in this example because the GNE would otherwise block IP access between the PC and foreign 
node. This configuration also requires a firewall tunnel on the ENE.
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Figure 19-18 Foreign Node Connection to an ENE Ethernet Port
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C H A P T E R 20

Alarm Monitoring and Management

This chapter describes Cisco Transport Controller (CTC) alarm management. To troubleshoot specific 
alarms, refer to the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide. 

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Chapter topics include:

• 20.1 Overview, page 20-1

• 20.2 Alarm Counts on the LCD for a Node, Slot, or Port, page 20-2

• 20.3 Alarm Display, page 20-2

• 20.4 Alarm Severities, page 20-8

• 20.5 Alarm Profiles, page 20-9

• 20.6 Alarm Suppression, page 20-13

• 20.7 External Alarms and Controls, page 20-13

• 20.8 Audit Trail, page 20-15

20.1 Overview
CTC detects and reports alarms generated by the Cisco ONS 15454 and the larger network. You can use 
CTC to monitor and manage alarms at the card, node, or network level. Default alarm severities conform 
to the Telcordia GR-253 standard, but you can set alarm severities in customized alarm profiles or 
suppress CTC alarm reporting. For a detailed description of the standard Telcordia categories employed 
by Optical Networking System (ONS) nodes, refer to the Cisco ONS 15454 SONET and DWDM 
Troubleshooting Guide.

Note ONS 15454 alarms can also be monitored and managed through Transaction Language One (TL1) or a 
network management system (NMS).
20-1
 Installation and Operations Guide, R4.7



Chapter 20      Alarm Monitoring and Management
20.2   Alarm Counts on the LCD for a Node, Slot, or Port
20.2 Alarm Counts on the LCD for a Node, Slot, or Port
You can view node, slot, or port-level alarm counts and summaries using the buttons on the ONS 15454 
LCD panel. The Slot and Port buttons toggle between display types; the Slot button toggles between 
node display and slot display, and the Port button toggles between slot and port views. Pressing the 
Status button after you choose the display mode changes the display from alarm count to alarm summary.

The ONS 15454 has a one-button update for some commonly viewed alarm counts. If you press the Slot 
button once and then wait eight seconds, the display automatically changes from a slot alarm count to a 
slot alarm summary. If you press the Port button to toggle to port-level display, you can use the Port 
button to toggle to a specific slot and to view each port’s port-level alarm count. Figure 20-1 shows the 
LCD panel layout.

Figure 20-1 Shelf LCD Panel 

20.3 Alarm Display
In the card-, node-, or network-level CTC view, click the Alarms tab to display the alarms for that card, 
node, or network. The Alarms window shows alarms in conformance with Telcordia GR-253. This 
means that if a network problem causes two alarms, such as loss of frame (LOF) and loss of signal 
(LOS), CTC only shows the LOS alarm in this window because it supersedes the LOF and replaces it. 

The Path Width column in the Alarms and Conditions tabs expands upon alarmed object information 
contained in the access identifier (AID) string (such as “STS-4-1-3”) by giving the number of STSs 
contained in the alarmed path. For example, the Path Width tells you whether a critical alarm applies to 
an STS1 or an STS48c. The column reports the width as a 1, 3, 6, 12, 48, etc. as appropriate, understood 
to be “STS-n.” 

Table 7-1 on page 7-7 lists the column headings and the information recorded in each column and 
Table 7-2 on page 7-8 lists the color codes for alarm and condition severities.

20.3.1 Viewing Alarms With Each Node’s Time Zone
By default, alarms and conditions are displayed with the time stamp of the CTC workstation where you 
are viewing them. But you can set the node to report alarms (and conditions) using the time zone where 
the node is located by clicking Edit > Preferences, and clicking the Display Events Using Each Node’s 
Timezone check box. See the “DLP-G118 Display Alarms and Conditions Using Time Zone” task on 
page 7-11.
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20.3.2 Controlling Alarm Display
You can control the display of the alarms shown on the Alarms window. Table 20-1 shows the actions 
you can perform in the Alarms window.

20.3.3 Filtering Alarms
The alarm display can be filtered to prevent the display of alarms with certain severities or alarms that 
occurred between certain dates. You can set the filtering parameters by clicking the Filter button at the 
bottom-left of the Alarms window. You can turn the filter on or off by clicking the Filter tool at the 
bottom-right of the window. CTC retains your filter activation setting. For example, if you turn the filter 
on and then log out, CTC keeps the filter active the next time you log in.

See the “NTP-G69 Enable, Modify, or Disable Alarm Severity Filtering” procedure on page 7-29.

20.3.4 Viewing Alarm-Affected Circuits
A user can view which ONS 15454 circuits are affected by a specific alarm by positioning the cursor 
over the alarm in the Alarm window and right-clicking. A shortcut menu appears (Figure 20-2). 

See the “NTP-G66 View Alarm-Affected Circuits” procedure on page 7-14.

Table 20-1 Alarm Display

Button/Check Box/Tool Action

Filter button Allows you to change the display on the Alarms window to show only 
alarms that meet a certain severity level, occur in a specified time frame, 
and/or reflect specific conditions. For example, you can set the filter so that 
only critical alarms display in the window.

If you enable the Filter feature by clicking the Filter button in one CTC 
view, such as node view, it is enabled in the others as well (card view and 
network view).

Synchronize button Updates the alarm display. Although CTC displays alarms in real time, the 
Synchronize button allows you to verify the alarm display. This is 
particularly useful during provisioning or troubleshooting.

Delete Cleared Alarms 
button

Deletes alarms that have been cleared.

AutoDelete Cleared 
Alarms check box

If checked, CTC automatically deletes cleared alarms.

Filter tool Enables or disables alarm filtering in the card, node, or network view. When 
enabled or disabled, this state applies to other views for that node and for 
all other nodes in the network. For example, if the Filter tool is enabled in 
the node (default login) view Alarms window, the network view Alarms 
window and card view Alarms window also show the tool enabled. All other 
nodes in the network also show the tool enabled.
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Figure 20-2 Select Affected Circuits Option 

When the user selects the Select Affected Circuits option, the Circuits window appears to show the 
circuits that are affected by the alarm (Figure 20-3).

Figure 20-3 Viewing Alarm-Affected Circuits
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20.3.5 Conditions Tab
The Conditions window displays retrieved fault conditions. A condition is a fault or status detected by 
ONS 15454 hardware or software. When a condition occurs and continues for a minimum period, CTC 
raises a condition, which is a flag showing that this particular condition currently exists on the 
ONS 15454. See the “DLP-G120 View Conditions” task on page 7-12.

The Conditions window shows all conditions that occur, including those that are superseded. For 
instance, if a network problem causes two alarms, such as LOF and LOS, CTC shows both the LOF and 
LOS conditions in this window (even though LOS supersedes LOF). Having all conditions visible can 
be helpful when troubleshooting the ONS 15454. If you want to retrieve conditions that obey a 
root-cause hierarchy (that is, LOS supersedes and replaces LOF), you can exclude the same root causes 
by checking a check box in the window.

Fault conditions include reported alarms and Not Reported or Not Alarmed conditions. Refer to the 
trouble notifications information in the Cisco ONS 15454 SONET and DWDM Troubleshooting Guide 
for more information about alarm and condition classifications.

20.3.6 Controlling the Conditions Display
You can control the display of the conditions on the Conditions window. Table 20-2 shows the actions 
you can perform in the window.

20.3.6.1 Retrieving and Displaying Conditions

The current set of all existing conditions maintained by the alarm manager can be seen when you click 
the Retrieve button. The set of conditions retrieved is relative to the view. For example, if you click the 
button while displaying the node view, node-specific conditions are displayed. If you click the button 
while displaying the network view, all conditions for the network (including ONS 15454 nodes and other 
connected nodes) are displayed, and the card view shows only card-specific conditions.

You can also set a node to display conditions using the time zone where the node is located, rather than 
the time zone of the PC where they are being viewed. See the “20.3.1 Viewing Alarms With Each Node’s 
Time Zone” section on page 20-2 for more information.

Table 20-2 Conditions Display

Button Action

Retrieve Retrieves the current set of all existing fault conditions, as maintained by 
the alarm manager, from the ONS 15454.

Filter Allows you to change the Conditions window display to only show the 
conditions that meet a certain severity level or occur in a specified time 
frame. For example, you can set the filter so that only critical conditions 
display on the window.

There is a Filter button on the lower-right of the window that allows you to 
enable or disable the filter feature.

Exclude Same Root 
Cause

Retrieves conditions that obey a root-cause hierarchy (LOS supersedes and 
replaces LOF).
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20.3.6.2 Conditions Column Descriptions

Table 20-3 lists the Conditions window column headings and the information recorded in each column.

20.3.6.3 Filtering Conditions

The condition display can be filtered to prevent display of conditions (including alarms) with certain 
severities or that occurred between certain dates. You can set the filtering parameters by clicking the 
Filter button at the bottom-left of the Conditions window. You can turn the filter on or off by clicking 
the Filter tool at the bottom-right of the window. CTC retains your filter activation setting. For example, 
if you turn the filter on and then log out, CTC keeps the filter active the next time your user ID is 
activated.

20.3.7 Viewing History
The History window displays historic alarm or condition data for the node or for your login session. You 
can chose to display only alarm history, only events, or both by checking check boxes in the History > 
Node window. You can view network-level alarm and condition history, such as for circuits, at that 
level. At the node level, you can see all port (facility), card, STS, and system-level history entries. For 
example, protection-switching events or performance-monitoring threshold crossings appear here. If 
you double-click a card, you can view all port, card, and STS alarm or condition history that directly 
affects the card. See the “DLP-G116 View Alarm or Event History” task on page 7-8.

The ONS 15454 can store up to 640 critical alarm messages, 640 major alarm messages, 640 minor alarm 
messages, and 640 condition messages. When any of these limits is reached, the ONS 15454 discards 
the oldest events in that category.

Table 20-3 Conditions Column Description

Column Information Recorded

Date Date and time of the condition.

Object TL1 AID for the condition object. For an STSmon or VTmon, the object.

Eqpt Type Card type in this slot.

Slot Slot where the condition occurred (appears only in network and node view).

Port Port where the condition occurred. For STSTerm and VTTerm, the port refers to the 
upstream card it is partnered with.

Path Width Width of the data path

Sev1

1. All alarms, their severities, and service-affecting statuses are also displayed in the Condition tab unless you choose to filter 
the alarm from the display using the Filter button.

Severity level: CR (Critical), MJ (Major), MN (Minor), NA (Not Alarmed), NR 
(Not Reported).

SA1 Indicates a service-affecting alarm (when checked).

Cond The error message/alarm name; these names are alphabetically defined in the 
Cisco ONS 15454 SONET and DWDM Troubleshooting Guide.

Description Description of the condition.
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Note In the Preference dialog General tab, the Maximum History Entries value only applies to the Session 
window.

Different views of CTC display different kinds of history:

• The History > Session window is shown in network view, node view, and card view. It shows alarms 
and conditions that occurred during the current user CTC session. 

• The History > Node window is only shown in node view. It shows the alarms and conditions that 
occurred on the node since CTC software was operated on the node. 

• The History > Card window is only shown in card view. It shows the alarms and conditions that 
occurred on the card since CTC software was installed on the node. 

Tip Double-click an alarm in the History window to display the corresponding view. For example, 
double-clicking a card alarm takes you to card view. In network view, double-clicking a node alarm 
takes you to node view.

If you check the History window Alarms check box, you display the node history of alarms. If you check 
the Events check box, you display the node history of Not Alarmed and transient events (conditions). If 
you check both check boxes, you retrieve node history for both. 

20.3.7.1 History Column Descriptions

Table 20-4 lists the History window column headings and the information recorded in each column.

Table 20-4 History Column Description

Column Information Recorded

Num Num (number) is the quantity of alarm messages received, and is incremented 
automatically as alarms occur to display the current total of received error messages. 
(The column is hidden by default; to view it, right-click a column and choose Show 
Column.) 

Ref Ref (reference) is a unique identification number assigned to each alarm to reference a 
specific alarm message that is displayed. (The column is hidden by default; to view it, 
right-click a column and choose Show Column.) 

Date Date and time of the condition.

Object TL1 AID for the condition object. For an STSmon or VTmon, this is the monitored STS 
or VT object.

Slot Slot where the condition occurred (only displays in network view and node view).

Port Port where the condition occurred. For STSTerm and VTTerm, the port refers to the 
upstream card it is partnered with.

Path Width Width of the data path.

Sev Severity level: Critical (CR), Major (MJ), Minor (MN), Not Alarmed (NA), 
Not Reported (NR).

ST Status: raised (R), cleared (C), or transient (T).

SA Indicates a service-affecting alarm (when checked).
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20.3.7.2 Retrieving and Displaying Alarm and Condition History

You can retrieve and view the history of alarms and conditions, as well as transients (passing 
notifications of processes as they occur) in the CTC history window. The information in this window is 
specific to the view where it is shown (that is, network history in the network view, node history in the 
node view, and card history in the card view). 

The node and card history views are each divided into two tabs. In node view, when you click the 
Retrieve button, you can see the history of alarms, conditions, and transients that have occurred on the 
node in the History > Node window, and the history of alarms, conditions, and transients that have 
occurred on the node during your login session in the History > Session window. In the card-view 
history window, after you retrieve the card history, you can see the history of alarms, conditions, and 
transients on the card in the History > Card window, or a history of alarms, conditions, and transients 
that have occurred during your login session in the History > Session window.

You can also filter the severities and occurrence period in these history windows.

20.4 Alarm Severities
ONS 15454 alarm severities follow the Telcordia GR-253 standard, so a condition might be Alarmed (at 
a severity of Critical [CR], Major [MJ], or Minor [MN]), Not Alarmed (NA), or Not Reported (NR). 
These severities are reported in the CTC software Alarms, Conditions, and History windows at all levels: 
network, shelf, and card.

ONS equipment provides a standard profile named Default listing all alarms and conditions with severity 
settings based on Telcordia GR-253 and other standards, but users can create their own profiles with 
different settings for some or all conditions and apply these wherever desired. (See the “20.5 Alarm 
Profiles” section on page 20-9.) For example, in a custom alarm profile, the default severity of a carrier 
loss (CARLOSS) alarm on an Ethernet port could be changed from major to critical. The profile allows 
setting to Not Reported or Not Alarmed, as well as the three alarmed severities.

Critical and Major severities are only used for service-affecting alarms. If a condition is set as Critical 
or Major by profile, it will raise as Minor alarm in the following situations: 

• In a protection group, if the alarm is on a standby entity (the side not carrying traffic)

• If the alarmed entity has no traffic provisioned on it, so no service is lost

Because of this possibility of being raised at two different levels, the alarm profile pane shows Critical 
as CR / MN and Major as MJ / MN.

Cond Condition name.

Description Description of the condition.

Eqpt Type Card type in this slot.

Table 20-4 History Column Description (continued)

Column Information Recorded
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20.5 Alarm Profiles
The alarm profiles feature allows you to change default alarm severities by creating unique alarm profiles 
for individual ONS 15454 ports, cards, or nodes. A created alarm profile can be applied to any node on 
the network. Alarm profiles can be saved to a file and imported elsewhere in the network, but the profile 
must be stored locally on a node before it can be applied to the node, its cards, or its cards’ ports. 

CTC can store up to ten active alarm profiles at any time to apply to the node. Custom profiles can take 
eight of these active profile positions. Two other profiles, Default profile and Inherited profile, are 
reserved by the NE, and cannot be edited.The reserved Default profile contains Telcordia GR-253 
severities. The reserved Inherited profile allows port alarm severities to be governed by the card-level 
severities, or card alarm severities to be determined by the node-level severities.

If one or more alarm profiles have been stored as files from elsewhere in the network onto the local PC 
or server hard drive where CTC resides, you can utilize as many profiles as you can physically store by 
deleting and replacing them locally in CTC so that only eight are active at any given time.

See the “NTP-G68 Create, Download, and Assign Alarm Severity Profiles” procedure on page 7-17.

20.5.1 Creating and Modifying Alarm Profiles
Alarm profiles are created in the network view using the Provisioning > Alarm Profiles tabs. Figure 20-4 
shows the default list of alarm severities. A default alarm severity following Telcordia GR-253 standards 
is preprovisioned for every alarm. After loading the default profile or another profile on the node, you 
can clone a profile to create custom profiles. After the new profile is created, the Alarm Profiles window 
shows the original profile—frequently Default—and the new profile.

Figure 20-4 Network View Alarm Profiles Window
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Note The alarm profile list contains a master list of alarms that is used for a mixed node network. Some of 
these alarms might not be used in all ONS nodes.

Note The Default alarm profile list contains alarm and condition severities that correspond when applicable 
to default values established in Telcordia GR-253.

Note All default or user-defined severity settings that are Critical (CR) or Major (MJ) are demoted to Minor 
(MN) in non-service-affecting situations as defined in Telcordia GR-474. 

Tip To see the full list of profiles, including those available for loading or cloning, click the Available 
button. You must load a profile before you can clone it. 

Note Up to 10 profiles, including the two reserved profiles—Inherited and Default—can be stored in CTC.

Wherever it is applied, the Default alarm profile sets severities to standard Telcordia GR-253 settings. 
In the Inherited profile, alarms inherit, or copy, severity from the next-highest level. For example, a card 
with an Inherited alarm profile copies the severities used by the node housing the card. If you choose the 
Inherited profile from the network view, the severities at the lower levels (node and card) are copied 
from this selection. 

You do not have to apply a single severity profile to the node-, card-, and port-level alarms. Different 
profiles can be applied at different levels. You could use the inherited or default profile on a node and 
on all cards and ports, but apply a custom profile that downgrades an alarm on one particular card. For 
example, you might choose to downgrade an OC-N unequipped path alarm (UNEQ-P) from Critical 
(CR) to Not Alarmed (NA) on an optical card because this alarm raises and then clears every time you 
create a circuit. UNEQ-P alarms for the card with the custom profile would not display on the Alarms 
tab (but they would still be recorded on the Conditions and History tabs.) 

When you modify severities in an alarm profile:

• All Critical (CR) or Major (MJ) default or user-defined severity settings are demoted to Minor (MN) 
in Non-Service-Affecting (NSA) situations as defined in Telcordia GR-474. 

• Default severities are used for all alarms and conditions until you create a new profile and apply it. 

The Load and Store buttons are not available for Retrieve and Maintenance users.

The Delete and Store options will only display nodes to delete profiles from or store profiles to if the 
user has provisioning permission for those nodes. If the user does not have the proper permissions, CTC 
greys out the buttons and they are not available to the user.

20.5.2 Alarm Profile Buttons
The Alarm Profiles window displays six buttons at the bottom of the screen. Table 20-5 lists and 
describes each of the alarm profile buttons and their functions. 
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20.5.3 Alarm Profile Editing
Table 20-6 lists and describes the five profile-editing options available when you right-click an alarm 
item in the profile column (such as Default). 

20.5.4 Alarm Severity Options
To change or assign alarm severity, left-click the alarm severity you want to change in the alarm profile 
column. Seven severity levels appear for the alarm:

• Not Reported (NR)

• Not Alarmed (NA)

• Minor (MN)

• Major (MJ) 

• Critical (CR)

• Use Default

• Inherited

Inherited and Use Default severity levels only appear in alarm profiles. They do not appear when you 
view alarms, history, or conditions. 

Table 20-5 Alarm Profile Buttons

Button Description

New Creates a new profile.

Load Loads a profile to a node or a file.

Store Saves profiles on a node (or nodes) or in a file.

Delete Deletes profiles from a node.

Compare Displays differences between alarm profiles (for example, individual alarms that 
are not configured equivalently between profiles).

Available Displays all profiles available on each node.

Usage Displays all entities (nodes and alarm subjects) present in the network and which 
profiles contain the alarm. Can be printed.

Table 20-6 Alarm Profile Editing Options

Button Description

Store Saves a profile in a node or in a file.

Rename Changes a profile name.

Clone Creates a profile that contains the same alarm severity settings as the profile being cloned.

Reset Restores a profile to its previous state or to the original state (if it has not yet been applied).

Remove Removes a profile from the table editor.
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20.5.5 Row Display Options
In the network or node view, the Alarm Profiles window (Alarm Profile Editor for Node view) displays 
three check boxes at the bottom of the window:

• Only show service-affecting severities—If unchecked, the editor shows severities in the format 
sev1/sev2 where sev1 is a service-affecting severity and sev2 is not service-affecting. If checked, the 
editor only shows sev1 alarms.

• Hide reference values—Highlights alarms with nondefault severities by clearing alarm cells with 
default severities.

• Hide identical rows—Hides rows of alarms that contain the same severity for each profile. 

20.5.6 Applying Alarm Profiles
In CTC node view, the Alarm Behavior window displays alarm profiles for the node. In card view, the 
Alarm Behavior window displays the alarm profiles for the selected card. Alarm profiles form a 
hierarchy. A node-level alarm profile applies to all cards in the node except cards that have their own 
profiles. A card-level alarm profile applies to all ports on the card except ports that have their own 
profiles.

At the node level, you can apply profile changes on a card-by-card basis or set a profile for the entire 
node. At the card-level view, you can apply profile changes on a port-by-port basis or set alarm profiles 
for all ports on that card. Figure 20-5 shows the E1000-2-G card view of an alarm profile.

Figure 20-5 Card View of an E1000-2-G Card Alarm Profile
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20.6 Alarm Suppression
ONS 15454 nodes have an alarm suppression option that clears raised alarm messages for the node, 
chassis, one or more slots (cards), or one or more ports. After they are cleared, these alarms change 
appearance from their normal severity color to white and they can be cleared from the display by clicking 
Synchronize. Alarm suppression itself raises an alarm called AS-CMD that is shown in applicable 
Alarms windows. Node-level suppression is shown in the node view Alarms window, and card or 
port-level suppression is shown in all views. The AS-CMD alarm itself is not cleared by the suppress 
command. Each instance of this alarm indicates its object separately in the Object column.

A suppression command applied at a higher level does not supersede a command applied at a lower level. 
For example, applying a node-level alarm suppression command makes all raised alarms for the node 
appear to be cleared, but it does not cancel out card-level or port-level suppression. Each of these 
conditions can exist independently and must be cleared independently. 

Suppression causes the entity alarm to behave like a Not Reported event. This means that the alarms, 
having been suppressed from view in the Alarms window, are now only shown in the Conditions window. 
The suppressed alarms are displayed with their usual visual characteristics (service-affecting status and 
color-coding) in the window. The alarms still appear in the History window.

See the “NTP-G70 Suppress Alarms or Discontinue Alarm Suppression” procedure on page 7-33.

Note Use alarm suppression with caution. If multiple CTC or TL1 sessions are open, suppressing the alarms 
in one session suppresses the alarms in all other open sessions.

20.7 External Alarms and Controls
External alarm inputs can be provisioned on the Alarm Interface Controller (AIC) or Alarm Interface 
Controller–International (AIC-I) cards for external sensors such as an open door and flood sensors, 
temperature sensors, and other environmental conditions. External control outputs on these two cards 
allow you to drive external visual or audible devices such as bells and lights. They can control other 
devices such as generators, heaters, and fans.

You provision external alarms in the AIC card view Provisioning > External Alarms tab and controls in 
the AIC card view Provisioning > External Controls tab. Up to 4 external alarm inputs and four external 
controls are available with the AIC card. Up to 12 external alarm inputs and four external controls are 
available with the AIC-I card. If you also provision the alarm extension panel (AEP) with the AIC-I, 
there are 32 inputs and 16 outputs. 

Note The AEP is compatible with the ONS 15454 ANSI shelf. It is not compatible with the ONS 15454 ETSI 
shelf.

See the “NTP-G71 Provision External Alarms and Controls on the Alarm Interface Controller Card” 
procedure on page 7-36 or the “NTP-G72 Provision External Alarms and Controls on the Alarm 
Interface Controller-International” procedure on page 7-38.
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20.7.1 External Alarms
You can provision each alarm input separately. Provisionable characteristics of external alarm inputs 
include:

• Alarm Type—List of alarm types.

• Severity—CR, MJ, MN, NA, and NR.

• Virtual Wire—The virtual wire associated with the alarm.

• Raised When—Open means that the normal condition is no current flowing through the contact, and 
the alarm is generated when current does flow; closed means that normal condition is to have current 
flowing through the contact, and the alarm is generated when current stops flowing.

• Description—CTC alarm log description (up to 63 characters).

Note If you provision an external alarm to raise upon an open contact before you physically connect 
to the ONS equipment, the alarm will raise until you do create the physical connection.

Note When you provision an external alarm, the alarm object is ENV-IN-nn. The variable nn refers to 
the external alarm’s number, regardless of the name you assign.

20.7.2 External Controls
You can provision each alarm output separately. Provisionable characteristics of alarm outputs include:

• Control type.

• Trigger type (alarm or virtual wire).

• Description for CTC display.

• Closure setting (manually or by trigger). If you provision the output closure to be triggered, the 
following characteristics can be used as triggers:

– Local NE alarm severity—A chosen alarm severity (for example, major) and any higher-severity 
alarm (in this case, critical) causes output closure.

– Remote NE alarm severity—Similar to local NE alarm severity trigger setting, but applies to 
remote alarms.

– Virtual wire entities—You can provision an alarm that is input to a virtual wire to trigger an 
external control output.

20.7.3 Virtual Wires
Provisioning the AIC and AIC-I card provides a “virtual wires” option used to route external alarms and 
controls from different nodes to one or more alarm collection centers. In Figure 20-6, smoke detectors 
at Nodes 1, 2, 3, and 4 are assigned to Virtual Wire #1, and Virtual Wire #1 is provisioned as the trigger 
for an external bell at Node 1. 
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Figure 20-6 External Alarms and Controls Using a Virtual Wire

When using AIC virtual wires, you can:

• Assign different external devices to the same virtual wire.

• Assign virtual wires as the trigger type for different external controls.

20.8 Audit Trail
The Cisco ONS 15454 maintains a Telcordia GR-839-CORE-compliant audit trail log that resides on the 
TCC2. This record shows who has accessed the system and what operations were performed during a 
given period of time. The log includes authorized Cisco logins and logouts using the operating system 

command line interface, CTC, and TL1; the log also includes FTP actions, circuit creation/deletion, and 
user/system generated actions.

Event monitoring is also recorded in the audit log. An event is defined as the change in status of an 
element within the network. External events, internal events, attribute changes, and software 
upload/download activities are recorded in the audit trail.
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Audit trails are useful for maintaining security, recovering lost transactions and enforcing 
accountability. Accountability refers to tracing user activities; that is, associating a process or action 
with a specific user. Users can access the audit trail logs from any management interface (CTC, CTM, 
TL1).

The audit trail is stored in persistent memory and is not corrupted by processor switches, resets or 
upgrades. However, if a user pulls both TCC2 cards, the audit trail log is lost.

See the “NTP-G108 Viewing the Audit Trail Records” procedure on page 11-19 and the “NTP-G109 
Off-Load the Audit Trail Record” procedure on page 11-21.

20.8.1 Audit Trail Log Entries
Audit trail records capture the following activities:

• User—Name of the user performing the action

• Host—Host from where the activity is logged

• Device ID—IP address of the device involved in the activity

• Application—Name of the application involved in the activity

• Task—Name of the task involved in the activity (view a dialog box, apply configuration, and so on)

• Connection Mode—Telnet, Console, Simple Network Management Protocol (SNMP)

• Category—Type of change: Hardware, Software, Configuration

• Status—Status of the user action: Read, Initial, Successful, Timeout, Failed

• Time—Time of change

• Message Type—Denotes whether the event is Success/Failure type

• Message Details—Description of the change

20.8.2 Audit Trail Capacities
The system is able to store 640 log entries.When this limit is reached, the oldest entries are overwritten 
with new events. When the log server is 80 percent full, an AUD-LOG-LOW condition is raised and 
logged (by way of Common Object Request Broker Architecture [CORBA]/CTC). 

When the log server reaches a maximum capacity of 640 entries and begins overwriting records that 
were not archived, an AUD-LOG-LOSS condition is raised and logged. This event indicates that audit 
trail records have been lost. Until the user off-loads the file, this event occurs only once regardless of 
the amount of entries that are overwritten by the system. 
20-16
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

September 2004



Cisco ONS 15454 DWDM
September 2004
A P P E N D I X A

CTC Information and Shortcuts

Note The terms "Unidirectional Path Switched Ring" and "UPSR" may appear in Cisco literature. These terms 
do not refer to using Cisco ONS 15xxx products in a unidirectional path switched ring configuration. 
Rather, these terms, as well as "Path Protected Mesh Network" and "PPMN," refer generally to Cisco's 
path protection feature, which may be used in any topological network configuration. Cisco does not 
recommend using its path protection feature in any particular topological network configuration.

This appendix describes the Cisco Transport Controller (CTC) views, menus options, tool options, 
shortcuts, and table display options. This appendix also describes the shelf inventory data presented in 
CTC. For more information about CTC, see Chapter 17, “Cisco Transport Controller Operation.”

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

Display Node, Card, and Network Views
CTC provides three views of the ONS 15454 and the ONS network:

• Node view appears when you first log into an ONS 15454. This view shows a graphic of the 
ONS 15454 shelf and provides access to tabs and subtabs that you use to manage the node.

• Card view provides access to individual ONS 15454 cards. This view provides a graphic of the card 
and provides access to tabs and subtabs that you use to manage the card.

• Network view shows all the nodes in a ring. A Superuser can set up this feature so each user will see 
the same network view, or the user can create a custom view with maps. This view provides access 
to tabs and subtabs that you use to manage the network.

Table A-1 lists different actions for changing CTC views.
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Node Icons on the Network View Map
Table A-2 lists the node icons on the network view map.

Table A-1 Change CTC Views

To Display Perform One of the Following

Node view • Log into a node; node view is the default view.

• In network view, double-click a node icon, or right-click the node and 
choose Open Node from the shortcut menu.

• In network view, single-click a node icon, then choose Go To Selected 
Object View from the View menu.

• From the View menu, choose Go To Other Node, then choose the node 
you want from the shortcut menu.

• Use the arrows on the CTC toolbar to navigate up or down views. For 
example, in network view, click a node, then click the down arrow.

Network view • In node view, click the up arrow or the Network View tool on the CTC 
toolbar.

• From the View menu, choose Go To Network View.

Card view • In node view, double-click a card or right-click the card and choose 
Open Card.

• In node view, single-click a card icon, then choose Go To Selected Object 
View from the View menu.

• Use the arrows on the CTC toolbar to navigate up or down views. For 
example, in node view, click a card, then click the down arrow.
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Table A-2 Description of Node Icons on Network View Map

Node Name Icon Description

SONET

SDH

Hybrid OADM

Hybrid line amplifier

Hybrid terminal

Passive hybrid terminal

Amplified TDM 

A SONET, SDH, hybrid, or amplified time-division 
multiplexing (TDM) node icon is represented as a cylinder 
with crossed arrows. 

Note Release 4.7 is DWDM only. It does not support 
SONET, SDH, or hybrid nodes.

• A SONET or SDH node can include OC-N cards, 
electrical cards, cross-connects, and more. 

• A hybrid optical add/drop multiplexing (OADM) node 
contains at least one Channel OADM (AD-xC-xx.x) or 
one Band OADM (AD-xB-xx.x) card and two Advanced 
Timing, Communications, and Controller (TCC2) cards. 
TDM cards can be installed in any available slot.

• A hybrid line amplifier node contains amplifiers and both 
TDM and dense wavelength division multiplexing 
(DWDM) cards.

• A hybrid terminal node contains at least one 32-Channel 
Multiplexer (32MUX-O) card, one Double-Slot 
32-Channel Demultiplexer (32DMX-O) card, amplifiers, 
two TCC2 cards, and TDM cards.

• A passive hybrid terminal node has the same equipment as 
the hybrid terminal node, but does not contain amplifiers.

• An amplified TDM node is a node that increases the span 
length between two ONS 15454 nodes that contain TDM 
cards and optical amplifiers. Amplified TDM nodes 
contain either Optical Booster (OPT-BST) amplifiers or 
AD-1C cards.

Hub A DWDM hub node icon is represented as a three-dimensional 
cylinder with amplifiers. A hub node contains at least two 
32DMX or 32DMX-O cards and two 32MUX-O. No OADM 
cards are provisioned.

OADM A DWDM OADM node icon is represented as a 
three-dimensional cylinder with arrows. An OADM node 
contains at least one AD-xC-xx.x or one AD-xB-xx.x. No 
32MUX-O, 32DMX-O, or 32DMX cards are provisioned.
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Manage the CTC Window
Different navigational methods are available within the CTC window to access views and perform 
management actions. You can double-click and right-click objects in the graphic area and move the 
mouse over nodes, cards, and ports to view popup status information.

ROADM A reconfigurable OADM (ROADM) node icon is represented 
as a three-dimensional cylinder with two amplifier symbols 
that have arrows between them. An ROADM node contains at 
least one 32-channel Wavelength Selective Switch (32WSS). 
A single-slot 32DMX or double-slot 32DMX-O can be 
installed, but is not required. Transponders (TXPs) and 
muxponders (MXPs) can be installed in Slots 6 and 12. If 
amplification is not used, TXPs or MXPs can be installed in 
Slots 1 and 17. If OPT-BSTs are not installed, Optical Service 
Channel and Combiner/Separator Module (OSC-CSM) cards 
are installed in Slots 2 and 16 and Slots 8 and 10 are empty.

Terminal (west) A terminal (west) node is represented as a three-dimensional 
cylinder with one amplifier on the west side of the icon.

• A terminal node contains one 32DMX or 32DMX-O and 
one 32-MUX-O. No OADM cards are provisioned.

• A flexible terminal node contains a series of OADM and 
amplifier cards.

Terminal (east) A terminal (east) node is represented as a three-dimensional 
square with one amplifier on the east side of the icon. 

• A terminal node contains one 32DMX or 32DMX-O and 
one 32MUX-O. No OADM cards are provisioned.

• A flexible terminal node contains a series of OADM and 
amplifier cards.

Line

OSC regeneration line 

Line and OSC regeneration line nodes are represented as a 
three-dimensional cylinder with one arrow pointing west and 
another arrow pointing east. 

• A line node has only Optical Preamplifier (OPT-PRE) or 
OPT-BST amplifiers provisioned.

• An optical service channel (OSC) regeneration line node 
contains two OSC-CSM cards. 

Unknown An unknown DWDM node icon is represented as a 
three-dimensional cylinder with one arrow pointing north. An 
unknown node means that the provisioned cards do not allow 
the node to fit any of the defined DWDM node categories.

Table A-2 Description of Node Icons on Network View Map (continued)

Node Name Icon Description
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CTC Menu and Toolbar Options
The CTC window menu bar and toolbar provide primary CTC functions. Table A-3 shows the actions 
that are available from the CTC menu and toolbar.

Table A-3 CTC Menu and Toolbar Options

Menu Menu Option Toolbar Description

File Add Node Adds a node to the current session. See the “DLP-G49 Add a Node to the Current 
Session or Login Group” task on page 2-30.

Delete Selected 
Node

Deletes a node from the current session. 

Lock CTC Locks CTC without closing the CTC session. A user name and password are 
required to open CTC.

Print Prints CTC data. See the “DLP-G113 Print CTC Data” task on page 7-2.

Export Exports CTC data. See the “DLP-G114 Export CTC Data” task on page 7-4.

Exit — Closes the CTC session. 

Edit Preferences Displays the Preferences dialog box, which shows the following tabs:

• General—Allows you to change event defaults and manage preferences.

• Login Node Groups—Allows you to create login node groups. See the 
“DLP-G48 Create Login Node Groups” task on page 2-29.

• Map—Allows you to customize the network view. See the “DLP-G168 
Change the Network View Background Color” task on page 9-15 and the 
“DLP-G170 Apply a Custom Network View Background Map” task on 
page 9-17.

• Circuit—Allows you to change the color of circuit spans. This task is not 
applicable on DWDM-only nodes.

• Firewall—Sets the Internet Inter-ORB Protocol (IIOP) listener ports for 
access to the ONS 15454 through a firewall. See the “NTP-G27 Set Up the 
ONS 15454 for Firewall Access” procedure on page 3-19.

• JRE—Allows you to select another Java Runtime Environment (JRE) 
version. See the “DLP-G52 Change the JRE Version” task on page 2-32.
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View Go To Previous View Displays the previous CTC view.

Go To Next View Displays the next CTC view. Available only after you navigate to a previous 
view. Go to Previous View and Go to Next View are similar to forward and 
backward navigation in a web browser.

Go To Parent View References the CTC view hierarchy: network view, node view, and card view. In 
card view, this command displays the node view; in node view, the command 
displays network view. Not available in network view.

Go To Selected 
Object View

Displays the object selected in the CTC window.

Go To Home View Displays the login node in node view.

Go To Network View Displays the network view.

Go To Other Node Displays a dialog box allowing you to type in the node name or IP address of a 
a network node that you want to view. 

Show Status Bar — Click this item to display or hide the status bar at the bottom of the CTC window.

Show Tool Bar — Click this item to display or hide the CTC toolbar.

— — Zooms out the network view area (toolbar only).

— — Zooms in the network view area (toolbar only).

— — Zooms in a selected network view area (toolbar only).

Table A-3 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Tools Circuits — Displays the following options:

• Repair Circuits—Repairs incomplete circuits following replacement of the 
ONS 15454 alarm interface panel (AIP). Refer to the Cisco ONS 15454 
SONET and DWDM Troubleshooting Guide for more information.

• Reconfigure Circuits—Allows you to reconfigure circuits. Not applicable to 
DWDM nodes.

• Set Path Selector Attributes—Allows you to edit path protection or 
subnetwork connection protection (SNCP) circuit path selector attributes. 
Not applicable on DWDM nodes.

• Set Circuit State—Allows you to change a circuit state. Not applicable on 
DWDM nodes.

• Roll Circuit—(ONS 15600 only.) Allows you to reroute live traffic without 
interrupting service. Refer to the Cisco ONS 15600 Procedure Guide.

• Delete Rolls —(ONS 15600 only.) Refer to the Cisco ONS 15600 Procedure 
Guide.

Overhead Circuits — Displays the Repair IP Tunnels option, which fixes circuits that are in the 
PARTIAL status as a result of node IP address changes. See the “DLP-G111 
Repair an IP Tunnel” task on page 6-17.

Topology Upgrade — Displays the following options:

• Convert path protection (or SNCP) to BLSR (or MS-SPRing)—Converts a 
path protection to a bidirectional line switch ring (BLSR). Not applicable to 
DWDM nodes.

• Convert Unprotected to path protection (or SNCP)—Converts a 
point-to-point or linear add/drop multiplexer (ADM) to path protection. Not 
applicable to DWDM nodes.

Manage VLANs — Displays a list of VLANs that have been created and allows you to delete 
VLANs. Not applicable to DWDM nodes.

Open TL1 
Connection

Displays the TL1 session dialog box so you can create a TL1 session to a 
specific node. Refer to the Cisco ONS 15454 SONET and SDH TL1 Command 
Quick Reference Guide.

Open IOS 
Connection

Displays the Cisco IOS command line interface dialog box if a Cisco IOS 
capable card (ML1000-2 or ML100T-12) is installed in the node. Not applicable 
to DWDM nodes.

Help Contents and Index — Displays the online help window.

User Manuals — Displays the Cisco ONS 15454 documentation.

About CTC — Displays the software version and the nodes in the CTC session.

Table A-3 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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CTC Mouse Options
In addition to the CTC menu bar and toolbar, you can invoke actions by double-clicking CTC window 
items with your mouse, or by right-clicking an item and selecting actions from shortcut menus. 
Table A-4 lists the CTC window mouse shortcuts.

— Network Scope — Displays the selected network scope. The network scope drop-down list has 
three options: DWDM, TDM, or All. If you choose DWDM, DWDM and hybrid 
nodes appear on the network view map. If you choose TDM, TDM and hybrid 
nodes appear on the network view map. If you choose All, every node on the 
network appears on the network view map.

Note Release 4.7 is DWDM only. Hybrid configurations are not supported. 

— — Opens the CTC Alerts dialog box, which shows the status of certain CTC 
background tasks. When the CTC Alerts toolbar icon contains a red triangle, 
unread notifications exist. When there are no unread notifications, the CTC 
Alerts toolbar icon contains a gray triangle (see the icons in the Toolbar column 
for comparison). Notifications include:

• Network disconnection.

• Send-PDIP inconsistency—CTC discovers a new node that does not have a 
SEND-PDIP setting consistent with the login node.

• Circuit deletion status—Reports when the circuit deletion process 
completes if you chose “Notify when complete” as described in the 
“NTP-G61 Modify and Delete Overhead Circuits” procedure on page 6-17. 
The CTC Alerts window always reports circuit deletion errors. 

• Conditions retrieval error.

• Software download failure.

You can save a notification by clicking the Save button in the CTC Alerts dialog 
box and navigating to the directory where you want to save the text file. 

By default, the CTC Alerts dialog box appears automatically. To disable 
automatic popup, see the “DLP-G53 Configure the CTC Alerts Dialog Box for 
Automatic Popup” task on page 2-33. 

Table A-3 CTC Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Table A-4 CTC Window Mouse Shortcuts

Technique Description

Double-click • Node in network view—Displays the node view.

• Card in node view—Displays the card view.

• Alarm/Event—Displays the object that raised the alarm or event.

• Circuits—Displays the Edit Circuit window.

Right-click • Network view graphic area—Displays a menu that you can use to create a 
new domain; change the position and zoom level of the graphic image; save 
the map layout (if you have a Superuser security level); reset the default 
layout of the network view; set, change, or remove the background image 
and color; and save or reset the node position.

• Node in network view—Displays a menu that you can use to open the node, 
reset the node icon position to the longitude and latitude set on the 
Provisioning > General tab, delete the node, fix the node position for 
automatic layout, provision circuits, provision channels, and update circuits 
or channels with a new node.

• Span in network view—Displays a menu that you can use to view 
information about the span’s source and destination ports, the protection 
scheme, and the optical or electrical level. 

• Card in node view—Displays a menu that you can use to open, delete, reset, 
and change cards. The card that you choose determines the commands that 
appear.

• Card in card view—Displays a menu that you can use to reset the card, or 
go to the parent view (node view).

• Empty slot in node view—Displays a menu with cards that you can choose 
to preprovision the slot.

Move mouse cursor • Over node in network view—Displays a summary of node alarms and 
provides a warning if the node icon has been moved out of the map range.

• Over span in network view—Displays circuit (node, slot, port) bandwidth 
and protection information. For DWDM spans, the optical direction and 
optical ring ID appear. If the span terminates on the trunk port of a 
transponder card (TXP or MXP), the associated DWDM wavelength also 
appears.

• Over card in node view—Displays card type, card status, alarm profile 
status and, depending on the DWDM card type, number of bands or 
channels. 

• Over card port in node view—Displays card name, port state, and alarm 
profile status.

• Over card port in card view—Displays port state and alarm profile status. 
For DWDM cards, the port number is labeled as channel, band, or line 
depending on the card type along with the port state and alarm profile status.
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    Manage the CTC Window
Node View Shortcuts
Table A-5 shows actions on ONS 15454 cards that you can perform by moving your mouse over the CTC 
window.

Network View Tasks
Right-click the network view graphic area or a node, span, or domain to display shortcut menus. 
Table A-6 lists the actions that are available from the network view.

Table A-5 Node View Card-Related Shortcuts

Action Shortcut

Display card 
information

In node view, move your mouse over cards in the graphic to display tooltips 
with the card type, card status (active or standby), the highest level of alarm (if 
any), and the alarm profile used by the card.

Open, reset, or delete 
a card

In node view, right-click a card. Choose Open Card to display the card in card 
view, Delete Card to delete it, or Reset Card to reset the card.

Preprovision a slot In node view, right-click an empty slot. Choose the card type for which you 
want to provision the slot from the shortcut menu.

Change a card In node view, right-click an OC-N card or a DS3 card, and choose 
Change Card. In the Change Card dialog box, choose the card type. 
Change Card retains all card provisioning, including data communications 
channel (DCC) terminations, protection, circuits, and ring.

Table A-6 Network Management Tasks in Network View

Action Task

Open a node Any of the following:

• Double-click a node icon.

• Right-click a node icon and choose Open Node from the shortcut menu.

• Click a node and choose Go To Selected Object View from the View 
menu.

• From the View menu, choose Go To Other Node. Choose a node from the 
Select Node dialog box.

• Double-click a node alarm or event in the Alarms or History tab.

Move a node icon Press the Ctrl key and the left mouse button simultaneously and drag the node 
icon to a new location.

Reset node icon 
position

Right-click a node and choose Reset Node Position from the shortcut menu. 
The node icon moves to the position defined by the longitude and latitude fields 
on the Provisioning > General tab in node view.

Provision a circuit Right-click a node. From the shortcut menu, choose Provision Circuit To and 
choose the node where you want to provision the circuit. For circuit creation 
procedures, see Chapter 6, “Create Channels and Circuits.”
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    Manage the CTC Window
Table Display Options
Right-clicking a table column displays a menu. Table A-7 shows table display options, which include 
rearranging or hiding CTC table columns and sorting table columns by primary or secondary keys. 

Update circuits with 
new node

Right-click a node and choose Update Circuits With New Node from the 
shortcut menu. Use this command when you add a new node and want to pass 
circuits through it.

Display a link end 
point

Right-click a span. From the shortcut menu, choose Go To {<node> | <port> 
| <slot>} for the drop port you want to view. CTC displays the card in card 
view.

Display span 
properties

Do any of the following: 

• Move the mouse over a span; the properties appear near the span.

• Click a span; the properties appear in the upper left corner of the window.

• Right-click a span; the properties appear at the top of the shortcut menu.

Perform a path 
protection (ANSI) or 
SNCP (ETSI) 
protection switch for 
an entire span

Right-click a network span and click Circuits. In the Circuits on Span dialog 
box, switch options appear in the path protection (or SNCP) Span Switching 
field.

Display DWDM span 
properties

Right-click a DWDM network span and choose Circuits from the shortcut 
menu. The optical channel network connection (OCHNC), optical direction, 
and circuit appear.

Upgrade a span Right-click a span and choose Upgrade Span from the shortcut menu. Not 
applicable to DWDM nodes.

Table A-6 Network Management Tasks in Network View (continued)

Action Task

Table A-7 Table Display Options

Task Click Right-Click Shortcut Menu

Resize column Click while dragging the column 
separator to the right or left.

—

Rearrange column order Click while dragging the column 
header to the right or left.

—

Reset column order — Choose Reset Columns Order/Visibility.

Hide column — Choose Hide Column.

Show column — Choose Show Column > column_name.

Display all hidden 
columns

— Choose Reset Columns Order/Visibility.

Sort table (primary) Click a column header; each 
click changes sort order 
(ascending or descending).

Choose Sort Column.
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Equipment Inventory
In node view, the Inventory tab displays information about the ONS 15454 equipment, including:

• Delete button—After highlighting a card with your mouse, use this button to delete the card from 
node view.

• Reset button—After highlighting a card with your mouse, use this button to reset the card.

• Location—Identifies where the equipment is installed, either chassis or slot number.

• Eqpt Type—Displays the type of equipment but not the specific card name, for example, OC-12 or 
DS-1.

• Actual Eqpt Type—Displays the specific card name, for example, OC12 IR/STM4 SH 1310.

• Admin State—Changes the card service state unless network conditions prevent the change. For 
more information about card administrative states, see Appendix C, “DWDM Enhanced State 
Model.”

– IS (ANSI) or Unlocked (ETSI)—Places the card in the In-Service and Normal (IS-NR [ANSI]) 
or Unlocked-enabled (ETSI) service state.

– OOS,MA (ANSI) or Locked,maintenance (ETSI)—Places the card in the Out-of-Service and 
Autonomous, Maintenance (OOS-AU,MT [ANSI]) or Unlocked-disabled,maintenance (ETSI) 
service state.

• Service State—Displays the current card service state, which is an autonomously generated state 
that gives the overall condition of the card. Service states appear in the format: Primary 
State-Primary State Qualifier, Secondary State. For more information about card service states, see 
Appendix C, “DWDM Enhanced State Model.” 

• HW Part #—Displays the hardware part number; this number is printed on the top of the card or 
equipment piece.

• HW Rev—Displays the hardware revision number.

• Serial #—Displays the equipment serial number; this number is unique to each card.

• CLEI Code—Displays the Common Language Equipment Identifier code.

• Firmware Rev—Displays the revision number of the software used by the application-specific 
integrated circuit (ASIC) chip installed on the ONS 15454 card.

• Product ID—Displays the manufacturing product identifier for a hardware component, such as a fan 
tray, chassis, or card. The Product ID column displays “N/A” for equipment existing before 
Software Release 4.6.

• Version ID—Displays the manufacturing version identifier for a fan tray, chassis, or card. The 
Version ID column displays “N/A” for equipment existing before Software Release 4.6.

Sort table (secondary 
sorting keys)

Press the Shift key and 
simultaneously click the column 
header.

Choose Sort Column (incremental).

Reset sorting — Choose Reset Sorting.

View table row count — View the number after “Row count=” (it is 
the last item on the shortcut menu).

Table A-7 Table Display Options (continued)

Task Click Right-Click Shortcut Menu
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Cisco ONS 15454 DWDM
April 2006
A P P E N D I X B

Hardware Specifications

This appendix contains hardware and software specifications for the ONS 15454 ANSI and ETSI shelf 
assemblies and cards.

Note Unless otherwise specified, “ONS 15454” refers to both ANSI and ETSI shelf assemblies.

B.1 Shelf Specifications
This section provides specifications for shelf bandwidth; a list of topologies; Cisco Transport Controller 
(CTC) specifications; the LAN, TL1, modem, and alarm specifications; timing, power, and 
environmental specifications; and shelf dimensions.

B.1.1 Bandwidth
The ONS 15454 has the following bandwidth specifications:

• Total bandwidth: 240 Gbps

• Data plane bandwidth: 160 Gbps

• SONET/SDH plane bandwidth: 80 Gbps

B.1.2 Configurations
The ONS 15454 can be configured for the following dense wavelength division multiplexing (DWDM) 
topologies:

• Hubbed rings 

• Multihubbed rings

• Point-to-point

• Linear

• Linear with optical add/drop multiplexing (OADM)
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B.1.3 Cisco Transport Controller
B.1.3 Cisco Transport Controller
CTC, the ONS 15454 craft interface software, has the following specifications: 

• 10BaseT 

• Advanced Timing, Communications, and Control (TCC2) card access: RJ-45 connector

• Backplane access: LAN pin field (ANSI only) 

• Front Mount Electrical Connection (FMEC) access: LAN connector on MIC-C/T/P faceplate (ETSI 
only)

B.1.4 External LAN Interface
The ONS 15454 external LAN interface has the following specifications: 

• 10BaseT Ethernet

• Backplane access: LAN pin field (ANSI only)

• FMEC access: LAN connector on MIC-C/T/P faceplate (ETSI only)

B.1.5 TL1 Craft Interface
The ONS 15454 TL1 craft interface has the following specifications: 

• Speed: 9600 bps

• TCC2 access: EIA/TIA-232 DB-9 type connector

• Backplane access: CRAFT pin field (ANSI only)

B.1.6 Modem Interface
The ONS 15454 modem interface has the following specifications: 

• Hardware flow control

• TCC2: EIA/TIA-232 DB-9 type connector

B.1.7 Alarm Interface
The ONS 15454 alarm interface has the following specifications: 

• ETSI

– Visual: Critical, Major, Minor, Remote

– Audible: Critical, Major, Minor, Remote

– FMEC access: 62-Pin DB connector on MIC-A/P faceplate

– Alarm inputs: Common 32-VDC output for all alarm-inputs, closed contact limited to 2 mA

– Control outputs: Open contact maximum 60 VDC, closed contact maximum 100 mA (ETSI 
only)

• ANSI
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B.1.8 EIA Interface (ANSI only)
– Visual: Critical, Major, Minor, Remote

– Audible: Critical, Major, Minor, Remote

– Backplane access: Alarm pin fields

– Alarm contacts: 0.045 mm, –48 V, 50 mA

B.1.8 EIA Interface (ANSI only)
The ONS 15454 electrical interface assembly (EIA) interface has the following specifications: 

• SMB: AMP #415504-3 75-ohm, 4-leg connectors

• BNC: Trompeter #UCBJ224 75-ohm 4 leg connector (King or ITT are also compatible)

• AMP Champ: AMP#552246-1 with #552562-2 bail locks

B.1.9 BITS Interface (ANSI only)
The ONS 15454 building integrated timing supply (BITS) interface has the following specifications: 

• 2 DS-1 BITS inputs

• 2 derived DS-1 outputs

• Backplane access: BITS pin field

B.1.10 System Timing
The ONS 15454 ANSI has the following system timing specifications: 

• Stratum 3 per Telcordia GR-253-CORE

• Free running accuracy: +/– 4.6 ppm

• Holdover stability: 3.7 x 10–7/day, including temperature (< 255 slips in first 24 hours)

• Reference: External BITS, line, internal

The ONS 15454 ETSI has the following system timing specifications: 

• Stratum 3E, per ITU-T G.813

• Free running accuracy: +/– 4.6 ppm

• Holdover stability: 3.7 exp –7/day, including temperature (< 255 slips in first 24 hours)

• Reference: External BITS, line, internal

B.1.11 System Power
The ONS 15454 ANSI has the following power specifications: 

• Input power: –48 VDC

• Power consumption: 55 W (fan tray only); 650 W (maximum draw with cards)

• Power requirements: –40.5 to –57 VDC

• Power terminals: #6 Lug
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B.1.12 System Environmental Specifications
• ANSI shelf: 100-A fuse panel (minimum 30 A fuse per shelf)
HD shelf: 100-A fuse panel (minimum 35 A fuse per shelf)

The ONS 15454 ETSI has the following power specifications: 

• Input voltage: –48 VDC

• Power consumption: Configuration dependent, 53 W for fan tray; 650 W (maximum draw with 
cards)

• Power requirements: 

– Nominal: –48 VDC

– Tolerance limits: –40.5 to –57.0 VDC

• Power terminals: 3WK3 Combo-D power cable connector (MIC-A/P and MIC-C/T/P faceplates)

• Fusing: 100 A fuse panel; minimum 30 A fuse per shelf

B.1.12 System Environmental Specifications
The ONS 15454 ANSI has the following environmental specifications: 

• Operating temperature: 32 to +131 degrees Farenheit (0 to +55 degrees Celsius); -40 to +139 degrees 
Farenheit (–40 to +65 degrees Celsius) with industrial temperature rated cards

• Operating humidity: 5 to 95%, noncondensing

The ONS 15454 ETSI has the following environmental specifications: 

• Operating temperature: 32 to 104 degrees Fahrenheit (0 to +40 degrees Celsius)

• Operating humidity: 5 to 95%, noncondensing

B.1.13 Dimensions
The ONS 15454 ANSI shelf assembly has the following dimensions: 

• Height: 18.5 in. (40.7 cm)

• Width: 19 or 23 in. (41.8 or 50.6 cm) with mounting ears attached

• Depth: 12 in. (26.4 cm) (5 in. or 12.7 cm projection from rack)

• Weight: 55 lb (24.947 kg) empty

The ONS 15454 ETSI shelf assembly has the following dimensions: 

• Height: 616.5 mm (24.27 in.)

• Width: 535 mm (17 in.) without mounting ears attached

• Depth: 280 mm (11.02 in.)

• Weight: 26 kg empty (57.3 lb)

B.2 General Card Specifications
This section provides power specifications and temperature ranges for all ONS 15454 cards. 
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B.2.1 Power
B.2.1 Power
Table B-1 provides power consumption information for the ONS 15454 cards.

Table B-1 Individual Card Power Requirements

Card Type Card Name Watts Amperes at –48 V BTU/Hr.

DWDM Cards OSCM Nominal 23

Maximum 26

Nominal 0.48

Maximum 0.54

Nominal 78.48

Maximum 88.71

OSC-CSM Nominal 24

Maximum 27

Nominal 0.5

Maximum 0.56

Nominal 81.89

Maximum 92.12

OPT-PRE Minimum 25

Nominal 30

Maximum39

Minimum 0.52

Nominal 0.5

Maximum 0.81

Minimum 85.3

Nominal 102.36

Maximum 88.71

OPT-BST Nominal 30

Maximum 39

Nominal 0.63

Maximum 0.81

Nominal 102.36

Maximum 88.71

32MUX-O Nominal 16

Maximum 25

Nominal 0.33

Maximum 0.52

Nominal 54.59 

Maximum 85.3

32DMX-O Nominal 16

Maximum 25

Nominal 0.33

Maximum 0.52

Nominal 54.59 

Maximum 85.3

32DMX Typical 15 

Maximum 25

Typical 0.31

Maximum 0.52

Typical 51.21

Maximum 85

4MD-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-1C-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-2C-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-4C-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-1B-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

AD-4B-xx.x Nominal 17

Maximum 25

Nominal 0.35

Maximum 0.52

Nominal 58.0

Maximum 85.3

32WSS Typical 50

Maximum 65

Typical 1.04

Maximum 1.35

Typical 170

Maximum 221
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B.2.2 Temperature
B.2.2 Temperature
Table B-2 provides temperature ranges and product names for ONS 15454 cards.

Note The I-Temp symbol is displayed on the faceplate of an I-Temp compliant card. A card without this 
symbol is C-Temp compliant.

Control Cards TCC2 19.20 0.4 66.8

AIC (ANSI only) 6.01 0.12 20.52

AIC-I 4.8 0.1 15.3

AEP 3 (from +5 VDC 
from AIC-I)

10.2

MIC-A/P 0.13 via TCC2 —

MIC-C/T/P 0.38 via TCC2 —

Transponder and 
Muxponder 
Cards

TXP_MR_10G 35.001 0.73 119.5

TXP_MR_10E Nominal 40

Maximum 50

Nominal 1.11

Maximum 1.04

Nominal 136.6

Maximum 170.7

TXP_MR_2.5G 35.001 0.73 119.5

TXPP_MR_2.5G 501 1.04 170.5

MXP_2.5G_10G 501 1.04 170.7

MXP_2.5G_10E Nominal 40

Maximum 50

Nominal 1.11

Maximum 1.04

Nominal 136.6

Maximum 170.7

MXP_MR_2.5G Nominal 50

Maximum 60

Nominal 1.04

Maximum 1.25

Nominal 170.7

Maximum 204

MXPP_MR_2.5G Nominal 50

Maximum 60

Nominal 1.04

Maximum 1.25

Nominal 170.7

Maximum 204

1. Calculated power; measured power was not available at the time of publication.

Card Type Card Name Watts Amperes at –48 V BTU/Hr.

Table B-2 Card Temperature Ranges and Product Names

Card Type Card Name

C-Temp Product Name 
(32 to 131 degrees Fahrenheit, 
0 to +55 degrees Celsius)

I-Temp Product Name
(–40 to 149 degrees Fahrenheit, 
–40 to +65 degrees Celsius)

Control Cards TCC2 — 15454-TCC2

AIC 15454-AIC 15454-AIC-T

AIC-I — 15454-AIC-I

AEP — 15454-AEP

MIC-A/P 15454-MIC-A/P

MIC-C/T/P 15454 MIC-C/T/P
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B.3 Common Control Card Specifications
B.3 Common Control Card Specifications
This section provides specifications for the TCC2, AIC, and AIC-I cards. 

For compliance information, refer to the Cisco Optical Transport Products Safety and Compliance 
Information document.

B.3.1 TCC2 Card Specifications
• CTC software

– Interface: EIA/TIA-232 (local craft access, on TCC2 faceplate) 

– Interface: 10BaseT LAN (on TCC2 faceplate) 

– Interface: 10BaseT LAN (via backplane)

Multirate 
Cards

TXP_MR_10G 15454-TXPMR10G —

TXP_MR_10E 15454-10EMRTXP —

TXP_MR_2.5G 15454-2.5GMRTXP —

TXPP_MR_2.5G 15454-2.5GMRTXP-P —

MXP_2.5G_10G 15454-MXP2.5G10G —

MXP_2.5G_10E 15454-4x2.5G10EMXP —

MXP_MR_2.5G 15454-Datamux2.5GDM —

MXPP_MR_2.5G 15454-Datamux2.5GDMP —

DWDM Cards OSCM 15454-OSCM —

OSC-CSM 15454-OSC-CSM —

OPT-PRE 15454-OPT-PRE —

OPT-BST 15454-OPT-BST —

32MUX-O 15454-32 MUX-O —

32DMX-O 15454-32 DMX-O —

32DMX 15454-32-DMX —

4MD-xx.x 15454-4MD-xx.x —

AD-1B-xx.x 15454-AD-1B-xx.x —

AD-4B-xx.x 15454-AD-4B-xx.x —

AD-1C-xx.x 15454-AD-1C-xx.x —

AD-2C-xx.x 15454-AD-2C-xx.x —

AD-4C-xx.x 15454-AD-4C-xx.x —

32WSS 15454-WSS —

Table B-2 Card Temperature Ranges and Product Names (continued)

Card Type Card Name

C-Temp Product Name 
(32 to 131 degrees Fahrenheit, 
0 to +55 degrees Celsius)

I-Temp Product Name
(–40 to 149 degrees Fahrenheit, 
–40 to +65 degrees Celsius)
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B.3.2 AIC Card Specifications (ANSI only)
• Synchronization

– Stratum 3, per Telcordia GR-253-CORE

– Free running access: Accuracy +/– 4.6 ppm

– Holdover stability: 3.7 x 10-7 per day including temperature (< 255 slips in first 24 hours)

– Reference: External BITS, line, internal

• Supply voltage monitoring 

– Both supply voltage inputs are monitored. 

– Normal operation: –40.5 to –56.7 V

– Undervoltage: Major alarm 

– Overvoltage: Major alarm 

• Environmental

– Operating temperature: –40 to +149 degrees Fahrenheit (–40 to +65 degrees Celsius) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 26.00 W, 0.54 A at –48 V, 88.8 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 235 mm (9.250 in.)

– Weight not including clam shell: 0.7 kg (1.5 lb) 

B.3.2 AIC Card Specifications (ANSI only)

Note The ONS 15454 ETSI does not support the AIC card.

• Environmental

– Operating temperature: 

C-Temp (15454-AIC): 32 to 131 degrees Fahrenheit (0 to +55 degrees Celsius)

I-Temp (15454-AIC-T): –40 to 149 degrees Fahrenheit (–40 to +65 degrees Celsius)

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 6.01 W, 0.12 A, 20.52 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Weight: 1.6 lb (0.7 kg)
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B.3.3 AIC-I Card Specifications
B.3.3 AIC-I Card Specifications
• Alarm inputs

– Number of inputs: 12 without alarm extension panel (AEP), 32 with AEP

– Opto-coupler isolated

– Label customer provisionable

– Severity customer provisionable

– Common 32 V output for all alarm inputs

– Each input limited to 2 mA

– Termination: Wire-wrap on backplane without AEP, on AEP connectors with AEP

• Alarm outputs

– Number of outputs: 4 (user configurable as inputs) without AEP, 16 with AEP 

– Switched by opto MOS (metal oxide semiconductor) 

– Triggered by definable alarm condition

– Maximum allowed open circuit voltage: 60 VDC

– Maximum allowed closed circuit current: 100 mA

– Termination: Wire-wrap on backplane without AEP, on AEP connectors with AEP

• Express orderwire/local orderwire (EOW/LOW)

– ITU-T G.711, ITU-T G.712, Telcordia GR-253-CORE 

– A-law, mu-law

Note Due to the nature of mixed coding, in a mixed-mode A-law/mu-law configuration, the 
orderwire is not ITU-T G.712 compliant.

– Orderwire party line 

– Dual tone, multifrequency (DTMF) signaling 

• User data channel (UDC)

– Bit rate: 64 kbps, codirectional

– ITU-T G.703 

– Input/output impedance: 120 ohm

– Termination: RJ-11 connectors

• Data communications channel (DCC)

– Bit rate: 576 kbps

– EIA/TIA-485/V11

– Input/output impedance: 120 ohm

– Termination: RJ-45 connectors

• ACC connection for additional alarm interfaces

– Connection to AEP

• Power monitoring alarming states: 
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B.3.4 MIC-A/P FMEC Specifications (ETSI only)
– Power failure (0 to –38 VDC)

– Undervoltage (–38 to –40.5 VDC)

– Overvoltage (beyond –56.7 VDC)

• Environmental

– Operating temperature: –40 to 149 degrees Fahrenheit (–40 to +65 degrees Celsius)

– Operating humidity: 5 to 95%, noncondensing

– Power consumption (including AEP, if used): 8.00 W, 0.17 A, 27.3 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Weight: 1.8 lb (0.82 kg)

B.3.4 MIC-A/P FMEC Specifications (ETSI only)

Note The ONS 15454 ANSI does not support the MIC-A/P FMEC.

• Power supply input BATTERY B

– System supply voltage: Nominal –48 VDC
Tolerance limits: –40.5 to –57.0 VDC

– Connector: 3WK3 Combo-D power cable connector 

• Alarm outputs 

– Voltage (open contact): Maximum 60 VDC

– Current (closed contact): Maximum 250 mA

– Connector: 62-pin DB connector (common for inputs/outputs) 

• Alarm inputs 

– Voltage (open contact): Maximum 60 VDC

– Current (closed contact): Maximum 2 mA

– Connector: 62-pin DB connector (common for inputs/outputs) 

• Environmental

– Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 0.13 W (provided by +5 V from the TCC2 card), 0.44 BTU/hr

• Dimensions

– Height: 182 mm (7.165 in.)

– Width: 32 mm (1.25 in.)

– Depth: 92 mm (3.62 in.)

– Depth with backplane connector: 98 mm (3.87 in.)
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Appendix B      Hardware Specifications
B.3.5 MIC-C/T/P FMEC Specifications (ETSI only)
– Weight not including clam shell: 0.2 kg (0.5 lb) 

• Compliance: Installed ONS 15454 ETSI cards comply with these safety standards:

– IEC 60950, EN 60950, UL 60950, CSA C22.2 No. 60950, TS 001, AS/NZS 3260

B.3.5 MIC-C/T/P FMEC Specifications (ETSI only)

Note The ONS 15454 ANSI does not support the MIC-C/T/P FMEC.

• Power supply input BATTERY A

– System supply voltage: Nominal –48 VDC
Tolerance limits: –40.5 to –57.0 VDC

– Connector: 3WK3 Combo-D power cable connector 

• Timing connector 

– Frequency: 2.048 MHz +/–10 ppm 

– Signal level: 0.75 to 1.5 V 

– Impedance: 75 ohms +/–5% (switchable by jumper to high impedance > 3 kohms)

Note 120 ohms balanced impedance is possible with external matching cable.

– Cable attenuation: Up to 6 dB at 2 MHz 

– Connectors: 1.0/2.3 miniature coax connector 

• System management serial port:

– System management serial port craft interface

– Modem port (for future use) 

– Connectors: 8-pin RJ-45

• System management LAN port connectors:

– Signal: IEEE 802.3 10BaseT

– Connectors: 8-pin RJ-45

• Environmental

– Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 0.38 W (provided by +5 V from the TCC2 card), 1.37 BTU/hr

• Dimensions

– Height: 182 mm (7.165 in.)

– Width: 32 mm (1.25 in.)

– Depth: 92 mm (3.62 in.)

– Depth with backplane connector: 98 mm (3.87 in.)

– Weight not including clam shell: 0.2 kg (0.5 lb) 
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B.4 DWDM Card Specifications
• Compliance: Installed ONS 15454 ETSI cards comply with these safety standards:

– IEC 60950, EN 60950, UL 60950, CSA C22.2 No. 60950, TS 001, AS/NZS 3260

B.4 DWDM Card Specifications
This section provides specifications for the OSCM, OSC-CSM, OPT-PRE amplifier, OPT-BST amplifier, 
32MUX-O, 32DMX-O, 32DMX, 4MD-xx.x, AD-IC-xx.x, AD-2C-xx.x, AD-4C-xx.x, AD-1B-xx.x, 
AD-4B-xx.x, and 32WSS cards. 

For compliance information, refer to the Cisco Optical Transport Products Safety and Compliance 
Information document.

B.4.1 OSCM Card Specifications
• Line 

– Bit rate: 155 Mbps 

– Code: Scrambled non-return to zero (NRZ)

– Loopback modes: None

– Connector: Duplex LC

– Compliance: Telcordia GR-253-CORE, ITU-T G.957

• Transmitter optical service channel (OSC) signal

– Maximum transmitter output power: –1 dBm

– Minimum transmitter output power: –5 dBm 

– Nominal wavelength: 1510-nm +/–10 nm

– Variable optical attenuator (VOA) necessary in the transmit path to adjust the in-fiber optical 
power level

• Receiver OSC signal

– Maximum receiver level: –8 dBm at 10–10 BER

– Minimum receiver level: –40 dBm at 10–10 BER

– Span budget: 40-dB span budget (about 150 km assuming fiber path loss equals 0.25 dB/km)

– Jitter tolerance: Telcordia GR-253/G.823 compliant

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95%, noncondensing

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)
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Appendix B      Hardware Specifications
B.4.2 OSC-CSM Card Specifications
B.4.2 OSC-CSM Card Specifications
• Line 

– Bit rate: 155 Mbps 

– Code: Scrambled NRZ

– Loopback modes: None

– Connector: Duplex LC

– Compliance: Telcordia GR-253-CORE, ITU-T G.957

• Transmitter OSC signal

– Maximum transmitter output power: –2 dBm

– Minimum transmitter output power: –24 dBm 

– Nominal wavelength: 1510-nm +/–10 nm

– VOA is necessary in the transmit path to adjust the in-fiber optical power level

• Receiver OSC signal

– Maximum receiver level: –8 dBm at 10–10 BER

– Minimum receiver level: –40 dBm at 10–10 BER

– Span loss budget: 35-dB span budget (approximately 140 km assuming that the fiber path loss 
is equal to 0.25 dB/km

– Jitter tolerance: Telcordia GR-253/G.823 compliant

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95%, noncondensing

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.3 OPT-PRE Amplifier Card Specifications
• Optical characteristics:

– Total operating wavelength range: 1530 to 1561.3 nm

– Gain ripple (peak to valley): 1.5 dB

– Mid-Access Loss (MAL) range (for Dispersion Compensation Unit (DCU)): 3 to 9 dB

– Gain range: 5 to 38.5 dBm in constant power mode, 5 to 28 dBm in constant gain mode

– Minimum gain (standard range): 5.0 dBm

Maximum gain (standard range with programmable gain tilt): 21 dBm 

Maximum gain (extended range with uncontrolled gain tilt): 38.5 dBm 
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B.4.4 OPT-BST Amplifier Card Specifications
– Gain and power regulation over/undershoot: 0.5 dB

– Limited maximum output power: 17.5 dBm

– Maximum output power (with full channel load): 17 dB

– Minimum output power (with one channel): –1 dBm

– Input power (Pin) range at full channel load: –21.5 to 12 dBm

– Input power (Pin) range at single channel load: –39.5 to –6 dBm

– Noise figure at G3 21 dB = 6.5 dB

– OSC filter drop (channels) insertion loss maximum: 1 dB

– OSC filter drop (OSC) insertion loss maximum: 1.8 dB

– OSC filter add (OSC) insertion loss maximum: 1.3 dB

– Optical connectors: LC-UPC/2

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 85%, noncondensing

• Dimensions

– Height: 12.65 in. (332 mm)

– Width: 0.92 in. (24 mm)

– Depth: 9.00 in. (240 mm)

B.4.4 OPT-BST Amplifier Card Specifications
• Optical characteristics:

– Total operating wavelength range: 1530 to 1561.3 nm

– Gain ripple (peak to valley): 1.5 dB

– Gain range: 5 to 20 dBm with programmable gain tilt

– Gain and power regulation over/undershoot: 0.5 dB

– Limited maximum output power: 17.5 dBm

– Maximum output power (with full channel load): 17 dB

– Minimum output power (with one channel): –1 dBm

– Input power (Pin) range at full channel load: –3 to 12 dBm

– Input power (Pin) range at single channel load: –21 to –6 dBm

– Noise figure at G3 20 dB = 6 dB

– OSC filter drop (channels) insertion loss maximum: 1 dB

– OSC filter drop (OSC) insertion loss maximum: 1.8 dB

– OSC filter add (OSC) insertion loss maximum: 1.3 dB

– Optical connectors: LC-UPC/2

• Environmental
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B.4.5 32MUX-O Card Specifications
– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 85%, noncondensing

• Dimensions

– Height: 12.65 in. (332 mm)

– Width: 0.92 in. (24 mm)

– Depth: 9.00 in. (240 mm)

B.4.5 32MUX-O Card Specifications
The 32 MUX-O card optical specifications are listed in Table B-3.

Note For power specifications, refer to the “14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 14-7.

The 32 MUX-O card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95% relative humidity (RH)

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 1.84 in. (46.8 mm)

Table B-3 32 MUX-O Optical Specifications

Parameter Note Condition Min Max Unit

Tx filter shape (–1 dB 
bandwidth)

All standard operating 
procedures (SOP) and 
within whole operating 
temperature range

In 1/32—Out beginning 
of life (BOL)

+/–180 +/–300 pm

In 1/32—Out end of life 
(EOL)

+/–160 +/–300 pm

Insertion loss All SOP and within 
whole operating 
temperature range

In 1/32—Out BOL 4 8.0 dB

In 1/32—Out EOL 4 8.5 dB

VOA dynamic range — — 25 — dB

Optical monitor 
tap-splitting ratio on 
monitor port

Optical monitor port 
with respect to output 
port in multiplexer 
only

— 19 21 dB

Maximum optical 
input power

— — 300 — mW
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B.4.6 32DMX-O Card Specifications
– Depth: 9.00 in. (228.6 mm)

B.4.6 32DMX-O Card Specifications
The 32 DMX-O card optical specifications are listed in Table B-4.

Note For power specifications, refer to the “14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 14-7.

The 32 DMX-O card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95% RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 1.84 in. (46.8 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.7 32DMX Card Specifications
The 32DMX card optical specifications are listed in Table B-5.

Note For power specifications, refer to the “14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 14-7.

Table B-4 32 DMX-O Optical Specifications

Parameter Note Condition Min Max Unit

Rx filter shape 
(–1 dB bandwidth)

All SOP and within 
whole operating 
temperature range

In 1/32—Out BOL +/–180 +/–300 pm

In 1/32—Out EOL +/–160 +/–300 pm

Insertion loss All SOP and within 
whole operating 
temperature range

In 1/32—Out BOL 4 8.0 dB

In 1/32—Out EOL 4 8.5 dB

VOA dynamic range — — 25 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.8 4MD-xx.x Card Specifications
The 32 DMX card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95% RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)

B.4.8 4MD-xx.x Card Specifications
The 4MD-xx.x card optical specifications are listed in Table B-6.

Note For power specifications, refer to the “14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 14-7.

Table B-5 32 DMX Optical Specifications

Parameter Condition Note Min Typical Max Units

–1 dB 
bandwidth

COM RX => TX 1, 32 
(OUT)

All SOP and within whole 
operating temperature 
range, connectors included, 
and for maximum VOA 
operating attenuation.

+/-110 — — pm

–3 dB 
bandwidth

+/-200 — — pm

Insertion loss COM RX => TX 1, 32 All SOP, and within whole 
operating temperature 
range, connectors included.

— — 5.5 dB

VOA 
dynamic 
range

COM RX => TX 1, 32 — 25 — — dB

Maximum 
optical input 
power

— — 300 — — mW
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B.4.8 4MD-xx.x Card Specifications
The 4MD-xx.x card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95% RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.00 in. (228.6 mm)

• For compliance information, refer to Cisco Optical Transport Products Safety and Compliance 
Information.

Table B-6 32 MUX-O Optical Specifications

Parameter Note Condition Min Max Unit

Trx filter shape 
(–0.5 dB bandwidth 
TrxBW2)

All SOP and within 
whole operating 
temperature range

COM Rx—xx.xx Tx

COM Rx—yy.yy Tx

COM Rx—zz.zz Tx

COM Rx—kk.kk Tx

+/–180 — pm

xx.xx Rx—COM Tx

yy.yy Rx—COM Tx

zz.zz Rx—COM Tx

kk.kk Rx—COM Tx

Insertion loss 
demultiplexer 
section

All SOP and within 
whole operating 
temperature range

COM Rx—xx.xx Tx — 1.9 dB

COM Rx—yy.yy Tx — 2.4 dB

COM Rx—zz.zz Tx — 2.8 dB

COM Rx—kk.kk Tx — 3.3 dB

Insertion loss 
multiplexer section

All SOP and within 
whole operating 
temperature range

(Two connectors 
included)

xx.xx Rx—COM Tx — 3.6 dB

yy.yy Rx—COM Tx — 3.2 dB

zz.zz Rx—COM Tx — 3.0 dB

kk.kk Rx—COM Tx — 2.6 dB

VOA dynamic range — — 25 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.9 AD-1C-xx.x Card Specifications
B.4.9 AD-1C-xx.x Card Specifications
Table B-7 lists the AD-1C-xx.x optical specifications.

AD-1C-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 14-3 on page 14-7 through Table 14-6 on page 14-9 for this 
information.

The AD-1C-xx.x card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95% RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.10 AD-2C-xx.x Card Specifications
Table B-8 lists the AD-2C-xx.x optical specifications.

Table B-7 AD-1C-xx.x Card Optical Specifications

Parameter Condition Note Min Max Unit

Trx filter shape
(–0.5 dB bandwidth)
TrxBW2

COM Rx—xx.xx Tx
xx.xx Rx—COM Tx

All SOP and within whole 
operating temperature range

+/–180 — pm

Rfx filter shape
(–0.5 dB bandwidth)
RfxBW2

COM Rx—Exp Tx
Exp Rx—COM Tx

All SOP and within whole 
operating temperature range

+/–180 — pm

Insertion loss
(drop section)

COM Rx—xx.xx Tx All SOP and within whole 
operating temperature range 
(two connectors included)

— 2.0 dB

Insertion loss
(express section)

COM Rx—Exp Tx
Exp Rx—COM Tx

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

— 2.4 or 
1.2

dB

Insertion loss
(add section)

xx.xx Rx—COM Tx VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

— 2.6 dB

VOA dynamic range — — 30 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.11 AD-4C-xx.x Card Specifications
AD-2C-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 14-3 on page 14-7 through Table 14-6 on page 14-9 for this 
information.

The AD-2C-xx.x has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95% RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.11 AD-4C-xx.x Card Specifications
Table B-9 lists the AD-4C-xx.x optical specifications.

Table B-8 AD-2C-xx.x Card Optical Specifications

Parameter Note Condition Min Max Unit

Trx filter shape
(–0.5 dB bandwidth)
TrxBW2

All SOP and within whole 
operating temperature range

COM Rx—xx.xx Tx
COM Rx—yy.yy Tx

+/–180 — pm

xx.xx Rx—COM Tx
yy.yy Rx—COM Tx

+/–180 —

Rfx filter shape
(–0.5 dB bandwidth)
RfxBW2

All SOP and within whole 
operating temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

+/–180 — pm

Insertion loss
(drop section)

All SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—xx.xx Tx — 2.0 dB

COM Rx—yy.yy Tx — 2.4 dB

Insertion loss
(express section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—Exp Tx — 2.7 dB

Exp Rx—COM Tx — 1.6 dB

Insertion loss
(add section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

xx.xx Rx—COM Tx — 3.1 dB

yy.yy Rx—COM Tx — 2.7 dB

VOA dynamic range — — 30 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.11 AD-4C-xx.x Card Specifications
AD-4C-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 14-3 on page 14-7 through Table 14-6 on page 14-9 for this 
information.

The AD-4C-xx.x has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95% RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

Table B-9 AD-4C-xx.x Optical Specifications

Parameter Note Condition Min Max Unit

Channel grid See Table B-10 — — — —

Trx filter shape
(–0.5 dB 
bandwidth)
TrxBW2

All SOP and within whole 
operating temperature range

COM Rx—xx.xx Tx
COM Rx—yy.yy Tx
COM Rx—zz.zz Tx
COM Rx—kk.kk Tx
xx.xx Rx—COM Tx
yy.yy Rx—COM Tx

+/–180 — pm

Rfx filter shape
(–1 dB bandwidth)
RfxBW2

All SOP and within whole 
operating temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

— — pm

Insertion loss
(drop section)

All SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—xx.xx Tx — 5.5 dB

COM Rx—yy.yy Tx — 5.0 dB

COM Rx—zz.zz Tx — 4.5 dB

COM Rx—kk.kk Tx — 4.1 dB

Insertion loss
(express section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

COM Rx—Exp Tx — 2.7 dB

Exp Rx—COM Tx — 1.2 dB

Insertion loss
(add section)

VOA at minimum attenuation; 
all SOP and within whole 
operating temperature range 
(two connectors included)

xx.xx Rx—COM Tx — 3.9 dB

yy.yy Rx—COM Tx — 4.3 dB

zz.zz Rx—COM Tx — 4.5 dB

kk.kk Rx—COM Tx — 4.9 dB

VOA dynamic 
range

— — 30 — dB

Maximum optical 
input power

— — 300 — mW
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B.4.12 AD-1B-xx.x Card Specifications
B.4.12 AD-1B-xx.x Card Specifications
Table B-10 lists the unit names, band IDs, channel IDs, frequencies, and wavelengths assigned to the 
eight versions of the AD-1B-xx.x card.

Table B-10 AD-1B-xx.x Channel Allocation Plan by Band

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)

AD-1B-30.3 B30.3 30.3 195.9 1530.33

30.7 195.85 1530.72

31.1 195.8 1531.12

31.5 195.75 1531.51

31.9 195.7 1531.90

32.2 195.65 1532.29

32.6 195.6 1532.68

33.3 195.55 1533.07

AD-1B-34.2 B34.2 34.2 195.4 1534.25

34.6 195.35 1534.64

35.0 195.3 1535.04

35.4 195.25 1535.43

35.8 195.2 1535.82

36.2 195.15 1536.22

36.6 195.1 1536.61

37.0 195.05 1537.00

AD-1B-38.1 B38.1 38.1 194.9 1538.19

38.5 194.85 1538.58

38.9 194.8 1538.98

39.3 194.75 1539.37

39.7 194.7 1539.77

40.1 194.65 1540.16

40.5 194.6 1540.56

40.9 194.55 1540.95

AD-1B-42.2 B42.1 42.1 194.4 1542.14

42.5 194.35 1542.54

42.9 194.3 1542.94

43.3 194.25 1543.33

43.7 194.2 1543.73

44.1 194.15 1544.13

44.5 194.1 1544.53

44.9 194.05 1544.92
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B.4.12 AD-1B-xx.x Card Specifications
Table B-11 lists AD-1B-xx.x optical specifications.

AD-1B-46.1 B46.1 46.1 193.9 1546.12

46.5 193.85 1546.52

46.9 193.8 1546.92

47.3 193.75 1547.32

47.7 193.7 1547.72

48.1 193.65 1548.11

48.5 193.6 1548.51

48.9 193.55 1548.91

AD-1B-50.1 B50.1 50.1 193.4 1550.12

50.5 193.35 1550.52

50.9 193.3 1550.92

51.3 193.25 1551.32

51.7 193.2 1551.72

52.1 193.15 1552.12

52.5 193.1 1552.52

52.9 193.05 1552.93

AD-1B-54.1 B54.1 54.1 192.9 1554.13

54.5 192.85 1554.54

54.9 192.8 1554.94

55.3 192.75 1555.34

55.7 192.7 1555.75

56.1 192.65 1556.15

56.5 192.6 1556.96

56.9 192.55 1556.96

AD-1B-58.1 B58.1 58.1 192.4 1558.17

58.5 192.35 1558.58

58.9 192.3 1558.98

59.3 192.25 1559.39

59.7 192.2 1559.79

60.2 192.15 1560.20

60.6 192.1 1560.61

61.0 192.05 1561.01

Table B-10 AD-1B-xx.x Channel Allocation Plan by Band (continued)

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)
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B.4.12 AD-1B-xx.x Card Specifications
Table B-12 lists the range of wavelengths for the receive (express) band.

AD-1B-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 14-3 on page 14-7 through Table 14-6 on page 14-9 for this 
information.

Table B-11 AD-1B-xx.x Optical Specifications

Parameter Note Condition Min Max Unit

–1 dB bandwidth All SOP and within whole 
operating environmental range 

COM Rx—Band Tx
Band Rx—COM Tx

3.6 — nm

–1 dB bandwidth All SOP and within whole 
operating temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

Refer to 
Table B-12.

nm

Insertion loss
(drop section)

All SOP and within whole 
operating environmental range; 
two connectors included, VOA set 
at minimum attenuation

COM Rx—Band Tx — 3.0 dB

Insertion loss
(express section)

All SOP and within whole 
operating environmental range; 
two connectors included

Exp Rx—COM Tx — 1.6 dB

All SOP and within whole 
operating environmental range; 
two connectors included, VOA set 
at its minimum attenuation

COM Rx—Exp Tx — 2.2 dB

Insertion loss
(add section)

All SOP and within whole 
operating environmental range; 
two connectors included

Band Rx—COM Tx — 2.2 dB

VOA dynamic 
range

— — 30 — dB

Maximum optical 
input power

— — 300 — mW

Table B-12 AD-1B-xx.x Transmit and Receive Dropped Band Wavelength Ranges

Tx (Dropped) Band

Rx (Express) Band

Left Side (nm) Right Side (nm)

B30.3 — Wavelengths 1533.825 or higher

B34.2 Wavelengths 1533.395 or lower Wavelengths 1537.765 or higher

B38.1 Wavelengths 1537.325 or lower Wavelengths 1541.715 or higher

42.1 Wavelengths 1541.275 or lower Wavelengths 1545.695 or higher

46.1 Wavelengths 1545.245 or lower Wavelengths 1549.695 or higher

50.1 Wavelengths 1549.235 or lower Wavelengths 1553.705 or higher

54.1 Wavelengths 1553.255 or lower Wavelengths 1557.745 or higher

58.1 Wavelengths 1557.285 or lower —
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B.4.13 AD-4B-xx.x Card Specifications
The AD-1B-xx.x card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95% RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.13 AD-4B-xx.x Card Specifications
Table B-13 lists the unit names, band IDs, channel IDs, frequencies, and wavelengths assigned to the two 
versions of the card.
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B.4.13 AD-4B-xx.x Card Specifications
Table B-13 AD-4B-xx.x Channel Allocation Plan by Band

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)

AD-4B-30.3 B30.3 30.3 195.9 1530.33

30.7 195.85 1530.72

31.1 195.8 1531.12

31.5 195.75 1531.51

31.9 195.7 1531.90

32.2 195.65 1532.29

32.6 195.6 1532.68

33.3 195.55 1533.07

B34.2 34.2 195.4 1534.25

34.6 195.35 1534.64

35.0 195.3 1535.04

35.4 195.25 1535.43

35.8 195.2 1535.82

36.2 195.15 1536.22

36.6 195.1 1536.61

37.0 195.05 1537.00

B38.1 38.1 194.9 1538.19

38.5 194.85 1538.58

38.9 194.8 1538.98

39.3 194.75 1539.37

39.7 194.7 1539.77

40.1 194.65 1540.16

40.5 194.6 1540.56

40.9 194.55 1540.95

B42.1 42.1 194.4 1542.14

42.5 194.35 1542.54

42.9 194.3 1542.94

43.3 194.25 1543.33

43.7 194.2 1543.73

44.1 194.15 1544.13

44.5 194.1 1544.53

44.9 194.05 1544.92
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B.4.13 AD-4B-xx.x Card Specifications
Table B-14 lists AD-4B-xx.x optical specifications.

AD-4B-46.1 B46.1 46.1 193.9 1546.12

46.5 193.85 1546.52

46.9 193.8 1546.92

47.3 193.75 1547.32

47.7 193.7 1547.72

48.1 193.65 1548.11

48.5 193.6 1548.51

48.9 193.55 1548.91

B50.1 50.1 193.4 1550.12

50.5 193.35 1550.52

50.9 193.3 1550.92

51.3 193.25 1551.32

51.7 193.2 1551.72

52.1 193.15 1552.12

52.5 193.1 1552.52

52.9 193.05 1552.93

B54.1 54.1 192.9 1554.13

54.5 192.85 1554.54

54.9 192.8 1554.94

55.3 192.75 1555.34

55.7 192.7 1555.75

56.1 192.65 1556.15

56.5 192.6 1556.96

56.9 192.55 1556.96

B58.1 58.1 192.4 1558.17

58.5 192.35 1558.58

58.9 192.3 1558.98

59.3 192.25 1559.39

59.7 192.2 1559.79

60.2 192.15 1560.20

60.6 192.1 1560.61

61.0 192.05 1561.01

Table B-13 AD-4B-xx.x Channel Allocation Plan by Band (continued)

Unit Name Band ID Channel ID Frequency (GHz) Wavelength (nm)
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B.4.13 AD-4B-xx.x Card Specifications
Table B-15 lists the range of wavelengths for the receive (express) band.

Table B-14 AD-4B-xx.x Optical Specifications

Parameter Note Condition Min Max Unit

–1 dB bandwidth All SOP and within whole operating 
environmental range 

COM Rx—Band Tx
Band Rx—COM Tx

3.6 — nm

–1 dB bandwidth All SOP and within whole operating 
temperature range

COM Rx—Exp Tx
Exp Rx—COM Tx

Refer to 
Table B-15.

nm

Insertion loss
(drop section)

All SOP and within whole operating 
environmental range; two connectors 
included, VOA set at minimum 
attenuation

COM Rx—Band Tx
30.3/46.1

— 2.9 dB

COM Rx—Band Tx
34.2/50.1

— 3.3 dB

COM Rx—Band Tx
38.1/54.1

— 3.8 dB

COM Rx—Band Tx
42.1/58.1

— 4.5 dB

Insertion loss
(express section)

All SOP and within whole operating 
environmental range; two connectors 
included

Exp Rx—COM Tx — 4.9 dB

All SOP and within whole operating 
environmental range; two connectors 
included, VOA set at its minimum 
attenuation

COM Rx—Exp Tx — 3 dB

Insertion loss
(add section)

All SOP and within whole operating 
environmental range; two connectors 
included

Band Rx 
30.3/46.1—COM Tx

— 3.5 dB

Band Rx 
34.2/50.1—COM Tx

— 2.8 dB

Band Rx 
38.1/54.1—COM Tx

— 2.3 dB

Band Rx 
42.1/58.1—COM Tx

— 1.8 dB

VOA dynamic 
range

— — 30 — dB

Maximum optical 
input power

— — 300 — mW

Table B-15 AD-4B-xx.x Transmit and Receive Dropped Band Wavelength Ranges

Tx (Dropped) Band

Rx (Express) Band

Left Side (nm) Right Side (nm)

B30.3 — Wavelengths1533.825 or higher

B34.2 Wavelengths 1533.395 or lower Wavelengths 1537.765 or higher

B38.1 Wavelengths 1537.325 or lower Wavelengths 1541.715 or higher

B42.1 Wavelengths 1541.275 or lower Wavelengths 1545.695 or higher
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B.4.14 32WSS Card Specifications
AD-4B-xx.x optical input and output power varies with amplifier output levels and the class of 
transponder interfaces used. See Table 14-3 on page 14-7 through Table 14-6 on page 14-9 for this 
information.

The AD-4B-xx.x has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: Telcordia GR-63 5.1.1.3 compliant; 5 to 95% RH 

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.92 in. (23.4 mm)

– Depth: 9.0 in. (228.6 mm)

B.4.14 32WSS Card Specifications
The 32WSS card optical specifications are listed in Table B-4.

Note For power specifications, refer to the “14.1.7 Multiplexer, Demultiplexer, and OADM Card Interface 
Classes” section on page 14-7.

B46.1 Wavelengths 1545.245 or lower Wavelengths 1549.695 or higher

B50.1 Wavelengths 1549.235 or lower Wavelengths 1553.705 or higher

B54.1 Wavelengths 1553.255 or lower Wavelengths 1557.745 or higher

B58.1 Wavelengths 1557.285 or lower —

Table B-15 AD-4B-xx.x Transmit and Receive Dropped Band Wavelength Ranges (continued)

Tx (Dropped) Band

Rx (Express) Band

Left Side (nm) Right Side (nm)

Table B-16 32WSS Optical Specifications

Parameter Condition Note Min Typical Max Units

–0.25 dB bandwidth EXP RX => 
COM TX

All SOP and within 
whole operating 
temperature range, 
connectors 
included, and for 
maximum VOA 
operating 
attenuation.

+/–/95 — — pm

–0.5 dB bandwidth +/–115 — — pm

–1.0 dB bandwidth +/–135 — — pm

–0.25 dB bandwidth Add 1, 32 => 
COM TX

+/–115 — — pm

–0.5 dB bandwidth +/–135 — — pm

–1.0 dB bandwidth +/–160 — — pm
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B.5 Transponder and Muxponder Card Specifications
The 32WSS card has the following additional specifications:

• Environmental

– Operating temperature: 

C-Temp: –5 to +55 degrees Celsius (+23 to +131 degrees Fahrenheit)

– Operating humidity: 5 to 95% RH

• Dimensions

– Height: 12.65 in. (321.3 mm)

– Width: 1.84 in. (46.8 mm)

– Depth: 9.00 in. (228.6 mm)

B.5 Transponder and Muxponder Card Specifications
This section provides specifications for the TXP_MR_10G, MXP_2.5G_10G, TXP_MR_2.5G, 
TXPP_MR_2.5G, MXP_MR_2.5G, MXPP_MR_2.5G, MXP_2.5G_10E, and TXP_MR_2.5G cards.

For compliance information, refer to the Cisco Optical Transport Products Safety and Compliance 
Information document. 

Insertion loss EXP RX => 
COM TX

All SOP, any 
optical switch state, 
and within whole 
operating 
temperature range, 
connectors 
included.

— — 11.3 dB

COM RX => 
EXP TX

— — — 1.5 dB

Add 1, 32 => 
COM TX

— — — 7.6 dB

COM RX => 
DROP TX

— 6 — 8.5 dB

VOA dynamic range EXP RX => 
COM TX

— 20 — — dB

Add 1, 32 => 
COM TX

— 25 — — dB

Maximum optical 
input power

— — 300 — — mW

Table B-16 32WSS Optical Specifications (continued)

Parameter Condition Note Min Typical Max Units
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B.5.1 TXP_MR_10G Card Specifications
B.5.1 TXP_MR_10G Card Specifications
The TXP_MR_10G card has the following specifications:

• Line (trunk side) 

– Bit rate: 

9.95328 Gbps for OC-192/STM-64

10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC

10.3125 Gbps for 10 GE 

11.095 Gbps with ITU-T G.709 Digital Wrapper/FEC over 10GE

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 1000 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10G 
card in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10G 
card. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_10G card.

– Connectors: LC 

– Compliance Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.691

• Transmitter (trunk side) 

– Maximum transmitter output power: +3.5 dBm 

– Minimum transmitter output power: +2.5 dBm 

– Transmitter: Lithium Niobate (LN) external modulator transmitter

– Wavelength stability (drift): +/- 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/- 25 pm.

• Currently available wavelengths and versions of MXP_2.5G_10G: 

ITU grid blue band:

– 1542.14 to 1542.94 nm, 10M-L1-42.1 

– 1543.73 to 1544.53 nm, 10M-L1-43.7 

ITU grid red band:

– 1558.17 to 1558.98 nm, 10M-L1-58.1 

– 1559.79 to 1560.61 nm, 10M-L1-59.7 

• Receiver (trunk side): 

– Receiver input power (no FEC, unamplified, 23 dB OSNR, BER 1 * 10 exp – 12): –8 to –21 dBm

– Receiver input power (no FEC, unamplified, 23 dB OSNR, @ +/– 1000 ps/nm BER 1 * 10 
exp – 12): –8 to –19 dBm
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B.5.1 TXP_MR_10G Card Specifications
– Receiver input power (no FEC, amplified, 19 dB OSNR, BER 1 * 10 exp – 12): –8 to –20 dBm

– Receiver input power (no FEC, amplified, 19 dB OSNR, @ +/– 1000 ps/nm BER 1 * 10 
exp – 12):–8 to –18 dBm

– Receiver input power (FEC, unamplified, 23 dB OSNR, BER 8 * 10 exp – 5): –8 to –24 dBm

– Receiver input power (FEC, unamplified, 23 dB OSNR, @ +/– 1000 ps/nm, BER 8 * 10 
exp – 5): –8 to –22 dBm

– Receiver input power (FEC, amplified, 9 dB OSNR, BER 8 * 10 exp – 5): –8 to –18 dBm

– Receiver input power (FEC, unamplified, 11 dB OSNR, @ +/– 800 ps/nm, BER 8 * 10 exp – 5): 
–8 to –18 dBm

• Line (client side) 

– Bit rate: 9.95328 Gbps or 10.3125 Gbps

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: Compliant with SR-1 specification for OC-192. In 
the case of 10 GE, allowance is up to 10km of SMF fiber of dispersion. 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.697, 10GE BASE LR

• Transmitter (client side)

– Maximum transmitter output power: –1 dBm 

– Minimum transmitter output power: –6 dBm 

– Center wavelength: 1290 to 1330 nm

– Nominal wavelength: 1310 nm

– Transmitter: Distributed feedback (DFB) laser 

• Receiver (client side)

– Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12 

– Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12 

– Receiver: APD

– Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12

– Receiver input wavelength range: 1290 to 1605 nm

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 35.00 W, 0.73 A at –48 V, 119.5 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)
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B.5.2 MXP_2.5G_10G Card Specifications
– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.5.2 MXP_2.5G_10G Card Specifications
The MXP_2.5G_10G card has the following specifications:

• Line (trunk side) 

– Bit rate: 

9.95328 Gbps for OC-192/STM-64 

10.70923 Gbps with ITU-T G.709 Digital Wrapper/FEC

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 1000 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10G 
card in a loopback on the trunk port. Do not use direct fiber loopbacks with the 
MXP_2.5G_10G card. Using direct fiber loopbacks causes irreparable damage to the 
MXP_2.5G_10G card.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.691

• Transmitter (trunk side) 

– Maximum transmitter output power: +3 dBm 

– Minimum transmitter output power: –16 dBm 
(The optical output power on the trunk side is configurable from –16 to +3 dBm with an 
accuracy of +/–0.5 dB.)

– Transmitter: Lithium Niobate (LN) external modulator transmitter

– Wavelength stability (drift): +/- 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/- 25 pm.

• Receiver (trunk side) 

– Receiver input power (no FEC, unamplified, 23 dB OSNR, BER 1 * 10 exp – 12): –8 to –21 dBm

– Receiver input power (no FEC, unamplified, 23 dB OSNR, @ +/– 1000 ps/nm BER 1 * 10 
exp – 12): –8 to –19 dBm

– Receiver input power (no FEC, amplified, 19 dB OSNR, BER 1 * 10 exp – 12): –8 to –20 dBm

– Receiver input power (no FEC, amplified, 19 dB OSNR, @ +/– 1000 ps/nm BER 1 * 10 
exp – 12):–8 to –18 dBm

– Receiver input power (FEC, unamplified, 23 dB OSNR, BER 8 * 10 exp – 5): –8 to –24 dBm
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B.5.2 MXP_2.5G_10G Card Specifications
– Receiver input power (FEC, unamplified, 23 dB OSNR, @ +/– 1000 ps/nm, BER 8 * 10 
exp – 5): –8 to –22 dBm

– Receiver input power (FEC, amplified, 9 dB OSNR, BER 8 * 10 exp – 5): –8 to –18 dBm

– Receiver input power (FEC, unamplified, 11 dB OSNR, @ +/– 800 ps/nm, BER 8 * 10 exp – 5): 
–8 to –18 dBm

• Line (client side) 

– Bit rate: 2.48832 Gbps

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: Compliant with SR-1 specification for OC-192. In 
the case of 10 GE, allowance is up to 10km of SMF fiber of dispersion. 

– Loopback modes: Terminal and facility

– Connectors: LC

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side)

– Depends on SFP that is used. There are two SFPs available: 15454-SFP-OC48-IR (1310 nm for 
OC48/DV6000, intermediate reach) and ONS-SE-2G-S1 (1310 nm for OC48/STM-16, short 
reach). See the “14.13 SFP Modules” section on page 14-123 and the document titled 
“Installing GBIC, SFP and XFP Optics Modules in Cisco ONS 15454, 15327, 15600, and 15310 
Platforms” for more details.

• Receiver (client side)

– Depends on SFP that is used. There are two SFPs available: 15454-SFP-OC48-IR (1310 nm for 
OC48/DV6000, intermediate reach) and ONS-SE-2G-S1 (1310 nm for OC48/STM-16, short 
reach). See the “14.13 SFP Modules” section on page 14-123 and the document titled 
“Installing GBIC, SFP and XFP Optics Modules in Cisco ONS 15454, 15327, 15600, and 15310 
Platforms” for more details.

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 50.00 W, 1.04 A at –48 V, 170.7 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

• Compliance

– For compliance information, refer to the Cisco Optical Transport Products Safety and 
Compliance Information.
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B.5.3 TXP_MR_2.5G and TXPP_MR_2.5G Card Specifications
B.5.3 TXP_MR_2.5G and TXPP_MR_2.5G Card Specifications
The TXP_MR_2.5G and TXPP_MR_2.5G cards have the following specifications:

• Line (trunk side) 

– Bit rate: 

2.488 Gbps for OC-48/STM-16 

2.66 Gbps with ITU-T G.709 Digital Wrapper/FEC

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 6000 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the TXP_MR_2.5G 
and TXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks 
with the TXP_MR_2.5G and TXPP_MR_2.5G cards. Using direct fiber loopbacks causes 
irreparable damage to the TXP_MR_2.5G and TXPP_MR_2.5G cards.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (trunk side) 

– Maximum transmitter output power: +1 dBm 

– Minimum transmitter output power: –4.5 dBm 

– Transmitter: Direct modulated laser

– Wavelength stability (drift): +/- 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/- 25 pm.

• Currently available wavelengths of TXP_MR_2.5G and TXPP_MR_2.5G: 

ITU grid blue band: 1530.334 to 1544.526 nm

ITU grid red band: 1546.119 to 1560.606 nm

• Receiver (trunk side) 

– Receiver input power (no FEC, unamplified, BER 1 * 10 exp – 12): –9 to –30 dBm

– Receiver input power (FEC, unamplified, BER 1 * 10 exp – 6): –9 to –31 dBm

– Receiver input power (no FEC, amplified, BER 1 * 10 exp – 12): –9 to –23 dBm

– Receiver input power (FEC, amplified, BER 1 * 10 exp – 6): –9 to –25 dBm

– Receiver: APD

– Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at 
BER = 1 * 10 exp – 12 including dispersion

– Receiver input wavelength range: 1290 to 1605 nm
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B.5.4 MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications
• Line (client side) 

– Bit rate: 8 Mbps to 2.488 Gbps

– Code: Scrambled NRZ 

– Fiber: 1310-nm single-mode 

– Maximum chromatic dispersion allowance: 1600 ps/nm 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side)

– Depends on SFP that is used. There are 13 SFPs available: 15454-SFP3-1-IR, 
15454E-SFP-L.1.1, 15454-SFP12-4-IR, 15454E-SFP-L.4.1, 15454-SFP-OC48-IR, 
15454E-SFP-L.16.1, ONS-SE-2G-S1, 15454-SFP-200, 15454E-SFP-200, 
15454-SFP-GEFC-SX, 15454E-SFP-GEFC-S, 15454-SFP-GE+-LX, and 
15454E-SFP-GE+-LX. See the “14.13 SFP Modules” section on page 14-123 and the 
document titled “Installing GBIC, SFP and XFP Optics Modules in Cisco ONS 15454, 15327, 
15600, and 15310 Platforms” for more details and specifications.

• Receiver (client side)

– Depends on SFP that is used. There are 13 SFPs available: 15454-SFP3-1-IR, 
15454E-SFP-L.1.1, 15454-SFP12-4-IR, 15454E-SFP-L.4.1, 15454-SFP-OC48-IR, 
15454E-SFP-L.16.1, ONS-SE-2G-S1, 15454-SFP-200, 15454E-SFP-200, 
15454-SFP-GEFC-SX, 15454E-SFP-GEFC-S, 15454-SFP-GE+-LX, and 
15454E-SFP-GE+-LX. See the “14.13 SFP Modules” section on page 14-123 and the 
document titled “Installing GBIC, SFP and XFP Optics Modules in Cisco ONS 15454, 15327, 
15600, and 15310 Platforms” for more details and specifications.

• Environmental

– Operating temperature: –5 to +45 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 35.00 W, 0.73 A at –48 V, 119.5 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.5.4 MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications
The MXP_MR_2.5G and MXPP_MR_2.5G cards have the following specifications:

• Payload configuration

– 2xGE or 2xFC

– 1x2G FC
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B.5.4 MXP_MR_2.5G and MXPP_MR_2.5G Card Specifications
– Mixed configurations up to maximum line rate (for example, if you have a port configured for 
2G FC, you cannot use another port at the same time)

• Client ports: 8x SFP

• Performance monitoring (PM) for all interfaces

• Buffer-to-buffer credit management for distance extension

• Line (trunk side) 

– Bit rate: 2.488 Gbps for OC-48/STM-16

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: 6000 ps/nm 

– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_MR_2.5G 
and MXPP_MR_2.5G cards in a loopback on the trunk port. Do not use direct fiber loopbacks 
with the MXP_MR_2.5G and MXPP_MR_2.5G cards. Using direct fiber loopbacks causes 
irreparable damage to the MXP_MR_2.5G and MXPP_MR_2.5G cards.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, Telcordia GR-2918-CORE, Issue 2, ITU-T G.957, and 
ITU-T 100-GHz grid standard G.692

• Transmitter (trunk side) 

– Transmit power: +3 +/–1 dBm with MXP_MR_2.5G card, and +/–1 dBm with 
MXPP_MR_2.5G card

– 50-GHz DWDM migration ready (the wavelength deviation is less than +/–0.040 nm through 
wavelocker deployment)

– Four-channel wavelength tunability at 100-GHz spacing

– Transmitter maximum return reflectance: –27 dB

– Chromatic dispersion allowance: 5400 ps/nm, giving an optical power penalty < 2.0 dB

– Minimum side mode suppression ratio: 30 dB

– Transmitter is a direct modulated laser

– Wavelength stability (drift): +/- 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/- 25 pm.

• Currently available wavelengths of the TXP_MR_2.5G and TXPP_MR_2.5G cards: 

ITU grid blue band: 1530.334 to 1544.526 nm

ITU grid red band: 1546.119 to 1560.606 nm

• Receiver (trunk side) 

– Receiver sensitivity –28 dBm, BER 1 * 10 exp – 12

– Receiver overload is equal to or exceeds –8 dBm
B-37
Cisco ONS 15454 DWDM Installation and Operations Guide, R4.7

April 2006



Appendix B      Hardware Specifications
B.5.5 MXP_2.5G_10E Card Specifications
– Receiver maximum reflectance of –27 dB

• Line (client side) 

– Bit rate: 1.06 Gbps to 2.125 Gbps per client

– Code: Scrambled NRZ 

– Fiber: 1310-nm single-mode or 850-nm multimode

– Maximum chromatic dispersion allowance: 1600 ps/nm 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side)

– Depends on SFP that is used. There are four SFPs available: 15454-SFP-GE+-LX, 
15454E-SFP-GE+-LX, 15454-SFP-GEFC-SX, and 15454E-SFP-GEFC-S. See the “14.13 SFP 
Modules” section on page 14-123 and the document titled “Installing GBIC, SFP and XFP 
Optics Modules in Cisco ONS 15454, 15327, 15600, and 15310 Platforms” for more details and 
specifications.

• Receiver (client side)

– Depends on SFP that is used. There are four SFPs available: 15454-SFP-GE+-LX, 
15454E-SFP-GE+-LX, 15454-SFP-GEFC-SX, and 15454E-SFP-GEFC-S. See the “14.13 SFP 
Modules” section on page 14-123 and the document titled “Installing GBIC, SFP and XFP 
Optics Modules in Cisco ONS 15454, 15327, 15600, and 15310 Platforms” for more details and 
specifications.

• Environmental

– Operating temperature: –5 to +40 degrees Celsius (+23 to +104 degrees Fahrenheit) 

– Operating humidity: 5 to 85%, noncondensing

– Power consumption (maximum): 60 W, 1.25 A at –48 V, 204 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 2.25 lb (1.02 kg) 

B.5.5 MXP_2.5G_10E Card Specifications 
The MXP_2.5G_10E card has the following specifications:

• Line (trunk side) 

– Bit rate: 10.70923 Gbps (in ITU-T G.709 Digital Wrapper/FEC mode)

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: +/–1200 ps/nm (specified penalty) 
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B.5.5 MXP_2.5G_10E Card Specifications
– Loopback modes: Terminal and facility

Caution You must use a 20-dB fiber attenuator (15 to 25 dB) when working with the MXP_2.5G_10E card in a 
loopback on the trunk port. Do not use direct fiber loopbacks with the MXP_2.5G_10E card. Using 
direct fiber loopbacks causes irreparable damage to the MXP_2.5G_10E card.

– Connectors: LC 

– Compliance: ITU-T G.707, ITU-T G.709, ITU-T G.957, and Telcordia GR-253-CORE

• Transmitter (trunk side) 

– Maximum transmitter output power: +6 dBm 

– Minimum transmitter output power: +3 dBm 

– Transmitter: LN external modulator transmitter

– Wavelength stability (drift): +/- 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/- 25 pm.

• Currently available wavelengths and versions of MXP_2.5G_10E: 

ITU grid blue band:

– 1530.33 to 1533.07 nm 

– 1534.25 to 1537.00 nm 

– 1538.19 to 1540.95 nm

– 1542.14 to 1544.92 nm

ITU grid red band:

– 1546.12 to 1548.92 nm 

– 1550.12 to 1552.93 nm 

– 1554.13 to 1556.96 nm 

– 1558.17 to 1561.01 nm 

• Receiver (trunk side) 

– Receiver input power (no FEC, unamplified, BER 1 * 10 exp – 12): –8 to –22 dBm

– Receiver input power (FEC, unamplified, BER 1 * 10 exp – 6): –8 to –26 dBm

– Receiver input power (no FEC, amplified, BER 1 * 10 exp – 12): –8 to –20 dBm

– Receiver input power (FEC, amplified, BER 1 * 10 exp – 6): –8 to –18 dBm

– Receiver: APD

– Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at 
BER = 1 * 10 exp – 12 including dispersion

– Receiver input wavelength range: 1290 to 1605 nm

• Line (client side) 

– Bit rate: 2.5 Gbps per port (OC-48/STM-16)

– Code: Scrambled NRZ 
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– Fiber: 1310-nm single-mode 

– Maximum chromatic dispersion allowance: 12 ps/nm (SR SFP version) 

– Loopback modes: Terminal and facility

– Connectors: LC (optical)

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957

• Transmitter (client side)

– Depends on the SFP that is used.

• Receiver (client side)

– Depends on the SFP that is used.

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 50.00 W (maximum), 1.11 A at –48 V, 136.6 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.5.6 TXP_MR_10E Card Specifications
The TXP_MR_10E card has the following specifications:

• Line (trunk side) 

– Bit rate: OC-192/STM-64 (9.95328 Gbps), OTU2 (10.70923 Gbps), 10GE (10.3125 Gbps), 
10GE into OTU2 (non-standard 11.0957 Gbps), 10G FC (10.51875 Gbps), or 10G FC into 
OTU2 (non-standard 11.31764 Gbps).

– Code: Scrambled NRZ 

– Fiber: 1550-nm single-mode 

– Maximum chromatic dispersion allowance: +/–1200 ps/nm (specified penalty) 

– Loopback modes: Terminal and facility

Caution You must use a 15-dB fiber attenuator (10 to 20 dB) when working with the TXP_MR_10E 
card in a loopback on the trunk port. Do not use direct fiber loopbacks with the TXP_MR_10E 
card. Using direct fiber loopbacks causes irreparable damage to the TXP_MR_10E card.

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957, and ITU-T G.709 

• Transmitter (trunk side) 
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– Maximum transmitter output power: +6 dBm 

– Minimum transmitter output power: +3 dBm 

– Transmitter: LN external modulator transmitter

– Wavelength stability (drift): +/- 25 picometers (pm)

Note An optical device on the card keeps the laser wavelength locked as closely as possible to the ITU nominal 
value. The allowed drift is +/- 25 pm.

• Currently available wavelengths and versions of TXP_MR_10E: 

ITU grid blue band:

– 1530.33 to 1533.07 nm 

– 1534.25 to 1537.00 nm 

– 1538.19 to 1540.95 nm

– 1542.14 to 1544.92 nm

ITU grid red band:

– 1546.12 to 1548.92 nm 

– 1550.12 to 1552.93 nm 

– 1554.13 to 1556.96 nm 

– 1558.17 to 1561.01 nm 

• Receiver (trunk side) 

– Receiver input power (no FEC, unamplified, BER 1 * 10 exp – 12): –8 to –22 dBm

– Receiver input power (FEC, unamplified, BER 1 * 10 exp – 6): –8 to –26 dBm

– Receiver input power (no FEC, amplified, BER 1 * 10 exp – 12): –8 to –20 dBm

– Receiver input power (FEC, amplified, BER 1 * 10 exp – 6): –8 to –18 dBm

– Receiver: APD

– Link loss budget: 24 dB minimum, with no dispersion or 22 dB optical path loss at 
BER = 1 * 10 exp – 12 including dispersion

– Receiver input wavelength range: 1290 to 1605 nm

• Line (client side) - XFP-based SR

– XFP-based SR

– Bit rate: 10GE (10.3125 Gbps), 10G FC (10.51875 Gbps), or STM-64/OC-192

– Code: Scrambled NRZ 

– Fiber: 1310-nm single-mode 

– Maximum chromatic dispersion allowance: 6.6 ps/nm 

– Loopback modes: Terminal and facility

– Connectors: LC 

– Compliance: Telcordia GR-253-CORE, ITU-T G.707, ITU-T G.957, ITU-T G.691

• Transmitter (client side)

– Maximum transmitter output power: –1 dBm 
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B.6 SFP Specifications
– Minimum transmitter output power: –6 dBm 

– Center wavelength: 1290 to 1330 nm

– Nominal wavelength: 1310 nm

– Transmitter: DFB laser 

• Receiver (client side)

– Maximum receiver level: –1 dBm at BER 1 * 10 exp – 12 

– Minimum receiver level: –14 dBm at BER 1 * 10 exp – 12 

– Receiver: APD

– Link loss budget: 8 dB minimum, at BER = 1 * 10 exp – 12

– Receiver input wavelength range: 1290 to 1605 nm

• Environmental

– Operating temperature: –5 to +55 degrees Celsius (+23 to +113 degrees Fahrenheit) 

– Operating humidity: 5 to 95%, noncondensing

– Power consumption: 50.00 W (maximum), 1.11 A at –48 V, 136.6 BTU/hr

• Dimensions

– Height: 12.650 in. (321.3 mm)

– Width: 0.716 in. (18.2 mm)

– Depth: 9.000 in. (228.6 mm)

– Depth with backplane connector: 9.250 in. (235 mm)

– Weight not including clam shell: 3.1 lb (1.3 kg) 

B.6 SFP Specifications
Table B-17 lists the specifications for available SFPs. 

Table B-17 SFP Specifications

SFP Interface
Transmitter Output 
Power Min/Max (dBm)

Receiver Input Power 
Min/Max (dBm)

15454-SFP3-1-IR= OC-3 –15 to –8 –23 to –8

15454E-SFP-L.1.1= STM-1 –15 to –8 –34 to –10

15454-SFP12-4-IR= OC-12, D1 Video –15 to –8 –28 to –7

15454E-SFP-L.4.1= STM-4, D1 Video –15 to –8 –28 to –8

15454-SFP-OC48-IR= OC-48, DV6000 (C-Cor) –5 to +0 –18 to +0

ONS-SE-2G-S1= OC-48, STM-16 –10 to –3 –18 to –3

15454E-SFP-L.16.1= STM-16, DV6000 
(C-Cor)

–5 to +0 –18 to +0

15454-SFP-200/
15454E-SFP-200

ESCON –8 to –4 –28 to –3
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B.6 SFP Port Cabling Specifications
SFP Port Cabling Specifications
Table B-18 provides cabling specifications for the single-mode fiber (SMF) SFPs and Table B-19 
provides cabling specifications for multimode fiber (MMF) SFPs that you install into Ethernet cards. The 
ports of the listed SFPs have LC-type connectors.

15454-SFP-GEFC-SX=/
15454E-SFP-GEFC-S=

Fibre Channel 
(1 and 2 Gbps), FICON, 
GE

–10 to –3.5 –17 to 0 (1FC and 1GE)

–15 to 0 (2FC)

15454-SFP-GE+-LX=/
15454E-SFP-GE+-LX=

Fibre Channel
(1 and 2 Gbps), FICON, 
GE, HDTV

–9.5 to –3.0 –20 to –3 (1FC, 1GE, 
and 2FC)

Table B-17 SFP Specifications (continued)

SFP Interface
Transmitter Output 
Power Min/Max (dBm)

Receiver Input Power 
Min/Max (dBm)

Table B-18 Single-Mode Fiber SFP Port Cabling Specifications

SFP Wavelength1

1. Typical loss on a 1310 nm wavelength is 0.6 dB/km.

Fiber Type Cable Distance

15454-SFP3-1-IR=
Intermediate Reach

1310 nm 9 micron SMF 15 km (9.3 miles)

15454E-SFP-L.1.1=
Short Haul

1310 nm 9 micron SMF 15 km (9.3 miles)

15454-SFP12-4-IR=
Intermediate Reach

1310 nm 9 micron SMF 15 km (9.3 miles)

15454E-SFP-L.4.1=
Short Haul

1310 nm 9 micron SMF 15 km (9.3 miles)

15454-SFP-OC48-IR=
Intermediate Reach

1310 nm 9 micron SMF 15 km (9.3 miles)

ONS-SE-2G-S1=
Short Reach

1310 nm 9 micron SMF 2 km (1.2 miles)

15454E-SFP-L.16.1=
Short Haul

1310 nm 9 micron SMF 15 km (9.3 miles)

15454-SFP-GE+-LX=/
15454E-SFP-GE+-LX=
Long Reach

1310 nm 9 micron SMF 10 km (6.2 miles) for FC 1G, 
FC 2G, and GE
5 km (3.1 miles) for HDTV
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Table B-19 Multimode Fiber SFP Port Cabling Specifications

SFP Wavelength Fiber Type Cable Distance

15454-SFP-200/
15454E-SFP-200
Long Reach

1310 nm 62.5 micron MMF 2 km (1.2 miles)

15454-SFP-GEFC-SX/
15454E-SFP-GEFC-S
Short Reach

850 nm 62.5 micron MMF 300 m (984 ft) for FC 1 Gbps 
and 1.2 Gbps GE
150 m (492 ft) for FC 2 Gbps

50.0 micron MMF 550 m (1804 ft) for FC 1 Gbps 
and 1.2 Gbps GE
300 m (984 ft) for FC 2 Gbps
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September 2004
A P P E N D I X C

DWDM Enhanced State Model

This appendix describes the state model for Cisco ONS 15454 dense wavelength division multiplexing 
(DWDM) cards, optical payload ports, out-of-band optical supervision channel (OSC) ports, optical 
channel network connections (OCHNC), and transponder/muxponder cards and ports. Software 
Release 4.7 states are based on the generic state model defined in Telcordia GR-1093 Core, Issue 2 and 
ITU-T X.731. 

C.1 Service States
Service states include a Primary State (PST), a Primary State Qualifier (PSTQ), and one or more 
Secondary States (SST). Table C-1 lists the ANSI and ETSI service state PSTs and PSTQs supported by 
the ONS 15454.

Table C-2 defines the ANSI and ETSI SSTs supported by the ONS 15454.

Table C-1 ONS 15454 Service State Primary States and Primary State Qualifiers

ANSI Primary State, Primary 
State Qualifier

ETSI Primary State, Primary 
State Qualifier Definition

IS-NR (In-Service and Normal) Unlocked-enabled  The entity is fully operational and will perform as 
provisioned.

OOS-AU (Out-of-Service and 
Autonomous)

Unlocked-disabled  The entity is not operational because of an autonomous 
event.

OOS-AUMA (Out-of-Service 
and Autonomous Management)

Locked-disabled  The entity is not operational because of an autonomous 
event and has also been manually removed from service.

OOS-MA (Out-of-Service and 
Management) 

Locked-enabled The entity has been manually removed from service.
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C.2   C.2   Administrative States
C.2 Administrative States
Administrative states are used to manage service states. Administrative states consist of a PST and an 
SST. Table C-3 lists the ANSI and ETSI administrative states supported by the ONS 15454. See 
Table C-2 on page C-2 for SST definitions. 

Note A change in the administrative state of an entity does not change the service state of supporting or 
supported entities. 

Table C-2 ONS 15454 Secondary States

ANSI Secondary 
State ETSI Secondary State Definition

AINS automaticInService The entity is delayed before transitioning to the 
IS-NR (ANSI)/Unlocked-enabled (ETSI) service state. The transition to 
IS-NR/Unlocked-enabled depends on correction of conditions. Alarm 
reporting is suppressed, but traffic is carried. Raised fault conditions, 
whether or not their alarms are reported, can be retrieved on the CTC 
Conditions tab or by using the TL1 RTRV-COND command.

DSBLD disabled The entity was manually removed from service and does not provide its 
provisioned functions. All services are disrupted; unable to carry traffic.

MEA mismatchOfEquipment An improper card is installed. For example, an installed card is not 
compatible with the card pre-provisioning or the slot. This SST applies 
only to cards.

MT maintenance The entity has been manually removed from service for a maintenance 
activity but still performs its provisioned functions. Alarm reporting is 
suppressed, but traffic is carried. Raised fault conditions, whether or not 
their alarms are reported, can be retrieved on the CTC Conditions tab or 
by using the TL1 RTRV-COND command.

SWDL softwareDownload The card is involved in a software and database download. This SST 
applies only to cards.

UAS unassigned The card is not provisioned in the database. This SST applies only to cards.

UEQ 
(Unequipped)

notInstalled The card is not physically present (that is, an empty slot). This SST applies 
only to cards.

Table C-3 Cisco ONS 15454 Administrative States

ANSI Administrative 
State (PST,SST)

ETSI Administrative State 
(PST,SST) Definition

IS Unlocked Puts the entity in-service.

IS,AINS Unlocked,automaticInService Puts the entity in automatic in-service.

OOS,DSBLD Locked,disabled Removes the entity from service and disables it.

OOS,MT Locked,maintenance Removes the entity from service for maintenance.
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C.3 Service State Transitions
This section describes the transition from one service state to the next state for DWDM cards, optical 
payload ports, OSC ports, OCHNCs, and transponder/muxponder cards and ports. A service state 
transition is based on the action performed on the entity and any autonomous activity.

C.3.1 DWDM Card Service State Transitions 

Table C-4 lists ANSI and ETSI service state transitions for AD-1B-xx.x, AD-4B-xx.x, AD-1C-xx.x, 
AD-2C-xx.x, AD-4C-xx.x, OSC-CSM, OSCM, OPT-BST, OPT-PRE, 4MD-xx.x, 32MUX-O, and 
32DMX-O cards.

Table C-4 Cisco ONS 15454 Optical Unit Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Delete the card. OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Reset the card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Delete the card. If the card is valid: 

• OOS-AUMA,UAS (ANSI)

• Locked-disabled,unassigned (ETSI)

If the card is invalid: 

• OOS-AUMA,MEA & UAS (ANSI) 

• Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)
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OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Insert a valid card. OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Insert an invalid card. OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment 
(ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Delete the card. If the card is valid: 

• OOS-AUMA,UAS (ANSI) 

• Locked-disabled,unassigned (ETSI)

If the card is invalid: 

• OOS-AUMA,MEA & UAS (ANSI)

• Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload 
(ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

Provision the card. OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment (ETSI)

OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Restart completed. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled (ETSI)

Table C-4 Cisco ONS 15454 Optical Unit Service State Transitions (continued)

Current Service State Action Next Service State
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C.3.2 Optical Payload Port Service State Transitions
Table C-5 lists the ANSI and ETSI optical payload port service state transitions. 

OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled (ETSI)

Provision an invalid 
card.

OOS-AU,MEA (ANSI)

Unlocked-disabled,mismatchOfEquipment (ETSI)

Provision a valid card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

Pre-provision a card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Table C-4 Cisco ONS 15454 Optical Unit Service State Transitions (continued)

Current Service State Action Next Service State

Table C-5 Cisco ONS 15454 Optical Payload Port Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,DSBLD 
administrative state.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

The OCHNC end-to-end path no 
longer exists.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

All required OCHNC 
connections exist.

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the OOS,DSBLD. OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the port in the OOS,MT. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)
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C.3   C.3.3   OSC Port Service State Transitions
C.3.3 OSC Port Service State Transitions
Table C-6 lists the ANSI and ETSI OSC port service state transitions. 

C.3.4 OCHNC Service State Transitions
Table C-7 lists the ANSI and ETSI OCHNC service state transitions. 

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the port in the OOS,DSBLD 
administrative state.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Table C-5 Cisco ONS 15454 Optical Payload Port Service State Transitions (continued)

Current Service State Action Next Service State

Table C-6 Cisco ONS 15454 OSC Port Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Delete the OSC. OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Create the OSC. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Table C-7 Cisco ONS 15454 OCHNC Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Put the connection in the 
OOS,MT administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Put the connection in the 
IS,AINS administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)
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C.3   C.3.5   Transponder/Muxponder Card Service State Transitions
C.3.5 Transponder/Muxponder Card Service State Transitions
Table C-4 lists ANSI and ETSI transponder and muxponder card service state transitions.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Put the connection in the IS 
administrative state.

IS-NR (ANSI)

Unlocked-enabled (ETSI)

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Put the connection in the 
IS,AINS administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Table C-7 Cisco ONS 15454 OCHNC Service State Transitions (continued)

Current Service State Action Next Service State

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Change the administrative state 
to OOS,MT.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Delete the card. OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Reset the card. OOS-AU,SWDL (ANSI)

Unlocked-disabled,softwareDownload 
(ETSI)

OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MEA & MT (ANSI)

Locked-disabled,mismatchOfEquipment & 
maintenance (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Delete the card. If the card is valid:

• OOS-AUMA,UAS (ANSI) 

• Locked-disabled,unassigned (ETSI)

If the card is invalid:

• OOS-AUMA,MEA & UAS (ANSI) 

• Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)
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C.3   C.3.5   Transponder/Muxponder Card Service State Transitions
OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Pull the card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

Insert a valid card. OOS-AU,AINS & SWDL (ANSI)

Unlocked-disabled,automaticInService & 
softwareDownload (ETSI)

Insert an invalid card. OOS-AU,AINS & MEA (ANSI)

Unlocked-disabled,automaticInService & 
mismatchOfEquipment (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

OOS-AU,MEA (ANSI) Pull the card. OOS-AU,UEQ (ANSI)

Unlocked-disabled,notInstalled (ETSI)

Delete the card. If the card is valid: 

• OOS-AUMA,UAS (ANSI)

• Locked-disabled,unassigned (ETSI)

If the card is invalid:

• OOS-AUMA,MEA & UAS (ANSI) 

• Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload 
(ETSI)

Restart completed. IS-NR (ANSI)

Unlocked-enabled (ETSI)

Pull the card. OOS-AU,UEQ (ANSI)

Locked-disabled,notInstalled (ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

Current Service State Action Next Service State
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C.3   C.3.5   Transponder/Muxponder Card Service State Transitions
OOS-AU,UEQ (ANSI)

Locked-disabled,notInstalled (ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Change the administrative state 
to OOS,MT.

OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

OOS-AUMA,MEA & MT (ANSI)

Locked-disabled,mismatchOfEquipment 
& maintenance (ETSI)

Change the administrative state 
to IS.

OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

Delete the card. If the card is valid:

• OOS-AUMA,UAS (ANSI) 

• Locked-disabled,unassigned (ETSI)

If the card is invalid:

• OOS-AUMA,MEA & UAS (ANSI)

• Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)

OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment 
& unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Provision the card. OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Restart completed. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

Current Service State Action Next Service State
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OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & 
notInstalled (ETSI)

Change the administrative state 
to IS.

OOS-AU,UEQ (ANSI)

Locked-disabled,notInstalled (ETSI)

Insert a valid card. OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Insert an invalid card. OOS-AUMA,MEA & MT (ANSI)

Locked-disabled,mismatchOfEquipment & 
maintenance (ETSI)

Delete the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & notInstalled 
(ETSI)

Provision an invalid card. OOS-AU,MEA (ANSI)

Locked-disabled,mismatchOfEquipment 
(ETSI)

Provision a valid card. OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload (ETSI)

OOS-AUMA,UAS & UEQ (ANSI)

Locked-disabled,unassigned & 
notInstalled (ETSI)

Insert a valid card. OOS-AU,SWDL (ANSI)

Locked-disabled,softwareDownload (ETSI)

Insert an invalid card. OOS-AUMA,MEA & UAS (ANSI)

Locked-disabled,mismatchOfEquipment & 
unassigned (ETSI)

Pre-provision a card. OOS-AU,AINS & UEQ (ANSI)

Unlocked-disabled,automaticInService & 
notInstalled (ETSI)

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Change the administrative state 
to IS.

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Delete the card. OOS-AUMA,UAS (ANSI)

Locked-disabled,unassigned (ETSI)

Pull the card. OOS-AUMA,MT & UEQ (ANSI)

Locked-disabled,maintenance & notInstalled 
(ETSI)

Reset the card. OOS-AUMA,MT & SWDL (ANSI)

Locked-disabled,maintenance & 
softwareDownload (ETSI)

Table C-8 ONS 15454 Transponder/Muxponder Card Service State Transitions (continued)

Current Service State Action Next Service State
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C.3.6 Transponder/Muxponder Port Service State Transitions
Table C-9 lists the ANSI and ETSI transponder and muxponder port service state transitions. 

Table C-9 ONS 15454 Transponder/Muxponder Port Service State Transitions

Current Service State Action Next Service State

IS-NR (ANSI)

Unlocked-enabled (ETSI)

Place the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Place the port in the 
OOS,DSBLD administrative 
state.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Place the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Place the port in the IS 
administrative state.

IS-NR1 (ANSI)

Unlocked-enabled (ETSI)

Place the port in the OOS,MT 
administrative state.

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Place the port in the 
OOS,DSBLD.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Place the port in the IS 
administrative state.

IS-NR1 (ANSI)

Unlocked-enabled (ETSI)

Place the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Place the port in the OOS,MT. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

OOS-MA,LPBK & MT (ANSI)

Locked-enabled,loopback & maintenance 
(ETSI)

Release the loopback. OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

OOS-MA,MT (ANSI)

Locked-enabled,maintenance (ETSI)

Place the port in the IS 
administrative state.

IS-NR1

Unlocked-enabled (ETSI)

Place the port in the IS,AINS 
administrative state.

OOS-AU,AINS (ANSI)

Unlocked-disabled,automaticInService 
(ETSI)

Place the port in the 
OOS,DSBLD.

OOS-MA,DSBLD (ANSI)

Locked-enabled,disabled (ETSI)

Place the port in loopback. OOS-MA,LPBK & MT2 3 (ANSI)

Locked-enabled,loopback & maintenance 
(ETSI)
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C.3   C.3.6   Transponder/Muxponder Port Service State Transitions
1. The transponder and muxponder cards have both client and trunk ports. To bring up service, it is not necessary that both the client side and trunk side 
have to be in the IS-NR (ANSI)/Unlocked-enabled (ETSI) service state.

2. In a client-side facility loopback, the client port is in the OOS-MA,LPBK & MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state 
and the remaining client and trunk ports can be in any other service state. In a client-side terminal loopback on transponder cards, the client port is in 
the OOS-MA,LPBK & MT service state and the trunk ports are in IS-NR (ANSI)/Unlocked-enabled (ETSI). For client-side terminal loopbacks on 
muxponder cards, the client port is in the OOS-MA,LPBK & MT service state and remaining client and trunk ports can be in any service state.

3. In a trunk-side facility loopback, the trunk port is in the OOS-MA,LPBK & MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state 
and the remaining client and trunk ports can be in any other service state. In a trunk-side terminal loopback, the trunk port is in the OOS-MA,LPBK & 
MT (ANSI)/Locked-enabled,loopback and maintenance (ETSI) service state and the client ports are in IS-NR (ANSI)/Unlocked-enabled (ETSI) for 
complete loopback functionality. This type of loopback affects all client ports because it is performed on the aggregate signal.
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replacement 13-52

revision number A-12

serial number A-12

slot requirements 13-51

symbol and slot correspondence 13-51

card service state

change 10-83

description C-1

see also service state

card slots see slots

card view

change views A-2

description 17-12, A-1

list of tabs 17-13

CAT-5 cable see LAN cable

change node timing parameters 9-32

channel allocation plan 14-9

channel filter OADM cards

see AD-1C-xx.x card

see AD-2C-xx.x card

see AD-4C-xx.x card

circuits

disable circuit discovery 2-27

find circuits with alarms 20-3

see OCHNC

see overhead circuits

circuit states

description C-1

provision 6-4

see also enhanced state model

see also service states

CISCO15 2-27

Cisco MetroPlanner see MetroPlanner

Cisco Transport Controller see CTC

CLEI code A-12

CLETOP 11-34
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clock

change time 9-9

reset 1-37

set time 3-7

colors

cards 17-7, 17-9

FMECs 17-8

nodes 17-12

common control cards

see AIC-I card

see TCC2 card

compatibility

card 14-6

JRE 17-4

SFP 14-123

computer see PC setup

conditions

change time zone 7-11, 20-2

description 20-5

filter 20-6

history 20-8

view 7-12

connected rings 16-4

CORBA 3-20

corporate LAN connection

description 17-6

set up 2-20

cost 3-15, 3-16, 9-12, 19-8

covers

see backplane covers

see FMEC cover

craft connection

description 17-6

set up 2-9

crimp tool 1-38

CTC

see also PC setup 2-3

toolbar icons see toolbar icons

alerts 2-33
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back up 11-2

computer requirements 17-4

connect PCs 2-9, 2-20

determine version 2-26

export data 7-4

firewall access 3-19

incompatibility alarm 2-26

installation overview 17-3

install CD-ROM 2-3

log in 2-23

node setup 3-6

PC requirements 2-3

print data 7-2

remote site access 2-22

revert to earlier load 11-22, 17-15

set up network access 3-8

UNIX workstation requirements 2-6

verify software version 1-74

version mismatch among multiple nodes 2-26

views see network view, node view, card view

C-Temp ranges B-6

D

database

back up 11-2

clear the database 11-5

description 17-15

MAC address 13-29

parameters that are not restored 11-5

restore node and card defaults during disaster 
recovery 11-5

restore the database 11-3

revert 17-15

revert to earlier software database 11-22

datagrams 19-4

date

change setting 9-9

default 1-36
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provision 3-7

daylight savings 3-7

DCC

AIC-I compatibility 14-21

disable autodiscovery 2-27

metric (OSPF) 3-16

OSPF Area ID 3-16

pin assignments 14-21

viewing connections 17-11

DCU

hub node 15-2

install DCU chassis 1-67

install DCUs 3-28

OPT-PRE card 14-37

overview 14-2

typical rack layout 13-16

default router

change 9-11

change using LCD 3-13

enter IP address 3-10

dense wavelength division multiplexing see DWDM

destination

host 19-4

routing table 19-21

DHCP

change request recipient 9-11

enable 3-10

provision 2-13

scenario 19-3

dialog box, do not display 9-19

disaster recovery 11-5

dispersion compensating unit see DCU

DNS configuration 2-11, 2-14, 2-16, 2-20

domains

create 9-17

manage 9-18

DWDM

calculate cable connections 3-56

create connections 3-57
Cisc
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delete connections 3-57

fiber tray 13-39

monitor performance 8-8 to 8-15

nodes 15-1

optional hardware 1-66

provision a network 5-7

provision a ring ID 3-63

rack layouts 13-16

topologies 16-1 to 16-18

DWDM cards

channel allocation plan 14-9

fibering 3-35

install 3-26

LED behavior during install 3-27

power requirements B-5

remove and replace 11-12

reset 11-11

route fiber 3-55

see 32DMX card

see 32DMX-O card

see 32MUX-O card

see 32WSS card

see 4MD-xx.x card

see AD-1B-xx.x card

see AD-1C-xx.x card

see AD-2C-xx.x card

see AD-4B-xx.x card

see AD-4C-xx.x card

see OPT-BST card

see OPT-PRE card

see OSC-CSM card

see OSCM card

service state transitions C-3

dynamic host configuration protocol see DHCP

E

electrical codes 13-2

end network element 3-10
IN-7
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enhanced forward error correction 14-92, 14-93, 14-109

enhanced state model

description C-1 to C-12

see also service states

enterprise LAN see corporate LAN

environmental alarms

see external alarms

see external controls

equipment

DWDM 1-66

inventory A-12

user-supplied (ANSI) 1-3

user-supplied (ETSI) 1-5

ESD plug input 1-20

events

see alarms

see conditions

express channel connections 4-26, 4-27

external alarms

see also AEP

see also AIC card

see also AIC-I card

change 10-77, 10-80

description 14-15, 14-18

overview 20-13

pin assigments using external wire-wrap panel 1-60

pin assignments with AEP 13-33

pin assignments without AEP 1-49

provision 7-36, 7-38

wiring 1-48, 1-53

wiring description 13-47

external controls

see also AIC card

see also AIC-I card

see alsoAEP

change 10-78, 10-81

description 14-15, 14-18

overview 20-13

pin assignments with AEP 13-34
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pin assignments without AEP 1-49

provision 7-36, 7-38

wiring 1-48, 1-53

wiring description 13-47

external firewall 19-22

external LAN interface B-2

external switching commands

clear a lock on or lock out 9-27

clear a Manual or Force 9-25

Force 9-24

lock on 9-26

lock out 9-26

Manual 9-24

external timing see timing

external wire-wrap panel 1-59

F

factory configuration 11-5

fan-tray air filter see air filter

fan-tray assembly

description 13-41

fan failure 13-43

fan speed 13-42

install 1-40

power cable 11-42

remove to replace air filter 11-30

replace 11-35

far-end laser control 14-121

FELC 14-121

ferrites 1-77, 13-52

fiber clips 3-55

fiber patch panel 1-68

fiber see cables

fiber storage shelf 1-68

filtering, alarm see alarm filtering

filter stopper 1-12

firewall

change IIOP listener port 9-11
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external firewall description 19-22

provision IIOP listener port 3-20

provision IIOP listener port on PC 3-22

set up 3-19

shortcut A-5

SNMP 3-23

firewall tunnels

add a tunnel 5-11

delete a tunnel 9-14

description 19-24

flange 1-12, 13-6

FlexLayer

FlexLayer system description 13-10

hardware part numbers 1-70

install modules 1-69

install shelf 1-69

install y-cable modules in FlexLayer chassis 1-71

see also y-cable protection

FMEC

see FMEC cover

seeMIC-A/P FMEC

see MIC-C/T/P FMEC

FMEC cover

install and close 1-63

open 1-24

overview 13-3

remove 1-25

Force switch 9-24, 9-25

foreign node settings

change GCC 9-28

open GNE 19-24

provision a proxy tunnel 5-10

provision GCC terminations 3-62

specify IP address 9-29

frame-ground pin 1-58

framing 5-5, 9-33

front door

description 13-19

label 13-23
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open 1-20

remove 1-21, 11-29

replace 3-64

front mount electrical connection see FMEC

fuse and alarm panel

100 amp 1-13, 1-15, 1-17, 1-31, 1-40

80 amp 1-13, 1-15, 1-17, 1-31, 1-40

description 13-2, 13-3

location 13-6, 13-9

measure and cut cables 1-37

G

G.709 see OTN

gateway

default 19-6

on routing table 19-21

returning MAC address 19-4

gateway settings see proxy server

GCC

change GCC terminations 9-28

delete GCC terminations 9-29

foreign termination 5-10, 5-11

OSPF Area ID 3-16

provision GCC terminations 3-62

y-cable protection 14-87, 14-92, 14-95

general communication channel see GCC

GNE

dual GNEs 19-17

load balancing 19-17

open GNE 19-24

ground

connect to ANSI shelf 1-33

connect to ETSI shelf 1-32

description 13-43

ground posts 13-44

install 1-30

see also office ground

ground strap
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avoid interference with cards 3-65

detach 1-22

illustration 13-21

H

hello interval 3-17

hop 3-15, 9-12, 19-8

hubbed rings 16-2

hub node

convert pass-through connections 9-31

CTC icon A-3

description 15-1

install fiber 3-40

I

idle time 3-4

idle user timeout 18-5

IIOP

change IIOP listener port 9-11

listener port 3-20

select IIOP listener port 3-10

installation

overview 13-2, 13-3

acceptance test 1-77

air ramp see air ramp

alarm expansion panel see AEP

CTC installation overview 17-3

CTC installation wizard 2-3, 2-6

DCU see DCU

DWDM hardware 1-66

fan-tray assembly see fan-tray assembly

fiber patch panel shelf 1-68

fiber storage shelf 1-68

FlexLayer modules 1-69

FlexLayer shelf 1-69

install y-cable protection modules 1-71
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list of procedures 1-1

power and ground 1-30, 13-43

required tools (ANSI) 1-2

required tools (ETSI) 1-4

see also rack

see also shelf assembly

wires see wires

Internet Explorer see browsers

Internet protocol see IP

inventory 17-14, A-12

IP

see also IP address

change settings 9-11

create IP-encapsulated tunnel 6-13

environments 19-1

provision IP settings 3-9

requirements 19-2

subnetting 19-1

IP address

change using LCD 3-13

log in 2-25

NMS 3-23

repair 6-17

scenarios

CTC and nodes connected to router 19-3

CTC and nodes on same subnet 19-2

default gateway on CTC workstation 19-6

Dual GNEs on a Subnet 19-17

OSPF 19-9

Proxy ARP and gateway 19-4

static routes connecting to LANs 19-7

select IP address for log in 2-27

set up network information 3-9

static IP addresses 2-11

IP-encapsulated tunnel

create 6-13

delete 6-18

repair 6-17

I-Temp ranges B-6
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J

J0 section trace 6-18

Java Plug-in Security Warning 2-26, 2-28

Java policy file 2-28

jitter 14-111

JRE

overview 17-4

change version 2-32

requirements 17-5

K

kepnut 1-22

L

LAN

connection points 13-48

modems 2-22

OSPF activity 3-16

pin assignments 13-49

wires 1-52, 1-57

LAN cable

connect computer to ONS 15454 2-24

connect to backplane 1-57

connect to MIC-C/T/P 1-28, 1-52

connect to TCC2 card 2-24, 14-13

description 17-5

set up craft connection 2-13

laser warning 13-25, 13-26

latitude 3-6

LCD

change default router 3-13

change IP address 3-13

change network mask 3-13

provision network settings 3-9

verify software version 1-74

view alarm counts 7-16, 20-2
Cisc
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line amplifier node

CTC icon A-3

description 15-11

install fiber 3-44

linear configurations

description 16-5

optical performance 16-8, 16-10, 16-13

line timing see timing

listener port 3-20

lock on 9-26, 9-27

lock out 9-26, 9-27

lock washer 3-65

log in 2-23

login legal disclaimer 9-9

login node groups

add to current session 2-30

create 2-29

delete 2-31

delete from a specified group 2-31

shortcut A-5

view 2-27, 17-11

longitude 3-6

M

MAC address

AIP 13-29

clear table 18-3

proxy ARP 19-4

read-only 3-10

retrieve table 18-3

maintenance user see security

Manual switch 9-24, 9-25

map see network view

meshed rings 16-4

MetroPlanner

import a configuration file 3-59

internal connections 3-35

provision a network 5-8
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requirement 1-67, 3-1

MIB 8-28

MIC-A/P FMEC

description 14-21

install 1-27

install alarm wires 1-48

power requirements B-6

specifications B-10

temperature range B-6

MIC-C/T/P FMEC

description 14-24

install 1-27

install LAN wires 1-52

install timing wires 1-51

power requirements B-6

specifications B-11

temperature range B-6

modem interface B-2

module see card

mounting brackets

description 13-5

mount rear cover 1-65

reverse 1-10

multi-hubbed rings 16-2

multiplexer and demultiplexer cards

see 32DMX card

see 32DMX-O card

see 32MUX-O card

see 4MD-xx.x card

muxponder cards

see MXP_2.5G_10E card

see MXP_2.5G_10G card

see MXP_MR_2.5G card

see MXPP_MR_2.5G card

MXP_2.5G_10E card

change PM thresholds 10-43

create RMON thresholds 8-28

create y-cable protection 3-33

description 14-104
IN-12
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enhanced FEC capability 14-109

install 3-30

modify line settings 10-43

monitor performance 8-15

port state transitions C-11

power requirements B-6

put ports out of service 11-14

reset 11-11

service state transitions C-7

specifications B-38

temperature range B-7

timing 5-6

trunk wavelengths 14-110

MXP_2.5G_10G card

change PM thresholds 10-43

create RMON thresholds 8-28

create y-cable protection 3-33, 5-6

description 14-101

GCC terminations 3-62

install 3-30

modify line settings 10-43

monitor performance 8-15

port state transitions C-11

power requirements B-6

put ports out of service 11-14

reset 11-11

service state transitions C-7

specifications B-33

temperature range B-7

y-cable description 14-119

MXP_MR_2.5G card

change PM thresholds 10-65

create RMON thresholds 8-28

create y-cable protection 3-33

description 14-113

install 3-30

modify line settings 10-65

monitor performance 8-15

port state transitions C-11
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power requirements B-6

put ports out of service 11-14

reset 11-11

service state transitions C-7

specifications B-36

temperature range B-7

timing 5-6

y-cable description 14-119

MXPP_MR_2.5G card

change PM thresholds 10-65

create RMON thresholds 8-28

create y-cable protection 3-33

description 14-113

install 3-30

modify line settings 10-65

monitor performance 8-15

port state transitions C-11

power requirements B-6

put ports out of service 11-14

reset 11-11

see also splitter protection

service state transitions C-7

specifications B-36

temperature range B-7

timing 5-6

N

Netscape Navigator see browsers

network element defaults, restore 11-5

networks

building circuits 6-1

convert connections during upgrade 9-31

DWDM topologies 16-1 to 16-18

optical performance 16-6

optical safety 16-18

set up basic information 3-9

set up CTC network access 3-8

timing example 18-7
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network time protocol 3-6

network view

description 17-11

add nodes to map see domains

apply a custom background image (map) 9-17

change the background color 9-15

change the default network map 9-16

change views A-2

create a customized network view 5-15

create new users 3-5

delete users 9-40

description A-1

DWDM A-8

node icons A-2

node status (icon colors) 17-12

security levels per tab 18-4

switch between TDM and DWDM network views 9-20

tasks A-10

TDM A-8

node

add to current session 2-30

change node access 9-37

change node contact info 9-8

change node date 9-8

change node name 9-8

change node time 9-8

date, time, and contact information 3-6

delete from current session 2-31

icons A-3

remove power 12-1

node services protocol 16-1

node view

alarm profile 7-26

change views A-2

description 17-7, A-1

security levels per tab 18-1

shortcuts A-10

non-ONS node see foreign node settings

NSP 16-1
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NTP server 3-6

O

OADM node

acceptance test 4-16, 4-18, 4-20

check power values 5-9

CTC icon A-3

description 15-4

install fiber 3-48

optical performance 16-8

verify add and drop connections 4-33, 4-35

verify express channel connections 4-26, 4-27

verify OSC-CSM power 4-25

verify pass-through channel connections 4-29

OAM&P access 17-6

OCHNC

circuit status 6-5

delete 6-11

filter 6-6

locate and view 6-2

provision 6-9

search 6-2

see also service states

service state transitions C-6

view 6-3

view alarms on OCHNCs 7-14, 20-3

view on a span 6-7

office ground

connect to ANSI shelf 1-33

connect to ETSI shelf 1-32

office power

connect to ANSI shelf 1-37

connect to ETSI shelf 1-35

turn on and verify 1-39

open GNE

description 19-24

see also firewall tunnels

see also proxy tunnels
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Open Shortest Path First see OSPF

OPT-BST card

description 14-39

fiber clip 3-55

first-time tune up 5-8

install 3-26

monitor performance 8-10

power requirements B-5

put ports out of service 11-16

reset 11-11

service state transitions C-3

specifications B-14

temperature range B-7

verify laser and power 4-22

optical add/drop multiplexer

see 32WSS card

see AD-1B-xx.x card

see AD-1C-xx.x card

see AD-2C-xx.x card

see AD-4B-xx.x card

see AD-4C-xx.x card

see OADM node

optical amplifier cards

see OPT-BST card

see OPT-PRE card

optical channel network connections see OCHNC

optical performance 16-6

optical receive power 5-13

optical service channel cards

see OSC-CSM card

see OSCM card

optical service channel see OSC

OPT-PRE card

change PM thresholds 10-10

description 14-35

fiber clip 3-55

first-time tune up 5-8

install 3-26

install required DCU 3-28
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modify line settings 10-10

monitor performance 8-10

power requirements B-5

reset 11-11

service state transitions C-3

specifications B-13

temperature range B-7

verify laser and power 4-23

orderwire

change settings

AIC card 10-79

AIC-I card 10-82

delete 6-18

description

AIC card 14-15

AIC-I card 14-19

OSCM and OSC-CSM cards 14-26

pin assignments

AIC card 14-16

AIC-I card 14-20, 14-29, 14-34, 14-38, 14-42, 14-48, 14-52, 
14-56, 14-60, 14-65, 14-69, 14-73, 14-77, 14-81

provision 6-15

OSC

delete OSC terminations 9-30

description 14-26

install fiber for OSC link terminations 3-37

OSC port service state transitions C-6

provision OSC terminations 3-61

OSC-CSM card

asymmetric line node acceptance test 4-13

change PM thresholds 10-2

description 14-30

install 3-26

modify settings 10-2

monitor performance 8-8

power requirements B-5

put ports out of service 11-15

reset 11-11

service state transitions C-3
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specifications B-13

symmetric line node acceptance test 4-12

symmetric OADM node acceptance test 4-18

symmetric passive OADM node acceptance test 4-20

temperature range B-7

verify add and drop connections 4-35

verify incoming power 4-25

verify power 4-24, 4-25

verify transmit power 3-63

OSCM card

asymmetric line node acceptance test 4-13

change PM thresholds 10-2

description 14-26

fiber clip 3-55

install 3-26

modify settings 10-2

monitor performance 8-8

power requirements B-5

put ports out of service 11-15

reset 11-11

service state transitions C-3

specifications B-12

symmetric line node acceptance test 4-10

symmetric OADM node acceptance test 4-16

temperature range B-7

verify add and drop connections 4-33

verify transmit power 3-63

OSC regeneration node

CTC icon A-4

description 15-12

install fiber 3-46

OSNR

network applications 16-1

verify 5-14

OSPF

alternative to static routes 19-7

area range table 3-17

disable 9-13

IP addressing scenario 19-9
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IP networking overview 19-1

provisionable patchcords 19-19

set up or change 3-16

OTDR 9-4, 15-19

OTN

change OTN settings 10-40, 10-52, 10-62

enable OTN FEC performance monitoring 8-17

G.709

change thresholds 10-40, 10-52, 10-62

enable OTN G.709 performance monitoring 8-16

trunk bit rates with G709 enabled 14-95

view PMs 8-21

overhead circuits

create 6-12

delete 6-18

see also IP-encapsulated tunnel

see also orderwire

see also user data channel

shortcut A-7

P

pass-through channel connections 4-29

passwords

change 9-38

create new user 3-4, 3-5

login 2-26

PCM 6-15, 14-15, 14-19

PC setup

connect computer to ONS 15454 2-24

connect PC to ONS 15454 2-2

corporate LAN connection 2-20

craft connection (requiring IP address 
reconfiguration) 2-11

craft connection (without multiple IP 
reconfigurations) 2-15

craft connection using DHCP 2-13

disable proxy service 2-21

install browser 2-2
IN-16
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install JRE 2-3, 2-6

remote (modem) access 2-22

requirements 2-3, 17-4

set up PC for local craft connection 2-9

performance, optical 16-6

performance monitoring

see also individual cards

clear current (displayed) counts 8-5

clear stored counts 8-6

PM clearing privilege 9-37

refresh 15-minute intervals 8-2

refresh counts, different port 8-7

refresh one-day intervals 8-3

set auto-refresh interval 8-6

threshold crossing alert see TCA

view far-end counts 8-4

view near-end counts 8-4

pin assignments

overview (ANSI) 13-44

AEP 1-47, 13-32

alarms

ANSI 1-55

ETSI 1-49

craft 1-59

LAN

ANSI 1-58

ETSI 1-52

timing

ANSI 1-56

ETSI 1-51

wire-wrap panel on the AEP 1-60, 1-61

ping 19-2

pinned hex (Allen) key 1-20

pluggable port module see SFPs

plug-in unit see card

popup data 17-10

ports

default UDP port for SNMP 9-43

listener port 3-20
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put optical ports in⁄ out of service 6-14

TCC2 19-23

TL1 port 17-4

UDP 3-23

power

BAT1 backplane power terminal 1-39

coat bare conductors 1-38

connect office power to ANSI shelf 1-37

connect office power to ETSI shelf 1-35

fan-tray assembly requirements 13-43

measure voltage 1-79

OSCM and OSC-CSM transmit power 3-63

RET2 backplane power terminal 1-39

see also office power

set power monitor thresholds 3-8

specifications B-3

supply 1-30, 13-43

verify 32DMX-O or 32DMX power 4-24

verify 32MUX-O and 32DMX-O power 4-22

verify office power 1-39

verify optical receive power 5-13

power monitoring 14-20

protection, card see y-cable protection or splitter 
protection

protocols

DHCP 3-10

IP 19-1

NTP 3-6

Proxy ARP see Proxy ARP

SNTP 3-6

SSM 18-8

provisionable patchcord

create 5-12

delete 9-30

description 19-19

provisioning user see security

Proxy ARP

description 19-1

enable an ONS 15454 gateway 19-4
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use with static routes 19-5

proxy server

gateway settings, change 9-12

gateway settings, description 19-12

gateway settings, provision 3-10

proxy service

disable using Internet Explorer 2-21

disable using Netscape 2-21

proxy tunnels

add a tunnel 5-10

delete a tunnel 9-14

PST C-1

PSTQ C-1

public-key security certificate 2-26, 2-28

pulse code modulation 6-15

R

rack

installation overview 13-3, 13-7

Bay Assembly 13-7

mount a single node 1-13, 1-15, 13-6, 13-8

mount multiple nodes 1-16, 13-6, 13-9

reversible mounting bracket 1-10, 13-5

RAM

PC requirements for CTC 2-3

UNIX requirements for CTC 2-6

rear cover 13-28

reinitialization tool 11-5

remote access

description 17-6

set up 2-22

remote monitoring see RMON

reset 11-10

retrieve user see security

revert 11-22, 17-15

revertive timing 5-5

rings

any-to-any 16-3
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hubbed rings 16-2

meshed DWDM 16-4

multihubbed 16-2

optical performance for ROADM rings 16-13

provision ring ID 3-63

RIP 3-18

RJ-11 connector 14-16, 14-20

RMON

create alarm thresholds 8-28

delete alarm thresholds 8-30

RMON see also SNMP

ROADM

card requirements 14-52

CTC node icons A-4

description 14-81

install fiber 3-53

multiplexer 14-108

node acceptance test 4-6

node-type description 15-8

view ROADM node power equilization 9-6

routing information protocol see RIP

routing table 19-21

S

secure shell 18-6

security

assign user levels 3-4, 3-5

change policy 9-34, 9-36

change security level 9-38

idle times 3-4

idle user timeout 18-5

modify settings 9-34

policies 18-5

requirements 18-1

set up 3-3

superuser privileges 18-5, 18-6

tasks per tab 18-2, 18-4

user level definitions 18-1
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viewing 17-7

service states

card 17-12, A-12

card state transitions C-3

change 6-14, 10-83

description C-1

equipment A-12

ports 17-8

see also enhanced state model

SFPs

compatibility 14-123

delete provisioning 10-31

description 14-123

install 3-32

provision 10-29

remove 3-32

specifications B-42

shelf assembly

see also installation

specifications B-1

unpack and inspect 1-6

ANSI

description 13-3

Bay Assembly 13-7

dimensions 13-5, B-4

ETSI

description 13-7

dimensions 13-8, B-4

mounting 13-8

shutdown, automatic laser 16-18

simple network time protocol see SNTP

single-span link

description 16-6

optical performance 16-17

slots

overview 13-49

AIC card and AIC-I card 3-3

fiber management 13-37

FMEC slots 13-30
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preprovision 3-24

requirements 13-51

unused slots 13-2

small form factor pluggable connector see SFP

SNMP

delete trap destination 9-43

modify trap destination 9-42

set up 3-22

SNTP 3-6

software see CTC

Solaris see UNIX

SONET

timing parameters 18-6

span loss

description 15-15

optical 9-3

use OTDR 9-4

verify 9-2, 15-18

splitter protection

definition 3-33

description 14-120

modify 9-22

SSH 18-6

SSM

enable 5-5, 9-33, 10-3

message set 5-4, 9-32

SST C-1

ST3 clock 18-7

standard constant 3-20

standoff kit 1-12

state see service state

static route

create 3-15

delete 9-13

IP addressing scenario 19-7

modify 9-12

straight-through (CAT-5) cable see LAN cable

subnet

CTC and nodes on different subnets 19-3
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CTC and nodes on same subnet 19-2

multiple subnets on the network 19-6

using static routes 19-7

with Proxy ARP 19-4, 19-5

subnet mask

24-bit 19-22

32-bit 19-22

change 9-11

description 19-8

OSPF area range table 3-17

provision in a static route 3-15

provision subnet mask length 3-10

routing table 19-21

Windows setup 2-12, 2-13

superuser see security

synchronization status messaging see SSM

T

tables

see also List of Tables

change format A-11

display hidden columns A-11

print data 7-2

resize columns A-11

sort A-11

tabs

overview 17-7

card view 17-14

Alarms 17-13

Circuits 17-13

Conditions 17-13

History 17-13

Maintenance 17-14

Performance 17-14

Provisioning 17-14

network view

Alarms 17-12, 18-4

Circuits 17-12, 18-4
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Conditions 17-12, 18-4

History 17-12, 18-4

Maintenance 17-12, 18-5

Provisioning 17-12, 18-5

node view

Alarms 17-10, 18-2

Circuits 17-10, 18-2

Conditions 17-10, 18-2

History 17-10, 18-2

Inventory 17-10, 18-3

Maintenance 17-10, 18-3

Provisioning 17-10, 18-2

TCA 8-3

TCC2 card

clear the database for disaster recovery 11-5

connect LAN cable 2-24

craft interface B-2

craft wires vs. RS-232 port 1-59

CTC access B-2

database backup 11-2, 17-15

description 14-11

install 1-73

modem interface B-2

ports 19-23

power requirements B-6

reboot behavior 3-11

restore the database 11-3

RJ-45 (LAN) port 2-22

soft reset 11-10, 17-14

software installation overview 17-1

software version change (automatic upload) 1-75

specifications B-7

temperature range B-6

verify installation 3-2

TCP/IP

change configuration for Windows 2000 2-12, 2-14, 2-17

change configuration for Windows 98 2-11, 2-14

change configuration for Windows NT 2-12, 2-14, 2-17

change configuration for Windows XP 2-13, 2-15, 2-18
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terminal lug 3-65

terminal node

CTC icons A-4

description 15-3

install fiber 3-43

third-party equipment 13-2, 13-3

threshold crossing alert see TCA

timed out see idle time

time zone 3-7, 7-11

timing 9-32

BITS see BITS

change node timing reference 11-24

connections 13-48

external, set up 5-4

internal, set up 5-6

line, set up 5-4

mode 5-6

NE reference 5-6

network timing example 18-7

node timing description 18-6

set node clock 3-7

set up 5-4

specifications B-3

SSM 18-8

view timing report 11-25

TL1

AID in CTC 20-7

commands 17-4

connection 17-6

craft interface connection 1-58, 13-49

interface specifications B-2

pin assignments 1-59

TCC2 RS-232 port connection 1-58

toolbar icon A-7

toolbar icons

add node A-5

delete selected node A-5

export A-5

go to home view A-6
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go to network view A-6

go to next view A-6

go to other node A-6

go to parent view A-6

go to previous view A-6

go to selected object view A-6

lock node A-5

open TL1 connection A-7

preferences A-5

print A-5

zoom in A-6

zoom in selected area A-6

tools, required 1-2, 1-4

traffic routing 19-21

transponder cards

see TXP_MR_10E card

see TXP_MR_10G card

see TXP_MR_2.5G card

see TXPP_MR_2.5G card

trap 3-23

TXP_MR_10E card

change PM thresholds 10-32

create RMON thresholds 8-28

create y-cable protection 3-33

description 14-90

install 3-30

modify line settings 10-32

monitor performance 8-15

port state transitions C-11

power requirements B-6

put ports out of service 11-14

reset 11-11

service state transitions C-7

specifications B-40

temperature range B-7

TXP_MR_10G card

change PM thresholds 10-32

create RMON thresholds 8-28

create y-cable protection 3-33
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description 14-87

GCC terminations 3-62

install 3-30

modify line settings 10-32

monitor performance 8-15

port state transitions C-11

power requirements B-6

put ports out of service 11-14

reset 11-11

service state transitions C-7

specifications B-31

temperature range B-7

y-cable description 14-119

TXP_MR_2.5G card

change PM thresholds 10-55

create RMON thresholds 8-28

create y-cable protection 3-33

description 14-94

GCC terminations 3-62

install 3-30

modify line settings 10-55

monitor performance 8-15

port state transitions C-11

power requirements B-6

put ports out of service 11-14

reset 11-11

service state transitions C-7

specifications B-35

temperature range B-7

y-cable description 14-119

TXPP_MR_2.5G card

see also splitter protection

change PM thresholds 10-55

create RMON thresholds 8-28

description 14-94

GCC terminations 3-62

install 3-30

modify line settings 10-55

monitor performance 8-15
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port state transitions C-11

power requirements B-6

put ports out of service 11-14

reset 11-11

service state transitions C-7

specifications B-35

temperature range B-7

U

UNIX

connect cable to ONS 15454 2-24

CTC installation wizard 2-6

disable proxy service 2-21

set up craft connection to ONS 15454 2-18

software installation description 17-3

workstation requirements 17-4

unpack 1-6

user data channel

delete 6-18

description 14-20

provision 6-16

user-defined alarms

see external alarms

see external controls

users

see also security

change password or security settings 9-38

create new user on a single node 3-4

create new users on multiple nodes 3-4

delete 9-39, 9-40

log out 9-40, 9-41

security level definitions 18-1

set up 3-3

V

variable optical attenuator see automatic node setup 3-58
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views

see card view

see network view

see node view

virtual links see provisionable patchcords

virtual link table (OSPF) 3-17

virtual wires 20-14

VOA 15-15, 15-16, 15-19

voltage, measure 1-79

voltmeter 1-40, 1-79

W

WAN 19-1

WINS configuration 2-11, 2-14, 2-16, 2-20

wires

install alarm wires 1-48, 1-53

install LAN wires 1-52, 1-57

install timing wires 1-51, 1-56

install TL1 craft interface wires 1-58

wire-wrap panel, external 1-59

wizard, installation 2-3, 2-6

Y

y-cable protection

delete 9-22

description 13-10, 14-119

install FlexLayer modules 1-69

install FlexLayer shelf 1-69

modify 9-21

y-cable protection modules 1-71
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